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Important User Information 
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards. 
Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice. 
If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may 
be impaired. 
In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment. 
The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables 
and requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams. 
No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual. 
Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., 
is prohibited. 
Throughout this manual, when necessary, we use notes to make you aware of safety considerations. 

 
WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to 
personal injury or death, property damage, or economic loss. 

 

 
ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. 
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. 

 
IMPORTANT Identifies information that is critical for successful application and understanding of the product. 

Labels may also be on or inside the equipment to provide specific precautions. 

 
SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

 

 
BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous 
temperatures. 

 

 
ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will 
cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for 
Personal Protective Equipment (PPE). 

Rockwell Automation recognizes that some of the terms that are currently used in our industry and in this publication are 
not in alignment with the movement toward inclusive language in technology. We are proactively collaborating with 
industry peers to find alternatives to such terms and making changes to our products and content. Please excuse the 
use of such terms in our content while we implement these changes. 
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Summary of changes 
This manual includes new and updated information. Use these reference 
tables to locate changed information. 

Global changes 
None for this release. 

New or enhanced features 
This table contains a list of topics changed in this version, the reason for 
the change, and a link to the topic that contains the changed information.  

Topic Name Reason 

Import and export on page 727 new feature 
Configure network-based security logon using 
Active Directory   on page 703 

new feature 

Add controller references on page 85 enhanced feature 
Project Navigation on page 551 enhanced feature 
Logix datatype support on page 374 enhanced feature 
CommonControls on page 180 enhanced feature 
Perform basic functions on page 752 enhanced feature 
Display alarms on page 563 enhanced feature 
Configure Ethernet ports on page 742 enhanced feature 
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Preface 
The Studio 5000 Automation Engineering & Design Environment® 
combines engineering and design elements into a common environment. 
The Studio 5000® environment is the foundation for the future of 
Rockwell Automation® engineering design tools and capabilities. The 
Studio 5000 environment is the one place for design engineers to 
develop all elements of their control system. 

 
 

 

 

Studio5000 
environment_View Designer 

Studio 5000 View Designer 
Help 
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Get started 
creating a 
runtime 
application 
• Create a project on page 

53 
• Select a target HMI 

device for a new project
on page 67 

• Add a controller 
reference on page 85 

• Project Explorer on page 
95 

• View the default content 
of a project on page 59 

• Create a screen on page 
348 

• Add a graphic element to
a screen on page 136 

• Change the properties of 
a graphic element on 
page 139 

• Bind a property to a data 
item on page 508 

• Trigger an action on a 
Button Behavior event on 
page 444 

• Create a shortcut to an 
existing screen on page 
102 

• Create an Add-On 
Graphic on page 375 

• Add a language to a View
Designer project on page 
672 

• Download a runtime 
application to an HMI 
device on page 710 

• Open a screen on page 
757 

• Settings screen on page 
740 

Helpful links 
FactoryTalk View 
Machine Edition (ME) vs 
View Designer on page 
30 

On Literature Library 
search for: 
• PanelView™ 5510 

Terminals User Manual 
2715P-UM001 

• PanelView™ 5310 
Terminals User Manual 
2713P-UM001 
http://literature.rockw
ellautomation.com/idc
/groups/literature/doc
uments/um/2713p-um
001_-en-p.pdf 

These documents contain additional information concerning related 
Rockwell Automation products. 

Resource Description 

Industrial Automation Wiring and Grounding 
Guidelines, publication 1770-4.1  

Provides general guidelines for installing a Rockwell 
Automation industrial system. 

Product Certifications webpage, available at 
http://ab.rockwellautomation.com  

Provides declarations of conformity, certificates, and 
other certification details. 

PanelView 5310 Terminals User Manual publication 
2713P-UM001 

Describes how to install, configure, operate, and 
troubleshoot the PanelView 5310 terminals. 

Additional resources 

http://literature.rockwellautomation.com/idc/groups/public/documents/webassets/browse_category.hcst
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2713p-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2713p-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2713p-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2713p-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2713p-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1770-in041_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1770-in041_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1770-in041_-en-p.pdf
http://ab.rockwellautomation.com/
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2713p-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2713p-um001_-en-p.pdf
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Resource Description 

PanelView 5510 Terminals User Manual publication 
2715P-UM001 

Describes how to install, configure, operate, and 
troubleshoot the PanelView 5510 terminals. 

View or download publications at 
http://www.rockwellautomation.com/literature. To order paper copies of 
technical documentation, contact the local Rockwell Automation 
distributor or sales representative. 

Rockwell Automation publishes legal notices, such as privacy policies, 
license agreements, trademark disclosures, and other terms and 
conditions on the Legal Notices page of the Rockwell Automation 
website. 

End User License Agreement (EULA) 
You can view the Rockwell Automation End User License Agreement 
(EULA) by opening the license.rtf file located in your product's install 
folder on your hard drive.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\license.rtf. 

Open Source Software Licenses 
The software included in this product contains copyrighted software that 
is licensed under one or more open source licenses.  

You can view a full list of all open source software used in this product 
and their corresponding licenses by opening the licenses.txt files located 
your product's OPENSOURCE folder on your hard drive. This file is 
divided into these sections: 

• Components
Includes the name of the open source component, its version
number, and the type of license.

• Copyright Text
Includes the name of the open source component, its version
number, and the copyright declaration.

• Licenses
Includes the name of the license, the list of open source
components citing the license, and the terms of the license.

The default locations of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\Help\Studio 5000 View 
Designer Help\V9\Release Notes\OPENSOURCE\licenses.txt 

You may obtain Corresponding Source code for open source packages 
included in this product from its respective project web site(s). 
Alternatively, you may obtain complete Corresponding Source code by 
contacting Rockwell Automation via the Contact form on the Rockwell 
Automation website: 
http://www.rockwellautomation.com/global/about-us/contact/contact.pag
e. Please include "Open Source" as part of the request text.

Legal notices

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/2715p-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/2715p-um001_-en-p.pdf
https://www.rockwellautomation.com/literature
https://www.rockwellautomation.com/global/legal-notices/overview.page
http://www.rockwellautomation.com/global/about-us/contact/contact.page
http://www.rockwellautomation.com/global/about-us/contact/contact.page
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Commercial Software Licenses  
This software also includes these commercially licensed software 
components: 

Component Copyright 

Actipro WPF Controls Copyright © Actipro Software LLC 
KODAK DIGITAL SCIENCE Java CMM Copyright © Eastman Kodak Company 
Microsoft .NET Copyright © Microsoft Corporation 
Microsoft Visual Studio 2015 Isolated Shell Copyright © Microsoft Corporation 
Microsoft Visual Studio Internal Debugging 
Proxy/Stub 

Copyright © Microsoft Corporation 

Microsoft Expression Interactions Copyright © Microsoft Corporation 
Microsoft Runtime Library Copyright © Microsoft Corporation 
Foxit PDF Viewer Copyright © Foxit Software Incorporated 
QT Copyright © The Qt Company 
Telerik Windows Controls Copyright © Progress Software Corporation 
Telerik Windows Data Copyright © Progress Software Corporation 
Xceed Controls for WPF Copyright © Xceed Software Inc. 
Xceed DataGrid for WPF Copyright © Xceed Software Inc. 

 

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT 
PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER 
OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE 
AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO 
THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL 
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR 
SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL 
INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE 
HTTP://WWW.MPEGLA.COM  

Rockwell Automation recognizes that some of the terms that are currently 
used in our industry and in this publication are not in alignment with the 
movement toward inclusive language in technology. We are proactively 
collaborating with industry peers to find alternatives to such terms and 
making changes to our products and content. Please excuse the use of 
such terms in our content while we implement these changes. 

 

http://www.mpegla.com/
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Chapter 1 

View Designer 

The following diagram shows how View Designer works with the Studio 
5000 suite to create a control and visualization system to monitor and 
control the manufacturing process.  

 
 

Item Name Description 

 
View Designer Build the projects that are downloaded to an HMI device. 

 
Tag Browser Search for and select tags within a Logix Designer project file to 

bind the tags to the properties of graphic elements and screens in 
the View Designer project.  

 
Logix Designer Develop control logic for an industrial automation system.  

 
ACD file The Automation Control Database (ACD) file that is the Logix 

Designer project file containing the logic or code, including tags and 
data types, that runs within a controller. View Designer uses the Tag 
Browser to read data from the ACD file.  

 
HMI project The user-defined screens, controller references, information about 

the target HMI device, and so forth. Projects are stored in files with 
a .vpd extension. 

 
View Designer Download Runtime 
Application Wizard 

Transfer the HMI project to the HMI device.  

View Designer 
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HMI device The Human Machine Interface (HMI) device, such as a PanelView 

5000 device, that runs the HMI project. At runtime, the HMI device 
communicates directly with the controllers. 

 
VPDR file Save a Runtime Application VPDR file from View Designer.  

 
Load from media Load a Runtime Application VPDR file from removable media such as 

an SD Card or USB storage device to the HMI device. 

 
Controller A controller with the ACD file and tags used in the View Designer 

project.  

See also 
Gather process and system requirement information on page 47 

What types of HMI screens do I need? on page 47 

Define conventions for screens on page 49 

Project navigation on page 551 

View Designer is not a replacement for FactoryTalk View Machine 
Edition (ME); however, it provides many of the same features.  

When familiar with working in FactoryTalk ME, review the differences in 
functionality and terminology. 

See also 
FactoryTalk View Machine Edition (ME) vs View Designer on page 
30 

FactoryTalk View Machine Edition (ME) vs View Designer: 
Terminology on page 31 

Although View Designer is not a replacement for FactoryTalk View ME 
(ME), it provides many of the same features. However, there are 
significant differences in the performing some tasks: 

• Set up communications 
• Create a navigation menu 
• Setup security 
• Display alarms and alarm messages 
• Change the appearance and behavior of graphic elements 
• Display runtime diagnostics 
• Pass parameter to a screen 
• Format color values 

See also 
View ME ViewE: Create a navigation menu on page 31 

View ME ViewE: Display alarms and alarm messages on page 32 

View ME ViewE: Change the appearance and behavior of graphic 
elements on page 31 

View ME ViewE: Pass parameters to a screen on page 33 

FactoryTalk View Machine 
Edition (ME) vs View 
Designer 

FactoryTalk View Machine 
Edition (ME) vs View 
Designer 
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ViewME ViewE: Format color values on page 33 

The following table provides the View Designer equivalent of some 
FactoryTalk View Machine Edition (ME) terms.   

FactoryTalk View ME term View Designer equivalent term 

graphic object graphic element 

Object Explorer Graphic Explorer 
On Top display popup 
operator interface application HMI project 
parameter files screen properties 
Symbol Factory Extensive built-in graphics library 
tag placeholders user-defined alias properties or data type properties 
Studio Designer 
project file (.med) project file (.vpd) 
shortcut or device shortcut controller reference 

See also 
• FactoryTalk View Machine Edition (ME) vs View Designer on page 

30 
FactoryTalk View ME (ME) provides various dialog boxes to change the 
appearance and behavior of objects. It also provides several editors for 
configuring animations such as changing the color of an object. 

View Designer provides a Properties window on the main interface to 
configure the appearance and behavior of the selected screen or graphic 
element. This includes configuring events and animation, and selecting 
tags to bind to properties. Bind most graphic element properties, such as 
opacity, directly.  

See also 
Properties window on page 493 

In FactoryTalk View Machine Edition (ME), the display list selector object 
shows a list of displays from which to choose. Scroll through the list and 
select the display to open. Opening the display requires security access.  

In View Designer, drag and drop screen shortcuts into the Navigation 
Menu folder on the Project Properties window. Organize the contents of 
a project into folders and subfolders. View Designer creates a 
Navigation menu based on the structure of the contents of the 
Navigation Menu folder. Screens that have security access for the 
logged in user appear in the Navigation Menu. 

See also 
How do I create navigation for the HMI screens? on page 43  

FactoryTalk View Machine 
Edition (ME) vs View 
Designer: Terminology 

View ME ViewE: Change the 
appearance and behavior of 
graphic elements 

View ME ViewE: Create a 
navigation menu 



Chapter 1  View Designer 
 

32 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

In FactoryTalk View ME (ME), use the Alarm Setup editor to set up 
alarm triggers (the tags or expressions to monitor), define alarm 
messages, and so forth. Use the default [ALARM] display or create a 
graphic display. 

In Studio 5000 Logix Designer, program Logix Designer alarm detection 
instructions in a Logix controller and reference that controller in a View 
Designer project. View Designer provides pre-configured Alarm 
Summary or Alarm Manager tables to display the alarm data and 
messages. The alarm tables receive the alarm data automatically; 
configuration and tag binding is not required.  

Every View Designer project contains an Alarm Summary screen and a 
Alarm Manager screen by default. Create alarm screens by dragging the 
Alarm Manager or Alarm Summary graphic elements onto the screen.  

See also 
Create an alarm screen on page 565 

FactoryTalk View ME (ME) uses FactoryTalk Diagnostics to record 
various types of system activity such as: 

• System messages and errors. 
• Errors from the communication network. 
• Tag read and write activity. 

Configuring the severity of a system activity to log adds a message to the 
list when the activity occurs. The list appears in the default 
[DIAGNOSTICS] display or user-created display. 

View Designer provides several options for monitoring system health, 
network communications, and tag read and write activity in a project. The 
Predefined Screens folder in the Project Explorer contains: 

• Alarm Summary, Alarm Manager and Alarm History screens to 
monitor alarms set up in the controller. 

• Troubleshooting screen to collect data and export a log to 
external media. 

• NetworkDiagnostic screen and ControllersDiagnostic screen 
to troubleshoot network and controller problems. 

The Toolbox contains alarm graphic elements used to create screens. 

On the HMI device, errors are indicated for a graphic element when the 
graphic element or group of graphic elements is outlined in red and has 

an Error icon . Select the Error icon  to view the Error list, which 
contains a snapshot of the diagnostic messages associated with a 
graphic element or group of graphic elements in error.  

See also 
View error messages for a graphic element on page 769 

View ME ViewE: Display 
alarms and alarm 
messages 

View ME ViewE: Display 
runtime diagnostics 
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In FactoryTalk View ME (ME), create tag placeholders in graphic 
displays and then create a parameter file or a parameter list. This 
specifies which tags or folders to substitute for which placeholders when 
a display opens at runtime.    

In View Designer, pass tag values from controllers to a screen or popup 
by defining properties and exposing them for re-use. These user-defined 
properties can be aliases of existing screen properties or properties that 
have a data type. Data type properties replace a specific Logix Designer 
tag instance when configuring bindings and expressions on the screen. 
To pass the correct tag context to use at runtime, create a navigation 
event or a shortcut to the screen.  

In addition to passing tag values from controllers to a screen, pass the 
values of non-alias screen properties from one screen to non-alias 
screen properties of another screen with each target screen acting on the 
data associated with its source screen. This chains reusable screens 
together by passing tag values to the first screen, when then passes the 
values to subsequent screens.   

See also 
Example of content reuse on page 359 

FactoryTalk View ME (ME) requires specifying and configuring an 
FactoryTalk® Linx or OPC server, configuring the path between the data 
server and each controller, and adding device tags to the tag database 
for the application. 

In View Designer, set up an Ethernet driver in RSLinx Classic. Use the 
Application tab on the Project Properties dialog box to select the HMI 
device for the project. Use the References tab to add and configure the 
controller references. Both tabs contain integrated browsers for selecting 
the HMI device, controller, and Logix project file and setting up the 
appropriate communication paths. Manually enter an IP address and slot 
number for the controller instead of browsing for the path. 

See also 
 Project Properties dialog box on page 68 

When binding a color property to a tag or expression, the string tag or 
expression in View Designer resolves to the format #RRGGBB. R, G, B 
are the Hex digits that represent the value for the red, green, and blue 
color channels. For example, in View Designer, the string "#ffff00" 
produces yellow.  

FactoryTalk View Machine Edition (ME) and FactoryTalk View Site 
Edition (SE) use the format #BBGGRR. Change this format to #RRGGBB 
for color property strings and expressions in View Designer.   

View ME ViewE: Pass 
parameters to a screen 

View ME ViewE: Set up 
communications 

ViewME ViewE: Format 
color values 
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See also 
FactoryTalk View Machine Edition (ME) vs View Designer on page 
30 

This section provides step-by-step direction to perform some basic tasks 
in View Designer:   

• Animate a graphic element 
• Configure a button with an event 
• Display values on graphic elements  
• Reuse screens 
• Trigger an action on a screen or graphic element 
• Set up security  
• Create navigation on the HMI device 
• Display alarm data from controllers 

See also 
How do I animate a graphic element? on page 34 

How do I create a reusable screen? on page 38 

How do I secure a screen, shortcut, or folder? on page 42 

How do I create navigation for the HMI screens? on page 43 

Use animation to enhance the graphical representation of the state of a 
machine or process on the HMI device. View Designer provides 
animation through these methods:  

• Property binding 
• Color tables 
• State tables 

Configure graphic elements in View Designer to monitor the temperature 
of the liquid in the tank using a Color Table or a State Table. The color of 
the liquid in a tank changes when the temperature is too cool, too hot, or 
at the appropriate temperature. In this topic, animate the graphic element 
using a Color Table.  

Prerequisites 
• Create the following tags in Logix Designer. For information on 

creating tags in Logix Designer, refer to the Logix Designer Help. 
• TankFill: To monitor the tank level. 
• TankTemperature: To monitor the temperature of the tank. 

• Create a project.  
• Add a controller reference.  
• Create a screen.  

To animate a graphic element 
1. Add a Tank Assembled graphic element to the screen. 

Learn 

How do I animate a graphic 
element? 
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2. Configure the graphic element for animation using a Color Table.  
a. Select the Tank Assembled graphic element on the screen. 

b. In the Properties window, click the Animations tab.  

c. Click Add Animation > Color Table.   

d. In the Name box of the Color Table Definition dialog box, 
enter a name for the Color Table. 

e. In the Number of states box, enter or select 3, to indicate too 
cold, too hot, and normal temperature states. 

f. Select the LevelColor property and click OK. The Color Table 
card appears in the Animations tab of the Properties window. 

g. In the Expression box on the card, click Select tag  to 
select a tag, or type a tag name, to base an expression on. 
Select the TankTemperature tag. 

3. Enter the expression value and color for each state.  
• To indicate cold temperatures, type 0-25 in the Expression 

Value box and enter Hex value #0000FF for a blue color or click 
the down arrow to select a color from the Color Picker.  

• To indicate normal temperatures, type 25-75 in the Expression 
Value box and enter Hex value #00FF00 for a green color or 
click the down arrow to select a color from the Color Picker. 

• To indicate hot temperatures, type 75-100 in the Expression 
Value box and enter Hex value #FF0000 for a red color or click 
the down arrow to select a color from the Color Picker. 

4. Download the runtime application to the HMI device. The result of 
the expression is compared with the values entered in the Color 
Table. The Color Table is evaluated from top to bottom. The first 
expression value that is met applies the color to the graphic 
element. 

See also 
Create a project on page 53 

Add a controller reference on page 85 

Create a screen on page 348 

Animate a graphic element or screen on page 435 

Use an HMI Button Control (HMIBC) instruction in Logix Designer to 
communicate between an HMI device and a Logix controller over a 
high-speed I/O connection. On the HMI device, initiate machine control 
operations, such as jogging a motor or opening and closing a valve, with 
a higher degree of accuracy and determinism than a standard button on a 
typical HMI. Any graphic element can be configured to function as a 
high-speed HMIBC button. Each Logix controller can support up to 256 
HMIBC tags. 

In this topic, create a button that jogs a motor so that when the button is 
pressed, the motor starts and runs until the button is released. Create a 
visual notification of the status of whether the motor is running or 

How do I configure a button 
for high-speed control? 
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stopped. Use a Compact servo motor and a Text Display graphic element 
to receive notification when the motor stops. 

Prerequisites 
• In a Logix Designer project, create an HMIBC instruction. Ensure 

that the HMIBC instruction in Logix Designer is configured to scan 
quickly enough to perform the motor jog control needed. For more 
information on creating an HMIBC instruction, refer to the Logix 
Designer help. 

• In Logix Designer, add a PanelView 5000 HMI device to the I/O 
configuration tree in the Controller Organizer. For more 
information on adding a device to the I/O configuration tree, refer 
to the Logix Designer help. 

• Create a View Designer project. 
• Add a controller reference.  
• Create a screen. 

To configure a button for high-speed control 
1. Add Button, Compact servo motor, and Text Display graphic 

elements to the screen. 

 
Tip: All graphic elements in View Designer are located in the Toolbox grouped by categories. 
The Button and Text Display graphic elements are located in the CommonControls category. 
The Compact motor graphic element is located in the General Equipment > Motors > Servo 
category. 

2. Configure the Button graphic element to behave as a high-speed 
HMIBC button. 

a. On the screen, right-click the Button graphic element and click 
Button Behavior > Logix HMIBC set to 1 on press, 0 on 
release. A Button Behavior Event card opens on the Events 
tab on the Properties pane. 

b. In the Key box, select Touch Only. 

c. In the HMIBC Tag box, type the name of the HMIBC tag or click 
Select tag  and select the tag. 

3. Configure the Compact servo motor to receive visual feedback: 
a. Select the Compact servo motor graphic element. 

b. On the Properties window, click the Animations tab.  

c. Click Add Animation > State Table. 

d. In the Name box of the State Table Definition dialog box, enter 
a name for the State Table. 

e. In the Number of states box, enter or select 2, to indicate the 
state of the machine - stopped or running.  

f. Select the Fill Color property, and click OK. The State Table 
appears in the Animations Tab of the Properties window. 

g. In the Expression box on the card, click Select tag  to select 
a tag, or type a tag name, to base an expression on. Select the 



Chapter 1  View Designer 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 37 
 

HMIBC tag configured with the .ProgFB member. The .ProgFB 
member provides feedback to the HMI device when the device 
controlled by the HMIBC instruction changes state. 

h. For each state, enter the expression value and color. 

• To indicate the stopped state of the motor: Enter a value of 0 
in the Expression Value box and click the swatch in the 
FillColor box to select a red color from the Color Picker. 

• To indicate the running state of the motor: Enter a value of 1 
in the Expression Value box and click the swatch in the 
FillColor box to select a red color from the Color Picker. 

At runtime, the value of the HMIBC tag is compared with the 
value entered in the State Table and the appropriate color 
changes are applied.  

4. Configure the Text Display graphic elements to receive visual 
feedback: 

a. Select the Text Display graphic element. 

b. On the Properties window, click the Animations tab.  

c. Click Add Animation > State Table. 

d. In the Name box of the State Table Definition dialog box, enter 
a name for the State Table. 

e. In the Number of states box, enter or select 2, to indicate the 
state of the machine - stopped or running. 

f. Select the Text property, and click OK. The State Table 
appears in the Animations Tab of the Properties window. 

g. In the Expression box on the card, click Select tag  to 
select a tag, or type a tag name, to base an expression on. 
Select the tag configured with the .ProgFB member. 

h. For each state, enter the expression value and the text to 
display on the graphic element. 

• To indicate stopped, enter 0 in the Expression Value box, 
and Stopped in the Text Display box.  

• To indicate running, enter 1 in the Expression Value box, 
and Running in the Text Display box. 

5. Download the runtime application to the HMI device, the value of 
the HMIBC tag is compared with the value entered in the State 
Table and the appropriate text appears. 

See also 
Create a project on page 53 

Add a controller reference on page 85 

Create a screen on page 348 

Create an HMIBC Button on page 489 
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Extended properties are properties added to tags and data types in Logix 
Designer to help reduce the number of tags that need to be created. If an 
individual tag is configured in Logix Designer with extended properties, 
use the extended properties on the tag.   

For example, use tags to display values of extended properties, such as 
name and description of a tank, the minimum and maximum values, and 
engineering units of the level of the liquid in the tank. Then Bind graphic 
elements in View Designer to the tag configured with the Name, 
Description, Min, Max, and Engineering Unit extended properties.  

Prerequisites 
• In Logix Designer, create a tag with Name, Description, 

Engineering unit, Min, and Max extended properties. For 
information on how to create a tag with extended properties, refer 
to the Logix Designer help. 

• Create a project. 
• Add a controller reference. 

To create a graphic or screen that displays values of Logix extended 
properties  

1. Create a screen. 
2. Add five Text Display graphic elements to the screen. 
3. Bind each Text Display graphic element to the tag configured with 

extended properties. For each of the Text Display graphic 
elements: 

a. Select the Text Display graphic element. 

b. In the Properties tab, point to the Text property to show and 
click Binding  , and then click Bind property to item. 

c. Click Select tag  to open the Tag Browser and navigate to 
the tag configured with extended properties.  

d. Double-click one of the extended properties in the list. 

4. Download the runtime application to the HMI device. The Text 
Display graphic elements show the values of the extended 
properties.  

See also 
Create a project on page 53 

Add a controller reference on page 85 

Create a screen on page 348 

Assume there is a plant that has two mixer tanks, and the application 
requires: 

• One screen to provide an overview of the plant showing both 

How do I create a graphic or 
screen that displays values 
of Logix extended 
properties? 

How do I create a reusable 
screen? 
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tanks.  
• Individual screens that show details specific to each tank.  

Use View Designer to create: 

• One overview screen that displays all of the tanks.  
• One mixer detail screen reused to display information for each 

tank on request.  
The detail screen essentially acts as a template, and the detail 
information for each tank is passed into the screen at runtime. In this 
topic, the tank graphic elements on the overview screen act as buttons to 
navigate to the detail screen.  

Prerequisites 
• Use Logix Designer user-defined data types to create a data 

structure to match the machine or process. Assign a name, 
description, and data type for each member of the user-defined 
data type. For more information refer to the Logix Designer help. 

• Create a View Designer project.  
• Add a controller reference.  

To create a reusable screen 
1. Create an overview screen with content to show on the HMI 

device.  
a. Create a screen named Overview. 

b. Add a graphic element to the overview screen. For example, 
add the Mixing Hopper Side graphic element to the Overview 
screen. The Mixing Hopper Side graphic element is located in 
the GeneralEquipment > TanksAndContainers > Agitators 
category. 

c. Bind a property of the graphic element to a tag.   

2. Create a detail screen with content to show on the HMI device.  
a. Create a screen named Mixing Hopper Detail. 

b. Add graphic elements to the detail screen. For example, add the 
Mixing Hopper Side, Text Display, and Numeric Display graphic 
elements to the screen. The Numeric Display graphic element 
can show the name of the mixing hopper, and the Numeric 
Display graphic elements can show the values of the mixing 
hopper.   

3. Create user-defined properties with a data type. 
a. At the bottom of the screen, in the Name box of the Property 

Definition tab, type a name for the property. 

b. Click Expand  below the screen to display the Property 
Definition tab if it is not open. 

c. Click the Data Type box and click Select data type  to 
select a data type: 
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• User-Defined. A structure data type defined in Logix 
Designer. 

• Predefined. An atomic or structure data type that is defined 
by the controller.  

• Module-Defined. A structure data type defined by a module 
when you create it. Tags of these types are created to store 
input, output, and configuration data for the module. 

The selected data type is used as a filter criteria for the Tag 
Browser. Only items in the Logix Designer project (.acd) file 
that meet the filter criteria appear in the Tag Browser. 

4. Bind graphic element properties to an instance of a user-defined 
property. 

a. Expand the categories in the Properties tab to locate the property 
to bind to a tag.  

b. Point to the property box to show and click the Binding  and 
then click Bind property to item. 

c. Click Select tag  to open the Tag Browser and select a data 
item from the Tag Browser, or enter an expression.  

• To create or edit lengthy or complex expressions, click Open 
Expression Editor  . 

• To bind to a property of a graphic element, browse to enter  
ElementName.PropertyName.  

• To bind to an instance of a user-defined property, select the 
graphic element in the Tag Browser and then the Level 
member.  

5. Create a Button Behavior event for screen navigation. This passes 
the screen properties to the target screen when the event occurs.   

a. On the Overview screen, select the graphic element to trigger the 
event.  

b. In the Properties window, click the Events tab.  

c. Click Add Event and click Button Behavior. 
d. Click Choose Behavior and click Navigate to screen on 

release. 

e. In the Screen box, click User-Defined Screens and then click 
the Mixing Hopper Detail screen. 

f. In the Property Configuration box, click Select tag and select 
the data type tag. The Tag Browser displays only tags of the 
type specified in the Property Definition tab. 

6. Configure the overview screen to reuse the detail screen. 
a. Copy and paste another instance of the mixing hopper on the 

Overview screen.  

b. Click the copied mixing hopper and change the binding from, for 
example, Mixer 1 to Mixer 2. 

c. On the Events tab, change the Property Configuration to, for 
example, Mixer 2.  
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7. Download the runtime application to the HMI device. Tapping each 
mixing hopper displays the details of the mixing hopper. The event 
passes the details of the mixing hopper to the screen.  

See also 
Create a project on page 53 

Add a controller reference on page 85 

User-defined property on page 370 

Make any graphic element or screen interactive by adding events. An 
event is something that occurs to trigger an action. For each event, 
configure one or more actions or commands that the event triggers. 
When something occurs to trigger the event, this performs the configured 
command of the event. Depending on the type of event, configure 
commands from different categories to perform tasks. 

In this topic, monitor two bottling lines. There are two screens with a 
button on Screen_A that opens Screen_B. Configure a Button graphic 
element on Screen_A that opens Screen_B. 

Prerequisites 
• Create a project. 
• Add a controller reference.  
• Create screens named Screen_A and Screen_B.  

To make a graphic element interactive 
1. Open Screen_A. 
2. In the Toolbox, expand the appropriate category. 

 
Tip: All graphic elements in View Designer are located in the Toolbox grouped by categories. 
Button and Text Display graphic elements are located in the CommonControls category. The 
Compact motor graphic element is located in the General Equipment > Motors > Servo 
category.  

3. Drag the graphic element onto the screen.  
4. Double-click the graphic element in the Toolbox to add it to the 

center of the screen.  
5. Select the graphic element. The Properties window shows the 

properties of the selected graphic element. 
6. In the Properties window, click the Events tab.  
7. Click Add Event and select Touch Release event from the list. 
8. Click Add Command. 
9. Expand the Navigation category and select the Screen Navigate 

command. 
10. In the Navigate To box, click the arrow, expand the 

User-Defined Screens category and select Screen_B. 
11. Download the runtime application to the HMI device. When 

releasing the button, Screen_B opens. 

 
Tip: To configure a graphic element to behave as a button to navigate to a screen or change 
a tag value, create a Button Behavior event 

How do I make a graphic 
element interactive? 



Chapter 1  View Designer 
 

42 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

See also 
What is an event? on page 476 

Configure an event to trigger an action on page 447 

Trigger an action on a Button Behavior event on page 444 

Add a controller reference on page 85 

Create a screen on page 348 

By default, all users on HMI devices have access to these items in the 
Project Explorer:  

• Shortcuts in the Navigation Menu folder. 
• Screens and popups in the User-Defined Screens or Predefined 

Screens folders.  
In this topic, a Screens folder in the Navigation menu contains 
shortcuts to Screen_ A and Screen_B. Set security for Screen_A and 
Screen_B and the folder in the Navigation menu that contains the 
screens. Set different security for a screen than the folder from which the 
screen inherits security. Do this if the data on most screens in a folder is 
not useful to users assigned to the Maintenance security role.  

To secure a screen or shortcut, give users assigned the Maintenance 
security role Read-only access to Screen_A and Screen_B. To secure 
a folder, give users assigned the Restricted security role No access to 
the Screens folder.  

Prerequisites 
• Create a project. 
• Add a controller reference. 
• Create screens named Screen_A and Screen_B. 

To secure a screen, shortcut, or folder  
1. In the Project Explorer, expand the User-Defined Screens 

folder. 
2. Select Screen_A. 
3. In the Properties tab, expand the Security category. 
4. After the Maintenance box, click the arrow and select Read Only.   
5. For Screen_B, set the security for users who are assigned the 

Maintenance security role Read Only access.  
6. Download the runtime application to the HMI device. Users with 

the Maintenance security role can navigate to both Screen_A and 
Screen_B, but cannot interact with the screens. 

How do I secure a screen, 
shortcut, or folder? 
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Tips: 
• By default, security for shortcuts is based on the security assigned to the defining screen of the 

shortcut. Configuring the security of a shortcut to not use the security of the screen is allowed. 
• To secure a folder, in the Project Explorer, select the Screens folder and then in the Properties tab, 

expand the Security category to select Restricted after the  Restricted box. 
• At runtime on the HMI device, users with the Restricted security role do not see the Screens folder 

in the Navigation menu. As a result, they are unable to access screens in that folder. 
• If it is visible at the top of the screen, users have full access to the System Banner and its items, 

regardless of the security assigned to the screen.  

See also 
Set security on page 685 

Create a project on page 53 

Add a controller reference on page 85 

Create a screen on page 348 

To create navigation for the HMI project, organize content, such as 
screens and folders, in the Navigation Menu folder in the Project 
Explorer in View Designer. The content and order of the Navigation 
Menu folder appears in the Navigation menu on the HMI device.  

In this topic, access Screen_A and Screen_B from the Navigation 
Menu. Create the shortcuts and arrange the content to create the 
Navigation menu that opens on the HMI device.  

To create navigation for the HMI screens 
1. Create a folder in the Navigation Menu folder to contain shortcuts 

and other folders: 
a. In the Project Explorer, right-click the Navigation Menu folder.    

b. Click New Folder. A new folder appears at the bottom of the 
folder with the default name Folder_001 or increment number. 
Folders at the same level must have unique names. 

c. Right-click the folder, click Rename, type a new name for the 
folder, and then press Enter.  

2. Create shortcuts to appear in the Navigation menu: 
• Drag a screen from the User-Defined Screens folder or the 

Predefined Screens folder to the Navigation Menu folder.  
• In the User-Defined Screens folder or the Predefined 

Screens folder, right-click the desired screen to base the 
shortcut, and click New Shortcut. The new shortcut appears in 
the Navigation Menu folder. The new shortcut is given a 
default name that is identical to the screen name. Move the new 
shortcut within the Navigation Menu folder and its subfolders.  

3. Drag a graphic element onto the screen and double-click a graphic 
element in the Toolbox to add it to the center of the screen.  

 
Tip: Configure any graphic element with navigation. For example, add a back arrow. 

How do I create navigation 
for the HMI screens? 
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4. Configure the graphic element to open a screen when pressing the 
graphic element on the HMI device. 

a. Select the graphic element.  

b. In the Properties window, click the Events tab.  

c. Click Add Event and select Touch Release event from the list. 

d. Click Add Command, expand the Navigation commands 
category, and then select the Screen Navigate command. 

e. In the Navigate To box, navigate to the User-Defined Screens 
folder and select Screen_A. 

5. Download the runtime application to the HMI device. Pressing the 
graphic element navigates to Screen_A. 

See also  
Navigation menu contents on page 553 

Select an icon for a shortcut in the Navigation menu on page 554 

Project navigation on page 551 

Use alarm screens to monitor and manage control system alarms. Use 
Logix Designer to program alarm detection instructions in Logix 
controllers. The View Designer Alarm Manager shows alarms in all 
states and include all conditions for an alarm. The View Designer Alarm 
Summary shows alarms that are in interesting states or require attention, 
such as alarms that are In Alarm and Unacknowledged. 

In this topic, monitor alarms in View Designer that become active when 
the temperature of the liquid in a tank goes out of normal range. 

Prerequisites 
• Create alarm instructions in Logix Designer. Create instructions 

for an analog Level alarm that enters the In Alarm state when the 
tank temperature is outside the normal range. For information on 
creating alarm instructions, refer to the Logix Designer software 
instruction set topic in Logix Designer Help.  

• Create a project.  
• Add controller references.  

To display alarm data from controllers 
• View alarms by performing one of the following:  

• Create an alarm screen. In the Alarms category of the 
Toolbox, drag and drop the appropriately sized alarm table 
graphic element onto the screen.    

• Open a predefined alarm screen.  
a. On the Menu bar, click View > Project Explorer. 

How do I display alarm data 
from controllers? 
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b. In the Project Explorer folder, expand the Predefined 
Screens. 

c. Double-click the AlarmSummary or AlarmManager screen. 

 
Tips:  
• View Designer provides Alarm Manager Large, Alarm Manager Medium, Alarm Summary Large, and 

Alarm Summary Medium graphic elements. 
• The Alarm Summary and Alarm Manager graphic elements are pre-configured to automatically 

display alarm data from the Logix Designer project files (.vpd) referenced on the References 
window. No tag binding is required.  

• Adjust the appearance and order of alarm tables on either a predefined alarm screen or on a 
screen that includes an alarm table graphic element to meet the needs of the application. For 
example, change the font, opacity, and sort order of the content on the screens. Create filters on 
the screens to show items that match specified criteria. For example, create a filter to show only 
alarms in the In Alarm state. 

See also 
What is the Alarm Summary? on page 99 

What is the Alarm Manager? on page 99 

Display alarms on page 563 

Add a controller reference on page 85 

Create a screen on page 348 

Create a View Designer project that supports multiple languages to 
select the appropriate language to display on the HMI device.  

For example, create a project in English for operators who only speak 
French. Use View Designer to create a single project and then export all 
of the user-editable strings to a language file. Translate the strings in 
French and then import the language file to add the language to the 
project. On the HMI device, select French as the language for the text 
strings. 

To display a different language on the HMI device 
1. On the Standard Menu bar, click Tools > Export Languages. 
2. In the Select current language list, select the language in which 

the project was created.  
3. In the Selected language for localization box, select one or 

more languages for translating the strings. 

 
Tips:  
• View Designer does not support the Spanish (Spain, Traditional Sort) language that is supported in 

Studio 5000 Logix Designer®.  
• When opening the exported language file in Microsoft Excel, the selected languages appear as 

column headers. Languages currently in the project are always included in the export operation, 
and are not available for selection. 

4. In the Export language file to box, click Browse to select the 
location to save the language file, and click Save. 

How do I display a different 
language on the HMI 
device? 
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Tips: 
•  The default path and file name is C:\Users\username\Documents\Studio 5000\Projects\Project 

name_Language.xlsx.  
• View Designer supports .xlsx and .txt file formats only.  
• If a file name does not have a file extension, or has an file extension that is not supported, View 

Designer appends the file to the default .xlsx format. 
View Designer only exports localizable and unlinked properties. 

5. Click Export.  
6. Open the exported file using Excel.  
7. To add a language that is not in the spreadsheet, in the column 

next to the last language column, enter the language code for the 
desired language, such as en-US. 

 
Tip: Reference the Internet Engineering Task Force (IETF®) RFC 5646 for guidelines on 
formatting language codes. 

8. On the Standard Menu bar, click Tools > Import Languages. 
9. On the Import Languages dialog box, next to the Language file 

box click Browse and select the translated language file.  
The Import language changes box lists the language changes to 
be made to the project: 
• Languages Added 
• Languages Updated 
• Languages Removed 
• Invalid Languages  

 
Tips:  
• View Designer supports .xlsx and .txt file formats only. 
• If importing a file with a name that does not have a file extension, or has an file extension that is 

not supported, View Designer appends the file to the default .xlsx format. 
• When exporting the language file, all language data in the project exports. 
• View Designer only imports localizable and unlinked properties. 

10. Click Import. 
11. Save the project. 
12. Select the language to display and download to the runtime 

application: 
a. From the Menu bar, click COMMUNICATIONS > Download. 

b. In the Location box, click Browse  and select the IP 
address of the HMI device to which to download the runtime 
application. 

c. Click Next to open Controller References. 

 
Tip: If a translatable string is left blank, View Designer defaults to the download language for 
runtime applications downloaded to the HMI device. If the translated string for the download 
language is also blank, View Designer defaults to the language used when designing the 
project.  

See also 
Export Languages dialog box on page 669 

Import Languages dialog box on page 671 

Download Runtime Application wizard on page 709 

About changing the project language on page 675 
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View Designer projects are used to create runtime applications for 
monitoring and managing a system. Before creating a project, take some 
time to become familiar with the View Designer interface and adjust it to 
suit your needs.  

During the planning phase of your project, gather information from a 
variety of sources so that you have a complete understanding of the 
automation process and can create screens to support it and establish an 
effective hierarchy of screens. 

Creating runtime application in FactoryTalk View Machine Edition (ME) is 
different than creating runtime application in View Designer.  

See also 
What types of HMI screens do I need? on page 47 

FactoryTalk View Machine Edition (ME) vs View Designer on page 
30 

Before creating an HMI project, gather information from a variety of 
sources to gain a complete understanding of the process to automate:  

• Review the project scope (usually created by a process engineer 
or a chemical engineer). 

• Talk to operators and other experts who will use the system to find 
out what information they need to optimize plant operations. 

• Talk to information systems staff to find out what information they 
need to support design decisions.  

• Talk to management staff to find out what information they need to 
support planning decisions. 

After understanding the overall process, analyze key process areas and 
consider important factors such as alarms and security. Pay attention to 
details that might affect the overall performance of the system. 
Specifically: 

• Determine the process variables to be accessed and identify their 
locations in the programmable controllers or devices. 

• Determine which parts of the process to secure and identify the 
most efficient ways to restrict user access. 

See also 
What types of HMI screens do I need? on page 47 

Screen hierarchy on page 48 

An HMI project contains multiple types of HMI screens and each serves a 
different purpose. Use HMI screens to access and navigate the  runtime 
application as well as provide high level and detailed views of plant 
activity.  

Common types of HMI screens used in a runtime application include:.  

HMI screen Description 

Plan 

Gather process and system 
requirement information 

What types of HMI screens 
do I need? 
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HMI screen Description 

Log in  A Home screen that provides a way to log in. Assign different levels of 
access to the HMI screens within the application based on the credentials 
of the logged in user.  

Menu  An optional navigation screen that provides a high-level view of the 
screens and functional areas within the operator interface application. 
Navigate to progressively more detailed screens from a menu screen.  
For most applications, a menu screen is not required because View 
Designer creates a Navigation menu based on the organization of the 
contents of the Navigation Menu folder. The Navigation menu that 
appears at runtime is sufficient for all but very large applications.  

Alarm Summary A high-level HMI screen that contains all the alarms for the controllers in 
the project. By default, each HMI project contains an Alarm Summary 
screen for monitoring and responding to alarms. Alarms are configured in 
Logix Designer. Alarms in Logix controllers appear on the Alarm Summary 
screen automatically at runtime. No configuration is required. Add an 
Alarm Summary to another screen to increase alarm visibility.  

Process overview A high-level HMI screen that provides an overview of the process being 
controlled or monitored. The primary purpose of a process overview 
screen is to provide situational awareness, but it is not generally used to 
execute any controls. From these screens, navigate to additional screens 
that represent specific process areas. 

System status A high-level HMI screen that provide one place to review the health and 
status of the processes and devices being controlled and monitored from 
the operator interface application. 

Process area A mid-level HMI screen that provides information about a specific process 
area that is usually within the control of the user. Process area screens 
monitor the process and are often the main control interface for 
performing routine operational tasks. From these screens, navigate to 
detail displays related to the process being represented.  

Equipment overview  A mid-level HMI screen that provides information about a specific 
collection of equipment. An equipment overview screen is often used to 
view all equipment of a certain type. For example, create an equipment 
overview screen that shows all of the tanks. From this screen, select a 
specific tank and navigate to a tank detail screen within the collection. 

Equipment detail  A detailed HMI screen that contains all available information for a specific 
piece of equipment. For example, create a detail equipment screen for a 
specific tank or a specific pump. 

See also 
Create a screen on page 348 

Screen hierarchy on page 48 

A well-designed runtime application has an effective hierarchy of 
screens that guides users through the system. The hierarchy provides 
progressively more detail when moving through different levels of 
information and data.  

Before designing a screen hierarchy and creating navigation for screens, 
consider:  

• The needs of all users, including managers, supervisors, and 
operators 

• Which users have access to which parts of the application 
• How users navigate through the application 
• The process areas being monitored 
• Required equipment overview screens 

Screen hierarchy 
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• Required specific equipment screens 
• Any other types of required screens 

The most common and effective method for presenting a screen 
hierarchy for the runtime application is to use the Navigation menu 
created automatically by View Designer. When building an application, 
View Designer automatically creates a Navigation Menu that is included 
with the application. The location and hierarchy of screens in the 
Navigation menu at runtime is determined by the organization of the 
contents of the Navigation Menu folder in the Project Explorer.  

See also 
Gather process and system requirement information on page 47 

What types of HMI screens do I need? on page 47 

Define conventions for screens on page 49 

Project navigation on page 551 

To increase application usability and operator efficiency, follow 
established conventions and good visual design principles when creating 
screens.   

Prerequisites 
Decide the specific settings to use for items before creating screens:  

• Colors, background colors, and fonts 
• Equipment symbols 
• Position and status of valves 
• Position and status of pumps and motors 
• Information to be included on each screen such as a company 

logo.  

Consistency considerations 
Follow guidelines to make the screens within the application consistent:  

• Present the same information and basic functions in the same 
places on each display to make it easier for users to find elements 
as they navigate from screen to screen. 

• Use the standard and easily recognizable symbols from the View 
Designer library of predefined graphics. For example, View 
Designer contains standard ISA symbols for tanks and valves. 

• Place the same kind of buttons in the same positions on each 
screen, and label them consistently. For example, if there is a Start 
button in a certain position in one screen, do not put a Stop button 
in the same position on another screen. 

• Use standard, clear terminology. Avoid abbreviations or 
acronyms. 

• Use colors with recognizable meanings. For example, in Europe 
and North America, the colors red and green often mean stop and 

Define conventions for 
screens 
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start. Keep color meanings consistent by assigning red only to 
Stop buttons, and green only to Start buttons. 

Usability considerations 
Follow guidelines to increase application usability:  

• On each screen, include only necessary information. Create 
pop-ups to provide more detailed information.  

• For touch screens, place important buttons where they will not be 
blocked by a pop-up. Also ensure that buttons are large enough 
and spaced far enough apart for users to touch them easily, even 
when they are wearing work gloves. 

• Ensure there is always a clear way to move between displays. 
• For text, use high-contrast color combinations such as yellow on 

blue or dark text on light-colored backgrounds. 

Reuse considerations 
After establishing conventions for screens, ensure screen uniformity by 
reusing screens. 

See also 
What types of HMI screens do I need? on page 47 

Screen hierarchy on page 48 

All objects created in View Designer must follow specific naming 
conventions listed in this section: 

 

• The name must contain only numbers, letters, and underscores.  
• The name must not begin with a number, contain spaces, have 

more than one underscore in a row, or end with an underscore.  
• The name must not be a reserved keyword:  

Keyword Keyword Keyword Keyword Keyword Keyword Keyword Keyword 

ABS ACOS ACS AND ASIN ASN ATAN ATN 
BEGIN_NT_RUNG BY CASE COS DEG DEG DO ELSE 

ELSIF END_CASE END_FOR END_IF END_NT_RUNG END_REPEAT END_WHILE EXIT 
FOR FRD GOTO IF IMAGES LN LOG MOD 
NOT OF OR PROFILES RAD REPEAT RETURN SIN 
SQR SQRT TAN THEN THIS TO TOD TRN 
TRUNC UNTIL WHILE XOR     

 

The naming conventions apply to the following items: 

• project names 
• screen names 
• popup names 

Object Naming Conventions 
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• custom property names for screens and popups 
• folder names 
• shortcut names 
• graphic element names 
• add-on graphic names 
• pdf document names 
• image names 
• data log names 
• project event names 
• controller reference names 
• user names 
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Chapter 2 

Create a project in View Designer 

The first step towards building a runtime application is creating a project. 
A View Designer project includes screens, controller references, and 
information about the target HMI device. 

View Designer creates and uses the file extension .vpd for user-created 
projects. By default, projects are saved to <user>\My Documents\Studio 
5000\Projects. 

Use the View tab on the New Project dialog box to: 

• Create and name a View Designer project. 
• Select the type of HMI device. 

See also 
Create a project for a PanelView HMI device on page 53 

New Project dialog box on page 54 

Open a project on page 56 

Save a project on page 62 

The first step towards building a runtime application is creating a project. 
A View Designer project includes the screens, controller references, and 
information about the target HMI device. View Designer creates and uses 
the file extension .vpd for user-created projects. By default, projects are 
saved to <user>\My Documents\Studio 5000\Projects. 

Prerequisites 
• Close any open project. Creating a project is not allowed if another 

project is open. Projects in other instances of View Designer may 
remain open. It is recommended that no more than three instances 
of View Designer run at one time. 

  

Create a project 

Create a project 
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To create a project 
1. On the Menu bar, select File > New Project. 
2. In the Name box, type a name for the project, and select Finish.  

• The name must contain only numbers, letters, and underscores.  
• The name must not begin with a number, contain spaces, have 

more than one underscore in a row, or end with an underscore. 
The name must not be a reserved keyword:  

Keyword Keyword Keyword Keyword Keyword Keyword Keyword Keyword 

ABS ACOS ACS AND ASIN ASN ATAN ATN 
BEGIN_NT_RUNG BY CASE COS DEG DEG DO ELSE 

ELSIF END_CASE END_FOR END_IF END_NT_RUNG END_REPEAT END_WHILE EXIT 
FOR FRD GOTO IF IMAGES LN LOG MOD 
NOT OF OR PROFILES RAD REPEAT RETURN SIN 
SQR SQRT TAN THEN THIS TO TOD TRN 
TRUNC UNTIL WHILE XOR     

View Designer creates the project and displays its contents in the Project 
Explorer tab. The project contains a default screen named Screen_001, 
which is open. 

The Project Properties dialog box is also open. Use the References tab 
to add the controller references for this project. A controller reference is a 
connection from the View Designer project file (.vpd) to a Logix Designer 
project file (.acd).  

See also 
Add a controller reference on page 85 

Select a target HMI device for a new project on page 67 

Close a project on page 64 

Rename a project on page 60 

Save a copy of a project on page 62 

How do I open the New Project dialog box? 

On the Menu bar, click FILE > New Project.  

Use the View tab on the New Project dialog box to: 

• Create and name a View Designer project. A View Designer 
project includes the screens that you create, controller references, 
and information about the target HMI device. The project is stored 
in a file with a .vpd extension.  

• Select the type of HMI device. The screens in a project represent 
the physical size of the HMI device selected for the project.  

• Optionally, select the View Designer version with which to create 
the project when there are multiple versions of View Designer 
installed. 

  

New Project dialog box 



Chapter 2  Create a project in View Designer 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 55 
 

Creating a project is the first step in building a runtime application.  
Tip: Close any open project before creating another project. Projects in other instances 

of View Designer may remain open. It is recommended that no more than three 
instances of View Designer run at one time.  

See also 
Create a project on page 53 

Open a project on page 56 

Close a project on page 64 

Rename a project on page 60 

Save a project on page 62 

The first step towards building a runtime application is creating a project. 
A View Designer project includes the screens, controller references, and 
information about the target HMI device. View Designer creates and 
uses the file extension .vpd for user-created projects. By default, projects 
are saved to <user>\My Documents\Studio 5000\Projects.  

To create a project from the Studio 5000 launcher  
1. Start Studio 5000 from the icon on the desktop.  
2. Select New Project.  
3. On the New Project dialog box, select the View tab. 
4. In the Name box, type a name for the project, and click Finish.  

• The name must contain only numbers, letters, and underscores.  
• The name must not begin with a number, contain spaces, have 

more than one underscore in a row, or end with an 
underscore.The name must not be a reserved keyword:  

Keyword Keyword Keyword Keyword Keyword Keyword Keyword Keyword 

ABS ACOS ACS AND ASIN ASN ATAN ATN 
BEGIN_NT_RUNG BY CASE COS DEG DEG DO ELSE 

ELSIF END_CASE END_FOR END_IF END_NT_RUNG END_REPEAT END_WHILE EXIT 
FOR FRD GOTO IF IMAGES LN LOG MOD 
NOT OF OR PROFILES RAD REPEAT RETURN SIN 
SQR SQRT TAN THEN THIS TO TOD TRN 
TRUNC UNTIL WHILE XOR     

5. (optional) If multiple versions of View Designer are installed, to 
create a project using a different version, in the Version box, 
select a version. The Version box lists the versions of View 
Designer installed.  

See also 
Add a controller reference on page 85 

Select a target HMI device for a new project on page 67 

Close a project on page 64 

Create a project from the 
Studio 5000 launcher 
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Rename a project on page 60 

Save a copy of a project on page 62 

Open the last saved project or any previously saved project. Open a 
View Designer project using the same or later version of View Designer 
used to save the project. Opening a .vpd file of an earlier version than the 
installed version of View Designer converts the .vpd file to the installed 
version of View Designer. 

IMPORTANT Converting a View Designer project to a later version does not convert any user-defined 
changes to predefined screens or the System Banner. When converting a project to a 
later version, reapply the user-defined changes to the predefined screens and the 
System Banner.  
 
To copy user-defined changes to predefined screens and the System Banner: 
1. Copy the user-defined content (for example, the System Banner) and paste it to a 

temporary screen in the original project. 
2. Convert the project to a later version. 
3. Copy the changes from the temporary screen back to predefined screens or the 

System Banner 
4. Delete the temporary screen. 

Prerequisites 
• Close any open project. Only one project can be open at a time. 

Projects in other instances of View Designer may remain open. It 
is recommended that no more than three instances of View 
Designer run at one time.  

• Verify the version used to save the project without opening View 
Designer. Browse to and hover over the .vpd file. To show the 
project version you can also right-click the .vpd file, select 
Properties, and then select the Details tab. 

To open a project: 
1. On the Menu bar, click File > Open Project. 
2. Select a project and select Open. The title bar shows the name of 

the open project and the HMI device type for the project. 

Open a project 
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Tips:  
• When opening a large project, wait for the project to finish opening before using these functions: 
• Download 
• Emulate 
• Verify 
• Find and Replace 
• Save as .vpdr 

• Double-click a .vpd file to launch View Designer and open the project. 
• Opening a project created using an earlier version of View Designer opens the Opening Project 

dialog box. This indicates that the project was created using an earlier version and creates a 
backup of the project. Selecting Convert saves the backup of the original project in the same 
folder. The name of the backup file is appended with _Vn, where n is the version of View Designer 
used by the project.  

• A project does not convert if the Templates folder or a project template file is missing or corrupt. 
Repair the View Designer install to create or replace an unrevised missing or corrupt project 
template. If the Templates folder is revised, manually delete a corrupt project file. 

• Opening a project saved with a later version of View Designer is not allowed.  
• View Designer provides a list of recent projects. On the Menu bar, click File > Recent Projects. The 

most recently closed project appears at the top of the list. 

See also 
Close a project on page 64 

Open Project dialog box on page 57 

Rename a project on page 60 

Change the type of HMI device for a project to change the device for 
which the project is configured. Do this to view the runtime application on 
the different HMI device.  

To change the HMI device of a project 
1. Select Project > Project Properties. The Target HMI Device 

dialog box opens. 
2. Select the HMI device. To search for the HMI device, start typing 

the name of the HMI device in the Search box. 
3. Click Next.  
4. Select the HMI device screen size for a PanelView HMI device 

project. The screens in the project represent the physical size of 
the screen for the project. 

5. Click OK.  

See also 
Runtime application scaling on different HMI devices on page 77 

How changing the HMI device for a project affects screens on 
page 73 

Save a project on page 62 

How do I open the Open Project dialog box? 

On the Menu bar, click FILE > Open project. The Open project option 

Change the HMI device of a 
project 

Open Project dialog box 
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is also available on the Studio 5000 Launcher. 

The Open Project dialog box provides a list of HMI projects saved to the 
computer. Use the Open Project dialog box to select and open a project. 

Close any open project before opening another project. Projects in other 
instances of View Designer may remain open. It is recommended that no 
more than three instances of View Designer run at one time.  

See also 
Open a project on page 56 

Close a project on page 64 

Rename a project on page 60 

Save a copy of a project on page 62 

Convert a project to upgrade it from an earlier version of View Designer 
to the current installed version of View Designer. Converting a project to 
an earlier version of View Designer is not allowed. 

IMPORTANT Converting a View Designer project to a later version does not convert any user-defined 
changes to predefined screens or the System Banner. When converting a project to a 
later version, reapply the user-defined changes to the predefined screens and the 
System Banner.  
 
To copy user-defined changes to predefined screens and the System Banner: 
1. Copy the user-defined content (for example, the System Banner) and paste it to a 

temporary screen in the original project. 
2. Convert the project to a later version. 
3. Copy the changes from the temporary screen back to predefined screens or the 

System Banner 
4. Delete the temporary screen. 

Prerequisites 
• Verify the version used to save the project without opening View 

Designer. Browse to and hover over the .vpd file. Right-clicking the 
.vpd file, selecting Properties, and then selecting the Details tab 
also shows the project version. 

To convert a project 
1. (optional) To retain customized content on a predefined screen or 

the System Banner, open the project using the current version of 
View Designer, copy any customized predefined screen or the 
System Banner content to a separate screen for temporary 
storage, and then save and close the project. 

 
Tip: Copy content that appears on separate tabs of predefined screens to separate screens. 

2. Create a new project in View Designer using the new version.  
3. Select File > Close Project.  
4. Select File > Open Project 

Convert a project 
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5. Select the project to convert and select Open. A prompt appears 
to convert the project to the current version of View Designer.  

6. Select Convert. When the project converts, View Designer 
creates a backup of the original project in the same location as the 
converted file. View Designer appends the name of the backup file 
with _V#. 

 
Tips:  
• A project does not convert if the Templates folder or a project template file is missing or corrupt. 

Repair the View Designer install to create or replace an unrevised missing or corrupt project 
template.  

• To repair a missing or corrupt project template manually, copy the missing or corrupt content from 
another project. After revising the Templates folder manually, delete the corrupt project template.  

7. (optional) Copy the custom content from the temporary screens 
created in step 1 onto the new versions of the predefined screens 
and System Banner. Then delete the temporary screens. 

See also 
Open a project on page 56 

Close a project on page 64 

Open Project dialog box on page 57 

Rename a project on page 60 

The Predefined Screens folder in the Project Explorer contains default 
screens, popups, and a Banner item for each project.  

To view the default content of a project 
1. Select View > Project Explorer. 
2. View the contents of the Predefined Screens folder: 

• Banner. Appears at the top of each project screen. It displays 
date and time, active and unacknowledged alarm indicators, 
controller diagnostic, and network diagnostic information. It also 
provides buttons to navigate to the Alarm Summary, log on 
and log off from the project, move backward and forward 
through navigation history, and display the Navigation menu at 
the bottom of the HMI device. 

• Settings. Provides a menu of options to configure settings for 
the HMI device. By default, access the Settings screen through 
the Navigation menu on the HMI device. The options on the 
Settings screen open the popups listed under the screen in the 
Predefined Screens folder. These popups perform tasks to 
configure the HMI device. 

 
Tip: Restrict access to the screens that configure the HMI device. Apply any role that is 
not Administrator to the Guest User on the Security Administration screen. Any 
non-Administrator user, including users with the None role assigned, can open the 
popups but cannot change the options. 

• AlarmSummary. This screen displays a list of alarms that are 
in "interesting" states or that require attention. For example, the 
Alarm Summary lists alarms that are In Alarm and 
Unacknowledged. By default, access the AlarmSummary 

View the default content of 
a project 
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screen through the System Banner or the Navigation menu on 
the HMI device.   

• AlarmManager. This screen displays a list of all alarms 
regardless of their state. Alarms in the Alarm Manager include 
all of the conditions for a given alarm. By default, access the 
AlarmManager screen through the Navigation menu or the 
Alarm Summary on the HMI device. 

• Alarm History. This screen displays a list of all alarm state 
changes. Each row in the table contains one state change. By 
default, access the Alarm History screen through the 
Navigation menu on the HMI device. 

 
• To add or remove information and functionality from predefined items, change the content of 

predefined screens, popups, and the Banner item like any other screen. Do not remove content 
that configures the HMI device. 

• To restore the default content of a predefined screen, popup, or the Banner item, remove any 
remaining content from the revised item, open an unchanged version of the item in another 
project, and copy and paste the default content to the item.     

• Dragging the Settings, AlarmSummary, and AlarmManager screens to the Navigation Menu folder in 
the Project Explorer creates a shortcut for the screen. The shortcut appears in the Navigation 
Menu. By default, these items are already in the Navigation Menu. 

3. View the contents of the Assets > Add-On Graphics folder: 
• PDF_Reader. This predefined Add-On Graphic occupies the 

entire screen of an HMI device to display, zoom, and navigate a 
PDF document. 

• PDF_Reader_Small. This predefined Add-On Graphic 
occupies half of the screen of an HMI device to display, zoom, 
and navigate a PDF document. This Add-On Graphic is not 
available on six-inch or seven-inch HMI devices.   

See also 
New Project dialog box on page 54 

Create a project on page 53 

Open a project on page 56 

Close a project on page 64 

Change the name of an open project. Renaming a project file does not 
change the project name. 

  

Rename a project 
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To rename a project 
1. In the Project Explorer, right-click the project and select 

Rename.  
2. Type a new name for the project file and select Enter.  

• The name must contain only numbers, letters, and underscores.  
• The name must not begin with a number, contain spaces, have 

more than one underscore in a row, or end with an 
underscore.The name must not be a reserved keyword:  

Keyword Keyword Keyword Keyword Keyword Keyword Keyword Keyword 

ABS ACOS ACS AND ASIN ASN ATAN ATN 
BEGIN_NT_RUNG BY CASE COS DEG DEG DO ELSE 

ELSIF END_CASE END_FOR END_IF END_NT_RUNG END_REPEAT END_WHILE EXIT 
FOR FRD GOTO IF IMAGES LN LOG MOD 
NOT OF OR PROFILES RAD REPEAT RETURN SIN 
SQR SQRT TAN THEN THIS TO TOD TRN 
TRUNC UNTIL WHILE XOR     

3. On the Standard toolbar, select Save  .  

See also 
Close a project on page 64 

Project Explorer on page 95 

Save a project on page 62 

Save a copy of a project on page 62 

Rename a View Designer project file on page 61 

View Designer project files can have a different name than the project 
name. Renaming a project does not rename the project file name. 

To rename a View Designer project file  
• Use one of the following methods: 

• Navigate to the file location and change the file name. By 
default, projects are saved as VPD files in the project directory 
<user>\My Documents\Studio 5000\Projects. 

• Select File > Save Project As and type a unique name for the 
project. 

 
Tip: View Designer cannot save a .vpd file with a name if a .vpd file of the same name is 
open in another instance of View Designer. 

See also 
Create a project on page 53 

Rename a project on page 60 

Rename a View Designer 
project file 
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View and sort a list of all open screens, shortcuts, and popups in a 
project.  

To sort the contents of a project: 
1. On the Menu bar, click WINDOW > Windows.  
2. Click the Name column heading. Clicking the heading switches 

between ascending and descending sort order. 

 
Tip: To display an item from the list, select the item and click Activate. Activating an item also 
opens the corresponding Graphic Explorer and Properties windows for the item. 

See also 
Graphic Explorer on page 132 

Properties window on page 493 

As a best practice, save a project frequently while working on it. This 
prevents data loss due to an unexpected power failure or other problem. 

By default, projects are saved as .vpd files in the project directory 
<user>\My Documents\Studio 5000\Projects. 

To save a project 
• On the Standard toolbar, select Save . 

See also 
Save a copy of a project on page 62 

Close a project on page 64 

Open a project on page 56 

Rename a project on page 60 

Use the Save Project As command to create a copy of an open project. 
Create a copy of a project to:  

• Create a project from an existing project.  
• Prevent overwriting the original project. 

To save a copy of a project 
1. Select File > Save Project As.   
2. In the File name box, type a name for the project. 
3. Select Save. The open project is now the new project, not the 

original project. Pending edits are saved only to the new project. 
They are not saved to the original project. 

 
Tip: View Designer cannot save a project if a .vpd file with the same name is open in another 
instance of View Designer. 

4. (optional) Rename the project.  

Sort the contents of a 
project  

Save a project 

Save a copy of a project 
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See also 
Save a project on page 62 

Close a project on page 64 

Rename a project on page 60 

Save a View Designer runtime application as a .vpdr file. Files that are a 
.vpdr file download to the HMI device without using View Designer. Save 
the .vpdr file to removable media. After inserting the removable media in 
the HMI device, download the runtime application to the HMI device. 

Prerequisites 
• To save the runtime application to removable media, insert a USB 

storage device or SD card into the HMI device.  

To save a project to removable media 
1. Select File > Save Project As. Windows Explorer opens. 
2. Navigate to the location to save the runtime application. 

 
Tip: Save the runtime application directly to a USB drive or SD card, or save the runtime 
application to another location and then copy the runtime application to the USB drive or SD 
card. 

3. In the File name box, type a unique name for the runtime 
application. 

 
Tips:  
• Do not insert the characters ( ) or commas in runtime application file names. When selecting a 

.vpdr file to upload from removable media on the HMI device, any .vpdr file name that contains a 
comma or ( ) characters does not appear in the list selector. The list selector cannot show file 
names that contain a comma or ( ). 

• If typing the .vpdr extension as part of the file name, type the extension in lowercase letters.  

4. In the Save as type box, select View Designer Runtime 
Application (.vpdr) and select Save. The Save Runtime 
Application wizard opens the Save Runtime Application page. 
The Location box on the Save Runtime Application page 
contains the specified location and file name. 

 
Tip: Downloading a .vpd project file to the HMI device from removable media is not supported.  

5. In the Default language used at startup of HMI device and for 
undefined translations box, select the language in which to 
display the runtime application on the HMI device. 

6. Select Save. The wizard builds and saves the runtime application 
on the removable device. 

 
Tips:  
• While saving, the project is verified. Any warnings and errors that occur appear. Select Close and 

correct any warnings or errors and then save the project again.  
• Select Cancel to not save the project. 

7. When the save is complete, select Close. 

 
Tip: When the runtime application exists in a location other than removable media, copy the 
.vpdr from the location to the USB drive or SD card. 

Save a runtime application 
to removable media 
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See also 
Create a project on page 53 

Save a project on page 62 

Use the Save Runtime Application wizard to: 

• Save a runtime application .vpdr file to removable media. 
• Select the default language of the .vpdr file.  
• Download a project to an HMI device without using View Designer. 

After saving the runtime application to removable media, download the 
application by inserting the removable media in the HMI device and 
performing the download from the Settings screen. 

 
Tips:  
• When saving the runtime application, the syntax of all expressions, the elements and properties 

referenced in expressions, and the existence of all project tags in the referenced controller 
projects are verified.   

• If View Designer encounters a problem, the Save Runtime Application wizard indicates that there is 
an error. Errors appear in the Errors window below the View Designer screen. Select Close to close 
the Save Runtime Application wizard and use the Errors window to navigate to the source of the 
error. Resolve all errors before saving the runtime application to removable media. 

See also 
Create a project on page 53 

Save a project on page 62 

Save a runtime application to removable media on page 63 

If you have unsaved changes, you are prompted to save or discard the 
changes before the project closes.  

To close a project 
• Select File > Close Project.   

See also 
Open a project on page 56 

Rename a project on page 60 

Save a project on page 62 

Save a copy of a project on page 62 

Create a project using content from one or more existing View Designer 
projects. For example, assume that you use the same screen in multiple 
projects and now the screen requires updating. Instead of modifying each 
screen in each project, modify the screen in one project and then copy it 
to the other projects.  

Save Runtime Application 
wizard 

Close a project 

Content reuse 
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Or assume that you have different projects but the same users are 
accessing them. Configure the security access for each user in one 
project and then copy them to the other projects. 

The ability to cut or copy and then paste content depends on the item: 

Item: Cut or copy within a 
project? 

Cut or copy to a different 
project? 

Project Explorer   
Navigation Menu content Yes No 
User-Defined Screens folder No No 

Predefined Screens folder No No 
Predefined screens (excluding System 
Banner) 

Copy to User-Defined Screens 
folder only; no cut 

Copy to User-Defined Screens 
folder only; no cut 

Important: Pasting screens or popups in the Predefined Screens folder is not allowed. 

Images folder No No 

Screens with no user-defined properties Yes Yes 
Screens with user-defined properties Yes Yes 

Screens with shortcuts Copy only; no cut Copy only; no cut 
Popups with no user-defined properties Yes Yes 
Popups with user-defined properties Yes Yes 
Shortcuts Yes No 
System Banner No No 
   
Screen and popup content   
Graphic elements Yes Yes 
Images Yes Yes 
Drawing elements Yes Yes 
User-defined properties Yes Yes 
   
Controller reference Yes Yes 
Security Administration user account Yes Yes 
   
Table content (State Table, Color Table, 
Property Definition tab) 

  

Rows Yes Yes 
Cells Copy only; no cut Copy only; no cut 

Pasted content retains its appearance and behavior:  

• Screens and popups paste with all of their content.  
• Links to shortcuts and popups are retained. 
• Navigation events are retained. Verify that the navigation works 

correctly. 
• Graphic elements maintain their physical size and position on the 

screen. 
• Content pasted between projects with different terminal sizes are 

converted using the Do not scale scaling mode.  
• Position animation behavior may change when copying and 

pasting with projects of different terminal sizes. The animation 
works, but the location that it begins and ends may be different 
due to scaling. 
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See also 
Copy a Security Administration user account on page 432 

Copy an image from a different project on page 324 
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Chapter 3 

Select an HMI device 

The screens in a project represent the physical size of the HMI device 
selected for the project.  

Use the Application tab of the Project Properties dialog box to: 

• Specify the location of the HMI device to which the runtime 
application will be downloaded. 

• Select the type of HMI device for the project. 
• Specify how screens scale in View Designer if you change the 

target HMI device after you create screens for a project. 
• Specify how screens scale if you download a runtime application 

to an HMI device that has a different size or aspect ratio than the 
HMI device for the configured project. 

See also 
Select a target HMI device for a new project on page 67 

How changing the HMI device for a project affects screens on 
page 73 

Screen scaling overview on page 72 

PanelView 5000 HMI device dimensions and DPI on page 80 

The screens in a project represent the physical size of the HMI device 
selected for the project. Selecting a target HMI device is required to 
download the runtime application to the HMI device. The selected HMI 
device determines the number of allowed controller references for the 
project. 

Prerequisites 
• Create a new project. Selecting Finish on the New Project dialog 

box opens the Project Properties dialog box. 

To select a target HMI device for a new project 
1. On the Project Properties dialog box, click the Application tab. 
2. In the Location box, select from a list of the most recently used 

location. 

 
Tip: When clicking Browse  to select the HMI device, the OK button is available only when 
a View Designer-compatible device is selected. 

3. In the Type box, select Browse .  

Select an HMI device 

Select a target HMI device 
for a new project 
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4. On the Select HMI Device dialog box, select the appropriate HMI 
device type. By default, this is the HMI device type specified in the 
New Project dialog box.  

5. Select OK. Select Apply to save changes and remain on the 
Project Properties dialog box, or select OK to save changes and 
close the Project Properties dialog box. 
Important: Use the Screen Scaling options on the Application tab when changing the HMI device 

type after creating screen content. 

See also 
Project Properties dialog box on page 68 

Change the target HMI device for a project and select a Screen 
Scaling option on page 70 

PanelView 5000 HMI device dimensions and DPI on page 80 

The Browse for HMI Device window is a network browser that displays 
active network connections and devices in tree form. 

Use the Browse for HMI Device window to: 

• Select a target HMI device to which to download the project. 
• Remove an unused HMI device from the network tree. 

See also 
Select a target HMI device for a new project on page 67 

Remove an HMI device from the network tree on page 71 

PanelView 5000 HMI device dimensions and DPI on page 80 

Download Runtime Application wizard on page 709 

The Project Properties dialog box consists of: 

• Application tab: Select or change the target HMI device for a 
project. 

• References tab: Add and configure the controller references for a 
project. 

• Log On Method tab: Select the logon method for users of the HMI 
device. 

• Language tab: Select the default language for HMI devices to use 
for a download or restart. 

• Usage & Capacity tab: Compare the total number of user-defined 
screens and popups as well as the total number of controller 
references in the open project with the maximum number allowed. 
View the number of existing shortcuts, Add-On Graphics, PDFs, 
and images used in a project.  

See also 
Add a controller reference on page 85 

Browse for HMI Device 
window 

Project Properties dialog 
box 
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Select a target HMI device for a new project on page 67 

Change the target HMI device for a project and select a Screen 
Scaling object on page 70 

Security overview on page 698 

Use the Application tab of the Project Properties dialog box to: 

• Specify the location of the HMI device to which to download the 
runtime application. 

• Select the type of HMI device for the project. 
• Specify how existing screens scale in View Designer when 

changing the target HMI device. 
• Specify how screens scale when downloading a runtime 

application to an HMI device that has a different size or aspect 
ratio than the HMI device for the configured project. 

• Specify the size of the keyboard and keypad for the HMI device.   

See also 
Project Properties dialog box on page 68 

Select a target HMI device for a new project on page 67 

Change the target HMI device for a project and select a Screen 
Scaling object on page 70 

Screen scaling overview on page 72 

Select a default language for HMI devices to use for a download or 
restart. 

1. On the Project Properties dialog box, select the Language tab.  
2. Select the Default language for HMI device startup list, select a 

language, and select OK. 

 
Tip: If the Default language for HMI device startup list is disabled, import languages to enable 
the list.  

See also 
Project Properties dialog box on page 68 

Language tab on page 69 

Use the Language tab to select the default language for HMI devices to 
use for a download or restart. 

See also 
Project Properties dialog box on page 68 

About changing the project language on page 675 

Add a language to a View Designer project on page 672 

Import a language file on page 671 

Application tab 

Select a default language 
for HMI device 

Language tab 
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Remove a language from a View Designer project on page 674 

The Usage & Capacity tab compares the number of certain items 
included in the open project with the maximum number allowed in a 
project. Use this tab on the Project Properties dialog box to:  

• Compare the total number of user-defined screens and popups in 
an open project with the maximum number allowed for a project.  

• View the number of existing shortcuts, Add-On Graphics, PDFs, 
and images used in an open project. 

• Compare the size of the data log configuration in an open project 
to the maximum size allowed for a project. 

• Compare the total number of controller references in an open 
project with the maximum number allowed for the selected HMI 
device of the project. 

See also 
Project Properties dialog box on page 68 

What is a popup? on page 118 

Shortcut customization on page 107 

Create a screen on page 348 

Delete a screen on page 352 

The screens in a project represent the physical size of the HMI device 
selected for the project. Changing the target HMI device type after 
creating screens for a project converts the screens to fit the dimensions 
of the new HMI device based on the selected Screen Scaling option. 

IMPORTANT • Changing the screen size and then changing it back to the original size may change 
the size and position of the contents. 

• Changing screen size cannot be undone. To revert to the original screen size, change 
to the original screen size. 

To change the target HMI device for a project and select a Screen 
Scaling option 

1. Open the project. 
2. (optional) To save the project with a new name to preserve screen 

content in the original project, on the Menu bar, select File > Save 
Project As, enter a new name, and select Save. 

3. On the Menu bar, select Project > Project Properties and select 
the Application tab. 

4. In the Type box, select Browse . The Select HMI Device 
dialog box opens. 

5. Select the appropriate HMI device type. The default HMI device 
type is set in the New Project dialog box.  

6. Select OK to close the Select HMI Device dialog box.  
7. In the Screen Scaling section of the Application tab, select a 

scaling option: 

Usage & Capacity tab 

Change the target HMI 
device for a project and 
select a Screen Scaling 
option 



Chapter 3  Select an HMI device 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 71 
 

• Scale with fixed aspect ratio. (Default) When you resize the 
screen, content is resized to fill the screen as much as possible 
while maintaining the same aspect ratio. If the aspect ratio of 
the screens changes from regular (4:3) to wide, or vice versa, 
squares and circles do not elongate into rectangles and 
ellipses. Screen content anchors to the upper left of the screen. 
Any extra space appears to the right of or below the converted 
screen content. 

• Stretch to fit. Resizes the screen content to fill the screen. As 
you resize the screen from wider or narrower and vice versa, 
squares and circles are elongated into rectangles and ellipses. 
In addition, wrapped text may wrap at different word boundaries 
on the new screens.   

• Do not scale. Keeps the screen content the same size and 
position on the new HMI device as the original screens. Screen 
content ianchores to the upper-left of the screen. Any extra 
space is added to the right of or below the converted screen 
content. If the screen on a new PanelView HMI device is smaller 
than the original screen, the content might be placed outside the 
new screen borders. 

8. In the Keypad and Keyboard Size section, select the size of the 
keypad and keyboard for an PanelView 5000 device. 
• Normal. The default size of the keypad and keyboard.  
• Large. The keypad and keyboard display in a larger size similar 

to a physical keypad and keyboard. 

 
Tip: The HMI device scales the Large keypad and keyboard to fit the screen.  

9. Select Apply and then select OK. The Project Properties dialog 
box closes. 

 
Tips:  
• Changing the target HMI device to an HMI device that allows fewer controller references displays 

errors on the References tab of the Project Properties dialog box.  
• The maximum number of controller references for the HMI device appears at the top of the 

References tab.  
• Delete controller references on the References tab to not exceed the maximum allowed for the HMI 

device of the project. 

10. Review the screens, popups, and the banner in the project to 
ensure that the content, including text and raster images, displays 
as intended.   

See also 
Project Properties dialog box on page 68 

How changing the HMI device for a project affects screens on 
page 73 

Screen scaling overview on page 72 

Remove an HMI device from the network tree in the Browse HMI Device 
window to display only the devices relevant to the project.  Remove an HMI device from 

the network tree 
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To remove an HMI device from the network tree 
1. On the Application tab of the Project Properties dialog box, or 

on the HMI Device Location page of the Download wizard, 
select Browse  next to the Location box.  

2. In the Browse HMI Device window, right-click the HMI device and 
select Remove. 

See also 
Select a target HMI device for a new project on page 67 

Browse for HMI Device window on page 68 

PanelView 5000 HMI device dimensions and DPI on page 80 

Screen scaling ensures that screen content on the target HMI device is 
sized similar to the content size on the original HMI device when: 

• Changing the target HMI device after creating screens for a project  
• Downloading the project to an HMI device that has a different 

aspect ratio, resolution, or DPI than the HMI device for the 
configured project 

Control how converted screens display in View Designer and how 
downloaded screens display on the new HMI device by selecting a 
scaling mode on the Application tab of the Project Properties dialog 
box: 

• Scale with fixed aspect ratio. (Default) Resizes the screen 
content to fill the screen on the new HMI device as much as 
possible while maintaining the same aspect ratio. If the aspect 
ratio of the screens changes from regular (4:3) to wide, or vice 
versa, squares and circles are not elongated into rectangles and 
ellipses. 

• Stretch to fit. Resizes the screen content to fill the screen on the 
new HMI device. If the aspect ratio of the screens changes from 
regular (4:3) to wide or vice versa, squares and circles are 
elongated into rectangles and ellipses.  

• Do not scale. Keeps the screen content the same size and 
position on the new HMI device as the original screens. 

See also 
• Change the target HMI device for a project and select a Screen 

Scaling option on page 70 
• How changing the HMI device for a project affects screens on 

page 73 
• Download a runtime application to a different HMI device on page 

711 
• Runtime application scaling on different HMI devices on page 77 

Screen and content measurements and display on page 81 

Screen scaling overview 
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When changing the target HMI device after creating screens for a 
project, View Designer converts the screens to fit the dimensions of the 
new HMI device. Screens in the project convert to display in View 
Designer as they do on the new HMI device. 

The conversion may change the size and position properties of the 
graphic elements in the original project based on the scaling mode 
selected. This may require moving content to new screens when 
converting to a smaller HMI device or combining content into fewer 
screens when converting to a larger HMI device. 

Screens are affected by 
• Content placement 

Screen content is anchored to the upper left of the screen in pixel 
position 0,0. Extra space is added below or to the right of the 
existing screen content. If the new HMI screen is smaller than the 
original screen, screen content might be placed outside the new 
screen borders. 

• Text 
Point size may change during conversion. Word wrapping is not 
maintained.   

• Banner 
The banner is always as wide as the screen width. The height of 
the banner is set based on the selected Screen Scaling option. 

• Popups 
Popups and their contents remain the same physical size as on 
the original screen unless they do not fit the screens on the new 
HMI device. In this case, the popups and their contents reduce to 
fit the new screen area while maintaining a fixed aspect ratio. This 
is regardless of the Screen Scaling option selected. After the 
screens convert, the relative space that the popups cover on the 
new screens is different from the original screens.  

• Bindings to size and position properties of graphic elements 
Bindings to size and position properties of graphic elements may 
not work the same after project conversion. This is because the 
size and position properties of the graphic elements may have 
changed. The animation values in the controller may need to be 
updated to reflect the new size and position coordinates. 

• Raster images 
Bitmap or raster images store as a series of tiny dots called pixels. 
When adding a raster image to a View Designer screen, the image 
Height and Width property values in the Properties tab match the 
pixel size of the image. Raster images may appear unclear 
because View Designer scales the bitmap image to match the 
physical size of the image as it appears on the HMI device screen. 
Images appear sharp on the HMI device screen. 

• Graphic elements 

How changing the HMI 
device for a project affects 
your View Designer screens 
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The corner radius and the border width of graphic elements do not 
resize. 
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See also 
Application tab on page 69 

Change the target HMI device for a project on page 70 

Screen scaling overview on page 72 

Scaling options under Screen Scaling on the Application tab include: Scaling examples 
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Scale with fixed Aspect ratio 

 
Screen examples represent the View Designer screen (canvas). 

Stretch to fit 

 
Screen examples represent the View Designer screen (canvas). 
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Do not scale 

 

See also 
Change the target HMI device for a project and select a Screen 
Scaling option on page 70 

When downloading a project to a different HMI device, screens 
automatically scale on the HMI device to fit based on the scaling option 
for the project. This does not affect the project contents in View Designer. 
The scaling option is appears on the Application tab of the Project 
Properties dialog box.  

Downloading a project to an HMI device with a different DPI setting 
affects the display of screens:  

• Content placement 
Screens appear in the center of the new HMI device. Any extra 
space required for Scale with fixed aspect ratio or Do not scale 
options appears equally on either side or above and below the 
screen. If the new HMI screen is smaller than the original screen, 
the Do not scale option is overridden to Scale with fixed aspect 
ratio to ensure screen content is not clipped. 

• Text 
Text appears at the point size for the targeted HMI device. If the 
actual HMI device differs, the text stretches to fit the new area 
based on the scale mode selected. If the actual HMI device has a 
different aspect ratio and the scale mode selected is Stretch to fit, 
the aspect ratio of the text stretches or compresses to fill the new 
area. 

• System Banner 
The System Banner is always as wide as the screen. The height 
of the System Banner depends on the selected scaling option.  

• Popups 

Runtime application scaling 
on different HMI devices 
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Popups and their contents remain the same physical size as on 
the original screen unless they do not fit the screens on the new 
HMI device. In this case, the popups and their contents reduce to 
fit the new screen area while maintaining a fixed aspect ratio. This 
is regardless of the Screen Scaling option selected. After the 
screens convert, the relative space that the popups cover on the 
new screens is different from the original screens.  

• Bindings to size and position properties 
Downloading a project to a different HMI device does not affect 
bindings to size and position properties of graphic elements. 
Update animation values in the controllers as necessary to match 
the new size and position values. 

• Raster images 
Bitmap or raster images store as a series of tiny dots called pixels. 
When adding a raster image to a View Designer screen, the image 
Height and Width property values in the Properties tab match the 
pixel size of the image. Raster images may appear unclear 
because View Designer scales the bitmap image to match the 
physical size of the image as it appears on the HMI device screen. 
Images appear sharp on the HMI device screen. 
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Loading a raster image on an HMI device that is different from the 
HMI device for the project results in the image appearing unclear 
compared to the original. Add ore remove pixels to match the new 
image size. The image size varies from with HMI device screen 
size. 
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See also 
Project Properties dialog box on page 68 

Screen scaling overview on page 72 

Download a runtime application to a different HMI device on page 
711 

Dimensions and DPI for the PanelView 5510 HMI device include:  

 
HMI device 

7-inch 7-inch with 
keypad 7-inch wide 9-inch wide 10-inch 10-inch with 

keypad 
Screen diagonal (in) 6.5 6.5  7 9 10.4 10.4 

Catalog number 2715P-T7CD 2715P-B7CD 2715P-T7WD 2715P-T9WD 2715P-T10CD 2715P-B10CD 

Screen size (px) 640 x 480 640 x 480 800 X 480 800 x 480 800 x 600 800 x 600 
Screen (DPI) 123 123 134 103  96 96  
Screen, W x H (mm) 132 x 99 132 x 99 152.5 x 91.5 196 x 118 211 x 158 211 x 158 
Screen, W x H (in) 5.20 x 3.90 5.20 x 3.90 6 x 3.6 7.76 x 4.65 8.31 x 6.22 8.31 x 6.22 

 

 
HMI device 

12-inch wide 15-inch 15-inch with 
keypad 19-inch 

Screen diagonal (in) 12.1 15 15 19 

Catalog number 2715P-T12WD 2715PT-T15CD 2715P-B15CD 2715P-T19CD 

Screen size (px) 1280 x 800 1024 x 768 1024 x 768 1280 x 1024 
Screen (DPI) 125 86 86 86 
Screen, W x H (mm) 262.6 x 164.7 305.6 x 229.6 305.6 x 229.6 377.0 x 301.8 
Screen, W x H (in) 10.34 x 6.48 12.03 x 9.04 12.03 x 9.04 14.84 x 11.88 

 

Dimensions and DPI for the PanelView 5310 HMI device include:  

 
HMI device 
6-inch  7-inch wide 9-inch wide  10-inch  12-inch wide 

Screen diagonal (in)  5.7 7 9 10.4 12.1 
Catalog number 2713P-T6CD1 2713P-T7WD1 2713P-T9WD1 2713P-T10CD1 2713P-T12WD1 

Screen size (px)  640 x 480 800 X 480 800 x 480  800 x 600  1280 x 800 
Screen (DPI)  142 134 103  96  125 
Screen, W x H (mm)   115.2 x 86.4 152.5 x 91.5 196 x 118  211 x 158  262.6 x 164.7 
Screen, W x H (in)  4.5 x 3.4 6 x 3.6  7.76 x 4.65  8.31 x 6.22  10.34 x 6.48 

See also 
Application tab on page 69 

Select a target HMI device for a new project on page 67 

Screen and content measurements and display on page 81 

PanelView 5000 HMI device 
dimensions and DPI 
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View Designer is a WYSIWYG editor. Text and graphics on the screen in 
View Designer closely resemble what appears on the target HMI device. 
Screens and their content are measured and displayed in ways that 
ensure a project can appear on different HMI devices. 

Project screens 
Project screens are measured by: 

• Pixel dimension. Pixel dimension is the number of pixels wide 
and high for a screen. For example, the 7" PanelView device is 
640 wide x 480 pixels high. The density of these pixels is known as 
DPI (Dots Per Inch). DPI is the number of pixels in a linear inch.  
Screen resolution is also expressed in DPI. For example, the 
resolution of the 7" PanelView device is 123 DPI. 

• Physical size. The physical size of an HMI device screen is 
usually specified as a diagonal measurement, such as from the 
lower left corner to the upper right corner. For example, the 
physical size of the 7" PanelView device is 6.5".  
The HMI device screen can also be measured by the width and 
height measurements that are more important for motion 
animation. For example, the 7" PanelView device is 5.20" wide x 
3.90" high. 
The proportional relationship between the width and height of a 
screen is called aspect ratio. 

The screens in View Designer measure the same as the screens of the 
configured HMI device. This assumes that Windows is calibrated to the 
DPI of the monitor on which View Designer is running.  For example, the 
7" PanelView device is 640 x 480 pixels. To show the screens sized in 
View Designer with Windows set to 96 DPI, the screens are scaled down 
to 500 x 375 pixels to represent the 5.20" x 3.90" size. 

Text 
Text size is typically measured in points, where a point is 1/72 of an inch. 
This defines the height of the text, but not its width. This means that text 
width varies slightly on different devices depending on the DPI of the 
device.  

To prevent text from being distorted on screens of varying DPI, View 
Designer draws the text at the DPI of the target HMI device and sets the 
width and height based on the number of pixels the text used. Therefore, 
the X, Y, Width, and Height property values in the Properties window are 
shown in the pixel size they will be drawn on the configured HMI device. 
The text, including its border, is scaled to the physical size it is on the HMI 
device. Seeing and measuring the actual size maintains minimum touch 
areas. This assumes that Windows is calibrated to the DPI of the monitor 
on which View Designer is running.  

Screen and content 
measurements and display 
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Screen content 
Screen content is sized to match the size of the font, so that when a 
screen is viewed at 100%, the text and elements are the same size as 
they appear on the HMI device.  

Changing the HMI device for a project, and selecting Do Not Scale as a 
scaling option causes the size and position properties to change to the 
pixels necessary to maintain the same size. Text width may also change 
when the DPI changes, so the font point size might also change to keep 
the text from being clipped. 

Changing the HMI device for a project, and selecting a scale mode other 
than Do Not Scale also changes the size and position properties, 
including font size. However, this is a relative change, not a physical 
change. The screen elements take up the same percent of screen space 
on the new screen as they did on the old screen, but they are now a 
different physical size and pixel size. 

The spacing around content within a graphic element may differ on View 
Designer screens that are targeted to different HMI devices. This is due 
to the different HMI devices having different DPI values. However, text 
wrapping for content within a graphic element is usually the same from 
View Designer to an HMI device.  

See also 
Select a target HMI device for a new project on page 67 

Change the target HMI device for a project and select a Screen 
Scaling option on page 70 

PanelView 5000 HMI device dimensions and DPI on page 80 

Screen scaling overview on page 72 

Raster images, such as .bmp, .tif, .jpg, or .png files, are comprised of a 
grid of pixels, or a bitmap. Scaling elements in View Designer to match 
the DPI of the HMI device so that fonts look correct on the HMI device 
can make raster images look unclear in View Designer. This happens 
when the DPI of the target HMI device is much larger than the DPI under 
which View Designer is running.  

The unclear or pixelated effect occurs because the size of all of the 
elements on the screen are reduced to match the fewer number of pixels 
used to display fonts on View Designer. The image may look unclear in 
View Designer, but it displays correctly on the target HMI device. You can 
typically scale down raster graphics with little loss of quality. 

Copying and pasting an image between View Designer projects for 
different size HMI devices maintains the physical size of the image. The 
image no longer has the same number of pixels on the new HMI device 
as it had on the original HMI device. Add the image to the new screen or 
manually resize the image to correct the size on the new HMI device. 

Raster images look unclear 
in View Designer 
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See also 
Screen scaling overview on page 72 

Screen and content measurements and display on page 81 

PanelView 5000 HMI device dimensions and DPI on page 80 
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Chapter 4 

Add a controller reference 

A controller reference is a connection to a Logix Designer project file 
(.acd) from a View Designer project file (.vpd). The connection 
automatically synchronizes data between a Logix Designer project file 
(.acd) and View Designer project file (.vpd). 

Add up to four controller references, and a recommended maximum of 
50,000 tags in a Logix controller to a project. Use a maximum of one 
controller for each PanelView 5310 project or a maximum of four 
controllers for a PanelView 5510 project. 

 
Tip: Every scalar, array element, and structure member is considered a separate tag. 

Use the References tab on the Project Properties dialog box to add or 
change a controller reference. 

See also 
Add a controller reference on page 85 

Synchronization on page 89 

References tab on page 87 

 

A controller reference is a connection to a Logix Designer project file 
(.acd) from a View Designer project file (.vpd). The connection 
automatically synchronizes data between a Logix Designer project file 
(.acd) and View Designer project file (.vpd). For PanelView 5510 HMI 
devices, View Designer supports up to four controller references.  

Adding a controller reference adds the controller reference to the next 
available reference card on the References tab. Each controller 
reference has a number in the reference card. This controller number 
appears when browsing for HMI device controller tags in the Tag 
Browser. 

IMPORTANT Select a controller only from an Ethernet network. Logix controllers and project files 
must be version 27 or later. 

 

 
Tip: For projects with a PanelView 5000 HMI device, the recommended number of tags across all four 
Logix controllers is 200,000. A tag is a scalar tag. Scalar tags are BOOL, DINT, REAL, a member of 
structure, or an element of an array. 

Add a controller reference 
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To add a controller reference 
1. On the Project Properties dialog box, select the References tab. 
2. In the Controller[#] Reference Name box, type a unique name 

for the controller reference. Name the controller reference a 
different name than the project. 

 
Tips:  
• Add up to four controller references for projects configured with a PanelView 5510 HMI device.  
• Entering a controller reference name or selecting Add controller reference  adds an additional 

controller reference card for projects configured with a PanelView 5510 HMI device.  
• Added controller references appear after the last controller reference card. After saving controller 

references, reference cards appear in order by controller reference number that appears in the 
Controller[#] Reference Name box. 

• Adding the maximum number of controller references for an HMI device makes Add controller 
reference  unavailable. 

• Add up to four controller references for projects configured with a PanelView 5510 HMI device.  
• Entering a controller reference name or selecting Add controller reference  adds an additional 

controller reference card for projects configured with a PanelView 5510 HMI device.  
• Added controller references appear after the last controller reference card. After saving controller 

references, reference cards appear in order by controller reference number that appears in the 
Controller[#] Reference Name box. 

• Adding the maximum number of controller references for an HMI device makes Add controller 
reference  unavailable. 

• Controller References each contain an index number. When controllers replicate at the same time, 
the controller with the lowest index number replicates before the other controllers in queue. The 
controller with the lowest index number in queue has the highest priority. 

• The combined number of PanelView 5000 HMI devices and Logix controllers that can communicate 
with each other through a 1756-EN2T or 1756-EN3T Ethernet module is eight or fewer. 

3. Type the path of the file or select a Logix Designer project file 
(.acd) by selecting Browse  next to the Logix Project File box. 

 
Tip: The project file (.acd) for each referenced controller must be Logix Designer version 27 or 
later. 

4. Set the path from the HMI device to the controller: 
a. Type the IP address of the controller. To browse for the controller, 

after the HMI to Controller Path box, select Browse  and 
select the controller running the selected Logix Designer project 
file (.acd). 

b. In the Slot box, select the slot number of the controller to 
reference. After browsing to the controller in the previous step, 
the slot number appears automatically. 

5. Set the path from the View 5000 Emulator to the controller: 
a. After the Emulator to Controller Path box, select Browse  

and select the controller running the selected Logix Designer 
project file (.acd). 

b. (optional) If the controller is previously viewed, select the Select 
Controller Path list and select the controller from an Ethernet 
network or virtual backplane running Logix Emulator. 

 
Tips:  
• The Select Controller Path list contains up to the last five recently viewed controller paths. If there 

are no previously viewed paths, the list does not appear. 
• Setting the Emulator to Controller path to the same path for multiple controller references displays 

duplicate alarms in the Alarm Summary and the Alarm Manager. Each alarm in the controller 
displays for each controller reference that has the same Emulator to Controller path. 
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6. Select Apply to save changes and keep the Project Properties 
dialog box open, or select OK to save changes and close the 
dialog box. 

 
Tip: When browsing for a controller, the OK button is available when selecting a View 
Designer-compatible device. 

See also 
Project Properties dialog box on page 68 

References tab on page 87 

Select a target HMI device for a new project on page 67 

Remove a controller reference on page 88 

Use the References tab to add controller references to the project. A 
controller reference is a connection to a Logix Designer project file (.acd) 
from a View Designer project file (.vpd). Add up to four controller 
references for a PanelView 5510 HMI device. The connection 
automatically synchronizes data between a Logix Designer project file 
(.acd) and View Designer project file (.vpd). 

See also 
Project Properties dialog box on page 68 

Synchronization on page 89 

Add a controller reference on page 85 

Remove a controller reference on page 88 

The Browse for Controller window is a network browser that displays 
active network connections and devices in tree form.   

Use the Browse for Controller window to select a controller to 
reference for the project. 

See also 
• Add a controller reference on page 85 
• Remove a controller from the network tree on page 89 

Copy a controller reference within a View Designer project or from one 
View Designer project to another. This eliminates the need to manually 
enter the information in a project. Copy individual items from a controller 
reference or the entire controller reference. Paste controller references 
that are of the same version of Logix Designer. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 

References tab 

Browse for Controller 
window 

Copy a controller reference  
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• If pasting content into another project, start an instance of View 
Designer and open the target project. Open no more than three 
instances of View Designer at one time.   

To copy a controller reference 
1. In the source project, select Project > Project Properties and 

select the References tab. 
2. Right-click the controller reference and select Copy. 

 
Tip: To copy a single item from a controller reference card, select the controller reference, 
select the item to copy, and then right-click and select Copy. 

3. In each target project: 
a. Select Project > Project Properties and select the References 

tab. 

b. Right-click the new controller reference card and select Paste. 
Pasting assigns the next available controller reference number.  

c. Select Apply to save changes and remain on the Project 
Properties dialog box, or select OK to save changes and close 
the Project Properties dialog box. 

 
Tips:  
• Pasted controller references appear after the last controller reference card. Each controller 

reference card has a controller reference number that identifies the position on the References 
tab and the name of the referenced controller. When reopening the References tab, reference 
cards appear in order by controller reference number that appears in the Controller[#] Reference 
Name box. 

• After saving controller references, reference cards appear in order by controller reference number.  
• For PanelView 5310 HMI devices, View Designer does not support pasting a controller reference in a 

project that already contains a controller reference. 
• For PanelView 5510 HMI devices, paste up to four controller references in a project.  
• For multiple controllers and their tags to appear in the Tag Browser for a PanelView 5510 HMI 

device, the project file (.acd) for each referenced controller requires the same version of Logix 
Designer. 

• View Designer does not support pasting a number of controller references that exceeds the total 
allowed for an HMI device. A prompt appears to paste the copied controller references that do not 
exceed the maximum for the HMI device.  

• The maximum number of controller references appears at the top of the References tab and on 
the Usage & Capacity tab. Deleting the required number of controller references from the 
References tab removes the errors. 

See also 
Project Properties dialog box on page 68 

References tab on page 87 

Add a controller reference on page 85 

Remove a controller reference on page 88 

Removing a controller reference disconnects the View Designer project 
from the Logix Designer project file (.acd). Tags and data types for the 
referenced controller do not appear in the Tag Browser or Data Type 
Browser.  

Remove a controller 
reference 
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To remove a controller reference 
1. On the Project Properties dialog box, select the References tab. 
2. To the right of the controller reference, select Remove controller 

reference . The reference no longer appears. 

 
Tips:  
• Removing a controller reference adjusts the placement of any subsequent reference cards. After 

saving controller references, reference cards appear in order by controller reference number that 
appears in the Controller[#] Reference Name box. 

• In the Controllers popup on the HMI device, any unused controller reference has a tab named Not 
configured. 

3. Select Apply to save changes and remain on the Project 
Properties dialog box, or select OK to save changes and close 
the Project Properties dialog box. 

See also 
Project Properties dialog box on page 68 

References tab on page 87 

Remove a controller from the network tree in the Browse for Controller 
window to display only the controllers that are relevant to the project.  

1. On the References tab of the Project Properties dialog box, or 
on the Controller References page of the Download wizard, 
select Browse   next to the Slot box.  

2. In the Browse for Controller window, right-click the controller 
and select Remove. 

See also 
Browse for Controller window on page 87 

Add a controller reference on page 85 

Studio 5000 automatically synchronizes data between a Logix Designer 
project file (.acd) and a View Designer project file (.vpd).  

It also synchronizes data between the runtime application on the HMI 
device and the controller connected to that HMI device. The 
synchronized data includes tags, data types, program tags, and alarms. 
The synchronization service automatically runs in the background every 
15 seconds, enabling you to continue working while the data is 
synchronized. 

Synchronization between Logix Designer and View Designer 
When you create an HMI project in View Designer, use the synchronized 
data to bind to graphic elements, screens, or expressions.  

In View Designer:  

• Synchronization state indicator icons appear next to the controller 
on the References tab, and on the Tag Browser window to 

Remove a controller from 
the network tree 

How does synchronization 
work? 
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indicate the state of the controller. The state indicators do not 
appear if there is no new data to synchronize. The following table 
describes the state indicator icons. 
State indicator icons 

Icon Description 

 
The controller is synchronizing.  

 
The data in the controller is not synchronized; it will be automatically synchronized. Hover your mouse on the icon to 
display additional information. 

 
A synchronization error occurred. The Logix Designer project file (.acd) does not exist, or it is a version that is not 
supported. Hover your mouse on the icon to display additional information. 

 
The controller is synchronized. 

 

• When you add a new controller reference, content is synchronized 
between the Logix Designer project file (.acd) for that controller 
and the View Designer project file (.vpd). 

• When synchronization is in progress, you cannot download an 
HMI project to the HMI device. As a best practice, Rockwell 
Automation recommends you save your HMI project after 
synchronization is complete.  

• When you change the controller reference, click OK on the 
References tab to synchronize content between the newly 
referenced Logix Designer project file (.acd) for that controller and 
the View Designer project file (.vpd). If the Logix Designer project 
file (.acd) is not valid, the synchronization service displays an 
error, synchronization does not take place, and the HMI project 
references the previously synchronized data from the last 
referenced Logix Designer project file (.acd). 

• When you delete the controller reference, the previously 
synchronized data from the Logix Designer project file (.acd) is 
removed from the View Designer project file.  

 
Tip: If you save the View Designer project before synchronization finshes, or if you abort the 
synchronization (for example by closing the project before it finishes), content 
synchronization will start again the next time you open the project.  

In Logix Designer: 

When you make a change in a Logix Designer project file (.acd), the 
synchronization service detects the changes to the Logix Designer 
project file (.acd). The synchronization service automatically 
synchronizes data between the Logix Designer and View Designer 
project files. 

Synchronization between the runtime application on the HMI device 
and the controller connected to the HMI device 
When you download the HMI project to the HMI device, the 
synchronization service connects the runtime application to the controller 
referenced in the HMI project. After the synchronization service connects 
to the controller, it reads data from the controller to determine if it 
matches the data in the HMI project. If the data does not match, the data 
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in the HMI project automatically synchronizes with the data in the 
controller. 

When the runtime application is running on the HMI device, the 
synchronization service checks if the Logix Designer file in the controller 
was updated. The Logix Designer project file in the controller can be 
updated using the online editing features in Logix Designer. If the project 
file was updated, the synchronization service will automatically 
synchronize data between the Logix Designer project file referenced in 
the runtime application and the newly updated Logix Designer project file 
in the controller. 

You can configure system tags to display information about the 
synchronization status of the runtime application and the Logix5000 
controller or use the ControllersGeneral screen in the Predefined 
Screens folder. 

See also 
References tab on page 87 

Add a controller reference on page 85 

Remove a controller reference on page 88 

System tags: Controller on page 537 

When creating an HMI project in View Designer, use the synchronized 
data to bind to graphic elements, screens, or expressions.  

In View Designer 
Synchronization state indicator icons appear next to a controller 
on the References tab, and on the Tag Browser window to 
indicate the state of the controller. The state indicators do not 
appear if there is no new data to synchronize.  

• When adding a new controller reference, content is synchronized 
between the Logix Designer project file (.acd) for that controller 
and the View Designer project file (.vpd). 

• When synchronization is in progress, downloading an HMI project 
to the HMI device is not supported. As a best practice, Rockwell 
Automation recommends saving the HMI project after 
synchronization is complete.  

• When changing a controller reference, select OK on the 
References tab to synchronize content between the newly 
referenced Logix Designer project file (.acd) for that controller and 
the View Designer project file (.vpd). If the Logix Designer project 
file (.acd) is not valid, the synchronization service displays an 
error, synchronization does not take place, and the HMI project 
references the previously synchronized data from the last 
referenced Logix Designer project file (.acd). 

• When deleting a controller reference, the previously synchronized 
data from the Logix Designer project file (.acd) no longer appears 
in the View Designer project file.  

Synchronization between 
Logix Designer and View 
Designer 
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Tip: If you save the View Designer project before synchronization finshes, or if you abort the 
synchronization (for example by closing the project before it finishes), content 
synchronization will start again the next time you open the project.  

In Logix Designer 
When making a change in a Logix Designer project file (.acd), the 
synchronization service detects the changes to a Logix Designer project 
file (.acd). The synchronization service automatically synchronizes data 
between the Logix Designer and View Designer project files. 

See also 
Synchronization between the runtime application and the 
controller on page 92 

Tag browsing in a secured Logix Designer project file on page 93 

These are the controller state indicator icons: 

Icon Description 

 
A controller is synchronizing.  

 
The data in a controller is not synchronized. Controller data synchronizes automatically. Hover the mouse on the icon to 
display additional information. 

 
A synchronization error occurred. The Logix Designer project file (.acd) does not exist, or it is a version that is not 
supported. Hover your mouse on the icon to display additional information. 

 
The controller is synchronized. 

See also 
Synchronization on page 89 

When downloading the HMI project to the HMI device, the 
synchronization service connects the runtime application to the controller 
referenced in the HMI project. After the synchronization service connects 
to the controller, it reads data from the controller to determine if it 
matches the data in the HMI project. If the data does not match, the data 
in the HMI project automatically synchronizes with the data in the 
controller. 

When the runtime application runs on the HMI device, the 
synchronization service checks if the Logix Designer file in the controller 
was updated. The Logix Designer project file in the controller can be 
updated using the online editing features in Logix Designer. If the project 
file was updated, the synchronization service will automatically 
synchronize data between the Logix Designer project file referenced in 
the runtime application and the newly updated Logix Designer project file 
in the controller. 

Configure system tags to display information about the synchronization 
status of the runtime application and the Logix5000 controller or use the 
ControllersGeneral screen in the Predefined Screens folder. 

Synchronization: Controller 
state indicator icons 

Synchronization between 
the runtime application and 
the controller 
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See also 
Synchronization between Logix Designer and View Designer on 
page 91 

Tag browsing in a secured Logix Designer project file on page 93 

Browsing for tags in a secured Logix Designer project file (.acd) from 
View Designer is allowed only with security access to the .acd file. 

The first logged-on user to open View Designer may prevent subsequent 
users who log on and open View Designer from synchronizing .acd files 
in their Documents folder while the first user is still logged on. To prevent 
this: 

• Have the subsequent user synchronize with a file that both the 
subsequent user and first user can access.  

• Have the first user log off before the subsequent user logs on.  
If multiple users log on and log off of the same computer, and the first 
user to start View Designer logs out, subsequent users will no longer be 
able to synchronize .acd files or create or change references to them. To 
prevent this, have only one user logged on to a multi-user computer at a 
time when running View Designer.  

Install Logix Designer to synchronize with an .acd file.  

Install Logix Designer version 27 or version 28, or Studio 5000 Logix 
Designer version 29 to add a reference to their respective .acd file. 
However, A View Designer project (.vpd file) that already has an .acd file 
reference added and synchronized stays synchronized without installing 
Logix Designer.  

See also 
Synchronization between Logix Designer and View Designer on 
page 91 

Synchronization between the runtime application and the 
controller on page 92 

 

Tag browsing in a secured 
Logix Designer project file 
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Chapter 5 

View the default content of a project 

View Designer provides default content to use to build and organize a 
project. 

The Project Explorer displays the contents of a View Designer project in 
tree form. The root-level project folder contains the project name and 
default folders -- Navigation Menu, User-Defined Screens, and 
Predefined Screens.  

See also 
Project Explorer on page 95 

Predefined Screens folder on page 96 

What is the System Banner? on page 97 

What is the Settings screen? on page 97 

What is the Alarm Summary? on page 99 

How do I open the Project Explorer? 

On the Menu bar, click VIEW > Project Explorer. 
The Project Explorer displays the contents of a View Designer project in 
tree form. The root-level project folder contains the project name and 
default folders. These folders contain the items of the project, including 
default content. Project items include: 

Default Folder Screens Shortcuts Popups Folders Default 
Project 
Screens and 
Popups 

Add-On 
Graphics 

Images Sample rates Documents Events 

Navigation Menu           

User-Defined 
Screens 

          

Predefined 
Screens 

          

Assets           
Data Logging           

Project Events           

The content and its order in the Navigation Menu folder are displayed as 
menu items in the Navigation menu on the HMI device. The shortcuts in 
the Navigation Menu folder are based on user-defined screens or the 
Settings, Alarm Summary, and Alarm Manager predefined screens. 

Use the Project Explorer to: 

• Browse and organize the contents of a project. 

Project Explorer 
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• Add screens, shortcuts, popups, and folders to a project. 
• Open, rename, and delete screens, shortcuts, popups, and 

folders. 
• Create navigation for the user on the HMI device. 
• Create an Add-On Graphic or image to add to a screen or popup 
• Create a data log with sample rates to add to a screen or popup 
• Display the properties of a project, such as controller references 

and the target HMI device. 
• Verify a project. 
• Rename a project. 
• Add a PDF document 
• Create project events 
• Copy and paste single and multiple objects. 

Right-click an item in the Project Explorer to see a list of actions to 
perform. 

See also 
Create a screen on page 348 

Create a shortcut to an existing screen on page 102 

Create a popup on page 110 

Open a screen on page 348 

Specify a Home screen on page 553 

The Predefined Screens folder in the Project Explorer contains default 
screens, popups, and a Banner item for each project. The contents of 
the Predefined Screens folder includes:  

• Banner. By default, this item appears at the top of each project 
screen. It displays date and time, active and unacknowledged 
alarm indicators, controller diagnostic, and network diagnostic 
information. It also provides buttons to navigate to the Alarm 
Summary, log on and log off the project, move backward and 
forward through navigation history, and display the Navigation 
menu at the bottom of the HMI device.   

• Settings. This screen provides a menu to configure settings for 
the HMI device. By default, access the Settings screen through 
the Navigation menu on the HMI device. The options on the 
Settings screen open the popups listed under the screen in the 
Predefined Screens folder. These popups perform tasks to 
configure HMI device settings.  

• AlarmSummary. This screen displays the Alarm Summary, a list 
of alarms that are in interestingstates or that require attention. For 
example, the Alarm Summary lists alarms that are In Alarm and 
Unacknowledged. By default, access the AlarmSummary screen 
through the System Banner or the Navigation menu on the HMI 
device.   

• AlarmManager. This screen displays the Alarm Manager, a list 
of all alarms regardless of their state. Alarms listed in the Alarm 
Manager include all of the conditions for an alarm. By default, 

Predefined Screens folder 
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access the AlarmManager screen through the Navigation menu 
or the Alarm Summary on the HMI device. 

• AlarmHistory. This screen displays the Alarm History, a list of all 
alarm state changes. By default, access the AlarmHistory screen 
through the Navigation Menu. 

See also 
What is the Settings screen? on page 97 

What is the Alarm Manager? on page 99 

What is the Alarm Summary? on page 99 

What is the System Banner? on page 97 

The System Banner appears at the top of each screen configured to 
show the System Banner, and each shortcut to which you have access. 
The System Banner contains a default set of items. Security access to 
the System Banner cannot be set for a particular role. You can remove 
the System Banner from a screen or shortcut through the Properties 
window for the selected screen or shortcut.  

You can change the height of the System Banner, but not the width. The 
System Banner is always as wide as the screen.    

If you do not scale screens and change the HMI device type for your 
project, this affects the System Banner. For example, blank space 
appears to the right of the System Banner when you configure the 
project for larger HMI device screens. Space to the right of the System 
Banner is removed when you configure the project for smaller HMI 
device screens. When you do not scale screens and change project 
settings to a smaller HMI device, elements may appear clipped at the 
right end of the System Banner on the HMI device.   

See also 
Open the System Banner on page 122 

Add a graphic element to the System Banner on page 123 

Remove a graphic element from the System Banner on page 125 

Remove the System Banner from a screen on page 125 

System Banner contents on page 127 

Use the Settings screen on the HMI device to view and change HMI 
device and system-wide settings. The Settings screen opens popups 
that appear in the Predefined Screens folder of the Project Explorer.   

What is the System Banner? 

What is the Settings 
screen? 
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View Designer does not support moving the popups into the 
User-Defined Screens folder. Create events to open these popups from 
other screens and graphic elements in a project. On the HMI device, use 
the Settings screen to select an option to open a popup and perform the 
associated tasks. 

Option: Popup: Tasks: 

Network 
 

NetworkIPSettings tab • Specify Internet Protocol 
settings 

• Specify IP addresses 
• Specify DNS addresses 

NetworkLinkSettings tab • Enable Ethernet links 
• Set link speed 
• Specify link duplex 

NetworkDiagnostic tab • View network diagnostics 
Display Display • Adjust the HMI device screen 

brightness 
• Turn on the screen saver 
• Set the brightness and delay for 

the screen saver 
• Calibrate the screen to respond 

accurately to touch  
HMI Device 
 

HMIDevice • Specify if project downloads and 
firmware updates are allowed 

• Change the name of the HMI 
device 

• View catalog and firmware 
numbers 

• View diagnostic information 
HMIDevice_RebootConfirm • Restart the HMI device 

Data Export Data Export • Export the alarm history or data 
logs to removable media 

Troubleshooting Troubleshooting • Import a troubleshooting profile 
• Export a troubleshooting log 
• Turn off troubleshooting and 

restart the HMI device 
Date and Time DateAndTime • Set the date and time for the HMI 

device 
• Set the time zone for the HMI 

device 
Controllers 
 

ControllersGeneral tab • View controller reference and 
status information 

ControllersDiagnostic tab • View controller diagnostics 

Download from Media Load Application • Load a .vpdr file from an HMI 
storage device or an SD Card 
inserted into the HMI device.  

VNC VNC • Configure remote access rights 
to an HMI device as either 
Full-Access or View-Only, or 
disable the remote access to the 
HMI device.   

Email Email • Configure the SMTP client to 
send emails. 
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See also 
Predefined Screens folder on page 96 

What is the System Banner? on page 97 

What is the Alarm Summary? on page 99 

What is the Alarm Manager? on page 99 

The Alarm Summary lists alarms that are In Alarm or Unacknowledged. 
The Alarm Summary automatically subscribes to all alarms from the 
controller references specified in the project properties. It displays one 
alarm condition per row. Use the Alarm Summary to monitor and 
interact with alarms. Add or remove columns to show different data for 
alarms in the Alarm Summary table. The 5380, 5480 and 5580 Logix 
families of controllers support tag-based alarms.  

Use the Alarm Summary on an HMI device to:  

• Acknowledge alarms. 
• Disable alarms. 
• Shelve alarms. 
• Sort alarms. 
• Filter alarms. 
• Pause alarms. 
• Reset digital alarms. 
• View alarm details. 

See also 
Alarm Summary contents for a large HMI device screen on page 
577 

Alarm Summary contents for a medium HMI device screen on 
page 575 

Alarm Summary table columns on page 579 

Columns tab on page 580 

Details pane for an Alarm Summary on page 580 

The Alarm Manager lists all alarms configured in a system and their 
current states. The Alarm Manager subscribes to alarms in the 
controllers. Every alarm from the controllers is listed unless an alarm is 
removed from a controller. Use the Alarm Manager table to monitor and 
interact with the alarms on the HMI device. 

 
Tips: 
• For tag-based alarms, the Alarm Manager only displays alarms with Use and evaluate alarm 

selected in the Logix Designer. 
• The 5380, 5480 and 5580 Logix families of controllers support tag-based alarms. 

By default, an AlarmManager screen is included in each project. Create 
a user-defined Alarm Manager screen by adding an Alarm Manager 
graphic element to a screen in View Designer.   

Use the Alarm Manager to: 

What is the Alarm 
Summary? 

What is the Alarm Manager? 
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• View alarm names to identify the controller and tag of an alarm. 
• Enable or disable alarms to take them in or out of service. 
• Shelve and unshelve alarms and alarm conditions. 
• Reset counts for alarms.  
• Sort and filter alarms. 
• View alarm errors. 
• View individual conditions for an alarm. 
• View details for a selected alarm or alarm condition. 

See also 
Alarms overview on page 563 

Create an alarm screen on page 565 

Alarm Manager contents for a large HMI device screen on page 
589 

Alarm Manager table columns on page 591 
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Chapter 6 

Shortcuts 

Use shortcuts to pass properties to screens to customize the screen 
content that appears on the HMI device.  

A shortcut is a link to a screen on which the shortcut is based. Shortcuts 
can be based on either new or existing screens. 

Shortcuts based on existing screens can reuse screen content to create 
additional screens that are similar but have been customized to display 
different values. A project can contain up to 200 shortcuts.  

See also 
Create a shortcut to an existing screen on page 102 

Create a shortcut to a new screen on page 103 

Open a shortcut on page 104 

Copy a shortcut on page 105 

Use the New Shortcut dialog box to create a shortcut to a screen. 
Shortcuts provide quick access to a specific screen on the HMI device 
and can pass tag values from the shortcut to the defining screen using 
properties you create. Create a shortcut to create another version of a 
screen by changing the properties of the shortcut.   

Shortcuts appear in the Navigation Menu folder of the Project 
Explorer. Shortcuts also appear in the Navigation menu on the HMI 
device.  

Use the New Shortcut dialog box to: 

• Create a new shortcut. 
• Link a shortcut to a new or existing screen. 
• Open a new screen that is linked to the shortcut. 

See also 
Create a shortcut to an existing screen on page 102 

Open a shortcut on page 104 

Rename a shortcut on page 104 

Open the defining screen of a shortcut on page 105 

Shortcut customization on page 107 

The Shortcut tab displays the contents of the shortcut on the HMI 
device. A shortcut is a link to the screen on which the shortcut is based. A 

New Shortcut dialog box 

Shortcut tab 
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shortcut displays the same content as the screen to which it is linked. 
Create screen properties the shortcut can use to pass different tag values 
to a screen. This allows creating a reusable screen that multiple shortcuts 
can call using different tag values.   

Use shortcuts to provide operators: 

• Quick access to a screen. 
• A way to call the same screen with different data.  

Use the Shortcut tab to:  

• Specify the icon for the shortcut to appear on the Navigation 
menu of the HMI device.  

• Modify properties passed from the shortcut to the defining screen. 
• Open the defining screen of the shortcut. 

See also 
Open a shortcut on page 104 

Open the defining screen of a shortcut on page 105 

Change a user-defined property on page 368 

Restrict access to an item on the HMI device on page 354 

Create a shortcut to a screen in the Project Explorer to create a link to 
the existing screen. From the shortcut, change any properties defined for 
the screen. The values of these properties are passed from the shortcut 
to the screen so that the screen displays different data.   

Rockwell Automation recommends using no more than 200 shortcuts per 
project. Create many shortcuts in order to reuse a single screen and pass 
different values to the screen. Shortcuts appear in the Navigation Menu 
folder of the Project Explorer and in the Navigation menu on the HMI 
device.     

To create a shortcut to an existing screen 
• In the Project Explorer, use one of these methods: 

• Right-click a screen. In the User-Defined Screens folder or 
the Predefined Screens folder, right-click the screen on which 
to base the shortcut, and select New Shortcut. The new 
shortcut appears in the Navigation Menu folder. The new 
shortcut is given a default name that is identical to the screen 
name. Move the new shortcut within the Navigation Menu 
folder and its subfolders.  

• Drag a screen. Drag a screen from the User-Defined Screens 
folder or the Predefined Screens folder to the Navigation 
Menu folder.  

• Right-click a location. 
a. Right-click the Navigation Menu folder or one of its subfolders 

and select New Shortcut. 

Create a shortcut to an 
existing screen 
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b. In the Name box of the New Shortcut dialog box, type a 
unique name for the shortcut and select OK.  

c. Select Linked to an existing screen, navigate to select the 
screen that defines the shortcut, and select OK. The shortcut 
appears in the selected location in the Navigation Menu 
folder. Shortcuts with identical names in the same folder are 
appended with an increment number. 

 
Tips:  
• Create a shortcut to a new screen from the New Shortcut dialog box. 
• Creating a shortcut to a shortcut is not allowed. 
• To not have a shortcut appear in the Navigation menu on the HMI device, delete the shortcut. 

See also 
Create a shortcut to a new screen on page 103 

Rename a shortcut on page 104 

Move an item in the Project Explorer on page 556 

Create a user-defined property with a data type on page 365 

Create an alias property on page 361 

Create a shortcut to a screen that does not yet exist in the Project 
Explorer. Any changes made to the newly created screen and its 
properties are passed to the shortcut. If the screen that defines the 
shortcut contains property definitions, change those properties in the 
shortcut to customize the shortcut. 

Rockwell Automation recommends using no more than 200 shortcuts per 
project. A View Designer project for a PanelView 5310 can contain no 
more than a total of 100 screens and popups. A View Designer project for 
a PanelView 5510 can contain no more than a total of 500 screens and 
popups. Projects must have a minimum of one screen. Shortcuts appear 
in the Navigation Menu folder of the Project Explorer and in the 
Navigation menu on the HMI device. 

To create a shortcut to a new screen 
1. Right-click the Navigation Menu folder or one of its subfolders 

and select New Shortcut. 
2. In the Name box of the New Shortcut dialog box, type a unique 

name for the shortcut. Shortcut names are not case sensitive. 
Screen_001 and screen_001 are considered the same name. 

3. Select Linked to a new screen and type the name of the new 
screen. 

4. Select the Open screen check box to have the new screen open 
when creating a shortcut and screen. 

5. Select OK. The new screen appears in the User-Defined 
Screens folder and its shortcut appears in the Navigation Menu 
folder. If you selected the Open screen check box, the new 
screen opens. 

Create a shortcut to a new 
screen 
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Any changes you make to the new screen are reflected in any 
shortcut you create for the screen. 

See also 
Create a shortcut to an existing screen on page 102 

Rename a shortcut on page 104 

Move an item in the Project Explorer on page 556 

Create a user-defined property with a data type on page 365 

Create an alias property on page 361 

Open a shortcut to:  

• View its contents.   
• Change the contents of the screen that defines the shortcut.  
• Change the values of any user-defined screen properties that are 

passed to the defining screen of the shortcut.   
Changing the contents of a shortcut is not allowed. 

To open a shortcut 
1. In the Project Explorer, expand the Navigation Menu folder.  
2. Double-click the shortcut. The shortcut opens. 

See also 
Create a shortcut to an existing screen on page 102 

Create a shortcut to a new screen on page 103 

Open the defining screen of a shortcut 

Create a user-defined property with a data type on page 365 

Create an alias property on page 361 

The default shortcut in a project is named Screen_001. Rename a 
shortcut to make the name more meaningful. For example, give the 
shortcut a name that reflects the purpose, content, or targeted user of the 
shortcut. Names within a folder must be unique and are not case 
sensitive. For example, Bottling_Line and bottling_line are considered 
identical names.  

1. In the Project Explorer, expand the Navigation Menu folder. 
2. Click the shortcut once to select the item. 
3. Click the shortcut again and type the new name. 

 
Tip: Right-clicking the shortcut, selecting Rename, and then entering a new name also 
renames the shortcut. 

Open a shortcut 

Rename a shortcut 
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See also 
Open a shortcut on page 104 

Rename a shortcut on page 104 

Delete a shortcut on page 106 

Create a user-defined property with a data type on page 365 

Create an alias property on page 361 

Copy a shortcut to reuse it within a project.  

1. In the Project Explorer, expand the Navigation Menu folder. 
2. Right-click the shortcut and select Copy. 

 
Tip: To select multiple shortcuts, hold Ctrl and select the items. 

3. Right-click the location in the target Navigation Menu folder and 
select Paste.  

4. If the target folder contains a shortcut with the same name, select 
Keep Both to keep both shortcuts. The name of the new shortcut 
is appended with a number to distinguish it from the original. 

 
Tips:  
• Copying an item from a folder in the Project Explorer and then pasting it in the same folder in the 

same project creates a copy of the item. The name of the pasted item is appended with a number 
that increments with each copy. 

• Copy and paste shortcuts in the Navigation Menu folder only.  

See also 
Create a shortcut to an existing screen on page 102  

Rename a shortcut on page 104 

Open the defining screen of a shortcut on page 105 

Delete a shortcut on page 106 

Open the screen linked to a shortcut. From this defining screen, make 
changes to depict in the shortcuts of the defining screen. 

1. In the Project Explorer, expand the Navigation Menu folder.  
2. Point to the shortcut in the folder to identify the defining screen of a 

shortcut. The name of the screen linked to the shortcut appears in 
a tooltip. 

3. Right-click the shortcut and select Edit Definition. The screen on 
which the shortcut is based opens. 

 
Tips:  
• When a shortcut is open, select the link at the top of the shortcut to open the defining screen of 

the shortcut.  
• When both the defining screen and a shortcut of that defining screen are open, changes made to 

the defining screen do not appear in the shortcut until selecting the shortcut. 

See also 
Create a shortcut to an existing screen on page 102 

Open a screen on page 348 

Copy a shortcut 

Open the defining screen 
of a shortcut 
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Change a user-defined property on page 368 

Change a property on page 493 

Shortcut customization on page 107 

Close a shortcut to close items in a project that no longer need to be 
open. For example, close items that currently do not require viewing or 
editing.   

To close a shortcut 
• On the tab of the item, select Close . 

See also 
Delete a shortcut on page 106 

Rename a shortcut on page 104 

Copy a shortcut on page 105 

Open a shortcut on page 104 

Delete a shortcut from the Project Explorer to remove it from the 
project. A deleted shortcut no longer appears in the Navigation menu 
on the HMI device. Deleting a shortcut does not remove the screen linked 
to the shortcut. The defining screen remains in the User-Defined 
Screens or Predefined Screens folder of the Project Explorer. 
Deleting the shortcut designated as the Home screen is not allowed. You 
cannot undelete a shortcut. 

Prerequisites 
• If the shortcut to delete is the Home screen, designate another 

shortcut as the Home screen for the project.   

To delete a shortcut 
1. In the Project Explorer, expand the Navigation Menu folder. 
2. Right-click the shortcut and select Delete. The shortcut no longer 

appears in the Project Explorer. 

See also 
Specify a Home screen on page 553 

Rename a shortcut on page 104 

Close a shortcut on page 106 

Project Explorer on page 95 

Close a shortcut 

Delete a shortcut 
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A shortcut is a link to a screen that displays the same content as the 
screen. 

Customize a shortcut to create similar versions of a screen without 
recreating screens individually. To change the appearance and tag 
values in a shortcut, create property definitions for the defining screen 
and its contents in the Property Definition tab at the bottom of the 
defining screen. Aliased properties appear for each shortcut created for 
the screen. Change the values of the properties passed from the shortcut 
to the screen. This customizes the shortcuts of a screen.   

For example, assume a plant has 10 bottling lines. On the HMI device, 
you want to see production details for each line. You do not have to 
create 10 physical screens and bind tags for each line. Create one 
screen with property definitions. These properties then exist for each 
shortcut you create for the screen. Create 10 shortcuts and change the 
properties for each shortcut. For example, Shortcut 1 can pass the 
screen parameters for bottling line 1, and Shortcut 2 can pass the screen 
parameters for bottling line 2.  

Edit only the defined properties for a shortcut. To add or delete elements, 
or to change the properties of graphic elements on the screen, edit the 
screen that defines the shortcut. Any changes made to the defining 
screen are automatically reflected in the shortcuts of the screen.   

Shortcuts appear in the Navigation Menu folder of the Project 
Explorer. Shortcuts also appear as items in the Navigation menu on the 
HMI device. Press the item on the Navigation menu of the HMI device to 
access a shortcut. Rockwell Automation recommends a maximum of 200 
shortcuts per project.  

Shortcuts cannot have events or animations. The Properties window 
does not display the Events tab or the Animations tab for an open 
shortcut or a shortcut selected in the Project Explorer. 

See also 
Create a shortcut to an existing screen on page 102 

Create a shortcut to a new screen on page 103 

Open a shortcut on page 104 

Copy a shortcut on page 105 

Delete a shortcut on page 106 

 

Shortcut customization 
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Chapter 7 

Popups 

A popup is a window that is superimposed on the screen to show relevant 
information on the HMI device. A View Designer project for a PanelView 
5310 can contain no more than a total of 100 screens and popups. A 
View Designer project for a PanelView 5510 can contain no more than a 
total of 500 screens and popups. Projects must have a minimum of one 
screen. 

Use a popup to display relevant information or display a prompt on the 
HMI device screen. Popups open when an event occurs or you perform 
an action. One popup can be open on the HMI device screen at a time. 
The popup must be closed before further interaction with the screen is 
allowed. 

See also 
Create a popup on page 110 

Open a popup on page 110 

Resize a popup on page 115 

Rename a popup on page 115 

What is a popup? on page 118 

Use the Popup tab to view and modify the contents of a superimposed 
window to appear on a screen on the HMI device. A popup can show 
additional information for the open screen or a prompt to perform a task. 
Popups open when an event configured with an Open Popup command 
triggers.   

Use the Popup tab to:  

• Change the caption of a popup. 
• Insert and configure graphic elements on the popup like any other 

screen.  

See also 
Create a popup on page 110 

Change the caption on a popup on page 112 

Resize a popup on page 115 

Add a graphic element to a screen on page 136 

Popup contents on page 119 

Popup tab 
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Create a popup to superimpose a window on top of an open screen on 
the HMI device. A popup can show additional information for the screen 
or a prompt to perform a task. A View Designer project for a PanelView 
5310 can contain no more than a total of 100 screens and popups. A 
View Designer project for a PanelView 5510 can contain no more than a 
total of 500 screens and popups. Projects must have a minimum of one 
screen. 

 
Tip: Shortcuts and predefined screens do not count towards the number of screens and popups used. 

Popups exist in the User-Defined Screens folder of the Project 
Explorer. Default popups that open from the Settings screen on the HMI 
device exist in the Predefined Screens folder of the Project Explorer. 
Popups do not exist in the Navigation Menu folder because popups 
cannot appear as items in the Navigation menu on the HMI device. A 
popup opens on the HMI device using an event configured with an Open 
Popup command.  

To create a popup 
1. In the Project Explorer, right-click the User-Defined Screens 

folder. 
2. Select New Popup. A popup named Popup_001 or increment 

number is added to the folder. Popup names must be unique and 
are case insensitive. For example, Popup_001 and popup_001 
are considered identical names. 

 
Tips:  
• Add graphic elements, events, and animation to the popup like any other screen. 
• Create user-defined properties for a popup like any other screen. On the HMI device, user-defined 

properties pass a tag to the popup through a Navigation event such as Popup Open. 
• Popups do not support alarm tables. Do not add an alarm table to a popup. Add an alarm table to a 

screen only. 
• Size the popup and its elements so that all of the content on the popup appears on the HMI device. 
• Adding elements does not resize the popup.  
• Popups do not contain scroll bars.  
• Elements placed off the edge of the popup appear clipped on the HMI device. 

See also 
Change the background color of a popup on page 114 

Change the caption on a popup on page 112 

Rename a popup on page 115 

Remove the Close button from a popup on page 113 

What is a popup? on page 118 

Open a popup to view and modify its contents. 

1. In the Project Explorer, expand the User-Defined Screens 
folder. 

2. Double-click the popup to open the popup.  

Create a popup 

Open a popup 
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See also 
Change the caption on a popup on page 112 

Remove the caption from a popup on page 113 

Remove the Close button from a popup on page 113 

Resize a popup on page 115 

Close a popup on page 116 

Copy a popup to reuse it within or across View Designer projects.  Paste 
a popup into the same folder in the Project Explorer to create a copy of 
the popup and append the name with an increment number. Pasting a 
popup into the Predefined Screens folder is not allowed. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy a popup  
1. In the source project, in the Project Explorer, right-click the 

popup and select Copy. 

 
Tip: To select multiple popups, hold Ctrl and select the items. 

2. Right-click the target folder and select Paste. If the target folder 
contains a popup with the same name, select one of two options:  
• Select Replace to overwrite the existing popup. 
• Select Keep Both to keep both popups. The name of the new 

popup is appended with a number that increments with each 
copy. 

Copy a popup 
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Tips:  
• Copying a popup that contains an instance of an Add-On Graphic to a different project that does 

not contain a popup with the same name adds the definition of the Add-On Graphic to the Assets > 
Add-On Graphics folder of the Project Explorer and adds the Add-On Graphic to the Toolbox 
category indicated for the Add-On Graphic. 

• Copying a popup that contains an instance of an Add-On Graphic to a different project that 
contains an Add-On Graphic with the same name provides three options:   
• Keep Both. Append the name of the copied Add-On Graphic definition with _001 or increment 

number. The definition appears in the folder and the Add-On Graphic appears in the Toolbox.  
• Replace. Replace the existing Add-On Graphic definition with the copied definition. Any 

instances of the existing Add-On Graphic are updated with the new definition of the Add-On 
Graphic.  

• Cancel. Do not paste the copied Add-On Graphic definition into the project. 
• If pasting a popup with an Add-On Graphic replaces an alias property in the definition of an Add-On 

Graphic and that alias is linked in an instance, the alias property shows in the Properties window 
of the instance, and the alias remains linked to the value of the base property in the definition. 

• If pasting a popup with an Add-On Graphic replaces an alias property in the definition of an Add-On 
Graphic and that alias is unlinked in an instance, the alias property shows in the Properties window 
of the instance, but the alias property retains its value from the original Add-On Graphic definition. 
The value of the alias property is not linked to the base property of the pasted Add-On Graphic 
definition. 

• Copying a popup that has an Add-On Graphic with an image that exists in both the source and 
target projects displays a prompt to replace the image. Images are copied to the Assets > Images 
folder of the Project Explorer. 

• When copying a popup, any localized data associated with the popup and its children is also 
copied. 

See also 
Create a popup on page 110 

Rename a popup on page 115 

Delete a popup on page 116 

What is a popup? on page 118 

Reuse content on page 359 

A popup has a caption at the top by default. The caption is not the name 
of the popup in the Project Explorer. Change the caption to reflect the 
content or purpose of the popup.  

To change the caption on a popup 
1. In the Project Explorer, expand the User-Defined Screens 

folder. 
2. Double-click the popup to open the popup.  
3. At the top of the popup, double-click the caption and type a new 

caption or change the caption in the Properties window.  

 
Tips: 
• Binding the Caption box of the popup to a tag or expression includes the data in the caption.  
• Embedding a REAL tag value in a text display or popup caption shows 13 digits after the decimal 

point by default. To reduce the number of digits after the decimal point, use a truncate and divide 
operation. For example, to limit the number of digits shown after the decimal point to 3 digits, use 
the expression TRUNC(MyTag*10e2)/10e2. To show n+1 digits, use the expression 
TRUNC(MyTag*10en)/10en. 

Change the caption on a 
popup 
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See also 
Open a popup on page 110 

Remove the caption from a popup on page 113 

Remove the Close button from a popup on page 113 

Resize a popup on page 115 

Bind a property to a data item on page 508 

Remove a caption from a popup so the caption no longer appears at the 
top of a popup. A popup cannot move on the HMI device if the popup 
does not have a caption. 

1. In the Project Explorer, expand the User-Defined Screens 
folder. 

2. Select the popup.  
3. In the Properties window, select the Properties tab. 
4. Expand the Appearance category. 
5. Clear the CaptionVisible check box. The caption is removed from 

the popup. 

See also 
Properties tab on page 494 

Change the caption on a popup on page 112 

Remove the Close button from a popup on page 113 

Popup contents on page 119 

What is a popup? on page 118 

By default, Close  appears in the upper right corner of a popup. This 
button closes the popup on the HMI device. Without this button, 
dismissing the popup on the HMI device requires tapping elsewhere on 
the screen, opening the Navigation menu, or opening another screen or 
popup. An event with a Popup Close command can also close a popup 
on the HMI device.  

1. In the Project Explorer, expand the User-Defined Screens 
folder. 

2. Select the popup. 
3. In the Properties window, select the Properties tab. 
4. Expand the Appearance category. 
5. Clear the CloseButtonVisible check box. Close  is removed 

from the popup. 

See also 
Properties tab on page 494 

Remove the caption from a popup on page 113 

Events tab on page 447 

Remove the caption from a 
popup 

Remove the Close button 
from a popup 
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Popup contents on page 119 

What is a popup? on page 118 

Change the background color of a popup to a different color, gradient 
color, or custom color. Radial gradients are not supported for popup fill 
color.  

1. In the Project Explorer, expand the User-Defined Screens 
folder. 

2. Double-click the popup to open the popup.  
3. In the Properties window, click the Properties tab. 
4. Expand the Appearance category. 
5. In the FillColor box, select a color using one of these methods: 

• Type the Hex value in the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and represent the color channel 
values for red, green, and blue. For example, #ffff00 produces 
yellow. 

• Select the arrow or color swatch to open the Color Picker, and 
select or create a color.   

See also 
Create a popup on page 110 

Change the opacity of a popup on page 114 

Create a color gradient on page 498 

Select a fill color on page 141 

Create a custom color using the Color Picker on page 497 

Change the transparency level of a popup to make the popup more or 
less opaque. Make a popup less opaque to see graphic elements behind 
the popup when it opens on the HMI device.  

1. In the Project Explorer, expand the User-Defined Screens 
folder. 

2. Select the popup.   
3. In the Properties window, select the Properties tab. 
4. Expand the Appearance category. 
5. In the BackgroundOpacity box, enter the opacity percentage: 

• 0 (fully transparent) - 100 (fully opaque) 

See also 
Change the caption on a popup on page 112 

Change the background color of a popup on page 114 

Remove the caption from a popup on page 113 

Remove the Close button from a popup on page 113 

What is a popup? on page 118 

Change the background 
color of a popup 

Change the opacity of a 
popup 
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A popup has a preset size and appears centered on the screen in View 
Designer. Popups cannot move in View Designer, but popups can move 
on the HMI device. Resize a popup to better accommodate the contents. 
Resizing a popup does not change the size of graphic elements on the 
popup. Making a popup smaller may make graphic elements on the 
popup appear clipped on the HMI device. You cannot make a popup 
smaller than one inch.  

Popups do not rescale automatically when you change the HMI device 
size in Project Properties or download the project to a differently sized 
HMI device. 

1. In the Project Explorer, expand the User-Defined Screens 
folder. 

2. Double-click the popup to open the popup.  
3. On the screen, select the popup.  
4. Drag a sizing handle in a corner of the popup to resize the popup. 

When dragging a handle, the height and width of the popup shows 
in pixels. The dotted line surrounding the area outside the popup 
represents the screen of the HMI device. Releasing the mouse 
centers the popup. 

 
Tips:  
• Change the Height and Width properties in the Properties window to resize a popup. 
• Adding elements does not resize the popup. Size the popup and its elements so that all of the 

content on the popup appears on the HMI device. 
• Popups do not contain scroll bars.  
• You cannot rotate a popup. 

See also 
Change the caption on a popup on page 112 

Change the opacity of a popup on page 114 

Remove the Close button from a popup on page 113 

Remove the caption from a popup on page 113 

Popup contents on page 119 

By default, the initial popup created in a project is named Popup_001. 
This number is incremented when creating new popups. 

Rename a popup to make the name more meaningful. For example, give 
the popup a name that reflects the purpose, content, or targeted user of 
the popup. Names within a folder must be unique and are not case 
sensitive. For example, Bottling_Line and bottling_line are considered 
identical names. Renaming any popup in the Predefined Screens folder 
of the Project Explorer is not allowed. 

To rename a popup 
1. In the Project Explorer, expand the User-Defined Screens 

folder. 
2. Double-click the popup to open the popup.  

Resize a popup 

Rename a popup 
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See also 
Change the caption on a popup on page 112 

Remove the caption from a popup on page 113 

Remove the Close button from a popup on page 113 

Popup contents on page 119 

Open a popup on page 110 

Delete a popup from the Project Explorer to remove it from the project. 
You cannot undelete a popup. 

1. In the Project Explorer, expand the User-Defined Screens 
folder. 

2. Right-click the item and select Delete. The item is removed. 

See also 
Change the caption on a popup on page 112 

Remove the caption from a popup on page 113 

Remove the Close button from a popup on page 113 

Rename a popup on page 115 

Close a popup to close items in a project that no longer need to be open. 
For example, close items that currently do not require viewing or editing.    

• On the tab of the popup, select Close . 

See also 
Delete a popup on page 116 

Open a popup on page 110 

Popup contents on page 119 

Restore the default content of a screen, popup, or Banner item in the 
Predefined Screens folder of the Project Explorer to overwrite any 
changes made to the item. For example, restore the content of the 
Banner item to have the default content appear at the top of screens.   

1. With the revised item open, press CTRL+A to select all remaining 
content in the item and press Delete.  

2. Open another View Designer project and open the unchanged 
version of the item. 

3. With the unchanged item open, press CTRL+A to select all of the 
default content. 

4. Right-click a selected item and select Copy to copy the content to 
the clipboard. 

5. Right-click the empty revised item and select Paste. The default 
content of the item is restored.  

Delete a popup 

Close a popup 

Restore the default content 
of a predefined item 
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See also 
Predefined Screens folder on page 96 

What is the System Banner? on page 97 

What is the Settings screen? on page 97  

What is the Alarm Summary? on page 99 

What is the Alarm Manager? on page 99 

Screens, popups and the System Banner have a default update rate of 
500 milliseconds. Use the UpdateRate property to change the frequency 
rate for an element. 

 
Tip: If the high update rate negatively impacts performance, the HMI device automatically lowers the 
update rate value. 

To change the update rate of a screen, popup, or the System Banner 
1. In the Project Explorer, expand the User-Defined Screens or 

the Predefined Screens folder. 
2. Select the item to change. 
3. In the Properties window, select the Properties tab. 
4. Expand the General category. 
5. In UpdateRate, select the rate. 

• 100 ms 
• 250 ms 
• 500 ms 

 
Tips:  
• For best performance, on a PanelView 5310 HMI device use: 
• Up to 600 tag references on a screen at 500 ms update rate 
• Up to 200 tag references on a screen at 250 ms update rate 
• Up to 100 tag references on a screen at 100 ms update rate 

• For best performance, on a PanelView 5510 HMI device use: 
• Up to 800 tag references on a screen at 500 ms update rate 
• Up to 300 tag references on a screen at 250 ms update rate 
• Up to 150 tag references on a screen at 100 ms update rate 

• It is possible to use up to 2000 tag references on one screen, however, using more references than 
listed above may cause the HMI device to skip updates. 

See also 
What is a Popup? on page 118 

What is the System Banner? on page 97 

Create an alias property on page 361 

Add popups to cache to decrease their loading time. The cache size is 20 
MB and may not contain all of the popups in the project. Consider 
assigning only those popups that HMI operators open frequently. Popups 
upload to cache in the order they are placed in the Predefined Screens 
folder. 

Change the update rate of a 
screen, popup, or the 
System Banner 

Add popups to cache 
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To add popups to cache: 
1. In the Project Explorer, expand the User-Defined Screens or 

the Predefined Screens folder. 
2. Select a popup. 
3. In the Properties window, select the Properties tab. 
4. Expand the General category. 
5. Select the Cacheable property. 
6. Repeat for each popup you want to add to cache. 
7. Select Verify Project. View Designer displays a warning message 

for each Cacheable property that did not fit into the cache. 

See also 
Work with popups on page 109 

Create a popup on page 110 

A popup is a small window superimposed on the HMI device screen. A 
popup opens in response to an event or an action performed. An event 
configured with a Popup Open command opens a popup. Interacting 
with graphic elements on the HMI device screen while a popup is open is 
not allowed. You can interact with only the popup until you close the 
popup. Only one popup can open on the HMI device screen at a time.   

Popups can provide: 

• A method of showing data, including diagnostic information, 
related to the screen. 

• Additional information without having to open another screen. 
• A prompt to perform a task. 
• Access to additional events and animations. 

A popup has a caption at the top by default that describes the contents of 
the popup.  

Add graphic elements to a popup like any other screen. A popup does not 
change size when resizing or copying and pasting graphic elements. 
Create property definitions for a popup or its graphic elements to have 
those properties change the popup or its contents through an event or 
animation.  

See also 
Create a popup on page 110 

Popup contents on page 119 

Properties window on page 493 

What is an event? on page 476  

What is a popup? 
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A popup is a small window superimposed on a screen. A popup has 
basic components:  

 
Item Description 

 
An optional caption describing the contents and data the popup contains. On the 
HMI device, move a popup by dragging the caption. If a popup does not have a 
caption, the popup cannot move on the HMI device. 

 
An optional Close button. Select Close to close the popup on the HMI device. 
Other methods of closing popups include selecting elsewhere on the screen, 
opening the Navigation menu, opening another screen or popup, or creating an 
event with a Popup Close command. 

 
The contents of the popup.  

See also  
Popup on page 733 

 

Popup contents 
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Chapter 8 

System Banner 

The System Banner appears at the top of each screen configured to 
show the banner. If a screen is configured to show the System Banner, 
shortcuts to that screen show the banner. The System Banner contains 
a default set of items.  

Display the System Banner on screens to log on and off, navigate to 
screens, and display network and controller issues on the HMI device. 
Change the System Banner by changing its height, background color, 
and contents, or removing the System Banner.  

See also 
Open the System Banner on page 122 

Add a graphic element to the System Banner on page 123 

Restore the default content of a predefined item on page 116 

System Banner contents on page 127 

What is the System Banner? on page 97  

The System Banner is included in each project by default. It is a 
rectangular banner that appears at the top of each screen and shortcut. 
The System Banner contains a default set of items.  

There is only one System Banner per project. To omit the System 
Banner from screens or shortcuts, change the properties of the screen or 
shortcut. 

The Banner is a predefined screen. When open, the Banner appears in 
the Graphic Explorer. Open the Banner from the Project Explorer to:    

• Add, move, or remove elements from the System Banner. Include 
only graphic elements to appear on every project screen.  

• Change the appearance of the top of a screen by changing the fill 
color and height of the System Banner. 

• Configure the properties of graphic elements on the System 
Banner like any other graphic element.   

• Animate or create events for the System Banner or its graphic 
elements. 

See also 
What is the System Banner? on page 97 

System Banner contents on page 127 

Add a graphic element to the System Banner on page 123 

Banner tab 
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Remove the System Banner from a screen on page 125 

Change the background color of the System Banner on page 123 

Open the Banner item to add or change the contents of the System 
Banner. The System Banner contains default items.   

1. In the Project Explorer of the open project, expand the 
Predefined Screens folder. 

2. Double-click the Banner item. The System Banner opens.  

See also 
Remove the System Banner from a screen on page 125 

Change the background color of the System Banner on page 123 

Change the height of the System Banner on page 122 

System Banner contents on page 127 

By default, the System Banner appears at the top of each screen and 
shortcut in a project and contains a default set of items. Change the 
height of the System Banner to accommodate fewer or more elements.  

Before changing the height of the System Banner, consider the size of 
the HMI device screen. The default screen size is outlined below the 
open System Banner to help visualize how much room there is to resize 
the System Banner. Making the System Banner taller reduces the 
available space on the screen. Making the System Banner shorter adds 
to the available space on the screen.  

You can change only the height of the System Banner. You cannot 
change the width. Changing the height of the System Banner affects 
every screen in the project shows the System Banner.   

To change the height of the System Banner 
1. In the Project Explorer, expand the Predefined Screens folder. 
2. Select or double-click the Banner item to open the System 

Banner.  
3. In the Properties window, select the Properties tab. 
4. Expand the Position and Size category.  
5. In the Height box, enter: 

• A numeric value between 1 and the value representing 95% of 
the height of the screen. 

See also 
Add a graphic element to the System Banner on page 123 

Remove a graphic element from the System Banner on page 125 

Change the background color of the System Banner on page 123 

Project Explorer on page 95 

Open the System Banner 

Change the height of the 
System Banner 
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Change the background color of the System Banner that appears at the 
top of each screen in a project. Change the fill color of the banner to a 
different color, a gradient color, or a custom color.  

To change the background color of the System Banner 
1. In the Project Explorer, expand the Predefined Screens folder. 
2. Select the Banner item or double-click it to open the System 

Banner. 
3. In the Properties window, click the Properties tab.  
4. Expand the Appearance category. 
5. In the FillColor box, select a color using one of the these 

methods: 
• Type the Hex value in the format #RRGGBB. R, G, and B are 

Hex digits from 0 through F and represent the color channel 
values for red, green, and blue. For example, #ffff00 produces 
yellow. 

• Select the arrow or color swatch to open the Color Picker, and 
select or create a color.   

See also 
Bind a color property to a tag or expression on page 500 

Open the System Banner on page 122 

Add a graphic element to the System Banner on page 123 

Change the height of the System Banner on page 122 

Remove the System Banner from a screen on page 125 

By default, the System Banner appears at the top of each screen and 
shortcut in a project. Customize the System Banner by adding or 
deleting graphic elements.  

To add a graphic element to the System Banner  
1. In the Project Explorer, expand the Predefined Screens folder. 
2. Double-click the Banner to open the System Banner.   
3. From the Toolbox, drag the desired graphic element to the 

System Banner.   
• If any portion of the graphic element is placed off the edge of the 

banner rectangle on the Banner tab, that portion of the graphic 
element appears clipped in the System Banner on the HMI 
device.  

• Placing a graphic element on top of the banner rectangle on an 
open screen rather than on the Banner tab makes any portion 
of the graphic element that is on top of the rectangle on the 
screen not visible on the HMI device.  

• Graphic elements with valid tag values placed off the banner 
rectangle do not appear on the System Banner on the HMI 
device. Graphic elements with invalid tag values are outlined in 

Change the background 
color of the System Banner 

Add a graphic element to 
the System Banner 
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red. If a graphic element in error is placed near an edge or off 

the System Banner, an arrow with an Error icon  points in 
the direction of the graphic element. Tap the arrow to open the 
Error list for the graphic element. 

 
Tips:  
• Using the Graphic Explorer, view and change graphic elements that are on the System Banner.  
• Do not place a graphic element on top of the System Banner at the top of an open screen. Place 

the graphic element on the banner rectangle on the open Banner tab. Any portion of a graphic 
element placed on top of the System Banner on the Screen tab rather than on the Banner tab is not 
visible on the HMI device. 

• After adding a graphic element to the System Banner, configure the element like any other graphic 
element, such as change properties and add animations and events. 

• Adjust the height of the System Banner to accommodate additional graphic elements. However, 
increasing the height of the banner decreases the amount of available screen space. Consider the 
size of the screen on the HMI device when adding graphic elements to the System Banner. 

See also 
Remove a graphic element from the System Banner on page 125 

Change the background color of the System Banner on page 123 

Change the height of the System Banner on page 122 

System Banner contents on page 127 

Copy and paste graphic elements in the System Banner to repeat a 
graphic element at the top of each screen in the project. Configure 
copied graphic elements with different property values, animations, or 
events like any other graphic element. When copying and pasting 
graphic elements in the System Banner, leave space between items to 
make them more easily tapped on the HMI device.  

To copy and paste a graphic element on the System Banner 
1. In the Project Explorer, expand the Predefined Screens folder. 
2. Double-click the Banner item. 
3. On the System Banner, right-click the item and select Copy. 

 
Tip: To select multiple items, hold Ctrl and select the items. 

4. Right-click anywhere on the System Banner and select Paste.  
5. Drag the graphic element to the desired position on the banner 

rectangle.  

See also 
Remove a graphic element from the System Banner on page 125 

Change the background color of the System Banner on page 123 

Change the height of the System Banner on page 122 

System Banner contents on page 127 

Copy and paste a graphic 
element on the System 
Banner 
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Remove a graphic element from the System Banner to no longer show 
that item at the top of each screen and shortcut in a project.  

To remove a graphic element from the System Banner 
1. In the Project Explorer, expand the Predefined Screens folder. 
2. Double-click the Banner item. The System Banner opens.   
3. Select the graphic element on the System Banner and press 

Delete. The graphic element no longer appears on the System 
Banner. Removing a graphic element from the System Banner 
does not remove the item from the Toolbox.  

See also 
Remove the System Banner from a screen on page 125 

Change the background color of the System Banner on page 123 

Change the height of the System Banner on page 122 

System Banner contents on page 127 

The System Banner appears at the top of each screen in a project 
configured to show the System Banner. Remove the System Banner 
from any screen on which it is not to appear. Removing the System 
Banner from a screen does not remove the System Banner or its items 
from the project.  

To remove the System Banner from a screen 
1. In the Project Explorer, expand the User-Defined Screens 

folder. 
2. Select the screen.  
3. On the Properties tab, expand the General category. 
4. Clear the ShowDefaultBanner check box. The System Banner 

no longer appears at the top of the screen. 

 
Tip: Graphic elements placed at the top of the screen where the System Banner was located 
do not cover the System Banner on the HMI device if you later select the ShowDefaultBanner 
box again. For example, if you clear the ShowDefaultBanner box, place a rectangle at the top 
of the screen, and then select the ShowDefaultBanner box, the rectangle may cover the 
System Banner in View Designer. However, the rectangle does not cover the System Banner 
on the HMI device. 

See also 
Add a graphic element to the System Banner on page 123 

Remove a graphic element from the System Banner on page 125 

System Banner contents on page 127 

Change the background color of the System Banner on page 123 

Change the height of the System Banner on page 122 

Remove a graphic element 
from the System Banner 

Remove the System Banner 
from a screen 
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Close the System Banner when viewing or changing the banner is no 
longer required.    

To close the System Banner 

• On the Banner tab, select Close .  

See also 
System Banner contents on page 127 

Remove a graphic element from the System Banner on page 125 

Remove the System Banner from a screen on page 125 

System Banner contents on page 127 

Restore the default content of a screen, popup, or Banner item in the 
Predefined Screens folder of the Project Explorer to overwrite any 
changes made to the item. For example, restore the content of the 
Banner item to have the default content appear at the top of screens.   

To restore the default content of a predefined item 
1. With the revised item open, press CTRL+A to select all remaining 

content in the item and press Delete.  
2. Open another View Designer project and open the unchanged 

version of the item. 
3. With the unchanged item open, press CTRL+A to select all of the 

default content. 
4. Right-click a selected item and select Copy to copy the content to 

the clipboard. 
5. Right-click the empty revised item and select Paste. The default 

content of the item is restored.  

See also 
Predefined Screens folder on page 96 

What is the System Banner? on page 97 

What is the Settings screen? on page 97  

What is the Alarm Summary? on page 99 

What is the Alarm Manager? on page 99 

Screens, popups and the System Banner have a default update rate of 
500 milliseconds. Use the UpdateRate property to change the frequency 
rate for an element. 

 
Tip: If the high update rate negatively impacts performance, the HMI device automatically lowers the 
update rate value. 

Close the System Banner 

Restore the default content 
of a predefined item 

Change the update rate of a 
screen, popup, or the 
System Banner 
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To change the update rate of a screen, popup, or the System Banner 
1. In the Project Explorer, expand the User-Defined Screens or 

the Predefined Screens folder. 
2. Select the item to change. 
3. In the Properties window, select the Properties tab. 
4. Expand the General category. 
5. In UpdateRate, select the rate. 

• 100 ms 
• 250 ms 
• 500 ms 

 
Tips:  
• For best performance, on a PanelView 5310 HMI device use: 
• Up to 600 tag references on a screen at 500 ms update rate 
• Up to 200 tag references on a screen at 250 ms update rate 
• Up to 100 tag references on a screen at 100 ms update rate 

• For best performance, on a PanelView 5510 HMI device use: 
• Up to 800 tag references on a screen at 500 ms update rate 
• Up to 300 tag references on a screen at 250 ms update rate 
• Up to 150 tag references on a screen at 100 ms update rate 

• It is possible to use up to 2000 tag references on one screen, however, using more references than 
listed above may cause the HMI device to skip updates. 

See also 
What is a Popup? on page 118 

What is the System Banner? on page 97 

Create an alias property on page 361 

By default, a System Banner appears at the top of each screen in a 
project. The System Banner contains a default set of items: 

 
Item Description 

 
 

Alarm Status Indicator opens the Alarm Summary screen on the HMI device. 

•  Shows there are no alarms. 

•  Turns red and flashes when there are active alarms that are unacknowledged. The numbered notification 
shows the number of unacknowledged alarms. 

•  Returns to a gray icon with a numbered notification showing the number of unacknowledged alarms when 
all alarms return to normal but some alarms are still unacknowledged.  

•  Turns to red when there are active alarms and all of them are acknowledged.  

  
Automatic Diagnostics Indicator opens Automatic Diagnostics screen on the HMI device. The button shows a 
notification with the number of active diagnostics. The button returns to an outlined icon when no diagnostics are 
active. 

  Previous displays the previous screen in the navigation history on the HMI device. 

  Next displays the next screen in the navigation history on the HMI device. To navigate with Next requires displaying 
a previous screen first. 

System Banner contents 
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  Navigation displays the Navigation menu at the bottom of the screen on the HMI device. Use the Navigation menu 
to display shortcuts and folder contents. 

  
Log On logs on or off the project. The name of the logged on user appears in the System Banner. The logged on 
user sees only the screens for which the assigned user role has access. 

 
General Diagnostics Status for the data log status and project event errors. These icons appear depending on the status of data 
export and project events. 

•  Data export ongoing. The data log is exporting.  

•  Data export error. The data log is in error while collecting data or exporting. 

•  Data export remove. The media containing the data log is ready to remove without corrupting files or making files 
read-only on the USB storage device or SD card. 

•  Data export warning. Tags in the data log are in error. Select the icon to view the error details.  
A data log status icon only appears when a project contains a data log and there are no project event errors. 

•  Error. Project events and data logs are in error. Select this icon to open the predefined popup for data log and project 
event status details.  

•  Project Event. Project events are in error. Select the icon to view the error details. The Project Event error icon only 
appears when a project event is in error. 

 

 
A Network Status icon appears only if there is an issue with network communication. Select the icon to open the HMI Device 
Configuration Network popup for details about the issue. 

•   Network caution. The network is functioning but has an issue that requires attention. For example, the Device Level 
Ring may have a break.  

•   Network error. The network is not functioning. An Ethernet link is disconnected, or there is a duplicate IP address. 

 
A Controller Status icon appears only if there is an issue with any controller in the project. Select the icon to open the Controllers 
General popup for details about the issue. 

•  Controller error. Any controller in the project is disconnected, powered down, or not configured. 

•  Controller caution. Any controller in the project is not in Run mode or the tag data of a controller is not synchronized 
with the HMI device. 

•  Controller unknown. No controller in the project is visible and it is unclear if a controller should be visible to the HMI 
device. This may occur when a controller is on a disconnected side of the network.  

 
The current time and date of the HMI device.  

See also 
Add a graphic element to the System Banner on page 123 

Remove a graphic element from the System Banner on page 125 

Change the background color of the System Banner on page 123 

Change the height of the System Banner on page 122 

The System Banner appears at the top of each screen configured to 
show the System Banner, and each shortcut to which you have access. 
The System Banner contains a default set of items. Security access to 
the System Banner cannot be set for a particular role. You can remove 
the System Banner from a screen or shortcut through the Properties 
window for the selected screen or shortcut.  

You can change the height of the System Banner, but not the width. The 
System Banner is always as wide as the screen.    

If you do not scale screens and change the HMI device type for your 
project, this affects the System Banner. For example, blank space 
appears to the right of the System Banner when you configure the 

What is the System Banner? 
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project for larger HMI device screens. Space to the right of the System 
Banner is removed when you configure the project for smaller HMI 
device screens. When you do not scale screens and change project 
settings to a smaller HMI device, elements may appear clipped at the 
right end of the System Banner on the HMI device.   

See also 
Open the System Banner on page 122 

Add a graphic element to the System Banner on page 123 

Remove a graphic element from the System Banner on page 125 

Remove the System Banner from a screen on page 125 

System Banner contents on page 127 
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Chapter 9 

Add a graphic element to a project 

Create screen content by adding graphic elements from the Toolbox or 
drawing free-form shapes. Rockwell Automation recommends using no 
more than 500 graphic elements, including image graphic elements, on a 
screen. 

After adding a graphic element to a screen, control its appearance and 
behavior by changing its properties, binding it to a tag, and associating it 
with an animation or event. 

See also 
Toolbox on page 131 

Add a graphic element to a screen on page 136 

Draw a line, polyline, or polygon on page 133 

Add an image to a screen on page 326 

Group graphic elements on page 151 

The Toolbox contains the drawing tools and graphic elements to use 
when creating the screens for an HMI project. The graphic elements are 
grouped into categories. Search the Toolbox to find a specific graphic 
element or types of graphic elements. 

Use the Toolbox to: 

• Draw free-form and one-dimensional objects, such as lines, 
rectangles, and ovals. 

• Add graphic elements, Add-On Graphics, and images to a screen. 
• Search for a graphic element or Add-On Graphic. 
•  

Tip: The spacing around content within a graphic element may differ on View 
Designer screens that are targeted to different HMI devices. This is due to the 
different HMI devices having different DPI values. However, text wrapping for 
content within a graphic element is usually the same from View Designer to an 
HMI device.  

See also 
Graphic elements library on page 153 

Add a graphic element to a screen on page 136 

Add an image to a screen on page 326 

Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 

Toolbox 
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Use the Graphic Explorer to display the contents of an open screen in 
tree form, including graphic elements and groups and their contents. 
This is helpful when changing an element of a group that is hidden by 
other elements. 

Selecting a graphic element or a group on the screen highlights the 
corresponding item in the Graphic Explorer. Selecting a graphic 
element or a group in the Graphic Explorer selects the corresponding 
item on the screen.  

Right-clicking in the Graphic Explorer displays the same options that 
appear when right-clicking a screen, group, or graphic element on the 
screen.  

Use the Graphic Explorer to: 

• View the names of the graphic elements and groups used in a 
screen. 

• View and change the stacking order of the graphic elements. 
• Group and ungroup graphic elements. 
• Identify and manage element groups. 
• Delete graphic elements. 
• Lock and unlock graphic elements. 

See also 
Select a graphic element in the Graphic Explorer on page 138 

Change the stacking order of graphic elements and groups on 
page 148 

Lock or unlock graphic elements on page 132 

Group graphic elements on page 151 

Lock graphic elements to prevent them from moving when developing a 
screen or the definition of an Add-On Graphic. Locked graphic elements 
cannot be selected or affected by keyboard or mouse input. Locking a 
graphic element does not affect the application on the HMI device. 
Locking screens and popups is not supported. 

To lock or unlock a graphic element: 
• In the Graphic Explorer, point to the graphic element. 

• To lock a graphic element, select Unlock . Unlock changes 
to Lock  to indicate the graphic element is locked. 

• To unlock a graphic element, select Lock . Lock changes to 
Unlock  to indicate the graphic element is unlocked. 

See also 
Graphic Explorer on page 132 

Move a graphic element on page 142 

Graphic Explorer 

Lock or unlock graphic 
elements 
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Resize a graphic element on page 144 

The Toolbox provides the drawing tools used in creating the screens for 
an HMI project.  

Use the drawing tools to draw free-form and one-dimensional objects, 
such as lines, rectangles, and ovals. 

See also 
Draw a line, polyline, or polygon on page 133 

Toolbox on page 131 

Group graphic elements on page 151 

Use the Rectangle Tool to draw rectangles or squares.  

To draw a rectangle or square: 
1. In the Toolbox, select the Rectangle Tool . 
2. On the screen, position the crosshair where the square or 

rectangle is to begin.  
• To draw a rectangle, click and drag.  
• To draw a square, press and hold Shift and drag. 

 
Tip: Use Smart Guides to help position the shape.  

See also  
Toolbox on page 131 

Smart Guides on page 146 

Use the Line Tool to draw a line, or the Pen Tool to draw a polyline, 
polygon, or line. 

To draw a line, polyline, or polygon: 
• In the Toolbox, select a tool to draw the item: 

• Line. Select the Line Tool  and drag to draw the line.   
• Polyline. Select the Pen Tool  and select points on the 

screen.  
• Polygon. Select the Pen Tool , select points on the screen, 

and then select the initial point to close the polyline shape.  

 
Tips:  
• Selecting the Pen Tool  and selecting a start and end point draws a line.  
• Use Smart Guides to help position the line. 
• To change the shape of a polyline or polygon, select the sizing handle in the middle of a line 

segment. 
• To remove a segment from a polyline or polygon, select the sizing handle at the end of the 

segment. 
• The selected drawing tool remains active until selecting a different drawing tool.  

Use drawing tools 

Draw a rectangle or square 

Draw a line, polyline, or 
polygon 
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See also 
Toolbox on page 131 

Smart Guides on page 146 

Use the Ellipse Tool to draw an oval or a circle. 

To draw an oval or circle: 
1. In the Toolbox, select the Ellipse Tool .  
2. On the screen, select where the oval or circle is to begin. 

• To draw an oval, drag to the desired size. 
• To draw a circle, press and hold Shift and drag. 

 
Tips:  
• Use Smart Guides to help position the shape. 
• To change the shape of an oval or circle, use the sizing handles. 
• The selected drawing tool remains active until selecting a different drawing tool.  

See also  
Toolbox on page 131 

Smart Guides on page 146 

Use the Arc Tool to draw a curved line on the screen. 

To draw an arc 

1. In the Toolbox, select the Arc Tool . 
2. On the screen, select the beginning point of the arc. 
3. Select a second point to determine the span and the direction of 

the arc. 
4. Select a third point to determine the height of the arc. 

 
Tips:  
• Use Smart Guides to position the shape. 
• The selected drawing tool remains active until you select a different drawing tool.  

See also  
Toolbox on page 131 

Smart Guides on page 146 

Create screen content by adding graphic elements from the Toolbox. 
Rockwell Automation recommends using no more than 500 graphic 
elements, including image graphic elements, on a screen.  

After adding a graphic element to a screen, control its appearance and 
behavior by changing its properties, binding it to a tag, and associating it 
with an animation or event. 

Draw an oval or circle 

Draw an arc 

Work with graphic elements 
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See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Graphic elements library on page 153 

Group graphic elements on page 151 

Add an image to a screen on page 326 

Use the Toolbox search feature to find a specific graphic element or 
types of graphic elements in the Toolbox.  

To find a graphic element in the Toolbox: 
1. In the Toolbox search box, type the name of the graphic element 

or a keyword.  
• Search text can contain alphanumeric characters and can be 

full words, fragments of a word, or a single letter or number. 
• Search text is not case-sensitive. 

Press Enter. The results display in the Search Results window in the 
Toolbox. Select   in the Toolbox search box to clear the search 
results. 

Use operators and filters 
• Use operators to narrow the search. Type one or more of the 

following operators with the keywords. 
To search for: Use this operator: Example: 

Two or more keywords AND (all capital letters) reactor AND tank 
returns a list of graphic elements 
with both words in their name or 
description. 

One of several keywords OR (all capital letters) reactor OR tank returns 
a list of graphic elements with the 
word in their name or description. 

Exact keywords " " (quotation marks) "reactor tank" returns 
a list of graphic elements with those 
exact keywords in that specific 
order. 

• Use one or more filters to narrow the search. Select to display 
the list of filters. Select a filter name to add it to the search box and 
type the keyword or keywords.  
To filter the search by: Select this filter: Or type this 

shortcut: 
Example: 

The name of a graphic element Name n: Name:rea
ctor tank 
or 
n:reacto
r tank 

Find a graphic element in 
the Toolbox 
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One or more words or part of a 
word in the description 

Description d: Descript
ion:show 
fill or 
d:show 
fill 

A Toolbox category Category c: Category
:tank or 
c:tank 

• Combine operators and filters.  For example: n:reactor AND 
tank returns a list of graphic elements that have reactor and tank 
in their name. 

• Use a previous search. Select the down arrow to see a list of your 
previous searches. Select one to add it to the search box. 

See also 
Toolbox on page 131 

Graphic elements library on page 153 

Add up to 500 graphic elements, including Add-On Graphics and Image 
graphic elements, to a screen. After adding a graphic element to a 
screen, change its appearance and behavior by changing its properties, 
binding it to a tag, and associating it with an animation or event. 

To add a graphic element to a screen 
1. In the Toolbox, click a category to display the graphic elements in 

that category.  
2. Drag a graphic element onto the screen. You can also double-click 

a graphic element in the Toolbox to add it to the center of the 
screen. If a graphic element is already selected on the screen, the 
new graphic element is placed on top of it. 

 
Tips: • If the outline of an empty Add-On Graphic appears on the screen, the 

definition of the Add-On Graphic is empty. Add graphic elements to the 
Add-On Graphic by changing the definition of the Add-On Graphic. All 
instances of the Add-On Graphic then update to display the contents of 
the Add-On Graphic. 

• Add a graphic element that is used in a different project by copying and 
pasting the graphic element between the projects. 

• If you know the name or type of the graphic element you want to add, use 
the search feature for the Toolbox. 

• The name of each graphic element ends with a number that increments 
by one each time you add an instance of that element. For example, 
TextDisplay_002 indicates a second instance of the Text Display graphic 
element on the screen. 

 

Add a graphic element to a 
screen 
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Important: • If you place a lot of content on your screens, such as large images, the 
HMI device can run out of memory. The Properties tab displays the size 
of the image. Use the predefined HMI Device screen to monitor memory 
usage. If the HMI device runs out of memory while it is running an 
application, it restarts and provides an error message indicating that an 
out-of-memory condition occurred. 

• If the computer running View Designer runs out of memory, View 
Designer shuts down and provides a message indicating that an 
out-of-memory condition occurred. View Designer retains the last saved 
version of the project. 

See also 
Toolbox on page 131 

Change the properties of a graphic element on page 139 

Bind a property to a data item on page 508 

Copy a graphic element on page 138 

Add an Add-On Graphic to a screen on page 394 

Select single or multiple graphic elements on a screen to perform actions 
or display properties.  

To select a graphic element on a screen 
• Select individual or multiple graphic elements: 

• Single graphic element. Select the graphic element. 
• Multiple graphic elements. Select the screen canvas above 

the graphic elements and drag diagonally to create a selection 
border around the graphic elements. When all the graphic 
elements are inside the border, release the mouse button. 
Sizing handles on all of the selected graphic elements replace 
the border.   

• Additional graphic elements outside of selection. To select 
graphic elements that are outside of the border, press and hold 
Ctrl while selecting each additional graphic element, or hold 
Ctrl while dragging to select additional graphic elements. 

• All graphic elements on a screen. Press Ctrl+A. 

 
Tips:  
• To deselect all selected graphic elements, select the screen. 
• If a screen contains a lot of content or overlapping graphic elements, use the Graphic Explorer to 

select a graphic element from a list of the graphic elements contained on the screen. 

See also 
Graphic Explorer on page 132 

Select a graphic element in the Graphic Explorer on page 138 

Select a graphic element on 
a screen 
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Select one or more graphic elements in the Graphic Explorer to perform 
actions on them or display their properties.   

To select a graphic element in the Graphic Explorer: 
1. Select View > Graphic Explorer to open the Graphic Explorer.  
2. (optional) If the graphic element is contained in a group, expand 

the group in the Graphic Explorer. 
3. To select: 

• A single graphic element, select the graphic element. 
• Multiple graphic elements, press and hold Ctrl while you select 

each element. 

 
Tip: To deselect the selected graphic elements, select the screen. 

See also 
Graphic Explorer on page 132 

Select a graphic element on a screen on page 137 

Copy a graphic element to reuse it on screens within a project or across 
View Designer projects. Copying a graphic element copies all of its 
properties, animations, and events. Copy single, multiple, or groups of 
graphic elements. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy a graphic element 
1. On the source screen or in the Graphic Explorer, right-click the 

graphic element and then select Copy. 
• To select multiple graphic elements or groups, hold Ctrl and 

select the items. 
2. On the target screen, right-click the location to paste the items and 

then select Paste. 

 
Tips:  
• If the target screen contains a graphic element with the same name, the name of the new graphic 

element is appended with a number that increments with each copy. 
• To cut a graphic element, right-click the graphic element and select Cut. 
• When copying a graphic element, any localized data associated with the graphic element is also 

copied. 

Select a graphic element in 
the Graphic Explorer 

Copy a graphic element 
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See also 
Graphic Explorer on page 132 

Duplicate a graphic element on page 150 

Reuse content on page 359 

Copy an instance of an Add-On Graphic within a project on page 
397 

Copy an instance of an Add-On Graphic between projects on page 
398 

Delete a graphic element or Add-On Graphic from a screen or from the 
Graphic Explorer. Deleting a graphic element or Add-On Graphic from 
a screen or the Graphic Explorer does not delete it from the Toolbox.  

To delete a graphic element: 
• On the screen or in the Graphic Explorer, select the graphic 

element or Add-On Graphic and press Delete. 

 
Tips:  
• To delete an Add-On Graphic from a project, delete all instances of the Add-On Graphic from the 

project and then delete the Add-On Graphic from the Project Explorer.   
• Alternate methods of deleting a graphic element include: 
• Right-clicking the element and selecting Delete. 
• Selecting the element and pressing Ctrl+X. 

• To select multiple graphic elements to delete, hold Ctrl while selecting each graphic element. 

See also 
Graphic Explorer on page 132 

Select a graphic element on a screen on page 137 

Delete an Add-On Graphic from a project on page 379 

Change the attributes of a graphic element or Add-On Graphic, such as 
position and size, using the Properties tab in the Properties window. 

To change the properties of a graphic element 
1. On the screen or in the Graphic Explorer, select the graphic 

element.  
• To select multiple elements, press and hold Ctrl while selecting 

each graphic element.  
• To select all of the graphic elements, press Ctrl+A. 

2. In the Properties window, select the Properties tab to display the 
properties for the selected graphic element 

 
Tip: Select multiple instances of Add-On Graphics to change the properties common to each 
instance instead of having to select and change the property values of each Add-On Graphic 
instance individually. 

3. Change any or all of the properties:  

Delete a graphic element 

Change the properties of a 
graphic element 
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• Type or select a value. 
• Bind the property to a data item. 

See also   
Add an Add-On Graphic to a screen on page 394 

Properties tab on page 494 

Graphic Explorer on page 132 

Bind a property to a data item on page 508 

Propagation of Add-On Graphic changes on page 393 

Change the text in any graphic element that displays text. For example, 
change the text on a button in the project. 

To change the text in a graphic element: 
• On the screen, double-click the graphic element to highlight the 

text and type the new text. 

 
Tips:  
• Resizing the width of a graphic element that displays text wraps the text as necessary. 
• Resizing the height of a graphic element that displays text does not resize the text to fit. Resize 

the height of the graphic element to display the text. 
• As an alternative, on the Properties tab, type the text in the Text property box for the graphic 

element.   
• To resize the text within a graphic element while resizing the graphic element, hold Ctrl while 

dragging a sizing handle. 
• Resizing an instance of an Add-On Graphic scales the text of any graphic element contained in the 

definition of the Add-On Graphic.  
• View Designer supports Unicode characters that appear in the Arial Unicode MS font. When 

inserting text that contains Unicode characters in a graphic element, select Arial Unicode MS in  
the FontName property of the graphic element. Supported Unicode characters appear on the HMI 
device. 

See also 
Toolbox on page 131 

Properties tab on page 494 

Change the properties of a graphic element on page 139 

Select a graphic element on a screen on page 137 

Change the color of the text that appears in a graphic element or Add-On 
Graphic. 

To select a text color 
1. Select the graphic element on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance node. 

Change the text in a graphic 
element 

Select a text color 
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4. In the FontColor box, select a text color using one of the following 
methods:  
• Type the Hex value in the format #RRGGBB. R, G, and B are 

Hex digits from 0 through F and represent the color channel 
values for red, green, and blue. For example, #ffff00 produces 
yellow. 

• Select the arrow or color swatch to open the Color Picker, and 
select or create a color. 

 
Tip: To save the selected color as a swatch, select Add . 

See also 
Color Picker on page 495 

Create a color gradient on page 498 

Select a fill color on page 141 

Bind a color property to a tag or expression on page 500 

Color Picker overview on page 495 

Select a solid or gradient color to fill a graphic element or the background 
of a screen or popup. 

To select a fill color 
1. In the Properties window, select the Properties tab. 
2. Expand the Appearance category.  

If the selected item has color properties you can change, those 
properties appear in this category. The currently applied color for a 
property appears as a swatch on the Property tab. 

3. In the FillColor property box, select a color using one of the 
following methods:  
• Type the Hex value in the format #RRGGBB. R, G, and B are 

Hex digits from 0 through F and represent the color channel 
values for red, green, and blue. For example, #ffff00 produces 
yellow. 

• Select the arrow or color swatch to open the Color Picker, and 
select or create a color.   

• Create a color gradient. 

 
Tips:  
• To save the selected color as a swatch, select Add . 
• Colors and gradients of some graphic elements may look different on the HMI device due to screen 

type and resolution. 
• Radial gradients are not supported for popup FillColor. 

See also 
Color Picker on page 495 

Create a color gradient on page 498 

Select a fill color 
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Select a text color on page 140 

Bind a color property to a tag or expression on page 500 

Create a custom color using the Color Picker on page 497 

Move graphic elements by using a mouse, a keyboard, or by changing its 
properties.  

To move a graphic element: 
• Using the mouse. On the screen, select and drag a graphic 

element to the desired location. 
• Using the keyboard. Select the graphic element to select it. 

• To move the graphic element 1 pixel, press the arrow key in the 
preferred direction.   

• To move the graphic element 10 pixels at a time, press 
Shift+an arrow key.  

• Changing the properties of the graphic element.  
1. Select a graphic element. 
2. On the Properties window, select the Properties tab and 

expand the Position and Size category. 
3. Enter any positive number in the X and Y properties: 

X. Specifies the horizontal coordinate, in pixels, from the upper 
left corner of the screen to the upper left corner of an unrotated 
graphic element, or to the center of a rotated graphic element. If 
the graphic element is in a group, X is relative to the parent. 
Y. Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of an unrotated graphic 
element, or to the center of a rotated graphic element. If the 
graphic element is in a group, X is relative to the parent. 

 
Tip: Green lines called Smart Guides appear when moving a graphic element with the 
mouse to help position the graphic element with precision. Smart Guides do not appear 
when using the keyboard or the X and Y properties to move a graphic element. 

See also 
Properties tab on page 494 

Align graphic elements on page 145 

Distribute graphic elements on page 149 

Lock or unlock graphic elements on page 132 

Rotate a graphic element on page 142 

Change the angle of a graphic element by rotating the graphic element. 

IMPORTANT Do not rotate the PDF Viewer graphic element or PDF Add-On Graphic. Rotating an element 
containing a PDF document reduces the clarity of content in the PDF document and 
prevents zooming and navigating the PDF document on the HMI device. 

Move a graphic element 

Rotate a graphic element 
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To rotate a graphic element 
1. Select the graphic element. 
2. Position the cursor on a corner sizing handle until it turns into a 

curved double-arrow. 
3. Drag to rotate the element. A tooltip displays the angle as you 

rotate the graphic element. The rotation angle is based on the 
center point of the graphic element. 

 
Tips:  
• The top left sizing handle is a circle so that you can identify the original top left corner after you rotate a graphic 

element or group. 
• To rotate multiple graphic elements, press and hold Ctrl while selecting the graphic elements. Use any sizing handle 

and drag to rotate all of the graphic elements.  
• Pressing Shift while rotating elements constrains the rotation to 45-degree steps. 
• Rotate a graphic element by changing the value of the Angle property in the Properties tab. Enter 180 to display the 

element upside down. When entering a value larger than 360, the portion of the numeric value that exceeds 360 
becomes the value. For example, enter 380 to enter a value of 20. If you enter a value less than 0, the negative value is 
subtracted from 360. For example, enter -30 to enter a value of 330.  

• The background of an Add-On Graphic may resize when rotating a graphic element in the definition of the Add-On 
Graphic. 

• Rotating the List Box Indicator and List Box Selector graphic elements is not supported. 
• View Designer does not support rotating a PDF Viewer graphic element or a PDF Add-On Graphic.  

See also 
Lock or unlock graphic elements on page 132 

Move a graphic element on page 142 

Graphic Explorer on page 132 

Flip a graphic element or Add-On Graphic to create a reverse image of 
the element.  

To flip a graphic element: 
1. On the screen or in the Graphic Explorer, right-click the graphic 

element and select Flip. 
2. Select one of the following options: 

• Horizontal. Flips the graphic element along its horizontal axis.  
• Vertical. Flips the graphic element along its vertical axis.  

 
Tips:  
• Alternate methods to flip a graphic element: 
• On the Drawing toolbar, select the Flip down arrow, and select an option. 
• Select Arrange > Flip, and select an option.  

• Flipping a graphic element that contains text does not flip the text. 
• Flip rotated graphic elements. The new rotation angle displays in the Angle property for the graphic 

element. 
• Flipping groups of graphic elements is supported. Flipping individual graphic elements within a 

group is not supported. 
• When flipping a graphic element in the definition of an Add-On Graphic, the background of the 

Add-On Graphic may resize to fit the flipped graphic element. 
• Flipping screens, popups, the definition of an Add-On Graphic, or the System Banner is not 

supported. 

Flip a graphic element 
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See also 
Add a graphic element to a screen on page 136 

Align graphic elements on page 145 

Change the stacking order of graphic elements and groups on 
page 148 

Graphic Explorer on page 132 

Resize any graphic element or instance of an Add-On Graphic. The 
Height and Width values of a resized graphic element appear in the 
Properties tab. 

To resize a graphic element 
1. Select the graphic element to resize. 
2. Position the cursor on a sizing handle  until it turns into a 

double-arrow. 
• To change the width or height of a graphic element, drag a side 

sizing handle. 
• To change both the width and height of a graphic element, drag 

a corner sizing handle. 
• To maintain the aspect ratio between width and height, hold 

Shift as you drag a sizing handle. 
• To maintain the center point of a graphic element, hold Alt as 

you drag a sizing handle. 
• To maintain the aspect ratio and center point of a graphic 

element, hold Shift+Alt as you drag a corner sizing handle. 
• To resize the text within a graphic element while you resize the 

graphic element, hold Ctrl as you drag a sizing handle. 

 
Tips:  
• A tooltip shows the height and width of the graphic element as you resize it. 
• The font size configured for a graphic element with a text value determines the height of the 

graphic element. If you resize or rotate a Text Input graphic element, the font size does not 
change. 

• If you resize an element while multiple graphic elements are selected, each element is resized and 
the proportion is maintained. The height and width shown in pixels are for the selection you are 
resizing.  

• Resizing an instance of an Add-On Graphic scales the text of any graphic element contained in the 
definition of the Add-On Graphic.     

• Changing the size of an instance of an Add-On Graphic does not change any other instance of the 
Add-On Graphic in the project. The proportion of each graphic element within the Add-On Graphic 
is maintained as the instance of the Add-On Graphic is resized. Resizing an instance of an Add-On 
Graphic does not affect the definition of the Add-On Graphic. 

See also 
Add an Add-On Graphic to a screen on page 394 

Graphic Explorer on page 132 

Group graphic elements on page 151 

Lock or unlock graphic elements on page 132 

Resize a graphic element 
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Work with groups on page 313 

Align selected graphic elements and Add-On Graphics vertically and 
horizontally based on the edges or the center points of the elements.  

To align graphic elements: 
1. Select the graphic elements: 

• To select all of the graphic elements on the screen, press 
Ctrl+A. 

• To select multiple graphic elements, press and hold Ctrl while 
selecting the graphic elements. 

2. Right-click, select Align, and select one of the following options: 
• Left Edges. Align the left edges of the graphic elements. 
• Right Edges. Align the right edges of the graphic elements.  
• Horizontal Centers. Align the center points of the graphic 

elements vertically.  

 
• Top Edges. Align the top edges of the graphic elements. 
• Bottom Edges. Align the bottom edges of the graphic 

elements.  
• Vertical Centers. Align the center points of the graphic 

elements horizontally.   

 

Align graphic elements 
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Tips:  
• To arrange graphic elements in a column, right-click the graphic elements and select Align > 

Horizontal Centers. Right-click the graphic elements again and select Distribute > Vertical.  
• To arrange graphic elements in a horizontal line, right-click the graphic elements and select Align 

> Vertical Centers. Right-click the graphic elements again and select Distribute > Horizontal. 
• Green lines called Smart Guides appear to help move a graphic element with precision.  
• When aligning graphic elements within the definition of an Add-On Graphic, the background of the 

Add-On Graphic may resize to fit the aligned graphic elements. 

See also 
Change the stacking order of graphic elements and groups on 
page 148 

Distribute graphic elements on page 149 

Lock or unlock graphic elements on page 132 

Smart Guides on page 146 

Smart Guides are green lines that appear when drawing, moving, or 
resizing a graphic element. Smart Guides indicate where a graphic 
element snaps relative to the edge of the screen or adjacent graphic 
elements. Use Smart Guides to help position graphic elements on the 
screen. 

Turn off Smart Guides by pressing the Ctrl key while you moving graphic 
elements. Release the Ctrl key to display the Smart Guides again. 

To indicate the placement of a graphic element relative to the screen, 
Smart Guides appear: 

• As a double line when a graphic element is 10 pixels from the top, 
bottom, left, or right edges of the screen: 

 
• As a large X when the center point of a graphic element is at the 

center point of the screen: 

 
• As a large X when the drawing tool is at the center point of the 

screen: 

 

Smart Guides 
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• As a single line when a graphic element is on the edge of the 
screen. Placing an element beyond this line crops the element on 
the HMI device screen.  
 

 
To indicate the placement of graphic elements relative to each other, 
Smart Guides appear: 

• As a double line when the edge of a graphic element is 10 pixels 
from the top, bottom, left, or right of the edge of another graphic 
element. 

 
• As a small x to indicate the center point of a graphic element and 

as an x and a single line from center point to center point of 
graphic elements that are aligned with each other. 
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• As a large X when the center point of a graphic element is at the 
center point of an overlapping graphic element. 

 
• As a single line when the edges of graphic elements are on the 

same vertical or horizontal plane. 

 
• As an x and a single line when the center point of a graphic 

element is aligned with the edge of another graphic element. 

 
When moving a graphic element, measurement guides show the position 
of the element relative to its starting point. 

See also 
Align graphic elements on page 145 

Move a graphic element on page 142 

Stack graphic elements and groups so that one graphic element or group 
appears in front of another. Change the stacking order by moving an item 
forward, backward, or in front of all of the other items on the screen or 
Add-On Graphic. The order is reflected in the Graphic Explorer. 
Change the stacking order of groups. Changing the graphic elements 
contained in a group is not supported.  

Change the stacking order 
of graphic elements and 
groups 
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To change the stacking order of graphic elements and groups: 
1. On the screen or Add-On Graphic, right-click the graphic element 

or group and select Order.  

 
Tips: 
• When a group is in the editing mode, you can select elements inside the group. 
• Select a graphic element or group in the Graphic Explorer. 

2. Select one of the following options:  
• Bring to Front. Move the selected graphic element or group to 

the top of the stack. 
• Bring Forward. Move the selected graphic element or group 

one level forward. 
• Send Backward. Move the selected graphic element or group 

one level backward. 
• Send to Back. Move the selected graphic element or group to 

the bottom of the stack. 

 
Tip:  
Alternate methods of changing the stacking order: 
• On the Drawing toolbar, select the Order down arrow, and select an option. 
• Select ARRANGE > Order, and then select an option.  

See also 
Graphic Explorer on page 132 

Align graphic elements on page 145 

Distribute graphic elements on page 149 

Group graphic elements on page 151 

Distribute graphic elements and Add-On Graphics to space them evenly 
and horizontally or vertically on the screen.  

 

 

Distribute graphic elements 
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To distribute graphic elements: 
1. On the screen, select at least three graphic elements to distribute. 

The outermost graphic elements act as end points for distribution. 
2. Right-click one of the selected graphic elements and select 

Distribute. 
3. Select Horizontal or Vertical. 

 
Tip: The background of an Add-On Graphic may resize when distributing graphic elements in 
the definition of the Add-On Graphic. 

See also 
Align graphic elements on page 145 

Group graphic elements on page 151 

Lock or unlock graphic elements on page 132 

Move a graphic element on page 142 

Use the Duplicate command to make a copy of a graphic element or 
Add-On Graphic. When duplicating a graphic element, everything 
associated with the graphic element, including property values, 
animations, and events, is also duplicated. 

To duplicate a graphic element: 
• On the screen or in the Graphic Explorer, select the graphic 

element or group of graphic elements and press Ctrl+D.  

 
Tips:  
• Duplicating a graphic element within the definition of an Add-On Graphic is supported. 
• Create copies until de-selecting the graphic element or group. 
• The duplicate function does not use the clipboard. The contents of the clipboard are not affected 

when duplicating graphic elements. 

Duplicate a graphic element 
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See also 
Copy a graphic element on page 138 

Combine graphic elements and Add-On Graphics into a group to work 
with them as a single element. Work with the elements as a group or 
manipulate the individual elements within the group. Groups can contain 
groups.  

To group graphic elements: 
1. On the screen or in the Graphic Explorer, select the graphic 

elements and Add-On Graphics to include in the group.  
2. Right-click one of the selected elements and select Group. 

View Designer names each group. Rename groups using the Name box 
in the Properties tab. The Properties tab displays the properties to 
change for the group. View and work with the contents of a group in the 
Graphic Explorer. 

 
Tip: Alternate methods of grouping: 
• On the Drawing toolbar, select Group. 
• On the Standard menu, select Arrange > Group. 
• Press Ctrl+G. 

See also 
Graphic Explorer on page 132 

Work with individual graphic elements in a group on page 315 

Work with groups on page 313 

Zoom in on a screen, shortcut, popup, the System Banner, or the 
definition of an Add-On Graphic to enlarge it and all of its contents. For 
example, zoom in to edit a small, complex portion of a screen. Zoom out 
to reduce the size of the contents. For example, zoom out to view an 
entire screen to preview how it appears on the HMI device.  

To zoom in or zoom out: 
• On the Screen Editor toolbar, or select  to zoom in or select 

 to zoom out. The minimum zoom is 10%. The maximum zoom 
is 500%. The toolbar displays the current zoom level. 

 
Tips:  
• To use the keyboard and mouse to zoom in or out, press the Ctrl key and rotate the wheel of the 

mouse. 
• To view the entire screen, shortcut, popup, System Banner, or Add-On Graphic definition, select Fit 

to Window . 
• To reset the screen, shortcut, popup, System Banner, or Add-On Graphic definition to actual size, 

press Ctrl+1. 
• The zoom level is not maintained when closing the screen or project.  

Group graphic elements 

Zoom in or zoom out 
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See also 
Add a graphic element to a screen on page 136 

Select a graphic element on a screen on page 137 

Open the definition of an Add-On Graphic on page 386 

Add a Slider graphic element to incrementally adjust numeric values for a 
tag within a configured range on an HMI device. 

To add a Slider: 
1. In the Toolbox, expand the CommonControls category. 
2. Drag a horizontal or vertical Slider graphic element onto the 

screen, popup, or Add-On-Graphic. Double-click a graphic 
element in the Toolbox to add it to the center of the screen. If a 
Slider is already selected on the screen, the new Slider is placed 
on top of the selected graphic element.  

 
Tips:  
• If the outline of an empty Add-On Graphic appears on the screen, the definition of the Add-On 

Graphic is empty. Add graphic elements to the Add-On Graphic by changing the definition of the 
Add-On Graphic. All instances of the Add-On Graphic then update to display the contents of the 
Add-On Graphic. 

• Add a graphic element used in a different project by copying and pasting the graphic element 
between the projects. 

• Use the search feature to search for a name or type of graphic element for the Toolbox. 
• The name of each graphic element ends with a number that increments by one when adding an 

instance of that element. For example, TextDisplay_002 indicates a second instance of the Text 
Display graphic element on the screen. 

3. In the Properties window, select the Properties tab. 
4. Expand the categories and configure the Slider properties:  

• General - Specify the Slider control values, and when the Slider 
control updates the values. 

• Appearance - Specify appearance properties for the slider. 
• Thumb - Specify border and fill color, style, thickness, shape, 

and visibility properties for the Slider thumb. 
• Track - Specify border and fill color, style, thickness, and 

visibility properties for the Slider track.  

 
Tip: Bind a Slider property value to another property or data item to change the slider 
property dynamically at runtime.  

 

IMPORTANT The Slider Vertical and Slider Horizontal graphic elements do not support LINT data 
types. An error occurs when using a LINT data type with a value property in a Slider. 

 

See also 
Bind a property to a data item on page 508 

Slider Horizontal on page 195 

Slider Vertical on page 199 

Add a Slider 
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Toolbox on page 131 

What is a Slider? on page 153 

A Slider graphic element is a read/write control that displays numeric 
values for a tag within the configured range in Runtime. Sliders are used 
to set a value for a configured write tag by dragging the slider thumb to 
the desired position in a range. Vertical and Horizontal Slider graphic 
elements are available in CommonControls for desired positioning. 

IMPORTANT If the Slider value tag is outside the MinValue and MaxValue range, the thumb moves to 
the closest MinValue or MaxValue. The slider track and thumb then change to the color 
defined in the OutofLimitFillColor property depicting that the value is outside the range.  

 

 
Tip: A release event automatically triggers with when these scenarios occur. 
• If the Visible property is set to false while the thumb is changing position on the Slider, the Slider 

then writes the current value of the thumb position to the controller or tag when the release 
occurs. 

• If the Enabled property is set to false while the thumb is changing position on the Slider, the Slider 
then writes the current value of the thumb position to the controller or tag when the release 
occurs. 

• If a graphic element covers a slider while the thumb is changing position, the Slider then writes the 
current value of the thumb position to the controller or tag when the release occurs. 

• If one or both of the X and Y properties are set to invalid values while the thumb is changing 
position on the Slider, the Slider then writes the current value of the thumb position to the 
controller or tag when the release occurs. 

• If the screen switches while the thumb is changing position on the Slider, the Slider then writes the 
current value of the thumb position to the controller or tag when the release occurs. 

See also 
Add a Slider on page 152 

Slider Horizontal on page 195 

Slider Vertical on page 199 

Toolbox on page 131 

The Toolbox contains graphic elements divided into categories: 

• Common Controls 
• Alarms 
• Buttons and Switches 
• Flags 
• GeneralEquipment 
• Graph 
• Security 
• Shapes 
• Signs and Symbols 
• System 
• Trend Charts 

See also 
Toolbox on page 131 

What is a Slider? 

Graphic elements library 
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Find a graphic element in the Toolbox on page 135 

Add a graphic element to a screen on page 136 

Add an image to a screen on page 326 

The Alarms category of the Toolbox includes four alarm table graphic 
elements:  

• Alarm Manager Large 
• Alarm Manager Medium 
• Alarm Summary Large 
• Alarm Summary Medium 

Alarms also contains an Icons category: 

See also 
Alarm Manager Large on page 154 

Alarm Manager Medium on page 157 

Alarm Summary Large on page 159 

Alarm Summary Medium on page 162 

Icons on page 168  

Alarm Manager table for a nine-inch or larger HMI device that is 
pre-defined to show alarms in all states and include all conditions for an 
alarm. 

The Alarm Manager displays tag-based alarms marked for use and 
evaluation. 

Use the Alarm Manager table to: 

• View a list of all alarms regardless of their state.  
• View alarm names to identify the controllers and tag of the alarm. 
• Enable or disable alarms to take them in or out of service. 
• Shelve and unshelve alarms. 
• Reset counts for alarms.   
• Sort and filter alarms. 
• Pause alarms. 
• View alarm errors. 
• View individual conditions for an alarm. 
• View details for a selected alarm or alarm condition. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

DateTimeFormat General Specifies the format of the date and time displayed for an 
alarm.  

Any selected option 

Alarms 

Alarm Manager Large 
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SelectedAlarmName General The name of the selected alarm in the alarm table on the HMI 
device.  
This value can write to the tag in a controller during a project 
event or be part of a state table used in a Navigation event.   

Any alarm name in a controller 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text. Any selected font 
FontSize Appearance Specifies the size of the text. Positive numbers 
RowPadding Appearance Specifies the distance, in pixels, between the cell contents 

and the cell border. 
Any positive number 

FilterIndex Appearance Specifies the default filter for an alarm table.  
The number of the filter represents the order in which the 
filter appears on the Filters tab. Entering 3 in the FilterIndex 
property initially filters the alarm table on the HMI device by 
third filter that appears on the Filters tab.  

Any positive number 

DisableEnabled Appearance Makes the Disable button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

EnabledEnabled Appearance Makes the Enable button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled - selected  
• Not Enabled - cleared 

ResetCountEnabled Appearance Makes the Reset Count button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled - selected  
• Not Enabled - cleared 

ShelveEnabled Appearance Makes the Shelve button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled - selected  
• Not Enabled - cleared 

SortOrder Appearance Specifies the columns to sort as well as the sort order.  A valid column number, colon, and a 
D for descending or A for ascending. 

UnshelveEnabled Appearance Makes the Unshelve button available.  
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 
 

• Enabled - selected  
• Not Enabled - cleared 

DisableAccess Security Specifies if all users have access to the Disable button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 
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EnableAccess Security Specifies if all users have access to the Enable button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

ResetCountAccess Security Specifies if all users have access to the Reset Count button or 
if access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

SelectedAlarmName General The name of the selected alarm in the alarm table on the HMI 
device.  
This value can write to the tag in a controller during a project 
event or be part of a state table used in a Navigation event.   

Any alarm name in a controller 

ShelveAccess Security Specifies if all users have access to the Shelve button or if 
access is inherited from the screen.  

• Inherit -  Access inherited from 
screen 

• Full Access - Access granted to all 
users 

UnshelveAccess Security Specifies if all users have access to the Unshelve button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

HelpEnabled Appearance Specifies if the help button is available on the HMI device. • Enabled (selected) 
• Not Enabled (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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See also 
Alarms on page 154 

Alarms overview on page 563 

Alarm Manager contents for a large HMI device screen on page 
589 

Disable a button on an Alarm Manager table on page 586 

Specify access to operations performed on an Alarm Manager 
table on page 587 

 Alarm Manager table for a seven-inch HMI device that is predefined to 
show alarms in all states and include all conditions for an alarm. 

The Alarm Manager displays tag-based alarms marked for use and 
evaluation. 

Use the Alarm Manager table to:   

• View a list of all alarms regardless of their state.  
• View alarm names to identify the controller and tag of the alarm. 
• Enable or disable alarms to take them in or out of service. 
• Shelve and unshelve alarms. 
• Reset counts for alarms.   
• Sort and filter alarms. 
• Pause alarms. 
• View alarm errors. 
• View individual conditions for an alarm. 
• View details for a selected alarm or alarm condition. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

DateTimeFormat General Specifies the format of the date and time displayed for an 
alarm.  

Any selected option 

SelectedAlarmName General The name of the selected alarm in the alarm table on the HMI 
device.  
This value can write to the tag in a controller during a project 
event or be part of a state table used in a Navigation event.   

Any alarm name in a controller 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text. Any selected font 

Alarm Manager Medium 
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FontSize Appearance Specifies the size of the text. Positive numbers 
RowPadding Appearance Specifies the distance, in pixels, between the cell contents 

and the cell border. 
Any positive number 

FilterIndex Appearance Specifies the default filter for an alarm table.  
The number of the filter represents the order in which the 
filter appears on the Filters tab. Entering 3 in the FilterIndex 
property initially filters the alarm table on the HMI device by 
third filter that appears on the Filters tab.  

Any positive number 

DisableEnabled Appearance Makes the Disable button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

EnabledEnabled Appearance Makes the Enable button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled - selected  
• Not Enabled - cleared 

ResetCountEnabled Appearance Makes the Reset Count button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled - selected  
• Not Enabled - cleared 

ShelveEnabled Appearance Makes the Shelve button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled - selected  
• Not Enabled - cleared 

SortOrder Appearance Specifies the columns to sort as well as the sort order.  A valid column number, colon, and a 
D for descending or A for ascending. 

UnshelveEnabled Appearance Makes the Unshelve button available.  
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 
 

• Enabled - selected  
• Not Enabled - cleared 

DisableAccess Security Specifies if all users have access to the Disable button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

EnableAccess Security Specifies if all users have access to the Enable button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

ResetCountAccess Security Specifies if all users have access to the Reset Count button or 
if access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

ShelveAccess Security Specifies if all users have access to the Shelve button or if 
access is inherited from the screen.  

• Inherit -  Access inherited from 
screen 

• Full Access - Access granted to all 
users 
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UnshelveAccess Security Specifies if all users have access to the Unshelve button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

HelpEnabled Appearance Specifies if the help button is available on the HMI device. • Enabled (selected) 
• Not Enabled (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Alarms on page 154 

Alarms overview on page 563 

Alarm Manager contents for a medium HMI device screen on page 
588 

Disable a button on an Alarm Manager table on page 586 

Specify access to operations performed on an Alarm Manager 
table on page 587 

Alarm Summary table for a nine-inch or larger HMI device that is 
predefined to show alarms that are in interesting states or require 
attention, such as alarms that are In Alarm and Unacknowledged.  

Alarm Summary Large 
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Use the Alarm Summary table to:  

• Acknowledge alarms 
• Disable alarms 
• Shelve alarms 
• Sort alarms 
• Filter alarms 
• Pause alarms 
• Reset latched alarms 
• View alarm details 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

AlarmManager General Specifies the name of the Alarm Manager screen for ten-inch 
or larger HMI devices.  

Alarm Manager screen to open from 
the Alarm Summary 

DateTimeFormat General Specifies the format of the date and time displayed for an 
alarm.  

Any selected option 

SelectedAlarmName General The name of the selected alarm in the alarm table on the HMI 
device.  
This value can write to the tag in a controller during a project 
event or be part of a state table used in a Navigation event.   

Any alarm name in a controller 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FontSize Appearance Specifies the size of the text. Positive numbers 
RowPadding Appearance Specifies the distance, in pixels, between the cell contents 

and the cell border. 
Any positive number 

AcknowledgeEnabled Security Makes the Acknowledge button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled - selected  
• Not Enabled - cleared 

FilterIndex Appearance Specifies the default filter for an alarm table.  
The number of the filter represents the order in which the 
filter appears on the Filters tab. Entering 3 in the FilterIndex 
property initially filters the alarm table on the HMI device by 
third filter that appears on the Filters tab.  

Any positive number 

DisableEnabled Appearance Makes the Disable button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 
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ResetLatchedEnabled Appearance Makes the Reset Latched Selected button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled (selected)  
• Not Enabled (cleared) 

ShelveEnabled Appearance Makes the Shelve button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled - selected  
• Not Enabled - cleared 

SortOrder Appearance Specifies the columns to sort as well as the sort order.  A valid column number, colon, and a 
D for descending or A for ascending. 

AcknowledgeAccess Security  Specifies if all users have access to the Acknowledge button 
or if access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access- Access granted to all 
users 

DisableAccess Security Specifies if all users have access to the Disable button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

ResetLatchedAccess Security Specify if all users have access to the Reset Latched Selected 
button or if access is inherited from the screen.  

• Inherit (access inherited from 
screen) 

• Full Access (access granted to all 
users) 

ShelveAccess Security Specifies if all users have access to the Shelve button or if 
access is inherited from the screen.  

• Inherit -  Access inherited from 
screen 

• Full Access - Access granted to all 
users 

HelpEnabled Appearance Specifies if the help button is available on the HMI device. • Enabled (selected) 
• Not Enabled (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
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X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 
left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Alarms on page 154 

Alarms overview on page 563 

Add a column to an Alarm Summary table on page 571 

Disable a button on an Alarm Summary table on page 573 

Specify access to operations performed on an Alarm Summary 
table on page 574 

Alarm Summary table for a seven-inch HMI device that is predefined to 
show alarms that are in interesting states, or require attention, such as 
alarms that are In Alarm and Unacknowledged. 

Use the Alarm Summary table to:  

• Acknowledge alarms 
• Disable alarms 
• Shelve alarms 
• Sort alarms 
• Filter alarms 
• Pause alarms 
• Reset latched digital alarms 
• View alarm details 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

AlarmManager General Specifies the name of the Alarm Manager screen for ten-inch 
or larger HMI devices.  

Alarm Manager screen to open from 
the Alarm Summary 

DateTimeFormat General Specifies the format of the date and time displayed for an 
alarm.  

Any selected option 

SelectedAlarmName General The name of the selected alarm in the alarm table on the HMI 
device.  
This value can write to the tag in a controller during a project 
event or be part of a state table used in a Navigation event.   

Any alarm name in a controller 

Alarm Summary Medium 
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Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text. Any selected font 
FontSize Appearance Specifies the size of the text. Positive numbers 
RowPadding Appearance Specifies the distance, in pixels, between the cell contents 

and the cell border. 
Any positive number 

AcknowledgeEnabled Security Makes the Acknowledge button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled - selected  
• Not Enabled - cleared 

FilterIndex Appearance Specifies the default filter for an alarm table.  
The number of the filter represents the order in which the 
filter appears on the Filters tab. Entering 3 in the FilterIndex 
property initially filters the alarm table on the HMI device by 
third filter that appears on the Filters tab.  

Any positive number 

DisableEnabled Appearance Makes the Disable button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

ResetLatchedEnabled Appearance Makes the Reset Latched Selected button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled (selected)  
• Not Enabled (cleared) 

ShelveEnabled Appearance Makes the Shelve button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it not 
available. 

• Enabled - selected  
• Not Enabled - cleared 

SortOrder Appearance Specifies the columns to sort as well as the sort order.  A valid column number, colon, and a 
D for descending or A for ascending. 

AcknowledgeAccess Security  Specifies if all users have access to the Acknowledge button 
or if access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access- Access granted to all 
users 

DisableAccess Security Specifies if all users have access to the Disable button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

ResetLatchedAccess Security Specify if all users have access to the Reset Latched Selected 
button or if access is inherited from the screen.  

• Inherit (access inherited from 
screen) 

• Full Access (access granted to all 
users) 

ShelveAccess Security Specifies if all users have access to the Shelve button or if 
access is inherited from the screen.  

• Inherit -  Access inherited from 
screen 

• Full Access - Access granted to all 
users 

HelpEnabled Appearance Specifies if the help button is available on the HMI device. • Enabled (selected) 
• Not Enabled (cleared) 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Alarms on page 154 

Alarms overview on page 563 

Add a column to an Alarm Summary table on page 571 

Disable a button on an Alarm Summary table on page 573 

Specify access to operations performed on an Alarm Summary 
table on page 574 

The Alarm History table for a nine-inch HMI device is predefined to 
display the history of alarm state changes.  

Use the Alarm History table to: 

• View history of state changes for alarms 
• Filter alarm state changes 
• View history of state changes for individual conditions of an alarm. 

Built-in animation properties 
Name Category Purpose Accepted values 

Alarm History Large 
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Name Category Purpose Accepted values 

DateTimeFormat General Specifies the format of the 
date and time displayed for an 
alarm 

Any selection option 

SelectedAlarmName General The name of the selected 
alarm in the alarm table on the 
HMI device.  

Any alarm name in a controller.  
Tip: This property is not bindable. 

Unique properties 
Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text Any selection font 
FontSize Appearance Specifies the size of the text. Positive numbers 
RowPadding Appearance Specifies the distance, in 

pixels, between the cell 
contents and the cell border. 

Any positive number 

Enabled Appearance Disable touch and key input 
for an alarm table to prevent 
interaction with the table on 
the HMI device. For example, 
disable touch and key input 
for an alarm table to prevent 
selecting alarms on the HMI 
device. 

• Enabled - selected 
• Not Enabled - cleared 

RefreshEnabled Appearance Makes the Refresh button 
available. When enabled, the 
button is available and 
accepts touch or key input on 
the HMI device. When not 
enabled, the button is not 
available and does not accept 
touch or key input. The button 
has a crosshatch overlay on 
top of it to indicate it is not 
available. 

• Enabled - selected 
• Not Enabled - cleared 

HelpEnabled Appearance Specifies if the help button is 
available on the Alarm History. 

• Enabled (selected) 
• Not Enabled (cleared) 

SortOrder Appearance Specifies the columns to sort 
as well as the sort order. 

A valid column number, colon, and a 
D for descending or A for ascending.  
For example, 1:D,2:D provides a 
primary sort of Column 1 in 
descending order, and a secondary 
sort of Column 2 in descending 
order. You can enter a value for each 
column in the table. 
Tip: This property is not bindable. 

Common Properties 
Name Category Purpose Accepted values 

Opacity Appearance Specifies the transparency of 
the graphic element. 

0 (fully transparent) - 100 (fully 
opaque) 
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Name Category Purpose Accepted values 

Visible Appearance Specifies if the graphic 
element is visible on the HMI 
device. 

• Visible (selected) 
• Not visible (cleared) 

Enabled Appearance Specifies if the graphic 
element is available on the HMI 
device and if the graphic 
element accepts touch and 
key input. 

• Enabled (selected) 
• Not Enabled (cleared) 

X Position and Size Specifies the horizontal 
coordinate, in pixels, from the 
upper left corner of screen to 
the upper left corner of a 
graphic element or group with 
no rotation. If the graphic 
element or group is rotated, 
the X property value does not 
change. 

Any positive number 

Y Position and Size Specifies the vertical 
coordinate, in pixels, from the 
upper left corner of screen to 
the upper left corner of a 
graphic element or group with 
no rotation. If the graphic 
element or group is rotated, 
the Y property value does not 
change. 

Any positive number 

Width Position and Size Specifies the width in pixels Any positive number 
Height Position and Size Specifies the height in pixels Any positive numeric value 
Angle Position and Size Specifies the rotation angle.  

Enter 180 to display the 
graphic element upside down. 
If you enter a value larger than 
360, the portion of numeric 
value that is over 360 
becomes the value. For 
example, enter 380 to see a 
value of 20. If you enter a 
value less than 0, the negative 
value is subtracted from 360. 
For example, enter -30 to see 
a value of 330.  

Numbers 0 to 360 

See also 
Alarms on page 154 

Alarms overview on page 563 

The Alarm History table for a seven-inch HMI device is predefined to 
display history of alarm state changes.  

Use the Alarm History table to: 

• View history of state changes for alarms 
• Filter alarm state changes 
• View history of state changes for individual conditions of an alarm. 

Alarm History Medium 
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Built-in animation properties 
Built-in animation properties under the General category of the 
Properties window. Specify values for these properties to animate the 
graphic element or change the information the graphic element shows on 
the HMI device. 

Name Category Purpose Accepted values 

DateTimeFormat General Specifies the format of the 
date and time displayed for an 
alarm 

Any selection option 

SelectedAlarmName General The name of the selected 
alarm in the alarm table on the 
HMI device.  

Any alarm name in a controller. 
Tip: This property is not bindable. 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share.  

Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text Any selection font 
FontSize Appearance Specifies the size of the text. Positive numbers 
RowPadding Appearance Specifies the distance, in 

pixels, between the cell 
contents and the cell border. 

Any positive number 

Enabled Appearance Disable touch and key input 
for an alarm table to prevent 
interaction with the table on 
the HMI device. For example, 
disable touch and key input 
for an alarm table to prevent 
selecting alarms on the HMI 
device. 

• Enabled - selected 
• Not Enabled - cleared 

RefreshEnabled Appearance Makes the Refresh button 
available. When enabled, the 
button is available and 
accepts touch or key input on 
the HMI device. When not 
enabled, the button is not 
available and does not accept 
touch or key input. The button 
has a crosshatch overlay on 
top of it to indicate it is not 
available. 

• Enabled - selected 
• Not Enabled - cleared 

HelpEnabled Appearance Specifies if the help button is 
available on the HMI device. 

• Enabled (selected) 
• Not Enabled (cleared) 

SortOrder Appearance Specifies the columns to sort 
and the sort order. 

A valid column number, colon, and a 
D for descending or A for ascending.  
For example, 1:D,2:D provides a 
primary sort of Column 1 in 
descending order, and a secondary 
sort of Column 2 in descending 
order. You can enter a value for each 
column in the table. 
Tip: This property is not bindable. 
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Common Properties 
Common properties exist for all graphic elements.  

Name Category Purpose Accepted values 

Opacity Appearance Specifies the transparency of 
the graphic element. 

0 (fully transparent) - 100 (fully 
opaque) 

Visible Appearance Specifies if the graphic 
element is visible on the HMI 
device. 

• Visible (selected) 
• Not visible (cleared) 

Enabled Appearance Specifies if the graphic 
element is available on the HMI 
device and if the graphic 
element accepts touch and 
key input. 

• Enabled (selected) 
• Not Enabled (cleared) 

X Position and Size Specifies the horizontal 
coordinate, in pixels, from the 
upper left corner of screen to 
the upper left corner of a 
graphic element or group with 
no rotation. If the graphic 
element or group is rotated, 
the X property value does not 
change. 

Any positive number 

Y Position and Size Specifies the vertical 
coordinate, in pixels, from the 
upper left corner of screen to 
the upper left corner of a 
graphic element or group with 
no rotation. If the graphic 
element or group is rotated, 
the Y property value does not 
change. 

Any positive number 

Width Position and Size Specifies the width in pixels Any positive number 
Height Position and Size Specifies the height in pixels Any positive numeric value 
Angle Position and Size Specifies the rotation angle.  

Enter 180 to display the 
graphic element upside down. 
If you enter a value larger than 
360, the portion of numeric 
value that is over 360 
becomes the value. For 
example, enter 380 to see a 
value of 20. If you enter a 
value less than 0, the negative 
value is subtracted from 360. 
For example, enter -30 to see 
a value of 330.  

Numbers 0 to 360 

See also 
Alarms on page 154 

Alarms overview on page 563 

The Icons category under Alarms in the Toolbox includes icons that 
appear on the Alarm Summary table and the Alarm Manager table by 
default. 

Icons 
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Place the icon on a screen or graphic element. Configure events for the 
icon in order for it to perform tasks on the HMI device.    

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Property Category Purpose Accepted Values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
• Alarms on page 154 
• Alarm Summary Large on page 159 
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• Alarm Summary Medium on page 162 
• Alarm Manager Large on page 154 
• Alarm Manager Medium on page 157 

The Automatic Diagnostics category of the Toolbox includes four 
automatic diagnostics table graphic elements:  

• Automatic Diagnostics Large 
• Automatic Diagnostics Medium 
• Automatic Diagnostics History Large 
• Automatic Diagnostics History Medium 

See also 
Automatic Diagnostics Large on page 170 

Automatic Diagnostics Medium on page 172 

Automatic Diagnostics History Large on page 174 

Automatic Diagnostics History Medium on page 175 

Automatic Diagnostics table for a nine-inch or larger HMI device 
predefined to show diagnostics that are in interesting states or require 
attention, such as diagnostics that are Active, Unsuppressed and 
Suppressed . 

Use the Automatic Diagnostics table to:  

• Display diagnostics 
• Sort diagnostics 
• Filter diagnostics by state 
• View diagnostics details 
• Suppress diagnostics 
• Unsuppress diagnostics 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

   Category Purpose Accepted values 

DateTimeFormat General Specifies the format of the date and time displayed for an 
automatic diagnostics.  

Any selected option 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text. Any selected font 
FontSize Appearance Specifies the size of the text. Positive numbers 

Automatic Diagnostics 

Automatic Diagnostics 
Large 
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RowPadding Appearance Specifies the distance, in pixels, between the cell contents 
and the cell border. 

Any positive number 

SortOrder Appearance Specifies the columns to sort as well as the sort order.  A valid column number, colon, and a 
D for descending or A for ascending. 

FilterIndex Appearance Specifies the default filter for an automatic diagnostics table.  
The number of the filter represents the order in which the 
filter appears on the Filters tab. Entering 3 in the FilterIndex 
property initially filters the automatic diagnostics on the HMI 
device by third filter that appears on the Filters tab.  

Any positive number 

HelpEnabled Appearance Specifies if the help button is available on the HMI device. • Enabled - selected 
• Not Enabled - cleared 

SuppressEnabled Appearance Makes the Suppress button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

UnsuppressEnabled Appearance Makes the Unsuppress button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

SuppressAccess Security Specifies if all users have access to the Suppress button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

UnsuppressAccess Security Specifies if all users have access to the Unsuppress button or 
if access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
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X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 
left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

 
Automatic Diagnostics table for a six-inch HMI device that is predefined 
to show automatic diagnostics that are in interesting states, or require 
attention, such as diagnostics that are Active, Unsuppressed and 
Suppressed. 

Use the Automatic Diagnostics table to:  

• Display diagnostics 
• Sort diagnostics 
• Filter diagnostics by state 
• View diagnostics details 
• Suppress diagnostics 
• Unsuppress diagnostics 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

   Category Purpose Accepted values 

DateTimeFormat General Specifies the format of the date and time displayed for an 
automatic diagnostics.  

Any selected option 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text. Any selected font 
FontSize Appearance Specifies the size of the text. Positive numbers 
RowPadding Appearance Specifies the distance, in pixels, between the cell contents 

and the cell border. 
Any positive number 

SortOrder Appearance Specifies the columns to sort as well as the sort order.  A valid column number, colon, and a 
D for descending or A for ascending. 

FilterIndex Appearance Specifies the default filter for an automatic diagnostics table.  
The number of the filter represents the order in which the 
filter appears on the Filters tab. Entering 3 in the FilterIndex 
property initially filters the alarm table on the HMI device by 
third filter that appears on the Filters tab.  

Any positive number 

Automatic Diagnostics 
Medium 
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HelpEnabled Appearance Specifies if the help button is available on the HMI device. • Enabled - selected 
• Not Enabled - cleared 

SuppressEnabled Appearance Makes the Suppress button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

UnsuppressEnabled Appearance Makes the Unsuppress button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

SuppressAccess Security Specifies if all users have access to the Suppress button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

UnsuppressAccess Security Specifies if all users have access to the Unsuppress button or 
if access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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The Automatic Diagnostics History table for a nine-inch HMI device is 
predefined to display the history of automatic diagnostics state changes.  

Use the Automatic Diagnostics History table to: 

• View history of state changes for automatic diagnostics 
• View history of state changes details of an automatic diagnostic. 

Built-in animation properties 
Name Category Purpose Accepted values 

DateTimeFormat General Specifies the format of the 
date and time displayed for an 
automatic diagnostics 

Any selection option 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text. Any selected font 
FontSize Appearance Specifies the size of the text. Positive numbers 
RowPadding Appearance Specifies the distance, in pixels, between the cell contents 

and the cell border. 
Any positive number 

SortOrder Appearance Specifies the columns to sort as well as the sort order.  A valid column number, colon, and a 
D for descending or A for ascending. 

FilterIndex Appearance Specifies the default filter for an automatic diagnostics table.  
The number of the filter represents the order in which the 
filter appears on the Filters tab. Entering 3 in the FilterIndex 
property initially filters the automatic diagnostics on the HMI 
device by third filter that appears on the Filters tab.  

Any positive number 

HelpEnabled Appearance Specifies if the help button is available on the HMI device. • Enabled - selected 
• Not Enabled - cleared 

SuppressEnabled Appearance Makes the Suppress button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

UnsuppressEnabled Appearance Makes the Unsuppress button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

SuppressAccess Security Specifies if all users have access to the Suppress button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

UnsuppressAccess Security Specifies if all users have access to the Unsuppress button or 
if access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

Automatic Diagnostics 
History Large 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

 

The Automatic Diagnostics History table for a seven-inch HMI device is 
predefined to display history of automatic diagnostics state changes.  

Use the Automatic Diagnostics History table to: 

• View history of state changes for automatic diagnostics 
• View history of state changes details of an automatic diagnostic. 

Built-in animation properties 
Name Category Purpose Accepted values 

DateTimeFormat General Specifies the format of the 
date and time displayed for an 
automatic diagnostics 

Any selection option 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text. Any selected font 

Automatic Diagnostics 
History Medium 
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FontSize Appearance Specifies the size of the text. Positive numbers 
RowPadding Appearance Specifies the distance, in pixels, between the cell contents 

and the cell border. 
Any positive number 

SortOrder Appearance Specifies the columns to sort as well as the sort order.  A valid column number, colon, and a 
D for descending or A for ascending. 

FilterIndex Appearance Specifies the default filter for an automatic diagnostics table.  
The number of the filter represents the order in which the 
filter appears on the Filters tab. Entering 3 in the FilterIndex 
property initially filters the automatic diagnostics on the HMI 
device by third filter that appears on the Filters tab.  

Any positive number 

HelpEnabled Appearance Specifies if the help button is available on the HMI device. • Enabled - selected 
• Not Enabled - cleared 

SuppressEnabled Appearance Makes the Suppress button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

UnsuppressEnabled Appearance Makes the Unsuppress button available. 
When enabled, the button is available and accepts touch or 
key input on the HMI device. When not enabled, the button is 
not available and does not accept touch or key input. The 
button has a crosshatch overlay on top of it to indicate it is 
not available. 

• Enabled - selected  
• Not Enabled - cleared 

SuppressAccess Security Specifies if all users have access to the Suppress button or if 
access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

UnsuppressAccess Security Specifies if all users have access to the Unsuppress button or 
if access is inherited from the screen.  

• Inherit - Access inherited from 
screen 

• Full Access - Access granted to all 
users 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 



Chapter 9  Add a graphic element to a project 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 177 
 

X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 
left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

 

The ButtonsAndSwitches category of the Toolbox contains graphic 
elements such as push buttons, potentiometer legend plates, and legend 
plates commonly seen on equipment in a manufacturing system. The 
graphic elements in ButtonsAndSwitches are organized into 
categories: 

• 22mm 
• 30mm 
• LegendPlates 

See also 
22mm on page 177 

30mm on page 178 

LegendPlates on page 180 

What types of HMI screens do I need? on page 47 

Toolbox on page 131  

The 22mm category under ButtonsAndSwitches in the Toolbox 
contains illuminated and non-illuminated industrial push buttons. 22mm 
pushbuttons save space on legend plates. This category of graphic 
elements also contains a pilot light and a reset button commonly seen in 
manufacturing systems.   

Use a 22mm graphic element on a legend plate to start, stop or jog a 
piece of equipment on the HMI device. To illuminate a pushbutton or the 
pilot light, bind the built-in animation property of the graphic element to a 
tag in a controller. To have the pushbutton behave like a button, add a 
Button Behavior event by right-clicking the graphic element or adding the 
event on the Events tab of the Properties window.  

Built-in animation properties 
A built-in property to animate a graphic element exists for only some of 
the graphic elements in this category. This property appears depending 
on the graphic element selected: 

Name Category Purpose Accepted values 

LightOn General Specifies the on and off state of the light. • On - selected 
• Off - cleared 

ButtonsAndSwitches 

22mm 
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Unique properties 
Name Category Purpose Accepted values 

HousingColor Appearance Specifies the color of the housing. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Trigger an action on a Button Behavior event on page 444 

ButtonsAndSwitches on page 177 

Search for and select a data type on page 373 

Search for and select a tag 

The 30mm category under ButtonsAndSwitches in the Toolbox 
contains illuminated and non-illuminated industrial push buttons. 30mm 
pushbuttons are used in manufacturing systems where more space for 

30mm 
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enclosing internal components is required. This category also contains a 
pilot light commonly seen in manufacturing systems.    

Use a 30mm graphic element on a legend plate to start, stop, or jog a 
piece of equipment on the HMI device. To illuminate a pushbutton or the 
pilot light, bind the built-in animation properties of the graphic element to 
tags in the controllers. To have the pushbutton behave like a button, add 
a Button Behavior event by right-clicking the graphic element or adding 
the event on the Events tab of the Properties window. 

Built-in animation properties 
A built-in property to animate a graphic element exists for only some of 
the graphic elements in this category. This property appears depending 
on the graphic element selected: 

LightOn General Specifies the on and off state of the light. • On - selected 
• Off - cleared 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Trigger an action on a Button Behavior event on page 444 
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ButtonsAndSwitches on page 177 

Search for and select a data type on page 373 

Search for and select a tag 

The LegendPlates category under ButtonsAndSwitches in the 
Toolbox contains standard, jumbo, and potentiometer legend plates 
commonly seen on equipment in a manufacturing system. 

Place a button or switch on a legend plate. Place a Text Display graphic 
element on the plate to depict the label on the legend plate.  

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
What is an event? on page 476 

Trigger an action on a Button Behavior event on page 444 

ButtonsAndSwitches on page 177 

The CommonControls category in the Toolbox contains the most 
common graphic elements added to a screen. The graphic elements in 
CommonControls are organized into categories:  

• Button 

LegendPlates 

CommonControls 
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• DateTimeDisplay 
• Image 
• NumericDisplay 
• NumericInput 
• TextDisplay 
• TextInput 
• Slider Horizontal 
• Slider Vertical 

See also 
Button on page 181 

Numeric Display on page 187 

Numeric Input on page 190 

Text Display on page 202 

Text Input on page 205 

The Button graphic element is an undefined standard button. Button 
appears under Common Controls in the Toolbox. 

Use a button to perform a task on the screen. The button should display 
explanatory text regarding the task the button performs. Configure events 
for the button in order for it to perform tasks on the HMI device:  

• Set a tag to 0 or 1. 
• Toggle a value. 
• Write a value. 
• Increment a value. 
• Use the button as an HMI Button Control (HMIBC).  
• Log on or log off the HMI device. 
• Open or close a popup. 
• Open a screen. 
• Navigate forward or backward a screen in navigation history. 
• Open the Navigation menu. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

Text General Specifies the text on the graphic element.  
Do not place text against the border of a graphic element. 
Allow for a small difference in space, such as one or two 
characters. If you place text against the border of a graphic 
element, the text may wrap differently or appear clipped on 
the HMI device. 

Alpha-numeric characters 

Button 
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Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

CornerRadius Appearance Specifies the curve of the corners.  0 or a positive number 

TextAlignment Appearance Specifies the vertical and horizontal alignment of the text.  Vertical alignment: 
• Top  
• Center  
• Bottom  
Horizontal alignment: 
• Left justified  
• Centered  
• Right justified  

Color Appearance/Border Specifies the color of the border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Style Appearance/Border Specifies the style of the border line. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Width Appearance/Border Specifies the width of the border line. • None 
• 1 point 
• 2 point 
• 4 point 
• 8 point 

FontName Appearance Specifies the font of the text. Any selected font 
FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontSize Appearance Specifies the size of the text. Positive numbers 
Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 

• Not bold - cleared 
FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 
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UsePredefinedDisabled Appearance Specifies if a crosshatch overlay shows on the control 
element when you disable the element. 

• Use predefined disabled 
appearance (selected) 

• Do not use predefined disabled 
appearance (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Toolbox on page 131 

CommonControls on page 180 

Events tab on page 447 

Trigger an action on a Button Behavior event on page 444 

What is an event? on page 476 

The DateTime Display graphic element is configured to show the current 
date and time on the HMI device. 

Add the DateTime Display graphic element to a screen to: 

• Show the current date and time on the HMI device screen.  
• Change the the format of the date and time in the Format box of 

the Properties window. 

DateTime Display 
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• Select the tag representing the date and time of the HMI device in 
the Value box in the Properties window. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

Format General Specifies the format of the date and time. • yyyy-MM-dd hh:mm:ss.zzzzzz 
• M/dd/yyyy h:mm:ss AP 
• d MMM yyyy hh:mm:ss 
• yyyy-MM-dd hh:mm:ss 
• dd/M/yyyy hh:mm:ss 
• dddd, MMMM d, yyyy 
• MMMM d, yyyy 
• d MMMM yyyy 
• d MMM yyyy 
• yyyy-MM-dd 
• M/d/yyyy 
• d/M/yyyy 
• dddd 
• MMMM d 
• yyyy 
• hh:mm:ss. zzz AP 
• hh:mm:ss AP 
• hh:mm ss 
• hh: mm AP 
• hh 
• mm 
• ss 

Value General Specifies the value of the graphic element. Bound tag 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

CornerRadius Appearance Specifies the curve of the corners.  0 or a positive number 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 
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TextAlignment Appearance Specifies the vertical and horizontal alignment of the text.  Vertical alignment: 
• Top  
• Center  
• Bottom  
Horizontal alignment: 
• Left justified  
• Centered  
• Right justified  

Color Appearance/Border Specifies the color of the border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Style Appearance/Border Specifies the style of the border line. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Width Appearance/Border Specifies the width of the border line. • None 
• 1 point 
• 2 point 
• 4 point 
• 8 point 

FontName Appearance Specifies the font of the text. Any selected font 
FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontSize Appearance Specifies the size of the text. Positive numbers 
Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 

• Not bold - cleared 
Padding 
 

Appearance Specifies the distance, in points, between the content of the 
element and the edge of the element. 

Any numeric value 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 



Chapter 9  Add a graphic element to a project 
 

186 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
CommonControls on page 180 

Add a graphic element to a screen on page 136 

What is the Settings screen? on page 97 

Change a property on page 493 

Use the Image graphic element to add an image file to the screen. Image 
appears under CommonControls in the Toolbox. Supported file 
formats include BMP, JPG, PNG, and SVG. Use an image file to display 
hardware, such as a tank that is not available in the Toolbox. 

Tips: • Configure an image like any other graphic element. For example, configure events such as screen 
navigation.  

• The image file can exist on the hard disk of your computer, a shared drive, or a network location.  
• You can copy image files for reuse in multiple locations. In the Project Explorer, image files exist in the 

Images folder under Assets. 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. Not all graphic elements in this category have the same 
properties. The unique properties of a graphic element in this category 
depend on the graphic element selected. 

Name Category Purpose Accepted values 

ImageName General Specifies the name of the file used in the Image element.  
Bind expressions or use State Tables to change the 
ImageName in an Image graphic element. Use this method 
to switch between images representing different states of 
equipment. 

• String - text 
• Alphanumeric for State Table. 

Image 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add an image to a screen on page 326 

CommonControls on page 180 

Events tab on page 447 

What is an event? on page 476 

The Numeric Display graphic element is a control with built-in animation 
properties to show a numeric value. Numeric Display appears under 
CommonControls in the Toolbox. 

Use the Numeric Display graphic element to show numeric data from a 
bound tag on the HMI device. For example, use a numeric display to 
show the current temperature of an oven. 

IMPORTANT A numeric display’s .Value property is treated as a string when using the “+” operator, 
causing a concatenation to occur instead of an addition.  To force an addition of 
.Value properties, first multiply .Value by 1. 
For example, (NumericDisplay_001.Value*1) + (NumericDisplay_002.Value*1) will perform 
an addition of the .Value properties.  However, NumericDisplay_001.Value + 
NumericDisplay_002.Value will perform a concatenation of the .Value properties. 

You can bind the Value property to a numeric tag (DINT, INT, SINT, or 
REAL) to an expression. You can also bind the Value property to a string 

Numeric Display 
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tag if the string consists of only numerals. For example, the string value 
456 displays as an integer and the string value 321.0 displays as a 
floating-point value. 

Use the Rounding field to specify how the numeric tag value appears 
when the amount of decimal places used by the numeric tag value 
exceeds the DigitsAfterDecimal value. For example, if 
DigitsBeforeDecimal is 3, DigitsAfterDecimal is 2, and Rounding = 
Nearest, the value 112.345 displays as 112.35. 

Tips: • If the Value property is assigned to an integer tag, the DigitsAfterDecimal property value is ignored. For example, if DigitsBeforeDecimal is 3 and 
DigitsAfterDecimal is 1, the INT tag value 123 displays as 123 instead of 123.0. 

• If the Value property is unassigned, the numeric display fills with asterisks. 
• If the value does not fit within the bounding box of the graphic element, the numeric display is filled with asterisks. 
• If the integer portion of the value, including the minus sign, contains more digits than specified for the display, the numeric display shows the value in 

scientific notation.   
• If the number of characters required to show the value in scientific notation exceeds the sum of the DigitsBeforeDecimal and DigitsAfterDecimal fields, 

the numeric display fills with asterisks. 
• If the value contains invalid characters, the numeric display shows dashes in place of the value. An error message appears above the graphic element. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

Value General Specifies the value of the graphic element. Bound tag 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

CornerRadius Appearance Specifies the curve of the corners.  0 or a positive number 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 
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TextAlignment Appearance Specifies the vertical and horizontal alignment of the text.  Vertical alignment: 
• Top  
• Center  
• Bottom  
Horizontal alignment: 
• Left justified  
• Centered  
• Right justified  

Color Appearance/Border Specifies the color of the border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Style Appearance/Border Specifies the style of the border line. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Width Appearance/Border Specifies the width of the border line. • None 
• 1 point 
• 2 point 
• 4 point 
• 8 point 

FontName Appearance Specifies the font of the text. Any selected font 
FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontSize Appearance Specifies the size of the text. Positive numbers 
Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 

• Not bold - cleared 
Padding 
 

Appearance Specifies the distance, in points, between the content of the 
element and the edge of the element. 

Any numeric value 

DigitsBeforeDecimal 
 

Numeric Specifies the number of digits before the decimal point.  0 - 9 

DigitsAfterDecimal 
 

Numeric Specifies the number of digits after the decimal point. 0 - 9 

LeadingZero Numeric Places a zero before REAL numbers that are less than 1. • Leading zero (selected) 
• No leading zero (cleared) 

TrailingZeros Numeric Specifies that zeros fill the remaining decimal places.  • Trailing zeros (selected) 
• No trailing zeros (cleared) 

Rounding Numeric Specifies the rounding method for the decimal portion of 
REAL numbers. 

• None - Do not round the number 
• Up - Round up to the nearest 

number 
• Nearest - Round up or down to the 

nearest number 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Numeric Input on page 190 

Change a property on page 493 

Properties window on page 493 

Search for and select a data type on page 373 

Search for and select a tag 

The Numeric Input graphic element is a control with built-in animation 
properties to show a tag value and open the virtual numeric keypad to 
change the value. Numeric Input appears under Common Controls in 
the Toolbox. 

Use the Numeric Input graphic element to show the operator numeric 
information from the data source and to enable the operator to write a 
numeric value to the data source using the Virtual Numeric Keypad. 
By default, the Virtual Numeric Keypad opens on PanelView projects 
when interacting with a Numeric Input graphic element. 

The range of input values that can be entered in the virtual numeric 
keypad are specified by the KeypadMaxValue and KeypadMinValue 
property values. 

Numeric Input 
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Mask the value displayed in the graphic element and in the virtual 
numeric keypad by selecting the MaskedValue box in the Properties 
window. 

Bind the Value property to a numeric tag (DINT, INT, SINT, or REAL). 
Bind the Value property to a string tag if the string consists of only 
numerals. For example, the string value 456 displays as an integer and 
the string value 321.0 displays as a floating-point value. 

Use the Rounding field to specify how the numeric tag value appears 
when the amount of decimal places used by the numeric tag value 
exceeds the DigitsAfterDecimal value. For example, if 
DigitsBeforeDecimal is 3, DigitsAfterDecimal is 2, and Rounding = 
Nearest, the value 112.345 displays as 112.35. 

 
Tips:  
• If the Value property is assigned to an integer tag, the DigitsAfterDecimal property value is ignored. 

For example, if DigitsBeforeDecimal is 3 and DigitsAfterDecimal is 1, the INT tag value 123 displays 
as 123 instead of 123.0. 

• If the Value property is unassigned, the numeric display fills with asterisks. 
• If the value does not fit within the bounding box of the graphic element, the numeric display is 

filled with asterisks. 
• If the integer portion of the value, including the minus sign, contains more digits than specified for 

the display, the numeric display shows the value in scientific notation.   
• If the number of characters required to show the value in scientific notation exceeds the sum of 

the DigitsBeforeDecimal and DigitsAfterDecimal fields, the numeric display fills with asterisks. 
• If the value contains invalid characters, the numeric display shows dashes in place of the value. An 

error message appears above the graphic element. 
• To change the method for entering values in this graphic element, change the ValueEntryMethod 

property for the graphic element. The ValueEntryMethod property specifies whether entering 
values is inherited from the project properties, performed through the Virtual Numeric Keypad. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Property Category Purpose Accepted Values 

Value General Specifies the value of the graphic element. Bound tag 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Property Category Purpose Accepted Values 

CornerRadius Appearance Specifies the curve of the corners.  0 or a positive number 
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FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

TextAlignment Appearance Specifies the vertical and horizontal alignment of the text.  Vertical alignment: 
• Top  
• Center  
• Bottom  
Horizontal alignment: 
• Left justified  
• Centered  
• Right justified  

Color Appearance/Border Specifies the color of the border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Style Appearance/Border Specifies the style of the border line. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Width Appearance/Border Specifies the width of the border line. • None 
• 1 point 
• 2 point 
• 4 point 
• 8 point 

FontName Appearance Specifies the font of the text. Any selected font 
FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontSize Appearance Specifies the size of the text. Positive numbers 
Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 

• Not bold - cleared 
Padding 
 

Appearance Specifies the distance, in points, between the content of the 
element and the edge of the element. 

Any numeric value 

UsePredefinedDisabled Appearance Specifies if a crosshatch overlay shows on the control 
element when you disable the element. 

• Use predefined disabled 
appearance (selected) 

• Do not use predefined disabled 
appearance (cleared) 

DigitsBeforeDecimal 
 

Numeric Specifies the number of digits before the decimal point.  0 - 9 

DigitsAfterDecimal 
 

Numeric Specifies the number of digits after the decimal point. 0 - 9 
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LeadingZero Numeric Places a zero before REAL numbers that are less than 1. • Leading zero (selected) 
• No leading zero (cleared) 

TrailingZeros Numeric Specifies that zeros fill the remaining decimal places.  • Trailing zeros (selected) 
• No trailing zeros (cleared) 

Rounding Numeric Specifies the rounding method for the decimal portion of 
REAL numbers. 

• None - Do not round the number 
• Up - Round up to the nearest 

number 
• Nearest - Round up or down to the 

nearest number 
MaskedValue Input Specifies that asterisks mask the value entered on the 

numeric keypad. 
• Value masked (selected) 
• Value not masked (cleared) 

KeypadMaxValue Input Specifies the maximum value to show and enter on the 
numeric keypad. 

Any numeric value that is greater 
than the KeypadMinValue property 
value 

KeypadMinValue Input Specifies the minimum value to show and enter on the 
numeric keypad 

Any numeric value that is less than 
the KeypadMaxValue property value 

ValueEntryMethod Input Specifies the method for entering values in the graphic 
element. The default is to inherit the value entry method from 
the project. Selecting the virtual keypad value entry method 
overrides the default setting of the project.   

• InheritProjectSetting 
• VirtualKeypad 
When binding to this property, use 
either the name of a value or the 
associated number: 
• 0 (InheritProjectSetting) 
• 1 (VirtualKeypad) 

KeypadPosition Input Specifies the position of the virtual numeric keypad on the 
screen. The default position is the center of the screen 
(Middle-center). 

• Top-left 
• Top-center 
• Top-right 
• Middle-left 
• Middle-center 
• Middle-right 
• Bottom-left 
• Bottom-center 
• Bottom-right 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
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X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 
left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
• CommonControls on page 180 
• Numeric Display on page 187 
• Search for and select a data type on page 373 
• Search for and select a tag 

Use the PDF graphic element in the System category in the Toolbox to 
open and view a PDF, or add a PDF to a screen, popup, or 
Add-On-Graphic to display a PDF on the HMI device 

Unique Properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted Values 
DocumentName General Displays the name of the currently 

viewed PDF.  
Any listed PDF document.  

PageCount General Displays the number of pages in the 
PDF. 

Read-only 

PageNumber General Displays the page number currently 
being viewed. It also specifies the 
page that is shown when the screen 
containing the PDF opens. 
Tip: Writing to this property at 
runtime changes the page shown in 
the PDF. 

Any positive number. If the PDF has 
not been loaded, the value of the 
property is 1.  

Zoom General Displays the current zoom value used 
in the PDF. It also specifies the zoom 
magnification value used in the PDF 
Viewer when the screen containing 
the PDF opens. 
Tip: Writing to this property at 
runtime changes the zoom 
magnification value used in the PDF 
Viewer. 

• Fit Height 
• Fit page 
• Actual size 

PDF graphic element 
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BackgroundColor Appearance Specifies the background color of the 
PDF. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, 3ffff00 
produces yellow. 

Bookmarks Bookmark Displays the bookmarks in a PDF 
document.  

Read-only 

BookmarkIndex Bookmark Displays the bookmark index to 
display in runtime. 

The value of the property is 0.  

 

Common Properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a PDF document to a project on page 332 

Select Document dialog box on page 335 

Toolbox on page 131 

Use the Slider Horizontal graphic element to build an application using 
slider control. The Slider Horizontal graphic element appears in the 
CommonControls category of the Toolbox.  

Slider Horizontal 
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Built-in-Animation Properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Property Category Purpose Accepted Values 

Value General Specifies the value of the graphic element Bound tag 
MinValue General Specifies the minimum value on the graphic element Any numeric value less than the 

MaxValue property value. 
MaxValue General Specifies the maximum value on the graphic element Any numeric value greater than the 

MinValue property value. 
Write Mode General Specifies when the control updates the value tag Continuous Update - Updates the 

tag bound to the value property 
while dragging the slider thumb 
along the track 
Update on Release - Updates the tag 
bound to the value property after 
releasing the slider thumb. 

 

Unique Properties 
Unique properties are not shared by all graphic elements in Toolbox. 

Name Category Purpose Accepted Values 
CornerRadius Appearance Specifies the curve of button corners. Zero or a positive number. 
UsePredefinedDisabled Appearance Specifies the crosshatch overlay on 

disabled graphic element. 
True or false 

FillColor Appearance Specifies the fill color. Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

BorderColor Appearance/Border Specifies the border color of the 
graphic element. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

BorderStyle Appearance/Border Specifies the border style for the 
graphic element. 

• Any selected Line style -- None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style -- Flat, 
Round, or Square 

• Any selected Join style -- Miter, 
Bevel, or Round 

BorderWidth Appearance/Border Specifies the border width for the 
graphic element. 

• None 
• 1 pixel 
• 2 pixels 
• 4 pixels 
• 8 pixels 
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Name Category Purpose Accepted Values 
ThumbStyle Appearance/Thumb Specifies the appearance of the slider 

thumb. 
• Square 
• Octagon 
• Diamond 
• Circle 

ThumbFillColor Thumb Specifies the fill color for the slider 
thumb. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

ThumbBorderColor Thumb Specifies the border color for the 
slider thumb. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

ThumbThickness Thumb Adjusts the size of the thumb width 
along the track. 

Zero or a positive number. 

TrackVisible Track Specifies visibility of the slider track 
element. 

Enable or Disable 

TrackFillColor Track Specifies the fill color for the slider 
track. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

TrackBorderColor Track Specific the border color for the slider 
track. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow.  

TrackThickness Track Specifies the relative thickness of the 
slider track. 

The percentage (0 to 100) of the 
height for Slider Horizontal or the 
percentage of the width for Slider 
Vertical. 

TrackCornerRadius Track  Specifies the curve of the track. Zero or a positive number 

LimitVisible Track Specifies the visibility of the range 
between the LowLimit and HighLimit . 

Enable or Disable 

LowLimit Track Specifies the LowLimit value between 
the MinValue and MaxValue. 

Any numeric value less than the 
HighLimit. 

HighLimit Track Specifies the HighLimit value between 
the MinValue and MaxValue. 

Any numeric value greater than the 
LowLimit. 
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Name Category Purpose Accepted Values 
LimitFillColor Track Specifies the fill color for the range 

between the LowLimit and HighLimit . 
Tip: Enable TrackVisible and 
LimitVisible before configuring 
LimitFillColor. The LimitFillColor 
property goes inactive after disabling 
TrackVisible and LimitVisible. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

OutofLimitFillColor Track Specifies the fill color for the thumb 
and a portion of the track when the 
LowLimit and HighLimit are outside 
the MinValue and MaxValue range. 
Tip: Enable TrackVisible and 
LimitVisible before configuring 
LimitFillColor. The OutofLimitFillColor 
property goes inactive after disabling 
TrackVisible and LimitVisible. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

Common Properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a Slider on page 152 

What is a Slider? on page 153 
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Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

Use the Slider Vertical graphic element to build an application using 
slider control. The Slider Vertical graphic element appears in the 
CommonControls category of the Toolbox.  

Built-in Animation Properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device. Not all of the graphic elements in this 
category have the same properties. The built-in animation properties of a 
graphic element in this category depend on the graphic element selected.  

Property Category Purpose Accepted Values 

Value General Specifies the value of 
the graphic element 

Bound tag 

MinValue General Specifies the minimum 
value on the graphic 
element 

Any numeric value less than the MaxValue property value. 

MaxValue General Specifies the 
maximum value on the 
graphic element 

Any numeric value greater than the MinValue property value. 

Write Mode General Specifies when the 
control updates the 
value tag 

Continuous Update - Updates the tag bound to the value 
property while dragging the slider thumb along the track 
Update on Release - Updates the tag bound to the value 
property after releasing the slider thumb. 

Unique Properties 
Unique properties are not shared by all graphic elements in Toolbox. 

Name Category Purpose Accepted Values 
CornerRadius Appearance Specifies the curve of button corners. Zero or a positive number. 
UsePredefinedDisabled Appearance Specifies the crosshatch overlay on 

disabled graphic element. 
True or false 

FillColor Appearance Specifies the fill color. Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

BorderColor Appearance/Border Specifies the border color of the 
graphic element. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

Slider Vertical 
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Name Category Purpose Accepted Values 
BorderStyle Appearance/Border Specifies the border style for the 

graphic element. 
• Any selected Line style -- None, 

Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style -- Flat, 
Round, or Square 

• Any selected Join style -- Miter, 
Bevel, or Round 

BorderWidth Appearance/Border Specifies the border width for the 
graphic element. 

• None 
• 1 pixel 
• 2 pixels 
• 4 pixels 
• 8 pixels 

ThumbStyle Appearance/Thumb Specifies the appearance of the slider 
thumb. 

• Square 
• Octagon 
• Diamond 
• Circle 

ThumbFillColor Thumb Specifies the fill color for the slider 
thumb. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

ThumbBorderColor Thumb Specifies the border color for the 
slider thumb. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

ThumbThickness Thumb Adjusts the size of the thumb width 
along the track. 

Zero or a positive number. 

TrackVisible Track Specifies visibility of the slider track 
element. 

Enable or Disable 

TrackFillColor Track Specifies the fill color for the slider 
track. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

TrackBorderColor Track Specific the border color for the slider 
track. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow.  
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Name Category Purpose Accepted Values 
TrackThickness Track Specifies the relative thickness of the 

slider track. 
The percentage (0 to 100) of the 
height for Slider Horizontal or the 
percentage of the width for Slider 
Vertical. 

TrackCornerRadius Track  Specifies the curve of the track. Zero or a positive number 

LimitVisible Track Specifies the visibility of the range 
between the LowLimit and HighLimit . 

Enable or Disable 

LowLimit Track Specifies the LowLimit value between 
the MinValue and MaxValue. 

Any numeric value less than the 
HighLimit. 

HighLimit Track Specifies the HighLimit value between 
the MinValue and MaxValue. 

Any numeric value greater than the 
LowLimit. 

LimitFillColor Track Specifies the fill color for the range 
between the LowLimit and HighLimit . 
Tip: Enable TrackVisible and 
LimitVisible before configuring 
LimitFillColor. The LimitFillColor 
property goes inactive after disabling 
TrackVisible and LimitVisible. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

OutofLimitFillColor Track Specifies the fill color for the thumb 
and a portion of the track when the 
LowLimit and HighLimit are outside 
the MinValue and MaxValue range. 
Tip: Enable TrackVisible and 
LimitVisible before configuring 
LimitFillColor. The OutofLimitFillColor 
property goes inactive after disabling 
TrackVisible and LimitVisible. 

Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

Common Properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
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X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 
left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a Slider on page 152 

What is a Slider? on page 153 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

The Text Display graphic element is a control to show text or a string tag 
value. Text Display appears under CommonControls in the Toolbox.  

Use the Text Display graphic element to: 

• Show messages from the data source on the HMI device. For 
example, set up the data source to generate strings that report on 
the state of a process or operation, or that provide instructions 
about what the operator needs to do next. 

• Provide descriptive text or labels for other graphic elements on the 
screen. 

Bind the Text property to a string tag, a numeric tag, or an expression to 
display information from the data source. To use the Text Display as a 
label with static text, enter the static text value in the Text box. 

 
Tips:  
• To change the Text property value, double-click the Text Display graphic element on the screen to 

select the text and enter a new value. If the Text Display is bound to a tag or expression, the Initial 
value of the Text box changes. 

• Do not place text against the border of a graphic element. Allow for a small difference in space, 
such as one or two characters. If you place text against the border of a graphic element, the text 
may wrap differently or appear clipped on the HMI device. 

• The maximum length of a text display reading from a String data type in a controller is 476 
characters. 

• If the String is encoded using UTF-8, the text display may not show 476 characters because each 
character may take multiple bytes of data. 

• Embedding a REAL tag value in a text display or popup caption shows 13 digits after the decimal 
point by default. To reduce the number of digits after the decimal point, use a truncate and divide 
operation. For example, to limit the number of digits shown after the decimal point to 3 digits, use 
the expression TRUNC(MyTag*10e2)/10e2. To show n+1 digits, use the expression 
TRUNC(MyTag*10en)/10en. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Text Display 
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Name Category Purpose Accepted values 

Text General Specifies the text on the graphic element.  
Do not place text against the border of a graphic element. 
Allow for a small difference in space, such as one or two 
characters. If you place text against the border of a graphic 
element, the text may wrap differently or appear clipped on 
the HMI device. 

Alpha-numeric characters 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

CornerRadius Appearance Specifies the curve of the corners.  0 or a positive number 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

TextAlignment Appearance Specifies the vertical and horizontal alignment of the text.  Vertical alignment: 
• Top  
• Center  
• Bottom  
Horizontal alignment: 
• Left justified  
• Centered  
• Right justified  

Color Appearance/Border Specifies the color of the border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Style Appearance/Border Specifies the style of the border line. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Width Position and Size Specifies the width in pixels. Any positive number 
FontName Appearance Specifies the font of the text. Any selected font 
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FooterFontColor Appearance Specifies the color of the text in the footer. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FooterFontSize Appearance Specifies the size of the text in the footer. Positive numbers 

Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 
• Not bold - cleared 

Underline Appearance Make the text underlined. • Underline - selected 
• No underline - cleared 

Padding 
 

Appearance Specifies the distance, in points, between the content of the 
element and the edge of the element. 

Any numeric value 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Change the text in a graphic element on page 140 

Text Input on page 205 

• CommonControls on page 180 
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The Text Input graphic element is a control with built-in animation 
properties to show a string tag value and open the virtual keyboard to 
change the value. Text Input appears under CommonControls in the 
Toolbox. 

Use the Text Input graphic element to show messages from the data 
source on the HMI device, and write a new value to the data source. By 
default, the Virtual Standard Keyboard opens in PanelView projects 
when interacting with a Text Input graphic element.  

Make the value you enter by selecting the MaskedValue box in the 
Properties window. For example, select MaskedValue to have users not 
see their passwords while they type them.  

Bind the Text box in the Properties window to a string tag, a numeric tag, 
or an expression to display information from the data source. Write a new 
value to the tag on the HMI device using the virtual keyboard. If you enter 
an invalid value, the value does not write to the tag and an error appears. 
For example, if the Text property is bound to an INT tag, writing the value 
"abc" to the tag is not supported. 

 
Tips:  
• Do not place text against the border of a graphic element. Allow for a small difference in space, 

such as one or two characters. If placing text against the border of a graphic element, the text may 
wrap differently or appear clipped on the HMI device. 

• The maximum length of a text input is 82 characters. 
• To change the method for entering values in this graphic element, change the ValueEntryMethod 

property for the graphic element. The ValueEntryMethod property specifies whether entering 
values is inherited from the project properties, performed through the Virtual Numeric Keypad. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Property Category Purpose Accepted Values 

Text General Specifies the text on the graphic element.  
Do not place text against the border of a graphic element. 
Allow for a small difference in space, such as one or two 
characters. If you place text against the border of a graphic 
element, the text may wrap differently or appear clipped on 
the HMI device. 

Alpha-numeric characters 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Property Category Purpose Accepted Values 

CornerRadius Appearance Specifies the curve of the corners.  0 or a positive number 

Text Input 
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FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

TextAlignment Appearance Specifies the vertical and horizontal alignment of the text.  Vertical alignment: 
• Top  
• Center  
• Bottom  
Horizontal alignment: 
• Left justified  
• Centered  
• Right justified  

Color Appearance/Border Specifies the color of the border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Style Appearance/Border Specifies the style of the border line. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Width Appearance/Border Specifies the width of the border line. • None 
• 1 point 
• 2 point 
• 4 point 
• 8 point 

FontName Appearance Specifies the font of the text. Any selected font 
FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontSize Appearance Specifies the size of the text. Positive numbers 
Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 

• Not bold - cleared 
Padding 
 

Appearance Specifies the distance, in points, between the content of the 
element and the edge of the element. 

Any numeric value 

UsePredefinedDisabled Appearance Specifies if a crosshatch overlay shows on the control 
element when you disable the element. 

• Use predefined disabled 
appearance (selected) 

• Do not use predefined disabled 
appearance (cleared) 

MaskedValue Input Specifies that asterisks mask the value entered on the 
numeric keypad. 

• Value masked (selected) 
• Value not masked (cleared) 

KeypadMinValue Input Specifies the minimum value to show and enter on the 
numeric keypad 

Any numeric value that is less than 
the KeypadMaxValue property value 
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KeypadMaxValue Input Specifies the maximum value to show and enter on the 
numeric keypad. 

Any numeric value that is greater 
than the KeypadMinValue property 
value 

ValueEntryMethod Input Specifies the method for entering values in the graphic 
element. The default is to inherit the value entry method from 
the project. Selecting the virtual keyboard value entry method 
overrides the default setting of the project.  

• InheritProjectSetting 
• VirtualKeyboard 
Bind to the name of a value or the 
associated number: 
• 0 (InheritProjectSetting) 
• 1 (VirtualKeyboard) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
• Change the text in a graphic element on page 140 
• Text Display on page 202 
• CommonControls on page 180 
• Search for and select a data type on page 373 
• Search for and select a tag 

The Flags category in the Toolbox contains graphic elements of the 
flags of various countries. These graphic elements share properties 
common to all graphic elements.  

Flags 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
What types of HMI screens do I need? on page 47 

Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

The GeneralEquipment category in the Toolbox contains tanks, 
containers, lab equipment, conveyors, instrumentation, and pipes that 
represent this equipment in a manufacturing system. The graphic 
elements in GeneralEquipment are organized into categories:  

• Cabinets 
• Computers 
• Conveyors 
• Fans 
• Feeders 
• Fixtures 
• Gauges 
• Indicators 
• Instrumentation 
• Laboratory 

GeneralEquipment 
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• Miscellaneous 
• Motors 
• Pallets 
• Pipes 
• Pumps 
• Sensors 
• Separators 
• Spools 
• TanksAndContainers 
• Textures 
• Tick Marks 
• Valves 

See also 
What types of HMI screens do I need? on page 47 

Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

The Cabinets category under GeneralEquipment in the Toolbox 
contains small, medium and large cabinet graphic elements.  

Use a cabinet on the screen to depict a storage area in a manufacturing 
system.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

DoorOpacity Appearance Specifies the transparency of the cabinet door. 0 (fully transparent) - 100 (fully 
opaque) 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Cabinets 
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Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

GeneralEquipment on page 208 

The Computers category under GeneralEquipment in the Toolbox 
contains a computer work station and server.  

Use a computer or server on the screen to depict a monitoring or 
computer server area associated with the manufacturing system.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Computers 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

The Conveyors category in the Toolbox contains conveyor belts and 
conveyor rollers commonly used in a manufacturing system. The 
Conveyors category has graphic elements in additional Belt and Roller 
categories. 

Use a conveyor to depict ingredients and products moving in a 
manufacturing system.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Conveyors 
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Not all graphic elements in this category have built-in animation 
properties. 

Name Category Purpose Accepted values 

DiverterPosition General Specifies the current position of the conveyor diverter. Bound tag 

MaxDiverterPosition General Specifies the value for a completely open  diverter.  Any numeric value greater than the 
MinDiverterPosition property value 

MaxPusherPosition General Specifies the value for a maximum extended conveyor 
pusher. 

Any numeric value greater than the 
MinPusherPosition property value 

MinDiverterPosition General Specifies the value for a completely closed diverter. Any numeric value less than the 
MaxDiverterPosition property value 

MinPusherPosition General Specifies the value for a minimum extension of the conveyor 
pusher. 

Any numeric value less than the 
MaxPusherPosition property value 

PusherPosition General Specifies the current position of the pusher arm. Bound tag 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. Not all graphic elements in this category have the same 
properties. The unique properties of a graphic element in this category 
depend on the graphic element selected.  

Name Category Purpose Accepted values 

DiverterColor Appearance Specifies the color of the conveyor diverter. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

RailColor Appearance Specifies the color of the rail. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 
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Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
What types of HMI screens do I need? on page 47 

Find a graphic element in the Toolbox on page 135 

Belt on page 213 

Roller on page 215 

GeneralEquipment on page 208 

The Belt category under GeneralEquipment > Conveyors in the 
Toolbox contains conveyor belts commonly used in a manufacturing 
system.   

Use a conveyor belt on the screen to depict where and how products or 
ingredients are moved in the manufacturing system.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. Not all graphic elements in this category have the same 
properties. The unique properties of a graphic element in this category 
depend on the graphic element selected.  

Name Category Purpose Accepted values 

Belt 
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BeltColor Appearance Specifies the color of the conveyor belt. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LegColor Appearance Specifies the color of the conveyor belt legs. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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See also 
Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

The Roller category under GeneralEquipment > Conveyors in the 
Toolbox contains conveyor rollers commonly used in a manufacturing 
system.   

Use a conveyor roller on the screen to depict where and how products or 
ingredients are moved in the manufacturing system.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. Not all graphic elements in this category have the same 
properties. The unique properties of a graphic element in this category 
depend on the graphic element selected. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LegColor Appearance Specifies the color of the conveyor belt legs. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

RollerColor Appearance Specifies the fill color of the conveyor rollers. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Roller 
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Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

The Fans category under GeneralEquipment in the Toolbox contains 
fans, including a box fan with built-in animation properties, commonly 
used in a manufacturing system.     

Use a fan to depict the cooling process on the manufacturing site. Certain 
fans have built-in animation properties. Animate the fan by binding the 
built-in animation properties of the graphic element to tags in the 
controllers.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Not all graphic elements in this category have the same properties. The 
built-in animation properties of a graphic element in this category depend 
on the graphic element selected.  

Name Category Purpose Accepted values 

Value General Specifies the value of the graphic element. Bound tag 

Fans 
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Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Not all graphic elements in this category have the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected. 

Name Category Purpose Accepted values 

BladeColor Appearance Specifies the color of the fan blades. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FinColor Appearance Specifies the color of the fan fins. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
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X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 
left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Search for and select a data type on page 373 

Search for and select a tag 

Add a graphic element to a screen on page 136 

What is an event? on page 476 

GeneralEquipment on page 208 

The Feeders category under GeneralEquipment in the Toolbox 
contains vibrating feeders commonly used in a manufacturing process.  

Use a feeder to depict at what point a product or ingredientis inserted in 
the manufacturing system. 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

SlotColor Appearance Specifies the color of the feeder slots.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Feeders 
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Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

GeneralEquipment on page 208 

The Fixtures category under GeneralEquipment in the Toolbox 
contains an industrial shelf and a table commonly used in a 
manufacturing system. 

Use a shelf or a table to depict where products and ingredients are 
placed in a manufacturing system.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

Fixtures 
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FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

GeneralEquipment on page 208 

The Gauges category under GeneralEquipment  in the Toolbox 
contains bar graphs, including spider charts, and gauges commonly 
used in a manufacturing system.  

Use a bar graph or gauge to display a value from a controller by moving 
the needle or filling a bar on a graph. Animate the graphic element to 

Gauges 



Chapter 9  Add a graphic element to a project 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 221 
 

display values or move a needle. Bind the built-in animation properties of 
the graphic element to tags in the controllers.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Not all graphic elements in this category have the same properties. The 
built-in animation properties of a graphic element in this category depend 
on the graphic element selected. For graphic elements with more than 
one indicator, a value pertains to a certain side of a graphic element. For 
example the MaxValue property for certain graphic elements may be 
LeftMaxValue or RightMinValue and Value may be LeftValue. Configure 
left and right value properties to affect a needle or bar on the indicated 
side of the graphic element.  

Name Category Purpose Accepted values 

LeftMaxValue General Specifies the maximum value for left side of the graphic 
element. 

Any numeric value greater than the 
LeftMinValue property value 

LeftMinValue General Specifies the minimum value for the left side of the graphic 
element. Any numeric value 

less than the 
LeftMaxValue property 
value 

LeftValue General Specifies the current position of the needle on the left side of 
the gauge. 

Bound tag 

MaxValue General Specifies the maximum value on the graphic element. Any numeric value greater than the 
MinValue property value 

MinValue General Specifies the minimum value on the graphic element.  Any numeric value less than the 
MaxValue property value 

RightMaxValue General Specifies the maximum value for the right side of the graphic 
element. 

Any numeric value greater than the 
RightMinValue property value 

RightMinValue General Specifies the minimum value for the right side of the graphic 
element. 

Any numeric value less than the 
RightMaxValue property value 

RightLevel General Specifies the level of the bar on the right side of the graph. Bound tag 

Value General Specifies the value of the graphic element. Bound tag 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Not all graphic elements in this category share the same unique 
properties. The unique properties of a graphic element depend on the 
graphic element selected.  

Name Category Purpose Accepted values 
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FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FillOpacity Appearance Specifies the transparency of the fill color. 0 (fully transparent) - 100 (fully 
opaque) 

FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontName Appearance Specifies the font of the text. Any selected font 
FontSize Appearance Specifies the size of the text. Positive numbers 
HighColor Appearance Specifies the color of the high zone on the gauge. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

HousingColor Appearance Specifies the color of the housing. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LevelColor Appearance Specifies the color of the fill level.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LeftLevelColor Appearance Specifies the level color of the bar on the left side of the 
graph. 

Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LowColor Appearance Specifies the color of the low zone. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 
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MediumColor Appearance Specifies the color of the medium zone on the gauge. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

NeedleColor Appearance Specifies the color of the needle. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

RightLevelColor Appearance Specifies the color of the bar on the right side of the graph. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

TextOpacity Appearance Specifies the transparency of the text.  0 (fully transparent) - 100 (fully 
opaque) 

TickMarkColor Appearance Specifies the color of the tick marks. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

TickMarkOpacity Appearance Specifies the transparency of the tick marks.  0 (fully transparent) - 100 (fully 
opaque) 

WarningColor Appearance Specifies the color of the warning zone. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 
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Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Search for and select a data type on page 373 

Search for and select a tag 

GeneralEquipment on page 208 

The Indicators category in the Toolbox contains graphic elements that 
represent equipment such as lights and poles.   

Use an indicator to depict the status of a machine on the plant floor, to 
symbolize start and stop on the HMI device, or to indicate when a certain 
value is reached. The Indicators category has graphic elements in 
additional categories:   

• StackLights 
• TrafficLights 
• WallMountLights 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Not all graphic elements in this category have the same properties. The 
built-in animation properties of a graphic element in this category depend 
on the graphic element selected. 

Name Category Purpose Accepted values 

Indicators 
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InputTag General Specifies the tag in a controller that represents the input data 
of the device. 

Bound tag 

On General Specifies the on or off state of the LED. • On (selected) 
• Off (cleared) 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Not all graphic elements in this category have the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected.  

Name Category Purpose Accepted values 

BaseColor Appearance Specifies the color of the base of the graphic element. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

HousingColor Appearance Specifies the color of the housing. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 
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Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
What types of HMI screens do I need? on page 47 

Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

The StackLights category under GeneralEquipment > Indicators  in 
the Toolbox contains stack light modules as well as poles, bases, and 
caps for the modules. Stack lights are commonly used in a manufacturing 
system. 

Use a stack light to display the status of a machine on the plant floor. For 
example, illuminate the green light when the machine is operating 
correctly, the red light when the machine is not operating correctly, and 
the blue light when the machine is being serviced. To animate the graphic 
element, bind the built-in animation properties to tags. The values in a  
controller illuminate the lights when certain values in the controller are 
read.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Not all graphic elements in this category have the same properties. The 
built-in animation properties of a graphic element in this category depend 
on the graphic element selected. For example, the LightOn property for 
certain stack lights may be Light1On, Light2On, Light3On, Light4On, or 
Light5On, depending on the number of flights on the module. Configure 
the LightOn properties for a stack light to animate the indicated light on 
the graphic element.   

Name Category Purpose Accepted values 

LightOn General Specifies the on and off state of the light. • On - selected 
• Off - cleared 

StackLights 
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Light1On General Specifies the one and off state of the single or bottom light. • On (selected) 
• Off (cleared) 

Light2On General Specifies the on and off state of the second light from the 
bottom. 

• On (selected) 
• Off (cleared) 

Light3On General Specifies the on and off state of the third light from the 
bottom. 

• On (selected) 
• Off (cleared) 

Light4On General Specifies the on and off state of the fourth light from the 
bottom. 

• On (selected) 
• Off (cleared) 

Light5On General Specifies the on and off state of the fifth light from the 
bottom. 

• On (selected) 
• Off (cleared) 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Not all graphic elements in this category have the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected. For example, LightColor properties may 
include Light1Color, Light2Color, Light3Color, Light3Color, or 
Light5Color, depending on the stack light selected.  

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LightColor Appearance Specifies the color of the light. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Light1Color Appearance Specifies the color the single or bottom light. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Light2Color Appearance Specifies the color of the second light from the bottom. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 
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Light3Color Appearance Specifies the color of the third light from the bottom. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Light4Color Appearance Specifies the color of the fourth light from the bottom. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Light5Color Appearance Specifies the color the of the fifth light from the bottom. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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See also 
Add a graphic element to a screen on page 136 

What is an event? on page 476 

Search for and select a data type on page 373 

Search for and select a tag 

The TrafficLights category under GeneralEquipment > Indicators  in 
the Toolbox contains traffic lights with two and three lights.  

Use a traffic light to symbolize stop and start on the HMI device. To 
animate the graphic element, bind the built-in animation properties to 
tags. The values from a controller illuminate the lights when certain 
values in the controller are read.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

Light1On General Specifies the one and off state of the single or bottom light. • On (selected) 
• Off (cleared) 

Light2On General Specifies the on and off state of the second light from the 
bottom. 

• On (selected) 
• Off (cleared) 

Light3On General Specifies the on and off state of the third light from the 
bottom. 

• On (selected) 
• Off (cleared) 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

TrafficLights 
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Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

What is an event? on page 476 

Search for and select a data type on page 373 

• Search for and select a tag 
The WallMountLights category under GeneralEquipment > 
Indicators  in the Toolbox contains wall mounted lights with two to five 
lights. These lights are commonly used in a manufacturing system. 

Use a wall mount light to indicate when a certain value in a controller is 
reached by illuminating the light. To animate the graphic element, bind 
the built-in animation properties to tags. The values from a controller 
illuminate the lights when certain values in the controller are read.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Not all graphic elements in this category have the same properties. The 
built-in animation properties of a graphic element in this category depend 
on the graphic element selected. For example, the built-in animation 

WallMountLights 
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properties for a wall mount light with two modules are Light1On and 
Light2On. For a wall mount light with five modules, these properties 
include Light1On through Light5On.  

Name Category Purpose Accepted values 

Light1On General Specifies the one and off state of the single or bottom light. • On (selected) 
• Off (cleared) 

Light2On General Specifies the on and off state of the second light from the 
bottom. 

• On (selected) 
• Off (cleared) 

Light3On General Specifies the on and off state of the third light from the 
bottom. 

• On (selected) 
• Off (cleared) 

Light4On General Specifies the on and off state of the fourth light from the 
bottom. 

• On (selected) 
• Off (cleared) 

Light5On General Specifies the on and off state of the fifth light from the 
bottom. 

• On (selected) 
• Off (cleared) 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share.  

Not every graphic element in this category has the same unique 
properties. The unique properties of a graphic element depend on the 
graphic element selected. For example, LightColor properties may 
include Light1Color, Light2Color, Light3Color, Light3Color, or 
Light5Color, depending on the wall mount light selected. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Light1Color Appearance Specifies the color the single or bottom light. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Light2Color Appearance Specifies the color of the second light from the bottom. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 
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Light3Color Appearance Specifies the color of the third light from the bottom. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Light4Color Appearance Specifies the color of the fourth light from the bottom. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Light5Color Appearance Specifies the color the of the fifth light from the bottom. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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See also 
Add a graphic element to a screen on page 136 

What is an event? on page 476 

Search for and select a data type on page 373 

Search for and select a tag 

The Instrumentation category in the Toolbox contains graphic 
elements that represent digital indicators and panel meters. The graphic 
elements in Instrumentation are organized into a category named 
Process.    

See also 
What types of HMI screens do I need? on page 47 

Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

GeneralEquipment on page 208 

The Process category under GeneralEquipment > Instrumentation in 
the Toolbox contains a digital indicator and panel meters commonly 
used in a manufacturing system. 

Use a digital indicator or panel meter to display a value on a piece of 
equipment in the manufacturing system. To display a value, bind the 
built-in animation property of the graphic element to a tag in a controller. 
The Value built-in animation property exists in the General category of 
the Properties window.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

Value General Specifies the value of the graphic element. Bound tag 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share.  

Not all graphic elements in this category have the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected.  

Instrumentation 

Process 
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Name Category Purpose Accepted values 

Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 
• Not bold - cleared 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontName Appearance Specifies the font of the text. Any selected font 
FontSize Appearance Specifies the size of the text. Positive numbers 
HousingColor Appearance Specifies the color of the housing. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 
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Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

What is an event? on page 476 

Search for and select a data type on page 373 

Search for and select a tag 

Bind a property to a data item on page 508 

The Laboratory category under GeneralEquipment in the Toolbox 
contains equipment, such as beakers, a flask, funnel, test tube, and 
thermometers.  

Use laboratory graphic elements as symbols on the HMI device or to 
depict a laboratory environment. To animate the graphic element, bind 
the built-in animation properties of the graphic element to tags in the 
controllers. Not all of the graphic elements in this category have the same 
properties. The built-in animation properties of a graphic element in this 
category depend on the graphic element selected.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

Level General Specifies the value for the fill level. Bound tag 

MaxLevel General Specifies the value for the maximum fill level. Any numeric value greater than the 
MinLevel property value 

MinLevel General Specifies the value for the minimum fill level. Any numeric value less than the 
MaxLevel property value 

ShowFlame General Specifies the on or off state for the flame. • Show flame - selected 
• Do not show flame - cleared 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share.  

Not all graphic elements in this category have the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected.  

Name Category Purpose Accepted values 

Laboratory 
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BaseColor Appearance Specifies the color of the base of the graphic element. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LevelColor Appearance Specifies the color of the fill level.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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See also 
Add a graphic element to a screen on page 136 

What is an event? on page 476 

Search for and select a data type on page 373 

Search for and select a tag 

GeneralEquipment on page 208 

The Miscellaneous category under GeneralEquipment in the Toolbox 
contains graphic elements that represent equipment such as brackets, 
blades, blowers, flames, gears, hydraulic arms, thermometers, levers, lift 
tables, paper rolls, wheels, and so forth. The graphic elements in 
Miscellaneous are organized into a Frames category. 

See also 
What types of HMI screens do I need? on page 47 

Toolbox on page 131  

Add a graphic element to a screen on page 136 

Frames on page 237 

GeneralEquipment on page 208 

The Frames category under GeneralEquipment > Miscellaneous in 
the Toolbox contains a non-beveled panel and a beveled panel that 
resemble control panels.   

Place a frame on the screen and add buttons and indicators to the frame.    

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Miscellaneous 

Frames 
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Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

The Motors category in the Toolbox contains graphic elements that 
represent servo and control matched motors. The graphic elements in 
Motors are organized into ControlMatched and Servo categories.  

See also 
What types of HMI screens do I need? on page 47 

Toolbox on page 131  

Add a graphic element to a screen on page 136 

ControlMatched on page 238 

Servo on page 239 

The ControlMatched category under GeneralEquipment > Motors in 
the Toolbox contains motors commonly used in a manufacturing 
system.   

Use a control matched motor to depict the location of the motor in the 
manufacturing system.   

Motors 

ControlMatched 



Chapter 9  Add a graphic element to a project 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 239 
 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

The Servo category under GeneralEquipment > Motors in the 
Toolbox contains motors used in a manufacturing system. Servo motors Servo 
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include rotary and linear motors commonly used to control robotics at 
high rates of speed. 

Use a servo motor to depict the location of the motor in the manufacturing 
system.       

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Not all graphic elements in this category share the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected.  

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

RailColor Appearance Specifies the color of the rail. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
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X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 
left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

The Pallets category under GeneralEquipment in the Toolbox 
contains pallets commonly used in a manufacturing system.   

Use a pallet on the screen to depict the placement of product and 
ingredients in the manufacturing process.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 

Pallets 
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Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 
opaque) 

Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 
• Not visible - cleared 

Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

GeneralEquipment on page 208 

The Pipes category in the Toolbox contains graphic elements that 
represent pipes, tubes, and flanges commonly used in a manufacturing 
system. The graphic elements in Pipes are organized into categories:   

• Flanges 
• FlexibleTubes 
• Piping 

See also 
Toolbox on page 131  

Add a graphic element to a screen on page 136 

Flanges on page 242 

FlexibleTubes on page 243 

Piping on page 245 

The Flanges category under GeneralEquipment > Pipes in the 
Toolbox contains pipe flanges commonly used in a manufacturing 
system.   

Use a flange to connect pipes in the application on the HMI device.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

Pipes 

Flanges 
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FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

The FlexibleTubes category under GeneralEquipment > Pipes in the 
Toolbox contains tubes at a variety of angles commonly used in a 
manufacturing system.   

Use a flexible tube to indicate where a pipe bends and to show the flow of 
liquid material through the pipes. To animate the graphic element, bind 
the built-in animation property of the graphic element to a tag. The value 

FlexibleTubes 
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from the controller shows the flow when a certain value in the controller is 
read.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.   

Not all graphic elements in this category have this built-in animation 
property: 

Name Category Purpose Accepted values 

ShowFlow General Specifies the on or off state for flow.  • Show flow - selected 
• Do not show flow - cleared 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Not all graphic elements in this category have the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected.  

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FlowColor Appearance Specifies the color of the flow. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 
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Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

• Search for and select a tag 
The Piping category under GeneralEquipment > Pipes in the Toolbox 
contains pipes at a variety of angles, as well as connectors, that are 
commonly used in a manufacturing system.   

Use pipes and connectors to show the flow of liquid material within a 
manufacturing system. To animate the graphic element, bind the built-in 
animation property of the graphic element to a tag. The value from a 
controller shows the flow when a certain value in the controller is read.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device. Not all graphic elements in this 
category have built-in animation properties.   

Name Category Purpose Accepted values 

ShowFlow General Specifies the on or off state for flow.  • Show flow - selected 
• Do not show flow - cleared 

Piping 



Chapter 9  Add a graphic element to a project 
 

246 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share.  

Not all graphic elements in this category have the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected.  

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FlowColor Appearance Specifies the color of the flow. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FlowOpacity Appearance Specifies the transparency of the flow color. 0 (fully transparent) - 100 (fully 
opaque) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 
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Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

• Search for and select a tag 
The Pumps category under GeneralEquipment in the Toolbox 
contains a pump and a submersible pump commonly used in a 
manufacturing system.   

Use a pump to depict the flow of liquid material. To animate the graphic 
element, bind the built-in animation property of the graphic element to a 
tag. The value from a controller shows the flow when a certain value in 
the controller is read.     

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Not all graphic elements in this category have this built-in animation 
property:  

Name Category Purpose Accepted values 

ShowFlow General Specifies the on or off state for flow.  • Show flow - selected 
• Do not show flow - cleared 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share.  

Not all graphic elements in this category have the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected.  

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Pumps 
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FlowColor Appearance Specifies the color of the flow. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FlowOpacity Appearance Specifies the transparency of the flow color. 0 (fully transparent) - 100 (fully 
opaque) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

Search for and select a tag 

• GeneralEquipment on page 208 
The Sensors category under GeneralEquipment in the Toolbox 
contains sensors such as a barcode scanner, flow meter, photo eye 

Sensors 
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sensors and a scale. These elements are commonly used in a 
manufacturing system.   

Use a sensor graphic element to depict where products and ingredients 
are detected and measured in the manufacturing system. If you place the 
Flow Meter graphic element on the screen, animate the graphic element 
by binding the built-in animation property of the graphic element to a tag. 
The value from a controller shows the flow when a certain value in the 
controller is read.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Not all graphic elements in this category have this built-in animation 
property:  

Name Category Purpose Accepted values 

ShowFlow General Specifies the on or off state for flow.  • Show flow - selected 
• Do not show flow - cleared 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. Not all graphic elements in this category have the same 
properties. The unique properties of a graphic element in this category 
depend on the graphic element selected.  

Name Category Purpose Accepted values 

BeamColor Appearance Specifies the color of the laser beam. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

BeamOpacity Appearance Specifies the transparency of the laser beam. 0 (fully transparent) - 100 (fully 
opaque) 

DisplayColor Appearance Specifies the color of the display unit. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 
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DisplayFaceColor Appearance Specifies the color of the face of the display unit. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FlowColor Appearance Specifies the color of the flow. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FlowOpacity Appearance Specifies the transparency of the flow color. 0 (fully transparent) - 100 (fully 
opaque) 

IndicatorColor Appearance Specifies the color of the indicator light. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common Properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
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X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 
left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

Search for and select a tag 

GeneralEquipment on page 208 

The Separators category under GeneralEquipment in the Toolbox 
contains a separator commonly used in a manufacturing system.   

Use a separator to depict where products or ingredients are separated in 
the manufacturing process.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Separators 
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Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

GeneralEquipment on page 208 

The Spools category under GeneralEquipment in the Toolbox 
contains spools commonly used in a manufacturing system.   

Use a spool to show how items such as electrical cable or hose are 
housed before use in a manufacturing system.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Spools 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

GeneralEquipment on page 208 

The TanksAndContainers category in the Toolbox contains graphic 
elements that represent tanks and container equipment in the plant. The 
graphic elements in TanksAndContainers are organized into 
categories:  

• Agitators 
• Containers 
• Cutouts 
• Other 
• Tanks 

See also 
What types of HMI screens do I need? on page 47 

TanksAndContainers 
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Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

GeneralEquipment on page 208 

The Agitators category under GeneralEquipment > 
TanksAndContainers in the Toolbox contains agitators and mixing 
hoppers commonly used in a manufacturing system.   

Use an agitator or mixing hopper to depict combining ingredients in a 
manufacturing system. If you place a mixing hopper on the screen, 
change the built-in animation properties to show the initial, maximum, 
and minimum levels in the hopper. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device. Not all graphic elements in this 
category have built-in animation properties.  

Name Category Purpose Accepted values 

Level General Specifies the value for the fill level. Bound tag 

MaxLevel General Specifies the value for the maximum fill level. Any numeric value greater than the 
MinLevel property value 

MinLevel General Specifies the value for the minimum fill level. Any numeric value less than the 
MaxLevel property value 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. Not all graphic elements in this category have the same 
properties. The unique properties of a graphic element in this category 
depend on the graphic element selected.  

Name Category Purpose Accepted values 

AgitatorColor Appearance Specifies the color of the hopper agitator.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

AxleColor Appearance Specifies the color of the agitator axle.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Agitators 
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FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LevelColor Appearance Specifies the color of the fill level.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

MotorColor Appearance Specifies the color of the motor. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

Search for and select a tag 

The Containers category under GeneralEquipment > 
TanksAndContainers in the Toolbox contains bins, bottles, cans, 
boxes, crates, jars, on and so forth. Containers are commonly used in a 
manufacturing system.   

Use a container to depict packaging in the manufacturing system. If you 
place a container on the screen that can depict data such as fill levels, 
change the built-in animation properties for the graphic element. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Not all graphic elements in this category have built-in animation 
properties. The built-in animation properties for a graphic element in this 
category depend on the graphic element selected.  

Name Category Purpose Accepted values 

Cap General Specifies if the cap is on or off.  • Cap on - selected 
• Cap off - cleared 

Level General Specifies the value for the fill level. Bound tag 

MaxLevel General Specifies the value for the maximum fill level. Any numeric value greater than the 
MinLevel property value 

MinLevel General Specifies the value for the minimum fill level. Any numeric value less than the 
MaxLevel property value 

ShowOpen General Specifies the open or closed state of the cardboard box. • Open - selected 
• Closed - cleared 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share.  

Not all graphic elements in this category have the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected.  

Name Category Purpose Accepted values 

Containers 
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CapColor Appearance Specifies the color of the cap. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LevelColor Appearance Specifies the color of the fill level.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

Search for and select a tag 

The Cutouts category under GeneralEquipment > 
TanksAndContainers in the Toolbox contains tank cutouts commonly 
depict levels of ingredients and products in a manufacturing system.   

Use a tank cutout to depict the level of an ingredient or product in a 
manufacturing system.For any tank cutout you place on the screen, 
change the built-in animation properties to show the initial, maximum, 
and minimum levels in the tank. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

Level General Specifies the value for the fill level. Bound tag 

MaxLevel General Specifies the value for the maximum fill level. Any numeric value greater than the 
MinLevel property value 

MinLevel General Specifies the value for the minimum fill level. Any numeric value less than the 
MaxLevel property value 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LevelColor Appearance Specifies the color of the fill level.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Cutouts 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

Search for and select a tag 

The Other category under GeneralEquipment > TanksAndContainers 
in the Toolbox contains tubes and tube fill indicators commonly depict 
levels of ingredients in a manufacturing system.   

Use a tube or tube fill indicator to depict the level of an ingredient in a 
manufacturing system.Change the built-in animation properties to show 
the initial, maximum, and minimum levels of the graphic element. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Other 
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Name Category Purpose Accepted values 

Level General Specifies the value for the fill level. Bound tag 

MaxLevel General Specifies the value for the maximum fill level. Any numeric value greater than the 
MinLevel property value 

MinLevel General Specifies the value for the minimum fill level. Any numeric value less than the 
MaxLevel property value 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. Not all graphic elements in this category have the same 
properties. The unique properties of a graphic element in this category 
depend on the graphic element selected.  

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

KnobColor Appearance Specifies the color of the knobs. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LevelColor Appearance Specifies the color of the fill level.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

PipeColor Appearance Specifies the color of the pipes that connect to the fill 
indicator. 

Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

TickMarkOpacity Appearance Specifies the transparency of the tick marks.  0 (fully transparent) - 100 (fully 
opaque) 

TubeColor Appearance Specifies the color of the tube.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

Search for and select a tag 

The Tanks category under GeneralEquipment > 
TanksAndContainers in the Toolbox contains tanks, silos, boilers, and 
cooling tanks commonly used in a manufacturing system.   

Use a tank or cooling tower to depict products or ingredients housed in a 
manufacturing system. If you place a tank or other graphic element on 
the screen that depicts fill level, change the built-in animation properties 
for the graphic element.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 

Tanks 
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animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Not every graphic element in this category has built-in animation 
properties. The built-in animation properties for a graphic element 
depend on the graphic element selected.  

Name Category Purpose Accepted values 

Level General Specifies the value for the fill level. Bound tag 

MaxLevel General Specifies the value for the maximum fill level. Any numeric value greater than the 
MinLevel property value 

MinLevel General Specifies the value for the minimum fill level. Any numeric value less than the 
MaxLevel property value 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Not all graphic elements in this category have the same properties. The 
unique properties for a graphic element in this category depend on the 
graphic element selected.  

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

JacketColor Appearance Specifies the color of the tank jacket. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LevelColor Appearance Specifies the color of the fill level.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 
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Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

Search for and select a tag 

The Textures category under GeneralEquipment in the Toolbox 
contains concrete pads and stainless steel plates commonly used in a 
manufacturing system.  

Use a concrete pad or stainless steel plate to enhance or more 
accurately depict a piece of equipment in the manufacturing system.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

Textures 



Chapter 9  Add a graphic element to a project 
 

264 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

GeneralEquipment on page 208 

The Tick Marks category under GeneralEquipment in the Toolbox 
contains marks commonly shown on gauges and graphs or any other 
graphic element used to depict a value in a manufacturing system.   

Use a tick mark to show a value on a gauge, graph, or other graphic 
element. 

Tick Marks 
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Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

Color Appearance/Border Specifies the color of the border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Style Appearance/Border Specifies the style of the border line. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Width Appearance/Border Specifies the width of the border line. • None 
• 1 point 
• 2 point 
• 4 point 
• 8 point 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 
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Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

• eneralEquipment on page 208 
The Valves category under General Equipment in the Toolbox 
contains valves commonly used in a manufacturing system.  

Add a valve, spray nozzle, or lever to a piece of equipment in the 
manufacturing system. Animate a spray nozzle or lever by binding the 
built-in animation properties of the graphic element to tags. The values 
from a controller show the spray or open the lever when a certain value in 
the controller is read.   

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Not all graphic elements in this category have the same properties. The 
built-in animation properties of a graphic element in this category depend 
on the graphic element selected.  

Name Category Purpose Accepted values 

ShowOpen General Specifies the open or closed state of the cardboard box. • Open - selected 
• Closed - cleared 

ShowSpray General Specifies the on or off state of the spray. • Show spray - selected 
• Do not show spray - cleared 

SprayOpacity Appearance Specifies the transparency of the spray.  0 (fully transparent) - 100 (fully 
opaque) 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Not all graphic elements in this category have the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected. 

Name Category Purpose Accepted values 

Valves 
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BodyColor Appearance Specifies the color of the valve body. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

HousingColor Appearance Specifies the color of the housing. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

SpindleColor Appearance Specifies the spindle color of the valve. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

SprayColor Appearance Specifies the color of the spray. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
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Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 
opaque) 

Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 
• Not visible - cleared 

Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

Search for and select a tag 

GeneralEquipment on page 208 

The Graphs category under GeneralEquipment in the Toolbox 
contains graphic elements to display data on bar graphs and spider 
charts. These graphic elements are commonly used to display data in a 
manufacturing system. 

Add a bar graph that shows the amount filled or a spider chart that 
displays the status of three to seven tag values, depending on the spider 
chart selected. For example, to display the status of four tag values, add 
the Spider Chart 4 graphic element and bind the built-in animation 
properties of the graphic element to a tag. The values from a controller 
are plotted on the chart or graph when the values are read from the 
controller.   

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device. 

Not all graphic elements in this category have the same properties. The 
built-in animation properties for a graphic element in this category 
depend on the graphic element selected. For example, the Input values 
for a Spider Chart 4 include Input1 through Input4, Input1Min through 
Input4Min, and Input1Max through Input4Max.  

Name Category Purpose Accepted values 

Input1 General Specifies the value for the first dimension in the spider chart. Bound tag 

Input2 General Specifies the value for the second dimension in the spider 
chart. 

Bound tag 

Graph 
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Input3 General Specifies the value for the third dimension in the spider 
chart.  

Bound tag 

Input4 General Specifies the value for the fourth dimension in the spider 
chart.  

Bound tag 

Input5 General Specify the value for the fifth dimension in the spider chart. Bound tag 

Input6 General Specifies the value for the sixth dimension in the spider 
chart.  

Bound tag 

Input7 General Specifies the value for the seventh dimension of the spider 
chart.  

Bound tag 

Input1Max General Specifies the maximum value for the first dimension in the 
spider chart. 

Any value greater than the Input1Min 
property value 

Input2Max General Specifies the maximum value for the second dimension in the 
spider chart. 

Any value greater than the Input2Min 
property value 

Input3Max General Specifies the maximum value for the third dimension in the 
spider chart.  

Any value greater than the Input3Min 
property value 

Input4Max General Specifies the maximum value for the fourth dimension in the 
spider chart.  

Any value greater than the Input4Min 
property value 

Input5Max General Specifies the maximum value for the fifth dimension of the 
spider chart.  

Any value greater than the Input5Min 
property value 

Input6Max General Specifies the maximum value for the sixth dimension of the 
spider chart.  

Any value greater than the Input6Min 
property value 

Input7Max General Specifies the maximum value for the seventh dimension in 
the spider chart.  

Any value greater than the Input7Min 
property value 

Input1Min General Specifies the minimum value for the first dimension in the 
spider chart. 

Any value less than the Input1Max 
property value 

Input2Min General Specifies the minimum value for the second dimension in the 
spider chart.  

Any value less than the Input2Max 
property value 

Input3Min General Specifies the minimum value for the third dimension in the 
spider chart.  

Any value less than the Input3Max 
property value 

Input4Min General Specifies the minimum value for the fourth dimension in the 
spider chart.  

Any value less than the Input4Max 
property value 

Input5Min General Specifies the minimum value for the fifth dimension of the 
spider chart. 

Any value less than the Input5Max 
property value 

Input6Min General Specifies the minimum value for the sixth dimension in the 
spider chart. 

Any value less than the Input6Max 
property value 

Input7Min General Specifies the minimum value for the seventh dimension of 
the spider chart.  

Any value less than the Input7Max 
property value 

MaxValue General Specifies the maximum value on the graphic element. Any numeric value greater than the 
MinValue property value 

MinValue General Specifies the minimum value on the graphic element.  Any numeric value less than the 
MaxValue property value 

Value General Specifies the value of the graphic element. Bound tag 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. Not all graphic elements in this category have the same 
properties. The unique properties of a graphic element in this category 
depend on the graphic element selected.  

Name Category Purpose Accepted values 
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Color Appearance/Axis Specifies the color of the lines on the spider chart. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Color Appearance/Border Specifies the color of the border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

CornerRadius Appearance Specifies the curve of the corners.  0 or a positive number 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

LevelColor Appearance Specifies the color of the fill level.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Style Appearance/Axis Specifies the style of the lines on the spider chart. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Style Appearance/Border Specifies the style of the border line. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Width Appearance/Axis Specifies the width of the lines on the spider chart. • None 
• 1 pixel 
• 2 pixels 
• 4 pixels 
• 8 pixels 

Width Appearance/Border Specifies the width of the border line. • None 
• 1 point 
• 2 point 
• 4 point 
• 8 point 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

Search for and select a tag 

The Security category under GeneralEquipment in the Toolbox 
contains buttons predefined to log on and log off the application on the 
HMI device: 

• Log Off Button 
• Log On Button 

See also 
What types of HMI screens do I need? on page 47 

Toolbox on page 131  

Add a graphic element to a screen on page 136 

Security 
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Log Off Button on page 274 

Log On Button on page 272 

The Log On Button is a graphic element predefined to open the Logon 
dialog box. The Log On Button appears in the Security category of the 
Toolbox. 

Use the Log On button to: 

• Open the Logon dialog box on the HMI device.  
• Log on to the project on the HMI device using your user name and 

password or PIN. 

 
Tips:  
• Guest and and logged on user accounts see only those screens on the HMI device for which their 

security role is granted access.  
• By default, a Log On button appears in the System Banner at the top of each screen.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

Text General Specifies the text on the graphic element.  
Do not place text against the border of a graphic element. 
Allow for a small difference in space, such as one or two 
characters. If you place text against the border of a graphic 
element, the text may wrap differently or appear clipped on 
the HMI device. 

Alpha-numeric characters 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

CornerRadius Appearance Specifies the curve of the corners.  0 or a positive number 

TextAlignment Appearance Specifies the vertical and horizontal alignment of the text.  Vertical alignment: 
• Top  
• Center  
• Bottom  
Horizontal alignment: 
• Left justified  
• Centered  
• Right justified  

Log On Button 
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Color Appearance/Border Specifies the color of the border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Style Appearance/Border Specifies the style of the border line. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Width Appearance/Border Specifies the width of the border line. • None 
• 1 point 
• 2 point 
• 4 point 
• 8 point 

FontName Appearance Specifies the font of the text. Any selected font 
FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontSize Appearance Specifies the size of the text. Positive numbers 
Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 

• Not bold - cleared 
FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

UsePredefinedDisabled Appearance Specifies if a crosshatch overlay shows on the control 
element when you disable the element. 

• Use predefined disabled 
appearance (selected) 

• Do not use predefined disabled 
appearance (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 
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Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a Security Administration user account on page 688 

Log Off Button on page 274 

Security on page 271 

The Log Off Button is a graphic element predefined to log you off the 
application on the HMI device. The Log Off Button appears in the 
Security category of the Toolbox.  

Use the Log Off button to: 

• Log off the project on the HMI device. 
• Automatically log on using the Guest user role. A Guest user can 

access only those screens on the HMI device for which the Guest 
user role is granted access.  

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

Text General Specifies the text on the graphic element.  
Do not place text against the border of a graphic element. 
Allow for a small difference in space, such as one or two 
characters. If you place text against the border of a graphic 
element, the text may wrap differently or appear clipped on 
the HMI device. 

Alpha-numeric characters 

Log Off Button 
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Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

CornerRadius Appearance Specifies the curve of the corners.  0 or a positive number 

TextAlignment Appearance Specifies the vertical and horizontal alignment of the text.  Vertical alignment: 
• Top  
• Center  
• Bottom  
Horizontal alignment: 
• Left justified  
• Centered  
• Right justified  

Color Appearance/Border Specifies the color of the border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Style Appearance/Border Specifies the style of the border line. • Any selected Line style - None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style - Flat, 
Round, or Square 

• Any selected Join style - Miter, 
Bevel, or Round 

Width Appearance/Border Specifies the width of the border line. • None 
• 1 point 
• 2 point 
• 4 point 
• 8 point 

FontName Appearance Specifies the font of the text. Any selected font 
FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontSize Appearance Specifies the size of the text. Positive numbers 
Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 

• Not bold - cleared 
FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 
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UsePredefinedDisabled Appearance Specifies if a crosshatch overlay shows on the control 
element when you disable the element. 

• Use predefined disabled 
appearance (selected) 

• Do not use predefined disabled 
appearance (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a Security Administration user account on page 688 

Log On Button on page 272 

Security on page 271 

The SignsAndSymbols category in the Toolbox contains graphic 
elements that represent symbols such as electrical symbols as well as 
hazard and alert signs and symbols. The graphic elements in 
SignsAndSymbols are organized into categories: 

• ElectricalSymbols 
• FluidPower 
• Flowcharts 
• Icons 
• Indicators 
• ISASymbols 

SignsAndSymbols 
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• ISOHazardAlertSigns 
• ISOHazardAlertSymbols 
• ISOMandatorySigns 
• ISOMandatorySymbols 
• ISOSignTemplates 
• SignTemplates 

See also 
What types of HMI screens do I need? on page 47 

Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

The ElectricalSymbols category under SignsAndSymbols in the 
Toolbox contains electrical symbols such as lines, meters, circuits 
breakers, contacts, connections, breaks, and so forth. These shapes 
commonly used to depict an electrical system.  

Add symbols to the screen to depict an electrical system in a 
manufacturing plant. 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

BorderColor Appearance Specifies the border color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

ElectricalSymbols 
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Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

SignsAndSymbols on page 276 

The Flowcharts category under GeneralEquipment > 
SignsAndSymbols in the Toolbox contains miscellaneous shapes as 
well as shapes used to create flowcharts. These shapes are commonly 
used in the processes of a manufacturing system.   

Use flowchart symbols to depict work flow or process in a manufacturing 
system.    

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Flowcharts 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

The FluidPower category under SignsAndSymbosl in the Toolbox 
contains valves and pneumatic symbols. These graphic elements are 
commonly used to depict a fluid power system.   

Add values and the pneumatic symbols to depict a power system that 
uses water.    

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FluidPower 
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BorderColor Appearance Specifies the border color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

 
FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 
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SignsAndSymbols on page 276 

The Icons category under SignsAndSymbols in the Toolbox contains 
icons used throughout the manufacturing system.   

Use an icon to create a button or sign. You can also configure an icon to 
perform an event. Graphic elements configured with an event perform the 
configured task on the HMI device. 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

Icons 
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See also 
Add a graphic element to a screen on page 136 

Trigger an action on a Button Behavior event on page 444 

What is binding? on page 502 

SignsAndSymbols on page 276 

The Indicators category under SignsAndSymbols in the Toolbox 
contains icons used throughout the manufacturing system.    

Use an icon to create a button, sign, or an overlay for another graphic 
element. Configure an indicator to perform an event. Graphic elements 
configured with an event perform the configured task on the HMI device.  

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
What types of HMI screens do I need? on page 47 

Toolbox on page 131  

Add a controller reference on page 85 

Indicators 
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The ISOHazardAlertSigns category under SignsAndSymbols in the 
Toolbox contains various ISO® signs such as Electrical Shock sign, 
High Voltage Sign, Toxic sign, and so forth. These signs are commonly 
used in a manufacturing system.    

Use an ISO sign on the screen indicate a potential hazard in the 
manufacturing process.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

SignColor Appearance Specifies the fill color of the sign. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 

ISOHazardAlertSigns 
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X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 
left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

SignsAndSymbols on page 276 

The ISOHazardAlertSymbols category under SignsAndSymbols in 
the Toolbox contains various ISO symbols such as Electrical Shock 
sign, High Voltage Sign, Toxic sign, and so forth. These symbols are 
commonly used to create ISO Hazard Alert signs.       

Use an ISO symbol on the screen or to create a sign.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

ISOHazardAlertSymbols 



Chapter 9  Add a graphic element to a project 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 285 
 

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

SignsAndSymbols on page 276 

The ISOMandatorySigns category under SignsAndSymbols in the 
Toolbox contains various ISO signs such as Hard Hat Required to be 
posted in a manufacturing system.     

Use an ISO mandatory sign on the screen to indicate a potential hazard 
in the manufacturing process.   

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

SignColor Appearance Specifies the fill color of the sign. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

ISOMandatorySigns 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

SignsAndSymbols on page 276 

The ISOMandatorySymbols category under SignsAndSymbols in the 
Toolbox contains various ISO symbols such as Hard Hat Required. 
These symbols are commonly used to create mandatory ISO signs.       

Use an ISO mandatory symbol on the screen or to create a sign.    

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

ISOMandatorySymbols 
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FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

SignsAndSymbols on page 276 

The ISOSignTemplates category under SignsAndSymbols in the 
Toolbox contains sign shapes and colors commonly used to create ISO 
signs.     

Use a sign template to change a sign or create a new sign. To create a 
custom sign, add text or an icon to the template.   

ISOSignTemplates 
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Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

SignColor Appearance Specifies the fill color of the sign. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

SignsAndSymbols on page 276 

The ISASymbols category under SignsAndSymbols in the Toolbox 
contains symbols that depict equipment such as valves, agitators, 
blowers, and furnaces used in a manufacturing system.  

Use ISA symbols to have line drawings depict manufacturing equipment.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

BorderColor Appearance Specifies the border color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

 
FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

ISASymbols 
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Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

SignsAndSymbols on page 276 

The SignTemplates category under SignsAndSymbols in the Toolbox 
contains signs with default content.     

Use a sign template on the screen to create a sign. Add a graphic 
element or symbols to the sign. Change the header, text, sign color and 
other unique properties to customize the sign template.   

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share.  

Not all graphic elements in this category share the same properties. The 
unique properties of a graphic element in this category depend on the 
graphic element selected.  

Name Category Purpose Accepted values 

BorderColor Appearance Specifies the border color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

 
FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

SignTemplates 
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FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontSize Appearance Specifies the size of the text. Positive numbers 
FooterFontColor Appearance Specifies the color of the text in the footer. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FooterFontSize Appearance Specifies the size of the text in the footer. Positive numbers 

FooterText Appearance Specifies the text in the footer. Alpha-numeric characters 

HeaderColor Appearance Specifies the fill color of the header. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

HeaderFontColor Appearance Specify the color of the text in the header. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

HeaderFontSize Appearance Specifies the size of the text in the header. Positive numbers 

HeaderText Appearance Specifies the text in the header. Alpha-numeric characters 

SignColor Appearance Specifies the fill color of the sign. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

StripesColor Appearance Specifies the color of the striped border. Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Text General Specifies the text on the graphic element.  
Do not place text against the border of a graphic element. 
Allow for a small difference in space, such as one or two 
characters. If you place text against the border of a graphic 
element, the text may wrap differently or appear clipped on 
the HMI device. 

Alpha-numeric characters 
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Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

• SignsAndSymbols on page 276 
The System category in the Toolbox contains graphic elements used in 
the system by default. Some of the graphic elements in this category are 
elements without built-in animation properties. Other graphic elements in 
this category are pre-configured to perform a task. The graphic elements 
in System are organized into categories:  

• Activity Indicator 
• Alarm Status Indicator 
• Checkbox 
• Controller Status Indicator 
• Error 
• List Box Indicator 
• List Box Selector 
• Navigation Menu 
• Network Status Indicator 

System 
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• PDF Viewer 
• Radio Button 
• Success 

See also 
What types of HMI screens do I need? on page 47 

Toolbox on page 131  

Add a graphic element to a screen on page 136 

Find a graphic element in the Toolbox on page 135 

The Activity Indicator is predefined to show the completeness of an 
activity. This graphic element appears in the System category of the 
Toolbox.  

Use the Activity Indicator to show that a task is being performed in the 
manufacturing system. For example, place the Activity Indicator next to a 
tank that is filling on the screen. Bind the Visible box in the Properties 
window of the Activity Indicator graphic element to a tag in a controller. 
The Activity Indicator shows when the tag value is true and does not 
show when the tag value is false. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

Activity Indicator 
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See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Find a graphic element in the Toolbox on page 135 

System on page 292 

The Alarm Status Indicator button  is pre-defined to open the Alarm 
Summary screen. This graphic element appears in the System category 
of the Toolbox.  

Use the Alarm Status Indicator to: 

• Open the Alarm Summary screen on the HMI device. By default, 
this button opens the AlarmSummary screen.  

• Change the screen the Alarm Status Indicator opens. With the 
Alarm Status Indicator selected, change the screen name in the 
NavigateTo box of the Properties window. 

 
Tips:  
• An Alarm Status Indicator button appears in the System Banner at the top of each screen. The 

button is red and flashing when there are active alarms that are unacknowledged.  
• The button remains red as long as there are active alarms (acknowledged or unacknowledged).  
• The button returns to default state with gray icon when all alarms are normal, even if alarms are 

unacknowledged. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

NavigateTo General Specifies the screen to open on a touch release event.  Screen name in project 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Alarm Status Indicator 
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Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
System on page 292 

Alarm faults and alarm quality on page 565 

Resolve alarm faults on page 567 

Alarms overview on page 563 

Find a graphic element in the Toolbox on page 135 

The Checkbox is a graphic element pre-defined to show a check mark. 
This graphic element appears selected or cleared based on the value of 
a boolean tag. It can be used as a control that toggles the value of a 
boolean tag between 1 and 0. The Checkbox graphic element appears in 
the System category of the Toolbox.  

Use the Checkbox graphic element to: 

• Display the state of a boolean tag.  
• Toggle the state of a boolean tag. 

 
Tip: To use the Checkbox to toggle the state of a tag, on the Events tab, create a Button 
Behavior event. Set the button behavior to Toggle a tag on release and bind it to the same tag 
value in the ShowMark box of the Properties window. When you tap the checkbox on the HMI 
device, the button behavior event triggers, toggling the tag value in the ShowMark box to 
either select or clear the check box. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

ShowMark General Specifies the selected or cleared state of the check box.  • Show mark - selected 
• Do not show mark - cleared 

Checkbox 
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Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

MarkColor Appearance Specifies the color of the checkmark.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

UsePredefinedDisabled Appearance Specifies if a crosshatch overlay shows on the control 
element when you disable the element. 

• Use predefined disabled 
appearance (selected) 

• Do not use predefined disabled 
appearance (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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See also 
System on page 292 

Trigger an action on a Button Behavior event on page 444 

What is an event? on page 476 

Change the properties of a graphic element on page 139 

Find a graphic element in the Toolbox on page 135 

The Controller Status Indicator is a graphic element pre-defined to show 
controller communication issues and open the screen for configuring 
controllers. This graphic element appears in the System category of the 
Toolbox.  

Use the Controller Status Indicator to: 

• See a visual indicator when there is an issue with the 
communication of any controller in the project.   

• Open the Controllers popup. This popup shows details about the 
communication status of all referenced controllers in the project. 

• Change the screen the Controller Status Indicator opens. When 
selecting the Controller Status Indicator, change the screen name 
in the NavigateTo box of the Properties window.  

 
Tips: 
•  By default, the Controller Status Indicator appears in the System Banner at the top of the screen. 

The same controller details appear when selecting Controller from the Settings screen.   
• The Controller Status Indicator changes appearances based on the issue:  

•  Controller error. Any controller in the project has no power or connection.  

•  Controller caution. Any controller in the project has a fault or is in Program mode. 

•  Controller unknown. No controller is visible or it is unclear if a controller should be visible 
to the HMI device. This occurs when any controller referenced in the project is disconnected, 
powered down, or is on a disconnected side of the network. 

Built-in Animation Properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

NavigateTo General Specifies the screen to open on a touch release event.  Screen name in project 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Controller Status Indicator 
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Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
System on page 292 

What is the System Banner? on page 97 

System Banner contents on page 127 

Find a graphic element in the Toolbox on page 135 

Change the properties of a graphic element on page 139 

The Error graphic element is an icon used to indicate that an error has 
occurred. This graphic element appears in the System category of the 
Toolbox.  

Add an Error graphic element to indicate that a task did not complete 
successfully in the manufacturing system. For example, use the Error 
graphic element to indicate if a product passed inspection at a test stand. 
Bind the Visible box in the Properties window for the Error graphic 
element to a tag in a controller. The Error graphic element shows when 
the tag value is True, indicating the product did not pass. The Error 
graphic element does not show when the tag value is False, indicating 
the product passed. For a successful test, you can bind a tag to the 
Success graphic element. 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Error 
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Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

System on page 292 

Events tab on page 447 

What is an event? on page 476 

The List Box Indicator graphic element is a read-only list box with built-in 
animation properties to highlight an item in the list. This graphic element 
appears in the System category of the Toolbox.  

Use the List Box Indicator graphic element to create a list of items 
highlighted by the system. The List Box Indicator highlights the item in the 
list that matches the value of the tag in a controller. For example, the list 
could highlight the bottling line that is filled. The item must exist in the list 
in order for the List Box Indicator to highlight the item. Items in the list 
must have unique names. If an item does not have a unique name, the 
system highlights any one of the items that has a duplicate name.  

Have the List Box Indicator highlight different text based on different 
values in the controller. There are two common tag types in a Logix 
controller to bind to the Value property of the List Box Indicator: 

• String tag. Separate the strings in the Items box using commas. 
For example, in the Items box enter: No Part,Part Entering,Part In 
Place,Machining Part,Part Exiting. Do not enter spaces between 
the commas and the items. Bind the Value box in the Properties 

List Box Indicator 
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window to the tag containing the items. When the string tag bound 
to the Value box has the Part Entering value, the List Box Indicator 
highlights the Part Entering row.  

• Numeric tag. Separate the strings in the Item box and the 
numeric value you want to associate with each string in 
parentheses. Separate those items using commas. Do not enter 
spaces between the commas and the items. For example, in the 
Items box, enter: No Part (1),Part Entering (2),Part in Place 
(3),Machining Part (4),Part Exiting (5). Bind the Value box in the 
Properties window to the numeric tag. For example, bind to the 
DINT tag containing the items. When the DINT tag bound to the 
Value box has a value of 4, the List Box Indicator highlights the 
Machining Part row.  
Tip: The List Box Indicator does not support Boolean expressions. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device. 

Name Category Purpose Accepted values 

DisplaySpecialCharacters General Select to display parentheses in Items when the text in the 
Item is enclosed in quotation marks.  For example, “Low 
Speed (10 RPM)” 
Note: You can still read numbers from the Value property by 
using numbers in parentheses after the Item in quotation 
marks.  For example, if you use the following for the Items 
property: "Low Speed (10 RPM)"(10),"Medium Speed (30 
RPM)"(30),"High Speed (50 RPM)"(50), the List Box Indicator will 
indicate Low Speed (10 RPM) when the Value property is 10. 

• Parenthesis displayed on Items 
when the Item is enclosed in 
quotation marks – selected 

• Parentheses in Items always 
interpreted as containing a 
number matching a value in the 
Value property - cleared 

Items General Specifies the items for the list, separated by commas.  One or more alphanumeric strings 
separated by commas 

Value General Specifies the value of the graphic element. Bound tag 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text. Any selected font 
FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontSize Appearance Specifies the size of the text. Positive numbers 
Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 

• Not bold - cleared 
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FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

ItemPadding Appearance Specifies the amount of space before list items. Numeric values 
SelectionColor Appearance Specifies the color of the selected list item.  Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

UsePredefinedDisabled Appearance Specifies if a crosshatch overlay shows on the control 
element when you disable the element. 

• Use predefined disabled 
appearance (selected) 

• Do not use predefined disabled 
appearance (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 
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See also 
System on page 292 

List Box Selector on page 302 

What is the Settings screen? on page 97  

The List Box Selector is a read-write graphic element with built-in 
animation properties to write a list item to the controller. This graphic 
element appears in the System category of the Toolbox. 

Use the List Box Selector graphic element to create a list of items to 
select on the HMI device. The List Box Selector writes the different value 
to the tag as items are selected on the HMI device. Items in the list must 
have unique names. If an item does not have a unique name, select an 
item that has a duplicate name.  

Have the List Box Selector write different values to the tag in the 
controller. These are the common tag types in the Logix controller for 
binding the Value property of the List Box Selector: 

• String tag. Separate the strings in the Items box using commas. 
For example, in the Items box enter: No Part,Part Entering,Part In 
Place,Machining Part,Part Exiting. Do not enter spaces between 
the commas and the items. Bind the Value box in the Properties 
window to the tag containing the items. When selecting the Part 
Entering row in the List Box Selector on the HMI device, write the 
value Part Entering to the tag in the controller.   

• Numeric tag. Separate the strings in the Item box and the 
numeric value to associate with each string in parentheses. 
Separate those items using commas. Do not enter spaces 
between the commas and the items. For example, in the Items 
box, enter: No Part (1),Part Entering (2),Part in Place 
(3),Machining Part (4),Part Exiting (5). Bind the Value box in the 
Properties window to the numeric tag. For example, bind to the 
DINT tag containing the items. When selecting the Machining Part 
row in the List Box Selector on the HMI device, write the the value 
4 to the tag in the controller. 
Tip: The List Box Selector does not support Boolean expressions. 

 

IMPORTANT Do not rotate the List Box Selector graphic element. Rotating the List Box Selector 
graphic element prevents touch input selection of the items on the HMI device. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

List Box Selector 
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DisplaySpecialCharacters General Select to display parentheses in Items when the text in the 
Item is enclosed in quotation marks.  For example, “Low 
Speed (10 RPM)” 
Note: You can still send numbers to the Value property by 
using numbers in parentheses after the Item in quotation 
marks.  For example, if you use the following for the Items 
property: "Low Speed (10 RPM)"(10),"Medium Speed (30 
RPM)"(30),"High Speed (50 RPM)"(50), the List Box Selector will 
write a value of 10, 30, or 50 to the Value property when the 
corresponding Item is selected at runtime. 

• Parenthesis displayed on Items 
when the Item is enclosed in 
quotation marks – selected 

• Parenthesis in Items always 
interpreted as containing a 
number to write to the Value 
property - cleared 

Items General Specifies the items for the list, separated by commas.  One or more alphanumeric strings 
separated by commas 

Value General Specifies the value of the graphic element. Bound tag 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

FontName Appearance Specifies the font of the text. Any selected font 
FontColor Appearance Specifies the color of the text. Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FontSize Appearance Specifies the size of the text. Positive numbers 
Bold Appearance Makes the text or value on the graphic element bold. • Bold - selected 

• Not bold - cleared 
CaretColor Appearance Specifies the color of the selection caret.  Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

ItemPadding Appearance Specifies the amount of space before list items. Numeric values 
ScrollBarFillColor Appearance Specifies the color of the scroll bar.  Any selected color in the Color Picker 

or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 
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SelectionColor Appearance Specifies the color of the selected list item.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

UsePredefinedDisabled Appearance Specifies if a crosshatch overlay shows on the control 
element when you disable the element. 

• Use predefined disabled 
appearance (selected) 

• Do not use predefined disabled 
appearance (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
CommonControls on page 180 

List Box Indicator on page 299 

hat is the Settings screen? on page 97 

The Navigation Menu is a button pre-defined to open the Navigation 
menu on the HMI device. This graphic element appears in the System 
category of the Toolbox. 

Navigation Menu 
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Use the Navigation Menu graphic element to: 

• Open the Navigation menu at the bottom of the HMI device 
screen.  

• Display only those items to which the logged on user or Guest user 
has security access.  

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share.  

Name Category Purpose Accepted values 

CornerRadius Appearance Specified the curve of the corners 0 for a positive number 
Color Appearance/Border Specifies the color of the border Any selected color in the Color Picker 

or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

Style Appearance/Border Specifies the style of the border line.  • Any selected Line style -- None, 
Solid, Dash, Dot, Dash Dot, or Dash 
Dot Dot 

• Any selected Cap style -- Flat, 
Round, or Square 

• Any selected Join style -- Miter, 
Bevel, or Round 

Width Appearance/Border Specifies the width of the border line. • None 
• 1 pixel 
• 2 pixels 
• 4 pixels 
• 8 pixels 

FillColor Appearance Specifies the fill color. Any selected color in the Color Picker 
or a Hex color value entered manually. 
The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits 
from 0 through F and represent the 
color channel values for red, green, 
and blue. For example, #ffff00 
produces yellow. 

UsePredefinedDisabled Appearance Specifies if a crosshatch overlay shows on the control element 
when you disable the element. 

• Use predefined disabled 
appearance (selected) 

• Do not use predefined disabled 
appearance (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 
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Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Project navigation on page 551 

Navigation menu on page 732 

System on page 292 

The Network Status Indicator is predefined to show network 
communication issues and open the screen for configuring the network. 
This graphic element appears in the System category of the Toolbox. 

Use the Network Status Indicator to: 

• See a visual indicator when there is an issue with the 
communication of the network.   

• Open the Network popup from the Settings screen. 
• Change the screen the Network Status Indicator opens. To do 

this, change the screen name in the NavigationTo box of the 
Properties window for the graphic element. 

 
Tips:  
• By default, the Network Status Indicator appears in the System Banner at the top of the screen.  
• The Network Status Indicator changes appearance based on the issue:  

•  Network caution. The network is functioning. However, one or more, but not all, of the 
controllers associated with the project are not communicating properly. For example, a device 
may be powered-down. In a 2-port unit, one Ethernet port may be disconnected.  

•  Network error. The network is not functioning. No Ethernet port is connected, none of the 
controllers associated with the project are communicating properly, or there is a duplicate IP 
address. 

Network Status Indicator 
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Built-in Animation Properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

NavigateTo General Specifies the screen to open on a touch release event.  Screen name in project 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
What is the System Banner? on page 97 

System Banner contents on page 127 

Controller Status Indicator on page 297 

System on page 292 
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The Project Events Status Indicator is predefined to open an error list 
displaying project event errors. This graphic element appears in the 
System category of the Toolbox.  

Use the Project Events Status Indicator to: 

• See a visual indicator when there is an issue with project events. 
• Display an error list showing project event errors.  

Common Properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Search for and select a data type on page 373 

• Search for and select a tag 
The Radio Button is a graphic element with built-in animation properties 
to select and clear radio button. This graphic element appears in the 
System category of the Toolbox. 

Project Events Status 
Indicator 

Radio Button 
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Use a Radio Button to select options on the HMI device. Group multiple 
radio buttons to present a list of mutually exclusive options from which to 
select. Implementing this functionality requires additional functionality. 

EXAMPLE Create two radio buttons to switch a process between running a machine automatically or 
manually (for example, to jog a conveyor manually during maintenance). For this example, 
assume there is a tag in the controller named Mode. This tag specifies manual versus 
automatic mode. The value 1 specifies Automatic mode and the value 0 specifies Manual 
mode. Pressing a radio button selects it and clears the other radio button. Pressing a 
selected radio button keeps the radio button selected.  
1. Add two Radio Button graphic elements to the screen. 
2. Next to each radio button, add a Text Display graphic element with text describing the 

option you are selecting. For example, type Manual after one radio button and type 
Automatic after the other radio button. 

3. For each radio button, add a Touch Release event with a Value Write command.  
4. Select the Automatic radio button and for the Value Write command, in the Write To box, 

browse to select the Mode tag in the controller. In the box below the Write To box, type 1. 
Pressing the Automatic button on the HMI device writes a 1 to the Mode tag and runs the 
machine automatically. 

5. Select the Manual radio button and for the Value Write command, in the Write To box, 
browse to select the Mode tag in the controller. In the box below the Write To box, type 0. 
Pressing the Manual button on the HMI device writes a 0 to the Mode tag and runs the 
machine manually. 

6. For each radio button, on the Properties tab, in the ShowMark box, browse to select the 
Mode tag. In the Expression box below the ShowMark box, enter the expression for each 
graphic element. For example, select the Automatic radio button and in the Expression 
Editor, type Mode == 1. Select the Manual radio button and in the Expression Editor, type 
Mode == 0. When the result of the expression is 1, this selectes the Automatic radio 
button. When the result of the expression is 0, this selected the Manual radio button. 
Selecting the Manual radio button when the machine is in Automatic mode writes a 0 to 
the controller and places the machine in manual mode. 

Built-in animation properties 
Built-in animation properties appear under the General category of the 
Properties window. Specify values for these properties in order to 
animate the graphic element or change the information the graphic 
element shows on the HMI device.  

Name Category Purpose Accepted values 

ShowMark General Specifies the selected or cleared state of the check box.  • Show mark - selected 
• Do not show mark - cleared 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 
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FillColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

MarkColor Appearance Specifies the color of the checkmark.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

UsePredefinedDisabled Appearance Specifies if a crosshatch overlay shows on the control 
element when you disable the element. 

• Use predefined disabled 
appearance (selected) 

• Do not use predefined disabled 
appearance (cleared) 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
System on page 292 
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Checkbox on page 295 

The Success graphic element indicates that an activity is complete. This 
graphic element appears in the System category of the Toolbox.  

Add a Success graphic element to indicate that a task completed 
successfully in the manufacturing system. For example, use the Success 
graphic element to indicate if a product passed inspection at a test stand. 
Bind the Visible box in the Properties window for the Success graphic 
element to a tag in a controller. The Success graphic element shows 
when the tag value is True, indicating the product passed. The Success 
graphic element does not show when the tag value is False, indicating 
the product did not pass. For a failed test, bind a tag to the Error graphic 
element.   

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 
Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

Toolbox on page 131 

Events tab on page 447 

What is an event? on page 476 

Success 
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The Trend Charts category in the Toolbox contains a trend chart with a 
vertical Y Axis that represents data and a horizontal X Axis that 
represents time. This category also contains a Trend Legend graphic 
element that provides the means to identify the traces on the trend chart.     

Use the trend chart to plot data for up to eight tags from the controllers 
referenced in the project. To depict data on the trend chart, bind the Tag 
box on the Traces tab to the tag in a controller. Values from the tag are 
plotted on the trace. Add up to eight traces to a trend chart. Customize 
the line of a trace by changing the properties in the Appearance category 
on the Traces tab. Use the Trend Legend graphic element to identify the 
traces on the trend chart. 

Unique properties 
Unique properties are properties that not all graphic elements in the 
Toolbox share. 

Name Category Purpose Accepted values 

BackgroundColor Appearance Specifies the fill color.  Any selected color in the Color Picker 
or a Hex color value entered 
manually. The Hex value must be in 
the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and 
represent the color channel values 
for red, green, and blue. For 
example, #ffff00 produces yellow. 

Timespan General Specifies the span of time, in seconds, of data to display on 
the time axis of the trend chart.  

Positive numbers between 10 and 
3600 

Common properties 
Common properties exist for all graphic elements. 

Property Category Purpose Accepted Values 

Access Security Specifies if all users have access to the control element, or if 
access is inherited from the screen. 

• Inherit - Access inherited from 
screen. 

• Full Access - Access granted to all 
users. 

Angle Position and Size Specifies the rotation angle.  
Enter 180 to display the graphic element upside down. If you 
enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to 
see a value of 20. If you enter a value less than 0, the 
negative value is subtracted from 360. For example, enter -30 
to see a value of 330.  

• Numbers 0 to 360  

Enabled Appearance  Specifies if the graphic element is available on the HMI device 
and if the graphic element accepts touch and key input. 

• Enabled - selected 
• Not Enabled - cleared 

Height Position and Size Specifies the height in pixels.  Any positive numeric value 
Opacity Appearance Specifies the transparency of the graphic element. 0 (fully transparent) - 100 (fully 

opaque) 
Visible Appearance Specifies if the graphic element is visible on the HMI device. • Visible - selected 

• Not visible - cleared 

Trend Charts 
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Width Position and Size Specifies the width in pixels. Any positive number 
X Position and Size Specifies the horizontal coordinate, in pixels, from the upper 

left corner of screen to the upper left corner of a graphic 
element or group with no rotation. If the graphic element or 
group is rotated, the X property value does not change. 

Any positive number 

Y Position and Size Specifies the vertical coordinate, in pixels, from the upper left 
corner of screen to the upper left corner of a graphic element 
or group with no rotation. If the graphic element or group is 
rotated, the Y property value does not change. 

Any positive number 

See also 
Add a graphic element to a screen on page 136 

What is an event? on page 476 

Search for and select a data type on page 373 

Search for and select a tag 

Combine graphic elements into a group to work with them as if they were 
a single graphic element.  

Work with the graphic elements as a group or manipulate the individual 
graphic elements within the group. Groups can be created within groups 
to form sub-groups.  

When you ungroup elements within a group, animations, events, and the 
binding properties of the group are lost. Bindings and expressions that 
reference graphic elements and Add-On Graphics that are a part of the 
group still work. 

You can work with groups or individual elements within a group by 
selecting an item on the screen (canvas) or in the Graphic Explorer. 
Some operations are available directly on the screen or in the Graphic 
Explorer while others require highlighting an item and editing its 
properties in the Properties window. 

See also 
Add a graphic element to a screen on page 136 

Group graphic elements on page 151 

Graphic Explorer on page 132 

Toolbox on page 131 

Combine graphic elements and Add-On Graphics into a group to work 
with them as a single element. Work with the elements as a group or 
manipulate the individual elements within the group. Groups can contain 
groups.  

To group graphic elements: 
1. On the screen or in the Graphic Explorer, select the graphic 

elements and Add-On Graphics to include in the group.  

Work with groups 

Group graphic elements 
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2. Right-click one of the selected elements and select Group. 
View Designer names each group. Rename groups using the Name box 
in the Properties tab. The Properties tab displays the properties to 
change for the group. View and work with the contents of a group in the 
Graphic Explorer. 

 
Tip: Alternate methods of grouping: 
• On the Drawing toolbar, select Group. 
• On the Standard menu, select Arrange > Group. 
• Press Ctrl+G. 

See also 
Graphic Explorer on page 132 

Work with individual graphic elements in a group on page 315 

Work with groups on page 313 

Add graphic elements or groups to a group. 

To add a graphic element or group to a group on the screen: 
1. Add an element or group to the screen. 
2. Copy or cut the element. 
3. Double-click any element in a target group to put the group in the 

editing mode. 
4. Paste the new element or group. 

 
IMPORTANT Clicking anywhere on the canvas when the group is in the editing mode 

unselects the group. 

To add a graphic element or group to a group in Graphic Explorer: 
1. Add an element or group to the screen. It automatically appears in 

the Graphic Explorer. 
2. Select an element or elements you want to add to a group. 
3. Drag and drop the element or elements in the desired group. 

See also 
Work with groups on page 313 

Graphic Explorer on page 132 

You can remove graphic elements and groups from a group. 

To remove a graphic element or a group from a group: 
1. Double-click a graphic elements or a group you want to remove. 

Add a graphic element or a 
group to a group 

Remove a graphic element 
or a group from a group 
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2. Right-click the selected graphic elements or a group and select 
Delete. 

 
Tip: Removing the last element from the group, removes the group. Clicking Undo restores 
the element and all groups (parent and nested) if they were deleted. 

 

See also 
Work with groups on page 313 

Graphic Explorer on page 132 

You can change the appearance, position, and size of individual graphic 
elements or groups in a group. You can bind to the individual properties 
and attach events or animations. 

To work with individual graphic elements or groups in a group: 
1. In the Graphic Explorer, expand the group and select the graphic 

element. 
• To select multiple graphic elements, press and hold Ctrl while 

you click each graphic element. 
2. Use the tabs on the Properties window to change the properties 

and create animations and events for the selected graphic 
element. 

 
Tip:You can also edit the size and angle of individual elements or groups on the screen: 
1. Double-click any element in a group to put the group in the editing mode. 
2. Select the element you want to edit. 
3. Use the arrows to change the size, angle, and position of the element or group. 

 
Tip:You can change the position of elements or groups by selecting, dragging and dropping 
them in the Graphic Explorer. 

 
Tip: Multiselect is only possible for the elements on the same level of nesting. 

 

Lock groups to keep them from moving while you are developing a 
screen. 

Locking applies to groups which are directly on the canvas, you cannot 
lock nested groups. When a group or element is locked, you cannot 
perform any operations on canvas. You can still adjust some settings in 
the Properties window when an element is selected in the Graphic 
Explorer. 

Locking a group does not affect the application during runtime. 

Work with individual 
graphic elements or groups 
in a group 

Lock or unlock groups 



Chapter 9  Add a graphic element to a project 
 

316 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

 Tip:You can select and group a locked group with other 
elements or groups in the Graphic Explorer.. The group 
remains locked and the property of any grouped element is 
unselected. 

Locking elements or groups within a parent group is not 
allowed. You can edit individual elements or groups properties 
in the Properties window. 
1. In Graphic Explorer, select a locked group , press CTRL and select group or elements you want to 

group together. 
2. Right-click selected elements or groups and select Group. 

 

To lock a group: 
• In the Graphic Explorer, point to the group you want to lock and 

click the unlock icon . The unlock icon changes to the lock icon 
 to indicate the group is locked. 

  

 
Tip: Alternate methods of locking a group: 
• In the Graphic Explorer, right-click the group and click Lock. 
• Select the group and then from the Menu bar, click Edit > Lock. 

To unlock a group: 
• In the Graphic Explorer, point to the group you want to unlock 

and click the lock icon . The lock icon changes to the unlock 
icon  to indicate the group is unlocked. 

 
Tip: Alternate methods of unlocking a group: 
• In the Graphic Explorer, right-click the group and click Unlock. 
• In the Graphic Explorer, click the group and then from the Menu bar, click Edit > Unlock. 

See also 
Work with groups on page 313 

Graphic Explorer on page 132 

You can resize any group. The Height and Width values of a resized 
group display in the Properties tab. 

IMPORTANT Resizing a group while not maintaining the aspect ratio can cause the graphic elements 
to skew. Skewing can cause the graphic elements to become disconnected when 
ungrouped. 

To resize a group: 
1. On the screen or in the Graphic Explorer, select the group. 
2. On the screen, position the cursor on a sizing handle  until it 

turns into a double-arrow. 

Resize a group 
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• To change the width or the height of the group, drag a side 
sizing handle. 

• To change the width and the height of the group, drag a corner 
sizing handle. 

• To maintain the aspect ratio, press and hold Shift as you drag a 
sizing handle. 

• To maintain the center point of a group, press and hold Alt as 
you drag a sizing handle. 

• To maintain the aspect ratio and center point of a group, press 
and hold Shift+Alt as you drag a corner sizing handle. 

 
Tips:  
• A tooltip shows the height and width of the group as you resize it. 
• When you resize a group, the ScaleHorizontal and ScaleVertical properties show the percentage by 

which a selected graphic element within the group was resized horizontally and vertically. The 
horizontal or vertical scale value for a graphic element within a group that has not been resized is 
100.  

• If you resize a graphic element in a group, the Height and Width properties display the new size of 
the element, but the proportion is maintained. That is, the ScaleHorizontal and ScaleVertical values 
for the graphic elements in the group do not change. 

• The font size configured for an element with a text value determines the height of the element. For 
example, if you resize or rotate a Text Input element, the font size does not change.  

See also 
Work with groups on page 313 

Graphic Explorer on page 132 

Flip a group or an element in a group to create a reverse image of it. 
Graphic elements in a group that contain text do not flip.  

The Angle property displays the new rotation angle. The new angle is 
calculated using the following equation: NewAngle = 360 - OldAngle. For 
example, a group with an Angle value of 45 (45 degrees) before being 
flipped displays an Angle value of 315 (315 degrees) after being flipped. 

To flip a group: 
1. On the screen or in the Graphic Explorer, right-click the group or 

a graphic element and click Flip. 
2. Select one of the options: 

• Horizontal. Flips the group along its horizontal axis.  
• Vertical. Flips the group along its vertical axis.  

 
Tip: Alternate methods to flip a group: 
• On the Drawing toolbar, click the Flip down arrow, and select an option. 
• On the Menu bar, click Arrange > Flip, and select an option.  

See also 
Work with groups on page 313 

Graphic Explorer on page 132 

Flip a group or an element 
in a group 
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Change the angle of a group by rotating it. 

 

IMPORTANT Rotating elements in a group and then resizing the group without maintaining its 
aspect ratio may cause the rotated elements to deform. 

To rotate a group or an individual element: 
1. Select the group. 
2. Position the cursor on a corner sizing handle until it turns into a 

curved double-arrow. 
3. Drag to rotate the group. A tooltip displays the angle as you rotate 

the group. The rotation angle is based on the center point of the 
group. 

 
Tips:  
• The top left sizing handle is a circle that identifies the original top left corner after rotating a 

graphic element or group. 
• You can rotate multiple groups simultaneously. Press and hold Ctrl while you click on each group to 

select them. Use any corner sizing handle and drag to rotate all of the groups. 
• You can rotate a group by changing the value of the Angle property in the Properties tab. 180 

displays the group upside down. If you enter a value larger than 360, the portion of numeric value 
that is over 360 becomes the value. For example, enter 380 to see a value of 20. If you enter a 
value less than 0, the negative value is subtracted from 360. For example, enter -30 to see a value 
of 330.    

• You can rotate a graphic element within a group. In the Graphic Explorer, select the graphic 
element and rotate it using any corner sizing handle. The rotation angle is based on the center 
point of the graphic element. 

• Alternatively, in the Properties window, you can change the angle of a group or graphic element to 
a desired value. 

See also 
Work with groups on page 313 

Group graphic elements on page 151 

Move a group by using a mouse, a keyboard, or by changing its 
properties.  

• Select a group or an element on the screen or in the Graphic 
Explorer. 
• By mouse: 

• Drag and drop the group or an element in a desired location
  

• By keyboard: 
•  Use the arrow keys to move the object to a desired position.  

Tips: • To move the group 1 pixel, press an arrow key in the preferred direction. 
• To move the group 10 pixels at a time, press Shift + an arrow key. 

• By changing properties: 
• On the Properties tab, expand the Position and Size 

category 
• Enter any positive number in the X and y properties: 

Rotate a group or an 
individual element 

Move a group or an 
individual element 
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• X. Specifies the horizontal coordinate, in pixels, from the 
upper left corner of screen to the upper left corner of a 
graphic element or group with no rotation. If the graphic 
element or group is rotated, the X property value does not 
change. 

• Y. Specifies the vertical coordinate, in pixels, from the 
upper left corner of screen to the upper left corner of a 
graphic element or group with no rotation. If the graphic 
element or group is rotated, the Y property value does not 
change. 
Tips: The green lines that appear when you move a group using the mouse are called Smart Guides. Use 

Smart Guides to help position a group on the screen with precision. Smart Guides do not appear 
when you use the keyboard or the X and Y properties to move a group. 

See also 
Work with groups on page 313 

Graphic Explorer on page 132 

Lock or unlock groups 

Align selected groups vertically and horizontally based on the edges of 
the groups or their center points. When a group is in the editing mode, 
you can align elements in that group. 

To align groups: 
1. Press and hold Ctrl to select groups or elements in a group. 

 
Tip:Press Ctrl+A to select all of the graphic elements and groups on the screen.It allows you 
to align groups, not elements in a group. 

2. Right-click the selection, click Align, and select an option: 
• Left Edges. Align the left edges of the groups. 
• Right Edges. Align the right edges of the groups. 
• Horizontal Centers. Align the center points of the groups 

vertically. 

 
• Top Edges. Align the top edges of the groups.   

Align groups or elements in 
a group 
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• Bottom Edges. Align the bottom edges of the groups. 
• Vertical Centers. Align the center points of the groups 

horizontally.   

 

 
Tip: Green lines called Smart Guides appear to help move a graphic element with 
precision.  

See also 
Group graphic elements on page 151 

Move a group on page 318 

Lock or unlock groups on page 315 

Change the stacking order of graphic elements and groups on 
page 148 

Stack graphic elements and groups so that one graphic element or group 
appears in front of another. Change the stacking order by moving an item 
forward, backward, or in front of all of the other items on the screen or 
Add-On Graphic. The order is reflected in the Graphic Explorer. 
Change the stacking order of groups. Changing the graphic elements 
contained in a group is not supported.  

To change the stacking order of graphic elements and groups: 
1. On the screen or Add-On Graphic, right-click the graphic element 

or group and select Order.  

 
Tips: 
• When a group is in the editing mode, you can select elements inside the group. 
• Select a graphic element or group in the Graphic Explorer. 

2. Select one of the following options:  
• Bring to Front. Move the selected graphic element or group to 

the top of the stack. 
• Bring Forward. Move the selected graphic element or group 

one level forward. 
• Send Backward. Move the selected graphic element or group 

one level backward. 

Change the stacking order 
of graphic elements and 
groups 
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• Send to Back. Move the selected graphic element or group to 
the bottom of the stack. 

 
Tip:  
Alternate methods of changing the stacking order: 
• On the Drawing toolbar, select the Order down arrow, and select an option. 
• Select ARRANGE > Order, and then select an option.  

See also 
Graphic Explorer on page 132 

Align graphic elements on page 145 

Distribute graphic elements on page 149 

Group graphic elements on page 151 

Cut, copy, and paste a group on a single screen, across multiple 
screens, and between projects.  

Important: Copying and pasting a group of graphic elements that reference properties of those graphic elements will break      
copied groups. This is because copying and pasting a graphic element increments the name of the element, inclu      
group. However, the reference remains unchanged. If you update bindings and expressions that reference the na      
changes to graphic element names are not propagated automatically. 

 

 
Tip: You can paste graphic elements stored in the clipboard to an edited group directly on the screen 
or in the Graphic Explorer by selecting any element in the target group destination. 

To cut, copy, paste or delete a group or an element in a group 
• Right-click an item on the screen or in the Graphic Explorer and 

select the option: 
• Cut. From the context menu, select Cut. 

 
Tip: Alternate methods for cutting:  
• On the keyboard, press Ctrl+X 
• On the Menu bar, click EDIT > Cut. 

On the Standard toolbar, click Cut .  Alternate methods for cutting:  
• On the keyboard, press Ctrl+X 
• On the Menu bar, click EDIT > Cut. 

On the Standard toolbar, click Cut .  Alternate methods for cutting:  
• On the keyboard, press Ctrl+X 
• On the Menu bar, select EDIT > Cut. 

• On the Standard toolbar, select Cut .   
 

• Copy. From the context menu, select Copy. 

Cut, copy, paste, or delete a 
group or an element in a 
group 
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Tip: Alternate methods for copying: 
• On the keyboard, press Ctrl+C. 
• On the Menu bar, select EDIT > Copy. 

• On the Standard toolbar, click Copy .  
 

• Paste. From the context menu, select Paste. 

 
Tip: Alternate methods for pasting: 
• On the keyboard, press Ctrl+V. 
• On the Menu bar, click EDIT > Paste. 

On the Standard toolbar, click Paste . Alternate methods for pasting: 
• On the keyboard, press Ctrl+V. 
• On the Menu bar, click EDIT > Paste. 

On the Standard toolbar, click Paste . Alternate methods for pasting: 
• On the keyboard, press Ctrl+V. 
• On the Menu bar, click EDIT > Paste. 

On the Standard toolbar, click Paste . Alternate methods for pasting: 
• On the keyboard, press Ctrl+V. 
• On the Menu bar, click EDIT > Paste. 

On the Standard toolbar, click Paste . Alternate methods for pasting: 
• On the keyboard, press Ctrl+V. 
• On the Menu bar, click EDIT > Paste. 

On the Standard toolbar, click Paste .  

• Delete. From the context menu, select Delete. 

 
Tip:  
Alternate methods for deleting:  
• On the keyboard, press Ctrl+X 
• On the Menu bar, click EDIT > Delete. 

See also 
Work with groups on page 313 

Graphic Explorer on page 132 

Use the Duplicate command to make a copy of a group. Duplicating a 
group duplicates the property values, animations, and events associated 
with the group.  

IMPORTANT Duplicating a group of graphic elements that reference properties of those graphic 
elements breaks the property references in the duplicated groups. This is because 
duplicating a group increments the name of the elements contained in the group. The 
reference remains unchanged. Due o the incremented names, update the bindings and 
expressions that reference the elements within the new group. Changes to graphic 
element names do not propagate automatically. 

To duplicate a group: 
• Select the group and press Ctrl+D.  

 
Tips:  
• Continue to create copies until de-selecting the group. 
• Duplicated contents are not placed in the clipboard.   

Duplicate a group 
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See also 
Work with groups on page 313 

Graphic Explorer on page 132 

Ungroup graphic elements and Add-On Graphics when you no longer 
need to work with multiple elements as a group. 

 

IMPORTANT  You cannot undo an Ungroup operation. When ungrouping, animations and events 
configured for the group, as well as the bindings to properties of the group, are lost. 
Bindings and expressions that reference graphic elements and Add-On Graphics that 
are part of the group still function. 

To ungroup graphic elements:  
• On the screen, right-click the group and select Ungroup. 

• If you ungroup a rotated group, the Angle value is applied to the 
graphic elements within the group. 

See also 
Work with groups on page 132 

Graphic Explorer on page 132 

Add an Image graphic element to a screen to display an image. 
Referencing the same image in multiple Image graphic elements saves 
memory. Preview an image from the Project Explorer before adding the 
image to a screen. Existing Image graphic elements appear in the 
Images folder of the Project Explorer.  

See also 
Add an image to a project on page 327 

Add a graphic element to a screen on page 136 

Preview an image on page 328 

Toolbox on page 131 

Project Explorer on page 95 

Add an image to the Images folder of the project to be able to add an 
image to a screen. 

To add an image to the Images folder: 
1. In the Project Explorer, expand the Assets folder, right-click the 

Images folder, and select New Images. 
2. Browse to and select one or more image files.  

Ungroup graphic elements 

Work with images 

Add an image to the Images 
folder 
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The image appears alphabetically in the Images folder and 
becomes part of the project. The folder displays images as icons.  

 
Tips:  
• Image files must be in BMP, JPG, PNG or SVG format, and resolution no larger than 7.91 megapixels 

(3840 x 2160 pixels). 
• For best screen and popup performance, use images optimized for size. 
• The HMI application includes an image cache that shortens the loading time of the most frequently 

used images. 
• Supported SVG files include Tiny 1.1 SVG files and Tiny 1.2 SVG files.  
• Adding an image that begins with a numeric character pre-pends "FILE" at the beginning of the 

image name. For example, 1Tank.img appears as FILE1Tank.img in the Images folder. 

3. To see the image file name, file type, and file size, select the 
image in the Images folder and expand the General category in 
the Properties window. 

 
Tips:  

Browsing to a new image in the Select Image dialog box adds 
the image to the Images folder of the Project Explorer.   

View Designer does not support the following within the SVG 
image definition: 

• Scripting 
• Animation 
• Units of %, pica, or cm 
• Linked images 

To ensure the Image graphic element displays the SVG image, 
when creating an SVG file: 

• Use Adobe Illustrator CS6 to create the image and save 
it as an SVG type.  

• In the SVG Options dialog box, complete: 
• SVG Profiles. Select SVG Tiny 1.2 Location. Select 

Embed. 
Fonts Type. If including text in the SVG image, select Convert to outline. Rockwell Automation 
recommends that you do not include text in an SVG image. 

See also 
Add an image to a screen on page 326 

Delete an image from a project on page 329 

Rename an image on page 329 

Replace an image throughout a project on page 330 

Image naming conventions on page 331 

Copy an image between View Designer projects to ensure consistency 
or when access to the original image file does not exist. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 

Copy an image between 
View Designer projects 
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• If the content is to be pasted into another project, for each project, 
start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy an image between projects 
1. Copy the image from the source project images folder to the target 

project Images folder. Alternatively, copy the image from the 
source screen to the target screen.  

2. If the target project contains an image file with the same image file 
name, overwrite the existing image file or cancel the copy 
operation. 
• Select Replace to overwrite the existing image file. 

 
Tips:  
• When copying an image file that already exists in the target project when that image file contains 

a different graphic, View Designer adds an increment number to the name of the image in the 
target project. For example, if you copy an image named Tank1 and that image contains tank.bmp, 
and the target project also has an image file named Tank1 but that image contains watertank.bmp, 
the name of the image in the target project increments to Tank1_001. 

• Copying an image that has a removed graphic element shows a red X for the removed graphic 
element. If the image appears in an Add-On Graphic, the red X appears in both the definition of the 
Add-On Graphic and in instances of the Add-On Graphic.   

• Content pasted between projects of different terminal sizes is converted using the Do not scale 
scaling option. The screen content remains the same size and position as on the original screens.  

• Cut an image by selecting Cut instead of Copy. 
• Copying a screen or popup that contains an Image graphic element from one project to another, 

copies the image file associated with the graphic element and places the image file in the Assets 
folder of the target project. 

See also 
Copy a graphic element on page 138 

Add an image to a screen on page 326 

Replace an image throughout a project on page 330 

Copy an image assets folder on page 432 

How do I open the Select Image dialog box? 

In Toolbox > CommonControls, double-click the Image graphic 
element. 

Use the Select Image dialog box to reference a new or existing image 
that the Image graphic element displays on the screen.   

The Select Image dialog box lists the existing images in the Images 
folder of the Project Explorer and and enables browsing to new images. 
Selected images appear in the Images folder.   

The Images folder is in the Assets folder of the Project Explorer. 

Select Image dialog box 
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See also 
Add an image to a project on page 327 

Add an image to a screen on page 326 

Add an Image graphic element to a screen to display an image. Existing 
Image graphic elements appear in the Images folder of the Project 
Explorer. 

To add an image to a screen 
1. In the Toolbox, expand the Common Controls category.  
2. Double-click or drag the Image graphic element onto the screen. 

The Select Image dialog box opens. 

 
Tips:  
• Pressing Enter when an Image graphic element is selected opens the Select Image dialog box.  
• Preview an image before opening the Select Image dialog box, by double-clicking the image in the 

Assets > Images folder of the Project Explorer or right-click the image and select Open. 

3. On the Select Image dialog box either: 
• Select an existing image and select OK. 
• Select Browse, select a new image or multiple images, select 

Open to add the image to the Select Image dialog box, select 
the image to add to the screen, and then select OK. 

The Image graphic element appears on the screen and is linked to 
the image in the Images folder of the Project Explorer. 

 
Tips:  
• Browsing to and selecting multiple images from the Select Image dialog box highlights the last 

selected image.  
• Browsing to an image in the Select Image dialog box adds the image to the Images folder of the 

Project Explorer.  
• Adding an image to the Images folder of the Project Explorer displays the image in the Select 

Image dialog box.   
• Selecting Cancel on the Select Image dialog box places a 100 pixel by 100 pixel Image graphic 

element on the screen. The Image graphic element displays a red X to indicate there is no 
referenced image. 

• Add an image from the Project Explorer by expanding the Assets > Images folders and dragging the 
image to the screen, or right-clicking an image and then selecting Add to (screen name). 

• If the original image is larger than 100 pixels in width or height, the larger dimension value is set to 
100 pixels. The smaller dimension is set to a value that maintains the aspect ratio of the original 
image. If the original image is 100 pixels or smaller, the Image graphic element uses the actual 
dimensions of the original image.  

• Resize image graphic elements with the sizing handles. Each instance of an image is sized 
independent of any other instance. Multiple images on multiple screens can each have a different 
image size. Resizing an image by binding the height and width properties is not recommended as 
it may result in poor performance. 

 

Add an image to a screen 
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IMPORTANT • Too much content on screens can result in the HMI device running out of memory. 
The Properties tab displays the size of the image. Use the predefined HMI Device 
screen to monitor memory usage. If the HMI device runs out of memory while running 
an application, the HMI device restarts and provides an error message indicating that 
an out-of-memory condition occurred. 

• If the computer running View Designer runs out of memory, View Designer shuts 
down and provides a message indicating that an out-of-memory condition occurred. 
View Designer retains the last saved version of the project. 

• Changing the aspect ratio of the original image and then re-importing it does not 
automatically rescale all Image graphic elements linked to that image. 

See also 
Add an image to a project on page 327 

Preview an image on page 328 

Replace an image throughout a project on page 330 

Replace an image on a screen on page 330 

Copy an image between View Designer projects on page 324 

Add an image to the Images folder of the project to be able to add the 
image to a screen.   

To add an image to a project 
1. In the Project Explorer, expand the Assets folder, right-click the 

Images folder, and click New Images. 
2. Browse to and select one or more image files. 

The image appears alphabetically in the Images folder and 
becomes part of the project. The folder displays images as icons. 

 
Tips:  
• Image files must be in BMP, JPG, PNG or SVG format, and have a resolution that is no larger than 6 

MP. 
• For best screen and popup performance, use images optimized for size. 
• The HMI application includes an image cache that shortens the time to load the most frequently 

used images. 
• Supported SVG files include Tiny 1.1 SVG files and Tiny 1.2 SVG files. 
• Adding an image that begins with a numeric character pre-pends "FILE" at the beginning of the 

image name. For example, 1Tank.img appears as FILE1Tank.img in the Images folder. 

3. To view the image filename, type, and size, click the image in the 
Images folder and expand the General category in the 
Properties window. 

Add an image to a project 
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Tips:  

Browsing to a new image in the Select Image dialog box adds 
the image to the Images folder of the Project Explorer.   

View Designer does not support the following within the SVG 
image definition: 

• Scripting 
• Animation 
• Units of %, pica, or cm 
• Linked images 

To ensure the Image graphic element displays the SVG image, 
when creating an SVG file: 

• Use Adobe Illustrator CS6 to create the image and save 
it as an SVG type.  

• In the SVG Options dialog box, complete: 
• SVG Profiles. Select SVG Tiny 1.2 Location. Select 

Embed. 
Fonts Type. If including text in the SVG image, select Convert to outline. Rockwell Automation 
recommends that you do not include text in an SVG image. 

See also 
Add an image to a screen on page 326 

Delete an image from a project on page 329 

Rename an image on page 329 

Replace an image throughout a project on page 330  

Image naming conventions on page 331 

Open a read-only version of the image to preview the image before 
adding it to a screen. Preview images exist in the Assets > Images 
folder of the project.  

To preview an image 
1. In the Project Explorer, expand the Assets > Images folder.  
2. Double-click the image. A tab opens with a read-only version of 

the image. 

 
Tips:  
• The property values for the file name, type, size, and the memory the image requires on the HMI 

device are read-only. 
• Right-clicking an image in the Assets > Images folder and selecting Open previews an image.  

See also 
Add an image to a screen on page 326 

Add an image to a project on page 327 

Rename an image on page 329 

Preview an image 
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Image naming conventions on page 331 

Select Image dialog box on page 325 

Deleting an image from a project: 

• Removes the image from all screens in the project that use the 
image. 

• Deletes the references to the image wherever it is used in the 
project.  

• Clears the ImageName property in the Properties tab for each 
Image graphic element that references the ImageName.  

The Image graphic element displays a red X on the screen when it has no 
referenced image.  

IMPORTANT Deleting an image deletes the references to the image. Adding the image back to the 
Images folder does not restore the configuration.  

To delete an image from a project 
1. In the Project Explorer, open the Assets > Images folder.  
2. Right-click the image and click Delete. A prompt appears if an 

Image graphic element in the project uses the image.  
3. Click Yes to delete the image file. Click No to and keep the file. 

See also 
Add an image to a project on page 327 

Add an image to a screen on page 326 

Rename an image on page 329 

Replace an image in a project on page 330 

Renaming an image in the Images folder renames every instance of the 
image in the project.  

To rename an image 
1. In the Assets folder in the Project Explorer, locate the image in 

the Images folder. 
2. Click the image once to select the item. 
3. Click the image again and type the new name.  

 
Tips:  
• Right-clicking the name, clicking Rename, and entering a new name also renames the image. 
• The name must contain only numbers, letters, and underscores.  
• The name must not begin with a number, contain spaces, have more than one underscore in a row, 

or end with an underscore.  

 

IMPORTANT Renaming an image in the Images folder does not change the file name of the image. 
Click the image in the Images folder and expand the General category in the Properties 
window to see the file name. 

Delete an image from a 
project 

Rename an image 
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See also 
Add an image to a project on page 327 

Add an image to a screen on page 326 

Delete an image from a project on page 329 

Replacing an image on a screen references the new image in the Image 
graphic element. Link an image to an Image graphic element that has no 
referenced image. An Image graphic element shows a red X when it has 
no referenced image. Change the image referenced by an Image graphic 
element.  

To replace an image on a screen 
1. Select the Image graphic element on the screen.  
2. In the Properties window, select the Properties tab and expand 

the General category. 
3. Select the down arrow in the ImageName box. A list of the images 

in the Images folder appears. 
4. Select an image name. The image scales to fit the Image graphic 

element but does not maintain its aspect ratio. 

See also 
Add an image to a project on page 327 

Add an image to a screen on page 326 

Replace an image throughout a project on page 330 

Replace an image in the Images folder to replace the image wherever it 
is referenced in the project. 

To replace an image in the Images folder: 
1. In the Project Explorer, right-click the Images folder and select 

New Images. 
2. Browse to and select the replacement image. The replacement 

image must have the same file name as the existing image. 
3. Select Yes. The image is replaced and all instances of the 

referenced image are replaced with the latest version. 

See also 
Add an image to the Images folder on page 323 

Add an image to a screen on page 326 

Replace an image on a screen on page 330 

Delete an image from a project on page 329 

Rename an image on page 329 

Replace an image on a 
screen 

Replace an image 
throughout a project 



Chapter 9  Add a graphic element to a project 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 331 
 

Image names have the following considerations:    

• Invalid characters in file names are removed from the file name.  
• Characters after the 40-character limit in a file name are removed.  
• Underscores replace spaces in the file name.  
• Files created with the same name as a system-defined file name 

have file names that increment with an underscore and a number 
from 001 to 999.  
For example, adding an image file named 01_picture.png adds an 
image named picture.png to the the Images folder. Adding an 
image file named 02_picture.png adds an image named 
picture_001.png to the Images folder. 

See also 
Add an image to a project on page 327 

Rename an image on page 329 

Display a PDF document on an HMI device to view documentation, 
operating procedures, and machine setup. Each screen or popup can 
display up to two PDF documents. Add a PDF document to the project in 
the Assets > Documents folder of the Project Explorer. Then display 
the PDF document on a screen or popup using either a: 

• PDF Viewer Add-On Graphic. A PDF Viewer Add-On Graphic is 
pre-configured with buttons that have event commands to display, 
navigate, and zoom the referenced PDF document on the HMI 
device. A PDF Viewer Add-On Graphic requires no further 
customization.  

• PDF graphic element. A PDF graphic element has touch support 
for navigating and panning pages within the referenced PDF 
document. A PDF graphic element has no pre-configured buttons 
to navigate or zoom the PDF document.Customize a PDF graphic 
element to add buttons and event commands to navigate and 
zoom the PDF document on the HMI device.  

Adding a PDF document from the Project Explorer lists PDF Viewer 
Add-On Graphics and PDF graphic elements to display the PDF 
document on the HMI device.  

Change values in the DocumentName, CurrentPage, and Zoom 
properties of the PDF graphic element or PDF Viewer Add-On Graphic to 
specify the PDF document, the initial page that opens, and the initial 
zoom setting on the HMI device. 

 
Tips:  
• To have bookmarks appear in the PDF document on the HMI device, create bookmarks for the PDF 

document prior to adding the document in View Designer. 
• PDF files that contain complex drawings take longer to render. For example, if a PDF document 

contains an image comprised of individual shapes such as lines, circles, and rectangles, that 
image takes longer to render than a drawing that is a single image. 

See also 
Add a PDF document to a project on page 332 

Image naming conventions 

Work with PDF documents 
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Add a PDF Viewer Add-On Graphic to a screen or popup on page 
337 

Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 

Change the PDF document that appears on an HMI device on 
page 346 

Add a PDF document to the Documents folder of the Project Explorer 
to add that PDF document to the project. To view the PDF document on 
an HMI device, add a PDF graphic element or PDF Viewer Add-On 
Graphic to the screen or popup and reference the PDF document. 

To add a PDF document to a project 
1. In the Project Explorer, expand the Assets folder, right-click the 

Documents folder, and click New Documents to browse for PDF 
files. 

2. Select one or more PDF documents, and click Open. The PDF 
document appear alphabetically in the Documents folder.  

 
Tips:  
• Adding a PDF graphic element to a screen and browsing to select a new PDF document to display 

adds the PDF document to the Documents folder of the project. 
• When adding a PDF document with the same file name as another PDF document in the 

Documents folder, a prompt appears asking to replace the existing PDF or click Cancel. To keep 
both PDF documents, rename the PDF document before adding it to the Documents folder. 

• After adding the PDF document, to see the PDF file name, type, and size, select the PDF in the 
Documents folder and expand the General category in the Properties window. 

• View Designer removes invalid characters and characters over the limit are 40 from the name of a 
PDF document. For example, 1 Document.PDF becomes Document.PDF and 1.PDF becomes 
File_1.PDF. If a file name only contains invalid characters, File_ is pre-pended to the name. 

See also 
Select Document dialog box on page 335 

Add a graphic element to the definition of an Add-On Graphic on 
page 388 

Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 

Add a graphic element to the System Banner on page 123 

PDF naming conventions on page 346 

Renaming a PDF document in the Documents folder renames every 
instance of the PDF document in the project. The name of the PDF 
document changes in each instance of a PDF graphic element and PDF 
Viewer Add-On Graphic in the project.   

To rename a PDF 
1. In the Assets folder in the Project Explorer, locate the PDF 

document in the Documents folder.  

Add a PDF document to a 
project 

Rename a PDF document 
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2. Click the PDF document once to select the item. 
3. Click the PDF document again and type the new name.  

 
Tips:  
• Right-clicking the name of the PDF, clicking Rename, and entering a new name also renames the 

PDF. 
• The name must contain only numbers, letters, and underscores.  
• The name must not begin with a number, contain spaces, have more than one underscore in a row, 

or end with an underscore.  
• Renaming an existing PDF document applies the new name to all PDF graphic elements and PDF 

Viewer Add-On Graphics that reference the PDF document. 

 

IMPORTANT Renaming a PDF document in the Documents folder does not change the file name of 
the PDF document. Expand the folder and select the PDF document. Expand the General 
category in the Properties window to see the name of the PDF document. 

See also 
Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 

Add a PDF document to a project on page 332 

Delete a PDF document from a project on page 334 

PDF naming conventions on page 346 

Replace a PDF document in the Documents folder of the Project 
Explorer. This replaces each instance of the PDF document in the 
project.  

To replace a PDF document 
1. In the Project Explorer, right-click the Documents folder and 

click New Documents. 
2. Browse to and select the replacement PDF document. The 

replacement PDF document must have the same file name as the 
existing PDF document. 

3. Click Yes to replace the PDF document throughout the project.   

See also 
Add a PDF document to a project on page 332 

Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 

Change the PDF document that appears on an HMI device on 
page 346 

Delete a PDF document from a project on page 334 

Rename a PDF document on page 332 

Replace a PDF document 
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Copy a PDF document across View Designer projects: 

• To ensure consistency.  
• When access to the original PDF file does not exist. 
• To use a PDF document in another project. 

Prerequisites 
• Open the source View Designer project containing the PDF 

document to copy.  
• If pasting content into another project, open another instance of 

View Designer with the target project. Open no more than three 
instances of View Designer at one time. 

To copy a PDF document between projects 
1. Copy the PDF document from the Documents folder in the source 

project and paste it in the Documents folder of the target project.   
2. If the target project contains a PDF document with the same PDF 

file name, select Replace to overwrite the existing PDF document 
or select Cancel to not paste the PDF document. 

 
Tips:  
• Copying a PDF graphic element or a PDF Viewer Add-On Graphic copies the PDF document between 

projects.  
• When copying a PDF document that already exists in the target project and that PDF contains a 

different document, View Designer adds an increment number to the name of the PDF document. 
Copying a PDF named Document1 that contains InstructionManual1.pdf to a target project that 
already has a PDF named Document1 but contains a different document called 
InstructionManual2.pdf creates a PDF document named Document1_001. 

• Copying a PDF graphic element that contains a removed PDF document shows a red border with a 
message indicating that no PDF document is specified in the DocumentName property. If the PDF 
appears in an Add-On Graphic, the red border with a message indicating no PDF document appears 
in the definition of the Add-On Graphic and in instances of the Add-On Graphic.  

• Content pasted across projects of different terminal sizes is converted using the scaling option. 
The screen content remains the same size and position as on the original screens.  

• Copying a screen or popup that contains a PDF graphic element or PDF Viewer Add-On Graphic 
from one project to another copies the referenced PDF document to the Documents folder of the 
target project. 

See also 
Copy a graphic element on page 138 

Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 

Replace a PDF document on page 333 

Deleting a PDF from the Documents folder:  

• Removes the PDF document from all screens, popups, and 
Add-On Graphics in the project that reference the PDF.  

• Deletes the references to the PDF from instances of PDF graphic 
elements and PDF Viewer Add-On Graphics in the project. 

Copy a PDF document 
between projects 

Delete a PDF document 
from a project 
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• Removes the name from the DocumentName property in the 
Properties tab for each PDF graphic element and PDF Viewer 
Add-On Graphic in the project.  

The screen containing the PDF graphic element and PDF Viewer Add-On 
Graphic displays a red outline and a message to select a PDF document 
when there is no referenced PDF. 

IMPORTANT Deleting a PDF document cannot be undone. Re-adding a deleted PDF document to a 
project does not restore the configuration of the PDF document in instances of the PDF 
graphic element or PDF Viewer Add-On Graphic in the project. 

To delete a PDF document from a project 
1. In the Project Explorer, open the Assets > Documents folder. 
2. Right-click the PDF document and select Delete. A prompt 

appears if a PDF graphic element or PDF Viewer Add-On Graphic 
in the project references the PDF document.  

3. Select Yes to delete the PDF document or No to not delete the 
PDF document from the project.  

See also 
Add a PDF document to a project on page 332 

Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 

Rename a PDF document on page 332 

How do I open the Select Document dialog box?  

In Toolbox > System, double-click the PDF graphic element. 

Use the Select Document dialog box to reference a PDF document for 
the selected PDF graphic element or PDF Viewer Add-On Graphic on the 
screen.  

The Select Document dialog box lists the PDF documents that exist in 
the Documents folder of the Project Explorer and enables browsing to 
new documents. Selected documents appear in the Documents folder.  

The Documents folder is in the Assets folder of the Project Explorer.  

See also 
Add a PDF document to a project on page 332 

Add a graphic element to the definition of an Add-On Graphic on 
page 388 

Add a PDF Viewer Add-On Graphic to a screen or popup on page 
337 

Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 

Select Document dialog box 
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Add a graphic element to the System Banner on page 123 

Add a PDF document to a screen or popup from the Project Explorer. 
When adding a PDF document from the Documents folder of the 
Project Explorer, select the PDF Viewer Add-On Graphic or PDF 
graphic element to display the PDF document on the HMI device. A PDF 
Viewer Add-On Graphic has touch, navigation, and zoom commands. 
PDF documents appear directly in an Add-On Graphic. An Add-On 
Graphic cannot contain another Add-On Graphic. 

Prerequisites 
• (optional) Create bookmarks for the PDF document prior to adding 

the document to the project.  

To add a PDF document to a screen or popup 
1. In the Project Explorer, expand the Assets > Documents folder. 
2. Right-click the PDF document and select Add to (screen name) 

or drag the PDF document to the screen or popup. The Select 
PDF Viewer dialog box opens listing PDF Viewers and PDF 
graphic elements. 
Tip: The Select PDF Viewer dialog box lists Add-On Graphics when only one PDF 

graphic element in the Add-On Graphic has a user-defined property aliased 
to the DocumentName property of the Add-On Graphic. 

3. Select the PDF Viewer or graphic element to display the PDF 
document on the HMI device and click OK. 

4. In the Properties window of the PDF Viewer or Add-On Graphic, 
click the Properties tab.   

5. Expand a category to display a property and change the value or 
bind a property. 
Tips: • Each screen has a limit of displaying two PDF documents. This includes 

both PDF Viewer Add-On Graphics and PDF graphic elements. 
• PDF documents on the HMI device support internal links for navigation 

within the PDF document. PDF documents on the HMI device do not 
support external links. PDF links cannot navigate outside of the PDF 
document on the HMI device.  

• PDF files that contain complex drawings take longer to render. For 
example, if a PDF document contains an image comprised of individual 
shapes such as lines, circles, and rectangles, that image takes longer to 
render than a drawing that is a single image. 

• Do not rotate the PDF graphic element or a PDF Viewer Add-On 
Graphic. Rotating an element containing a PDF document reduces the 
clarity of content in the PDF document and prevents zooming and 
navigating the PDF document on the HMI device.  

See also 
Bind bookmark properties of a PDF graphic element on page 343 

Add an event command to interact with a PDF graphic element on 
page 344 

Add a PDF document to a project on page 332 

Add a PDF document to a 
screen or popup 
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Add a PDF document to an Add-On Graphic on page 337 

Add a PDF document to an Add-On Graphic to have the Add-On Graphic 
display the PDF document on the HMI device.     

Prerequisites 
• (optional) Create bookmarks for the PDF document prior to adding 

the document to the project.  

To add a PDF document to an Add-On Graphic 
1. Open the definition of the Add-On Graphic.  
2. In the Project Explorer, expand the Assets > Documents folder. 
3. Drag the PDF document to the definition of the Add-On Graphic. A 

PDF graphic element appears in the definition of the Add-On 
Graphic and shows the PDF document.  
Tips: • The Select PDF Viewer dialog does not open when adding a PDF 

document to an Add-On Graphic. View Designer  does not support adding 
a PDF Viewer Add-On Graphic to anther Add-On Graphic.  

• Dragging the PDF graphic element from the System category of the 
Toolbox opens the Select PDF Viewer dialog box.   

See also 
Bind bookmark properties of a PDF graphic element on page 343 

Add an event command to interact with a PDF graphic element on 
page 344 

Add a PDF document to a project on page 332 

Add a PDF Viewer Add-On Graphic to a screen or popup on page 
337 

Add a PDF document to an Add-On Graphic on page 337 

PDF Viewer Add-On Graphics contain a PDF graphic element and the 
predefined commands for navigating and zooming the PDF document on 
the HMI device. Add the PDF Viewer Add-On Graphic and specify the 
PDF document that opens on the HMI device.  

Prerequisites  
• Create bookmarks for the PDF document prior to adding the PDF 

document in View Designer. 

To Add a PDF Viewer Add-On Graphic to a screen or popup 
1. In the Toolbox, expand the Add-On Graphics category and 

double-click a PDF Viewer Add-On Graphic:  

Add a PDF document to an 
Add-On Graphic 

Add a PDF Viewer Add-On 
Graphic to a screen or 
popup 
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• PDF_Viewer. Occupies the entire screen on a seven-inch or 
nine-inch HMI device.  

• PDF_Viewer_Landscape. Occupies the entire screen on a 
10-inch HMI device and a portion of larger HMI devices. The 
PDF_Viewer_Landscape Add-On Graphic is not available on 
seven-inch or nine-inch HMI devices.  

• PDF_Viewer_Portrait. Occupies half of the screen on a 
10-inch HMI device. The PDF_Viewer_Portrait Add-On Graphic 
is available on 10-inch or larger HMI devices.  

 
Tips:  
• Each screen has a limit of displaying two PDF documents. This includes both PDF Viewer Add-On 

Graphics and PDF graphic elements. 
• PDF documents on the HMI device support internal links for navigation within the PDF document. 

PDF documents on the HMI device do not support external links. PDF links cannot navigate outside 
of the PDF document on the HMI device.  

• PDF files that contain complex drawings take longer to render. For example, if a PDF document 
contains an image comprised of individual shapes such as lines, circles, and rectangles, that 
image takes longer to render than a drawing that is a single image. 

2. In the Properties window, expand the General category.  
3. Configure the required properties: 

• DocumentName - The PDF document shown on the HMI 
device. Select the PDF document for the Add-On Graphic.  

• PageNumber - Type the page number of the PDF document to 
initially open on the HMI device. 

• Zoom - Select the zoom factor.  

 
Tips:  
• Add a PDF Viewer Add-On Graphic to a screen or popup from the Project Explorer by expanding the 

Assets > Add-On Graphics folders and then dragging the PDF_Viewer Add-On Graphic or 
right-clicking the PDF_Viewer Add-On Graphic and selecting Add Add-on Graphic to (screen name). 

• Adding a PDF document from the Assets > Documents folder of the Project Explorer opens the 
Select PDF Viewer dialog box to select the PDF Viewer or PDF graphic element to display the PDF 
graphic element on the HMI device. If the definition of an Add-On Graphic contains only one PDF 
graphic element that has an alias for the DocumentName property of the PDF graphic element, 
that Add-On Graphic appears in the Select PDF Viewer dialog box. 

• Do not rotate the PDF graphic element or a PDF Viewer Add-On Graphic. Rotating an element 
containing a PDF document reduces the clarity of content in the PDF document and prevents 
zooming and navigating the PDF document on the HMI device.  

See also 
Change the PDF document that appears on an HMI device on 
page 346 

Work with PDF documents on page 331 

PDF Viewer Add-On Graphic 
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A PDF Viewer Add-On Graphic with default content and a PDF document 
added contains items for navigating and zooming. 

 
 

Item Description 

 
The PDF document added to the PDF Viewer Add-On Graphic through the DocumentName property.  

  Bookmarks displays the bookmarks on the left side of the PDF document on the HMI device. 

  Previous opens the previous page of the PDF document. This button appears unavailable on the 
HMI device when on the first page of the PDF document PDF document.   

   Next opens the next page of the PDF document. This button appears unavailable when on the 
last page of the PDF document on the HMI device. 

 
The currently displayed Page Number of the PDF on the HMI device and the total Page Count or number 
of pages of the PDF document.  

 
The value in the Text property of the PDF Viewer Add-On Graphic that displays the name of the PDF 
document on the HMI device. 

   Fit Width expands the width of the PDF document. 

  Fit Window expands the entire page of the PDF document to fit the PDF graphic element.   

  Zoom In increases the PDF document magnification by the percentage specified in the 
ByPercent property of the Zoom In event command. 

  Zoom Out decreases the PDF document magnification by the percentage specified in the 
ByPercent property of the Zoom In event command. 

See also 
Add a PDF Viewer Add-On Graphic to a screen or popup on page 
337 

Change the definition of a PDF Viewer Add-On Graphic on page 
340 

Add a PDF document to a project on page 332 

Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 
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Add, remove, rearrange, and configure content in the definition of a PDF 
Viewer Add-On Graphic. Do this to modify a predefined PDF Viewer 
Add-On Graphic instead of using a PDF graphic element and adding 
required functionality to that graphic element. 

To change the definition of a PDF Viewer Add-On Graphic 
1. Double-click the definition of the PDF Viewer Add-On Graphic in 

the Project Explorer. The definition of the Add-On Graphic 
opens. 

2. Change the PDF Viewer Add-On Graphic:  
• Add content. Add graphic elements to the PDF Viewer Add-On 

Graphic.  
• Remove content. Select and delete graphic elements from the 

PDF Viewer Add-On Graphic to remove buttons from the 
Add-On Graphic. 

• Rearrange content. Drag to resize or change the order of 
content in the PDF Viewer Add-On Graphic. Do this to change 
the order and size of buttons in the Add-On Graphic.  

• Configure content. Change attributes of content in the Add-On 
Graphic by changing the property values, binding, animations, 
and events for a graphic element within the open definition of 
the Add-On Graphic. 

3. To close and save the definition of the PDF Viewer Add-On 
Graphic, on the tab of the open Add-On Graphic, select Close 
. 

See also 
Add a PDF Viewer Add-On Graphic to a screen or popup on page 
337 

PDF Viewer Add-On Graphic on page 338 

How do I open the Select PDF Viewer dialog box? 

Drag the PDF document from Project Explorer > Assets > 
Documents.  

Use the Select PDF Viewer dialog box to select a PDF Viewer or PDF 
graphic element when adding a PDF document from the Project 
Explorer to a screen or popup.  

The Select PDF Viewer dialog box lists PDF graphic elements that 
appear in the System category of the Toolbox. The Select PDF Viewer 
dialog box lists the PDF Viewer Add-On Graphics that exist in Project 
Explorer > Assets > Add-On Graphics. The Select PDF Viewer dialog 
box lists any Add-On Graphic for which a user-defined property alias 
exists for the DocumentName property of only one PDF document in the 
definition of that Add-On Graphic.   

Change the definition of a 
PDF Viewer Add-On Graphic 

Select PDF Viewer dialog 
box 
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See also 
Add a PDF Viewer Add-On Graphic to a screen or popup on page 
337 

PDF Viewer Add-On Graphic on page 338 

Change the definition of a PDF Viewer Add-On Graphic on page 
340 

Work with PDF documents on page 331 

Add a PDF graphic element to a screen, popup, or Add-On-Graphic from 
the Toolbox to display the PDF document on the HMI device. PDF 
graphic elements exist in the Toolbox. The PDF document that a PDF 
graphic element references exists in the Documents folder of the 
Project Explorer. 

Prerequisites 
• (optional) Create bookmarks for the PDF document prior to adding 

the document to the project.  

To add a PDF graphic element to a screen or popup, or Add-On 
Graphic 

1. From the Toolbox, expand the System category and then 
double-click or drag the PDF graphic element to a screen, popup, 
or definition of an Add-On Graphic.  

2. On the Select Document dialog box, either: 
• Select an existing PDF document and select OK.  
• Select Browse, select a new PDF document or multiple PDF 

documents, select Open to add the documents to the Select 
Image dialog box, select the PDF document to add to the 
screen, and then select OK.   

The PDF graphic element appears on the screen and references 
the PDF document.  

 
Tips:  
• Browsing to and selecting multiple PDF documents in the Select Document dialog box highlights 

the last selected PDF document.  
• Selecting Cancel on the Select Document dialog box places a PDF graphic element on the screen. 

The PDF graphic element displays a message to add a PDF document to the PDF graphic element. 

3. In the Properties window, select the Properties tab. The 
properties for that item appear in categories.  

4. Expand a category to display a property and change the value or 
bind a property. 

Add a PDF graphic element 
to a screen, popup, or 
Add-On Graphic 
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Tips:  
• To add a PDF Viewer Add-On Graphic configured with touch navigation and zoom commands, add a 

PDF Viewer Add-On Graphic from the Add-On Graphics category of the Toolbox.  
• Adding a PDF document from the Assets > Documents folder of the Project Explorer opens the 

Select PDF Viewer dialog box to select the PDF Viewer Add-On Graphic or PDF graphic element to 
display the PDF document on the HMI device. 

• PDF documents on the HMI device support internal links for navigation within the PDF document. 
PDF documents on the HMI device do not support external links. PDF links cannot navigate outside 
of the PDF document on the HMI device.  

• PDF files that contain complex drawings take longer to render. For example, if a PDF document 
contains an image comprised of individual shapes such as lines, circles, and rectangles, that 
image takes longer to render than a drawing that is a single image. 

• Do not rotate the PDF graphic element or a PDF Viewer Add-On Graphic. Rotating an element 
containing a PDF document reduces the clarity of content in the PDF document and prevents 
zooming and navigating the PDF document on the HMI device.  

See also 
Bind bookmark properties of a PDF graphic element on page 343 

Add an event command to interact with a PDF graphic element on 
page 344 

Add a PDF document to a project on page 332 

Add a PDF Viewer Add-On Graphic to a screen or popup on page 
337 

Change a property value for a PDF graphic element on page 342 

Change the property values of a PDF graphic element to change its 
appearance and behavior on the HMI device. Bind a property to a tag to 
update the property on the HMI device. For example, bind PageNumber 
to open a specified page dynamically when a state or alarm condition is 
reached. Use property-to-property binding to write a value to the property 
from another element or command event. For example, use a Numeric 
Input to write to the PageNumber property to change the PDF document 
to a specific page. 

To change a property value for a PDF graphic element 
1. Select the PDF graphic element on the screen, popup, or in the 

definition of an Add-On Graphic.  
2. In the Properties window, select the Properties tab.  
3. Expand the General category to display a property and change:   

• DocumentName. Select the document the PDF graphic 
element displays on the HMI device. 

• PageNumber. Enter the initial page number to show in View 
Designer and to open in the PDF document on the HMI device. 
Binding opens a specific page in the PDF document when the 
controller reaches the tag in the controller or by writing a value 
to the PageNumber property from another graphic element. The 
specified page in the PDF graphic element opens to resolve the 
issue, such as a state or alarm condition.  

• Zoom. Select the default zoom setting for the PDF document on 
the HMI device. The value of the Zoom property when the 

Change a property value for 
a PDF graphic element 



Chapter 9  Add a graphic element to a project 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 343 
 

screen with the PDF graphic element opens determines the 
initial zoom settings. Binding zooms by reaching a tag in the 
controller or by writing a value to the Zoom property from 
another graphic element. 
• Fit width. Expand the width of the PDF document. 
• Fit page. Expand the size of the PDF document to fit the PDF 

to the size of the PDF graphic element. 
• Actual Size. Change the size of the PDF document to the 

actual size of the document. This may require scrolling on the 
HMI device. 

 
Tip: The PageCount property displays the total number of pages in the PDF document 
on the HMI device. Changing the value in the PageCount property is not supported. 
This property value is View only.  

See also 
Bind bookmark properties of a PDF graphic element on page 343 

Property-to-property binding on page 510 

Bind PDF bookmark properties to display and navigate bookmarks in a 
PDF document on the HMI device. Bind the Bookmarks property to 
display the bookmarks in a PDF document. Bind the BookmarkIndex 
property to navigate to a specific bookmark in a PDF document.  

Prerequisites 
• Create bookmarks in the PDF document before adding to the PDF 

document to the project. 
• Verify that the screen, popup, or AOG contains the PDF graphic 

element. 

To bind bookmark properties of a PDF graphic element 
1. Drag a List Box Selector onto the screen, popup, or Add-On 

Graphic. 
2. Use property-to-property binding to bind the Items box of the List 

Box Selector to the Bookmarks property of the PDF graphic 
element. Bind the Items property of the List Box Selector to the 
Bookmarks property of the PDF graphic element. Use the format 
PDFGraphicElementName.Bookmarks. On the HMI device, the 
List Box Selector displays all of the bookmarks in the PDF 
document.  

3. Use property-to-property binding to bind the Value box of the List 
Box Selector to the BookmarkIndex property of the PDF graphic 
element. Bind the Value property of the List Box Selector to the 
BookmarksIndex property of the PDF graphic element. Use the 
format PDFGraphicElementName.BookmarksIndex. On the HMI 
device, selecting a bookmark opens the bookmark in the PDF 
document.  

Bind bookmark properties 
of a PDF graphic element 
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See also 
Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 

Add a PDF Viewer Add-On Graphic to a screen or popup on page 
337 

Property-to-property binding on page 510 

PDF graphic element on page 194 

Create an event to navigate pages or change the view in a PDF 
document. Add a PDF navigation command to a touch or key event to 
navigate to the previous page, next page, or a specific page in a PDF. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To create an event command to interact with a PDF Viewer graphic 
element 

1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the PDF category and select and configure the command:  

• Next Page. Navigates to the next page in the PDF when the 
event triggers. 

• Previous Page. Navigates to the previous page in the PDF 
when the event triggers. 

• Go to Page. Navigates to the specified page in the PDF. In the 
Page box, enter the page number to display when the event 
triggers. 

• Zoom In. Increases the document magnification by a 
percentage of the preset level in a PDF document. In the 
ByPercent box, enter a value to increase magnification. 

• Zoom Out. Decreases the document magnification by a 
percentage of the preset level in a PDF document. In the 
ByPercent box, enter a value to decrease magnification. 

• Zoom To. Adjusts the magnification of the PDF to fit an entire 
page, fit the width of the page, or show the page at 100% in the 
PDF Viewer. In the Zoom list, select a magnification option. 

Add an event command to 
interact with a PDF graphic 
element 
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Tips:  
• Bind a PDF command property value to a tag in a controller to change the PDF property 

dynamically on the HMI device. If there is a problem with a tank, bind the specific page number of 
the PDF document to a tag for user assistance. The controller opens the document to the specified 
page explaining how to fix the issue. 

• Project events do not support PDF commands. 

See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Copy a single or multiple PDF graphic elements or PDF Viewer Add-On 
Graphics to reuse the PDF on screens and popups within a project or 
across View Designer projects. Copying a PDF graphic element or PDF 
Viewer Add-On Graphic copies all of the property values of the graphic 
element or Add-On Graphic.  

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If pasting content into another project, start another instance of 

View Designer to open the target project. Open no more than three 
instances of View Designer at one time. 

To copy a PDF graphic element or PDF Viewer Add-On Graphic 
1. In the Graphic Explorer, right-click the PDF graphic element or a 

PDF Viewer Add-On Graphic and then select Copy.  

 
Tip: To select multiple PDF graphic elements or Add-On Graphics, hold Ctrl and select multiple 
items.  

2. On the target screen, right-click the location to paste and select 
Paste. 

 
Tips: 
• If the target screen contains a PDF graphic element or PDF Viewer Add-On Graphic with the same 

name, the name of the new graphic element or Add-On Graphic appears with an increment 
number. 

• Copying a PDF graphic element or PDF Viewer Add-On Graphic copies the referenced PDF 
document. When a PDF document with the same name already exists in the target project, replace 
the PDF document or cancel copying the PDF document. 

• To cut a PDF graphic element or a PDF Viewer Add-On Graphic, right-click the graphic element and 
select Cut. 

• Copying a PDF graphic element or a PDF Viewer Add-On Graphic copies the property values of the 
graphic element or Add-On Graphic, including the name of the PDF document.  

Copy a PDF graphic element 
or PDF Viewer Add-On 
Graphic 
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See also 
Graphic Explorer on page 132 

Duplicate a graphic element on page 150 

Copy an instance of an Add-On Graphic within a project on page 
397 

Copy an instance of an Add-On Graphic between projects on page 
398 

Change the PDF document referenced on a screen, popup, or Add-On 
Graphic to view a different PDF document on the HMI device. 

To change the PDF document that appears on an HMI device 
1. On the screen, select the PDF graphic element or PDF_Viewer 

Add-On Graphic that references the PDF document. 
2. In the Properties window, select the Properties tab and expand 

the General category. 
3. In the DocumentName box, select a different PDF document. 

 
Tip: A No document assigned message appears when the PDF graphic element or a PDF 
Viewer Add-On Graphic does not reference a PDF document. 

See also 
Add a PDF document to a project on page 332 

Add a PDF graphic element to a screen, popup, or Add-On 
Graphic on page 341 

The names of PDF documents, PDF graphic elements, and PDF Viewer 
Add-On Graphics change automatically to:  

• Remove invalid characters. 
• Remove characters over the 40-character limit. 
• Replace spaces with underscores. 
• Increment duplicate names with a number. Adding a PDF file 

named 01_picture.png adds a PDF named picture.png to the the 
Documents folder. Adding a PDF file named 02_picture.png adds 
a PDF named picture_001.png to the Documents folder. 

 
Tips:  
• Changing the name of a PDF document does not change the name of a PDF graphic element or PDF 

Viewer Add-On Graphic that references the PDF document. 
• Changing the name of a PDF graphic element or PDF Viewer Add-On Graphic does not change the 

name of the referenced PDF document. 

See also 
Add a PDF document to a project on page 332 

 

Change the PDF document 
that appears on an HMI 
device 

PDF naming conventions 
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Chapter 10 

Screens 

Use a screen to contain content and create shortcuts that appear in the 
application on the HMI device. After adding a screen to a project, build 
the content and design the behavior to see on the HMI device. A View 
Designer project for a PanelView 5310 can contain no more than a total 
of 100 screens and popups. A View Designer project for a PanelView 
5510 can contain no more than a total of 500 screens and popups. 
Projects must have a minimum of one screen. 

Once the screen is created, add content to and configure the behavior of 
the screen to provide interactivity on the HMI device. 

See also 
Screen tab on page 347 

Create a screen on page 348 

Open a screen on page 348 

Change the background color of a screen on page 349 

Delete a screen on page 352 

How do I open the Screen tab? 

When you open a project the screen designated as the Home screen 
opens. To open a different screen for the project, in the Project 
Explorer, expand the User-Defined Screens folder, and double-click 
the screen. Screen names are preceded by a Screen icon .  

The Screen tab is the drawing area that you use to create or edit the 
screens and popups viewed on the HMI device. A View Designer project 
for a PanelView 5310 can contain no more than a total of 100 screens 
and popups. A View Designer project for a PanelView 5510 can contain 
no more than a total of 500 screens and popups. Projects must have a 
minimum of one screen. 

Use the Screen tab to: 

• Create and change graphic elements. 
• Cut, copy, paste, and delete graphic elements. 
• Group, ungroup, or change the order of graphic elements. 
• Align or distribute graphic elements horizontally or vertically. 
• Lock a graphic element so it cannot be moved by the HMI 

designer. 
To design a screen that depicts a bottling line, add graphic elements 
representing bottles, conveyors, and other associated graphic elements 
and text.  

Work with screens 

Screen tab 
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See also 
Create a screen on page 348 

Create a popup on page 110 

Specify a Home screen on page 553 

Rename a screen on page 351 

Change the background color of a screen on page 349 

A screen in View Designer contains the items to appear on the screen on 
the HMI device. After adding a screen to a project, build the content and 
design the behavior to see on the HMI device. A View Designer project 
for a PanelView 5310 can contain no more than a total of 100 screens 
and popups. A View Designer project for a PanelView 5510 can contain 
no more than a total of 500 screens and popups. Projects must have a 
minimum of one screen. 

To create a screen: 
• In the Project Explorer, right-click the User-Defined Screens 

folder and click New Screen. A screen named Screen_002 or 
increment number is added to the folder. 

 

 
Tip: After adding the screen, create content for it by adding graphic elements. 

See also 
Add a graphic element to a screen on page 136 

Screen tab on page 347 

Popup tab on page 109 

Project Explorer on page 95 

Open a screen to display its contents.  

To open a screen: 
1. In the Project Explorer, expand the User-Defined Screens or 

Predefined Screens folder.  
2. Double-click the screen. The screen opens on its own tab. 

See also 
Create a screen on page 348 

Change the background color of a screen on page 349 

Project Explorer on page 95 

Create a screen 

Open a screen 
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Screen tab on page 347 

Change the background color of a screen to a different color, gradient 
color, or custom color. 

To change the background color of a screen:  
1. In the Project Explorer, expand the User-Defined Screens or 

Predefined Screens folder. 
2. Select the screen, or double-click the screen to open it.  
3. In the Properties window, select the Properties tab.  
4. Expand the Appearance category. 
5. In the FillColor box, select a color using one of these methods: 

• Type the Hex value in the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and represent the color channel 
values for red, green, and blue. For example, #ffff00 produces 
yellow. 

• Select the arrow or color swatch to open the Color Picker, and 
select or create a color.   

• In the Color Picker, create a color gradient. 
The selected color appears in the Fill Color box.  

See also 
Project Explorer on page 95 

Create a screen on page 348 

Color Picker overview on page 495 

Create a color gradient on page 498 

Bind a color property to a tag or expression on page 500 

Change the background color of a popup to a different color, gradient 
color, or custom color. Radial gradients are not supported for popup fill 
color.  

To change the background color of a popup 
1. In the Project Explorer, expand the User-Defined Screens 

folder. 
2. Double-click the popup to open the popup.  
3. In the Properties window, click the Properties tab. 
4. Expand the Appearance category. 
5. In the FillColor box, select a color using one of these methods: 

• Type the Hex value in the format #RRGGBB. R, G, and B are 
Hex digits from 0 through F and represent the color channel 
values for red, green, and blue. For example, #ffff00 produces 
yellow. 

• Select the arrow or color swatch to open the Color Picker, and 
select or create a color.   

Change the background 
color of a screen 

Change the background 
color of a popup 
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See also 
Create a popup on page 110 

Change the opacity of a popup on page 114 

Create a color gradient on page 498 

Select a fill color on page 141 

Create a custom color using the Color Picker on page 497 

Copy a screen to reuse it within or across View Designer projects. Paste 
a screen into the same folder in the Project Explorer to create a copy of 
the screen and append the name with an increment number. Paste 
screens from the Predefined Screens folder only into the User-Defined 
Screens folder within or across projects. Content copied to a project with 
a different HMI screen size maintains its original size and position. 

Prerequisites: 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy a screen  
1. In the source project, in the Project Explorer, right-click the 

screen and select Copy. 

 
Tip: To select multiple screens, hold Ctrl and select the items. 

2. Right-click the target folder and select Paste. If the target folder 
contains a screen with the same name, select one of two options: 
• Select Replace to overwrite the existing screen. 
• Select Keep Both to keep both screens. The name of the new 

screen is appended with a number that increments with each 
copy. 

Copy a screen 
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Tips:  
• Copying a screen that contains an instance of an Add-On Graphic to a different project that does 

not contain an Add-On Graphic with the same name adds the definition of the Add-On Graphic to 
the Assets > Add-On Graphics folder of the Project Explorer and adds the Add-On Graphic to the 
Toolbox category indicated for the Add-On Graphic. 

• Copying a screen that contains an instance of an Add-On Graphic to a different project that 
contains an Add-On Graphic with the same name provides three options:   
• Keep Both. Append the name of the copied Add-On Graphic definition with _001 or increment 

number. The definition appears in the folder and the Add-On Graphic appears in the Toolbox.  
• Replace. Replace the existing Add-On Graphic definition with the copied definition. Any 

instances of the existing Add-On Graphic are updated with the new definition of the Add-On 
Graphic.  

• Cancel. Do not paste the copied Add-On Graphic definition into the project. 
• If pasting a screen with an Add-On Graphic replaces an alias property in the definition of an 

Add-On Graphic and that alias is linked in an instance, the alias property shows in the Properties 
window of the instance, and the alias remains linked to the value of the base property in the 
definition. 

• If pasting a screen with an Add-On Graphic replaces an alias property in the definition of an 
Add-On Graphic and that alias is unlinked in an instance, the alias property shows in the Properties 
window of the instance, but the alias property retains its value from the original Add-On Graphic 
definition. The value of the alias property is not linked to the base property of the pasted Add-On 
Graphic definition. 

• Copying a screen that has an Add-On Graphic with an image that exists in both the source and 
target projects displays a prompt to replace the image. Images are copied to the Assets > Images 
folder of the Project Explorer. 

• When copying a screen, any localized data associated with the screen and its children is also 
copied. 

See also 
Create a screen on page 348 

Rename a screen on page 351 

Delete a screen on page 352 

Reuse content on page 359 

Project Explorer on page 95 

By default, each project contains a screen named Screen_001. This 
number increments with each new screen created with the same name.   

Rename a screen to make the name more meaningful. For example, give 
the screen a name that reflects its purpose, content, or targeted use. 
Names within a folder must be unique and are not case sensitive. For 
example, Bottling_Line and bottling_line are considered identical names. 
Renaming any screen in the Predefined Screens folder is not allowed. 

To rename a screen: 
1. In the Project Explorer, expand the User-Defined Screens 

folder. 
2. Click the screen once to select the item.  
3. Click the screen again and type the new name. 

 
Tip: Right-clicking the name, selecting Rename, and entering a new name also renames the 
screen. 

Rename a screen 
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See also 
Change the background color of a screen on page 349 

Delete a screen on page 352 

Project Explorer on page 95 

Screen tab on page 347 

Restore the default content of a screen, popup, or Banner item in the 
Predefined Screens folder of the Project Explorer to overwrite any 
changes made to the item. For example, restore the content of the 
Banner item to have the default content appear at the top of screens.   

To restore the default content of a predefined item 
1. With the revised item open, press CTRL+A to select all remaining 

content in the item and press Delete.  
2. Open another View Designer project and open the unchanged 

version of the item. 
3. With the unchanged item open, press CTRL+A to select all of the 

default content. 
4. Right-click a selected item and select Copy to copy the content to 

the clipboard. 
5. Right-click the empty revised item and select Paste. The default 

content of the item is restored.  

See also 
Predefined Screens folder on page 96 

What is the System Banner? on page 97 

What is the Settings screen? on page 97  

What is the Alarm Summary? on page 99 

What is the Alarm Manager? on page 99 

Delete a screen to remove it from the project. Delete screens from the 
User-Defined Screens folder in the Project Explorer. To delete a 
screen that is referenced by shortcuts, first delete the shortcuts. Deleting 
a screen from the Predefined Screens folder is not allowed. You cannot 
undelete a screen.  

Prerequisites 
• In the Navigation Menu folder, delete any shortcuts based on the 

screen to delete.  

Restore the default content 
of a predefined item 

Delete a screen 
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To delete a screen 
1. In the Project Explorer, expand the User-Defined Screens 

folder. 
2. Right-click the screen, and select Delete. The screen is removed 

from the Project Explorer. 

See also 
Create a screen on page 348 

Change the background color of a screen on page 349 

Project Explorer on page 95 

Screen tab on page 347 

Close a screen to close items in a project that no longer need to be open. 
For example, close items that currently do not require viewing or editing.   

To close a screen 
• On the tab of the item, select Close . 

See also 
Close all screens on page 353 

Change the background color of a screen on page 349 

Project Explorer on page 95 

Screen tab on page 347 

Close all screens in a project simultaneously to not close each screen 
individually. Closing all documents closes only screens. All other 
windows and tabs remain open. 

To close all screens 
1. Select Window > Close All Documents.  
2. If prompted to save changes to the screens, select Yes to save 

changes, or select No to not save changes.  

See also 
Screen tab on page 347 

Close a screen on page 353 

Delete a screen on page 352 

Rename a screen on page 351 

Close a screen 

Close all screens 
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Project Explorer on page 95 

By default, all users on HMI devices have access to these items in the 
Project Explorer:  

• Shortcuts in the Navigation Menu folder. 
• Screens and popups in the User-Defined Screens and 

Predefined Screens folders. Navigate to these items on the HMI 
device by triggering an event with a navigation command. Users 
who do not have the Administrator role have read-only access to 
the Settings screen and related popups in the Predefined 
Screens folder.  

Change the access level for any item in the Project Explorer. Restrict 
access to an item for any role except the Administrator role. The 
Administrator role always has Inherit access, and the role inherits Full 
Access from the root folder. 

To restrict access to an item on the HMI device 
1. In the Project Explorer, expand the folder that contains the item 

to restrict access:   
• To select a screen or popup, expand the User-Defined 

Screens folder or the Predefined Screens folder.  
• To select a shortcut, expand the Navigation Menu folder.   

2. Select or double-click the item. The Properties window for the 
item opens. 

3. In the Properties window for the selected item, expand the 
Security category. 

4. After each role (Engineer, Maintenance, Operator, Restricted, and 
Supervisor), select the access option for each role. 
• Inherit. Grants the same access assigned to the parent folder. 
• Full Access. Grants access to open and interacts with the item, 

and shows the item in the Navigation menu on the HMI device. 
• Read Only. Grants access to open the item, but denies 

interaction with it. The item appears in the Navigation menu on 
the HMI device. Users assigned to a role with read-only access 
can still interact with the Navigation menu and alarm tables. 
For example, a user with read-only access to an alarm table can 
still perform read operations, such as viewing alarms and 
details, selecting alarms and conditions, filtering alarms, and 
pausing alarms. The user cannot perform write commands that 
change the state of an alarm.   

• No Access. Denies access to open or interact with the item. 
The item does not appear in the Navigation menu on the HMI 
device. 

5. To set individual role access to a shortcut, independent of the 
access to the screen on which the shortcut is based: 

a. Select the shortcut.  

b. In the Properties window of the selected shortcut, clear the 
UseScreenSecurity check box. 

c. Select the access level for each role.  

Restrict access to an item 
on the HMI device 
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Do not base the security for a shortcut on its defining screen if 
the user has access to some shortcuts of a screen but should 
not have access to a particular shortcut.    

See also 
Restrict access to the HMI device on page 695 

Restrict access to a graphic element on page 695 

Project Explorer on page 95 

Properties tab on page 494 

Security overview on page 698 

Screens, popups and the System Banner have a default update rate of 
500 milliseconds. Use the UpdateRate property to change the frequency 
rate for an element. 

 
Tip: If the high update rate negatively impacts performance, the HMI device automatically lowers the 
update rate value. 

To change the update rate of a screen, popup, or the System Banner 
1. In the Project Explorer, expand the User-Defined Screens or 

the Predefined Screens folder. 
2. Select the item to change. 
3. In the Properties window, select the Properties tab. 
4. Expand the General category. 
5. In UpdateRate, select the rate. 

• 100 ms 
• 250 ms 
• 500 ms 

 
Tips:  
• For best performance, on a PanelView 5310 HMI device use: 
• Up to 600 tag references on a screen at 500 ms update rate 
• Up to 200 tag references on a screen at 250 ms update rate 
• Up to 100 tag references on a screen at 100 ms update rate 

• For best performance, on a PanelView 5510 HMI device use: 
• Up to 800 tag references on a screen at 500 ms update rate 
• Up to 300 tag references on a screen at 250 ms update rate 
• Up to 150 tag references on a screen at 100 ms update rate 

• It is possible to use up to 2000 tag references on one screen, however, using more references than 
listed above may cause the HMI device to skip updates. 

See also 
What is a Popup? on page 118 

What is the System Banner? on page 97 

Create an alias property on page 361 

 

Change the update rate of a 
screen, popup, or the 
System Banner 
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Chapter 11 

Undo and redo an action 

Undo the most recent edits made to a screen, popup, or the definition of 
an Add-On Graphic. View Designer tracks edits made to an open screen, 
popup, or definition of an Add-On Graphic. Each screen, popup, and 
Add-On Graphic definition has its own undo history. Changes made to 
the definition of an Add-On Graphic after deleting an instance of the 
Add-On Graphic apply to the instance when undoing the deletion of the 
instance.   

Closing a screen, popup, or Add-On Graphic definition clears the undo 
actions to perform on that screen, popup, or Add-On Graphic definition. 
When re-opening the screen, popup, or Add-On Graphic definition, the 
previous actions are not available to undo. 

 
Tips:  
• Undo is not available for some actions, such as finding and replacing text in a project or 

ungrouping grouped graphic elements.  
• Undoing changes made to Project Explorer (for example, deleting a screen), Project Properties (for 

example, deleting a controller), or Security Administration (for example, deleting a user) is not 
supported. 

To undo an action: 
• On the Standard toolbar, select Undo . The most recent action 

is undone. 

 
Tips:  

• Place the cursor over the  button to show the action to be undone. 
• Alternative methods for undoing an action include: 
• Press Ctrl+Z. 
• Select Edit > Undo. 
• Changes to the definition of an Add-On Graphic appear in a previously deleted instance of the 

Add-On Graphic when deleting an instance, changing the definition, and then undeleting the 
instance. For example, any changes to the content, an alias, a binding, or a value appear in the 
undeleted instance of the Add-On Graphic. 

See also 
• Graphic Explorer on page 132 

Redo the most recent edit to a screen, popup, or the definition of an 
Add-On Graphic. View Designer tracks edits made to an open screen, 
popup, or definition of an Add-On Graphic. Each screen, popup, and 
Add-On Graphic definition has its redo history.  

Closing a screen, popup, or Add-On Graphic definition clears redo 
actions to perform on that screen, popup, or Add-On Graphic definition. 
When re-opening the screen, popup, or Add-On Graphic definition, the 
previous actions are not available to redo.  

Undo an action 

Redo an action 
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To redo an action 

• On the Standard toolbar, select Redo . The last undone action 
is redone. 

 
Tips:  

• Place the cursor over the  button to show the action to be redone. 
• Alternative methods for redoing an action include: 
• Press CTRL+Y. 
• Select Edit > Redo. 

See also 
• Graphic Explorer on page 132 
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Chapter 12 

Reuse content 

Reuse content in a View Designer project to save time and create 
consistency within the project. Reuse: 

• Screens and popups. Convey the same information on a screen 
or popup in another screen or popup. Depict information about 
different parts of a manufacturing system with consistency.  

• Add-On Graphics. Create custom graphic elements to depict a 
manufacturing system. Reuse Add-On Graphics to save time and 
create consistent content for screens. 

• Content from other projects. Reuse content from another View 
Designer project to save time when creating a new project.  

See also 
Reuse screens and popups on page 359 

Add-On Graphics on page 375 

Reuse content from other View Designer projects on page 422 

Pass tag values from the controllers to a screen or popup by defining 
properties and exposing them for reuse. These user-defined properties 
can be aliases of existing screen properties or properties that have a data 
type. Use the data type properties in place of a specific Logix Designer 
tag instance when configuring bindings and expressions on the screen.  

To pass the correct tag context to use at runtime, create a navigation 
event or a shortcut to the screen. This enables using a screen multiple 
times by passing different values to the user-defined properties through a 
shortcut or navigation command.  

See also 
Create an alias property on page 361 

Create a user-defined property with a data type on page 365 

User-defined property on page 370 

Assume a plant that has three tanks making soda and requires: 

• One screen that provides an overview of the plant showing all 
three tanks.  

• Screens that show details for each individual tank.  
Creating one tank detail screen, duplicating it three times, and changing 
all the tag bindings on the screen for each screen would require: 

Reuse screens and popups 

Example of content reuse 



Chapter 12  Reuse content 
 

360 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

• Additional time. 
• Extra memory for four screens.  
• Additional maintenance because adding or removing any element 

requires modifying all of the detail screens.  
Using View Designer requires only: 

• One overview screen that displays all of the tanks. 
• One tank detail screen reused to display information for each tank 

on request. Changes to the screen design requires changing only 
one screen. 

The tank detail screen essentially acts as a template. Create 
user-defined properties to act as placeholders for the values or data to 
pass to the template screen. Pass values into the reusable screen 
through two different types of properties:  

• An alias property that references an existing property of the screen 
and its content.  

• A data type property that is tied to a specific data type of a 
controller tag, such as a DINT, REAL, or a Logix Designer 
user-defined data type. For example, create a Logix Designer 
user-defined data type called Tank that has members 
representing all the data for a tank. The data type properties are 
used in place of a specific Logix Designer tag instance when you 
configure bindings and expressions on the screen.   

A user-defined property is a property of the screen. Screen properties 
appear on the Property Definition tab.  

To pass the correct tag context to use at runtime, use a Navigation event 
or a shortcut. For example, create three shortcuts to the tank detail 
screen. The first shortcut provides the values specific to tank 1, the 
second for tank 2, and the third for tank 3.  

On each shortcut, bind the user-defined properties to the appropriate 
Logix tags to provide values to the reusable screen.  

On the HMI device, the shortcuts appear as icons on the Navigation 
menu. Pressing the tank 1 screen icon opens the tank detail screen. The 
values for the tank 1 screen properties are passed to the screen. 

In addition to passing tag values from the controller to a screen, pass the 
values of non-alias screen properties from one screen to non-alias 
screen properties of another screen with each target screen acting on the 
data associated with its source screen. In other words, chain reusable 
screens together by passing tag values to the first screen, which are then 
passed to subsequent screens.  

IMPORTANT • Chaining alias properties together is not recommended. 
• Binding the property of a graphic element in a Navigation event displays the property 

value of the graphic element from the target screen. It does not display the property 
value of the graphic element from the source screen. Passing properties of graphic 
elements between screens is not supported.  

The same principle applies to reusing popups. To pass the correct tag 
context to use at runtime, create a Navigation event with a Popup Open 
command.  
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See also 
Property Definition tab on page 361 

User-defined property on page 370 

Shortcut customization on page 107 

Data Type Browser on page 373 

How do I open the Property Definition tab? 

The Property Definition tab is located below the Screen area. Click 
Expand  below the screen to display the Property Definition tab if it 
is not open. 

The Property Definition tab contains the properties you create for the 
current screen, popup, or Add-On Graphic definition. Create a 
user-defined property to act as a placeholder for a value or data on a 
screen, Add-On Graphic definition, or popup. This enables you to use a 
screen multiple times by passing different values to the user-defined 
properties using a shortcut or navigation command.  

Using custom properties in View Designer increases the time it takes 
PanelView 5000 HMI devices to synchronize with changes to the 
controller program. When using custom properties in View Designer, 
expect increased synchronization time when downloading a revised 
controller program to the controller or making online changes to the 
controller program. 

Use the Property Definition tab to create, change, or delete a 
user-defined property. 

See also 
Create a user-defined property with a data type on page 365 

Search for and select a data type on page 373 

User-defined property on page 370 

Reuse Add-On Graphics on page 402 

Create an alias property to create a reference to a property contained in 
a screen, popup, or Add-On Graphic definition. At runtime, when the 
screen or popup displays as a result of a navigation event or shortcut, the 
value of the referenced property is passed to the aliased property on the 
screen or popup. Alias property values for an instance of an Add-On 
Graphic are passed to the definition of the Add-On Graphic. Alias 
property values for an instance of an Add-On Graphic are not passed 
through a navigation event or to a shortcut unless the the alias property 
values are aliased on the screen that contains the Add-On Graphic 
instance. It is recommended to have no more than 20 alias and 
user-defined properties defined for an Add-On Graphic. 

Property Definition tab 

Create an alias property 
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To create an alias property 
1. Select the screen, popup, or Add-On Graphic definition that 

contains the property to alias. 

 
Tips:  
• Aliased properties do not appear on the Properties tab of the definition of an Add-On Graphic. 

Aliased properties appear only on the Properties tab of an Add-On Graphic instance.  
• Creating an alias on a screen for a user-defined data type property of an Add-On Graphic instance 

is not supported.  
• Create an alias on a screen for a user-defined alias property of an Add-On Graphic instance. 

2. In the Properties tab, right-click the property and select New 
Alias. The new property appears on the Property Definition tab 
below the screen. Edit the name and description of the property. 

 
Tip: Creating more than one alias for the same property of a graphic element is not 
supported. 

3. (optional) Click in the Category column for the property and select 
the category of the new property. 

 
Tips:  
• As an alternative, create a new category by typing a unique name in the Category column. Category 

names are not case-sensitive.  
• The new property appears in the Properties tab for the screen, not the graphic element. 
• User-defined properties appear in the Properties tab for the instances of the Add-On Graphic 

within a project, not within the definition of the Add-On Graphic. Change values for user-defined 
properties for an instance of an Add-On Graphic. Changing values for a user-defined property 
within the definition of the Add-On Graphic is not allowed. 

After creating the alias properties, configure the runtime implementation. 
Use shortcuts or navigation commands, such as Navigate To and Open 
Popup, to define the appropriate tag instances to use. Define tag 
instances for the alias properties of an Add-On Graphic instance added 
to the screen.   

See also 
Property Definition tab on page 361 

Properties that do not support aliasing on page 362 

User-defined property on page 370 

Example of content reuse on page 359 

Alias a property in an Add-On Graphic on page 412 

Certain objects have properties that do not support aliasing: 

Object Properties 

Add-On Graphic • Category 
• Description 
• Extended 
• Icon 
• Major 
• Minor 
• Note 
• Vendor 

Alarm table • Icon 
• SelectedAlarmName 
• ShowDefaultBanner 

Properties that do not 
support aliasing 
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Object Properties 

Banner • FillColor 
• Height 

Popup • BackgroundOpacity 
• Caption 
• CaptionVisible 
• CloseVisible 
• Height 
• Width 

Screen and shortcut • Icon 
• ShowDefaultBanner 

Trace • Label 
• Color 
• Marker 
• Width 

Trend chart • TimeSpan 
• SampleRate 
• GridColor 
• AxesColor 
• ShowGridVertical 
• ShowGridHorizontal 
• ShowAxes 
• ShowButtons 

See also 
Property Definition tab on page 361 

Create an alias property on page 361 

User-defined property on page 370 

Example of content reuse on page 359 

User-defined alias type 
property binding 
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In this example, alias properties on the screen appear in each shortcut. 
Entering a value or binding changes the value of the aliased property in 
the shortcut on the HMI device.  

 

 Add-On Graphic definition 
Item Description 
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A user-defined alias property for the screen which includes:  
• Name. The name of the alias. By default, the name of the alias property in the 

Property Definition tab is the name of the property appended with _001 or increment 
number. Type the name of the property to appear in the Properties window for the 
screen and any shortcut.     

• Alias For. Automatically specifies the selected graphic element name and property. 
The format for the alias is ElementName.PropertyName. For example, if the selected 
graphic element is a mixing hopper and the aliased property is LevelColor, the Alias 
For column may contain MixingHopperSide_001.LevelColor.  

• Description. An optional description for the alias property. Type a description to 
appear as a tooltip when hovering over the box in the Properties window. 

• Category. The category where the alias property appears in the Properties window. 

 
Alias properties. In this example, the alias properties are Level_001, LevelColor_001, and 
Text_001. Create an alias property by right-clicking the property and selecting New 
Alias. The alias property appears in the Property Definition tab below the screen.  

 Shortcuts 
Item Description 

 
The Properties window for a shortcut. The Level_001 alias is bound to the level of the 
mixer. The LevelColor_001 alias is burgundy. The Text_001 alias labels Mixer 1.  

 
The Properties window for a second shortcut. The Level_001 alias is bound to the level 
of mixer 2. The LevelColor_001 alias is purple. The Text_001 alias labels Mixer 2.  

See also 
Property Definition tab on page 361 

Create an alias property on page 361 

Properties that do not support aliasing on page 362 

User-defined property on page 370 

Create a user-defined property with a data type so that you can modify 
your screen, Add-On Graphic definition, or popup contents using a 
specific type of tag in your Logix Designer project (.acd) file. When the 
screen, instance of the Add-On Graphic, or popup displays as a result of 
a navigation event or shortcut, the value of a tag of the specified type is 
passed to the data type property on the screen. Add-On Graphic 
instance, or popup. It is recommended to have no more than 20 alias and 
user-defined properties defined for an Add-On Graphic.  

User-defined properties are stored in the Property Definition tab and 
become properties of the screen. 

IMPORTANT To avoid confusion, do not create a user-defined property with the same name as a 
property of a graphic element on the screen. Using a user-defined property name in an 
expression or binding in a graphic element containing a property with the same name, 
causes that the expression or binding uses the value of the graphic element property, 
not the value of the user-defined property. 

Create a user-defined 
property with a data type 
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To create a user-defined property with a data type: 
1. Select the screen for which you want to create a data type 

property. 
2. In the Name box of the Property Definition tab, type a name for 

the property. 
• Click Expand  below the screen to display the Property 

Definition tab if it is not open. 
3. Click in the Data Type box and click Browse  to select a data 

type: 
• User-Defined. A structure data type that you defined in Logix 

Designer. 
• Predefined. An atomic or structure data type that is defined by 

the controller.  
• Module-Defined.  A structure data type defined by a module 

when you create it. Tags of these types are created to store 
input, output, and configuration data for the module. 

The data type you select is used as a filter criteria for the Tag 
Browser. Only items in the Logix Designer project (.acd) file that 
meet the filter criteria appear when you open the browser. 

4. (optional) In the Description column, enter a description for the 
property. 
Tips: • As an alternative, you can create a new category by typing a name in the 

Category column. Category names are not case-sensitive. For example, 
you cannot have a General category and a general category. 

• The new property appears in the Properties tab for the screen, not the 
graphic element. 

• User-defined properties that you create appear in the Properties tab for 
the instances of the Add-On Graphic within a project, not within the 
definition of the Add-On Graphic. You can change values for user-defined 
properties for an instance of an Add-On Graphic. You cannot change 
values for a user-defined property within the definition of the Add-On 
Graphic.  

See also  
Property Definition tab on page 361 

User-defined property on page 370 

Example of content reuse on page 359 

Create a user-defined data type property for an Add-On Graphic 
on page 378 

Bind properties of graphic elements to properties of other graphic 
elements in an Add-On Graphic on page 403 

User-defined data type 
property binding 
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This example depicts a mixer graphic with a level property bound to a 
user-defined data type property of the screen. It shows how a shortcut of 
the screen passes the controller tag to the user-defined data type 
property on the screen. The data type and member specified on the 
screen show the value on the shortcuts on the HMI device.  

 
 

 Screen 
Item Description 
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A user-defined data type property for the screen. User-defined data type properties and 
their members appear in the Tag Browser when browsing for tags on a screen. 
User-defined data type properties include: 
• Name. The name of the user-defined property. In this example, the name of the 

user-defined property is MixerTag. 
• Data Type. The data type of the user-defined property. This is the data type in the 

controller. Select the Data Type cell to select Browse  and navigate to the 
controller and data type. In this example, the data type is Mixer.  

• Description. An optional description for the user-defined property. This description 
appears as a tooltip when hovering over the property in the Properties window. 

• Category. The category where the user-defined property appears in the Properties 
window. 

 
The binding for a selected graphic element. When creating the binding, type or browse 
to the name of the user-defined data type property and the member of a tag in the data 
type. In this example, the member is the Level. The value of the level shows on the HMI 
device. 

 Shortcuts 
Item Description 

 
The Properties window for Mixer_001 in a shortcut. The user-defined data type property 
on the shortcut is bound to the Mixer1 tag The Mixer1 tag is passed to the screen. The 
Level member applied to the graphic element then shows the level for Mixer1 on the HMI 
device.   

 
The Properties window for Mixer_002 in a shortcut. The user-defined data type property 
on the shortcut is bound to the Mixer2 tag. The Mixer2 tag is passed to the screen. The 
Level member applied to the graphic element then shows the level for Mixer2 on the HMI 
device.    

 HMI device 
Item Description 

 
The shortcut on the HMI device that shows the level of Mixer1.  

 
The shortcut on the HMI device that shows the level of Mixer2.  

See also 
Reuse screens and popups on page 359 

Create a user-defined property with a data type on page 365 

Property Definition tab on page 361 

User-defined property on page 370 

After creating a user-defined property, it appears on the Property 
Definition tab and the Properties tab for the screen or popup. User 
defined properties created for the definition of an Add-On Graphic 
appear on the Properties tab for an instance of the Add-On Graphic. 
Use the Property Definition tab to change the definition of a 
user-defined property. Use the Properties tab to change the value of a 
user-defined property rather than the property itself. 

Change a user-defined 
property 
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To change a user-defined property 
1. Select the screen, Add-On Graphic definition, or popup that 

contains the user-defined property to change. 
2. Make changes to the property: 

• Use the Property Definition tab to change the Name, Data 
Type, Description, or Category of the user-defined property. 

• Use the Properties tab to change the value or binding. 
Changes to user-defined properties take effect immediately and 
are saved when the project is saved. 

 
Tip: A value or binding for an Add-On Graphic cannot change on the Properties tab for the 
definition of an Add-On Graphic. Change a value or binding for an instance of the Add-On 
Graphic on the Properties tab. 

See also  
Property Definition tab on page 361 

Create a user-defined property with a data type on page 365 

Delete a user-defined property on page 370 

User-defined property on page 370 

Remove a binding on page 513 

Changes to user-defined properties take effect immediately and are 
saved when the project is saved. How changes to user-defined 
properties are propagated depend on the item for which the user-defined 
property is created:  

Add-On Graphics 
• Changing the name of a user-defined property for an Add-On 

Graphic changes the name of the property in every instance of the 
Add-On Graphic. The names of properties in bindings and 
expressions do not change.  

• Changes made to the definition of a user-defined property for an 
Add-On Graphic definition are applied to any instances of the 
Add-On Graphic.  

• Changing the value of an alias property on an instance of an 
Add-On Graphic disconnects the property from the user-defined 
property on the definition of the Add-On Graphic. To reconnect the 
user-defined property to the base property, select Link  next to 
the property in the Properties tab. User-defined data type 
properties are always unlinked for an Add-On Graphic. 

Screens 
• Changing the name of a user-defined property changes the 

property name for the current screen only. Changing the property 
name for a screen or shortcut does not change the name of the 
property in all of the places that property name is used in the 

Propagation of changes to a 
user-defined property 
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project. The names of properties in bindings and expressions do 
not change.  

• Changes made to a user-defined property on a screen are applied 
to any shortcuts on which the shortcut is based. 

Shortcuts and events 
• Changing the value of a user-defined property on a shortcut or 

navigation command disconnects the user-defined property from 
its base property.  

• Binding an alias property or aliasing a bound property for a graphic 
element within the definition of an Add-on Graphic is not 
supported.  

See also 
Change a user-defined property on page 368 

Create a user-defined property with a data type on page 365 

Create an alias property on page 361 

Create a user-defined data type property for an Add-On Graphic 
on page 378 

Alias a property in an Add-On Graphic on page 412 

Deleting a user-defined property deletes it from the project and all 
commands or screen shortcuts with which it is associated. 

To delete a user-defined property 
1. Select the screen, popup, or Add-On Graphic definition that 

contains the user-defined property. 
2. In the Property Definition tab below the open screen, select the 

box to the left of the property.  

• To select all of the properties in the table, select Select All . 
3. Right-click and select Delete Selected Row(s).  

See also 
Property Definition tab on page 361 

Create an alias property on page 361 

Create a user-defined property with a data type on page 365 

User-defined property on page 370 

Example of content reuse on page 359 

Create a user-defined property to act as a placeholder for a value or data 
on a screen, popup, or Add-On Graphic definition. This enables using a 

Delete a user-defined 
property 

User-defined property 



Chapter 12  Reuse content 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 371 
 

screen multiple times by passing different values to the user-defined 
properties using a shortcut or navigation command.  

There are two types of user-defined properties: 

• Alias. Create an alias property to reference the property of a 
screen or definition of an Add-On Graphic, or the property of a 
graphic element. The alias name is comprised of the element 
name and the specific property to expose separated by a period: 
ElementName.PropertyName 
Using an alias property in an expression is not supported. 

• Data type. Create a user-defined property with a data type to 
associate it with a data type contained in a Logix Designer project 
(.acd) file. Data type properties replace a specific Logix Designer 
tag instance when configuring bindings and expressions on the 
screen. The data type is Predefined, Module-defined, or 
User-defined (UDT). 

See also 
Property Definition tab on page 361 

Create an alias property on page 361 

Create a user-defined property with a data type on page 365 

Example of content reuse on page 359 

Reuse Add-On Graphics on page 402 

A user-defined property on a: 

• screen shortcut 
• Screen Navigate command 
• Button Behavior event that navigates to a screen on a release 
• Popup Open command 

inherits its value from a base property.The base property is the property 
as defined on the screen or popup called by the shortcut or navigation 
command. 

 Link  next to a property in the Properties tab indicates that the value 
of the property is linked to its associated base property. If Unlink  is 
displayed, the property is unlinked from the base property and is no 
longer inheriting the value of the base property. 

To link a user-defined property to its base property 
• Next to the property in the Properties tab, select Unlink  and 

select Link to base property. Link  appears, and the screen 
property inherits the value of the base property.  

Link a user-defined 
property to its base 
property 
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Tips: • If you create a screen navigation to a shortcut, you create a link to the property on the shortcut, 
not to the base property. 

• The Border property does not support linking and unlinking. 
• User-defined data type properties are always unlinked for an Add-On Graphic. User-defined 

properties on an instance of an Add-On Graphic cannot link to the definition of the Add-On 
Graphic because there is no default value for the user-defined property on the definition.  

See also 
Property Definition tab on page 361 

Unlink a user-defined property from its base property on page 372 

Create an alias property on page 361 

Create a user-defined property with a data type on page 365 

Shortcut customization on page 107 

A user-defined property on a: 

• screen shortcut 
• Screen Navigate command 
• Button Behavior event that navigates to a screen on a release 
• Popup Open command 

inherits its value from a base property.The base property is the property 
as defined on the screen or popup called by the shortcut or navigation 
command. 

 Link  next to a property in the Properties tab indicates that the value 
of the property is linked to its associated base property. If Unlink  is 
displayed, the property is unlinked from the base property and is no 
longer inheriting the value of the base property. 

To unlink a user-defined property from its base property 
• Use one of the following methods: 

• Next to the property in the Properties tab, select Link  and 
select Unlink from base property. Unlink  appears and the 
screen property no longer inherits the value of the base 
property. 

• Change the value of the linked property. 
• Change the binding status of the linked property from bound to 

unbound or vice versa. 
• If the property is bound, change the Initial value or the Binding 

value of the property. 

 
Tip: The Border property does not support linking and unlinking. 

See also 
Property Definition tab on page 361 

Link a user-defined property to its base property on page 371 

Unlink a user-defined 
property from its base 
property 
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Create an alias property on page 361 

Create a user-defined property with a data type on page 365 

Shortcut customization on page 107 

Create a user-defined property with a data type so that you can modify a 
screen or  popup contents using a specific type of tag in your Logix 
Designer project (.acd) file. 

Use the Data Type Browser in the Property Definition tab to search for 
and select a data type to associate with a user-defined property.  

See also 
Example of content reuse on page 359 

Create a user-defined property with a data type on page 365 

Search for and select a data type on page 373 

Property Definition tab on page 361 

User-defined property on page 370 

How do I open the Data Type Browser? 

In the Property Definition tab, click in the Data Type box and click 
Browse . 

 

Use the Data Type Browser in the Property Definition tab to search for 
and select a data type to associate with a user-defined property.  

The Data Type Browser uses the data type you select as a filter criteria 
for the Tag Browser. When you open the Tag Browser to select an item 
to bind to the user-defined property, it displays only the items in the 
referenced Logix Designer project (.acd) file that meet the data type filter 
criteria.  

See also 
Search for and select a data type on page 373 

Create a user-defined property with a data type on page 365 

Property Definition tab on page 361 

Use the Data Type Browser in the Property Definition tab to search for 
and select a data type to associate with a user-defined property.  

The Data Type Browser uses the data type you select as a filter criteria 
for the Tag Browser. When you open the Tag Browser to select an item 
to bind to the user-defined property, it displays only the items in the 
referenced Logix Designer project (.acd) file that meet the data type filter 
criteria.  

Select a data type 

Data Type Browser 

Search for and select a 
data type 
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Prerequisites 
• On the Project Properties dialog box, verify that the View 

Designer project references the Logix Designer project file (.acd) 
that contains the tags to use. 

To search for and select a data type 
1. Select a screen, popup, or the definition of an Add-On Graphic.  
2. On the Property Definition tab, type a property name, select the 

Data Type box, and select Select data type  to open the Data 
Type Browser. The Data Type Browser displays the result the 
last browsing session. 

3. Select the drill-in arrow  next to the desired Data Types 
category.  

4. Expand a controller to the desired level and browse to the data 
type.   

5. Double-click the data type to select it and close the Data Type 
Browser. 

 
Tips:  
To use Search to search for a data type: 
• In the Search box, type a keyword and press Enter. Search text can contain alphanumeric 

characters and can be full words, fragments of a word, or a single letter or number. The Data Type 
Browser searches the Name and Description columns. 

• Use operators to narrow the search. Type one or more operators with the keywords. Entering a 
search string in the Search box displays results in the Data Type Browser without pressing Enter. 

• Use one or more filters to narrow the search. Select to display the filters. Select a filter name 
to add it to the search box and type the keyword or keywords.  

• Combine operators and filters. For example: n:BOOL AND l:::Plant_1 returns a 
list of data types named BOOL located in controller ::Plant_1. 

• Select the down arrow on the right side of the Search box to see a list of previous searches. Select 
a search to add it to the Search box. 

• In the results window, start typing the name of the data type. If a data type by that name exists, the 
browser navigates to the relevant row. 

• The Location column only appears in the results window. 
• The Location filter is not available when browsing at the controller level.  

See also 
Data Type Browser on page 373 

Data Type Browser operators 

Data Type Browser filters 

User-defined property on page 370 

Tag Browser 

View Designer supports the following Logix data types: 

 

• DT (Date/Time) - is a 64-bit data type. It provides information in 
microseconds for the DateTime Display control. 

• LDT (Long Date/Time) - is a 64-bit data type. It provides 
information in nanoseconds for the DateTime Display control. 

Logix Datatype 
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• LTime - is a 64-bit data type. It provides information about the 
duration of an event or between events in nanoseconds for the 
Numeric Input and Numeric Display controls. 

• Time - is a 64-bit data type. It provides information about the 
duration of an event or between events in microseconds for the 
Numeric Input and Numeric Display controls. 

• Time32 - is a 32-bit data type. It provides information about the 
duration of an event or between events in microseconds for the 
Numeric Input and Numeric Display controls. 

You can check the data on a main display or in more detail (every bit) by 
unfolding the chosen row. 

 

Create Add-On Graphics to: 

• Create custom graphic elements. 
• Combine graphic elements into a single graphic element.  
• Ensure consistency for all instances by changing the definition 

from one location. 
• Reuse graphic elements through user-defined properties. 

Add-On Graphics are self-contained graphics elements. From within the 
definition of an Add-On Graphic, bind to the properties of graphic 
elements in that definition. Add-On Graphics do not support adding 
graphic elements that have internal tag bindings to controller tags.  

The predefined PDF_Viewer_Landscape and PDF_Viewer_Portrait 
Add-On Graphics in Project Explorer display, zoom, and navigate a 
PDF document on the HMI device. 

Functionality within the definition of an Add-On Graphic is the same as 
any screen. The functionality of an instance of an Add-On Graphic is the 
same as any graphic element. 

See also 
Create an Add-On Graphic on page 375 

Change the definition of an Add-On Graphic on page 386 

Work with instances of an Add-On Graphic on page 394 

Reuse Add-On Graphics on page 402 

Create an Add-On Graphic to create a custom graphic element. Add-On 
Graphics are empty by default. Add graphic elements to the definition of 
an Add-On Graphic like any other other screen or popup. View Designer 
does not allow adding another Add-On Graphic to the definition of an 
Add-On Graphic.  

To create an Add-On Graphic 
1. In the Project Explorer, expand the Assets folder. 

Add-On Graphics 

Create an Add-On Graphic 
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2. Right-click the Add-On Graphics folder and select New Add-On 
Graphic. An initial Add-On Graphic named AddOnGraphic_001 
appears.  

3. Type a new name for the Add-On Graphic: 
• The name must not exist for another Add-On Graphic in the 

Add-On Graphics folder.  
• The name must contain only numbers, letters, and underscores.  

4. The name must not begin with a number, contain spaces, have 
more than one underscore in a row, or end with an 
underscore.Press Enter. 

 
Tips:  
• Add-On Graphics appear alphabetically in the Add-On Graphics folder in the Project Explorer. 

Renaming or deleting the Add-On Graphics folder from the Project Explorer is not allowed. 
• Properties for the definition of the Add-On Graphic appear in the Properties window. 
• Add-On Graphics appear in the Toolbox in the Add-On Graphics category.  
• To add content to an Add-On Graphic, double-click to open the Add-On Graphic, and then add 

graphic elements to the definition of the Add-On Graphic as if it were any other screen. 

See also  
Change the property values for the definition of an Add-On 
Graphic on page 376 

Rename an Add-On Graphic on page 380 

Change the definition of an Add-On Graphic on page 386 

Work with instances of an Add-On Graphic on page 394 

Reuse Add-On Graphics on page 402 

Change the property values for the definition of an Add-On Graphic. All 
properties for the definition of an Add-On Graphic are optional.  

To change the property values for the definition of an Add-On 
Graphic 

1. If the definition of the Add-On Graphic is open, select the 
background of the Add-On Graphic. 

2. In the Properties window, change the property values. 

 
Tip: In the Project Explorer, expand the Assets and Add-On Graphics folders to navigate to and 
select the Add-On Graphic. 

See also 
Change the vendor of an Add-On Graphic on page 377 

Change the revision information of an Add-On Graphic on page 
377 

Change the definition of an Add-On Graphic on page 386 

Change the property values 
for the definition of an 
Add-On Graphic 
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Change the vendor of an Add-On Graphic to change the name of the 
company that owns the Add-On Graphic.  

To change the vendor of an Add-On Graphic 
1. In the Project Explorer, expand the Assets and Add-On 

Graphics folders to navigate to and select the Add-On Graphic.  

 
Tip: If the definition of the Add-On Graphic is open, you can select the background of the 
Add-On Graphic. 

2. In the Properties window, expand the General category. 
3. In the Vendor box, type the name of the company that owns the 

Add-On Graphic.  

See also 
Change the revision information of an Add-On Graphic on page 
377 

Change the property values for the definition of an Add-On 
Graphic on page 376 

Rename an Add-On Graphic on page 380 

Change the definition of an Add-On Graphic on page 386 

Change revision information to track changes made to the definition of 
an Add-On Graphic. Change version numbers to indicate major and 
minor changes. For example, 2.1 may indicate a first minor change to a 
second major revision of an Add-On Graphic. Change extended 
information to include information, such as the validation state of an 
Add-On Graphic, or a note that describes the differences between 
versions of the Add-On Graphic. 

To change the revision information of an Add-On Graphic 
1. In the Project Explorer, expand the Assets and Add-On 

Graphics folders to navigate to and select the Add-On Graphic.  

 
Tip: If the definition of the Add-On Graphic is open, you can select the background of the 
Add-On Graphic. 

2. In the Properties window, expand the Revision category. 
3. Change the following revision information: 

• Major. Type a number between 0 and 65535 for the major 
version of the Add-On Graphic. Change the version number 
when major changes are made to the definition of the Add-On 
Graphic. For example, change the major version when 
additional graphic elements are added to the definition of the 
Add-On Graphic. 

• Minor. Type a number between 0 and 65535 for the minor 
version of the Add-On Graphic. Change the version number 
when minor changes are made to the definition or contents of 
the Add-On Graphic. For example, change the minor version 
when property values are changed for the existing definition of 
the Add-On Graphic. 

Change the vendor of an 
Add-On Graphic 

Change the revision 
information of an Add-On 
Graphic 
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• Extended. Type any additional information about the revision of 
the Add-On Graphic. For example, enter the validation state of 
the definition of the Add-On Graphic. Pasting text in this field 
causes any line breaks of the pasted text to appear as spaces. 

• Note. Type a single paragraph description of the differences 
between revisions of the Add-On Graphic. For example, 
describe a change in tag type for a graphic element in the 
definition of the Add-On Graphic.   

See also 
Change the property values for the definition of an Add-On 
Graphic on page 376 

Change the vendor of an Add-On Graphic on page 377 

Rename an Add-On Graphic on page 380 

Change the definition of an Add-On Graphic on page 386 

Create a user-defined data type property to bind an Add-On Graphic to a 
controller tag. An Add-On Graphic element cannot bind directly to a 
controller tag because different projects may not reference the same 
controllers. View Designer allows reusing Add-On Graphics between 
projects.  

To create a user-defined data type property for an Add-On Graphic 
1. In the Property Definition tab of the Add-On Graphic, type a 

name for the user-defined property in the Name box. 

 
Tip: If the Property Definition tab is not open, below the screen, click Expand . 

2. Click in the Data Type box and click Select data type . The 
Data Type Browser opens. 

3. Select a data type:  
• User-Defined. A structure data type defined in Logix Designer. 
• Predefined. An atomic or structure data type defined by a 

controller.  
• Module-Defined. A structure data type defined by a module 

when creating the module. Tags of these types store input, 
output, and configuration data for the module. 

The data type is used as a filter criteria for the Data Type 
Browser. Only items in the Logix Designer project (.acd) file that 
meet the filter criteria appear when opening the Data Type 
Browser. 

4. Click the drill-in arrow  next to a controller.  
5. Navigate to the desired level in the controller and select the data 

type. 
6. (optional) In the Description column, type a description for the 

property to appear when hovering over the property on the 
Properties window. 

Create a user-defined data 
type property for an Add-On 
Graphic 
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7. In the Category column, type the category where the property 
appears in the Properties window for an instance of the Add-On 
Graphic.  

8. Select a graphic element in the definition of the Add-On Graphic.  
9. To bind a property of the selected graphic element, click Browse 

 to browse to a data type property.  
10. Click the drill-in arrow  to select the member of the property. 

 
Tips:  
• Selecting a user-defined data type displays all of the members within the property and any nested 

properties. Expand a nested user-defined data type to display all of the members of the nested 
data type.   

• To type the binding instead of browsing to it, use the format: 
PropertyName.Member 
For example, if the user-defined data type property is named MixerTag and the data type in the 
controller has a Level member that is the value to show, type MixerTag.Level. 

See also 
Reuse Add-On Graphics on page 402 

Bind properties of graphic elements to properties of other graphic 
elements in an Add-On Graphic on page 403 

User-defined data type property binding for an Add-On Graphic on 
page 410 

Property Definition tab on page 361 

User-defined property on page 370 

Delete an Add-On Graphic from a project to no longer add it to a screen 
or popup. It is not possible to undelete an Add-On Graphic.   

Prerequisites 
• Delete all instances of the Add-On Graphic in the project. If the 

Add-On Graphic is used in the open project, it appears in the 
Graphic Explorer. 

To delete an Add-On Graphic from a project 
1. In the Project Explorer, open the Assets and Add-On Graphics 

folders to navigate to the Add-On Graphic.  
2. Right-click the Add-On Graphic and select Delete. The Add-On 

Graphic is removed from the project. 

 
Tip: If the Add-On Graphic is currently used in the project, a warning message appears 
indicated that the Add-On Graphic cannot be deleted. Delete all instances of the Add-On 
Graphic in the project and then delete the Add-On Graphic from the Project Explorer. 

See also 
Rename an Add-On Graphic on page 380 

Create an Add-On Graphic on page 375 

Delete an Add-On Graphic 
from a project 
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Change the definition of an Add-On Graphic on page 386 

Rename an Add-On Graphic when the definition or purpose of the 
Add-On Graphic changes. For example, if an Add-On Graphic with a 
single tank for a beverage line now contains two tanks, change the name 
from Single_Tank to Double_Tank. Changing the name of an Add-On 
Graphic does not break the link to any instances of the Add-On Graphic.  

To rename an Add-On Graphic 
1. In the Project Explorer, expand the Assets and Add-On 

Graphics folders and then navigate to select the Add-On 
Graphic. 

2. Select the Add-On Graphic to select the item. 
3. Select the item again and type the new name. 

 
Tips:  
• Rename an Add-On Graphic by right-clicking the name and selecting Rename. Then type a new 

name and press Enter. 
• To rename the Add-On Graphic, type a new name in the Name box of the Properties window.  
• The name must not exist for another Add-On Graphic in the Add-On Graphics folder.  

4. Press Enter. 

See also 
Change the property values for the definition of an Add-On 
Graphic on page 376 

Delete an Add-On Graphic from a project on page 379 

Change the definition of an Add-On Graphic on page 386 

Copy the definition of an Add-On Graphic to reuse the Add-On Graphic 
within the same project. The properties and behavior of the Add-On 
Graphic are copied. Copying the definition of an Add-On Graphic allows 
for the creation of additional versions of the Add-On Graphic. Change the 
property values and behavior of the copied definition.  

Add-On Graphics must have unique names. When copying the definition 
of an Add-On Graphic within a project, an increment number is appended 
to the name of the copied definition. The content of the Add-On Graphic 
is handled in the same manner. 

To copy the definition of an Add-On Graphic within a project  
1. In the open project in the Project Explorer, expand the Assets 

folder. 
2. Expand the Add-On Graphics folder.  
3. Right-click the Add-On Graphic and select Copy.  
4. Right-click the Add-On Graphics folder in the Project Explorer 

and then select Paste.  

Rename an Add-On Graphic 

Copy the definition of an 
Add-On Graphic within a 
project 
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Tips:  
• Pasting the definition of an Add-On Graphic that has a name that already exists increments the 

name of the copied definition with _001 or increment number.  
• Copying the definition of an Add-On Graphic that contains an image increments the name of the 

Add-On Graphic but does not create a new image. 

5. Change the properties and behavior of the copied Add-On Graphic 
to create a new version of the Add-On Graphic.  

See also 
Copy the definition of an Add-On Graphic between projects on 
page 381 

Change the property values for the definition of an Add-On 
Graphic on page 376 

Rename an Add-On Graphic on page 380 

Copy the definition of an Add-On Graphic between projects to reuse the 
Add-On Graphic in another project. The content, properties, and 
behavior of the Add-On Graphic definition are copied. Any changes to 
the definition of the Add-On Graphic are copied to every instance of the 
Add-On Graphic in the project.  

Add-On Graphics must have unique names. When copying the definition 
of an Add-On Graphic with the same name between projects, keep both 
Add-On Graphic definitions, replace the existing Add-On Graphic 
definition, or choose not to paste the Add-On Graphic definition.  

Contents of the Add-On Graphic are handled in the same manner as the 
contents of any other screen copied between projects.  

To copy the definition of an Add-On Graphic between projects  
1. Open the project containing the Add-On Graphic to copy. 
2. In the Project Explorer, expand the Assets folder. 
3. Expand the Add-On Graphics folder.  
4. Right-click the Add-On Graphic to copy and select Copy.  
5. Open the project where to contain the pasted Add-On Graphic. 
6. In the Project Explorer, expand the Assets folder. 
7. Expand the Add-On Graphics folder.  
8. Right-click the Add-On Graphics folder and select Paste. 

If a definition of an Add-On Graphic with the same name does not 
already exist in the project, the definition appears in the folder and 
the Add-On Graphic appears in the Toolbox. 

9. Pasting the definition of the Add-On Graphic in a different project 
where an Add-On Graphic definition with the name already exists 
displays options:  
• Keep Both. Append the name of the copied Add-On Graphic 

definition with _001 or increment number. The definition 
appears in the folder and the Add-On Graphic appears in the 
Toolbox.  

• Replace. Replace the existing Add-On Graphic definition with 
the copied definition. Any instances of the existing Add-On 

Copy the definition of an 
Add-On Graphic between 
projects 
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Graphic are updated with the new definition of the Add-On 
Graphic.  

• Cancel. Do not paste the copied Add-On Graphic definition into 
the project. 

 
Tips:  
• Replacing an alias property in the definition of an Add-On Graphic as a result of a paste when that 

alias is linked in an instance displays the alias property in the Properties window of the instance. 
The alias remains linked to the value of the base property in the definition.  

• Replacing an alias property in the definition of an Add-On Graphic as a result of a paste when that 
alias is unlinked in an instance displays the alias property in the Properties window of the 
instance. The alias property retains its value from the original Add-On Graphic definition. The value 
of the alias property is not linked to the base property of the pasted Add-On Graphic definition.  

• Copying the definition of an Add-On Graphic that has an image that exists in both the source and 
target projects displays a prompt to replace the image or cancel. Images in a copied Add-On 
Graphic appear in the Assets > Images folder of the Project Explorer. 

The Add-On Graphic is available for use in the project.  

See also 
Work with instances of an Add-On Graphic on page 394 

Copy the definition of an Add-On Graphic within a project on page 
380 

Change the property values for the definition of an Add-On 
Graphic on page 376 

Rename an Add-On Graphic on page 380 

If the copied definition of the Add-On Graphic contains an image that 
already exists in the target project, replace the image in the target project 
or cancel. 

Copying the definition of an Add-On Graphic that has an image file that 
already exists in the target project, but with a different image, adds an 
increment number to the name of the image in the target project. For 
example, if copying the definition of an Add-On Graphic that has an 
image named Tank1 and that image contains tank.bmp, and the target 
project also has an image file named Tank1 but that image contains 
watertank.bmp, the name of the image in the target project is 
incremented to Tank1_001.  

Not replacing an image in the Add-On Graphic in the target project copies 
the Add-On Graphic to the target project, but an empty image appears on 
the canvas of the definition of the Add-On Graphic.  

See also 
Copy the definition of an Add-On Graphic between projects on 
page 381 

Copy an image between View Designer projects on page 324 

Reuse of images in an 
Add-On Graphic between 
projects 
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User-defined properties are copied with the definition of an Add-On 
Graphic when copying the definition to another project. The user-defined 
properties of the source Add-On Graphic replace the user-defined 
properties of the target Add-On Graphic.  

If the definition of an Add-On Graphic contains a certain user-defined 
property, replacing that definition with a version that does not contain that 
same user-defined property removes the property from the definition and 
any instances of the Add-On Graphic. The property does not exist in the 
Property Definition tab for the definition of the Add-On Graphic. The 
property values and any bindings or expressions for that property no 
longer exist in the Properties window for instances of the Add-On 
Graphic.  

If the definition of an Add-On Graphic does not contain a user-defined 
property, replacing that definition with a version that does contain the 
user-defined property adds that property to the definition and instances of 
the Add-On Graphic. The property appears in the Property Definition 
tab for the definition of the Add-On Graphic. The property values and any 
bindings or expressions for that property appear in the Properties 
window for instances of the Add-On Graphic.     

User-defined properties that exist in the existing and replaced versions of 
an Add-On Graphic remain unchanged. 

See also 
Copy the definition of an Add-On Graphic between projects on 
page 381 

Create a user-defined property with a data type on page 365 

Create an alias property on page 361 

Property Definition tab on page 361 

An Add-On Instructions in Logix Designer complements an Add-On 
Graphic in Studio 5000 View Designer.  

• Add-On Instructions in Logix Designer provide commonly used 
functions or device control. They allow creating sets of 
commonly-used logic and provide a common interface to the logic 
and documentation for the instruction.  

• Add-On Graphics in Studio 5000 View Designer allow creating 
commonly-used graphic elements, defining their properties, and 
associating those properties with a Logix Designer user-defined 
data types. Reuse the Add-On Graphic with any tag from the same 
version of .acd file configured with that user-defined data type. 

If there is an Add-On Instruction in Logix Designer that represents a 
mixer, create a corresponding Add-On Graphic in View Designer to 
visually depict the mixer. Bind the properties of the graphic elements in 
the definition of the Add-On Graphic to members of the user-defined tag 
type by navigating to a single tag reference.  

For example, if there is a Mixer tag type that has Level and Temperature 
members, recreating the tag type and members for every mixer is not 
necessary. Create the Add-On Instruction in Logix Designer once and 

Reuse of user-defined 
properties in an Add-On 
Graphic between projects 

Benefits of using Add-On 
Instructions with Add-On 
Graphics 
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reuse it. If there are several mixers in the system, creating a graphic 
element to depict each mixer is not necessary. Create an Add-On 
Graphic once and reuse it.  

Use the Add-On Instruction with the Add-On Graphic by binding the the 
user-defined Mixer type to the Add-On Graphic by reusing the single 
Mixer tag reference. Binding tags when using the Add-On Graphic each 
time is not necessary. Bind once by selecting the instance of the 
user-defined type within Logix. Bind to the Mixer tag path to Mixer 1 for 
the first instance of the Add-On Graphic. All of the members of the Mixer 
tag type appear for the instance of the Add-On Graphic. Bind the Mixer 
tag path ito Mixer 2 for the second instance of the Add-On Graphic, and 
so forth.  

Later, if Agitator speed is added to the Add-On Instruction, the Agitator 
tag member appears for all Tank tags in the user-defined type. In View 
Designer, to depict the agitator on the Add-On Graphic, change the 
definition of the Tank Add-On Graphic to contain a numeric display, and 
bind that numeric display to the Agitator member of the Mixer tag type. 
The agitator and its data then appear on every instance of the Mixer 
Add-On Graphic. 

The benefits of using Add-On Instructions with Add-On Graphics are: 

• Code reuse. Save time recreating tag types and graphic elements 
by creating Add-On Instructions with Add-On Graphics. 

• Consistency. Promote consistency between projects by reusing 
Add-On Instructions with Add-On Graphics. 

• User friendly interface. Place complicated algorithms inside an 
Add-On Instruction and make only essential parameters visible or 
required. Place complicated visualizations inside an Add-On 
Graphic and make only essential properties visible. 

See also 
Change the definition of an Add-On Graphic on page 386 

Add-On Graphics on page 375 

Create an Add-On Graphic on page 375 

Predefined Add-On Graphics exist in the Add-On Graphics folder under 
Assets in the Project Explorer. These Add-On Graphics display, zoom, 
and navigate PDF documents on the HMI device:  

• PDF_Viewer. Occupies the entire screen of a six-inch or nine-inch 
HMI device.  

• PDF_Viewer_Landscape. Occupies the entire screen of a 
10-inch HMI device and a portion of larger HMI devices. The 
PDF_Viewer_Landscape Add-On Graphic is not available on 
six-inch or nine-inch HMI devices.  

• PDF_Viewer_Portrait. Occupies half of the screen of an HMI 
device. The PDF_Viewer_Portrait Add-On Graphic is not available 
on six-inch or nine-inch HMI devices.  

Predefined Add-On Graphics 
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See also 
View the default content of a project on page 59  

Add an Add-On Graphic to a screen on page 394 

Add-On Graphics on page 375 

On the HMI device, an example PDF_Viewer_Landscape includes:  

 
Item Description 

 
Bookmarks for the PDF document in the PDF_Viewer_Landscape.  

  Bookmarks displays the bookmarks of the PDF document. To display bookmarks, 
configure bookmarks for the PDF before adding the PDF to the View Designer project. 

  Previous opens the previous page in the PDF document. If there is no previous page to 
open, the button appears unavailable.  

  Next opens the next page in the PDF document. When on the last page, the button 
appears unavailable. 

 
The open page in the PDF document. Specify a different page number to open a different page in 
the PDF document.  

 
The name of the PDF document in the PDF Viewer. 

  Fit Width expands the width of the PDF document to the width of the PDF Viewer.  

  Fit Window expands the size of the PDF document to the size of the PDF Viewer. 

  Zoom In increases the PDF document magnification by the percentage specified in the 
event command. 

  Zoom Out decreases the PDF document magnification by the percentage specified in the 
event command. 

 
The PDF document specified for the PDF Viewer. In View Designer, the PDF document must exist 
in the Documents folder of the Project Explorer. 

PDF Viewer 
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See also 
Select a graphic element on page 759 

Trigger action to interact with a screen on page 760 

Every instance of an Add-On Graphic is linked to the definition of the 
Add-On Graphic in the Project Explorer. Changing the definition of an 
Add-On Graphic changes every instance of the Add-On Graphic in a 
project. To change the definition of an Add-On Graphic, change the 
following:  

• Content. Add, remove, move or resize graphic elements in the 
Add-On Graphic.  

• Property values. Change the property values in the Properties 
window for the Add-On Graphic, or change property values for a 
graphic element in the Add-On Graphic.  

• User-defined properties. Change user-defined properties in the 
Property Definition tab of the Add-On Graphic.  

• Behavior. Add animations and events to graphic elements in an 
Add-On Graphic. 

 
Tips:  
• The only way to resize the definition of an Add-On Graphic is to add, remove, or move graphic 

elements within the definition. 
• Changing the size of the definition of an Add-On Graphic by changing content within the definition 

changes does not affect the size of any instances of the Add-On Graphic.  
• Resizing graphic elements in the definition of an Add-On Graphic changes the size of the 

background of the Add-On Graphic. The graphic elements in the definition of the Add-On Graphic 
scale in each instance of the Add-On Graphic in the project.   

• Change user-defined properties for an instance of an Add-On Graphic. 
• Add animations and events to an instance of an Add-On Graphic, or a graphic element within an 

Add-On Graphic. Adding animations and events to an Add-On Graphic itself is not allowed.  
• Changes to the definition of an Add-On Graphic appear in a previously deleted instance of the 

Add-On Graphic if you delete an instance, change the definition, and then undelete the instance. 
For example, any changes to the content, an alias, a binding, or a value appear in the undeleted 
instance of the Add-On Graphic. 

See also 
Events and Add-On Graphics on page 400 

Change the property values for the definition of an Add-On 
Graphic on page 376 

Open the definition of an Add-On Graphic to add or change the content 
of the Add-On Graphic. For example, change the property values of 
graphic elements, the property definitions of the Add-On Graphic, or the 
behavior of the content of an Add-On Graphic.  

To open the definition of an Add-On Graphic 
1. In the Project Explorer, expand the Assets and Add-On 

Graphics folders. 
2. Right-click the Add-On Graphic and select Open. You can also 

double-click the Add-On Graphic. The definition of the Add-On 
Graphic opens in a separate tab.  

Change the definition of an 
Add-On Graphic 

Open the definition of an 
Add-On Graphic 
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Tips:  
• Right-click the Add-On Graphic and select Open or press Enter when the Add-On Graphic is 

selected to open the definition. 
• If an instance of the Add-On Graphic exists on a screen, right-click the Add-On Graphic on the 

screen or in the Graphic Explorer and then select Open Graphic Definition to open the definition. 
The Open Graphic Definition option is unavailable for selected groups and multiple selected 
graphic elements, even if the selection contains an Add-On Graphic. 

See also 
Create an Add-On Graphic on page 375 

Change the definition of an Add-On Graphic on page 386 

Close the definition of an Add-On Graphic on page 394 

Add-On Graphics on page 375 

How do I open the Add-On Graphic tab? 

In the Project Explorer, expand the Assets and Add-On Graphics 
folders to navigate to the Add-On Graphic and then perform one of the 
following: 

• Double-click the Add-On Graphic. 
• Right-click the Add-On Graphic and then select Open.  

A tab with the name of the Add-On Graphic opens. 
The Add-On Graphic tab displays the definition of an Add-On Graphic. 
The definition includes: 

• Graphic elements contained in the Add-On Graphic. 
• Property values, animations, and events of graphic elements 

contained in the Add-On Graphic. 
• User-defined properties for the Add-On Graphic. 

Use the Add-On Graphic tab to:  

• Display the content of the Add-On Graphic. 
• Add a graphic element to or remove a graphic element from the 

Add-On Graphic. 
• Move, flip, or rotate a graphic element in the Add-On Graphic.  
• Change property values for the Add-On Graphic. 
• Change property values for a graphic element in the Add-On 

Graphic.  
• Change property definitions for the Add-On Graphic.  
• Add animations or events to a graphic element in the Add-On 

Graphic.  

See also 
Open the definition of an Add-On Graphic on page 386 

Change the definition of an Add-On Graphic on page 386 

Change property values for a graphic element in the definition of 
an Add-On Graphic on page 389 

Add-On Graphic tab 
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Propagation of Add-On Graphic changes on page 393 

Close the definition of an Add-On Graphic on page 394 

Add-On Graphics are empty by default. Add a single or multiple graphic 
elements to the definition of the Add-On Graphic. For example, an 
Add-On Graphic can contain a tank or several tanks, each with its own 
Numeric Display graphic element. Adding content from the definition of 
an Add-On Graphic affects every instance of the Add-On Graphic in the 
project. Rockwell Automation recommends using no more than 500 
elements on a screen. Each AOG instance adds the number of elements 
contained in that AOG toward the recommended limit of 500 elements. 
For example, assume there is an AOG defined that contains 10 
elements. Now assume we instance that AOG 10 times on a screen. That 
accounts for 100 elements on the screen. 

To add a graphic element to the definition of an Add-On Graphic 
1. In the Project Explorer, expand the Assets and Add-On 

Graphics folders. 
2. Double-click the Add-On Graphic. The definition of the Add-On 

Graphic opens in a separate tab.  

 
Tips:  
• Right-click the Add-On Graphic and select Open or press Enter when the Add-On Graphic is 

selected to open the definition. 
• If an instance of the Add-On Graphic exists on a screen, right-click the Add-On Graphic on the 

screen or in the Graphic Explorer and then select Open Graphic Definition to open the definition. 
The Open Graphic Definition option is unavailable for selected groups and multiple selected 
graphic elements, even if the selection contains an Add-On Graphic. 

3. In the Toolbox, select a category to display the graphic elements 
in that category.  

4. Drag a graphic element onto the screen of the Add-On Graphic. 
Double-click a graphic element in the Toolbox to add it to the 
center of the checkered background of the Add-On Graphic. 

 
Tip:  
• Add-On Graphics are self-contained elements that cannot reference external controllers 

tags. Adding graphic elements that have internal tag bindings to the definition of an 
Add-On Graphic results in errors in the Errors pane upon project verification. Graphic 
elements with internal tag bindings include: 
• Alarm Summary 
• Alarm Manager 
• Alarm Indicator 
• Controller Indicator 
• Network Indicator 

• If a graphic element is selected on the Add-On Graphic screen when double-clicking to add 
another graphic element, the new graphic element appears on top of the selected graphic 
element. 

• The background of the Add-On Graphic becomes larger when adding graphic elements to 
the definition.  

• As you add graphic elements to the definition of the Add-On Graphic, any instances of the 
Add-On Graphic already in the project maintain their current size on the screen but include 
the additional graphic elements. 

You can now change the property values, binding, animations, 
and events for a graphic element within the open Add-On Graphic. 

Add a graphic element to 
the definition of an Add-On 
Graphic 
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5. To close and save the definition of the Add-On Graphic Element, 
on the tab of the open Add-On Graphic Element, select Close 
. 

See also 
Create an Add-On Graphic on page 375 

Delete a graphic element from the definition of an Add-On Graphic 
on page 392 

Change the definition of an Add-On Graphic on page 386 

What is an event? on page 476 

Animation using a Color Table or State Table on page 401 

Change the properties for a graphic element in the definition of an 
Add-On Graphic to change the appearance of only that graphic element.  

To change property values for a graphic element in the definition of 
an Add-On Graphic  

1. In the Project Explorer, expand the Assets and Add-On 
Graphics folders. 

2. Double-click the Add-On Graphic. The definition of the Add-On 
Graphic opens in a separate tab.  

 
Tips:  
• Right-click the Add-On Graphic and select Open or press Enter when the Add-On Graphic is 

selected to open the definition. 
• If an instance of the Add-On Graphic exists on a screen, right-click the Add-On Graphic on the 

screen or in the Graphic Explorer and then select Open Graphic Definition to open the definition. 
The Open Graphic Definition option is unavailable for selected groups and multiple selected 
graphic elements, even if the selection contains an Add-On Graphic. 

3. Select the graphic element in the Add-On Graphic. The properties 
for the selected graphic element appear in the Properties 
window.  

4. In the Properties window, change the property values. 

 
Tip: If a graphic element with an aliased property in the definition of an Add-On Graphic is 
unlinked, the unlinked property is not changed in the instances of the Add-On Graphic. 

See also 
Change the definition of an Add-On Graphic on page 386 

Create a user-defined data type property for an Add-On Graphic 
on page 378 

Bind properties of graphic elements to properties of other graphic 
elements in an Add-On Graphic on page 403 

Events tab on page 447 

Animations tab on page 435 

Change property values for 
a graphic element in the 
definition of an Add-On 
Graphic 
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Resize graphic elements within an Add-On Graphic to change the 
appearance of the Add-On Graphic. Resizing graphic elements may 
change the size of the definition of the Add-On Graphic. Instances of the 
resized Add-On Graphic contain the resized graphic element; however, 
the size of the Add-On Graphic instances does not change.  

If resizing graphic elements in the definition of an Add-On Graphic 
changes the size of the background for the Add-On Graphic, the graphic 
elements in the definition are stretched to fit in each instance of the 
Add-On Graphic in the project. Resizing a graphic element in the 
definition of an Add-On Graphic does not maintain aspect ratio.  

To resize a graphic element in the definition of an Add-On Graphic 
1. In the Project Explorer, expand the Assets and Add-On 

Graphics folders. 
2. Double-click the Add-On Graphic. The definition of the Add-On 

Graphic opens in a separate tab.  

 
Tips:  
• Right-click the Add-On Graphic and select Open or press Enter when the Add-On Graphic is 

selected to open the definition. 
• If an instance of the Add-On Graphic exists on a screen, right-click the Add-On Graphic on the 

screen or in the Graphic Explorer and then select Open Graphic Definition to open the definition. 
The Open Graphic Definition option is unavailable for selected groups and multiple selected 
graphic elements, even if the selection contains an Add-On Graphic. 

3. Select a graphic element and resize it like any other graphic 
element on a screen. The size and position of the graphic element 
update while dragging to resize the graphic element. 

 
Tips:  
The Add-On Graphic may resize as graphic elements in the definition are moved:  
• Making a graphic element smaller, when that graphic element is the only graphic element near the 

border of the background, makes the background of the Add-On Graphic smaller.  
• Making a graphic element larger, so that it appears off the border of the background, makes the 

background of the Add-On Graphic larger. 

See also 
Move a graphic element in the definition of an Add-On Graphic on 
page 390 

Change property values for a graphic element in the definition of 
an Add-On Graphic on page 389 

Delete a graphic element from the definition of an Add-On Graphic 
on page 392 

Change the definition of an Add-On Graphic on page 386 

Propagation of Add-On Graphic changes on page 393 

Move graphic elements within an Add-On Graphic to change the 
appearance of the definition of the Add-On Graphic. Move graphic 
elements in the definition of an Add-On Graphic like any other screen.  

Moving a graphic element in the definition of an Add-On Graphic may 
change the size of the Add-On Graphic. All instances of an Add-On 
Graphic are updated with the changes to the definition. The size of 

Resize a graphic element in 
the definition of an Add-On 
Graphic 

Move a graphic element in 
the definition of an Add-On 
Graphic 
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instances of an Add-On Graphic do not change. There content in the 
definition of an Add-On Graphic is stretched to fit the size of the instance.  

To move a graphic element in the definition of an Add-On Graphic 
1. In the Project Explorer, expand the Assets and Add-On 

Graphics folders. 
2. Double-click the Add-On Graphic. The definition of the Add-On 

Graphic opens in a separate tab.  

 
Tips:  
• Right-click the Add-On Graphic and select Open or press Enter when the Add-On Graphic is 

selected to open the definition. 
• If an instance of the Add-On Graphic exists on a screen, right-click the Add-On Graphic on the 

screen or in the Graphic Explorer and then select Open Graphic Definition to open the definition. 
The Open Graphic Definition option is unavailable for selected groups and multiple selected 
graphic elements, even if the selection contains an Add-On Graphic. 

3. Select a graphic element and move it like any other graphic 
element on a screen. The size and position of the graphic element 
updates when dragging to resize the graphic element. Smart 
Guides assist in the alignment of graphic elements within the 
definition of the Add-On Graphic. 

 
Tips:  
The Add-On Graphic may resize as graphic elements in the definition are moved:  
• Moving a graphic element closer to the center of the definition of the Add-On Graphic when that 

graphic element is the only graphic element near the edge of the background of the Add-On 
Graphic makes the Add-On Graphic smaller. 

• Moving a graphic element off the edge of the background of the Add-On Graphic makes the Add-On 
Graphic larger. 

See also 
Resize a graphic element in the definition of an Add-On Graphic 
on page 390 

Delete a graphic element from the definition of an Add-On Graphic 
on page 392 

Change the definition of an Add-On Graphic on page 386 

Propagation of Add-On Graphic changes on page 393 

Copy a graphic element to reuse it on screens within a project or across 
View Designer projects. Copying a graphic element copies all of its 
properties, animations, and events. Copy single, multiple, or groups of 
graphic elements. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

Copy a graphic element 
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To copy a graphic element 
1. On the source screen or in the Graphic Explorer, right-click the 

graphic element and then select Copy. 
• To select multiple graphic elements or groups, hold Ctrl and 

select the items. 
2. On the target screen, right-click the location to paste the items and 

then select Paste. 

 
Tips:  
• If the target screen contains a graphic element with the same name, the name of the new graphic 

element is appended with a number that increments with each copy. 
• To cut a graphic element, right-click the graphic element and select Cut. 
• When copying a graphic element, any localized data associated with the graphic element is also 

copied. 

See also 
Graphic Explorer on page 132 

Duplicate a graphic element on page 150 

Reuse content on page 359 

Copy an instance of an Add-On Graphic within a project on page 
397 

Copy an instance of an Add-On Graphic between projects on page 
398 

Delete a graphic element from the definition of an Add-On Graphic to 
change the appearance of the Add-On Graphic. The graphic element is 
removed from every instance of the Add-On Graphic in the project. 

Deleting graphic elements may change the size of the Add-On Graphic. 
The size of Add-On Graphic instances is not affected by deleting a 
graphic element from the definition. Instances of the Add-On Graphic are 
scaled to fit the content changed in the definition of the Add-On Graphic.  

To delete a graphic element from the definition of an Add-On Graphic 
1. In the Project Explorer, expand the Assets and Add-On 

Graphics folders. 
2. Double-click the Add-On Graphic. The definition of the Add-On 

Graphic opens in a separate tab.  
 

 
Tips:  
• Right-click the Add-On Graphic and select Open or press Enter when the Add-On Graphic is 

selected to open the definition. 
• If an instance of the Add-On Graphic exists on a screen, right-click the Add-On Graphic on the 

screen or in the Graphic Explorer and then select Open Graphic Definition to open the definition. 
The Open Graphic Definition option is unavailable for selected groups and multiple selected 
graphic elements, even if the selection contains an Add-On Graphic. 

3. Select the graphic element to delete and press Delete. 

 
Tip: Deleting the graphic element that is closest to the boundary of the Add-On Graphic 
causes the background of the Add-On Graphic to resize to fit the remaining graphic elements.  

Delete a graphic element 
from the definition of an 
Add-On Graphic 
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See also 
Add a graphic element to the definition of an Add-On Graphic on 
page 388 

Resize a graphic element in the definition of an Add-On Graphic 
on page 390 

Move a graphic element in the definition of an Add-On Graphic on 
page 390 

Change the definition of an Add-On Graphic on page 386 

Changes to the definition of an Add-On Graphic apply to the definition as 
well as any instances of the Add-On Graphic throughout the project.  

Changes to the definition of an Add-On Graphic are propagated 
throughout a project when: 

• Saving the project. 
• Closing the definition of the Add-On Graphic. 
• Taking focus away from the tab of the Add-On Graphic definition 

(for example, setting focus on another tab or window in View 
Designer).   

All instances of the Add-On Graphic in the project update to reflect 
changes to the definition. 

Any changes made to an instance of an Add-On Graphic do not affect the 
definition of the Add-On Graphic or any other instances of the Add-On 
Graphic. 

Changes to the definition of an Add-On Graphic appear in a previously 
deleted instance of the Add-On Graphic. This occurs when deleting an 
instance, changing the definition, and then undeleting the instance. Any 
changes to the content, an alias, a binding, or a value appear in the 
undeleted instance of the Add-On Graphic.   

If the size of the definition of an Add-On Graphic changes when content 
changes within the definition, this does not change the size of any 
instances of the Add-On Graphic. The size of instances remains 
unchanged. The content in the definition of an Add-On Graphic is 
stretched to fit the size of the instance.  

If the size of an instance within the project changes, the size of the other 
instances in the project are not affected. The size of an Add-On Graphic 
definition does not change when an instance of an Add-On Graphic is 
resized.   

Changes to user-defined properties for the definition of an Add-On 
Graphic appear in the Properties window for the instances of the 
Add-On Graphic. Changes to user-defined properties appear only for 
instances of an Add-On Graphic, not the definition of the Add-On 
Graphic. 

When changing the base property value of an alias for a graphic element 
in the Add-On Graphic, the change is propagated to an instance of the 
Add-On Graphic only if that alias on the instance is linked to the definition 
of the Add-On Graphic. If the instance is not linked to the definition, the 
instance does not change.  

Propagation of Add-On 
Graphic changes 

Changes to size 

Changes to user-defined 
properties 

Changes to aliased 
properties 
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See also 
Change the definition of an Add-On Graphic on page 386 

Add a graphic element to the definition of an Add-On Graphic on 
page 388 

Change property values for a graphic element in the definition of 
an Add-On Graphic on page 389 

Resize a graphic element in the definition of an Add-On Graphic 
on page 390 

Close the definition of an Add-On Graphic on page 394 

Close an Add-On Graphic like any other screen when changes to the 
definition of the Add-On Graphic are complete.  

To close the definition of an Add-On Graphic 
• On the tab of the open Add-On Graphic definition, select Close 

. 

See also 
Open the definition of an Add-On Graphic on page 386 

Change the definition of an Add-On Graphic on page 386 

Propagation of Add-On Graphic changes on page 393 

Work with instances of an Add-On Graphic in a project like any other 
graphic element. Resize, position, group, and copy and paste instances 
of an Add-On Graphic. Rockwell Automation recommends using no 
more than 500 elements on a screen. Each AOG instance adds the 
number of elements contained in that AOG toward the recommended 
limit of 500 elements. For example, assume there is an AOG defined that 
contains 10 elements. Now assume we instance that AOG 10 times on a 
screen. That accounts for 100 elements on the screen. 

See also 
Add an Add-On Graphic to a screen on page 394 

Copy an instance of an Add-On Graphic between projects on page 
398 

Copy an instance of an Add-On Graphic within a project on page 
397 

Add an Add-On Graphic to a screen from either the Toolbox or the 
Project Explorer. Add no more than 500 elements on a screen. Each 
Add-On Graphic instance adds the number of elements contained in that 
Add-On Graphic toward the recommended limit of 500 elements. If there 
is an Add-On Graphic defined that contains 10 elements and that that 
Add-On Graphic appears 10 times on a screen, this accounts for 100 

Close the definition of an 
Add-On Graphic 

Work with instances of an 
Add-On Graphic 

Add an Add-On Graphic to a 
screen 
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elements on the screen. After adding an Add-On Graphic to a screen, 
change its appearance and behavior by changing the properties of the 
Add-On Graphic, associating the Add-On Graphic with an animation or 
event, or binding the Add-On Graphic to a user-defined tag. Directly 
binding the definition of an Add-On Graphic to a controller tag is not 
allowed.  

Prerequisites 
• Verify that the definition of the Add-On Graphic exists in the 

Assets > Add-On Graphics folder of the Project Explorer. 

 
Tips:  
• The Add-On Graphics folder contains two predefined Add-On Graphics to display, zoom, and 

navigate a PDF document on the HMI device: 
• PDF_Viewer_Landscape. Occupies the entire screen of an HMI device. 
• PDF_Viewer_Portrait. Occupies half of the screen of an HMI device. 

• The PDF_Viewer_Portrait Add-On Graphic is not available on six-inch or seven-inch HMI devices. 

To add an Add-On Graphic to a screen 
1. In the Toolbox, expand the Add-On Graphic category. 
2. Drag or double-click the Add-On Graphic or press Enter when the 

Add-On Graphic is selected.   
The Add-On Graphic appears on the screen and links to the 
definition in the Add-On Graphics folder. 

 
Tips:  
• Double-clicking adds the Add-On Graphic to the center of the screen. 
• If a graphic element is selected on the screen when adding the Add-On Graphic, the Add-On 

Graphic is placed on top of the selected graphic element. 
• If the outline of an empty Add-On Graphic appears on the screen, the definition of the Add-On 

Graphic is empty. Add graphic elements to the Add-On Graphic by changing the definition of the 
Add-On Graphic. All instances of the Add-On Graphic update to display the contents of the Add-On 
Graphic. 

• Add an Add-On Graphic from a different project by copying and pasting the Add-On Graphic 
between the projects. 

• Search for a known name of the Add-On Graphic to add using the search feature of the Toolbox. 
• The name of each Add-On Graphic added to a screen is appended with a number that increments 

with each instance. For example, MyPlantMixer_002 indicates a second instance of the 
MyPlantMixer Add-On Graphic on a screen. 

• It is recommended to have no more than 200 Add-On Graphic definitions in a project. 
• To add an Add-On Graphic from the Project Explorer, drag the Add-On Graphic from the Assets > 

Add-On Graphics folder to the screen, or right-click the Add-On Graphic and select Add Add-On 
Graphic to (screen name).  

 

IMPORTANT • Too much content on screens can result in the HMI device running out of memory. 
The Properties tab displays the size of the image. Use the predefined HMI Device 
screen to monitor memory usage. If the HMI device runs out of memory while running 
an application, the HMI device restarts and provides an error message indicating that 
an out-of-memory condition occurred. 

• If the computer running View Designer runs out of memory, View Designer shuts 
down and provides a message indicating that an out-of-memory condition occurred. 
View Designer retains the last saved version of the project. 
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See also 
Create an Add-On Graphic on page 375 

Work with instances of an Add-On Graphic on page 394 

Change the properties of a graphic element on page 139 

Resize a graphic element on page 144 

Reuse Add-On Graphics on page 402 

Change the attributes of a graphic element or Add-On Graphic, such as 
position and size, using the Properties tab in the Properties window. 

To change the properties of a graphic element 
1. On the screen or in the Graphic Explorer, select the graphic 

element.  
• To select multiple elements, press and hold Ctrl while selecting 

each graphic element.  
• To select all of the graphic elements, press Ctrl+A. 

2. In the Properties window, select the Properties tab to display the 
properties for the selected graphic element 

 
Tip: Select multiple instances of Add-On Graphics to change the properties common to each 
instance instead of having to select and change the property values of each Add-On Graphic 
instance individually. 

3. Change any or all of the properties:  
• Type or select a value. 
• Bind the property to a data item. 

See also   
Add an Add-On Graphic to a screen on page 394 

Properties tab on page 494 

Graphic Explorer on page 132 

Bind a property to a data item on page 508 

Propagation of Add-On Graphic changes on page 393 

Resize any graphic element or instance of an Add-On Graphic. The 
Height and Width values of a resized graphic element appear in the 
Properties tab. 

To resize a graphic element 
1. Select the graphic element to resize. 
2. Position the cursor on a sizing handle  until it turns into a 

double-arrow. 
• To change the width or height of a graphic element, drag a side 

sizing handle. 

Change the properties of a 
graphic element 

Resize a graphic element 
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• To change both the width and height of a graphic element, drag 
a corner sizing handle. 

• To maintain the aspect ratio between width and height, hold 
Shift as you drag a sizing handle. 

• To maintain the center point of a graphic element, hold Alt as 
you drag a sizing handle. 

• To maintain the aspect ratio and center point of a graphic 
element, hold Shift+Alt as you drag a corner sizing handle. 

• To resize the text within a graphic element while you resize the 
graphic element, hold Ctrl as you drag a sizing handle. 

 
Tips:  
• A tooltip shows the height and width of the graphic element as you resize it. 
• The font size configured for a graphic element with a text value determines the height of the 

graphic element. If you resize or rotate a Text Input graphic element, the font size does not 
change. 

• If you resize an element while multiple graphic elements are selected, each element is resized and 
the proportion is maintained. The height and width shown in pixels are for the selection you are 
resizing.  

• Resizing an instance of an Add-On Graphic scales the text of any graphic element contained in the 
definition of the Add-On Graphic.     

• Changing the size of an instance of an Add-On Graphic does not change any other instance of the 
Add-On Graphic in the project. The proportion of each graphic element within the Add-On Graphic 
is maintained as the instance of the Add-On Graphic is resized. Resizing an instance of an Add-On 
Graphic does not affect the definition of the Add-On Graphic. 

See also 
Add an Add-On Graphic to a screen on page 394 

Graphic Explorer on page 132 

Group graphic elements on page 151 

Lock or unlock graphic elements on page 132 

Work with groups on page 313 

Copy an instance of an Add-On Graphic to reuse the Add-On Graphic in 
the same project. Copying multiple instances of Add-On Graphics that 
are linked to different Add-On Graphic definitions is allowed. Copied 
instances of Add-On Graphics may be contained in groups. 

When copying the instance of an Add-On Graphic within a project, the 
instance is linked to the existing definition of the Add-On Graphic. 

To copy an instance of an Add-On Graphic within a project  
1. On the screen, right-click the Add-On Graphic instance and select 

Copy.  
2. Open the target screen.  
3. Right-click the screen canvas and select Paste. Another instance 

of the Add-On Graphic is created and copied to the screen. 

Copy an instance of an 
Add-On Graphic within a 
project 
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Tips:  
• Pasting an instance of an Add-On Graphic for which there is no definition is not allowed. Pasting an 

instance of an Add-On Graphic is not supported when deleting the definition of the Add-On Graphic 
before pasting the instance.  

• Copying an instance of an Add-On Graphic that is linked to an Add-On Graphic definition that 
contains an image, does ont create a new image asset in the Assets > Images folder in the Project 
Explorer. 

Any changes to an instance of an Add-On Graphic do not affect 
any other instances of the Add-On Graphic. 

See also 
Add an Add-On Graphic to a screen on page 394 

Work with instances of an Add-On Graphic on page 394 

Copy the definition of an Add-On Graphic between projects on 
page 381 

Rename an Add-On Graphic on page 380 

Copy an instance of an Add-On Graphic between projects to reuse the 
Add-On Graphic in another project. Copied instances of Add-On 
Graphics may be contained in groups. 

Add-On Graphics must have unique names. Copying an instance of an 
Add-On Graphic between projects copies the definition of the Add-On 
Graphic. If a definition of an Add-On Graphic with the same name already 
exists in the target project, keep both Add-On Graphic definitions, replace 
the existing Add-On Graphic definition, or choose not to paste the 
Add-On Graphic definition.  

To copy an instance of an Add-On Graphic between projects  
1. Open the source project and screen containing the Add-On 

Graphic to copy. 
2. On the screen, right-click the Add-On Graphic and select Copy.  
3. Open the target project and screen to contain the pasted Add-On 

Graphic. 
4. Right-click the screen canvas in the target project and then select 

Paste. 

 
Tip: If the instance of the Add-On Graphic is linked to a definition of an Add-On Graphic that 
does not exist in the target project, the definition is added to the Add-On Graphics folder, and 
the Add-On Graphic is added to the Toolbox of the target project. 

5. Pasting an instance of an Add-On Graphic in a different project 
where a definition of an Add-On Graphic has the same name 
displays options: 
• Keep Both. Append the name of the copied Add-On Graphic 

definition with _001 or increment number. The definition 
appears in the Add-On Graphics folder and the Add-On 
Graphic appears in the Toolbox.  

• Replace. Replace the existing Add-On Graphic definition with 
the copied definition. Any existing instances of the Add-On 
Graphic are updated with the new definition of the Add-On 
Graphic.  

Copy an instance of an 
Add-On Graphic between 
projects 
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• Cancel. Do not paste the copied Add-On Graphic definition into 
the project. Paste the instance of the Add-On Graphic into the 
target project and link the instance to the existing Add-On 
Graphic definition with the same name.  

 
Tip:  
• When copying multiple Add-On Graphics that are linked to multiple Add-On Graphic 

definitions that have the same names as existing Add-On Graphic definitions in the 
target project, select the Do this for the x remaining items checkbox to apply the 
selected option to each copied Add-On Graphic definition.  

• When copying the definition of an Add-On Graphic that has an image that exists in the 
source and target projects, replace the image or cancel. Images are copied to the 
Assets > Images folder of the Project Explorer. 

Change the properties and behavior of the Add-On Graphic in the 
target project. Any changes to an instance of an Add-On Graphic 
do not affect any other instances of the Add-On Graphic.   

See also 
Change the properties of a graphic element on page 139 

Copy the definition of an Add-On Graphic between projects on 
page 381 

Resize a graphic element on page 144 

Copy the definition of an Add-On Graphic between projects to reuse the 
Add-On Graphic in another project. The content, properties, and 
behavior of the Add-On Graphic definition are copied. Any changes to 
the definition of the Add-On Graphic are copied to every instance of the 
Add-On Graphic in the project.  

Add-On Graphics must have unique names. When copying the definition 
of an Add-On Graphic with the same name between projects, keep both 
Add-On Graphic definitions, replace the existing Add-On Graphic 
definition, or choose not to paste the Add-On Graphic definition.  

Contents of the Add-On Graphic are handled in the same manner as the 
contents of any other screen copied between projects.  

To copy the definition of an Add-On Graphic between projects  
1. Open the project containing the Add-On Graphic to copy. 
2. In the Project Explorer, expand the Assets folder. 
3. Expand the Add-On Graphics folder.  
4. Right-click the Add-On Graphic to copy and select Copy.  
5. Open the project where to contain the pasted Add-On Graphic. 
6. In the Project Explorer, expand the Assets folder. 
7. Expand the Add-On Graphics folder.  
8. Right-click the Add-On Graphics folder and select Paste. 

If a definition of an Add-On Graphic with the same name does not 
already exist in the project, the definition appears in the folder and 
the Add-On Graphic appears in the Toolbox. 

9. Pasting the definition of the Add-On Graphic in a different project 
where an Add-On Graphic definition with the name already exists 
displays options:  

Copy the definition of an 
Add-On Graphic between 
projects 
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• Keep Both. Append the name of the copied Add-On Graphic 
definition with _001 or increment number. The definition 
appears in the folder and the Add-On Graphic appears in the 
Toolbox.  

• Replace. Replace the existing Add-On Graphic definition with 
the copied definition. Any instances of the existing Add-On 
Graphic are updated with the new definition of the Add-On 
Graphic.  

• Cancel. Do not paste the copied Add-On Graphic definition into 
the project. 

 
Tips:  
• Replacing an alias property in the definition of an Add-On Graphic as a result of a paste when that 

alias is linked in an instance displays the alias property in the Properties window of the instance. 
The alias remains linked to the value of the base property in the definition.  

• Replacing an alias property in the definition of an Add-On Graphic as a result of a paste when that 
alias is unlinked in an instance displays the alias property in the Properties window of the 
instance. The alias property retains its value from the original Add-On Graphic definition. The value 
of the alias property is not linked to the base property of the pasted Add-On Graphic definition.  

• Copying the definition of an Add-On Graphic that has an image that exists in both the source and 
target projects displays a prompt to replace the image or cancel. Images in a copied Add-On 
Graphic appear in the Assets > Images folder of the Project Explorer. 

The Add-On Graphic is available for use in the project.  

See also 
Work with instances of an Add-On Graphic on page 394 

Copy the definition of an Add-On Graphic within a project on page 
380 

Change the property values for the definition of an Add-On 
Graphic on page 376 

Rename an Add-On Graphic on page 380 

Add events to an instance of an Add-On Graphic on a screen or to a 
graphic element in the definition of an Add-On Graphic. As with groups, 
events for the content in the definition of an Add-On Graphic trigger in a 
specific order.   

Adding events to an Add-On Graphic in the Toolbox is not allowed. 
Selecting an Add-On Graphic in the Toolbox does not show the the 
Events tab in the Properties window.  

Events created for an instance of an Add-On Graphic take precedence 
over events created for a graphic element within the definition of the 
Add-On Graphic. For example, if the same event type exists in both the 
definition of an Add-On Graphic and an instance of that Add-On Graphic, 
the event for the instance of the Add-On Graphic is performed on the HMI 
device. 

See also  
In what order are touch events triggered? on page 478 

Trigger an action on a Button Behavior event on page 444 

Events and Add-On 
Graphics 
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Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a State Enter or State Exit event on page 454 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

A Color Table or State Table searches its list of states from top to 
bottom for the first state that matches the value of the input expression. 
Rules applied to how the value of the input expression is compared to the 
Expression Values in the table include: 

• Integer numbers containing 15 digits or less are compared to 
Expression Values directly.  

• Integer numbers containing more than 15 digits are rounded to a 
15-significant-digit double value in Engineering Format and then 
compared to the Expression Value.  

• Floating point numbers are rounded to five significant digits and 
then compared to Expression Values using fuzzy comparison.   

• Strings are compared to the actual content of the Expression 
Value. 

Using a Color Table or a State Table can affect more than one property 
simultaneously when the tag value or expression changes. Create Color 
Tables and State Tables on the Animations tab in the Properties 
window. The tables are similar in design and behavior, but the Color 
Table is used exclusively for color animation.  

• Use a Color Table to affect only the color properties of a graphic 
element. This option is available on the Animations tab only if the 
selected graphic element has a color property. Unlike State 
Tables, Color Tables cannot be used with State Enter or State 
Exit events.  

• Use a State Table to affect the Appearance, Position and Size, or 
General properties of a graphic element or to drive an animation 
with a State Enter or a State Exit event.  

Use multiple State Tables and Color Tables for a graphic element or 
screen.  

The tables reduce the need for custom scripting. To animate a graphic 
element, select the element and use a State Table or a Color Table to: 

• Set the condition to drive the animation. The condition is the input 
to the state table. Bind directly to a tag or build an expression 
using the integrated Expression Editor. Use numeric, range, 
and/or string values within the same table.  

• Identify the states the animation is to indicate, such as running, 
stopped, or temperature levels. 

• Select the properties of the graphic element to affect for each 
state, such as FillColor or Visibility. Only the properties to animate 
are available. Select multiple properties.  

• Specify the value to trigger the animation associated with each 
state (Expression Value).  

Whenever the input value to a Color Table or a State Table changes, 
the table searches the Expression Values from top to bottom. The first 

Animation using a Color 
Table or State Table 
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Expression Value that matches the input value triggers the 
corresponding color or state change. 

If the input value does not match any of the Expression Values, the 
animation uses the values in the Default row of the table. The Default 
values reflect the values of their corresponding properties in the 
Properties tab. Changing the value of the property in the Properties tab 
changes its value in the Default row of the Color Table. The Default row 
cannot be edited or removed. 

IMPORTANT • Do not use a State Table or Color Table to modify a property that is already bound to 
a tag or expression. This can cause undesired results. Property values change based 
on which input modifies the property first. There is no way to determine the order of 
inputs. 

• Modifying a property across multiple State Tables or Color Tables can cause 
undesired results. Property values change based on which input modifies the 
property first. There is no way to determine the order of inputs. 

•  

See also 
Animation using property binding on page 442 

Configure an animation using a Color Table on page 437 

Configure an animation using a State Table on page 438 

Bind a color property to a tag or expression on page 500 

How the output value of a Color Table or a State Table is 
calculated on page 443 

Assume a plant has 50 tanks. Depicting the plant requires 50 tank 
graphic elements. This requires a tank graphic element, a text display, 
and a value display for each tank. Create an Add-On Graphic that 
contains all three graphic elements and then reuse that Add-On Graphic 
50 times to avoid changing the tag bindings on each instance of the 
Add-On Graphic.  

To reuse an Add-On Graphic and not change tag bindings for each 
instance, create user-defined properties. User-defined properties act as 
placeholders for the values to pass from the instances of the Add-On 
Graphic to the definition of the Add-On Graphic. These values appear on 
the HMI device.  

There are several different methods to reuse Add-On Graphics:  

• User-defined data type property. A property in the definition of an 
Add-On Graphic tied to a specific data type in a controller. Bind a 
graphic element in the definition of the Add-On Graphic to a 
member of the data type. Then from Properties window in an 
instance of the Add-On Graphic, bind to an instance of the Logix 
data type. The binding passes the tag from the instance of the 
specified Logix data type to the instance of the Add-On Graphic. 
The Add-On Graphic displays the value on the HMI device. 

• Alias property. A user-defined property in the definition of an 
Add-On Graphic that appears in the Properties window of an 
instance of the Add-On Graphic. Alias a property within the 
definition of an Add-On Graphic so the property appears in an 

Reuse Add-On Graphics 
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instance of the Add-On Graphic where the value can change. View 
Designer passes the value of the aliased property to the instance 
of the Add-On Graphic. The Add-On Graphic displays the value on 
the HMI device. 

• Property to property binding. Bind the properties of one graphic 
element in the definition of an Add-On Graphic to the properties of 
another graphic element in the definition. The graphic elements in 
the definition can show the same value in different formats. For 
example, bind the Value property of a Numeric Display graphic 
element to the FillLevel property of a tank graphic element, and 
bind the FillLevel property of the tank to the tag that represents the 
fill level of the tank. The fill level displays graphically and 
numerically on the HMI device.   

See also 
User-defined data type property binding for an Add-On Graphic on 
page 410 

User-defined alias property for an Add-On Graphic on page 413 

Property to property binding in an Add-On Graphic on page 405 

Bind the properties of different graphic elements in the definition of an 
Add-On Graphic. Property to property binding shows the same value on 
different graphic elements, showing the value in different formats. For 
example, show the level property for a mixer graphic element and a 
numeric display so the level appears graphically and numerically on the 
HMI device.  

A controller tag must be passed to a user-defined data type property in 
the definition of the Add-on Graphic. For example, bind the Value 
property of a Numeric Display graphic element to the FillLevel property of 
a tank graphic element, and bind the FillLevel property of the tank to the 
tag that represents the fill level of the tank. The fill level displays 
graphically and numerically on the HMI device.  

To bind properties of graphic elements in an Add-On Graphic 
1. In the Property Definition tab of the Add-On Graphic, type a 

name for the user-defined property in the Name box. 

 
Tip: If the Property Definition tab is not open, below the screen, select Expand . 

2. Select the Data Type box and select Select data type . The 
Data Type Browser opens. 

3. Select a data type:  
• User-Defined. A structure data type defined in Logix Designer. 
• Predefined. An atomic or structure data type defined by a 

controller.  
• Module-Defined. A structure data type defined by a module 

when creating the module. Tags of these types store input, 
output, and configuration data for the module. 

Bind properties of graphic 
elements to properties of 
other graphic elements in 
an Add-On Graphic 
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The data type is used as a filter criteria for the Data Type 
Browser. Only items in the Logix Designer project (.acd) file that 
meet the filter criteria appear when opening the Tag Browser. 

4. Select the drill-in arrow  next to a controller.  
5. Navigate to the desired level in the controller and select the data 

type. 
6. (optional) In the Description column, type a description for the 

property to appear when hovering over the property on the 
Properties window. 

7. In the Category column, type the category where the property is to 
appear in the Properties window for an instance of the Add-On 
Graphic.  

8. Select a graphic element in the definition of the Add-On Graphic.  
9. In the property to bind to the selected graphic element, browse to 

select the user-defined data type property, and then navigate to 
select the member with the value to show on an instance of the 
Add-On Graphic. 

 
Tips:  
• Selecting a user-defined data type displays all of the members within the property and any nested 

properties. Expand a nested user-defined data type to display all of the members of the nested 
data type. 

• To type the binding, use the format: 
PropertyName.Member 
For example, if the user-defined data type is named MixerTag and the data type in the controller 
has a Level member that is the value to show on the Add-On Graphic, type MixerTag.Level. 

10. Select another graphic element in the definition of the Add-On 
Graphic. 

11. In the same property as the first graphic element, select 
Browse  to browse to and select the name of the same 
member to which the first graphic element is bound. When typing 
the binding, use the format ElementName.PropertyName. For 
example, to bind to the level of a first graphic element named 
MixingSideHopper, browse to or type the binding 
MixingSideHopper.Level. 

 
Tips:  
• When binding to a property, do not bind to properties within a category. For example, binding to 

the Color, Style, and Width under the Border category is not supported.   
• To ensure accuracy of the graphic element name when binding the second graphic element, copy 

the name of the first graphic element from the Name box in the Properties window of the first 
graphic element. 

12. Add an instance of the Add-On Graphic to a screen. 
13. In the Properties window for the instance, expand the category 

of the user-defined property and then in the user-defined property, 
browse to select the controller tag.   
On the HMI device, the Add-On Graphic shows the value of the 
controller tag. 

See also 
Property to property binding in an Add-On Graphic on page 405 

Reuse Add-On Graphics on page 402 

Controller tags and Add-On Graphics on page 420 
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Create a user-defined data type property for an Add-On Graphic 
on page 378 

What is binding? on page 502 

Property to property 
binding in an Add-On 
Graphic 
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This example depicts property to property binding within the definition of 
an Add-On Graphic. Property to property binding binds the property of 
one graphic element to another graphic element in the definition. Even if 
the graphic elements display a value in different formats, the graphic 
elements show the same value on the HMI device. In this example, a 
user-defined data property exists for the level of a mixer graphic element 
in the definition of an Add-On Graphic. Binding the property of the 
numeric display to the Level property of the mixer then shows the level 
graphically on the mixer, and numerically on a numeric display.   
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 Add-On Graphic definition 
Item Description 

 
The definition of an Add-On Graphic containing two graphic elements. In this example, 
there is one mixing hopper and one numeric display in the definition. 

 
A user-defined data type property for the definition of the Add-On Graphic. 
User-defined properties include: 
• Name. The name of the user-defined property. In this example, the name of the 

user-defined property is MixerTag. 
• Data Type. The data type of the user-defined property. This is the data type in the 

controller. Browse to the controller and data type. In this example, the data type is 
Mixer.  

• Description. An optional description for the user-defined property. This description 
appears as a tooltip when hovering over the box in the Properties window for an 
instance of the Add-On Graphic. 

• Category. The category where the user-defined property appears in the Properties 
window for an instance of the Add-On Graphic. 

 
The properties of MixingHopperSide_001 when that graphic element is selected in the 
definition. The Level property of the mixing hopper is bound to the user-defined data 
property and the Level member of the Mixer data type in the user-defined property. 
Type or browse to create the binding. Use the format PropertyName.Member. The value 
of the Level member shows on the mixing hopper on the HMI device.  

 
The properties of NumericDisplay_001 when that graphic element is selected in the 
definition. The Value property of the numeric display is bound to the mixing hopper 
graphic element in the definition. The binding is the name of the graphic element 
followed by the member that has the value to show on the numeric display. The format 
is ElementName.Member. The value of the Level member shows on the numeric display 
on the HMI device.  

 Add-On Graphic instances 
Item Description 

 
The Properties window for the Mixer_001 Add-On Graphic instance. The instance is 
bound to the Mixer1 controller tag. The Mixer1 tag is passed to the definition of the 
Add-On Graphic. The Level member applied to the graphic elements in the definition of 
the Add-On Graphic show the level for Mixer1 on the HMI device.  

 
The Properties window for the Mixer_002 Add-On Graphic instance. The instance is 
bound to the Mixer2 controller tag. The Mixer2 tag is passed to the definition of the 
Add-On Graphic. The Level member applied to the graphic elements in the definition of 
the Add-On Graphic show the level for Mixer2 on the HMI device.   

 Add-On Graphics on HMI device 
Item Description 

 
Each Add-On Graphic shows the level of the mixer. 

See also 
Reuse Add-On Graphics on page 402 

Controller tags and Add-On Graphics on page 420 

Create a user-defined data type property for an Add-On Graphic 
on page 378 

Bind properties of graphic elements to properties of other graphic 
elements in an Add-On Graphic on page 403 
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Create a user-defined data type property to bind an Add-On Graphic to a 
controller tag. An Add-On Graphic element cannot bind directly to a 
controller tag. All projects do not reference the same controllers, and 
View Designer allows reusing Add-On Graphics between projects.  

To bind an Add-On Graphic to a user-defined data type property 
1. In the Property Definition tab of the Add-On Graphic, type a 

name for the user-defined property in the Name box. 

 
Tip: If the Property Definition tab is not open, below the screen, select Expand . 

2. Select the Data Type box and select Browse  to select a data 
type:  
• User-Defined. A structure data type defined in Logix Designer. 
• Predefined. An atomic or structure data type that is defined by 

the controller.  
• Module-Defined. A structure data type defined by a module 

when you create it. Tags of these types are created to store 
input, output, and configuration data for the module. 

The data type is used as a filter criteria for the Tag Browser. Only 
items in the Logix Designer project (.acd) file that meet the filter 
criteria appear when opening the Tag Browser. 

3. (optional) In the Description column, type a description for the 
property to appear when hovering over the property on the 
Properties window. 

4. In the Category column, type the category where the property will 
appear in the Properties window for an instance of the Add-On 
Graphic.  

5. Select a graphic element in the definition of the Add-On Graphic.  
6. In the property to bind to the selected graphic element, select 

Browse  to select the user-defined data type property, and 
then navigate to select the member of the property. 

 
Tips:  
• Selecting a user-defined data type displays all of the members within the property as well as any 

nested properties. Expand a nested user-defined data type to display all of the members of the 
nested data type.  

• View Designer does not support browsing to an .@AlarmSet member of a data type property for an 
Add-On Graphic. Manually enter .@AlarmSet members when binding within an Add-On Graphic.  

• To type the binding instead of browsing to it, use the format: 
PropertyName.Member 
For example, if the user-defined data type property is named MixerTag and the data type in the 
controller has a Level member that is the value to show, type MixerTag.Level. 

7. Add an instance of the Add-On Graphic to a screen. 
8. In the Properties window of the instance, expand the category of 

the user-defined property.  
9. In the user-defined property, select Browse  to select an 

instance of the data type (for example, Mixer1), or a controller tag.  
On the HMI device, the Add-On Graphic shows the value of the 
controller tag. 

Bind an Add-On Graphic to a 
user-defined data type 
property 
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See also 
Reuse Add-On Graphics on page 402 

Bind properties of graphic elements to properties of other graphic 
elements in an Add-On Graphic on page 403 

User-defined data type property binding for an Add-On Graphic on 
page 410 

Property Definition tab on page 361 

User-defined property on page 370 

This example depicts a user-defined data type that is bound to a property 
in an instance of an Add-On Graphic to a controller tag. It shows how the 
instance of the Add-On Graphic passes the controller tag to the 
user-defined data type property in the definition of the Add-On Graphic. 
The data type and member specified in the definition then shows the 
value on the HMI device.  

 
 

User-defined data type 
property binding for an 
Add-On Graphic 



Chapter 12  Reuse content 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 411 
 

 Add-On Graphic definition 
Item Description 

 
A user-defined data type property for the definition of the Add-On Graphic. 
User-defined properties appear in the Tag Browser when browsing for tags for an 
instance of an Add-On Graphic. User-defined properties include: 
• Name. The name of the user-defined property. In this example, the name of the 

user-defined property is MixerTag. 
• Data Type. The data type of the user-defined property. This is the data type in the 

controller. Select Select data type  to navigate to the controller and data type. In 
this example, the data type is Mixer.  

• Description. An optional description for the user-defined property. This description 
appears as a tooltip when hovering over the property in the Properties window for an 
instance of the Add-On Graphic. 

• Category. The category where the user-defined property appears in the Properties 
window for an instance of the Add-On Graphic. 

 
The binding for a selected graphic element in the definition of the Add-on Graphic. Type 
or browse to the name of the user-defined data type property and the member of a tag 
in the data type. In this example, the member is the Level. The value of the level shows 
on the HMI device. 

 Add-On Graphic instances 
Item Description 

 
The Properties window for the Mixer_001 Add-On Graphic instance. The instance is 
bound to the Mixer1 tag. The Mixer1 tag is passed to the definition of the Add-On 
Graphic. The Level member applied to the graphic element in the definition of the 
Add-On Graphic then shows the level for Mixer1 on the HMI device.   

 
The Properties window for the Mixer_002 Add-On Graphic instance. The instance is 
bound to the Mixer2 tag. The Mixer2 tag is passed to the definition of the Add-On 
Graphic. The Level member applied to the graphic element in the definition of the 
Add-On Graphic then shows the level for Mixer2 on the HMI device.   

 Add-On Graphics on HMI device 
Item Description 

 
The Add-On Graphics on the HMI device. Each shows the level of the respective mixer. 

See also 
Reuse Add-On Graphics on page 402 

Create a user-defined data type property for an Add-On Graphic 
on page 378 

Bind properties of graphic elements to properties of other graphic 
elements in an Add-On Graphic on page 403 

Property to property binding in an Add-On Graphic on page 405 

After creating a user-defined property, it appears on the Property 
Definition tab and the Properties tab for the screen or popup. User 
defined properties created for the definition of an Add-On Graphic 
appear on the Properties tab for an instance of the Add-On Graphic. 

Change a user-defined 
property 
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Use the Property Definition tab to change the definition of a 
user-defined property. Use the Properties tab to change the value of a 
user-defined property rather than the property itself. 

To change a user-defined property 
1. Select the screen, Add-On Graphic definition, or popup that 

contains the user-defined property to change. 
2. Make changes to the property: 

• Use the Property Definition tab to change the Name, Data 
Type, Description, or Category of the user-defined property. 

• Use the Properties tab to change the value or binding. 
Changes to user-defined properties take effect immediately and 
are saved when the project is saved. 

 
Tip: A value or binding for an Add-On Graphic cannot change on the Properties tab for the 
definition of an Add-On Graphic. Change a value or binding for an instance of the Add-On 
Graphic on the Properties tab. 

See also  
Property Definition tab on page 361 

Create a user-defined property with a data type on page 365 

Delete a user-defined property on page 370 

User-defined property on page 370 

Remove a binding on page 513 

Alias a property in the definition of an Add-On Graphic to specify a 
unique value for the property on an Add-On Graphic instance. 
Otherwise, the property does not appear on an instance of the Add-On 
Graphic. Reuse the Add-On Graphic by changing the value of the aliased 
property on an instance of an Add-On Graphic.  

To alias a property in an Add-On Graphic 
1. In the definition of the Add-On Graphic, select a graphic element.  
2. In the Properties window for the selected graphic element, 

right-click the property to alias and select New Alias. This creates 
an alias property in the Property Definition tab below the 
definition of the Add-On Graphic. 

 
Tip: View Designer allows creating an alias for a property only if the property is not bound. 

3. In the Name column, type the name of the alias to appear in the 
Properties window of an instance of the Add-On Graphic. 

 
Tips:  
• By default, the name of the aliased property in the Property Definition tab is the name of the 

property appended with _001 or increment number.  
• The Alias For column automatically specifies the selected graphic element name and property. The 

format for the alias is ElementName.PropertyName. For example, if the selected graphic element is 
a mixing hopper and the aliased property is LevelColor, the Alias For column displays 
MixingHopperSide_001.LevelColor. 

Alias a property in an 
Add-On Graphic 
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4. (optional) In the Description column for the aliased property in the 
Property Definition tab, enter a description for the aliased 
property. 

5. In the Category column for the aliased property, type the category 
in which the aliased property is to appear in the Properties 
window for an instance of the Add-On Graphic.  

6. Add instances of the Add-On Graphic to a screen.  
7. In the Properties window for each instance, expand the category 

for the aliased property and then enter a value for the property. 

 
Tips:  
• Creating more than one alias for the same property of a graphic element is not supported. 
• Binding the property of a graphic element or Add-on Graphic instance to an alias of a screen, 

popup or Add-On Graphic definition is not allowed 

Each instance of the Add-On Graphic shows the value of the 
aliased property on the HMI device. 

See also 
User-defined alias property for an Add-On Graphic on page 413 

Reuse Add-On Graphics on page 402 

User-defined alias property for an Add-On Graphic on page 413 

Bind properties of graphic elements to properties of other graphic 
elements in an Add-On Graphic on page 403 

Property Definition tab on page 361 

User-defined alias property 
for an Add-On Graphic 
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In this example, alias properties in the definition of an Add-On Graphic 
appear on each instance of the Add-On Graphic. Entering a value or 
binding changes the value of the aliased property on an instance of the 
Add-On Graphic.  

 

 Add-On Graphic definition 
Item Description 

 
The alias property. In this example, the alias is for the LevelColor. Create an alias 
property by right-clicking the property and selecting New Alias. The alias property 
appears in the Property Definition tab below the definition of the Add-On Graphic.  
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The user-defined alias property for the definition of the Add-On Graphic: 
• Name. The name of the alias. By default, the name of the alias property in the 

Property Definition tab is the name of the property appended with _001 or increment 
number. Type the name of the property to appear on each instance of the Add-On 
Graphic. In this example, the alias for the LevelColor is named BeverageColor.  

• Alias For. This box automatically specifies the selected graphic element name and 
property. The format for the alias is ElementName.PropertyName. For example, if the 
selected graphic element is a mixing hopper and the aliased property is LevelColor, 
the Alias For column may contain MixingHopperSide_001.LevelColor.  

• Description. An optional description for the alias property. This description appears 
as a tooltip when hovering over the box in the Properties window for an instance of 
the Add-On Graphic. 

• Category. The category where the alias property appears in the Properties window for 
an instance of the Add-On Graphic. 

 Add-On Graphic instances 
Item Description 

 
The Properties window for the first instance of the Add-On Graphic on a screen. The 
BeverageColor alias property for Mixer_001 is set to orange and appears orange on the 
HMI device. 

 
The Properties window for the second instance of the Add-On Graphic on a screen. The 
BeverageColor alias property for Mixer_002 is set to purple and appears purple on the 
HMI device. 

See also 
Reuse Add-On Graphics on page 402 

Alias a property in an Add-On Graphic on page 412 

Changes to user-defined properties take effect immediately and are 
saved when the project is saved. How changes to user-defined 
properties are propagated depend on the item for which the user-defined 
property is created:  

Add-On Graphics 
• Changing the name of a user-defined property for an Add-On 

Graphic changes the name of the property in every instance of the 
Add-On Graphic. The names of properties in bindings and 
expressions do not change.  

• Changes made to the definition of a user-defined property for an 
Add-On Graphic definition are applied to any instances of the 
Add-On Graphic.  

• Changing the value of an alias property on an instance of an 
Add-On Graphic disconnects the property from the user-defined 
property on the definition of the Add-On Graphic. To reconnect the 
user-defined property to the base property, select Link  next to 
the property in the Properties tab. User-defined data type 
properties are always unlinked for an Add-On Graphic. 

Propagation of changes to a 
user-defined property 
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Screens 
• Changing the name of a user-defined property changes the 

property name for the current screen only. Changing the property 
name for a screen or shortcut does not change the name of the 
property in all of the places that property name is used in the 
project. The names of properties in bindings and expressions do 
not change.  

• Changes made to a user-defined property on a screen are applied 
to any shortcuts on which the shortcut is based. 

Shortcuts and events 
• Changing the value of a user-defined property on a shortcut or 

navigation command disconnects the user-defined property from 
its base property.  

• Binding an alias property or aliasing a bound property for a graphic 
element within the definition of an Add-on Graphic is not 
supported.  

See also 
Change a user-defined property on page 368 

Create a user-defined property with a data type on page 365 

Create an alias property on page 361 

Create a user-defined data type property for an Add-On Graphic 
on page 378 

Alias a property in an Add-On Graphic on page 412 

A user-defined property on a: 

• screen shortcut 
• Screen Navigate command 
• Button Behavior event that navigates to a screen on a release 
• Popup Open command 

inherits its value from a base property.The base property is the property 
as defined on the screen or popup called by the shortcut or navigation 
command. 

 Link  next to a property in the Properties tab indicates that the value 
of the property is linked to its associated base property. If Unlink  is 
displayed, the property is unlinked from the base property and is no 
longer inheriting the value of the base property. 

To link a user-defined property to its base property 
• Next to the property in the Properties tab, select Unlink  and 

select Link to base property. Link  appears, and the screen 
property inherits the value of the base property.  

Link a user-defined 
property to its base 
property 
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Tips: • If you create a screen navigation to a shortcut, you create a link to the property on the shortcut, 
not to the base property. 

• The Border property does not support linking and unlinking. 
• User-defined data type properties are always unlinked for an Add-On Graphic. User-defined 

properties on an instance of an Add-On Graphic cannot link to the definition of the Add-On 
Graphic because there is no default value for the user-defined property on the definition.  

See also 
Property Definition tab on page 361 

Unlink a user-defined property from its base property on page 372 

Create an alias property on page 361 

Create a user-defined property with a data type on page 365 

Shortcut customization on page 107 

A user-defined property on a: 

• screen shortcut 
• Screen Navigate command 
• Button Behavior event that navigates to a screen on a release 
• Popup Open command 

inherits its value from a base property.The base property is the property 
as defined on the screen or popup called by the shortcut or navigation 
command. 

 Link  next to a property in the Properties tab indicates that the value 
of the property is linked to its associated base property. If Unlink  is 
displayed, the property is unlinked from the base property and is no 
longer inheriting the value of the base property. 

To unlink a user-defined property from its base property 
• Use one of the following methods: 

• Next to the property in the Properties tab, select Link  and 
select Unlink from base property. Unlink  appears and the 
screen property no longer inherits the value of the base 
property. 

• Change the value of the linked property. 
• Change the binding status of the linked property from bound to 

unbound or vice versa. 
• If the property is bound, change the Initial value or the Binding 

value of the property. 

 
Tip: The Border property does not support linking and unlinking. 

See also 
Property Definition tab on page 361 

Link a user-defined property to its base property on page 371 

Unlink a user-defined 
property from its base 
property 
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Create an alias property on page 361 

Create a user-defined property with a data type on page 365 

Shortcut customization on page 107 

How do I open the Property Definition tab? 

The Property Definition tab is located below the Screen area. Click 
Expand  below the screen to display the Property Definition tab if it 
is not open. 

The Property Definition tab contains the properties you create for the 
current screen, popup, or Add-On Graphic definition. Create a 
user-defined property to act as a placeholder for a value or data on a 
screen, Add-On Graphic definition, or popup. This enables you to use a 
screen multiple times by passing different values to the user-defined 
properties using a shortcut or navigation command.  

Using custom properties in View Designer increases the time it takes 
PanelView 5000 HMI devices to synchronize with changes to the 
controller program. When using custom properties in View Designer, 
expect increased synchronization time when downloading a revised 
controller program to the controller or making online changes to the 
controller program. 

Use the Property Definition tab to create, change, or delete a 
user-defined property. 

See also 
Create a user-defined property with a data type on page 365 

Search for and select a data type on page 373 

User-defined property on page 370 

Reuse Add-On Graphics on page 402 

This example depicts an Add-On Graphic with a mixer and a screen with 
additional mixer graphic elements. To have the screen and the Add-On 
Graphic on the screen show the values for the same mixer, bind the 
user-defined data type property that appears on an instance of the 
Add-On Graphic to the user-defined data type property of the screen. 
When a shortcut or navigation command passes a value into the 
user-defined property of the screen, graphic elements in the Add-On 
Graphic and on the screen show values from the same mixer. A Mixer1 
shortcut or popup shows the values of Mixer1, and a Mixer2 shortcut or 
popup shows the values of Mixer2. 

Property Definition tab 

Add-On Graphics on 
reusable screens 
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 Add-On Graphic definition 
Item Description 

 
Graphic elements in the definition of the Add-On Graphic. 

 
A user-defined data type property named MixerTag in the Property Definition tab of the 
Add-On Graphic definition. 

 
The Properties windows for graphic elements in the definition of the Add-On Graphic. 
The value of each graphic element is bound to a member of the MixerTag data type in 
the user-defined property using the format PropertyName.MemberName. For example, 
the mixer graphic element is bound to MixerTag.Level and the input graphic element is 
bound to MixerTag.LevelSP. Search for user-defined data type properties created for 
the definition of an  Add-On Graphic and the members of that property through the Tag 
Browser.  
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 Reusable screen 
Item Description 

 
A screen containing an instance of the Add-On Graphic.  

 
A user-defined data type property named MixerTag created in the Property Definition 
tab of the screen.   

 
The Properties window of the selected instance of the Add-On Graphic on the screen. 
The Add-On Graphic is bound to the MixerTag user-defined data type property of the 
screen.    

 HMI device 
Item Description 

 
The binding of a shortcut to the Mixer1 instance of the controller tag. This binding 
passes the value of the user-defined property from the shortcut to the screen. On the 
HMI device, the graphic elements on the screen and on the Add-On Graphic show the 
values for Mixer1. 

 
The binding of a navigation command to the MixerTag user-defined property of the 
screen. This binding passes the value of the user-defined data type property to the 
screen when the event occurs. When the popup opens on the HMI device, the popup 
shows the values of Mixer1.  

See also 
Controller tags and Add-On Graphics on page 420 

Create a user-defined data type property for an Add-On Graphic 
on page 378 

Create a user-defined property with a data type on page 365 

User-defined property on page 370 

Binding directly to a controller tag from an Add-On Graphic is not 
allowed. Binding an Add-On Graphic to a controller tag by passing the 
tag from an instance of the Add-On Graphic to the definition of the 
Add-On Graphic is supported. The user-defined data type property in the 
definition is associated with a Logix data type. Bind a graphic element in 
the definition of the Add-On Graphic to reference a property of that 
graphic element. Browse to properties and their extended properties, 
including members, using the Tag Browser or type the binding using the 
format PropertyName.Member. 

For example, if creating a user-defined data property called MixerTag for 
a data type called Mixer, bind a graphic element in the definition of the 
Add-On Graphic to any member of that Mixer data type, such as Level. 
Each instance of the data type in Studio 5000 Logix Designer contains 
the same tag members. For example, the Mixer data type may have a 
member named Level. The Level member then exists for each instance 
of the data type (for example, Mixer1, Mixer2, Mixer3, and so forth). Bind 
an instance of an Add-On Graphic to the Mixer1 controller tag through the 
user-defined data type property. The Add-On Graphic then shows the 
level of Mixer 1. Bind another instance of the Add-On Graphic to the 
Mixer2 tag to show the level of Mixer 2, and so forth.  

Binding an instance of an Add-On Graphic to a controller tag through a 
user-defined tag property allows for reuse of an Add-On Graphic to show 

Controller tags and Add-On 
Graphics 



Chapter 12  Reuse content 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 421 
 

a different value for each instance of the Add-On Graphic. The instance 
of the Add-On Graphic passes the name of the controller tag to the 
definition of the Add-On Graphic. The definition of the Add-On Graphic 
reads the member of the data type to show the value of the tag on the 
HMI device.  

See also 
Create a user-defined data type property for an Add-On Graphic 
on page 378 

Property Definition tab on page 361 

User-defined property on page 370 

Create user-defined properties for a screen, popup, or the definition of an 
Add-On Graphic. User-defined properties appear in the Properties 
window of a screen, popup, or instance of an Add-On Graphic. The value 
of a user-defined property applies to a screen when opening the screen 
using a shortcut or navigation command, or the value applies to the 
instance of an Add-On Graphic when opening the screen that contains 
the instance. Bind the properties of graphic elements on a screen, popup, 
or in the definition of an Add-On Graphic to user-defined properties. The 
value appears on the HMI device. 

Create two types of user-defined properties:  

• Data type. Data type properties generally tie elements on a 
screen popup, or Add-On Graphic to the member of a user-defined 
data type in the controller. Expose a Logix data type defined in the 
controller program on a reusable screen or in the definition of an 
Add-On Graphic. Properties of elements on a screen, popup or 
Add-On Graphic are bound to members of the data type in the 
controller. Select the instance of the Logix data type that the 
property is to use when reusing the screen or Add-On Graphic in a 
project. Change the data type property value for a reusable screen 
through shortcuts or navigation commands to the screen. Change 
the data type value property for an Add-On Graphic through 
instances of the Add-On Graphic. For example, if there is a Mixer 
type in a controller that is a data type property for the definition of 
an Add-On Graphic, use the Tag Browser to bind properties of 
elements within the definition of the Add-On Graphic definition to 
members of the Logix data type, such as mixer level and mixer 
temperature. When adding an instance of the Add-On Graphic to a 
screen, bind the data type property value to the instance of the 
Mixer type, such as Mixer 2, that the graphic element represents.    

• Alias. Alias properties generally change the value of graphic 
element properties that are not based on a tag in the controller. 
Expose a property of a graphic element on a reusable screen or in 
the definition of an Add-On Graphic. Change the property value 
when reusing the screen or Add-On Graphic in the project. 
Change alias properties for a reusable screen through shortcuts or 
navigation commands to the screen. Change alias properties for 
an Add-On Graphic through instances of the Add-On Graphic. 
Alias properties are either bound or static. For example, set a text 
label on a graphic element.  

Alias versus data type 
user-defined properties 



Chapter 12  Reuse content 
 

422 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

User-defined alias properties do not require binding or a data type 
structure in the controller. 

See also 
Reuse Add-On Graphics on page 402 

User-defined data type property binding for an Add-On Graphic on 
page 410 

User-defined alias property for an Add-On Graphic on page 413 

Create a user-defined property to act as a placeholder for a value or data 
on a screen, popup, or Add-On Graphic definition. This enables using a 
screen multiple times by passing different values to the user-defined 
properties using a shortcut or navigation command.  

There are two types of user-defined properties: 

• Alias. Create an alias property to reference the property of a 
screen or definition of an Add-On Graphic, or the property of a 
graphic element. The alias name is comprised of the element 
name and the specific property to expose separated by a period: 
ElementName.PropertyName 
Using an alias property in an expression is not supported. 

• Data type. Create a user-defined property with a data type to 
associate it with a data type contained in a Logix Designer project 
(.acd) file. Data type properties replace a specific Logix Designer 
tag instance when configuring bindings and expressions on the 
screen. The data type is Predefined, Module-defined, or 
User-defined (UDT). 

See also 
Property Definition tab on page 361 

Create an alias property on page 361 

Create a user-defined property with a data type on page 365 

Example of content reuse on page 359 

Reuse Add-On Graphics on page 402 

Create a project using content from one or more existing View Designer 
projects. This can reduce the risk of error, ensure consistency, and save 
time.  

For example, assume that you have multiple different projects, and the 
same users will be accessing them. You can configure the security 
access for each user in one project and then copy them to the other 
projects. 

User-defined property 

Reuse content from other 
View Designer projects 
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See also 
Reuse content on page 359 

Copy a controller reference   on page 87 

Copy an image between View Designer projects on page 324 

Copy a Security Administration user account on page 432 

Copy a controller reference within a View Designer project or from one 
View Designer project to another. This eliminates the need to manually 
enter the information in a project. Copy individual items from a controller 
reference or the entire controller reference. Paste controller references 
that are of the same version of Logix Designer. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If pasting content into another project, start an instance of View 

Designer and open the target project. Open no more than three 
instances of View Designer at one time.   

To copy a controller reference 
1. In the source project, select Project > Project Properties and 

select the References tab. 
2. Right-click the controller reference and select Copy. 

 
Tip: To copy a single item from a controller reference card, select the controller reference, 
select the item to copy, and then right-click and select Copy. 

3. In each target project: 
a. Select Project > Project Properties and select the References 

tab. 

b. Right-click the new controller reference card and select Paste. 
Pasting assigns the next available controller reference number.  

c. Select Apply to save changes and remain on the Project 
Properties dialog box, or select OK to save changes and close 
the Project Properties dialog box. 

Copy a controller reference  
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Tips:  
• Pasted controller references appear after the last controller reference card. Each controller 

reference card has a controller reference number that identifies the position on the References 
tab and the name of the referenced controller. When reopening the References tab, reference 
cards appear in order by controller reference number that appears in the Controller[#] Reference 
Name box. 

• After saving controller references, reference cards appear in order by controller reference number.  
• For PanelView 5310 HMI devices, View Designer does not support pasting a controller reference in a 

project that already contains a controller reference. 
• For PanelView 5510 HMI devices, paste up to four controller references in a project.  
• For multiple controllers and their tags to appear in the Tag Browser for a PanelView 5510 HMI 

device, the project file (.acd) for each referenced controller requires the same version of Logix 
Designer. 

• View Designer does not support pasting a number of controller references that exceeds the total 
allowed for an HMI device. A prompt appears to paste the copied controller references that do not 
exceed the maximum for the HMI device.  

• The maximum number of controller references appears at the top of the References tab and on 
the Usage & Capacity tab. Deleting the required number of controller references from the 
References tab removes the errors. 

See also 
Project Properties dialog box on page 68 

References tab on page 87 

Add a controller reference on page 85 

Remove a controller reference on page 88 

Reuse content on page 359 

Cut or copy table content within or across View Designer projects. Copy 
table rows or cells from State Tables and Color Tables. Copy rows from 
the table on the Property Definition tab. Single cells cannot be cut. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. 
Open up to three instances of View Designer at one time. 

To cut or copy table content 
1. Cut or copy the content: 

• To cut a table row, right-click the row to cut and select Cut. Only 
an entire row can be cut.  

• To copy a table row or cell, right-click the row or cell to copy and 
select Copy. Copy a single cell or a range of cells. 

2. Right-click on the row or cell to paste the content and select Paste. 

Cut or copy table content 
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Tips:  

• The yellow star burst  indicates a new row. 
• When pasting an entire row, the destination row must have the same number of columns as the 

source row. 
• Paste content into cells that have the same type of content.  
• Pasting data copied from an external program into a table is not recommended. 
• Pasting data copied from a table into an external program is supported. 

See also 
Configure an animation using a Color Table on page 437 

Configure an animation using a State Table on page 438 

Reuse content on page 359 

Copy a graphic element to reuse it on screens within a project or across 
View Designer projects. Copying a graphic element copies all of its 
properties, animations, and events. Copy single, multiple, or groups of 
graphic elements. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy a graphic element 
1. On the source screen or in the Graphic Explorer, right-click the 

graphic element and then select Copy. 
• To select multiple graphic elements or groups, hold Ctrl and 

select the items. 
2. On the target screen, right-click the location to paste the items and 

then select Paste. 

 
Tips:  
• If the target screen contains a graphic element with the same name, the name of the new graphic 

element is appended with a number that increments with each copy. 
• To cut a graphic element, right-click the graphic element and select Cut. 
• When copying a graphic element, any localized data associated with the graphic element is also 

copied. 

See also 
Graphic Explorer on page 132 

Duplicate a graphic element on page 150 

Reuse content on page 359 

Copy a graphic element 
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Copy an instance of an Add-On Graphic within a project on page 
397 

Copy an instance of an Add-On Graphic between projects on page 
398 

Copy a popup to reuse it within or across View Designer projects.  Paste 
a popup into the same folder in the Project Explorer to create a copy of 
the popup and append the name with an increment number. Pasting a 
popup into the Predefined Screens folder is not allowed. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy a popup  
1. In the source project, in the Project Explorer, right-click the 

popup and select Copy. 

 
Tip: To select multiple popups, hold Ctrl and select the items. 

2. Right-click the target folder and select Paste. If the target folder 
contains a popup with the same name, select one of two options:  
• Select Replace to overwrite the existing popup. 
• Select Keep Both to keep both popups. The name of the new 

popup is appended with a number that increments with each 
copy. 

Copy a popup 
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Tips:  
• Copying a popup that contains an instance of an Add-On Graphic to a different project that does 

not contain a popup with the same name adds the definition of the Add-On Graphic to the Assets > 
Add-On Graphics folder of the Project Explorer and adds the Add-On Graphic to the Toolbox 
category indicated for the Add-On Graphic. 

• Copying a popup that contains an instance of an Add-On Graphic to a different project that 
contains an Add-On Graphic with the same name provides three options:   
• Keep Both. Append the name of the copied Add-On Graphic definition with _001 or increment 

number. The definition appears in the folder and the Add-On Graphic appears in the Toolbox.  
• Replace. Replace the existing Add-On Graphic definition with the copied definition. Any 

instances of the existing Add-On Graphic are updated with the new definition of the Add-On 
Graphic.  

• Cancel. Do not paste the copied Add-On Graphic definition into the project. 
• If pasting a popup with an Add-On Graphic replaces an alias property in the definition of an Add-On 

Graphic and that alias is linked in an instance, the alias property shows in the Properties window 
of the instance, and the alias remains linked to the value of the base property in the definition. 

• If pasting a popup with an Add-On Graphic replaces an alias property in the definition of an Add-On 
Graphic and that alias is unlinked in an instance, the alias property shows in the Properties window 
of the instance, but the alias property retains its value from the original Add-On Graphic definition. 
The value of the alias property is not linked to the base property of the pasted Add-On Graphic 
definition. 

• Copying a popup that has an Add-On Graphic with an image that exists in both the source and 
target projects displays a prompt to replace the image. Images are copied to the Assets > Images 
folder of the Project Explorer. 

• When copying a popup, any localized data associated with the popup and its children is also 
copied. 

See also 
Create a popup on page 110 

Rename a popup on page 115 

Delete a popup on page 116 

What is a popup? on page 118 

Reuse content on page 359 

Copy a screen to reuse it within or across View Designer projects. Paste 
a screen into the same folder in the Project Explorer to create a copy of 
the screen and append the name with an increment number. Paste 
screens from the Predefined Screens folder only into the User-Defined 
Screens folder within or across projects. Content copied to a project with 
a different HMI screen size maintains its original size and position. 

Prerequisites: 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

Copy a screen 
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To copy a screen  
1. In the source project, in the Project Explorer, right-click the 

screen and select Copy. 

 
Tip: To select multiple screens, hold Ctrl and select the items. 

2. Right-click the target folder and select Paste. If the target folder 
contains a screen with the same name, select one of two options: 
• Select Replace to overwrite the existing screen. 
• Select Keep Both to keep both screens. The name of the new 

screen is appended with a number that increments with each 
copy. 

 
Tips:  
• Copying a screen that contains an instance of an Add-On Graphic to a different project that does 

not contain an Add-On Graphic with the same name adds the definition of the Add-On Graphic to 
the Assets > Add-On Graphics folder of the Project Explorer and adds the Add-On Graphic to the 
Toolbox category indicated for the Add-On Graphic. 

• Copying a screen that contains an instance of an Add-On Graphic to a different project that 
contains an Add-On Graphic with the same name provides three options:   
• Keep Both. Append the name of the copied Add-On Graphic definition with _001 or increment 

number. The definition appears in the folder and the Add-On Graphic appears in the Toolbox.  
• Replace. Replace the existing Add-On Graphic definition with the copied definition. Any 

instances of the existing Add-On Graphic are updated with the new definition of the Add-On 
Graphic.  

• Cancel. Do not paste the copied Add-On Graphic definition into the project. 
• If pasting a screen with an Add-On Graphic replaces an alias property in the definition of an 

Add-On Graphic and that alias is linked in an instance, the alias property shows in the Properties 
window of the instance, and the alias remains linked to the value of the base property in the 
definition. 

• If pasting a screen with an Add-On Graphic replaces an alias property in the definition of an 
Add-On Graphic and that alias is unlinked in an instance, the alias property shows in the Properties 
window of the instance, but the alias property retains its value from the original Add-On Graphic 
definition. The value of the alias property is not linked to the base property of the pasted Add-On 
Graphic definition. 

• Copying a screen that has an Add-On Graphic with an image that exists in both the source and 
target projects displays a prompt to replace the image. Images are copied to the Assets > Images 
folder of the Project Explorer. 

• When copying a screen, any localized data associated with the screen and its children is also 
copied. 

See also 
Create a screen on page 348 

Rename a screen on page 351 

Delete a screen on page 352 

Reuse content on page 359 

Project Explorer on page 95 

Copy a folder in the Project Explorer to reuse it within or across View 
Designer projects. Copying a folder also copies all of its subfolders. 

IMPORTANT Copying a folder to a different project does not copy screens or popups that contain 
user-defined properties. 

Copy a folder 
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Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy a folder  
1. In the source project, in the Project Explorer, right-click the folder  

to copy and select Copy. 
2. In the target folder, right-click the location to paste the folder and 

select Paste. 

 
Tips:  
• Copying a root-level folder (for example, Navigation Menu, User-Defined Screens, and Predefined 

Screens) is not allowed. 
• Copying a folder in the Navigation menu between projects is not allowed. 
• Copying and pasting subfolders between root-level folders.   
• Paste folders three levels deep. The new folder appears at the same level as the item on which the 

folder is pasted. Folders at the same level must have unique names. Pasting a folder with the same 
name as an existing folder appends a number to the name of the pasted folder. For example, 
FolderName_002. 

• Only content from the Predefined Screens folder can be copied into a Predefined Screens folder. 
Copying the System Banner is not allowed. 

• Cut a folder by selecting Cut instead of Copy. 
• Copying a folder copies any children of the folder as well as any localized data associated with the 

folder.  

See also 
Create a folder on page 558 

Delete a folder on page 560 

Rename a folder on page 561 

Reuse content on page 359 

Copy a shortcut to reuse it within a project.  

To copy a shortcut 
1. In the Project Explorer, expand the Navigation Menu folder. 
2. Right-click the shortcut and select Copy. 

 
Tip: To select multiple shortcuts, hold Ctrl and select the items. 

3. Right-click the location in the target Navigation Menu folder and 
select Paste.  

4. If the target folder contains a shortcut with the same name, select 
Keep Both to keep both shortcuts. The name of the new shortcut 
is appended with a number to distinguish it from the original. 

Copy a shortcut 
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Tips:  
• Copying an item from a folder in the Project Explorer and then pasting it in the same folder in the 

same project creates a copy of the item. The name of the pasted item is appended with a number 
that increments with each copy. 

• Copy and paste shortcuts in the Navigation Menu folder only.  

See also 
Create a shortcut to an existing screen on page 102  

Rename a shortcut on page 104 

Open the defining screen of a shortcut on page 105 

Delete a shortcut on page 106 

Copy the definition of an Add-On Graphic between projects to reuse the 
Add-On Graphic in another project. The content, properties, and 
behavior of the Add-On Graphic definition are copied. Any changes to 
the definition of the Add-On Graphic are copied to every instance of the 
Add-On Graphic in the project.  

Add-On Graphics must have unique names. When copying the definition 
of an Add-On Graphic with the same name between projects, keep both 
Add-On Graphic definitions, replace the existing Add-On Graphic 
definition, or choose not to paste the Add-On Graphic definition.  

Contents of the Add-On Graphic are handled in the same manner as the 
contents of any other screen copied between projects.  

To copy the definition of an Add-On Graphic between projects  
1. Open the project containing the Add-On Graphic to copy. 
2. In the Project Explorer, expand the Assets folder. 
3. Expand the Add-On Graphics folder.  
4. Right-click the Add-On Graphic to copy and select Copy.  
5. Open the project where to contain the pasted Add-On Graphic. 
6. In the Project Explorer, expand the Assets folder. 
7. Expand the Add-On Graphics folder.  
8. Right-click the Add-On Graphics folder and select Paste. 

If a definition of an Add-On Graphic with the same name does not 
already exist in the project, the definition appears in the folder and 
the Add-On Graphic appears in the Toolbox. 

9. Pasting the definition of the Add-On Graphic in a different project 
where an Add-On Graphic definition with the name already exists 
displays options:  
• Keep Both. Append the name of the copied Add-On Graphic 

definition with _001 or increment number. The definition 
appears in the folder and the Add-On Graphic appears in the 
Toolbox.  

• Replace. Replace the existing Add-On Graphic definition with 
the copied definition. Any instances of the existing Add-On 
Graphic are updated with the new definition of the Add-On 
Graphic.  

Copy the definition of an 
Add-On Graphic between 
projects 
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• Cancel. Do not paste the copied Add-On Graphic definition into 
the project. 

 
Tips:  
• Replacing an alias property in the definition of an Add-On Graphic as a result of a paste when that 

alias is linked in an instance displays the alias property in the Properties window of the instance. 
The alias remains linked to the value of the base property in the definition.  

• Replacing an alias property in the definition of an Add-On Graphic as a result of a paste when that 
alias is unlinked in an instance displays the alias property in the Properties window of the 
instance. The alias property retains its value from the original Add-On Graphic definition. The value 
of the alias property is not linked to the base property of the pasted Add-On Graphic definition.  

• Copying the definition of an Add-On Graphic that has an image that exists in both the source and 
target projects displays a prompt to replace the image or cancel. Images in a copied Add-On 
Graphic appear in the Assets > Images folder of the Project Explorer. 

The Add-On Graphic is available for use in the project.  

See also 
Work with instances of an Add-On Graphic on page 394 

Copy the definition of an Add-On Graphic within a project on page 
380 

Change the property values for the definition of an Add-On 
Graphic on page 376 

Rename an Add-On Graphic on page 380 

Copy an image between View Designer projects to ensure consistency 
or when access to the original image file does not exist. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy an image between projects 
1. Copy the image from the source project images folder to the target 

project Images folder. Alternatively, copy the image from the 
source screen to the target screen.  

2. If the target project contains an image file with the same image file 
name, overwrite the existing image file or cancel the copy 
operation. 
• Select Replace to overwrite the existing image file. 

Copy an image between 
View Designer projects 
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Tips:  
• When copying an image file that already exists in the target project when that image file contains 

a different graphic, View Designer adds an increment number to the name of the image in the 
target project. For example, if you copy an image named Tank1 and that image contains tank.bmp, 
and the target project also has an image file named Tank1 but that image contains watertank.bmp, 
the name of the image in the target project increments to Tank1_001. 

• Copying an image that has a removed graphic element shows a red X for the removed graphic 
element. If the image appears in an Add-On Graphic, the red X appears in both the definition of the 
Add-On Graphic and in instances of the Add-On Graphic.   

• Content pasted between projects of different terminal sizes is converted using the Do not scale 
scaling option. The screen content remains the same size and position as on the original screens.  

• Cut an image by selecting Cut instead of Copy. 
• Copying a screen or popup that contains an Image graphic element from one project to another, 

copies the image file associated with the graphic element and places the image file in the Assets 
folder of the target project. 

See also 
Copy a graphic element on page 138 

Add an image to a screen on page 326 

Replace an image throughout a project on page 330 

Copy an image assets folder on page 432 

Copy an image assets folder to add the image to the Images folder and 
make it part of the target project.  

To copy an image assets folder 
1. In the Project Explorer of the source project, open the Images 

folder located in the Assets folder.  
2. Right-click the image and select Copy. 
3. In the Project Explorer of the target project, expand the Assets 

folder.  
4. Right-click the Images folder and select Paste. 

See also 
Copy an image between View Designer projects on page 324 

Copy a Security Administration user account to reuse the information 
within and across View Designer projects. Copy individual items from the 
user account or copy an entire user account card including the password 
and PIN. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 

Copy an image assets 
folder 

Copy a Security 
Administration user 
account 
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recommended to open no more than three instances of View 
Designer at one time. 

To copy a Security Administration user account 
1. In the source project, select Tools > Security Administration. 
2. Select the Users tab to display the User Accounts box.  
3. In the User Accounts box, select a user account card, and then 

right-click and select Copy. 
• To copy a single item, highlight the item, and then right-click and 

select Copy. 
4. In each target project in the User Accounts box, select a card 

(outside of the User Name box), right-click and select Paste. The 
card pastes below the currently selected card. 
• If a new user card is selected, the card pastes above it. 
• To paste a single item, right-click the appropriate box on the 

user account card and select Paste. 
5. Select OK to apply the changes and close the dialog box. 

 
Tips:  
• Copy only one user card at a time. 
• A red outline around a box on a user account card indicates an error condition, such as a duplicate 

name or PIN. You must correct all errors before you can save the changes. 
• Cut a Security Administration user account by selecting Cut instead of Copy. 

See also 
Security Administration dialog box on page 685 

Users tab on page 686 

Add a Security Administration user account on page 688 

Security overview on page 698 
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Chapter 13 

Animate a graphic element or screen 

Use animation to enhance the graphical representation of the state of a 
machine or process on the HMI device. Animate screens by binding 
properties of graphic elements to tags or expressions. As the value of a 
tag or expression changes, the appearance or behavior of the graphic 
element changes. 

Animate screens by binding properties of graphic elements to tags or 
expressions so that the appearance or behavior of the graphic elements 
change as the values of the tag or expression change. 

Attach animations to groups of graphic elements and screens as well as 
to graphic elements and groups in a popup. Attaching an animation to the 
popup itself is not supported. 

Create animations for both the graphic elements within the definition of 
an Add-On Graphic, as well as instances of an Add-On Graphic.  

View Designer provides three methods for configuring animations:  

• Binding properties 
• Using a Color Table 
• Using a State Table 

See also 
Configure an animation using a Color Table on page 437 

Configure an animation using a State Table on page 438 

How do I open the Animations tab? 

On the Properties window, click the Animations tab. 

Use animation to enhance the graphical representation of the state of a 
machine or process on the HMI device. This can mean hiding or showing 
graphic elements, including Add-On Graphics, and changing the 
appearance of the elements or moving them on the screen.  

Use the Animations tab to: 

• Use a Color Table or a State Table to animate a graphic element 
or screen. 

• Add or delete an animation. 
• Configure or change an animation. 
• View the animations associated with a graphic element or screen. 

Use a Color Table to: 

• Affect only the color properties of a graphic element or screen (for 
example, fill color, button color, border color).  

Animations tab 
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Use a State Table to: 

• Affect the Appearance, Position and Size, or General properties 
(for example, height, width, rotation angle) for a graphic element or 
screen.  

• Use a State Enter or State Exit event to trigger a command (for 
example, write a tag value to a controller when the State Table 
enters a specific state).  

See also 
Configure an animation using a Color Table on page 437 

Configure an animation using a State Table on page 438 

Events tab on page 447 

How do I open the Color Table Definition dialog box? 

On the Properties window, click the Animations tab. Click Add 
Animation and click Color Table. 
Use a Color Table to configure animations that can affect any or all of the 
color properties (for example, fill color, color, font color) of a graphic 
element, Add-On Graphic, or screen.  

Configure multiple color states and multiple Color Tables for a graphic 
element or Add-On Graphic. 

Use the Color Table Definition dialog box to: 

• Specify the number of states.  
• Select the properties to animate. 

See also 
Configure an animation using a Color Table on page 437 

Animations tab on page 435 

How do I open the State Table Definition dialog box? 

On the Properties window, click the Animations tab. Click Add 
Animation and click State Table. 
Use the State Table to configure animations to affect the Appearance, 
Position and Size, or General properties (for example, visibility, rotation 
angle, fill color) of a graphic element, Add-On Graphic, or screen. To use 
a State Enter or a State Exit event to drive animation, create a State 
Table before creating the event. 

Configure multiple states for each graphic element and Add-On Graphic. 
Configure more than one State Table per graphic element and Add-On 
Graphic. 

Use the State Table Definition dialog box to: 

• Specify the number of states to animate.  
• Select the properties to animate.  

Color Table Definition dialog 
box 

State Table Definition dialog 
box 
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See also 
Configure an animation using a State Table on page 438 

Animation using a Color Table or State Table on page 401 

Animations tab on page 435 

Configure an animation to change the color of a graphic element, 
Add-On Graphic, or screen based on the value of an associated tag or 
expression. Color animation can be applied to any color property of a 
selected element. 

IMPORTANT • Do not use a State Table or Color Table to modify a property that is already bound to 
a tag or expression. This can cause undesired results. Property values change based 
on which input modifies the property first. There is no way to determine the order of 
inputs. 

• Modifying a property across multiple State Tables or Color Tables can cause 
undesired results. Property values change based on which input modifies the 
property first. There is no way to determine the order of inputs. 

• When renaming a graphic element that is referenced by a State Table or a Color 
Table, change the reference to reflect the new graphic element name. View Designer 
does not automatically update the references with the new name. 

To configure an animation using a Color Table   
1. Select the screen or graphic element to animate.  
2. On the Properties window, select the Animations tab.  
3. Select Add Animation > Color Table.  
4. In the Name box of the Color Table Definition dialog box, enter a 

name for the Color Table. 
5. In the Number of states box, enter or select the desired number 

of states. For example, to use color to indicate two different states, 
such as running or stopped, type or select the number 2. 

 
Tip: The maximum supported number of states for one element on a screen is 2500.  
If any screen in the project exceeds 42000 states across all its elements, it is not possible to 
later convert the project to a newer version. 

6. Select the properties to affect and select OK. The Color Table 
card appears in the Animations tab of the Properties window.  

7. In the Expression box on the card, select Select tag  to select 
a tag, or type a tag name, to base an expression on.  
• Edit the expression, if necessary, to define the condition that will 

drive the animation. On the HMI device, the result of this 
expression is compared to the Expression Values (entered in 
the next step), and the appropriate color changes are applied. 

 
Tip: An Expression Value can be: 
• An integer number. Any positive or negative number up to 15 digits. 
• A floating point number. Any positive or negative number up to 15 significant digits in 

the range of  1.7 x 10±308. 
• A string. Any sequence of alpha-numeric characters enclosed in quotation marks. 

8. In the Color Table, for each state, complete these boxes:  
• Expression Value. Type the value, range of values, or string 

value (in surrounding quotation marks) to trigger the color 
change for the state.   

• Color Value. The actual column titles correspond to the color 
properties selected. Type the Hex value in the format 

Configure an animation 
using a Color Table 
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#RRGGBB. R, G, and B are Hex digits from 0 through F and 
represent the color channel values for red, green, and blue. For 
example, #ffff00 produces yellow. Alternatively, select the down 
arrow or color swatch to open the Color Picker, and select or 
create a color.     

See also 
Configure an animation using a State Table on page 438 

Create an expression on page 520 

Animations tab on page 435 

Configure an animation to change the properties of a graphic element, 
Add-On Graphic, or screen based on the value of an associated tag or 
expression.  

IMPORTANT • Do not use a State Table or Color Table to modify a property that is already bound to 
a tag or expression. This can cause undesired results. Property values change based 
on which input modifies the property first. There is no way to determine the order of 
inputs. 

• Modifying a property across multiple State Tables or Color Tables can cause 
undesired results. Property values change based on which input modifies the 
property first. There is no way to determine the order of inputs. 

• Do not use any of the following words as a state name: 
• state 
• states 
• properties 
• readonly 
• parent 
• type 
• name 
• id 
• persisted 
• objectname 

When renaming a graphic element that is referenced by a State Table or a Color Table, 
change the reference to reflect the new graphic element name. View Designer does not 
automatically update the references with the new name. 
• Do not configure a State Table that causes its states to act on each other in an 

infinite loop. Doing so may cause slow performance. 
• Continual tag writes using State Enter or State Exit events may cause slow 

performance. It is recommended to not continually write more than 10 tags per 
second. 

 

To configure an animation using a State Table 
1. Select the graphic element, Add-On Graphic, or screen to 

animate. 
2. On the Properties window, click the Animations tab.  
3. Click Add Animation > State Table. 
4. In the Name box of the State Table Definition dialog box, enter a 

name for the State Table. 
5. In the Number of states field, enter or select the desired number of 

states. For example, to animate three states (such as idle, 
running, and stopped) type or select the number 3. 

Configure an animation 
using a State Table 
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Tip: The maximum number of states for one element on a screen is 2500.  
If any screen in the project exceeds 42000 states across all its elements, it is not possible to 
later convert the project to a newer version. 

6. Select the properties to affect and select OK. The State Table 
card appears in the Animations tab of the Properties window. 

7. In the Expression box on the card, select Select tag  to select 
a tag, or type a tag name, to base an expression on. 

8. Edit the expression, if necessary, to define the condition to drive 
the animation. On the HMI device, the result of this expression is 
compared to the values of the expression and changes the 
properties.   

9. For each state, complete the following:   
• Expression Value. Type the value, range of values, or string 

value (in surrounding quotation marks) to trigger the property 
changes for the state.  

 
Tips:  
• An Expression Value can be: 
• An integer number. Any positive or negative number up to 15 digits. 
• A floating point number. Any positive or negative number up to 15 significant digits in the range 

of ±1.7 x 10±308. 
• A string. Any sequence of alpha-numeric characters enclosed in quotation marks.  

• Expressions can contain Unicode characters. View Designer supports Unicode characters that 
appear in the Arial Unicode MS font.    

• When inserting text that contains Unicode characters in a graphic element, select Arial Unicode MS 
in the FontName property of the graphic element. Supported Unicode characters appear on the 
HMI device. 

• State Name. Enter the name of the state (for example, Idle, 
Running, Stopped).  

• Property values. For color-related properties, type the Hex 
value in the format #RRGGBB. R, G, and B are Hex digits from 
0 through F and represent the color channel values for red, 
green, and blue. For example, #ffff00 produces yellow. 
Alternatively, select the down arrow or color swatch to open the 
Color Picker, and select or create a color. 

 
Tips:  
• Property values do not support bindings or expressions. 

• To display and edit the entire State Table, select Open table editor .  
• Changes are saved automatically. 

See also 
Configure an animation using a Color Table on page 437 

Create an expression on page 520 

What is binding? on page 502 

After creating an animation for a graphic element, including an Add-On 
Graphic, or screen, modify it. For example, adjust the value that drives 
the animation. 

 
Tip: If an event references a State Table and then the name of the table changes, change the 
reference to reflect the new State Table name. View Designer does not automatically update 
references with the new name. 

Change an animation  
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To change an animation 
1. Select the graphic element, Add-On Graphic, or screen that 

contains the animation to change. 
2. On the Properties window, select the Animations tab. 
3. Select the appropriate State Table or Color Table.  
4. Change any or all of the properties in the table. Changes are 

saved automatically.  

See also 
Animations tab on page 435 

Delete an animation on page 440 

Delete an animation from a graphic element, Add-On Graphic, or screen 
to no longer have it appear on the HMI device. Deleting an animation 
does not delete any State Enter or State Exit events configured for the 
animation. 

To delete an animation 
1. Select the graphic element, Add-On Graphic, or screen. 
2. On the Properties window, select the Animations tab. 
3. In the upper right corner of the appropriate State Table or Color 

Table card, select Delete Animation .   

See also 
Change an animation   on page 439 

Animations tab on page 435 

A Color Table or State Table searches its list of states from top to 
bottom for the first state that matches the value of the input expression. 
Rules applied to how the value of the input expression is compared to the 
Expression Values in the table include: 

• Integer numbers containing 15 digits or less are compared to 
Expression Values directly.  

• Integer numbers containing more than 15 digits are rounded to a 
15-significant-digit double value in Engineering Format and then 
compared to the Expression Value.  

• Floating point numbers are rounded to five significant digits and 
then compared to Expression Values using fuzzy comparison.   

• Strings are compared to the actual content of the Expression 
Value. 

Using a Color Table or a State Table can affect more than one property 
simultaneously when the tag value or expression changes. Create Color 
Tables and State Tables on the Animations tab in the Properties 
window. The tables are similar in design and behavior, but the Color 
Table is used exclusively for color animation.  

Delete an animation 

Animation using a Color 
Table or State Table 
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• Use a Color Table to affect only the color properties of a graphic 
element. This option is available on the Animations tab only if the 
selected graphic element has a color property. Unlike State 
Tables, Color Tables cannot be used with State Enter or State 
Exit events.  

• Use a State Table to affect the Appearance, Position and Size, or 
General properties of a graphic element or to drive an animation 
with a State Enter or a State Exit event.  

Use multiple State Tables and Color Tables for a graphic element or 
screen.  

The tables reduce the need for custom scripting. To animate a graphic 
element, select the element and use a State Table or a Color Table to: 

• Set the condition to drive the animation. The condition is the input 
to the state table. Bind directly to a tag or build an expression 
using the integrated Expression Editor. Use numeric, range, 
and/or string values within the same table.  

• Identify the states the animation is to indicate, such as running, 
stopped, or temperature levels. 

• Select the properties of the graphic element to affect for each 
state, such as FillColor or Visibility. Only the properties to animate 
are available. Select multiple properties.  

• Specify the value to trigger the animation associated with each 
state (Expression Value).  

Whenever the input value to a Color Table or a State Table changes, 
the table searches the Expression Values from top to bottom. The first 
Expression Value that matches the input value triggers the 
corresponding color or state change. 

If the input value does not match any of the Expression Values, the 
animation uses the values in the Default row of the table. The Default 
values reflect the values of their corresponding properties in the 
Properties tab. Changing the value of the property in the Properties tab 
changes its value in the Default row of the Color Table. The Default row 
cannot be edited or removed. 

IMPORTANT • Do not use a State Table or Color Table to modify a property that is already bound to 
a tag or expression. This can cause undesired results. Property values change based 
on which input modifies the property first. There is no way to determine the order of 
inputs. 

• Modifying a property across multiple State Tables or Color Tables can cause 
undesired results. Property values change based on which input modifies the 
property first. There is no way to determine the order of inputs. 

•  

See also 
Animation using property binding on page 442 

Configure an animation using a Color Table on page 437 

Configure an animation using a State Table on page 438 

Bind a color property to a tag or expression on page 500 
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How the output value of a Color Table or a State Table is 
calculated on page 443 

Animate a property of a graphic element by binding the property directly 
to a tag or expression.  

Bind color properties only to string tags. Binding to an integer tag, a 
floating point tag, or an expression is not supported and will not produce 
a change in the color. 

IMPORTANT • Changes to a graphic element name are not propagated to a State table or Color 
table when the graphic element is referenced in the State table or Color table 
expression. For example, if a Color table expression is bound to 
NumericDisplay_001.value and the element name changes to NumericDisplay_002, 
update the table manually in order for the table to work with the renamed graphic 
element. 

• State Enter events do not execute when navigating to a screen if the expression in 
the state table uses element property binding. 

See also 
Animation using a Color Table or State Table on page 401 

The methods to configure each animation type include: 

Use this 
animation 
type 

For this effect Using one of these methods Using these properties or tags 

Color 
Table 

State 
Table 

Property 
binding 

Color Draw attention to a graphic element or to 
indicate status. 

   Add one or more color properties to the Color Table or State 
Table or bind directly to them.  
Tip: Bind color properties only to string tags. Binding to an 
integer tag, a floating point tag, or an expression is not 
supported and will not produce a change in the color. 

Fill Show the level of the contents of a tank or 
other graphic element with a Level 
property.  

   Add a tank level property to the State Table or bind directly to 
it. 

Position Show motion, such as a product moving 
down a conveyor belt. Combine this 
method with size to show a perspective 
view of a graphic element moving.  

   Add the X, Y properties to the State Table or bind directly to 
them. 

Rotation Show angular motion, such as the hands 
moving on a clock. 

   Add the Angle property to the State Table or bind directly to it. 

Opacity Gradually show or hide a graphic element.    Add an opacity property to the State Table or bind directly to 
it. 

Visibility Show or hide screen content.    Add the Visible property to the State Table or bind directly to 
it. 

Size Use Size animation in combination with 
Position animation to show a perspective 
view of a graphic element moving. (The 
object becomes smaller as it moves away). 

   Add the Height, Width properties to the State Table or bind 
directly to them. 

Blink Draw attention to an element.    Bind the selected property (typically Visibility) to one of the 
Display system tags: Display.BlinkFast, Display.BlinkMedium, 
Display.BlinkSlow. 

Availability Prevent user interaction with a graphic 
element. 

   Bind to the Enabled property of a graphic element. 

See also 

Animation using property 
binding 

Animation types and their 
configuration methods 
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• Configure an animation using a Color Table on page 437 
• Configure an animation using a State Table on page 438 
• Bind a color property to a tag or expression on page 500 
• Animation using a Color Table or State Table on page 401 
• Animations tab on page 435 

When creating animations for graphic elements and Add-On Graphics 
within groups, consider that: 

• Invisibility overrides visibility. If a group is made invisible, all 
graphic elements within the group are invisible.This is true even if 
a graphic element has an individual visibility animation that 
normally makes that graphic element visible. 

• If a group is made visible, all graphic elements within the group are 
visible unless their visibility property is set to false. Set the visibility 
property to false by using animation, binding, an event, or the 
property value.   

• Color animations for individual graphic elements in a group 
override color animations for the entire group. 

See also 
Configure an animation using a Color Table on page 437 

Configure an animation using a State Table on page 438 

Animations tab on page 435 

Specify a single value or a value range for an Expression Value in a 
Color Table or in a State Table. An Expression Value can be: 

• An integer number. Any positive or negative number up to 15 
digits. 

• A floating point number. Any positive or negative number up to 
15 significant digits in the range of ±1.7 x 10±308. 

• A string. Any sequence of alpha-numeric characters enclosed in 
quotation marks.  

See also 

• Animations tab on page 435 
• Configure an animation using a Color Table on page 437 
• Configure an animation using a State Table on page 438 
• How the output value of a Color Table or a State Table is 

calculated on page 443 
A Color Table or State Table searches its list of states from top to 
bottom for the first state that matches the value of the input expression. 
Rules applied to how the value of the input expression is compared to the 
Expression Values in the table include: 

• Integer numbers containing 15 digits or less are compared to 
Expression Values directly.  

• Integer numbers containing more than 15 digits are rounded to a 
15-significant-digit double value in Engineering Format and then 
compared to the Expression Value.  

Animations and groups 

What can be used as an 
Expression Value in a Color 
Table or State Table 

How the output value of a 
Color Table or a State Table 
is calculated 
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• Floating point numbers are rounded to five significant digits and 
then compared to Expression Values using fuzzy comparison.   

• Strings are compared to the actual content of the Expression 
Value. 

See also 
Animations tab on page 435 

Configure an animation using a Color Table on page 437 

Configure an animation using a State Table on page 438 

Fuzzy comparison and output values of a state table on page 445 

Add a Button Behavior event to a graphic element or Add-On Graphic to 
have the element perform typical button actions. Button Behavior events 
apply typical button behaviors to a graphic element by performing 
pre-configured commands. For example, you can create a Button 
Behavior event that sets a tag to 1 on a touch press and sets the same 
tag to 0 on a touch release. This is useful for creating events for a button 
to start and stop a conveyor belt. Button behavior events include internal 
commands that you do not have to configure. Graphic elements and 
Add-On Graphics can have only one Button Behavior event.  

You can use an external keyboard with the HMI device. The L1 through 
L10 keys listed when creating Key Press and Key Release events 
correspond with pressing Shift+F1 through Shift+F10 keys on an 
external keyboard. The R1 through R10 keys listed when creating Key 
Press and Key Release events correspond with pressing Ctrl+F1 
through Ctrl+F10 on an external keyboard. 

To trigger an action on a Button Behavior event 
1. On the screen, right-click the graphic element or Add-On Graphic 

and then select Button Behavior. 

 
Tip: Adding a Button Behavior event for the selected element is also done through the Events 
tab of the Properties window. 

2. Select the button behavior. 

 
Tip: An instance of an Add-On Graphic cannot bind directly to a controller tag. Bind an 
instance of an Add-On Graphic to a controller tag by creating a user-defined data type 
property in the definition of the Add-On Graphic. 

3. To have the event occur even if focus is not first set by tabbing to 
the graphic element, clear the Requires Focus check box.  

4. For momentary button behaviors such as Set a tag to 1 on press, 
0 on release and Set a tag to 0 on press, 1 on release, check 
the Always Trigger Release Event box. 

Trigger an action on a 
Button Behavior event 
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Tips:  
• Selecting the behavior type after entering a tag leaves the selected tag in the Tag box. This occurs 

unless the selected behavior is HMIBC or navigation. For example, selecting Tag_1 for the Set a tag 
to 1 on release behavior and changing to Set a tag to 0 on release, leaves Tag_1 configured for the 
new selection. 

• By default, Button Behavior events work with touch only. To have a key press activate the Button 
Behavior event, in the Key box, select an HMI device key. Press the selected key or touch the 
graphic element to trigger the event.  

• Clear the Always Trigger Release Event check box to not commit to a press action. This allows a 
finger to slide off the graphic element without triggering the release event.  

 

See also 
Button behaviors on page 449 

Create a high-speed HMIBC button on page 490 

Bind an Add-On Graphic to a user-defined data type property on 
page 409 

What is HMI Button Control? on page 489 

In what order are touch events triggered? on page 478 

View Designer converts values that are being transmitted to numeric 
tags in the controllers, such as DIN, SINT, or REAL, into a number based 
on the following rules: 

• If the first character is 0 and the second character is an x, the rest 
of the data is treated as a hexadecimal number (base 16). 

• If the first character is 0 and the second character is a digit from 0 
to 7, the rest of the data is treated as an octal number (base 8). 

• If the value contains a decimal point, the value is treated as a 
floating point input. Based on the target tag type, the value may be 
rounded. 

• If the first character is a digit from 1 to 9, the rest of the value is 
treated as a base 10 number. 

• If value contains the letter e, the characters that follow it are 
treated as the exponent (base 10) for the number. 

• If the first character is a + or -, it is treated as a sign for the number. 
The resulting number is based on the rules described above. For 
example, -020 is treated as a negative octal number. 

• If the value contains any character except digits (0 to 9), ., +, -, or 
e, it is treated as an error. 

See also 
Bind a property to a data item on page 508 

Fuzzy comparison is used to compare uncertain or imprecise data. For 
example: .1 + .1 + .1 + .1 + .1 + .1 + .1 + .1 + .1 + .1 (.1 added 10 times) 
does not equal 1.0 because .1 cannot be stored exactly in floating point 
format. (The value is represented as a repeating bit pattern, like 1/3 = 
.333... in decimal.)  

How View Designer 
converts values that are 
transmitted to numeric tags 

Fuzzy comparison and 
output values of a state 
table 
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Fuzzy comparison provides a way to ensure that input expression values 
are consistently calculated and compared with the Expression Values to 
ensure predictable output values.  

For example, two values are determined equal if the following inequality 
is true:  

| value1 - value2 | <= 0.00001 * Min( | value1 |, | value2 | )  
or stated another way: 

AbsoluteValue("0.00001"( value1 - value2 ) <= (1.0 E-5) * 
SmallerValueOf( AbsoluteValue( value1 ), AbsoluteValue( value2 
) )  

The fuzzy comparison algorithm uses the resolution factor of 0.00001 
because Logix controllers use the REAL data type to store floating point 
data. The REAL data type stores values to seven or eight significant 
digits of precision. When using floating point numbers: 

• Do not specify more than five significant digits for the Expression 
Value.  

• Because 32-bit floating point values have, at most, approximately 
7.2 significant digits, and Logix 5000 encodes its real value as an 
eight-digit string, the least significant digit (LSD) may be an invalid 
digit. However, the LSD is still compared as if it is a valid digit. 
Verify that the eighth digit is valid. 
For example, typing 3123.45111 into a Logix 5000 tag value is 
saved as 3123.4512. If the eighth digit (LSD) is valid, it saves as 
3123.4511.  

See also 
Animations tab on page 435 

Configure an animation using a Color Table on page 437 

Configure an animation using a State Table on page 438 

How the output value of a Color Table or a State Table is 
calculated on page 443 

How View Designer converts values that are transmitted to 
numeric tags on page 445 
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Chapter 14 

Configure an event to trigger an action 

An event triggers an action on the HMI device. The operator on the HMI 
device or the system can trigger an event.  

Events can be added and configured to trigger an action when a: 

• Graphic element behaves like a button  
• Graphic element or screen is pressed or released 
• Key on an external keyboard is pressed or released 
• Graphic element enters or exits a selected state 

Graphic elements on the HMI device include Add-On Graphics.  

See also 
What is an event? on page 476 

Events tab on page 447 

Events and Add-On Graphics on page 400 

How do I open the Events tab? 

On the Menu bar, click VIEW > Properties Window, and click the 
Events tab. 

Import the desired languages before changing the language that appears 
on the HMI device. 

Use the Events tab to: 

• Add an event. Define what occurs to trigger an action. For 
example, add an event for when releasing a graphic button or key, 
or when pressing or releasing the screen or key. Add events 
typically performed by a button. For example, a Button Behavior 
event can configure a graphic element to act as a momentary push 
button or high-speed HMIBC button.  
Add events to a graphic element, Add-On Graphic, screen, popup, 
or the System Banner. For each event, configure the action that 
triggers when the event takes place. For example, an event of 
pressing a graphic element could trigger the action of opening a 
specific screen. 

• Configure a command. Define the action triggered when the 
event occurs. For example, the command can log off the project, 
navigate to a screen, increment a value, or calibrate the HMI 
device screen for touch.   

• Change the command an event performs. Delete the command 
and add a new command for the event.  

Configure an event to 
trigger an action 

Events tab 



Chapter 14  Configure an event to trigger an action 
 

448 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

• Delete a command. Delete a command from an event so the 
command does not trigger when the event occurs.  

See also 
What is an event? on page 476 

Trigger an action on a Button Behavior event on page 444 

Trigger an action on a Key Press or a Key Release event on page 
451 

Import a language file on page 671 

Export text strings for language translation on page 670 

Add a Button Behavior event to a graphic element or Add-On Graphic to 
have the element perform typical button actions. Button Behavior events 
apply typical button behaviors to a graphic element by performing 
pre-configured commands. For example, you can create a Button 
Behavior event that sets a tag to 1 on a touch press and sets the same 
tag to 0 on a touch release. This is useful for creating events for a button 
to start and stop a conveyor belt. Button behavior events include internal 
commands that you do not have to configure. Graphic elements and 
Add-On Graphics can have only one Button Behavior event.  

You can use an external keyboard with the HMI device. The L1 through 
L10 keys listed when creating Key Press and Key Release events 
correspond with pressing Shift+F1 through Shift+F10 keys on an 
external keyboard. The R1 through R10 keys listed when creating Key 
Press and Key Release events correspond with pressing Ctrl+F1 
through Ctrl+F10 on an external keyboard. 

To trigger an action on a Button Behavior event 
1. On the screen, right-click the graphic element or Add-On Graphic 

and then select Button Behavior. 

 
Tip: Adding a Button Behavior event for the selected element is also done through the Events 
tab of the Properties window. 

2. Select the button behavior. 

 
Tip: An instance of an Add-On Graphic cannot bind directly to a controller tag. Bind an 
instance of an Add-On Graphic to a controller tag by creating a user-defined data type 
property in the definition of the Add-On Graphic. 

3. To have the event occur even if focus is not first set by tabbing to 
the graphic element, clear the Requires Focus check box.  

4. For momentary button behaviors such as Set a tag to 1 on press, 
0 on release and Set a tag to 0 on press, 1 on release, check 
the Always Trigger Release Event box. 

Trigger an action on a 
Button Behavior event 
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Tips:  
• Selecting the behavior type after entering a tag leaves the selected tag in the Tag box. This occurs 

unless the selected behavior is HMIBC or navigation. For example, selecting Tag_1 for the Set a tag 
to 1 on release behavior and changing to Set a tag to 0 on release, leaves Tag_1 configured for the 
new selection. 

• By default, Button Behavior events work with touch only. To have a key press activate the Button 
Behavior event, in the Key box, select an HMI device key. Press the selected key or touch the 
graphic element to trigger the event.  

• Clear the Always Trigger Release Event check box to not commit to a press action. This allows a 
finger to slide off the graphic element without triggering the release event.  

 

See also 
Button behaviors on page 449 

Create a high-speed HMIBC button on page 490 

Bind an Add-On Graphic to a user-defined data type property on 
page 409 

What is HMI Button Control? on page 489 

In what order are touch events triggered? on page 478 

An event where a graphic element or Add-On Graphic behaves like a 
button triggers specific button behavior. When creating a Button 
Behavior event for a graphic element or Add-On Graphic, select a 
behavior:  

Behavior  Description 
Set a tag to 1 on release Set the value of the selected tag to 1 by releasing the button. 

To configure this command, in the Tag box, enter or browse to select the tag.  
Set a tag to 0 on release Set the value of the selected tag to 0 by releasing the button. 

To configure this command, in the Tag box, enter or browse to select the tag.  
Set a tag to 1 on press, 0 on release Set the value of the selected tag to 1 by pressing the button and then setting 

the value to 0 by releasing the button. Select a minimum hold time for this 
button behavior. 
To configure this command, in the Tag box, enter or browse to select the tag.  
For momentary button behaviors, press the button for a minimum length of 
time. The button stays pressed even when releasing the button before the 
minimum hold time. To set a minimum hold time for the momentary button, 
select the Minimum Hold Time box, and then select a minimum hold time. 
Pressing the button again before the minimum hold time expires is not 
allowed. If a screen or popup containing the button closes before the hold 
time expires, the hold time resets. The minimum hold time does not support 
binding. 

Set a tag to 0 on press, 1 on release Set the value of the selected tag to 0 by pressing the button and then setting 
the value to 1 by releasing the button. Select a minimum hold time for this 
button behavior. 
To configure this command, in the Tag box, enter or browse to select the tag.  
For momentary button behaviors, keep the button pressed for a minimum 
length of time. The button stays pressed even when releasing the button 
before the minimum hold time. To set a minimum hold time for the 
momentary button, select the Minimum Hold Time box, and then select a 
minimum hold time. Pressing the button again before the minimum hold time 
expires is not allowed. If a screen or popup containing the button closes 
before the hold time expires, the hold time resets. The minimum hold time 
does not support binding. 

Button behaviors 
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Toggle a tag on release Toggle the value of the selected BOOL tag from 0 to 1, or from 1 to 0, by 
releasing the button. 
To configure this command, in the Tag box, enter or browse to select the 
BOOL tag.  

Write to a tag on release Write a value to the selected tag by releasing the button. Specify the value 
with a number, a tag, or an expression. 
To configure this command, in the Tag box, enter or browse to select the tag. 
In the expression box, create the expression value to write to the tag when 
you release the button.  

Incrementally change a tag on release Increment the value of the selected tag by releasing the button. Specify the 
value with a number, a tag, or an expression. 
To configure this command, in the Tag box, enter or browse to select the tag. 
In the By box, create the expression value by which to increment the tag 
when releasing the mouse button. The increment can be either negative or 
positive. 

Logix HMIBC set to 1 on press, 0 on release Use high priority communication to set the value of the .ButtonState member 
of the selected HMIBC tag to 1 when pressing the button, and to 0 when 
releasing the button. 
To configure this command, in the HMIBC Tag box, select an HMIBC type tag. 
The Tag Browser filters HMIBC type tags from the Logix Designer project file 
(.acd). Select the HMIBC type tag only. Creating an HMIBC button using the 
Logix HMIBC set to 1 on press, 0 on release Button Behavior option 
automatically uses the .ButtonState member of the HMIBC tag. 

Logon on release Open the Log On dialog box to log on to the HMI device. When the Log On 
dialog box opens, any open popup closes. 

Logoff on release Log the current user off the HMI device. This logs on the Guest user role 
automatically to show only the items to which the Guest role has access.  

Open popup on release Open a specific popup when the event occurs.  
To configure this command, in the Open Popup box, navigate to and select 
the popup the event is to open. The popups listed exist in the User-Defined 
Screens and Predefined Screens folders of the Project Explorer. Only popups 
appear for the Popup Open command. Only one popup at a time can open on 
the HMI device. When a popup opens, any previously open popup closes.    
If the selected popup has a user-defined data type property, a Property 
Configuration box appears under the command. To pass a value to the popup 
on the HMI device when the popup opens, bind the value in the Property 
Configuration box to the user-defined data type property of the popup. 

Close popup on release Close the popup on the HMI device when the event occurs. Only one popup at 
a time can open on the HMI device. 

Navigate to screen on release Open the specified screen or shortcut by releasing the button.  
To configure this command, in the Navigate To box, select the shortcut or 
screen the event is to open. Navigate to the contents of the Navigation Menu, 
User-Defined Screens, and Predefined Screens folders of the Project 
Explorer. 
If the selected screen has a user-defined data type property, a Property 
Configuration box appears under the command. To pass a value to the 
screen on the HMI device when the screen opens, bind the value in the 
Property Configuration box to the user-defined data type property of the 
screen. 

Navigate backward on release Navigate back in history to open the screen opened using the Navigation 
menu or a Screen Navigate command.  
Logging off the HMI device erases the navigation history. 

Navigate forward on release Navigate forward in history to open the screen opened using the Navigation 
menu or a Screen Navigate command.  
Logging off the HMI device erases the navigation history. 

Show Navigation Menu on release Open the Navigation menu on the HMI device screen by releasing the button. 
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Switch language on release Switch to a specific language when the event occurs.  
Tip: Import the desired languages before switching to a specific language.  

See also 
Trigger an action on a Button Behavior event on page 444 

Events tab on page 447 

What is an event? on page 476 

Import a language file on page 671 

Export text strings for language translation on page 670 

Configure an action to occur when touching or releasing a key on the 
HMI device. For example, create a Key Press event so that pressing L1 
on the HMI device opens a specific screen. 

You can use an external keyboard with the HMI device. The L1 through 
L10 keys listed when creating Key Press and Key Release events 
correspond with pressing Shift+F1 through Shift+F10 keys on an 
external keyboard. The R1 through R10 keys listed when creating Key 
Press and Key Release events correspond with pressing Ctrl+F1 
through Ctrl+F10 on an external keyboard.  

To trigger an action on a Key Press or a Key Release event 
1. Select the item to have the event. The item can be a graphic 

element, a graphic element in the definition of an Add-On 
Graphic, an Add-On Graphic instance, a group of elements, a 
screen, a popup, or the System Banner. 

 
Tip: Select items on either the Screen area, Project Explorer, or Graphic Explorer. 

2. In the Properties pane, click the Events tab. 
3. Select Add Event and select an event from the list. 

• Key Press. Occurs when pressing a designated key on the HMI 
device or on an external keyboard. 

• Key Release. Occurs when releasing a designated key on the 
HMI device or an external keyboard.  

4. In the Key box, select the key to use for the event. 
5. To have the event occur even if the graphic element does not have 

focus when the event triggers, clear the Requires Focus 
checkbox. By default, this check box is not selected. Therefore, 
the event still triggers even when the graphic element does not 
have focus. This may occur when pressing Tab to highlight 
another graphic element on the screen. Placing focus on a graphic 
element requires pressing Tab to highlight the graphic element. 

6. If a Release event requires that the event of the graphic element 
triggers not only when releasing the element or key, but even if 
another screen opens, select the Always Trigger Release Event 
checkbox. This setting is useful for having the element act like a 
momentary push button where a Press event sets a tag to 1 to 

Trigger an action on a Key 
Press or a Key Release 
event 
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start a conveyor belt, and a Release event sets the same tag to 0 
to stop the conveyor belt. 

7. Select Add Command. 
8. Expand a command category to list the commands in that 

category:  
• Alarm History. Cancel export of the alarm history, clear alarm 

history, or export alarm history. 
• Data Log. Cancel export of data log, clear data log, or export 

data log to a USB or SD card.  
• HMI Device Configuration. Configure screen calibration, load 

a runtime application from removable media to the HMI device, 
reboot the HMI device, and safely remove media. 

• Language. Change the language that displays on the HMI 
device. 

 
Tips:  
• Import the desired languages before changing the language that displays on the HMI device. 
• If a translatable string is left blank, View Designer defaults to the download language for runtime 

applications downloaded to the HMI device. If the string that is translated for the download 
language is also blank, View Designer defaults to the language used for designing the project. 

• Navigation. Navigate to screens on the HMI device. 

 
Tip: Multiple screen navigation commands can exist for an event. All other types of 
commands for the event are executed before the navigation command. Only one 
navigation command is executed for an event. This is generally the first navigation 
command. The remaining navigation commands are ignored on the HMI device. To ensure 
the navigation command is the navigation command executed, Rockwell Automation 
recommends adding only one navigation command to an event.  

• Notification. Send an email notification. 
• PDF. Commands that zoom or navigate pages in a PDF file. 
• Security. Log on or log off the HMI device. 

9. Value. Commands that increment, toggle, or write a value to the 
selected tag.Select and configure the command the event is to 
perform.  

 
Tips:  
• Create multiple commands for each event. The order of execution may not correspond with the 

order of commands listed on the Event card. 
• Creating many tag write commands for an event may pause screen updates while the writes occur. 
• When an event performs multiple commands that write to multiple tags, all of the write commands 

occur sequentially. Therefore, you may not see all of the tag values in the Logix controllers at the 
same time. 

See also 
Event commands on page 456 

Events tab on page 447 

Trigger an action on a Button Behavior event on page 444 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a State Enter or State Exit event on page 454 
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Configure an action to occur when pressing or releasing a graphic 
element or the screen on the HMI device. For example, create a Touch 
Press event so that a specific screen opens when touching a graphic 
element.   

To trigger an action on a Touch Press or a Touch Release event 
1. Select the item to have the event. The item can be a graphic 

element, a graphic element in the definition of an Add-On 
Graphic, an Add-On Graphic instance, a group of elements, a 
screen, a popup, or the System Banner. 

 
Tip: Select items on either the Screen area, Project Explorer, or Graphic Explorer. 

2. In the Properties pane, click the Events tab. 
3. Select Add Event and select an event from the list. 

• Touch Press. Occurs when pressing a screen or element on 
the HMI device.  

• Touch Release. Occurs when releasing a screen or graphic 
element on the HMI device.   

4. If a Touch Release event requires that the event of the element 
trigger even if a finger slides off the element before releasing the 
element, the graphic element becomes disabled or invisible, or a 
screen navigation opens a different screen, select the Always 
Trigger Release Event checkbox. This setting is useful for having 
the element act like a momentary push button. For example, a 
Touch Press sets a tag to 1 to start a conveyor belt, and a Touch 
Release event sets the same tag to 0 to stop the conveyor belt. 

5. Select Add Command. 
6. Expand a command category to list the commands in that 

category:  
• Alarm History. Cancel export of the alarm history, clear alarm 

history, or export alarm history. 
• Data Log. Cancel export of data log, clear data log, or export 

data log to a USB or SD card.  
• HMI Device Configuration. Configure screen calibration, load 

a runtime application from removable media to the HMI device, 
reboot the HMI device, and safely remove media. 

• Language. Change the language that displays on the HMI 
device. 

 
Tips:  
• Import the desired languages before changing the language that displays on the HMI device. 
• If a translatable string is left blank, View Designer defaults to the download language for runtime 

applications downloaded to the HMI device. If the string that is translated for the download 
language is also blank, View Designer defaults to the language used for designing the project. 

• Navigation. Navigate to screens on the HMI device. 

 
Tip: Multiple screen navigation commands can exist for an event. All other types of 
commands for the event are executed before the navigation command. Only one 
navigation command is executed for an event. This is generally the first navigation 
command. The remaining navigation commands are ignored on the HMI device. To ensure 
the navigation command is the navigation command executed, Rockwell Automation 
recommends adding only one navigation command to an event.  

• Notification. Send an email notification. 
• PDF. Commands that zoom or navigate pages in a PDF file. 

Trigger an action on a 
Touch Press or a Touch 
Release event 
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• Security. Log on or log off the HMI device. 
7. Value. Commands that increment, toggle, or write a value to the 

selected tag.Select the command the event is to perform.  

 
Tips:  
• Create multiple commands for each event. The order of execution may not correspond with the 

order of commands listed on the Event card. 
• Creating many tag write commands for an event may pause screen updates while the writes occur. 
• When an event performs multiple commands that write to multiple tags, all of the write commands 

occur sequentially. Therefore, you may not see all of the tag values in the Logix controllers at the 
same time. 

See also 
Event commands on page 456 

Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a Button Behavior event on page 444 

Trigger an action on a State Enter or State Exit event on page 454 

In what order are touch events triggered? on page 478 

Configure an action to occur when a graphic element, Add-On Graphic, 
screen, popup, or System Banner enters or exits a specified state. 
Configure states using the State Table on the Animations tab. 

Prerequisites  
• Verify that the graphic element, screen, popup, or System Banner 

is configured for State Table animation. 

To trigger an action on a State Enter or State Exit event 
1. Select the item to have the event. The item can be a graphic 

element, a graphic element in the definition of an Add-On 
Graphic, an Add-On Graphic instance, a group of elements, a 
screen, a popup, or the System Banner. 

 
Tip: Select items on either the Screen area, Project Explorer, or Graphic Explorer. 

2. In the Properties pane, click the Events tab. 
3. Select Add Event and select an event from the list. 

• State Enter. Occurs when a graphic element, Add-On Graphic, 
screen, popup, or the System Banner transitions into the 
selected state through an animation. 

• State Exit. Occurs when a graphic element, Add-On Graphic, 
screen, popup, or the System Banner transitions out of the 
selected state through an animation. 

4. In the State Table box, select the State Table containing the 
desired state. 

5. In the State Name box, select the state to trigger the event.  
6. Select Add Command. 

Trigger an action on a State 
Enter or State Exit event 
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7. Expand a command category to list the commands in that 
category: 
• Alarm History. Cancel export of the alarm history, clear alarm 

history, or export alarm history. 
• Data Log. Cancel export of data log, clear data log, or export 

data log to a USB or SD card.  
• HMI Device Configuration. Configure screen calibration, load 

a runtime application from removable media to the HMI device, 
reboot the HMI device, and safely remove media. 

• Language. Change the language that displays on the HMI 
device. 

 
Tips:  
• Import the desired languages before changing the language that displays on the HMI device. 
• If a translatable string is left blank, View Designer defaults to the download language for runtime 

applications downloaded to the HMI device. If the string that is translated for the download 
language is also blank, View Designer defaults to the language used for designing the project. 

• Navigation. Navigate to screens on the HMI device. 

 
Tip: Multiple screen navigation commands can exist for an event. All other types of 
commands for the event are executed before the navigation command. Only one 
navigation command is executed for an event. This is generally the first navigation 
command. The remaining navigation commands are ignored on the HMI device. To ensure 
the navigation command is the navigation command executed, Rockwell Automation 
recommends adding only one navigation command to an event.  

• Language. Command that changes the language that displays 
on the HMI device.  

• Notification. Send an email notification. 
• State. Commands that apply a state from the selected State 

Table. 

 
Tips:  
• Import the desired languages before changing the language that displays on the HMI device. 
• If a translatable string is left blank, View Designer defaults to the download language for runtime 

applications downloaded to the HMI device. If the translated string for the download language is 
also blank, View Designer defaults to the language used for designing the project. 

• PDF. Commands that zoom or navigate pages in a PDF file. 
• Security. Log on or log off the HMI device. 

8. Value. Commands that increment, toggle, or write a value to the 
selected tag. 

9. Select and configure the command the event is to perform. 

 
Tips:  
• Create multiple commands for each event. The order of execution may not correspond with the 

order of commands listed on the Event card. 
• Creating many tag write commands for an event may pause screen updates while the writes occur. 
• When an event performs multiple commands that write to multiple tags, all of the write commands 

occur sequentially. Therefore, you may not see all of the tag values in the Logix controllers at the 
same time. 

See also 
Event commands on page 456 

Configure an animation using a State Table on page 438 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 
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Delete an event on page 476 

Select a command under a category to perform when an event triggers: 

Category Command Description 

Alarm History Cancel Alarm History Export Cancels the export of the alarm history. 
Clear Alarm History Removes all alarm events stored on the HMI device. 
Export Alarm History Exports a .csv file for the alarm history in the project to a .zip file and places the .zip 

file on a USB drive or SD card to review the alarm history on a computer. 
Certificates Delete Certificate Deletes a digital certificate stored on the HMI device. This command requires 

entering the fingerprint of a specific certificate. 

Import Certificate Imports a digital certificate with a specified file name. 
Data Log Cancel Data Log Export Cancels the export of the data log. 

Clear Data Log Clears the contents of all data logs or selected data logs. 

Export Data Log Exports a .csv file for each data log in the project to a .zip file and places the .zip file 
on a USB drive or SD card to review the data log on a computer. 

HMI Device 
Configuration 

Calibrate Touch Screen Calibrates the HMI device screen for touch. This command displays a red target on 
the screen. Press and hold the center of the target until the target turns white and 
another red target appears. Continue pressing and holding the centers of all 
remaining targets as they appear. All processed targets are replaced with white 
targets. A green circle with a check indicates successful calibration. A red circle with 
an X indicates a failed calibration. 
If a red circle with an X appears, perform the event again to calibrate the screen. 

Load Application Loads the specified runtime application file to the HMI device from either a USB 
storage or an SD card. 

Reboot Terminal Reboots the HMI device immediately. 
Safely Remove Media Prepares the SD card for safe removal from the HMI device so the files do not 

become corrupt or read-only. 
Language Switch Language Changes the language that displays on the HMI device. 

Tip: Import the desired languages before changing the language that displays on the 
HMI device. 

Navigation Navigate Backward Navigates back in history to the screen opened using the Navigation menu or a 
Screen Navigate command.  
Logging off the HMI device erases the navigation history.  

Navigate Forward Navigates forward in history to the screen opened using the Navigation menu or a 
Screen Navigate command.  
Logging off the HMI device erases the navigation history. 

Open web browser Opens the web browser in a new window. 
Close web browser Closes the web browser. 

Popup Close Closes the popup on the HMI device when the event occurs. Only one popup can be 
open on the HMI device at a time. 

Popup Open Opens a specific popup when the event occurs. Only one popup can be open on the 
HMI device at a time. 
In the Open Popup box, navigate to and select the popup the event is to open. If the 
selected popup has a user-defined data type property, bind the value in the Property 
Configuration box to the user-defined data type property of the popup. This passes 
the value to the popup when it opens on the HMI device.  
If a graphic element on the popup to open has an aliased property with a value, the 
Popup Open command can read the value from a referenced graphic element and 
apply it to the alias. In the Property Configuration box at the bottom of the 
command, enter the name of the graphic element and the property that has the 
value to apply to the aliased property. Use the format ElementName.PropertyName. 
When the event triggers, the graphic element on the popup with the aliased property 
shows the property value of the graphic element that is referenced in the Property 
Configuration box. The Property Configuration box appears for the command only if 
there is an aliased property or user-defined property on the target popup.   

Event commands 
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Category Command Description 

Screen Navigate Opens the specified shortcut or screen when the event occurs.  
In the Navigate To box, select the screen or shortcut that the event is to open. If the 
selected screen or shortcut has a user-defined data type property, bind the value in 
the Property Configuration box to the user-defined data type property of the screen 
or shortcut. This passes the value to the screen when it opens on the HMI device.   
If a graphic element on the screen to open has an aliased property with a value, the 
Screen Navigate command can read the value from a referenced graphic element 
and apply it to the alias. In the Property Configuration box at the bottom of the 
command, enter the name of the graphic element and the property that has the 
value to apply to the aliased property. Use the format ElementName.PropertyName. 
When the event triggers, the graphic element on the screen with the aliased property 
shows the property value of the graphic element that is referenced in the Property 
Configuration box. The Property Configuration box appears for the command only if 
there is an aliased property or user-defined property on the target screen. 

Show Navigation Menu Opens the Navigation menu on the HMI device screen when the event occurs. 
Notification Send Email Sends an email with a configurable subject and message to one or more recipients. 

First configure the email server connection from the Settings screen on the HMI 
device.  

PDF Previous Page Navigates to the previous page in a PDF document. 
Next Page Navigates to the next page in a PDF document. 
Go To Page Navigates to a specified page in a PDF document. 
Zoom in Increases the document magnification by a percentage of the preset level in a PDF 

document. 
Zoom out Decreases the document magnification by a percentage of the preset level in a PDF 

document. 
Zoom to Adjusts the magnification to fit the page, fit the width of the page, or display the 

page at 100% magnification. 
Security Logon Opens the Log On dialog box when the event occurs. When the Log On dialog box 

opens, any open popup closes. 
Logoff Logs you off the project. If the Guest user role has security access to the current 

screen, the screen remains open. If the Guest user role does not have security 
access to the current screen, the Home screen opens.   

State State Previous Applies the previous state in the selected State Table to the graphic element when 
the event occurs. To configure this command, in the box in the command card, 
select the name of the desired State Table. Select Wrap Around to continue to apply 
states when the event occurs, even if the beginning or end of the State Table is 
reached.  
If you create a State event with a State Previous command with Wrap Around 
selected, the graphic element loops through states in the State Table as the event 
occurs. 

State Next Applies the next state in the selected State Table to the graphic element when the 
event occurs. To configure this command, in the box in the command card, select 
the name of the desired State Table. Select Wrap Around to continue to apply states 
when the event occurs, even if the beginning or end of the State Table is reached.  
If you create a State event with a State Next command with Wrap Around selected, 
the graphic element loops through states in the State Table as the event occurs. 

Value Increment Increments the value of the selected tag when the event occurs. Specify the value 
with a number, a tag, an expression, an element property, or the property of a screen 
or Add-On Graphic.  
In the Increment box, enter or browse to select the tag or property of a screen or 
Add-On Graphic. In the By box, create the expression value by which to increment the 
tag when the event occurs. The increment can be either negative or positive.  

Toggle Toggles the value of the selected tag from 0 to 1, or from 1 to 0, when the event 
occurs.  
In the Tag box, enter or browse to select the tag or property of a screen or Add-On 
Graphic.  
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Category Command Description 

Write  Writes a value to the selected tag when the event occurs. Specify the value with a 
number, a tag, an expression, an element property, or the property of a screen or 
Add-On Graphic.  
In the Write To box, enter or browse to select the tag or property of a screen or 
Add-On Graphic. In the Expression box, create the expression value to write to the 
tag when the event occurs. 

 

 
Tips:  
• For best performance, create commands that evaluate no more than 20 tags. 

For example, it is best for a Write command to have an expression containing no more than 20 
tags or a Send Email command to embed no more than 20 tags in the message. 

• For commands with expressions using many tags in a reference, have 10 or fewer such commands 
in an event for best performance.  

• Using larger numbers of tag references in many commands may cause slow screen performance 
while those commands evaluate. 

• Reference 1000 or fewer tags across all the project events. Using a larger number of tag 
references may cause delays in PanelView 5000 recovery from controller disconnects. 

• If the HMI device processes a large number of background tasks, like multiple triggered alarms, 
you may need to repeat a button press to execute the button commands. 

See also 
Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a State Enter or State Exit event on page 454 

Import a language file on page 671 

Export text strings for language translation on page 670 

Add an event command to navigate a screen or popup on the HMI 
device. Do this to open a screen, navigate screen history, open or close a 
popup, or open the Navigation menu on the HMI device.   

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command for navigation on the HMI device 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Navigation category and select the command: 

Add an event command for 
navigation on the HMI 
device 
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• Navigate Backward. Navigates back in history to the screen 
opened using the Navigation menu or a Screen Navigate 
command.  

• Navigate Forward. Navigates forward in history to the screen 
opened using the Navigation menu or a Screen Navigate 
command.  

 
Tip: Logging off the HMI device erases the navigation history. 

• Show Navigation Menu. Opens the Navigation menu on the 
HMI device screen when the event occurs. 

• Popup Close. Closes the popup on the HMI device when the 
event occurs. Only one popup at a time can open on the HMI 
device. 

• Popup Open. In the Open Popup box, navigate to and select 
the popup the event is to open. 

• Screen Navigate. Opens the specified screen when the event 
occurs. In the Navigate To box, select the shortcut or screen 
that the event is to open.  

 
Tips:  
• If the selected screen or popup for a Screen Navigate or Popup Open command has a user-defined 

data type property, bind the value in the Property Configuration box to the user-defined data type 
property of the shortcut or popup. This passes the value to the screen or popup when it opens on 
the HMI device.   

• If a graphic element on the screen or popup to open for a Screen Navigate or Popup Open 
command has an aliased property with a value, the Screen Navigate command or Popup Open 
command can read the value from a referenced graphic element and apply it to the alias. In the 
Property Configuration box at the bottom of the command, enter the name of the graphic element 
and the property that has the value to apply to the aliased property. Use the format 
ElementName.PropertyName. When the event triggers, the graphic element on the screen or popup 
with the aliased property shows the property value of the graphic element that is referenced in the 
Property Configuration box. The Property Configuration box appears for the command only if there 
is an aliased property or user-defined property on the target screen or popup. 

See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Add an event command to calibrate the touch screen of the HMI device. 
The Calibrate Touch Screen command displays a red target on the 
screen of the HMI device. At runtime, press and hold the center of the 
target until the target turns white and another red target appears. 
Continue pressing and holding the centers of all remaining targets as 
they appear. All processed targets are replaced with white targets. A 
green circle with a check indicates a successful calibration.  

A red circle with an X indicates a failed calibration. If a red circle with an X 
appears, perform the event again to calibrate the screen. 

Add an event command to 
calibrate the touch screen 
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Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to calibrate the touch screen 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the HMI Device Configuration category and select 

Calibrate Touch Screen. 

See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Create an event command to change that language that displays the 
runtime application on the HMI device. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to change the language on the HMI device 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Language category and select Switch Language. 
4. In the Switch Language To list, select a language.  

Add an event command to 
change the language on the 
HMI device 
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See also 
Add a language to a View Designer project on page 672 

Import a language file on page 671 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

About changing the project language on page 675 

Add an event command to change the state of a graphic element. For 
example, have a graphic element fill with color or change colors when the 
event is triggered by a state change on the HMI device.    

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to change the state of a graphic element 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the State category and select the command:  

• State Previous. Applies the previous state in the selected State 
Table to the graphic element when the event occurs. Select the 
name of the desired State Table.  

• State Next. Applies the next state in the selected State Table to 
the graphic element when the event occurs. Select the name of 
the desired State Table.  

 
Tips:  
• Select Wrap Around to continue to apply states when the event occurs, even when reaching the 

beginning or end of the State Table.  
• Creating a State event with a State Previous command with Wrap Around selected loops the 

graphic element through states in the State Table as the event occurs. 

See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Add an event command to 
change the state of a 
graphic element 
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Trigger an action on a Key Press or a Key Release event on page 
451 

Add an event command to change the value of a tag. Do this to change 
the appearance of or the displayed value on a graphic element on the 
HMI device.    

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to change the value of a tag 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Value category and select the command: 

• Increment. Increments the value of the selected tag when the 
event occurs. Specify the value with a number, a tag, or an 
expression. In the Increment box, enter or browse to select the 
tag and in the By box, create the expression value by which to 
increment the tag when the event occurs. Increment by either a 
negative or positive value.  

• Toggle. Toggles the value of the selected tag from 0 to 1, or 
from 1 to 0, when the event occurs. In the Tag box, enter or 
browse to select the tag. 

• Write. Specify the value with a number, a tag, or an expression. 
In the Write To box, enter or browse to select the tag. In the 
expression box, create the expression value to write to the tag 
when the event occurs. 

See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Add an event command to 
change the value of a tag 
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Create an event to navigate pages or change the view in a PDF 
document. Add a PDF navigation command to a touch or key event to 
navigate to the previous page, next page, or a specific page in a PDF. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To create an event command to interact with a PDF Viewer graphic 
element 

1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the PDF category and select and configure the command:  

• Next Page. Navigates to the next page in the PDF when the 
event triggers. 

• Previous Page. Navigates to the previous page in the PDF 
when the event triggers. 

• Go to Page. Navigates to the specified page in the PDF. In the 
Page box, enter the page number to display when the event 
triggers. 

• Zoom In. Increases the document magnification by a 
percentage of the preset level in a PDF document. In the 
ByPercent box, enter a value to increase magnification. 

• Zoom Out. Decreases the document magnification by a 
percentage of the preset level in a PDF document. In the 
ByPercent box, enter a value to decrease magnification. 

• Zoom To. Adjusts the magnification of the PDF to fit an entire 
page, fit the width of the page, or show the page at 100% in the 
PDF Viewer. In the Zoom list, select a magnification option. 

 
Tips:  
• Bind a PDF command property value to a tag in a controller to change the PDF property 

dynamically on the HMI device. If there is a problem with a tank, bind the specific page number of 
the PDF document to a tag for user assistance. The controller opens the document to the specified 
page explaining how to fix the issue. 

• Project events do not support PDF commands. 

See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Add an event command to 
interact with a PDF graphic 
element 
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Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Create an event to load a runtime application from a USB storage device 
or SD card. Add a Load Application command to a touch or key event to 
load the application. When triggered on the HMI device, the event with 
the command loads the .vpdr file from the specified removable media. If 
required, the Load Application command updates the firmware version 
on the PanelView 5000 HMI device before loading the runtime 
application file. To enable updating firmware, copy the correct version of 
the .dmk firmware file to the removable media along with the .vpdr 
application file.  

 
Tip: Firmware update using the Load Application command only works in two cases: 
1. When the firmware on the HMI device is already V6 or later, and the firmware you want to load is V6 

or later. 
2. When the HMI device is running out-of-the-box manufacturing firmware, was manufactured after 

the V6 release date, and the firmware you want to load is V6 or later. 

 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to load a runtime application 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the HMI Device Configuration command category and 

select Load Application. 
4. Under Load Application from on the command card, in the 

Source box, select USB or SD Card.  
5. In the FileName box, type the name of the runtime application to 

load. 

 
Tip: Bind the FileName box of the Load Application event command to a graphic element 
property or a tag in the controller. Binding the file name specifies the file name to load on the 
HMI device. For example, bind the FileName box of the Load Application event command to 
the text property of Text Input graphic element. Use the Text Input graphic element to then 
enter the name of the .vpdr file to load from the removable media to the HMI device.  

6. In the HMItoControllerPath box, specify the controller path to use 
by selecting either: 
• Keep paths on HMI device. Use the HMI to controller path 

currently in use on the HMI device. 

Add an event command to 
load a runtime application 
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• Load path in VPDR file. Use the HMI to controller path in the 
runtime application file that is loading. 

7. In each box, select Select tag  to open the Tag Browser and 
browse to select the tag or manually enter a graphic element 
property to receive the value to display on the HMI device when 
the event command triggers: 
• FirmwareUpdateRequired. Whether or not a firmware update 

is required on the HMI device to load the runtime application file 
from the removable media.  

• VPDRMajorVersion. The major version of the runtime 
application file on the removable media. 

• FirmwareVersionToInstall. The version of the firmware that 
the Load Application command installs on the HMI device 
from the removable media.  

 
Tip: Rockwell Automation recommends binding to tags of graphic element properties in 
the FirmwareUpdateRequired, VPDRMajorVersion, and FirmwareVersonToInstall boxes to 
display updated firmware version information on the HMI device when loading the 
runtime application file.  

See also 
Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Event commands on page 456 

What is an event? on page 476 

Save a runtime application to removable media on page 63 

Add a command to an event to automatically send an email notification 
when the event triggers on the HMI device. For example, send an email 
automatically when a tank reaches or drops below a certain level by 
adding a Send email command to a State Enter or State Exit event. To 
send an email after pressing a button, add a Send email command to a 
touch press event on the graphic element.   

Prerequisites  
• Create an event to automatically trigger the command:  

• Touch Press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch Release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key Press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 
• State Enter. Occurs when a graphic element, screen, popup, or 

the System Banner transitions into the selected state through 
an animation.  

Add an event command to 
send an email 
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• State Exit. Occurs when a graphic element, screen, popup, or 
the System Banner transitions out of the selected state through 
an animation.  

IMPORTANT To send an email when a State Enter or State Exit event triggers, verify that 
the graphic element, screen, popup, or System Banner is configured for 
State Table animation. 

To add an event command to send an email 
1. Select the graphic element configured with the event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Messaging command category and select Send 

email. 
4. Complete the property boxes on the command card:    

• Recipient. The email addresses of the email recipients, 
separated by commas or semicolons.  

• Subject. The subject of the email. 
• Message. The complete text of the email to send.  
• Status. The status of the sent email in Numeric format (DINT). 

Status does not support binding to element properties. Bind this 
property to a controller tag to display the status code of the last 
email sent by the command: 
• Successfully sent: 10. This code indicates the email was 

successfully sent to all recipients.  
• Error returned from email server: 20. This code indicates 

multiple errors such as a timeout while sending the email, an 
incorrect email address, or a communication error with the 
email server.  

• Unable to reach email server: 30. This code indicates 
multiple errors such as an invalid password, invalid user 
name, or invalid server name. 

• Sending is in progress (email added to queue): 40. This code 
indicates an email is in progress to a recipient. 

• Email request rejected: 50. This code indicates the maximum 
buffer size of 120 email requests are in queue. Decrease the 
number of email commands that execute simultaneously. 

 
Tips:  
• Manually enter values in the property boxes to send a pre-configured static message when the 

event triggers. Use this method when sending only one or two emails and when entering 
information directly in the command is preferred. 

• To send a large number of emails with updated information from the system when the event 
triggers, bind the property boxes to tags in a controller. 

See also 
Event commands on page 456 

What is an event? on page 476 

Bind a property to a data item on page 508 

Configure the SMTP server to send email on page 747 
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Add an event command to either log on or log off the HMI device. Do this 
navigate a screen or popup on the HMI device. Do this to open a screen, 
navigate screen history, open or close a popup, or open the Navigation 
menu on the HMI device.   

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to navigate screens 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Security category and select the command: 

• Logon. Opens the Log On dialog box and closes any open 
popup when the event occurs.  

• Logoff. Logs off the project.  

 
Tip: When logging off, if the Guest user role has security access to the current screen, the 
screen remains open. If the Guest user role does not have security access to the current 
screen, the Home screen opens. 

See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Add an event command to reboot the HMI device. Rebooting the HMI 
device is also performed through the Settings screen on the HMI device.   

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

Add an event command to 
log on or log off the HMI 
device 

Add an event command to 
reboot the HMI device 
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• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to reboot the HMI device 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the HMI Device Configuration category and select 

Reboot Terminal. 

See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Create an event that prepares the SD card that is in the HMI device for 
safe removal. When triggered, the event prevents the files on the SD 
card from becoming corrupt or read-only. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to safely remove media 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the HMI Device Configuration command category and 

select Safely Remove Media. 

 
Tip: To create an indication of when the SD card is safe to remove, use the status from the 
DataLogStatus system tag. 

See also 
Event commands on page 456 

Add an event command to 
safely remove media 
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Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Create an event command to export a data log to view the tag values 
collected on the HMI device. When triggered on the HMI device, the 
event exports all of the data logs in the View Designer project. Data logs 
export to a USB storage device or SD card for a PanelView project as a 
.zip file. The .zip file contains a .csv file for each data log.  

For a PanelView project, create an additional event to allow the safe 
removal of the removable media from the HMI device so that files on the 
media do not become corrupt. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add event commands to export a data log 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Data Log category and configure the command: 

• Export Data Log. Creates and exports each data log in .csv 
format to a .zip file:  
• In the Destination box of the command card, select USB or 

SD Card for a PanelView project. 
• In the FileName box, type the name of the export .zip file for 

the data log.  
• Cancel Data Log Export. Cancels the export of the data log to 

the HMI device. Partial data logs do not export. No .zip file 
appears in the destination. 

Add an event command to 
export a data log 
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Tips:  
• Bind the FileName box of the Export Data Log event command to a graphic element property or a 

tag in a controller. Binding the file name specifies the data log to export on the HMI device. For 
example, bind the FileName box of the Export Data Log event command to the text property of Text 
Input graphic element. This displays the name of the data log on the Text Input graphic element 
that exports the data log from the HMI device. 

• Exporting the same data log file to the same removable media creates a new export file each time. 
The file name increments by one. This may cause the USB storage device, SD card, or destination 
to reach capacity. For example, DataLog_002 indicates a second instance of an exported data log 
named DataLog. 

• When the data log is exporting, the Data Export icon  appears in the System Banner. If there 

is an error exporting a data log, the Data Export Error icon  appears in the System Banner. 
• Data log exports do not complete or create a .zip file on removable media if a ControlFLASH, 

reboot, or power cycle to the HMI device occurs during the export. 
• The data log file contains tag values from all controllers. 

See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Create an event to clear data logs. Add a clear data log command to 
clear one or more data logs, or all data logs at once. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add event commands to clear a data log 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Data Log category and select and configure the 

command: 
a. Data Log. Select All data logs or select a specific data log name. 

b. Status. The status of the data log in Numeric format (DINT). 
Status does not support binding to element properties. Bind this 

Add an event command to 
clear one or more data logs 
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property to a controller tag to display the status code of the data 
log: 

• Data log clearing in progress: 10. 
• Data log successfully cleared: 20. 
• Unable to clear data log. Data log is not configured: 30. 
• Unable to clear data log. Data log is not running: 40. 
• Selected data log does not exist: 50. 
• Clear data log command is already in progress: 60. 
• Unable to clear data log. Export is in progress: 70. 
• Unable to clear data log. Insert SD card: 80. 
• Unable to restart the cleared data log. Remove and replace 

the SD card: 90. 
• Unable to clear the data log. Try again or restart terminal: 

100. 
4. Configure another command to clear additional data logs. 

See also 
Data log tab on page 665 

Data log contents on page 665 

Create an event command to open the web browser and access a 
specified URL. 

IMPORTANT The web browser is not supported by the PanelView 53xx HMI device family. 

Configure a command to allow the HMI device operator to access content 
on the intranet, the Internet, remote file servers, devices with built-in web 
pages, removable SD cards or USB drives, or IP cameras. 

 
Tips:  
• By default, the web browser blocks access to all locations. Configure the allowed locations list for 

the HMI device users. 
• Some locations do not use the default ports 80 and 433. To enable access, setup open ports 

specific to these locations. 

The web browser supports the following protocols:  

• HTTP 
• HTTPS 
• BLOB, WS, WSS (included in HTTP and HTTPS) 

To access removable media use these schemas:  

• sd:/ 
• usb:/ 

EXAMPLE SD:/videos/video1.mp3. 

You can run only one instance of web browser at a time. To run a 
different instance of the web browser (for example, to access a different 
location) first close the running instance. The web browser supports only 
one window or tab at a time. Links that open a page in a new tab or new 
window may not function. Bookmarks, file downloads and uploads are 

Add an event command to 
open the web browser 
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disabled. The HMI device does not retain browsing history, login data, or 
cookies. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to open Web Bowser 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Navigation category, select Open Web Browser, 

and configure the command: 
• URL. Specifies the first location to open when the web browser 

starts. Use http://, https://, sd:/, or usb:/ schemes. 
• TopBar. Select the look and the behavior of the top bar of the 

web browser: 
• None. Hides the address bar and navigation buttons. 
• Slim (read-only). Displays only the address bar. 
• Normal (read-only). Displays full top bar. The address bar is 

read-only. 
• Normal (editable). Displays full top bar. The operator can 

enter URLs in the address bar. 
• CloseOnLostFocus. Closes the web browser when the focus 

shifts to other screen elements. For example, the web browser 
closes when you select an element outside the web browser. 
This property is selected by default. 

• X, Y. Set the initial position of the top-left corner of the web 
browser canvas in pixels. 

• Width, Height. Set the dimensions of the web browser canvas 
in pixels. 

 
Tip: Set the values of X, Y, Width, and Height to 0 to make the web browser fit the entire 
available space below the System Banner. 

See also 
Event commands on page 456 

Add an event command to close the web browser on page 473 

Configure Auto-Logoff on page 688 

Add ports to the list of open ports on page 703 

Add locations to the allowed locations list on page 701 
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Create an event command to close the web browser. 

IMPORTANT The PanelView 53xx family of HMI devices does not support the web browser. 

 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to close the web browser 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Navigation category, and then select Close Web 

Browser.  

See also 
What is an event? on page 476 

Event commands on page 456 

Add an event command to open the web browser on page 471 

Import a certificate to allow encrypted communication between the web 
browser on the HMI device and a remote server. 

 
Tip: When creating a self-signed certificate, verify that the Subject Alternative Name property of the 
certificate contains the IP address of the device or server that you are connecting to. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to import a certificate 
1. Select the graphic element configured with the touch or key event.  

Add an event command to 
close the web browser 

Add an event command to 
import a certificate 
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2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Certificate command category and select Import 

Certificate. 
4. Under Import Certificate on the command card, in the Source 

box, select USB or SD Card.  
5. In the FileName box, type the file name of the certificate or or 

create a binding to a string which contains the file name of the 
certificate. 

See also 
What is an event? on page 476 

Event commands on page 456 

Add an event command to delete a certificate on page 474 

Delete a certificate to no longer store the certificate on the HMI device. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to delete a certificate 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Certificate command category and select Delete 

Certificate. 
4. In the Fingerprint box, type the fingerprint of the certificate or 

create a binding to a string containing the fingerprint of the 
certificate. 

See also 
What is an event? on page 476 

Event commands on page 456 

Add an event command to import a certificate on page 473 

Make changes to the command of an event after creating the event. For 
example, change the destination screen for a Screen Navigate 
command. Changing the type of event after creating the event is not 
supported. For example, changing a Touch Press event to a Key 

Add an event command to 
delete a certificate 

Change a command that an 
event performs 
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Release event is not supported. Delete an event if an event of that type is 
no longer required. 

IMPORTANT If an event references a State Table and then the name of the table changes, change 
the reference to reflect the new State Table name. View Designer does not 
automatically update references with the new name. 

To change a command that an event performs 
1. Select the element or screen in the Project Explorer or Graphic 

Explorer, or in the Screen area. 
2. In the Properties pane, select the Events tab. 
3. To the left of the event, select Show/Hide  to expose the 

commands associated with the event.  
4. Change the commands of the event. For example, change the 

expression, value, or destination of the command. 

See also 
Events tab on page 447 

Trigger an action on a Button Behavior event on page 444 

Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a State Enter or State Exit event on page 454 

Delete a command to no longer have the event perform the command. 
For example, delete a navigation command from the event of a button to 
no longer have the Touch Press event of the button open a popup.    

To delete a command from an event 
1. Select the graphic element, Add-On Graphic, or screen in the 

Project Explorer, Graphic Explorer, or in the Screen area. 
2. In the Properties pane, select the Events tab. 
3. To the left of the event, select Show/Hide  to display the 

commands associated with the event.  
4. Next to the command in the card, select Delete Command . 

The event no longer performs the deleted command. Deleting all 
commands means the event no longer performs any commands 
when the event triggers.   

See also 
Delete an event on page 476 

Change a command that an event performs on page 474 

Events tab on page 447 

Delete a command from an 
event 
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Delete an event or multiple events from the Events tab. Deleted events 
no longer perform on the HMI device screen.  

To delete an event 
1. Select the graphic element, Add-On Graphic, or screen in the 

Project Explorer, Graphic Explorer, or in the Screen area. 
2. In the Properties pane, select the Events tab. 
3. Next to the event, select Delete Event . The Events tab no 

longer lists the event. 

See also  
Events tab on page 447 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

An event is something that occurs to trigger an action. Events initiate on 
the HMI device. An example of an event is touching a graphic element or 
key. The system can also initiate events. An example event is a tag 
changing values in a controller.  

Create events for a graphic element, an instance of an Add-On Graphic, 
a graphic element within the definition of an Add-On Graphic, or a screen. 
There are four types of events:   

• Button Behavior. Touch or release a button or key on the HMI 
device, or configure a graphic element or Add-On Graphic with 
typical button behaviors. 

• Touch Press and Touch Release. Touch or release a graphic 
element, Add-On Graphic, screen, popup, or System Banner on 
the HMI device. 

• Key Press and Key Release. Touch or release a key on the HMI 
device keypad or an external keyboard.  

• State Enter and State Exit. Perform an event when a graphic 
element or Add-On Graphic transitions into or out of a selected 
state. For example, perform the event when the value of a tag in a 
controller changes from 50 to 100. 

Access Project Explorer > Project Events to create events for a 
project. Project events execute commands after evaluating an 
expression from false to true, or pressing a key. A project event triggers 
regardless of the screen or popup on the HMI device. 

Each event requires configuring one or more actions or commands that 
the event triggers. When the event occurs, the event performs the 
configured command. Depending on the type of event, commands from 
different categories can perform tasks. These categories and their 
commands are: 

• Alarm History. Remove all alarm events stored on the HMI 
device. Export alarm history to a .csv file on a USB device or an 
SD card in order to view the information on a computer, or cancel 
the export. 

Delete an event 

What is an event? 
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• Certificates. Import a digital certificate from removable media, or 
delete a certificate from the HMI device. A digital certificate allows 
the HMI device to access locations on the Internet using the 
secured HTTPS and WSS protocols. 

• Data Logs. Clear one or more data logs. Export a data log to a 
.csv file on a USB device or an SD card in order to view the 
information on a computer, or cancel the export. 

• HMI Device Configuration. Calibrate touch for the HMI device 
screen, load a runtime application from the HMI device, reboot the 
HMI device, or safely remove media when the event occurs. 

• Language. Change the language that displays on the HMI device. 
• Navigation. Open the next or previous screen in your navigation 

history, a popup on the screen, a specific screen on the HMI 
device, or the Navigation menu on the HMI device when the 
event occurs. Open or close the web browser. 

• Notification. Send an email with a configurable subject and 
message to one or more recipients. 

• PDF. Navigate through the pages of PDF documents. 
• Security. Open the Logon dialog box or log off when the event 

occurs. 
• State. Apply the previous or next state in the selected State Table 

to the graphic element or Add-On Graphic when the event occurs.  
• Value. Increment a tag value by a configured value or expression, 

toggle a tag value between True and False, or change a tag value 
by a configured value or expression when the event occurs. 

 
Tips:  
• Import the desired languages before changing the language that displays on the HMI device.  
• If a translatable string is left blank, View Designer defaults to the download language for runtime 

applications downloaded to the HMI device. If the translated string for the download language is 
also blank, View Designer defaults to the language used for designing the project. 

See also 
Trigger an action on a Button Behavior event on page 444 

Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a State Enter or State Exit event on page 454 

Import a language file on page 671 

Export text strings for language translation on page 670 

To create an event, assume that a screen named Bottling Line A opens 
when the operator releases L10 on the physical keypad of the HMI 
device. To accomplish this:  

1. Open the project containing the Bottling Line A screen.  
2. Select the screen from which to navigate to the Bottling Line A 

screen. Select the screen in the Project Explorer or the Graphic 
Explorer, or open the Screen and select its canvas.  

3. In the Properties window, select the Events tab.  
4. Add an event and select a Key Release event. 
5. Select the L10 key as the key to prompt the event. When using an 

external keyboard instead of the physical keypad of the HMI 

Example event 
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device, L10 corresponds with pressing Shift+F10 on an external 
keyboard. 

6. Add a Navigation command to the event and select Screen 
Navigate. 

7. In the Navigate To box, select the Bottling Line A screen to open 
when releasing L10 on the HMI device physical keypad, or 
Shift+F10 on an external keyboard, from the currently selected 
screen.  

See also 
Trigger an action on a Button Behavior event on page 444 

Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a State Enter or State Exit event on page 454 

Create multiple events of the same type to change the same property 
value for a graphic element or write to the same tag value. This shows 
only the result of the last event configured for the element. For example, 
create two events for a graphic element. One event changes the FillColor 
property of a bottle to white. The other event changes the FillColor 
property of the same bottle to yellow. The HMI device shows only the 
contents of the bottle that turn yellow.  

Create multiple events that change a different property for a graphic 
element or write to a different tag value. This shows the result of each of 
the events for the graphic element. For example, create two events for a 
graphic element. One event changes the FillColor property of a bottle to 
yellow. The other event changes the CapColor property of the same 
bottle to gray. The HMI device shows the contents of the bottle turning 
yellow and the bottle cap turning gray. 

See also 
Events tab on page 447 

In what order are touch events triggered? on page 478 

The order in which touch events trigger depends on the events 
configured for a screen and its graphic elements. When configuring 
multiple graphic elements or Add-On Graphics with touch events, touch 
events trigger for items in the following order: 

• Screen events 
• Group events 
• Graphic element events 

Multiple events 

In what order are touch 
events triggered? 
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Tips:  
• Press events trigger before release events.  
• An overlay over a group or graphic element does not affect the events of the group or graphic 

element, unless the overlay has an event of its own. If an overlay has an event of its own, that 
event takes place rather than the event of the group of graphic element.  

• Events created for an instance of an Add-On Graphic take precedence over events created for a 
graphic element within the definition of the Add-On Graphic. If the same event type exists in both 
the definition of an Add-On Graphic and an instance of that Add-On Graphic, the event for the 
instance of the Add-On Graphic on the screen is performed on the HMI device.  

See also 
Events tab on page 447 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Delete an event on page 476 

Events and Add-On Graphics on page 400 

A screen can have an event and also contain a graphic element with its 
own event. Touching the screen triggers the event. Touching the graphic 
element triggers the event of the screen and the event of the graphic 
element.  

In this example, there is an event associated with the screen, and an 
event associated with the button.  

 
Press Event Triggered action 

 
Press here to trigger the event associated with the screen.   

 
Press here to trigger the event associated with the screen and then trigger 
the event associated with the button.  

See also 
In what order are touch events triggered? on page 478  

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Example: Screen events 
trigger before graphic 
element events 
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A graphic element may lie partially over another graphic element on the 
screen. Each graphic element can have its own event. Touching a 
graphic element triggers the event of that graphic element. This is true 
even when touching the portion of a graphic element that is on top of the 
other. 

In this example, there is a unique event associated with each button. Part 
of Button B lies on top of Button A. 

 
Press Event Triggered action 

 
Press here to trigger the event associated with Button A.  

 
Press here to trigger the event associated with Button B. 

 
Press here to trigger the event associated with Button B. 

See also 
In what order are touch events triggered? on page 478  

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

A graphic element with a touch event may lie underneath an overlay 
element. If the overlay element does not have an event, pressing the 
portion of the element under the overlay triggers the event of the graphic 
element.  

In this example, there is an event associated with Button A. However, 
there is no event associated for the rectangle overlay lying on top of a 
portion of Button A.  

 
Press Event Triggered action 

 
Press here to trigger the event associated with Button A.  

 
Press here to trigger the event associated with Button A. 

 
Press here to trigger no event.  

See also 
In what order are touch events triggered? on page 478  

Example: Events of 
overlapping graphic 
elements trigger 
individually 

Example: Graphic element 
events trigger through an 
overlay element without 
events 
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Trigger an action on a Touch Press or a Touch Release event on 
page 453 

When a group with a touch event contains graphic elements with their 
own touch events, touching the group triggers the event of the group. 
Pressing a graphic element in the group triggers the event of the group, 
and the event of the graphic element. An overlay element that does not 
have an event does not affect triggered events. 

In this example, there is an event associated with the group consisting of 
Button A and Button B, an event associated with Button A, and an event 
associated with Button B positioned partially over Button A. There is no 
event associated with the rectangle overlay. 

 
Press Event Triggered action 

 
Press here to trigger the event associated with the group and then trigger 
the event associated with Button A.   

 
Press here to trigger the event associated with the group and then trigger 
the event associated with Button B.  

 
Press here to trigger the event associated with the group and then trigger 
the event associated with Button B.  

 
Press here to trigger the event associated with the group.  

See also 
In what order are touch events triggered? on page 478  

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

If a group of line art contains a touch event, it triggers the event of the 
group regardless of the touch location on the group. 

In this example, there is an event associated with the group that contains 
the line art.  

 

Example: Group events 
trigger before graphic 
element events 

Example: Group events 
trigger regardless of touch 
location 
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Press Event Triggered action 

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group.  

See also 
In what order are touch events triggered? on page 478  

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

If a group contains line art and an input graphic element, the event of the 
group triggers regardless of the touch location on the group. Pressing the 
input graphic element triggers the event of the group and opens the 
virtual numeric keypad or virtual standard keyboard. 

In this example, there is an event associated with the group. The group 
contains line art and a text input graphic element.  

 
Press Event Triggered action 

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group. 

 
Press here to trigger the event associated with the group and then open the 
virtual numeric keypad or virtual standard keyboard to enable input. 

See also 
In what order are touch events triggered? on page 478  

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

If a group lies on top of an input graphic element, touching the group 
triggers the event of the group. Pressing the input graphic element does 
not open a virtual numeric keypad or virtual standard keyboard. 

Example: Group events 
trigger before events for 
input graphic elements 
open a keypad or keyboard 

Example: Events for 
graphic elements below 
groups do not trigger 
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In this example, a group that has an event associated lies on top of an 
input graphic element that is not part of the group. 

 
Press Event Triggered action 

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group. The virtual 
numeric keypad or the virtual standard keyboard does not open.   

See also 
In what order are touch events triggered? on page 478  

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

A group with a touch event may contain two graphic elements with their 
own touch events. A graphic element with its own touch event lies on top 
of the group. Touching a graphic element not under the overlay element 
triggers the event of the group and the event of the graphic element. 
Pressing a graphic element under the overlay element triggers only the 
event of the overlay element. 

In this example, there is an event associated with the group. The two 
buttons in the group each have a unique event associated with them. 
There is also an event associated with an overlay element.  

 
Press Event Triggered action 

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group and then trigger 
the event associated with Button A.  

 
Press here to trigger the event associated with the rectangle overlay.  

Example: Overlay events 
take precedence over 
group events 



Chapter 14  Configure an event to trigger an action 
 

484 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

See also 
In what order are touch events triggered? on page 478  

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

A group may have a Touch Release event that contains a button with its 
own press and release events. The events of the button change the state 
of the button upon press and release. Pressing the button triggers the 
press event of the button to show the press state. Releasing the button 
triggers the Touch Release event of the group and the Touch Release 
event of the button to show the release state.  

In this example, a group contains only a button. There is a Touch 
Release event associated with the group. A Touch Press event and a 
Touch Release event are associated with the button.  

  
Press Event Triggered action 

 
Press the button to trigger the touch press event associated with the button. 
Release the button to trigger the Touch Release event associated with the 
group, and then trigger the touch release event associated with the button.    

See also 
In what order are touch events triggered? on page 478  

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Add an event to a project to execute commands on the HMI device after: 

• Evaluating an expression from false to true 
• Pressing a key 

Tips: • Project events trigger regardless of the screen or popup displayed on the HMI device. 
• View Designer supports adding up to 1000 project events.  

To add an event to a project 
1. In the Project Explorer, navigate to the Project Events folder. 
2. Right-click the Project Events folder and click New Project 

Event. The event has the default name ProjectEvent_001.  
3. In the Properties pane, click the Properties tab.  
4. Expand a category to change a property value or bind a property 

of the project event. 

Example: Press events 
trigger before release 
events 

Add an event to a project 
(Project Event) 
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• Enabled. Select or bind this property to enable the evaluation of 
the event. If the Enabled property is false, the event is not 
evaluated and the commands of the event do not perform. 

• ExecuteWhen. Bind this property to enter a tag or expression 
to trigger the event. The event triggers when the expression 
evaluates from false to true. 

• ExecuteOnKey. Select the key to trigger the event. Touch 
Only is the default. Select None if not using a key to trigger an 
event. 

• EvaluationPeriod. Select the rate to evaluate events. 

 
Tip: Any ExecuteOnKey project event configured for a specific key does not trigger on the 
HMI device if the open screen or a graphic element on that screen on the HMI device has 
a Key Press, Key Release, or Button Behavior event configured for the same key.  

5. Click the Events tab  

 
Tip: The Events tab only contains one project event card. View Designer does not allow 
deleting or adding project event cards. 

6. Click Add Command. 
7. Expand a command category to list the commands in that 

category:  
• HMI Device Configuration. Commands that configure screen 

calibration and reboot the HMI device.  
• Navigation. Commands that navigation to screens on the HMI 

device.  
Multiple screen navigation commands can exist for an event. All 
other types of commands for the event are executed before the 
navigation command. Only one navigation command is 
executed for an event. This is generally the first navigation 
command. The remaining navigation commands are ignored on 
the HMI device. To ensure the navigation command is the 
navigation command executed, Rockwell Automation 
recommends adding only one navigation command to an event.  

• Security. Commands that log on or log off the HMI device.  
• Value. Commands that increment, toggle, or write a value to the 

selected tag. 
• Language. Command that changes the language that displays 

on the HMI device.  
• Window.  

Tip: If a translatable string is left blank, View Designer defaults to the download language for 
runtime applications downloaded to the HMI device. If the translated string for the 
download language is also blank, View Designer defaults to the language used for 
designing the project.  

Select and configure the command that the event will perform. 
Tip: • You can create multiple commands for each event. The order of execution may not correspond 

with the order of commands listed on the Event card. 
• If the events for an item include more than one screen navigation command, only the first screen 

navigation is performed on the HMI device. The screen navigation occurs after all other 
commands for the events are performed. 

• When an event performs multiple commands that write to multiple tags, all of the write 
commands occur sequentially. Therefore, you may not see all of the tag values in the Logix 
controller at the same time. 
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See also 
Trigger an action on a Key Press or a Key Release event on page 
451 

Bind a property to a data item on page 508 

Create an expression on page 520 

Event commands on page 456 

What is a project event? on page 486 

Copy a project event between View Designer projects to ensure 
consistency. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy a project event between projects 
1. Copy the project event from the source folder to the target Project 

Events folder.   
2. If the target project contains a project event with the same name:  

• Click Replace to overwrite the existing file.  
• Click Keep both to rename the project event copied from the 

source folder 
• Click Cancel to not copy the the project event.  

See also 
Add an event to a project on page 484 

Delete an event on page 476 

Rename a project event on page 487 

What is a project event? on page 486 

Create a project event to trigger an action for an entire project. Events 
created for a specific item, such as a graphic element, Add-On Graphic, 
or a screen, trigger an action only for that item. A project event triggers 
regardless of the screen or popup on the HMI device. 

Project events execute commands on the HMI device after: 

• Evaluating an expression from false to true 
• Pressing a key 

Copy a project event 
between projects 

What is a project event? 
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Tip: You can use an external keyboard with the HMI device. The L1 through L10 keys listed 
when creating Key Press and Key Release events correspond with pressing Shift+F1 through 
Shift+F10 keys on an external keyboard. The R1 through R10 keys listed when creating Key 
Press and Key Release events correspond with pressing Ctrl+F1 through Ctrl+F10 on an 
external keyboard.  

For example, use project events to display a specific screen or popup 
when a machine enters a specific state and needs operator attention. 
These events trigger automatically without operator intervention.  

 
Tip: A matching key press event for the currently displayed screen or graphic element with focus 
takes precedence over the project event.  

Add one or more commands to a project event to execute those 
commands when the event triggers. Each event has a bindable Enabled 
property for evaluating the event. If the Enable property is false, the 
event is not evaluated and the commands of the event do not perform.   

See also 
What is an event? on page 476 

Add an event to a project on page 484 

Copy a project event between projects on page 486 

Rename a project event to reflect the purpose, content, or targeted use 
of the event. Names within a folder must be unique and are not case 
sensitive. For example, Monthly_ProjectEvent and monthly_projectevent 
are considered identical names.  

To rename a project event 
1. In the Project Explorer, expand the Project Events folder.  
2. Click the project event once to select the item. 
3. Click the project event again and type the new name. 

 
Tips:  
• Rename a project event by right-clicking the name and clicking Rename. Then type a new name 

and press Enter. 
• Change the name of the project event through the Name box in the Properties window of the 

project event.  

See also 
Add an event to a project on page 484 

Copy a project event between projects on page 486 

Delete an event on page 476 

What is a project event? on page 486 

 

Rename a project event 
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Chapter 15 

Create an HMIBC Button 

Create a high-speed HMIBC button in an HMI project to initiate machine 
control operations, such as jogging a motor, with a high-degree of 
precision and determinism.  

Any graphic element can be configured to function as a high-speed 
HMIBC button. Each Logix controller can support up to 256 HMIBC tags. 

See also 
What is HMI Button Control? on page 489 

Create a high-speed HMIBC button on page 490 

Configure visual feedback for an HMIBC button on page 491 

Use HMI Button Control (HMIBC) in Logix Designer to communicate 
between an HMI device and a Logix controller over a high-speed I/O 
connection. Machine controls including jogging a motor or opening and 
closing a valve are more precise with an HMIBC than a standard HMI 
device button. Configure any graphic element to function as an HMIBC. 
Each Logix controller supports up to 256 HMIBC tags. 

Include an HMIBC instruction for each button. The HMIBC instruction 
communicates with a PanelView 5000 HMI device only if the HMI device 
appears in the I/O Configuration tree in Logix Designer.  

There are three HMIBC tag members for an HMI Button Control: 

• ButtonState. Writes to the Logix controller during the button 
press. 

• ProgFB. Provides feedback to the HMI device when the device 
that the HMIBC controls changes states.  

• Out. Provides feedback to the HMI device when the command to 
the HMI device changes states. Use the Out tag member to 
indicate that the Logix controller detects the button press or that 
device the HMIBC controls does not have a feedback signal. 

 
Tip: For multiple HMI devices, pressing the HMIBC on any HMI device sets the Out member of 
the HMIBC instruction. 

 

IMPORTANT Do not write to other tags on the screen when writing to the HMIBC tag. Do not write to 
additional write commands on the HMIBC or perform State Enter or State Exit events on 
the screen, including the System Banner. 

See also 
Create a high-speed HMIBC button on page 490 

What is HMI Button Control? 
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Configure visual feedback for an HMIBC button on page 491 

Create a high-speed HMIBC button in an HMI project to initiate machine 
control operations, such as jogging a motor, with a high-degree of 
precision and determinism. A high-speed HMIBC button communicates 
to the controller over a high-priority I/O connection. Any graphic element 
can be configured to function as a high-speed HMIBC button. Each Logix 
controller can support up to 256 HMIBC tags. 

Prerequisites 
• Verify that the Logix Designer project includes an HMIBC 

instruction for each tag to use. 
• Verify that the I/O Configuration tree in Logix Designer includes 

the PanelView 5000 device to use in the application. This is 
required for the HMIBC buttons to communicate with the Logix 
controller. It is recommended to have no more than four HMI 
devices communicating with the controller. 

To create a high-speed HMIBC button 
1. On the screen, right-click the graphic element and click Button 

Behavior > Logix HMIBC set to 1 on press, 0 on release. A 
Button Behavior Event card opens on the Events tab on the 
Properties pane. 

2. In the Key box, select an option from the list:  
• Select Touch Only to trigger the command when pressing only 

the graphic element.   
• Select a key on the HMI device to trigger the command when 

pressing the selected key or the graphic element. 
3. (optional) Select Requires Focus if the graphic element for which 

HMIBC button behavior is configured requires focus to trigger the 
command. Placing focus on a graphic element requires pressing 
Tab on the keypad to highlight the graphic element or pressing the 
element. 

4. In the HMIBC Tag box, type the name of the HMIBC tag or click 
Browse  and select the tag.  

Create a high-speed HMIBC 
button 
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IMPORTANT • For best performance, setup no more than 300 total tag references on a 
screen when using a HMIBC button. 

• For the connection to the PanelView 5000 HMI devices, setup short RPI times 
in Studio 5000 Logix Designer. 

• For best performance, it is recommended that on a screen that uses HMIBC 
buttons, do not write to other tags on the screen at the same time as the 
write to the HMIBC tag. This includes additional write commands on the 
HMIBC button and writes on the screen or the System Banner using State 
Enter or State Exit events. 

• When configuring the HMIBC button using a Press and Release event instead 
of a Button Behavior, for the best performance, ensure that the command to 
write to the .ButtonState member of the HMIBC tag is the only command in 
the event. Using multiple commands in addition to the command to write to 
the .ButtonState member may slow down the write to the controller. 

• Do not not animate graphic elements in a View Designer project using alias 
tags created in Logix Designer to members of the HMIBC data structure. 
Aliased Logix Designer HMIBC tags are not supported in View Designer. 

• For best performance, it is recommended to not use HMIBC buttons on the 
same screen as an alarm summary or alarm manager. 

• When a PanelView 5000 HMI device is in the I/O tree of the Logix controller 
and the Logix controller becomes overloaded to the point where it can no 
longer process communication of tag data with the PanelView, a loss of the 
I/O connection between the Logix controller and the PanelView 5000 HMI 
device may occur. The I/O connection re-establishes once the Logix 
controller has the bandwidth to handle tag data communications. 

• A large number of alarms triggered at once may impact the performance of 
the HMIBC button. The performance returns to normal after the HMI device 
processes the alarms. 

• For best performance, do not perform tag writes using project events at the 
same time you use an HMIBC button. 

See also 
Configure visual feedback for an HMIBC button on page 491 

What is HMI Button Control? on page 489 

Trigger an action on a Button Behavior event on page 444 

Configure any property of a graphic element to provide visual feedback 
from the device being controlled by the HMIBC instruction. The .ProgFB 
member of the HMIBC tag provides feedback to the HMI device when the 
device controlled by the HMIBC instruction changes state. The .ProgFB 
member communicates over a high-priority I/O connection. 

Prerequisites 
• Verify that the Logix Designer project includes an HMIBC 

instruction with the .ProgFB member as an input from the device 
or machine. 

• Create a high-speed HMIBC button in View Designer. 

To configure feedback for an HMIBC button 
1. On the screen, select a graphic element to use for indicating the 

state of the device being controlled by the HMIBC instruction. 

Configure visual feedback 
for an HMIBC button 
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2. In the Properties window, bind a property of the graphic element, 
such as Visibility, to the .ProgFB member of the HMIBC tag. 

 
Tip: If the device controlled by the HMIBC instruction does not have a feedback signal, show 
feedback in the HMI project by binding a property of an element to the .Out member of the 
HMIBC instruction. When the .ButtonState member is set, the HMIBC instruction also sets the 
.Out member and indicates that the instruction received the button press from the HMI 
device. The .Out member communicates over a high-priority I/O connection. 

See also 
Create a high-speed HMIBC button on page 490 

What is HMI Button Control? on page 489 
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Chapter 16 

Change a property 

Change the properties in graphic elements, instances of an Add-On 
Graphics, screens, popups, shortcuts, and folders. For example, change 
the Security property of a screen to limit access to it, or change the 
FillColor property of a graphic element to change the color of the item. 

To change a property 
1. In the Toolbox, or on an open screen, select an item or multiple 

items. 
2. In the Properties window, select the Properties tab. The 

properties for that item are displayed in categories. 

 
Tips:  
• Select multiple items to display the common properties of the items. 
• Select multiple items of the same type in the Project Explorer to display their common properties. 

3. Expand a category to display a property and change the value of 
the property.   

See also 
List of properties on page 494 

Properties tab on page 494 

Properties window on page 493 

Bind a property to a data item on page 508 

Create an alias property on page 361 

How do I open the Properties window? 

On the Menu bar, select View > Properties Window.  

The Properties window consists of several tabs that may include 
Properties, Animations, Columns, Filters, and Events. The tabs on 
the Properties window depend on the item selected. The types of items 
include: 

• A screen, popup, shortcut, or Add-On Graphic definition 
• An element on a screen, popup, or shortcut, or Add-On Graphic 

definition 
• An item in the Project Explorer 
• An graphic element in the Graphic Explorer 

Each tab displays the attributes and behaviors you can configure for the 
selected item. The name of the selected item appears at the top of the 
Properties window.   

Change a property 

Properties window 
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See also 
Properties tab on page 494 

Animations tab on page 435 

Columns tab on page 580 

Filters tab on page 609 

Events tab on page 447 

How do I open the Properties tab? 

On the Properties window, click the Properties tab. 

 

The Properties tab contains the attributes of an item and the values 
assigned to that attribute. For example, the selected graphic element 
may have properties that define its color and position on the screen. 
Graphic elements, Add-On Graphics, screens, popups, shortcuts, and 
folders all have properties. These properties are categorized by type, 
such as Security, Appearance, and Position and Size.  

Graphic elements share some common properties. Some graphic 
elements also have properties that are not common to all graphic 
elements. Graphic elements may also have built-in animation properties 
in the General category that animate the graphic element or change the 
information the graphic element shows on the HMI device.  

Use the Properties tab to: 

• View or change the values of: 
• A property 
• Common properties between multi-selected graphic elements 

on a screen or popup 
• Common properties between multi-selected objects of the same 

type in Project Explorer. 
• Secure screens, popups, shortcuts, or folders. 
• Bind a property to a tag or expression so that the property value 

changes as the tag or expression value changes in a controller.  
• Link the value of a user-defined property to the value of its 

associated base property. 

See also 
List of properties on page 494 

Change a property on page 493 

Restrict access to an item on the HMI device on page 354 

Bind a property to a data item on page 508 

Create an alias property on page 361 

Use properties to change the appearance or behavior of graphic 
elements, screens, shortcuts, popups, and folders. Properties also 
change the behavior of a project event. 

Properties tab 

List of properties 
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See also 
Properties window on page 493 

Properties tab on page 494 

Change a property on page 493 

Bind a property to a data item on page 508 

Create an alias property on page 361 

Use the Color Picker to select or create colors and gradients to apply to 
graphic elements and screens.  

Bind a color property to a tag or expression to dynamically change a 
color.  

See also 
Color Picker overview on page 495 

Select a color using the Color Picker on page 497 

Create a color gradient on page 498 

Supported color keywords and RGB values on page 501 

Change a property on page 493 

How do I open the Color Picker?  

Select an item on the screen or the screen background. On the 
Properties tab (VIEW > Properties Window > Properties tab), in any 
color-related property box, click the down arrow or the color swatch.  

Use the Color Picker to select or create a color for items such as graphic 
elements, lines, and text on the screen or the background of the screen. 
Item colors for changing appear in color-related properties in the 
Appearance category of the Properties tab. 

Use the Color Picker to: 

• Select from a set of pre-configured and custom colors.  
• Create and save custom colors. 
• Create and save gradient colors. Use gradients for fill-color 

properties only. 

See also 
Select a color using the Color Picker on page 497 

Create a custom color using the Color Picker on page 497 

Create a color gradient on page 498 

Color Picker overview on page 495 

An overview of the Color Picker: 

Select or create a color 

Color Picker 

Color Picker overview 
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Item Name Purpose 

 
System color swatches Standard system colors.  

 
Favorite swatches  A set of pre-configured colors. Colors and gradients that you create are also stored here. 

 
Custom/Collapse custom Shows or hides the spectrum color picker and the gradient color selector. 

 
Create solid color Applies a single color evenly. 

 
Create gradient color Opens the gradient color selector located below the spectrum color picker.  

 
Spectrum color picker Provides the means to select a custom color.  

 
Spectrum color Shows the color selected in the spectrum color picker.  

 
Current color Shows the currently selected color. 

 
Gradient selector Provides the means to create a gradient color. Stops at either end of the gradient selector to provide the means to 

select the starting and ending color. 

 
Radial Gradient Creates a radial gradient using the selected gradient stop colors. Fades and blends colors in a circular path outward 

from a center point. The leftmost stop selects the center color. 

 
Linear Gradient Creates a linear gradient using the selected gradient stop colors. Fades and blends color along a straight line. 

 
Selected color Shows the selected color or gradient. 

 
R, G, B 
 

Shows the proportion of red, green, and blue in the selected color. Also allows manual adjustment of the proportion 
value.  

 
Add color swatch Adds a custom color or gradient to the Favorite swatches. 

See also 
Color Picker on page 495 

Select a color using the Color Picker on page 497 

Create a custom color using the Color Picker on page 497 

Create a color gradient on page 498 
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Use the Color Picker to select a color from a set of pre-configured colors 
or user-created colors that were saved as swatches. 

To select a color using Color Picker 
1. On the screen, select the item or the screen background. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category.  

If the selected item has color properties you can change, those 
properties appear in this category. The currently applied color for a 
property appears as a swatch on the Property tab. 

4. Click the down arrow or the color swatch to open the Color 
Picker, and click a new color swatch. The new color is applied to 
the item and displays in the swatch on the Property tab. 

5. Close the Color Picker by clicking the color swatch. 
 

 
Tip: Colors and gradients of some graphic elements may look different on the HMI device due 
to screen type and resolution. 

 

See also 
Create a color gradient on page 498 

Color Picker overview on page 495 

Color Picker on page 495 

Use the Color Picker to create a custom color. 

To create a custom color using the Color Picker 
1. In the Properties window, select the Properties tab. 
2. Expand the Appearance category.  

If the selected item has color properties you can change, those 
properties appear in this category. The currently applied color for a 
property appears as a swatch on the Property tab. 

3. Select the down arrow or the color swatch to open the Color 
Picker, and select the arrow next to Custom to display the 
spectrum color picker. The spectrum color picker displays the 
currently selected color in the spectrum color picker.  

4. Adjust the color using the following methods: 
• To select a color family, use the slider to the right of the 

spectrum color picker. 
• To adjust the color saturation level, click and drag the cursor left 

and right (x-axis). 
• To adjust the brightness level, click and drag the cursor up and 

down (y-axis). 

Select a color using the 
Color Picker 

Create a custom color using 
the Color Picker 
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• To make granular color changes or for precise color selection, 
adjust the RGB values. These values represent the proportion 
of red, green, and blue in the selected color. Use the up and 
down arrows or enter a integer number between 0 - 255. 

5. Close the Color Picker by selecting the color swatch.  

 
Tips:  
• Directly below the spectrum are two panes. The small pane on the right shows the current color. 

The larger pane to the left displays a preview when clicking and holding the mouse while moving 
the cursor over the spectrum. This enables you to compare the current color to a new color. 
Releasing the mouse button selects the color. 

• To save the selected color as a swatch, select Add . 
• To remove a swatch, right-click on it and select Remove color swatch. System color swatches 

cannot be removed. 
• Colors and gradients of some graphic elements may look different on the HMI device due to screen 

type and resolution. 

See also 
Create a color gradient on page 498 

Select a color using the Color Picker on page 497 

Color Picker overview on page 495 

Color Picker on page 495 

Supported color keywords and RGB values on page 501 

A gradient starts with one color and then merges into and finishes with an 
end color. Use a gradient to add lighting or shading to graphic elements, 
screens, or popups. 

To create a color gradient 
1. In the Properties window, select the Properties tab. 
2. Expand the Appearance category.  

If the selected item has color properties you can change, those 
properties appear in this category. The currently applied color for a 
property appears as a swatch on the Property tab. 

3. Select the down arrow or the color swatch to open the Color 
Picker. 

4. Select the arrow next to Custom to open the spectrum color 
picker. 

5. Select Define Gradient Color . Gradient colors can be created 
only for a FillColor property. If this button is not displayed, then a 
gradient color cannot be created for the selected item. 

6. Below the spectrum color picker, select a gradient pattern: 
• Radial Gradient : Radial pattern creating a circular gradient 

from the center. This option is not available for popups. 
• Linear Gradient : Linear pattern changing and blending from 

left to right. 
7. Select the left color stop . The triangle above the stop becomes 

solid black to indicate it is the active stop.  

Create a color gradient 
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8. Use the spectrum color picker to create a color or select a color 
swatch to select a color for that stop. 

9. Select the right color stop and select or create a color for that stop. 
10. Close the Color Picker by selecting the color swatch. 

 
Tips:  
• To save the selected color as a swatch, select Add . 
• There are only two color stops, and the stops are not adjustable. 
• Colors and gradients of some graphic elements may look different on the HMI device due to screen 

type and resolution. 
• Radial gradients are not supported for popup FillColor. 

See also 
Select a color using the Color Picker on page 497 

Create a custom color using the Color Picker on page 497 

Color Picker overview on page 495 

Color Picker on page 495 

Select a solid or gradient color to fill a graphic element or the background 
of a screen or popup. 

To select a fill color 
1. In the Properties window, select the Properties tab. 
2. Expand the Appearance category.  

If the selected item has color properties you can change, those 
properties appear in this category. The currently applied color for a 
property appears as a swatch on the Property tab. 

3. In the FillColor property box, select a color using one of the 
following methods:  
• Type the Hex value in the format #RRGGBB. R, G, and B are 

Hex digits from 0 through F and represent the color channel 
values for red, green, and blue. For example, #ffff00 produces 
yellow. 

• Select the arrow or color swatch to open the Color Picker, and 
select or create a color.   

• Create a color gradient. 

 
Tips:  
• To save the selected color as a swatch, select Add . 
• Colors and gradients of some graphic elements may look different on the HMI device due to screen 

type and resolution. 
• Radial gradients are not supported for popup FillColor. 

See also 
Color Picker on page 495 

Create a color gradient on page 498 

Select a text color on page 140 

Select a fill color 
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Bind a color property to a tag or expression on page 500 

Create a custom color using the Color Picker on page 497 

Change the color of the text that appears in a graphic element or Add-On 
Graphic. 

To select a text color 
1. Select the graphic element on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance node. 
4. In the FontColor box, select a text color using one of the following 

methods:  
• Type the Hex value in the format #RRGGBB. R, G, and B are 

Hex digits from 0 through F and represent the color channel 
values for red, green, and blue. For example, #ffff00 produces 
yellow. 

• Select the arrow or color swatch to open the Color Picker, and 
select or create a color. 

 
Tip: To save the selected color as a swatch, select Add . 

See also 
Color Picker on page 495 

Create a color gradient on page 498 

Select a fill color on page 141 

Bind a color property to a tag or expression on page 500 

Color Picker overview on page 495 

Bind a color property to a tag or expression to dynamically change a 
color.  

To bind a color property to a tag or an expression 
• Use one of the following methods: 

• Bind to a string tag or an expression that resolves to a string in 
the format #RRGGBB. R, G, B are the Hex digits that represent 
the values for the red, green, and blue color channels. For 
example, the string "#ffff00" produces yellow. 

• Bind to a string tag or to an expression that resolves to a string 
of a supported color name. For example, the string "yellow" 
produces yellow. 

IMPORTANT • Bind color properties only to string tags. Binding to an integer tag, a 
floating point tag, or an expression is not supported and does not change 
a color. 

• Selecting a default color is required. Selecting NoFill does not apply the 
bound tag value at runtime. 

Select a text color 

Bind a color property to a 
tag or expression 
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See also 
Supported color keywords and RGB values on page 501 

What is binding? on page 502 

Create an expression on page 520 

Configure an animation using a Color Table on page 437 

Configure an animation using a State Table on page 438 

Keywords to use as a string to select a color when binding a color 
property include:  

 

See also 
Bind a color property to a tag or expression on page 500 

Supported color keywords 
and RGB values 
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When a property is bound to a data item, the value of the property is 
specified dynamically at runtime. A data item can be a tag, an extended 
property of a tag, a property of a graphic element or screen, or an 
expression.  

If a property can be bound, a Binding button  appears next to the 
property name when you point to it. 

See also 
What is binding? on page 502 

Bind a property to a data item on page 508 

Assign the extended properties of a tag to a graphic element on 
page 514 

Create an expression on page 520 

Binding is the process of specifying the value of a property dynamically. 
Graphic element properties that are bound to data update automatically 
when the value of the data changes. 

Bind a property of a graphic element or instance of an Add-On Graphic to 
a data item:  

• A tag, including system tags. Browse for tags to bind to after you
configure a controller reference on the Project Properties dialog
box.

• Extended properties of tags.
• An expression. For example, to bind the property to the value of

the expression, you can enter
::controller\program.tag1+::controller\program.tag2.

• A property of a graphic element or screen. For example, you can
bind the Text property of TextDisplay_003 to
TextDisplay_001.Text.

• Each referenced analog tag has eu/min/max.
• Each BOOLEAN tag references has state identifiers
• All tags have descriptions

From within the definition of an Add-On Graphic, you can only bind to an 
external data type property or the property of another graphic element 
within the definition of an Add-On Graphic.  

Properties that you can bind display a Binding button  when you 
point to them. 

IMPORTANT The HMI device updates data from controllers at a fixed rate of 100, 250, or 500 
milliseconds. This update is asynchronous to any scan in a controller. 

See also 
Bind a property to a data item on page 508 

Bind a color property to a tag or expression on page 500 

Remove a binding on page 513 

Bind properties 

What is binding? 
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Properties tab on page 494 

Examples of combinations to use for creating an expression: 

Numeric literals in expressions 
Name Description Example 
Integers Numbers 0-9 specified in base-10 format. Leading zeros are 

not supported. 0 is supported, 01 is not supported. 
123 

Floating point Numbers that begin with zero or more base-10 digits, then 
the period character as decimal separator, followed by one 
or more base-10 digits. Leading zeros are not supported to 
the left of the decimal point, unless it is just a single zero 
immediately preceding the decimal point. Examples: 1.23 .23 
0.23  

1.23, .23, and 123.45 

Exponential Numbers that begin with an integer or floating point number, 
followed by the character 'e' (or 'E') and an integer. A negation 
operator '-' is supported before the exponent; other 
operators are not.  

6.02e23 means 6.02 * 1023 
1.66e-27 means 1.66 * 10-27 

String values (literal or tags) in expressions 
Name Description 
String A string literal begins with a double-quote character and 

ends with a double-quote character. Anything between the 
two double-quotes is part of the string literal. You can use 
strings as operands with the plus (+) operator and with 
relational operators. The + operator joins string operands. 
String tags and string literals behave the same way. 
Keep the following in mind when using string tags with the 
relational operators: 
• All relational operators are case-sensitive. 
• Strings are compared on a character-by-character basis. 
• Individual letters are compared based on their Unicode 

value. This means that a lowercase letter is greater than 
its corresponding uppercase letter. 

• If two strings are different lengths and the characters are 
the same, then the longer string is considered to be 
greater than the shorter string. 

Example: If tag1 = "SOME" and tag2 + "THING", then:
tag1+tag2 returns 
"SOMETHING"

Tags in expressions 
Name Description 

Tag A tag can stand alone as an expression or be included as 
part of an expression that is made up of other components. 
An expression that is a tag name returns the value of the tag. 
Tags begin with either "::" or "\".  Use the format 
::ControllerName.TagName.
You can type the tag name or open the Tag Browser and 
select a tag. 

Example: In a controller named Packing, if 
tag1 = 5 and tag2 = 7, then:
::Packing.tag1 returns 5
::Packing.tag1 + 25 returns 30
::Packing.tag1 % ::Packing.tag2 returns 5
::Packing.tag1>::Packing.tag2 returns 0 (false)
(::Packing.tag1<::Packing.tag2) 
&&(::Packing.tag1==5) returns 1 (both 
statements are true)

Expression examples 
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Numeric operators in expressions 
IMPORTANT • Using strings in numeric operations is not recommended. The exception is the + 

operator, which is used for string concatenation. 
• Using LINT tags in expressions, write commands, or increment commands is not 

recommended. This is because the values may lose resolution as a result of 
performing the expression calculations. 

• Ensure that any tag value you use as a divisor cannot at some point have a value of 
zero. Expressions that attempt to divide a number by zero produce an error at 
runtime. 

Symbol (Operation) Description 
+ (Addition) Returns the sum of the values. SINT, INT, DINT, LINT, and REAL 

tags can be used in any order. All values are converted to 
double-precision floating point first, and then the operation is 
performed. If any operand is a string, it is concatenated.  

Example: If tag1 = 5 and tag2 = 7, then: 
tag1 + tag2 returns a value of 
12 MyDINT + "SomeString" returns a value 
of  5SomeString, if MyDINT = 5

- (Subtraction) Returns the difference of the two values. SINT, INT, DINT, LINT, 
and REAL tags can be used in any order. All values are 
converted to double-precision floating point first, and then 
the operation is performed.  

tag1 - tag2 returns a value of 
-2

- (Negation) Inverts the sign of the operand, making a positive number into 
a negative number or a negative number into a positive 
number.  

-tag2 returns -7 

* (Multiplication) Returns the product of two values. SINT, INT, DINT, LINT, and 
REAL tags can be used in any order. All values are converted to 
double-precision floating point first, and then the operation is 
performed.   

tag1 * tag2 returns a 
value of 35  

/ (Division) Returns the quotient of the two values. SINT, INT, DINT, LINT, 
and REAL tags can be used in any order. All values are 
converted to double-precision floating point first, and then 
the operation is performed.  

tag1 / tag2 returns a 
value of 0.71

% (Modulus) Returns the remainder of one number divided by another. 
SINT, INT, DINT, LINT, and REAL tags can be used in any order. 
All values are converted to double-precision floating point 
first, and then the operation is performed.  

tag1 % tag2 returns  a 
value of 5

Math Function in expressions 
Function Description Example 
ABS, Abs, or abs Returns the absolute value of the expression. ABS(-1.23)returns 1.23. 

ABS(1.23)returns 1.23.
ARCCOS, arccos, ACOS, or acos Returns the arc cosine of the expression in radians. ACOS(-1.0)returns 3.14159. 
ARCSIN, arcsin, ASIN, or asin Returns the arc sine of the expression in radians. ARCSIN(1)returns 1.570796. 

ARCTAN, arctan, ATAN, or atan Returns the arc tan of the expression in radians. ATAN(-45.01)returns -1.54858. 

COS, Cos, or cos Returns the cosine of the expression in radians. COS(14.78)returns -0.599465. 
LOG, Log, or log Returns the natural log of the expression. LOG(2) returns 0.69314718 

LOG10, Log10, or log10 Returns the base-10 log of the parameter. LOG10(100)returns 2. 

SIN, Sin, or sin Returns the sine of the expression in radians. SIN(45.175643)returns 0.929607. 
SQRT, Sqrt, or sqrt Returns the square root of an expression. SQRT(144)returns 12. 
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TAN, Tan, or tan Returns the tangent of the expression in radians. TAN(1)returns 1.5574077246549023. 

TRUNC, Trunc, or trunc Returns the value of the parameter with any digits to the 
right of the decimal point removed. 

TRUNC(10.8282)returns 10. 

POW, pow Returns the result of raising the first value to the power of 
the second value. All values are converted to 
double-precision floating point first, and then the operation 
is performed. 

POW(10,3)returns 1000. 

String functions in expressions 
Function Description Example 
TOLOWER, ToLower, or tolower Converts any uppercase characters to lower lowercase. 

Converts a numeric to a string containing that number. 
TOLOWER("New York")returns "new york". 
This expression converts a numeric to a string  containing that 
number: 
TOLOWER(32) + TOLOWER(34) returns "3234". 

TOUPPER, ToUpper, or toupper Converts any lowercase characters to uppercase. TOUPPER("hello")returns "HELLO". 

Conditional statements in expressions 
IMPORTANT Keep the following in mind when using conditional statements: 

• The condition portion of the statement can be any numeric or Boolean expression.
• If the condition is a numeric expression, including a tag, zero is treated as false and

any non-zero value is treated as true. 
• Using a string operand (string Literals, string properties, string tags, or the result of a 

String Operation) as the condition of a conditional statement is not supported. 
• All parts of a conditional statement are required. 
The value if true and value if false portions of the conditional statement can be any 
valid expression, including another conditional statement. 

Function Description Example: If tag1 = 5 and tag2 = 7, then:
IIF, Iif, iif Evaluates with the same rules as numeric operands. If the 

condition evaluates to 0 (false), the second value is used. If 
the condition evaluates to non-zero (true), the first value is 
used.  
Use this format: IIF(condition, value if 
true, value if false) 

IIF (tag1 > tag2, tag1, tag2)
returns 7 (the value of tag2) because tag1 is not greater than tag2

?: The following requirements are specific to the ?: statement: 
• The conditional operator is right-associative. Therefore, a
? b : c ? d : e is evaluated as a ? b : (c ? d :
e). 

• The segments of a conditional operation must be 
surrounded by white space or parentheses. 

• A new line counts as white space. 
Use this format: condition ? value if
true : value if false 

(tag1 > tag2) ? tag1 : tag2 returns 7 
(the value of tag2) because tag1 is not greater than tag2

Relational operators in expressions 
Symbol (Function) Description Example: If tag1 = 5 and tag2 = 7, then:
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== (Equal to) Compares the two values and returns a 1 (true) if they are 
equal. Returns a 0 (false) if they are not equal. Performs a 
case-sensitive string comparison. All values are converted to 
double-precision floating point first, and then the operation 
is performed.  

tag1 == tag2 is false, so 
the expression returns 0

!= (Not equal to) Compares the two values and returns a 1 (true) if they are not 
equal. Returns a 0 (false) if they are equal. All values are 
converted to double-precision floating point first, and then 
the operation is performed. 

tag1 != tag2 is true, so 
the expression returns 1

< (Less than) Compares two values and returns a 1 (true) if the value on 
the left is smaller than the value on the right. Returns a 0 
(false) if not. All values are converted to double-precision 
floating point first, and then the operation is performed. 

tag1 < tag2 is true,  so the 
expression returns 1

> (Greater than) Compares two values and returns a 1 (true) if the value on 
the left is larger than the value on the right. Returns a 0 
(false) if not. All values are converted to double-precision 
floating point first, and then the operation is performed. 

tag1 > tag2 is false, so the 
expression returns 0

<= (Less than or equal to) Compares two values and returns a 1 (true) if the value on 
the left is smaller or the same as the value on the right. 
Returns a 0 (false) if not. All values are converted to 
double-precision floating point first, and then the operation 
is performed. 

tag1 <= tag2 is true, so 
the expression returns 1

>= (Greater than or equal to) Compares two values and returns a 1 (true) if the value on 
the left is larger or the same as the value on the right. 
Returns a 0 (false) if not. All values are converted to 
double-precision floating point first, and then the operation 
is performed. 

tag1 >= tag2 is false, so 
the expression returns 0

Logical operators in expressions 
Symbol (Function) Description 
&& (Logical AND) Returns a value of 1 if the statements to the right and to the 

left of the operator are both true (non-zero). 

Example: If tag1 = 5 and tag2 = 7, then:
(tag1 < tag2) && (tag1 == 5) returns a 1 
because both statements are non-zero (true)
tag1 && tag2 returns a 1 because both tag1 
and tag2 are non-zero (true)

ll (Logical OR) Returns a value of 1 if either the statement to the left or to the 
right of the operator is true (non-zero). 

(tag1 > tag2) ll  (tag1 == 5) returns a value of 
1 because tag1 == 5 is true

! (Logical NOT) Inverts the Boolean value of an expression. Returns true if the 
expression is false and returns false if the expression is true. 
If the expression (a>b) evaluates to true, then !(a>b) evaluates 
to false. 

!(tag1 < tag2)
The expression tag1 < tag2 evaluates to true 
and returns a value of 1, but the NOT operator 
reverses the logical value, and 0 is returned. 

Bitwise operators in expressions 
Symbol (Function) Description Example: If  tag1 = 5 (binary 0000 0000 0000 0101) 

and tag2 = 3 (binary 0000 0000 0000 0011), then:
& (Bitwise AND) Returns an integer with a bit set to 1 if both of the 

corresponding bits in the original numbers are 1. Otherwise, 
the resulting bit is 0. 

| (Bitwise inclusive OR) Returns an integer with a bit set to 1 if either or both of the 
corresponding bits in the original numbers are 1. If both bits 
are 0, the resulting bit is 0. 

tag1 | tag2 returns 7 (binary 0000 0000 0000 
0111) 

^ (Bitwise exclusive XOR) Returns an integer with a bit set to 1 if either of the 
corresponding bits in the original numbers is 1. If both bits 
are 1 or both are 0, the resulting bit is 0. 

tag1 ^ tag2 returns 6
(binary 0000 0000 0000 0110) 

tag1 & tag2 returns 1 (binary 0000 0000 0000 0001)
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>> (Right Shift) Shifts the bits within the left operand by the amount 
specified in the right operand. The bit on the right 
disappears. 
Either a 0 or a 1 is shifted in on the left depending on 
whether the integer is signed or unsigned. With unsigned 
integers, 0 is always shifted in on the left. With signed 
integers, a 0 is shifted in when the number is positive (that 
is, the leftmost bit--the sign bit--is 0), and a 1 is shifted in 
when the number is negative (that is, the leftmost bit--the 
sign bit--is 1). In other words, with signed integers, the sign 
of the number is always maintained. 

tag1 >> 1 returns 2 
(binary 0000 0000 0000 0010) 

<< (Left Shift) Shifts the bits within the left operand by the amount 
specified in the right operand. The bit on the left disappears 
and a 0 is shifted in on the right. 
If the left bit is a 1, an overflow occurs, and an error message 
appears. To prevent this, use the bitwise AND (&&) operator 
in an expression.  
For example, 
(dev << 1) && 65535, where 65535 is 1111 1111 1111 1111 in binary 
form. 
Where dev is a tag name whose value is being shifted left. 

tag1 << 1 returns 10
(binary 0000 0000 0000 1010) 

~ (Complement) Gives the ones complement of a number.  
For example, use this operator to reverse every bit within the 
number so that every 1 bit becomes a 0 and vice versa. 

~ tag1 returns -6 
(binary 1111 1111 1111 1010) 

Properties of graphic elements in expressions 
IMPORTANT • Avoid setting up circular references using graphic element property bindings 

because this can result in unpredictable values or a runtime error. 
An example of a circular reference would be having three elements on the screen 
such that, for example, Element1.Opacity is bound to Element2.Opacity, 
Element2.Opacity is bound to Element3.Opacity, and Element3.Opacity is bound to 
Element1.Opacity. 

• A numeric display’s .Value property is treated as a string when using the “+” operator, 
causing a concatenation to occur instead of an addition.  To force an addition of 
.Value properties, first multiply .Value by 1. 
For example, (NumericDisplay_001.Value*1) + (NumericDisplay_002.Value*1) will 
perform an addition of the .Value properties. However, NumericDisplay_001.Value + 
NumericDisplay_002.Value will perform a concatenation of the .Value properties. 

Name Description Example 
Property name Property names refer to components of the current application. This differs 

from tags, which refer to data items in a controller.  
The graphic elements must all be on the same screen, popup, or System 
Banner.  
You cannot use an alias property in an expression. 
Use the syntax: ElementName.PropertyName 
An expression can contain: 
• Bindable properties. 
• Multiple graphic element properties. 
• Graphic element property bindings AND tags AND user-defined properties 

or any combination. 

MyElement.X + MyElement.Y / MyElement.Opacity 

MyElement.X + ::MyController.MyTag + 
MyCustomProperty 

Punctuators in expressions 
Symbol Description Example 
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( ) Opening and closing parentheses. Use parentheses around 
any subexpression to specify the order of operations. 
Subexpressions inside parentheses are evaluated prior to any 
operators outside the parentheses being applied. 

3 + 2 * 6 returns 15 
(3 + 2) * 6 returns 30 

See also 
Create an expression on page 520 

When a property is bound to a data item, it receives its value 
dynamically. A data item can be a tag, an extended property of a tag, or 
an expression. Data items are also properties of screens, project events, 
and graphic elements, including instances of Add-On Graphics. If a 
property can be bound, a Binding button  appears next to the 
property name when you point to it. 

To bind a property to a data item 
1. Select the graphic element or instance of the Add-On Graphic.

Tip: Select multiple elements to bind a common property of each element simultaneously. 

2. Expand the categories in the Properties tab to locate the property
to bind to a tag.

3. Point to the property box, click the Binding button  when it
appears, and select Bind property to item.

4. Click Select tag . The Tag Browser opens.
5. Create the binding by performing one of the following:

• Select Browse  to open the Tag Browser and then navigate
to select the graphic element and property. Selecting a graphic
element in the Tag Browser lists of properties of the selected
graphic element.

Tip: Binding to user-defined alias properties of an Add-On Graphic is not supported. Bind 
only to user-defined data type properties in an Add-On Graphic.  

• Type an expression in the Enter binding box or to create or edit
lengthy or complex expression, select Open Expression
Editor .

Bind a property to a data 
item 
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IMPORTANT • When binding an enumerated property to a string tag, ensure that the 
content of the string tag, including case, matches the content and case 
on the user interface. For example, the rounding property value Nearest 
is different than the rounding property nearest.    

• When binding to a property that consists of a list (for example, FontName, 
Format, Rounding) use a string tag that exactly matches the text of the 
item in the list. For example, to bind and use the Saturday Sans font, the 
string must contain Saturday Sans ICG to be considered an exact match. 
If the value of the tag does not match a value in the list, the first item in 
the list is used. 

• References to graphic element properties in a binding do not update 
automatically if a graphic element is renamed.  

• Binding to the property of any screen or graphic element outside of the 
definition of an Add-On Graphic is not supported. Add-On Graphics are 
self-contained elements. From within the definition of an Add-On 
Graphic, bind to the properties of that definition, the properties of 
graphic elements in that definition, and properties passed into the 
definition through user-defined properties. 

• Bind the properties of graphic element or the instance of an Add-On 
Graphic only to properties of graphic elements and Add-On Graphics that 
are on the same screen, popup, or System Banner. 

• When changing the value of a graphic element or instance of an Add-On 
Graphic property on a screen by binding to it, the changed value is not 
retained when closing and re-opening the screen. 

• When changing the value of a graphic element or instance of an Add-On 
Graphic property on a popup by binding to it, the changed value is 
retained when closing and re-opening the popup. 

• When binding tags to numeric properties, keep the following in mind: 
• If a numeric property is bound to a REAL tag, the resulting value is 

rounded.   
• If a numeric property is bound to a STRING tag or property source, the 

resulting value is truncated. 

See also 
What is binding? on page 502 

Bind a color property to a tag or expression on page 500 

Remove a binding on page 513 

Search for and select a tag 

Create an expression on page 520 

Bind a color property to a tag or expression to dynamically change a 
color.  

To bind a color property to a tag or an expression 
• Use one of the following methods: 

• Bind to a string tag or an expression that resolves to a string in 
the format #RRGGBB. R, G, B are the Hex digits that represent 
the values for the red, green, and blue color channels. For 
example, the string "#ffff00" produces yellow. 

• Bind to a string tag or to an expression that resolves to a string 
of a supported color name. For example, the string "yellow" 
produces yellow. 

Bind a color property to a 
tag or expression 
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IMPORTANT • Bind color properties only to string tags. Binding to an integer tag, a 
floating point tag, or an expression is not supported and does not change 
a color. 

• Selecting a default color is required. Selecting NoFill does not apply the 
bound tag value at runtime. 

See also 
Supported color keywords and RGB values on page 501 

What is binding? on page 502 

Create an expression on page 520 

Configure an animation using a Color Table on page 437 

Configure an animation using a State Table on page 438 

Property-to-property binding binds the property of one graphic element 
to the same property of another graphic element on the screen. If the 
graphic elements display a value in different formats, the graphic 
elements show the same value on the HMI device. This example depicts 
binding the value property of a numeric display to the Level property of a 
mixer to show the level graphically and numerically on the HMI device.   

 

Property-to-property 
binding 
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 Graphic elements on a screen 
Item Description 

 
A MixingHopperSide_001 graphic element on a screen. The value of the 
MixingHopperSide_001 graphic element is bound to the Level tag. Browse to the 
controller tag to show the value on the HMI device. The value of the Level shows 
graphically on the mixing hopper on the HMI device. 

 
A NumericDisplay_001 graphic element on the same screen. The value of the 
NumericDisplay_001 graphic element is bound to the Level property of the mixing 
hopper graphic element. To bind the property of one graphic element to the property of 
another graphic element, use the format ElementName.PropertyName. The value of 
Level shows numerically on the numeric display on the HMI device.  

 Graphic elements on the HMI device 
Item Description 

 
The mixing hopper graphic element and the numeric display graphic element show the 
level of the mixer on the HMI device.   

See also 
Bind a property to a data item on page 508 

Properties that do not support binding on page 512 

Remove a binding on page 513 

What is binding? on page 502 

Keywords to use as a string to select a color when binding a color 
property include:  Supported color keywords 

and RGB values 
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See also 
Bind a color property to a tag or expression on page 500 

Certain objects have properties that do not support binding: 

Object Properties 

Alarm table • SelectedAlarmName 
• SortOrder 

Banner • Height 
Graphic element • Border 

• TextAlignment 
Popup • BackgroundOpacity 

• CaptionVisible 
• CloseVisible 
• Height 
• Width 

Properties that do not 
support binding 
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Object Properties 

Screen and shortcut • Icon 
• ShowDefaultBanner 

Trace • Label 
• Color 
• Marker 
• Width 

Trend chart • TimeSpan 
• SampleRate 
• GridColor 
• AxesColor 
• ShowGridVertical 
• ShowGridHorizontal 
• ShowAxes 
• ShowButtons 

See also 
Properties tab on page 494 

What is binding? on page 502 

Bind a property to a data item on page 508 

•  
Remove a binding between a property and a data item to associate the 
property with a static value or a different data item, or to leave the 
property unbound. 

To remove a binding 
1. Select the graphic element on the screen or in the Graphic 

Explorer.  
2. On the Properties window, click the Properties tab. 
3. Select Binding  for the bound property.  
4. Select Remove binding from property.  

See also 
What is binding? on page 502 

Bind a property to a data item on page 508 

Search for and select a tag 

If an individual tag is configured in Logix Designer with extended 
properties, use the extended properties on this tag to display the name, 
description, engineering units, limits, and state values of the tag. 

By binding graphic elements to the extended properties of tags, you no 
longer need to hard-code specific values, such as limits, in the graphic 
element. 

Remove a binding 

Bind to the extended 
properties of a tag 
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See also 
What are extended properties? on page 514 

Assign the extended properties of a tag to a graphic element on 
page 514 

What is binding? on page 502 

Bind a property to a data item on page 508 

Bind an extended property of a tag to a graphic element. Extended 
properties are added to tags in Logix Designer and are available to use in 
View Designer. 

Prerequisites 
• In Logix Designer, use the Tag Editor Properties pane to add 

extended properties to tags in the .acd project file and save the 
file. 

• In View Designer verify that the Logix Designer .acd project file 
with the extended properties is configured as a controller 
reference on the References tab of the Project Properties dialog 
box. 

To assign an extended property to a graphic element 
1. Add a graphic element to the screen.  
2. Expand the categories in the Properties tab to locate the property 

to bind to a tag.  
3. Point to the property box, click the Binding button  when it 

appears, and select Bind property to item. 
4. Click Select tag . The Tag Browser opens. to browse to the tag 

with the extended property. All extended properties begin with @.  
5. Select the extended property. 

See also 
What are extended properties? on page 514 

Add a graphic element to a screen on page 136 

Search for and select a tag 

Graphic element configured with extended properties on page 516 

Extended properties are properties added to tags and data types in Logix 
Designer. Extended properties help reduce the number of tags to create 
in Logix Designer. If an individual tag is configured in Logix Designer with 
extended properties, use the extended properties on this tag to display 
the name, description, engineering units, limits, and state values of the 
tag. Binding graphic elements and Add-On Graphics to the extended 
properties of tags means not having to hard-code specific values, such 
as limits, in the graphic element or Add-On Graphic. 

Assign the extended 
properties of a tag to a 
graphic element 

What are extended 
properties? 
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Downloading extended properties to the controller makes the properties 
available to use in View Designer. For example, adding an engineering 
unit property to a tag in Logix Designer makes the engineering unit 
property available to use when browsing to the tag in View Designer. If 
the engineering unit changes in Logix Designer, updating the project file 
(.acd) and downloading it to the controller changes the extended property 
value while the Logix controller is online. 

Bind extended properties to graphic elements and Add-On Graphics. For 
example, bind a text property of a graphic element to the extended 
property on a member of a tag. Include extended properties as values 
within expressions. Use both General and Data extended properties from 
Logix Designer in View Designer. 

General properties include: 

• Name. The name of the tag or data type which is limited to 40 
characters. 

• Description. The description of the tag or data type which is 
limited to 128 characters. 

Data properties include: 

• Engineering Units. The units of measurement, such as degrees 
Celsius, pounds, and pounds per square inch, associated with a 
tag or tag structure or array member. The Engineering unit is 
limited to 80 characters. 

• Minimum. The minimum (low) value of a tag or tag structure or 
array member. This may be used with the Maximum property to 
create a high and low limit for a DINT, INT, LINT, SINT, REAL, 
LREAL, UDINT, UINT, ULINT, and USINT tag. The Minimum 
property value must be less than or equal to the Maximum 
property value.  

• Maximum. Only the decimal display style is supported for the 
Minimum value. The minimum limit is not enforced in the Logix 
controller. There is no controller fault if the value exceeds the 
minimum limit.  

 
Tips:  
• Only the decimal display style is supported for the Minimum value. 
• Minimum and maximum limits are not enforced in the Logix controller. There is no controller fault 

if the value does not meet the minimum limit or exceeds the maximum limit. 
• Only the decimal display style is supported for the Maximum value. 
• The maximum limit is not enforced in the Logix controller. There is no controller fault if the value 

exceeds the maximum limit. 

• State 0. The State 0 identifier associated with the tag or tag 
structure or array member. Use this with the State 1 property to 
describe two states of a BOOL tag. For example, State0 is Start 
and State1 is Stop for a status state. The identifier is limited to 80 
characters. 

• State 1. The State 1 identifier associated with the tag or tag 
structure or array member. Use this with the State 0 property to 
describe two states for a BOOL tag. The identifier is limited to 80 
characters. 

The extended properties available for a selected tag depend on the data 
type of the tag.  
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IMPORTANT The HMI device does not display passed-through extended properties of aliased Logix 
Designer tags. 

See also 
Graphic element configured with extended properties on page 516 

Add a graphic element to a screen on page 136 

Assign the extended properties of a tag to a graphic element on 
page 514 

Search for and select a tag 

Extended properties and aliases on page 517 

To display the level and temperature of a tank, instead of assigning 
multiple tags to display the information, select the tags that have the 
extended properties configured in Logix Designer. To display the on or 
off status of the motor on the tank, select the tag configured with the 
State 0 and State 1 extended properties.  

In this example, the Tank.Level and Tank.Temp tags are bound to 
graphic elements. This displays the tag and extended property values for 
the name, description, minimum and maximum limits, and engineering 
units. The tag, MotorStatus, is bound to the Motor graphic element. This 
displays the State 0 and State 1 extended properties. 

 
Item Name Description 

 
Tank.Level Displays the value of the Tank.Level tag. 

 
Tank.Level.@EngineeringUnit Displays the unit of measurement, such as 

gallons, for the Tank.Level tag. 

 
Tank.Level.@Max Displays the maximum value of the 

Tank.Level tag. 

 
Tank.Level.@Min Displays the minimum value of the Tank.Level 

tag. 

 
Tank.Level@Name Displays the name of the Tank.Level tag. 

 
Tank.Level.@Description Displays the description of the Tank.Level 

tag. 

Graphic element configured 
with extended properties 
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MotorStatus Displays the status, On or Off, of the motor 

with the expression, for example:  
IIF(MotorStatus.Runnin
g==1,MotorStatus.Runni
ng.@State1, 
MotorStatus.Running.@S
tate0) 

 
Tank.Temp.@EngineeringUnit Displays the unit of measurement, such as 

degrees in Celsius, for the Tank.Temp tag. 

 
Tank.Temp.@Max Displays the maximum value of the 

Tank.Temp tag. 

 
Tank.Temp.@Min Displays the minimum value of the 

Tank.Temp tag. 

See also 
What are extended properties? on page 514 

Assign the extended properties of a tag to a graphic element on 
page 514 

For a SINT, INT, DINT, LINT, REAL, LREAL, UDINT, UINT, ULINT and 
USINT tag: 

Tag extended property 
referenced 

Base tag Alias of base tag using 
pass-through for all 
extended properties 

Alias of base tag using entered value for textual 
extended properties.  You cannot enter a value for 
the numeric extended properties. 

.@Name Displays value Displays value Displays value 

.@Description Displays value Displays a blank with no error Displays value 

.@EngineeringUnit Displays value Displays an error Displays value 

.@Max Displays value Displays an error Displays an error 

.@Min Displays value Displays an error Displays an error 

For a BOOL tag: 
Tag extended property 
referenced 

Base tag Alias of base tag using 
pass-through for all extended 
properties 

Alias of base tag using entered value for textual 
extended properties. 

.@Name Displays value Displays value Displays value 

.@Description Displays value Displays a blank with no error Displays value 

.@EngineeringUnit Displays value Displays an error Displays value 

.@State0 Displays value Displays an error Displays value 

.@State1 Displays value Displays an error Displays value 

See also 
What are extended properties? on page 514 

An expression is a tag name or an equation that returns a numeric value, 
true or false value, or text string.  

Use expressions to improve the data gathered from devices by 
comparing it to other values, combining it with other values, or creating 
cause-and-effect relationships between values.  

Extended properties and 
aliases 

Use expressions 
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See also 
Create an expression on page 520 

Expressions overview on page 518 

Search for and select a tag 

Bind a property to a data item on page 508 

An expression is a tag name or an equation that returns a numeric value, 
true or false value, or text string. Use expressions to make the data you 
gather from devices more meaningful by comparing it to other values, 
combining it with other values, or creating cause-and-effect relationships 
between values.  

You can also use expressions to write or increment values in the 
controller by including them in events.  

Most expressions consist of one or more tag references combined with 
numbers, mathematical operators, or built-in functions. However, a tag is 
not required in an expression. 

To create an expression, you can: 

• Type it directly into the expression/binding box. 
• Open the Expression Editor and create the expression in the 

editor. 
View Designer checks the expression syntax as you create the 
expression. A red outline appears around the expression when invalid 
syntax is detected. The red outline disappears when the syntax becomes 
valid.  

View Designer also verifies the syntax for all expressions in a project 
before it is downloaded to the HMI device. In addition, it verifies that tag 
references exist in the controller projects. It also verifies that the property 
of a graphic element referenced in an expression exists in the screen 
where it exists. If there are invalid expressions, the download process 
stops, and the invalid expressions appear in the Errors window. Verify 
expressions any time during the project development process by using 
the PROJECT > Verify Project command. 

Expressions can contain: 

• Numeric literals 
• String literals 
• Tags 
• Numeric operators 
• Functions 
• String functions 
• Conditional statements 
• Relational operators 
• Logical operators 
• Bitwise operators 
• Properties of graphic elements 

You can add white space to expressions in the form of spaces and new 
lines. Use white space to format expressions so that they are easier to 

Expressions overview 
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read. For example, add new lines to separate conditions in a complex 
expression. 

Use expressions in: 

• Events (Value commands only) 
• Animations (State Tables and Color Tables) 
• Properties (Any bindable property) 

IMPORTANT • Using LINT tags in expressions, write commands, or increment commands is 
not recommended. This is because the values may lose resolution as a result 
of performing the expression calculations. 

• Using strings in numeric operations is not recommended. The exception is 
the + operator, which is used for string concatenation. 

• The Value property of a Numeric Display graphic element evaluates as a 
string value in an expression. For example, if the value of 
NumericDisplay_001.value is 25, and the value of NumericDisplay_003.value 
is 30, then NumericDisplay_001.value + NumericDisplay_003.value will return 
2530, not 55. 

• Using an alias property in an expression is not supported. 
• The HMI device updates data from controllers at a fixed rate of 100, 250, or 

500 milliseconds. This update is asynchronous to any scan in a controller. 

See also 
Expression Editor on page 519 

Create an expression on page 520 

Errors window on page 522 

How are expressions evaluated? on page 529 

How do I open the Expression Editor? 

From any input box where you can apply an expression, click Open 
Expression Editor . 

Use the Expression Editor to create or edit lengthy or complex 
expressions in a resizable window.  

Most expressions consist of one or more tag references combined with 
numbers, mathematical operators, or built-in functions. However, a tag is 
not required in an expression. 

View Designer checks the expression syntax as you create the 
expression. A red outline appears around the expression when invalid 
syntax is detected. The red outline disappears when the syntax becomes 
valid.  

View Designer also verifies the syntax for all expressions in a project 
before it is downloaded to the HMI device. In addition, it verifies that tag 
references exist in the controller projects. It also verifies that the property 
of a graphic element referenced in an expression exists in the screen 
where it exists. If there are invalid expressions, the download process 
stops, and the invalid expressions appear in the Errors window. Verify 
expressions any time during the project development process by using 
the PROJECT > Verify Project command. 

Expression Editor 
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See also 
Create an expression on page 520 

Change an expression on page 521 

Expressions overview on page 518 

How are expressions evaluated? on page 529 

To create an expression, you can: 

• Type it directly into the expression/binding box. 
• Open the Expression Editor and create the expression in the 

editor. 
View Designer checks the expression syntax while the expression is 
created. A red outline appears around the expression when invalid 
syntax is detected. The red outline disappears when the syntax becomes 
valid.  

To create an expression 
1. Type the expression using any combination of the following: 

• Numeric Literals. Use positive and negative numbers. 
• Literal or tag string values. Combine string values that result in a 

single string value or assign a value to a text property. 
• Tags. Use tags as part of an expression or as the entire 

expression. 
• Numeric operators. Perform math on two or more numeric 

values and calculate the result. 
• Math functions. Perform operations such as trigonometric or 

logarithmic calculations on a tag or expression. 
• String functions. Change the case of characters in a string. 
• Conditional statements. Use these IIF functions to evaluate to 

true (1) or false (0). 
• Relational operators. Compare two numeric or string values to 

provide a true (1) or false (0) result. 
• Logical operators. Determine the validity of one or more 

statements and return a true (1) or false (0) result. 
• Bitwise operators. Examine and manipulate individual bits 

within a value. 
• Properties of graphic elements. Use the values of graphic 

element properties in expressions so that if the property values 
change, the result of the expression evaluation changes. The 
property values of graphic elements that reference this property 
also change when the result of the expression evaluation 
changes. 

• Punctuators. Specify the order of operations. 
• White space. Format an expression using spaces, tabs, and 

new lines so that it is easier to understand. 
2. (optional) When creating the expression using the Expression 

Editor, click OK to save the expression.  

Create an expression 
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IMPORTANT • To avoid confusion, do not create a user-defined property with the same 
name as a property of a graphic element on the screen. When using a 
user-defined property name in an expression or binding in a graphic element 
that contains a property with the same name, the expression or binding uses 
the value of the graphic element property, not the value of the user-defined 
property. 

• Using an alias property in an expression is not supported. 
• The HMI device updates data from controllers at a fixed rate of 100, 250, or 

500 milliseconds. This update is asynchronous to any scan in a controller. 

 

 
Tips:  
• Negation is supported for tags, numbers, and anything in parentheses.  
• Cutting, copying, and pasting expressions or parts of expressions between editors is not 

supported. 
• Function names are case sensitive. In general, all upper case, all lower case, and Pascal case are 

accepted. 
• Verify the syntax of all expressions in a project by clicking PROJECT > Verify Project any time 

during the project development process. The results of project verification display in the Errors 
window. 

• Expressions can contain Unicode characters. View Designer supports Unicode characters that 
appear in the Arial Unicode MS font.    

• When inserting text that contains Unicode characters in a graphic element, select Arial Unicode MS 
in the FontName property of the graphic element. Supported Unicode characters appear on the 
HMI device.   

See also 
Change an expression on page 521 

Nest conditional expressions on page 522 

Expression Editor on page 519 

Expressions overview on page 518 

Expression examples on page 503 

Change an expression, for example, to select a different tag. Changes to 
an expression save automatically. 

To change an expression 
• Type the changes directly into the expression/binding box. 
• Open the Expression Editor and make changes to the 

expression in the editor. 

 
Tip: To change a tag in an expression from within the definition of an Add-On Graphic, click 
the tag link in the expression to open the Tag Browser. The tag in the expression is selected 
in the Tag Browser automatically. Select a different tag to change the expression. 

See also 
Create an expression on page 520 

Expressions overview on page 518 

Change an expression 
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How do I open the Errors window? 

The Errors window opens automatically to display the invalid tags or 
expressions detected during project verification. 

To open the Errors window manually, on the Menu bar, click VIEW > 
Errors. 

The Errors window displays the results of project verification. It opens 
when View Designer detects invalid tags or expressions. Downloading a 
project automatically verifies that project. Verify a project at any time 
during project development. For example, verify a project if a controller is 
defined for the project.  

Project verification verifies: 

• The syntax of all expressions contained in the View Designer 
project 

• The validity of parameters passed from one item to another and 
required error messages 

• The existence of elements and properties referenced in an 
expression 

• The existence of tags in the View Designer project in the 
referenced controller projects 

• That Add-On Graphics do not contain direct bindings to controller 
tags or system tags 

• That property bindings in the definition of an Add-On Graphic are 
formatted as ElementName.PropertyName 

• That aliased properties of graphic elements in the definition of an 
Add-On Graphic are not bound  

• That all tags in the data logs are valid.  
Use the Errors window to: 

• View the errors and warnings detected during project verification. 
• Navigate to the source of the error or warning so that you can 

resolve the problem. 
• Sort the results to group them by severity level, description, or 

location in the project. 

See also 
Verify a project on page 718 

Verify Project dialog box on page 544 

Sort the contents of the Errors window on page 718 

Download a runtime application to an HMI device on page 710 

Create more complex expressions by nesting conditional statements 
inside one another to handle situations requiring complex branching. 

For example, assume MyTag1 = 1, MyTag2 = 2, and MyTag3 = 3.  

This example evaluates to 3: 
IIF( ::MyController.MyTag1 > ::MyController.MyTag2, 1, 
IIF( ::MyController.MyTag2> ::MyController.MyTag3, 2, 3 
) ) 

Errors window 

Nest conditional 
expressions 
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OR 

This example evaluates to 3: 
 ::MyController.MyTag1 > ::MyController.MyTag2 ? 1 : 
 ::MyController.MyTag2> ::MyController.MyTag3 ? 2 : 3 

See also 
Create an expression on page 520 

Expression Editor on page 519 

Expressions overview on page 518 

Expression verification checks the syntax of all expressions in your 
project. It also verifies that the property of a graphic element referenced 
in an expression exists in the screen where it is used. In addition, it 
verifies that tag references exist in the controller project. View Designer 
verifies expressions automatically upon downloading a project. Verify 
expressions at any time during project development. For example, verify 
a project if a controller is defined for the project. The Errors window 
displays the results. 

View Designer identifies invalid expression syntax as an error. The 
expression does not work for the project when downloaded to the HMI 
device. Resolve errors before downloading a project to the HMI device.  

To verify expressions: 
1. On the Menu bar, click Project > Verify Project. The Verify 

Project dialog box opens and verification begins.  
2. If there are invalid expressions listed in the Errors window, 

double-click an entry to navigate to the source of the error in the 
project, and make the necessary changes. The list updates each 
time the verification process runs for the project.   

3. Repeat the verification process until there are no errors listed in 
the Errors window. 

See also 
Errors window on page 522 

Verify a project on page 718 

Verify Project dialog box on page 544 

Examples of combinations to use for creating an expression: 

Numeric literals in expressions 
Name Description Example 
Integers Numbers 0-9 specified in base-10 format. Leading zeros are 

not supported. 0 is supported, 01 is not supported. 
123 

Verify expressions 

Expression examples 
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Floating point Numbers that begin with zero or more base-10 digits, then 
the period character as decimal separator, followed by one 
or more base-10 digits. Leading zeros are not supported to 
the left of the decimal point, unless it is just a single zero 
immediately preceding the decimal point. Examples: 1.23 .23 
0.23  

1.23, .23, and 123.45 

Exponential Numbers that begin with an integer or floating point number, 
followed by the character 'e' (or 'E') and an integer. A negation 
operator '-' is supported before the exponent; other 
operators are not.  

6.02e23 means 6.02 * 1023 
1.66e-27 means 1.66 * 10-27 

Numeric operators in expressions 
IMPORTANT • Using strings in numeric operations is not recommended. The exception is the + 

operator, which is used for string concatenation. 
• Using LINT tags in expressions, write commands, or increment commands is not 

recommended. This is because the values may lose resolution as a result of 
performing the expression calculations. 

• Ensure that any tag value you use as a divisor cannot at some point have a value of 
zero. Expressions that attempt to divide a number by zero produce an error at 
runtime. 

String values (literal or tags) in expressions 
Name Description 
String A string literal begins with a double-quote character and 

ends with a double-quote character. Anything between the 
two double-quotes is part of the string literal. You can use 
strings as operands with the plus (+) operator and with 
relational operators. The + operator joins string operands. 
String tags and string literals behave the same way. 
Keep the following in mind when using string tags with the 
relational operators: 
• All relational operators are case-sensitive. 
• Strings are compared on a character-by-character basis. 
• Individual letters are compared based on their Unicode 

value. This means that a lowercase letter is greater than 
its corresponding uppercase letter. 

• If two strings are different lengths and the characters are 
the same, then the longer string is considered to be 
greater than the shorter string. 

Example: If tag1 = "SOME" and tag2 + "THING", then:
tag1+tag2 returns 
"SOMETHING"

Tags in expressions 
Name Description 

Tag A tag can stand alone as an expression or be included as 
part of an expression that is made up of other components. 
An expression that is a tag name returns the value of the tag. 
Tags begin with either "::" or "\".  Use the format 
::ControllerName.TagName.
You can type the tag name or open the Tag Browser and 
select a tag. 

Example: In a controller named Packing, if 
tag1 = 5 and tag2 = 7, then:
::Packing.tag1 returns 5
::Packing.tag1 + 25 returns 30
::Packing.tag1 % ::Packing.tag2 returns 5
::Packing.tag1>::Packing.tag2 returns 0 (false)
(::Packing.tag1<::Packing.tag2) 
&&(::Packing.tag1==5) returns 1 (both 
statements are true)
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Math Function in expressions 
Function Description Example 
ABS, Abs, or abs Returns the absolute value of the expression. ABS(-1.23)returns 1.23. 

ABS(1.23)returns 1.23.
ARCCOS, arccos, ACOS, or acos Returns the arc cosine of the expression in radians. ACOS(-1.0)returns 3.14159. 
ARCSIN, arcsin, ASIN, or asin Returns the arc sine of the expression in radians. ARCSIN(1)returns 1.570796. 

ARCTAN, arctan, ATAN, or atan Returns the arc tan of the expression in radians. ATAN(-45.01)returns -1.54858. 

COS, Cos, or cos Returns the cosine of the expression in radians. COS(14.78)returns -0.599465. 
LOG, Log, or log Returns the natural log of the expression. LOG(2) returns 0.69314718 

LOG10, Log10, or log10 Returns the base-10 log of the parameter. LOG10(100)returns 2. 

SIN, Sin, or sin Returns the sine of the expression in radians. SIN(45.175643)returns 0.929607. 
SQRT, Sqrt, or sqrt Returns the square root of an expression. SQRT(144)returns 12. 
TAN, Tan, or tan Returns the tangent of the expression in radians. TAN(1)returns 1.5574077246549023. 

TRUNC, Trunc, or trunc Returns the value of the parameter with any digits to the 
right of the decimal point removed. 

TRUNC(10.8282)returns 10. 

POW, pow Returns the result of raising the first value to the power of 
the second value. All values are converted to 
double-precision floating point first, and then the operation 
is performed. 

POW(10,3)returns 1000. 

Symbol (Operation) Description 
+ (Addition) Returns the sum of the values. SINT, INT, DINT, LINT, and REAL 

tags can be used in any order. All values are converted to 
double-precision floating point first, and then the operation is 
performed. If any operand is a string, it is concatenated.  

Example: If tag1 = 5 and tag2 = 7, then: 
tag1 + tag2 returns a value of 
12 MyDINT + "SomeString" returns a value 
of  5SomeString, if MyDINT = 5

- (Subtraction) Returns the difference of the two values. SINT, INT, DINT, LINT, 
and REAL tags can be used in any order. All values are 
converted to double-precision floating point first, and then 
the operation is performed.  

tag1 - tag2 returns a value of 
-2

- (Negation) Inverts the sign of the operand, making a positive number into 
a negative number or a negative number into a positive 
number.  

-tag2 returns -7 

* (Multiplication) Returns the product of two values. SINT, INT, DINT, LINT, and 
REAL tags can be used in any order. All values are converted to 
double-precision floating point first, and then the operation is 
performed.   

tag1 * tag2 returns a 
value of 35  

/ (Division) Returns the quotient of the two values. SINT, INT, DINT, LINT, 
and REAL tags can be used in any order. All values are 
converted to double-precision floating point first, and then 
the operation is performed.  

tag1 / tag2 returns a 
value of 0.71

% (Modulus) Returns the remainder of one number divided by another. 
SINT, INT, DINT, LINT, and REAL tags can be used in any order. 
All values are converted to double-precision floating point 
first, and then the operation is performed.  

tag1 % tag2 returns  a 
value of 5
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String functions in expressions 
Function Description Example 
TOLOWER, ToLower, or tolower Converts any uppercase characters to lower lowercase. 

Converts a numeric to a string containing that number. 
TOLOWER("New York")returns "new york". 
This expression converts a numeric to a string  containing that 
number: 
TOLOWER(32) + TOLOWER(34) returns "3234". 

TOUPPER, ToUpper, or toupper Converts any lowercase characters to uppercase. TOUPPER("hello")returns "HELLO". 

Relational operators in expressions 
Symbol (Function) Description Example: If tag1 = 5 and tag2 
== (Equal to) Compares the two values and returns a 1 (true) if they are 

equal. Returns a 0 (false) if they are not equal. Performs a 
case-sensitive string comparison. All values are converted to 
double-precision floating point first, and then the operation 
is performed.  

tag1 == tag2 is false, so the expression returns 0

!= (Not equal to) Compares the two values and returns a 1 (true) if they are not 
equal. Returns a 0 (false) if they are equal. All values are 
converted to double-precision floating point first, and then 
the operation is performed. 

tag1 != tag2 is true, so the expression returns 1

< (Less than) Compares two values and returns a 1 (true) if the value on 
the left is smaller than the value on the right. Returns a 0 
(false) if not. All values are converted to double-precision 
floating point first, and then the operation is performed. 

tag1 < tag2 is true, so the expression returns 1

Conditional statements in expressions 
IMPORTANT Keep the following in mind when using conditional statements: 

• The condition portion of the statement can be any numeric or Boolean expression.
• If the condition is a numeric expression, including a tag, zero is treated as false and

any non-zero value is treated as true. 
• Using a string operand (string Literals, string properties, string tags, or the result of a 

String Operation) as the condition of a conditional statement is not supported. 
• All parts of a conditional statement are required. 
The value if true and value if false portions of the conditional statement can be any 
valid expression, including another conditional statement. 

Function Description 

IIF, Iif, iif Evaluates with the same rules as numeric operands. If the 
condition evaluates to 0 (false), the second value is used. If 
the condition evaluates to non-zero (true), the first value is 
used.  
Use this format: IIF(condition, value if 
true, value if false) 

Example: If tag1 = 5 and tag2 = 7, then:

IIF (tag1 > tag2, tag1, tag2)
returns 7 (the value of tag2) because tag1 is not greater than tag2

?: The following requirements are specific to the ?: statement: 
• The conditional operator is right-associative. Therefore, a
? b : c ? d : e is evaluated as a ? b : (c ? d :
e). 

• The segments of a conditional operation must be 
surrounded by white space or parentheses. 

• A new line counts as white space. 
Use this format: condition ? value if
true : value if false 

(tag1 > tag2) ? tag1 : tag2 returns 7 
(the value of tag2) because tag1 is not greater than tag2
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> (Greater than) Compares two values and returns a 1 (true) if the value on 
the left is larger than the value on the right. Returns a 0 
(false) if not. All values are converted to double-precision 
floating point first, and then the operation is performed. 

tag1 > tag2 is false, so the expression returns 0

<= (Less than or equal to) Compares two values and returns a 1 (true) if the value on 
the left is smaller or the same as the value on the right. 
Returns a 0 (false) if not. All values are converted to 
double-precision floating point first, and then the operation 
is performed. 

tag1 <= tag2 is true, so the expression returns 1

>= (Greater than or equal to) Compares two values and returns a 1 (true) if the value on 
the left is larger or the same as the value on the right. 
Returns a 0 (false) if not. All values are converted to 
double-precision floating point first, and then the operation 
is performed. 

tag1 >= tag2 is false, so the expression returns 0

Bitwise operators in expressions 
Symbol (Function) Description Example: If  tag1 = 5 (binary 0000 0000 0000 0101) and 

tag2 = 3 (binary 0000 0000 0000 0011), then:
& (Bitwise AND) Returns an integer with a bit set to 1 if both of the 

corresponding bits in the original numbers are 1. Otherwise, 
the resulting bit is 0. 

| (Bitwise inclusive OR) Returns an integer with a bit set to 1 if either or both of the 
corresponding bits in the original numbers are 1. If both bits 
are 0, the resulting bit is 0. 

tag1 | tag2 returns 7  (binary 0000 0000 0000 0111) 

^ (Bitwise exclusive XOR) Returns an integer with a bit set to 1 if either of the 
corresponding bits in the original numbers is 1. If both bits 
are 1 or both are 0, the resulting bit is 0. 

tag1 ^ tag2 returns
(binary 0000 0000 0000 0110) 

>> (Right Shift) Shifts the bits within the left operand by the amount 
specified in the right operand. The bit on the right 
disappears. 
Either a 0 or a 1 is shifted in on the left depending on 
whether the integer is signed or unsigned. With unsigned 
integers, 0 is always shifted in on the left. With signed 
integers, a 0 is shifted in when the number is positive (that 
is, the leftmost bit--the sign bit--is 0), and a 1 is shifted in 
when the number is negative (that is, the leftmost bit--the 
sign bit--is 1). In other words, with signed integers, the sign 
of the number is always maintained. 

tag1 >> 1 returns 2 (binary 0000 0000 0000 0010) 

Logical operators in expressions 
Symbol (Function) Description 
&& (Logical AND) Returns a value of 1 if the statements to the right and to the 

left of the operator are both true (non-zero). 

Example: If tag1 = 5 and tag2 = 7, then:
(tag1 < tag2) && (tag1 == 5) returns a 1 
because both statements are non-zero (true)
tag1 && tag2 returns a 1 because both tag1 
and tag2 are non-zero (true)

ll (Logical OR) Returns a value of 1 if either the statement to the left or to the 
right of the operator is true (non-zero). 

(tag1 > tag2) ll  (tag1 == 5) returns a value of 
1 because tag1 == 5 is true

! (Logical NOT) Inverts the Boolean value of an expression. Returns true if the 
expression is false and returns false if the expression is true. 
If the expression (a>b) evaluates to true, then !(a>b) evaluates 
to false. 

!(tag1 < tag2)
The expression tag1 < tag2 evaluates to true 
and returns a value of 1, but the NOT operator 
reverses the logical value, and 0 is returned. 

tag1 & tag2 returns 1 (binary 0000 0000 0000 
0001)
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<< (Left Shift) Shifts the bits within the left operand by the amount 
specified in the right operand. The bit on the left disappears 
and a 0 is shifted in on the right. 
If the left bit is a 1, an overflow occurs, and an error message 
appears. To prevent this, use the bitwise AND (&&) operator 
in an expression.  
For example, 
(dev << 1) && 65535, where 65535 is 1111 1111 1111 1111 in binary 
form. 
Where dev is a tag name whose value is being shifted left. 

tag1 << 1 returns 10
(binary 0000 0000 0000 1010) 

~ (Complement) Gives the ones complement of a number.  
For example, use this operator to reverse every bit within the 
number so that every 1 bit becomes a 0 and vice versa. 

~ tag1 returns -6 
(binary 1111 1111 1111 1010) 

Properties of graphic elements in expressions 
IMPORTANT • Avoid setting up circular references using graphic element property bindings 

because this can result in unpredictable values or a runtime error. 
An example of a circular reference would be having three elements on the screen 
such that, for example, Element1.Opacity is bound to Element2.Opacity, 
Element2.Opacity is bound to Element3.Opacity, and Element3.Opacity is bound to 
Element1.Opacity. 

• A numeric display’s .Value property is treated as a string when using the “+” operator, 
causing a concatenation to occur instead of an addition.  To force an addition of 
.Value properties, first multiply .Value by 1. 
For example, (NumericDisplay_001.Value*1) + (NumericDisplay_002.Value*1) will 
perform an addition of the .Value properties. However, NumericDisplay_001.Value + 
NumericDisplay_002.Value will perform a concatenation of the .Value properties. 

Name Description Example 
Property name Property names refer to components of the current application. This differs 

from tags, which refer to data items in a controller.  
The graphic elements must all be on the same screen, popup, or System 
Banner.  
You cannot use an alias property in an expression. 
Use the syntax: ElementName.PropertyName 
An expression can contain: 
• Bindable properties. 
• Multiple graphic element properties. 
• Graphic element property bindings AND tags AND user-defined properties 

or any combination. 

MyElement.X + MyElement.Y / MyElement.Opacity 

MyElement.X + ::MyController.MyTag + 
MyCustomProperty 

Punctuators in expressions 
Symbol Description Example 
( ) Opening and closing parentheses. Use parentheses around 

any subexpression to specify the order of operations. 
Subexpressions inside parentheses are evaluated prior to any 
operators outside the parentheses being applied. 

3 + 2 * 6 returns 15 
(3 + 2) * 6 returns 30 

See also 
Create an expression on page 520 
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The operations in an expression are performed in a prescribed order. 
Operations of equal order are performed from left to right. High 
precedence operators are evaluated before low precedence operators. 
The following lists the order in which the operations are performed, from 
highest to lowest. 

• Parenthetical expressions and functions
• Unary Negation, Logical Not, Bitwise Complement Operator
• Multiplication, Division, Modulus
• Addition, Subtraction
• Bitwise Shift Left, Bitwise Shift Right
• Greater Than, Less Than, Greater Than or Equal To, Less Than or

Equal To
• Equal To, Not Equal To
• Bitwise And
• Bitwise Exclusive Or
• Bitwise Or
• Logical And
• Logical Or
• Conditional operator ?:
• Comma (separating function arguments)

IMPORTANT The HMI device updates data from controllers at a fixed rate of 100, 250, or 500 
milliseconds. This update is asynchronous to any scan in a controller. 

Tip: If an expression contains multiple operators or functions, group the conditions in parenthesis "( 
)". This ensures the correct order of execution and makes it easier to read the expression. 

See also 
Create an expression on page 520 

Change an expression on page 521 

Expression Editor on page 519 

Expressions overview on page 518 

Supported expression components on page 529 

View Designer supports the following expression components: 

• Bitwise operators in expressions
• Conditional statements in expressions
• Logical operators in expressions
• Math functions in expressions
• Numeric literals in expressions
• Numeric operators in expressions
• Property names in expressions
• Punctuators in expressions
• Relational operators in expressions
• String functions in expressions
• String values in expressions
• Tags in expressions

How are expressions 
evaluated? 

Supported expression 
components 
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See also 
Create an expression on page 520 

How are expressions evaluated? on page 529 

Expressions overview on page 518 

Expression Editor on page 519 

These are the examples of bitwise operators in expressions. 

Symbol (Function) Description Example: If  tag1 = 5 (binary 0000 0000 0000 0101) and 
tag2 = 3 (binary 0000 0000 0000 0011), then:

& (Bitwise AND) Returns an integer with a bit set to 1 if both of the 
corresponding bits in the original numbers are 1. Otherwise, 
the resulting bit is 0. 

| (Bitwise inclusive OR) Returns an integer with a bit set to 1 if either or both of the 
corresponding bits in the original numbers are 1. If both bits 
are 0, the resulting bit is 0. 

tag1 | tag2 returns 7 (binary 0000 0000 0000 0111) 

^ (Bitwise exclusive XOR) Returns an integer with a bit set to 1 if either of the 
corresponding bits in the original numbers is 1. If both bits 
are 1 or both are 0, the resulting bit is 0. 

tag1 ^ tag2 returns 6 (binary 0000 0000 0000 
0110) 

>> (Right Shift) Shifts the bits within the left operand by the amount 
specified in the right operand. The bit on the right 
disappears. 
Either a 0 or a 1 is shifted in on the left depending on 
whether the integer is signed or unsigned. With unsigned 
integers, 0 is always shifted in on the left. With signed 
integers, a 0 is shifted in when the number is positive (that 
is, the leftmost bit--the sign bit--is 0), and a 1 is shifted in 
when the number is negative (that is, the leftmost bit--the 
sign bit--is 1). In other words, with signed integers, the sign 
of the number is always maintained. 

tag1 >> 1 returns 2 (binary 0000 0000 0000 0010) 

<< (Left Shift) Shifts the bits within the left operand by the amount 
specified in the right operand. The bit on the left disappears 
and a 0 is shifted in on the right. 
If the left bit is a 1, an overflow occurs, and an error message 
appears. To prevent this, use the bitwise AND (&&) operator 
in an expression.  
For example, 
(dev << 1) && 65535, where 65535 is 1111 1111 1111 1111 in binary 
form. 
Where dev is a tag name whose value is being shifted left. 

tag1 << 1 returns 10 (binary 0000 0000 0000 1010) 

~ (Complement) Gives the ones complement of a number.  
For example, use this operator to reverse every bit within the 
number so that every 1 bit becomes a 0 and vice versa. 

~ tag1 returns -6 (binary 1111 1111 1111 1010) 

• These are the examples of conditional statements in expressions. 

IMPORTANT Keep the following in mind when using conditional statements: 
• The condition portion of the statement can be any numeric or Boolean expression.
• If the condition is a numeric expression, including a tag, zero is treated as false and any 

non-zero value is treated as true. 
• Using a string operand (string Literals, string properties, string tags, or the result of a String 

Operation) as the condition of a conditional statement is not supported. 
• All parts of a conditional statement are required. 
• The value if true and value if false portions of the conditional statement can be any valid 

expression, including another conditional statement. 

Example: Conditional 
statements in expressions 

tag1 & tag2 returns 1 (binary 0000 0000 0000 
0001)
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Function Description Example: If tag1 = 5 and tag2 = 7, then: 

IIF, Iif, iif Evaluates with the same rules as numeric operands. If the 
condition evaluates to 0 (false), the second value is used. 
If the condition evaluates to non-zero (true), the first 
value is used.  
Use this format: IIF(condition, value 
if true, value if false)

IIF ( tag1 > tag2, tag1, tag2) returns 7 (the value of tag2) because tag1 is not 
greater than tag2

?: The following requirements are specific to the ?: 
statement:  
• The conditional operator is right-associative. 

Therefore, a ? b : c ? d : e is evaluated
as a ? b : (c ? d : e). 

• The segments of a conditional operation must be 
surrounded by white space or parentheses. 

• A new line counts as white space. 
Use this format: condition ? value if
true : value if false 

(tag1 > tag2) ? tag1 : tag2 returns 7 (the value of tag2) because tag1 is not greater 
than tag2

These are the examples of logical operators in expressions. 

Symbol (Function) Description 
&& (Logical AND) Returns a value of 1 if the statements to the right and to the 

left of the operator are both true (non-zero). 

Example: If tag1 = 5 and tag2 =7, then:
(tag1 < tag2) && (tag1 == 5) returns a 1 because both 
statements are non-zero (true)
tag1 && tag2 returns a 1 because both tag1 and tag2 are 
non-zero (true)

ll (Logical OR) Returns a value of 1 if either the statement to the left or to the 
right of the operator is true (non-zero). 

(tag1 > tag2) ll  (tag1 == 5)returns a value of 1 because tag1 
== 5 is true

! (Logical NOT) Inverts the Boolean value of an expression. Returns true if the 
expression is false and returns false if the expression is true. 
If the expression (a>b) evaluates to true, then !(a>b) evaluates 
to false. 

!(tag1 < tag2)
The expression tag1 < tag2 evaluates to true and 
returns a value of 1, but the NOT operator reverses the 
logical value, and 0 is returned. 

These are the examples of math functions in expressions. 

Description Example 
ABS, Abs, or abs Returns the absolute value of the expression. ABS(-1.23)returns 1.23. 

ABS(1.23)returns 1.23.
ARCCOS, arccos, ACOS, or acos Returns the arc cosine of the expression in radians. ACOS(-1.0)returns 3.14159. 
ARCSIN, arcsin, ASIN, or asin Returns the arc sine of the expression in radians. ARCSIN(1)returns 1.570796. 

ARCTAN, arctan, ATAN, or atan Returns the arc tan of the expression in radians. ATAN(-45.01)returns -1.54858. 

COS, Cos, or cos Returns the cosine of the expression in radians. COS(14.78)returns -0.599465. 
LOG, Log, or log Returns the natural log of the expression. LOG(2) returns 0.69314718 

LOG10, Log10, or log10 Returns the base-10 log of the parameter. LOG10(100)returns 2. 

SIN, Sin, or sin Returns the sine of the expression in radians. SIN(45.175643)returns 0.929607.
SQRT, Sqrt, or sqrt Returns the square root of an expression. SQRT(144)returns 12. 

Example: Math functions in 
expressions 

Function
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TAN, Tan, or tan Returns the tangent of the expression in radians. TAN(1)returns 1.5574077246549023. 

TRUNC, Trunc, or trunc Returns the value of the parameter with any digits to the 
right of the decimal point removed. 

TRUNC(10.8282)returns 10. 

POW, pow Returns the result of raising the first value to the power of 
the second value. All values are converted to 
double-precision floating point first, and then the operation 
is performed. 

POW(10,3)returns 1000. 

These are the examples of numeric literals in expressions. 
Name Description Example 
Integers Numbers 0-9 specified in base-10 format. Leading zeros are not allowed. 0 

is allowed, 01 is not allowed. 
123 

Floating point Numbers that begin with zero or more base-10 digits, then the period 
character as decimal separator, followed by one or more base-10 digits. 
Leading zeros are not allowed to the left of the decimal point, unless it is 
just a single zero immediately preceding the decimal point. Examples: 1.23 
.23 0.23 

1.23, .23, and 123.45 

Exponential Numbers that begin with an integer or floating point number, followed by 
the character 'e' (or 'E') and an integer. A negation operator '-' is allowed 
before the exponent; other operators are not.  

6.02e23 means 6.02 * 1023 
1.66e-27 means 1.66 * 10-27 

These are the examples of numeric operators in expressions. 

IMPORTANT • Using strings in numeric operations is not recommended. The exception is the + 
operator, which is used for string concatenation. 

• Using LINT tags in expressions, write commands, or increment commands is not 
recommended. This is because the values may lose resolution as a result of 
performing the expression calculations. 

• Ensure that any tag value you use as a divisor cannot at some point have a value of 
zero. Expressions that attempt to divide a number by zero produce an error at 
runtime. 

Symbol (Operation) Description 
+ (Addition) Returns the sum of the values. SINT, INT, DINT, LINT, and REAL 

tags can be used in any order. All values are converted to 
double-precision floating point first, and then the operation is 
performed. If any operand is a string, it is concatenated.  

Example: If tag1 = 5 and tag2 = 7, then:
tag1 + tag2 returns a value of 12
MyDINT + "SomeString" returns a value of  5SomeString, 
if MyDINT = 5

- (Subtraction) Returns the difference of the two values. SINT, INT, DINT, LINT, 
and REAL tags can be used in any order. All values are 
converted to double-precision floating point first, and then 
the operation is performed.  

tag1 - tag2 returns a value of -2

- (Negation) Inverts the sign of the operand, making a positive number into 
a negative number or a negative number into a positive 
number.  

-tag2 returns -7

* (Multiplication) Returns the product of two values. SINT, INT, DINT, LINT, and 
REAL tags can be used in any order. All values are converted to 
double-precision floating point first, and then the operation is 
performed.   

tag1 * tag2 returns a value of 35

Example: Numeric 
operators in expressions 
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/ (Division) Returns the quotient of the two values. SINT, INT, DINT, LINT, 
and REAL tags can be used in any order. All values are 
converted to double-precision floating point first, and then 
the operation is performed.  

tag1 / tag2 returns a value og 0.71

% (Modulus) Returns the remainder of one number divided by another. 
SINT, INT, DINT, LINT, and REAL tags can be used in any order. 
All values are converted to double-precision floating point 
first, and then the operation is performed.  

tag1 % tag2 returns a value of 5

These are the examples of property names in expressions. 

IMPORTANT Avoid setting up circular references using graphic element property bindings because 
this can result in unpredictable values or a runtime error. 
An example of a circular reference would be having three elements on the screen such 
that, for example, Element1.Opacity is bound to Element2.Opacity, Element2.Opacity is 
bound to Element3.Opacity, and Element3.Opacity is bound to Element1.Opacity. 

Name Description Example 
Property name Property names refer to components of the current application. This differs 

from tags, which refer to data items in a controller.  
The graphic elements must all be on the same screen, popup, or System 
Banner.  
Using an alias property in an expression is not supported. 
Use the syntax: ElementName.PropertyName 
An expression can contain: 
• Bindable properties. 
• Multiple graphic element properties. 
• Graphic element property bindings AND tags AND user-defined properties 

or any combination. 

MyElement.X + MyElement.Y / MyElement.Opacity 

MyElement.X + ::MyController.MyTag + 
MyCustomProperty 

These are the examples of punctuators in expressions. 

Description Example 
( ) Opening and closing parentheses. Use parentheses around 

any subexpression to specify the order of operations. 
Subexpressions inside parentheses are evaluated prior to any 
operators outside the parentheses being applied. 

3 + 2 * 6 returns 15 
(3 + 2) * 6 returns 30 

These are the examples of relational operators in expressions. 

Symbol (Function) Description Example: If tag1 = 5 and tag2 
== (Equal to) Compares the two values and returns a 1 (true) if they are 

equal. Returns a 0 (false) if they are not equal. Performs a 
case-sensitive string comparison. All values are converted to 
double-precision floating point first, and then the operation 
is performed.  

tag1 == tag2 is false, so the expression returns 0

!= (Not equal to) Compares the two values and returns a 1 (true) if they are not 
equal. Returns a 0 (false) if they are equal. All values are 
converted to double-precision floating point first, and then 
the operation is performed. 

tag1 != tag2 is true, so the expression returns 1

< (Less than) Compares two values and returns a 1 (true) if the value on 
the left is smaller than the value on the right. Returns a 0 
(false) if not. All values are converted to double-precision 
floating point first, and then the operation is performed. 

tag1 < tag2 is true, so the expression returns 1 

Example: Punctuators 
in expressions 

Symbol
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> (Greater than) Compares two values and returns a 1 (true) if the value on 
the left is larger than the value on the right. Returns a 0 
(false) if not. All values are converted to double-precision 
floating point first, and then the operation is performed. 

tag1 > tag2 is false, so the expression returns 0 

<= (Less than or equal to) Compares two values and returns a 1 (true) if the value on 
the left is smaller or the same as the value on the right. 
Returns a 0 (false) if not. All values are converted to 
double-precision floating point first, and then the operation 
is performed. 

tag1 <= tag2 is true,so the expression returns 1

>= (Greater than or equal to) Compares two values and returns a 1 (true) if the value on 
the left is larger or the same as the value on the right. 
Returns a 0 (false) if not. All values are converted to 
double-precision floating point first, and then the operation 
is performed. 

tag1 >= tag2 is false, so the expression returns 0

These are the examples of string functions in expressions. 

Description Example 
TOLOWER, ToLower, or tolower Converts any uppercase characters to lower lowercase. 

Converts a numeric to a string containing that number. 
TOLOWER("New York")returns "new york". 
This expression converts a numeric to a string  containing that 
number: 
TOLOWER(32) + TOLOWER(34) returns "3234". 

TOUPPER, ToUpper, or toupper Converts any lowercase characters to uppercase. TOUPPER("hello")returns "HELLO". 

These are the examples of string values in expressions. 

These are the examples of tags in expressions. 

Name Description Example: In a controller named Packing, if tag1 = 5 and 
tag2 = 7, then:

Example: String 
functions in expressions

Example: Tags in 
expressions 

Function

Name Description 
String A string literal begins with a double-quote character and 

ends with a double-quote character. Anything between the 
two double-quotes is part of the string literal. You can use 
strings as operands with the plus (+) operator and with 
relational operators. The + operator joins string operands. 
String tags and string literals behave the same way. 
Keep the following in mind when using string tags with the 
relational operators: 
• All relational operators are case-sensitive. 
• Strings are compared on a character-by-character basis. 
• Individual letters are compared based on their Unicode 

value. This means that a lowercase letter is greater than 
its corresponding uppercase letter. 

• If two strings are different lengths and the characters are 
the same, then the longer string is considered to be 
greater than the shorter string. 

Example: If tag1 = "SOME" and tag2 + "THING", then:
tag1+tag2 returns 
"SOMETHING"
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Tag A tag can stand alone as an expression or be included as 
part of an expression that is made up of other components. 
An expression that is a tag name returns the value of the tag. 
Tags begin with either "::" or "\".  Use the format 
::ControllerName.TagName.
You can type the tag name or open the Tag Browser and 
select a tag. 

::Packing.tag1 returns 5
::Packing.tag1 + 25 returns 30
::Packing.tag1 % ::Packing.tag2 returns 5
::Packing.tag1>::Packing.tag2 returns 0 (false)
(::Packing.tag1<::Packing.tag2) &&(::Packing.tag1==5) returns 1 
(both statements are true)

View Designer converts values that are being transmitted to numeric 
tags in the controllers, such as DIN, SINT, or REAL, into a number based 
on the following rules: 

• If the first character is 0 and the second character is an x, the rest
of the data is treated as a hexadecimal number (base 16).

• If the first character is 0 and the second character is a digit from 0
to 7, the rest of the data is treated as an octal number (base 8).

• If the value contains a decimal point, the value is treated as a
floating point input. Based on the target tag type, the value may be
rounded.

• If the first character is a digit from 1 to 9, the rest of the value is
treated as a base 10 number.

• If value contains the letter e, the characters that follow it are
treated as the exponent (base 10) for the number.

• If the first character is a + or -, it is treated as a sign for the number.
The resulting number is based on the rules described above. For
example, -020 is treated as a negative octal number.

• If the value contains any character except digits (0 to 9), ., +, -, or
e, it is treated as an error.

See also 
Bind a property to a data item on page 508 

System tags are predefined tags that provide information, such as the 
current date and time of the HMI device, or the number of active and 
acknowledged alarms in the runtime application.  

See also 
What are system tags? on page 535 

Bind a property to a data item on page 508 

What is binding? on page 502 

Search for and select a tag 

System tags are predefined tags that provide information, such as the 
current date and time of the HMI device, or the number of active and 
acknowledged alarms in the runtime application. System tags are 
automatically created when you create an HMI project and can be 

How View Designer 
converts values that are 
transmitted to numeric tags 

Bind to system tags 

What are system tags? 
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accessed from the Tag Browser in View Designer. View Designer 
provides several system tags in these categories:  

• Alarms. Includes system tags that provide count, status 
information, and export information about the alarms in the 
runtime application. 

• AutoLogoff. Includes system tags that provide status and 
configuration information about automatically logging off the user. 

• Controller. Includes system tags that provide status information 
about the controllers referenced in the HMI project. 

• DataLogs. Includes system tags that provide status information 
and export information. 

• DateTime. Includes system tags that provide current date and 
time values of the HMI device, and enables you to configure date, 
time, time zone values in the HMI device. 

• Device. Includes system tags that provide information about the 
HMI device, and enables you to configure the name of the HMI 
device and enable downloads and firmware updates to the HMI 
device. 

• Display. Includes system tags that provide information, such as 
the name of the currently displayed screen on the HMI device, and 
enables you to configure display settings such as the brightness 
level of the screen. 

• Enet. Includes system tags that display information such as the 
name or IP address of the Ethernet network, and enables you to 
configure the IP, DNS, MAC address and subnet mask of the 
Ethernet network. 

• EnetLink1 and EnetLink2. Includes system tags that display 
information on the connection status and speed of the Ethernet 
links on the HMI device, and enables you to configure the 
communication channel (Full Duplex) and connection speed. 

• ProjectEvents. Includes system tags that provide the number of 
errors in project events. 

• Security. Includes system tags that provide name and role of the 
currently logged on user. 

• SMTP. Includes system tags that provide configuration for the 
SMTP server. 

• VNC. Displays information about the VNC server.  

See also 
Bind to system tags on page 535 

Settings screen on page 740 

The Alarms system tags display information about the number and 
status of alarms in the runtime application. These have the 
::Local:HMIDevice.Alarms prefix. 

Tag name Type Provides this data Read or Write 

FaultedCount DINT Displays the number of alarms with a fault Read-only 
InAlarmAckCount DINT Displays the number of active alarms that are acknowledged, not including 

shelved and suppressed. 
Read-only 

InAlarmUnackCount DINT Displays the number of alarms that are active, but unacknowledged, 
including shelved and suppressed. 

Read-only 

System tags: Alarms 
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NormalUnackCount DINT Displays the number of alarms that are inactive and unacknowledged, 
including shelved and suppressed. 

Read-only 

UnknownCount DINT Displays the number of unknown alarms that are unable to display on the 
HMI device.  

Read-only 

ExportInProgress BOOL Indicates an active export. Read-only 
CurrentRecordExported DINT Displays the number of exported records.  Read-only 
TotalRecordsToExport DINT Displays the total number of records to export. Read-only 
LastExportTime LINT Displays the time and date of the last attempted export. Read-only 
ExportErrorStatus STRING Displays the error that occurred during the last attempted export. Read-only 

See also 
Bind to system tags on page 535 

Alarms overview on page 563 

AutoLogoff system tags provide status and configuration information 
about the Auto-Logoff function in the runtime application. AutoLogoff 
system tags have the ::Local:HMIDevice.AutoLogoff prefix. 

Tag name Type Provides this data Read or Write 

Enable BOOL Enables automatic logging off. Read-write 
Delay DINT Displays the duration of inactivity before logging off. Read-write 
RemainingTime DINT Displays the remaining time to lapse before logging off. Read-only 

 

The Controller system tags display status information about the 
controllers referenced in the HMI project. These tags are prefaced with 
::Local:HMIDevice.Controller[0]. 

Tag name Type Provides this data Read or Write 

ActiveDataItems DINT Displays the number of active data items that are being read from the 
controller. 

Read-only 

ActivityCounter LINT Displays the number of communication packets received from the 
controller. 

Read-only 

AlarmConnectionCount DINT Displays the number of Alarm CIP connections to the controller. Read-only 
Class1ConnectionCount DINT Displays the number of Class 1 CIP connections to the controller. Read-only 
Class3ConnectionCount DINT Displays the number of Class 3 CIP connections to the controller. Read-only 
ControllerName STRING Displays the name of the controller configured in Logix Designer. Read-only 
Enabled BOOL Indicates the controller is configured in the current runtime application. Read-only 
FailedDataItems DINT Displays the number of active data items that currently could not be read 

from the controller. 
Read-only 

MajorRev DINT Major revision of the controller firmware.  
MinorRev DINT Minor revision of the controller firmware.  
Mode STRING Displays the operating mode of the controller. The modes are Run, 

Program, Fault, Remote Run, and Remote Program. 
Read-only 

OptimizedBlocks DINT Displays the number of optimized data blocks sent between the controller 
and the HMI device. 

Read-only 

Path STRING Displays the communication path to the controller. Read-only 
Present BOOL Indicates if the controller is on the network. Read-only 
RecoverableMajorFaults BOOL Indicates if the controller has detected a recoverable major fault. Read-only 
RecoverableMinorFaults BOOL Indicates if the controller has detected a recoverable minor fault. Read-only 
ReferenceName STRING Displays the name of the controller reference configured in View Designer. Read-only 
RunMode BOOL Indicates if the controller is in run mode. Read-only 

System tags: AutoLogoff 

System tags: Controller 
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Synchronized BOOL Indicates if the data in the controller is synchronized with the data in the 
runtime application. 

Read-only 

SyncState STRING Shows the synchronization status of data between the runtime application 
and the Logix 5000 controller. In the runtime application, one of these 
values displays on the graphic element bound to this system tag: 

Read-only 

UnrecoverableMajorFaults BOOL Indicates that the controller has detected an unrecoverable major fault. Read-only 
UnrecoverableMinorFaults BOOL Indicates that the controller has detected an unrecoverable minor fault. Read-only 

See also 
Bind to system tags on page 535 

View information for configured controllers on page 749 

System tag - Sync state: values on page Error! Bookmark not 
defined. 

The following are the values of the SyncState tag from the Controller 
category: 

System tag - Sync state: values Description 

SYNCHED The data in the runtime application on the HMI device matches the data in 
the Logix 5000 controller. 

NEEDSUPDATING The synchronization service detects new data in the Logix 5000 
controller. 

UPDATING The synchronization service is synchronizing data between the runtime 
application on the HMI device and the Logix 5000 controller. 

INDETERMINATE The synchronization status is unknown. The synchronization service 
cannot communicate with the Logix 5000 controller. 

RESYNCHRONIZING: The synchronization service is re-synchronizing data between the runtime 
application on the HMI device and the Logix 5000 controller.  

SYNCHLOST The synchronization service detects new data in the Logix 5000 controller 
but is unable to synchronize. 

EXTRACTING The synchronization service is extracting data from the Logix 5000 
controller. 

See also 
System tags: Controller on page 537 

DataLogs system tags provide status information and export information 
on the data log in the runtime application. DataLogs system tags have 
the ::Local:HMIDevice.DataLogs prefix. 

Tag name Type Provides this data Read or Write 

ExportInProgress BOOL Indicates an active export. Read-only 
TagsInError BOOL Displays if the tags in the Data Log are in error. Read-only 
CurrentRecordExported DINT Displays the number of exported records.  Read-only 
TotalRecordsToExport DINT Displays the total number of records to export. Read-only 
LastExportTime LINT Displays the time and date of the last attempted export. Read-only 
DataLoggingError STRING Displays an error in the Data Logging service. Read-only 
DataLoggingStatus STRING Displays a message if the Data Logging service is collecting data. Read-only 
ExportErrorStatus STRING Displays the error that occurred during the last attempted export. Read-only 

 

System tags - Controller: 
SyncState values 

System tags: DataLogs 
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The Date and Time system tags display and enable you to configure the 
data and time on the HMI device. These tags are prefaced with 
::Local:HMIDevice.DateTime. 

Tag name Type Provides this data Read or Write 

CurrentValue LINT Displays the current date and time of the HMI device in microseconds. Read-only 
DateConfig STRING Configures the HMI device date. Read/Write 

TimeConfig STRING Configures the HMI device time. Read/Write 
TimeZoneConfig STRING Configures the HMI device time zone. Read/Write 

See also 
Bind to system tags on page 535 

Set the date and time on the HMI device on page 748 

The Device system tags display information about the HMI device. For 
example, the Device.ApplicationName system tag displays the name of 
the runtime application downloaded to the HMI device. These system 
tags also enable you to configure the name of the HMI device and set up 
application downloads and firmware updates to the HMI device. These 
tags are prefaced with ::Local:HMIDevice.Device. 

Tag name Type Provides this data Read or Write 

AmbientTemp DINT Displays the ambient temperature of the HMI device in centigrade. Read-only 

ApplicationName STRING Displays the name of the runtime application downloaded to the HMI 
device. 

Read-only 

AutoLogoffDelay DINT Configures the amount of inactivity time before an operator is 
automatically logged off. 

Read/Write 

AutoLogoffEnable BOOL Enables automatically logging off operators on an HMI device after a 
period of inactivity.  

Read/Write 

AutoLogoffRemaining Time DINT Displays the time remaining in seconds before automatic logoff occurs. Read only 

ControllerCount DINT Displays the number of controllers configured in the runtime application. Read-only 
CPUFrequency DINT Displays the frequency at which the CPU is running (in megahertz). Read-only 
CPUTemperature DINT Displays the temperature of CPU (in centigrade). Read-only 
CPUUtilization DINT Displays the percentage of CPU processing power used in the last second. Read-only 
DLRBroken BOOL Indicates one or more links on the Device Level Ring (DLR) network may be 

broken. 
Read-only 

DLRTopology BOOL Indicates that the network is in a Device Level Ring (DLR) topology. Read-only 
DownloadsEnabled BOOL Enables application downloads and firmware updates to the HMI device. Read/Write 
EnetNetworkCount DINT Indicates the number of Ethernet networks supported by the HMI device. Read-only 
FirmwareMajorRev DINT Displays the major revision of the HMI device firmware. Read-only 
FirmwareMinorRev DINT Displays the minor revision of the HMI device firmware. Read-only 
HardwareMajorRev DINT Displays the major revision of the HMI device hardware. Read-only 
HardwareMinorRev DINT Displays the minor revision of the HMI device hardware. Read-only 
HardwareProductCode DINT Displays the hardware product code of the HMI device.  Read-only 
HardwareProductType DINT Displays the hardware product type of the HMI device. Read-only 
HostName STRING Displays the name of the HMI device on the network. Read-only 
HostNameConfig STRING Configures the name of the HMI device on the network. Read/Write 
LastBootupTime LINT Displays the time at which the HMI device was last booted. Read-only 
LastDownloadTime LINT Displays the time at which HMI project was last downloaded to the HMI 

device. 
Read-only 

System tags: DateTime 

System tags: Device 
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MemoryFree DINT Displays the amount of unused RAM memory in the HMI device (in 
kilobytes). 

Read-only 

MemoryTotal DINT Displays the total amount of RAM memory in the HMI device (in kilobytes). Read-only 
MemoryUsed DINT Displays the amount of used RAM memory in the HMI device (in kilobytes). Read-only 

ProductName STRING Displays the model and catalog number of the HMI device. Read-only 
StorageFree DINT Displays the amount of unused nonvolatile storage in the HMI device (in 

kilobytes). 
Read-only 

StorageTotal DINT Displays the total amount of nonvolatile storage in the HMI device (in 
kilobytes). 

Read-only 

StorageUsed DINT Displays the amount of used nonvolatile storage in the HMI device (in 
kilobytes). 

Read-only 

TotalOnTime DINT Displays the total power on time of the HMI device in hours. Read-only 

See also 
Bind to system tags on page 535 

Change the name of the HMI device on page 746 

Disable downloads to the HMI device on page 746 

The Display system tags show information, such as the vertical 
resolution of the HMI device screen, or the blink rate that can be used to 
bind the Visible property of graphic elements to make the graphic 
elements appear as if they are blinking. These system tags also enable 
you to configure display settings, such as the brightness level of the HMI 
device screen. These tags are prefaced with 
::Local:HMIDevice.Display. 

Tag name Type Provides this data Read or Write 

BacklightIntensity DINT Configures the backlight brightness level when the screen saver is not 
active. 

Read/Write 

BlinkFast BOOL Shows the tag value alternating between set for 1 second and cleared for 
0.5 seconds. 

Read-only 

BlinkMedium BOOL Shows the tag value alternating between set for 2 seconds and cleared for 
1 second. 

Read-only 

BlinkSlow BOOL Shows the tag value alternating between set for 3 seconds and cleared for 
1.5 seconds. 

Read-only 

BlueAdjustment DINT Specifies the intensity of the blue color channel. The allowed values are 
between 0 and 100. The default value is 50 (no adjustment). 

Read/Write 

GreenAdjustment DINT Specifies the intensity of the green color channel. The allowed values are 
between 0 and 100. The default value is 50 (no adjustment). 

Read/Write 

CurrentScreenName STRING Displays the name of the screen currently displayed on the HMI device. Read-only 
RedAdjustment DINT Specifies the intensity of the red color channel. The allowed values are 

between 0 and 100. The default value is 50 (no adjustment). 
Read/Write 

ResolutionHorizontal DINT Displays the horizontal resolution of the HMI device display (in pixels). Read-only 
ResolutionVertical DINT Displays the vertical resolution of the HMI device display (in pixels). Read-only 
ScreenSaverEnabled BOOL Enables screen saver display when the HMI device is inactive for longer 

than the set screen saver time. 
Read/Write 

ScreenSaverImagePath STRING Displays the file name of the image (JPEG) displayed when the screen 
saver is active. 

Read/Write 

ScreenSaverIntensity DINT Specifies the backlight brightness level when the screen saver is active. Read/Write 
ScreenSaverTime DINT Specifies the time (in minutes) before the screen saver appears. Read/Write 

System tags: Display 
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See also 
Bind to system tags on page 535 

Adjust screen brightness on page 744 

Configure the screen saver on page 744 

Calibrate the touch screen on page 745 

The Enet system tags display information, such as the MAC address and 
subnet mask, of the Ethernet network. These system tags also enable 
you to configure the IP, DNS, MAC address, and the subnet mask of the 
Ethernet network. These tags are prefaced with 
::Local:HMIDevice.Enet[n]. 

Tag name Type Provides this data Read or Write 

DHCPConfig BOOL Configures DHCP for the Ethernet network and automatically assigns IP 
addresses using DNS. 

Read/Write 

Domain STRING Displays the domain name of the Ethernet network. Read-only 
DuplicateIP BOOL Indicates a duplicate IP address exists. Read-only 
Gateway STRING Displays the IP address of the Ethernet network gateway. Read-only 
GatewayConfig STRING Configures the IP address of the Ethernet network gateway. Read/Write 
IPAddress STRING Displays the IP address of the Ethernet network. Read-only 
IPAddressConfig STRING Configures the IP address of the Ethernet network. Read/Write 
MACAddress STRING Displays the MAC address of the Ethernet network. Read-only 
PrimaryDNS STRING Displays the primary DNS address of the Ethernet network. Read-only 
PrimaryDNSConfig STRING Configures the primary DNS address of the Ethernet network. Read/Write 
SecondaryDNS STRING Displays the secondary DNS address of the Ethernet network. Read-only 
SecondaryDNSConfig STRING Configures the secondary DNS address of the Ethernet network. Read/Write 
SubnetMask STRING Displays the subnet mask of the Ethernet network. Read-only 
SubnetMaskConfig STRING Configures the subnet mask of the Ethernet network. Read/Write 
TertiaryDNS STRING Displays the tertiary DNS address of the Ethernet network. Read-only 
TertiaryDNSConfig STRING Configures the tertiary DNS address of the Ethernet network. Read/Write 

See also 
Bind to system tags on page 535 

Assign an IP and DNS address on page 741 

View network diagnostics on page 743 

The EnetLink1 and EnetLink2 system tags provide status information 
about the two ethernet links on the HMI device. They also enable you to 
configure the speed and communication channel of the ethernet links. 
These tags are prefaced with ::Local:HMIDevice. 

Tag name Type Provides this data Read or Write 

EnetLink1.Disconnected BOOL Indicates if the Ethernet Link of the HMI device is connected to any 
powered network device. 

Read-only 

EnetLink1.FullDuplex BOOL Indicates if Full Duplex is configured for the Ethernet link. Read-only 
EnetLink1.FullDuplexConfig BOOL Configures Full Duplex for the Ethernet link. Read/Write 

EnetLink1.LinkEnabled BOOL Enables the Ethernet link. Read/Write 
EnetLink1.LinkSpeed STRING Indicates the speed of the Ethernet link. Read-only 
EnetLink1.LinkSpeedConfig STRING Configures the speed of the Ethernet link. The options are Auto, 100, or 10. Read/Write 

System tags: Enet 

System tags: EnetLink1 and 
EnetLink2 
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EnetLink2.Disconnected BOOL Indicates if the Ethernet Link of the HMI device is connected to any 
powered network device. 

Read-only 

EnetLink2.FullDuplex BOOL Indicates if Full Duplex is configured for the Ethernet link. Read-only 
EnetLink2.FullDuplexConfig BOOL Configures Full Duplex for the Ethernet link. Read/Write 
EnetLink2.LinkEnabled BOOL Enables the Ethernet link. Read/Write 
EnetLink2.LinkSpeed STRING Indicates the speed of the Ethernet link. Read-only 
EnetLink2.LinkSpeedConfig STRING Configures the speed of the Ethernet link. The options are Auto, 100, or 10. Read/Write 

See also 
Bind to system tags on page 535 

Configure Ethernet ports on page 742 

ProjectEvents system tags provide the number of errors in project 
events. ProjectEvents system tags have the 
::Local:HMIDevice.ProjectEvents prefix. 

Tag name Type Provides this data Read or Write 

ErrorCount DINT Displays the number of errors in Project Events. Read-only 
 

The Security system tags display information about the logged on user. 
These tags are prefaced with ::Local:HMIDevice.Security. 

Tag name Type Provides this data Read or Write 

CurrentUserName STRING Displays the name of the logged on user. Read-only 
CurrentUserRole STRING Displays the role of the logged on user. Read-only 

See also 
Bind to system tags on page 535 

Security overview on page 698 

The SMTP system tags display information about the email server to 
which the HMI device connects to send emails. For example, the 
HMIDevice.ServerName system tag displays the name of the email 
server. These system tags enable configuring the port of the server and 
enable secure communication to the email server. These tags are 
prefaced with ::Local:HMIDevice.SMTP. 

Tag name Type Provides this data Read or Write 

AuthenticatonMethod DINT Enables password authentication for sending emails to the 
email server. 

Read/Write 

ServerName STRING The name of the email server. Read/Write 
IsPasswordSet BOOL Indicates a user password is entered for sending emails to the 

email server. 
Read-only 

Port DINT The port number of the email server. Read/Write 

SenderName STRING The name of the sender that appears in emails.  Read/Write 
UserName STRING The email address of the user sending emails.    Read/Write 
UseSSL BOOL Enables secure communication to the email server. Read/Write 

System tags: ProjectEvents 

System tags: Security 

System tags: SMTP 
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See also 
Add an event command to send an email on page 465 

Configure the SMTP server to send email on page 747 

The VNC system tags display information about the VNC server. These 
tags are prefaced with ::Local:HMIDevice.VNCServer. 

Tag name Type Provides this data Read or Write 

AccessMode STRING Configures the state and access mode of the VNC Server.  
Valid values include: 
• "off" = The VNC is disabled 
• "view" = Read-only access 
• "full" = The VNC is configured for full remote control 
Tips:  
• Valid values are not case sensitive. 
• When VNCServer.AccessMode changes states between 

Full and Read, the VNC Server stops and restarts with 
the selected state. VNC connections automatically 
close, and disconnect any remotely connected users. 

Full/Read 

ActiveConnections DINT Displays the number of remote clients currently 
connected to the VNC Server. 
• 0 = No active connections 
• n = Number of remote users connected to the VNC 

server. 

Read-only 

See also 
Bind to system tags on page 535 

What are system tags? on page 535 

Search for and select a tag 

Tag verification checks that tags in a View Designer project are present 
in the referenced controller projects. Verification for tags occurs 
automatically upon downloading a project. Verify tags any time during 
project development. For example, verify tags after defining controllers 
for a project. The Errors window shows the results. 

An invalid tag reference shows as a warning. The project may work when 
downloading the project to an HMI device after fixing the tags in the 
controllers using Logix Designer. Resolving warnings is not required to 
download a project.      

To verify controller tags 
1. On the Menu bar, select Project > Verify Project. The Verify 

Project dialog box opens and verification begins.  
2. If there are invalid tags listed in the Errors window, double-click an 

entry to navigate to the source of the warning in the project, and 
make the necessary changes.  

3. Repeat the verification process until there are no warnings listed in 
the Errors window. The list updates each time the verification 
process runs for the project. 

System tags: VNC 

Verify controller tags 
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Tips:  
• Alternate methods of navigating to the source of a warning in the Errors window: 
• Click the hyperlink in the Location box. 
• Select a warning in the list and press Enter. 

• Alternate methods of starting the verification process: 
• In the Project Explorer, right-click the project name and click Verify Project. 
• On the Standard toolbar, click Verify Project . 

See also 
Verify Project dialog box on page 544 

Errors window on page 522 

How do I open the Verify Project dialog box? 

On the Menu bar, click PROJECT > Verify Project. 
 

The Verify Project dialog box displays the progress of the project 
verification process.  

Project verification verifies: 

• The syntax of all expressions contained in the View Designer 
project 

• The validity of parameters passed from one item to another and 
required error messages 

• The existence of elements and properties referenced in an 
expression 

• The existence of tags in the View Designer project in the 
referenced controller projects 

• That Add-On Graphics do not contain direct bindings to controller 
tags or system tags 

• That property bindings in the definition of an Add-On Graphic are 
formatted as ElementName.PropertyName 

• That aliased properties of graphic elements in the definition of an 
Add-On Graphic are not bound  

• That all tags in the data logs are valid.  
The Errors window displays the invalid tags and expressions detected 
by the project verification process.   

See also 
Verify controller tags on page 543 

Errors window on page 522 

How do I open the Errors window? 

The Errors window opens automatically to display the invalid tags or 
expressions detected during project verification. 

To open the Errors window manually, on the Menu bar, click VIEW > 
Errors. 

Verify Project dialog box 

Errors window 
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The Errors window displays the results of project verification. It opens 
when View Designer detects invalid tags or expressions. Downloading a 
project automatically verifies that project. Verify a project at any time 
during project development. For example, verify a project if a controller is 
defined for the project.  

Project verification verifies: 

• The syntax of all expressions contained in the View Designer 
project 

• The validity of parameters passed from one item to another and 
required error messages 

• The existence of elements and properties referenced in an 
expression 

• The existence of tags in the View Designer project in the 
referenced controller projects 

• That Add-On Graphics do not contain direct bindings to controller 
tags or system tags 

• That property bindings in the definition of an Add-On Graphic are 
formatted as ElementName.PropertyName 

• That aliased properties of graphic elements in the definition of an 
Add-On Graphic are not bound  

• That all tags in the data logs are valid.  
Use the Errors window to: 

• View the errors and warnings detected during project verification. 
• Navigate to the source of the error or warning so that you can 

resolve the problem. 
• Sort the results to group them by severity level, description, or 

location in the project. 

See also 
Verify a project on page 718 

Verify Project dialog box on page 544 

Sort the contents of the Errors window on page 718 

Download a runtime application to an HMI device on page 710 
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Chapter 17 

Find and replace 

Use the Find and Replace utility to find and replace alphanumeric 
characters, words, phrases, project events, and numbers on a screen, 
screen shortcut, popup, or graphic element within a project.  

The Find Results window displays the results of a Find and Replace 
command. 

See also 
Find text in a project on page 547 

Find and replace text in a project on page 548 

Find Results window on page 549 

Find and Replace dialog box on page 547 

How do I open the Find and Replace dialog box? 

Open a project and on the Menu bar, click EDIT > Find and Replace. 

Use the Find and Replace dialog box to search for properties with 
values that match specified criteria. Search an entire project or limit the 
search to a screen within the project. The Find and Replace dialog box 
searches the content of a project, including screens, popups, data logs, 
Add-On Graphic types, and the graphic elements that are part of the 
screens, popups, and Add-On Graphic definitions. 

See also 
Find and replace text in a project on page 548 

Find text in a project on page 547 

Use Find All on the Find and Replace dialog box to search and display 
all properties that match specified criteria. Find text and content such as 
graphic elements on a screen, popup, data log, or in the definition of an 
Add-On Graphic.  

To find text in a project 
1. Press CTRL+F. 
2. In the Find what box, type the text to find, or select the text of a 

previous search.  

 
Tip: Search text can contain alphanumeric characters and can be full words, fragments of a 
word, or a single letter or number. 

3. In the Find where box, select the scope of the search:  

Find and replace 

Find and Replace dialog box 

Find text in a project 



Chapter 17  Find and replace 
 

548 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

• Entire Project. Search the entire open project.  
• Current Tab. Search the open screen, popup, data log, or 

definition of an Add-On Graphic.   
• Selected Graphic Elements. Search the selected graphic 

elements on the open screen, popup, or definition of an Add-On 
Graphic. 

4. (optional) Narrow the search scope by selecting an option:  
• Match case 
• Find whole words only 

5. Select Find All. Results appear in the Find Results window.  
IMPORTANT To stop the Find and Replace operation, under Close, select Stop Find. The Stop 

Find button appears briefly and only during the current find and replace 
operation. Closing the Find and Replace dialog does not stop the find and 
replace operation. It continues to run in the background. 

 

 
Tips:  
• To navigate to an entry in the Find Results window, double-click the entry.  
• To replace a single instance of an entry, navigate to the entry and manually make the necessary 

changes. 

See also 
Find and Replace dialog box on page 547 

Find and replace text in a project on page 548 

Use the Replace All option in the Find and Replace dialog box to 
replace all values for all of the properties that match search criteria 
simultaneously.  

To find and replace values in a project 
1. Press CTRL+F. The Find and Replace dialog box opens.  
2. In the Find what box, type the text to find or select the text of a 

previous search. 

 
Tip: Search text can contain alphanumeric characters and can contain full words, fragments 
of a word, or a single letter or number. 

3. In the Replace With box, type the replacement text, or select the 
text of a previous replace operation. 

4. In the Find where box, select the scope of the search. 
• Entire Project. Search the entire open project. 
• Current Tab. Search the open screen, popup, data log, or 

definition of an Add-On Graphic. 
• Selected Graphic Elements. Search the selected graphic 

elements on the open screen, popup, or definition of an Add-On 
Graphic. 

5. (optional) Narrow the search scope by selecting the following:  
• Match case 
• Find whole words only 

6. Select Replace All.  

Find and replace text in a 
project 
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IMPORTANT • Invalid replace operations appear in the Replaced section of the Find Results 
window. These changes are not made. Replace operations are considered 
invalid when the item is Read-Only or a tag value is invalid. 

• The Find All operation may report more occurrences of an alias property 
value found than the Replace All operation reports. This is because the Find 
All operation reports all instances of an alias property value it finds. The 
Replace All operation reports and replaces only the first instance of the alias 
property value it finds. Other instances are linked to the first instance and 
are updated automatically within the software, not by the Replace All 
operation.  

• The Replace All operation may report more occurrences replaced than the 
Find All operation reports found. This is because the Find All operation 
reports the number of places, such as an expression or State Table, in which 
it finds the item. The Replace All operation reports the number of instances 
of the item it replaces. Therefore, a Find and Replace operation that finds 
multiples of the same string in an expression reports one location found, but 
multiple instances replaced. 

• To stop the Find and Replace operation, under Close, select Stop Find. The 
Stop Find button appears briefly and only during the current find and replace 
operation. Closing the Find and Replace dialog does not stop the find and 
replace operation. It continues to run in the background. 

 

 
Tips:  
• To navigate to an entry in the Find Results window, double-click the entry.  
• To replace a single instance of an entry, navigate to the entry and manually make the necessary 

changes. 

See also 
Find and Replace dialog box on page 547 

Find text in a project on page 547 

How do I open the Find Results window? 

The Find Results window opens automatically to display the items 
found as a result of a Find and Replace command. 

On the Menu bar, click VIEW > Find Results. 

The Find Results window displays the results of a Find and Replace 
command.  

Use the Find Results window to: 

• View the found property values and graphic elements. 
• Navigate to the source of an item on the list. 
• Sort the search results to group them by Container, Element, 

Property, or Found. 

See also 
Find and Replace dialog box on page 547 

Find text in a project on page 547 

Find and replace text in a project on page 548 

 

Find Results window 
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Chapter 18 

Project Navigation 

The Navigation menu provides a means of navigating to and opening 
shortcuts on the HMI device.  

Arrange items in the Navigation Menu folder, and any subfolders within 
it, to depict the order of items to appear in the Navigation menu on the 
HMI device. Determine which item is the Home screen, which icon 
represents an item in the Navigation menu, which items to omit from 
navigation, and which user roles can access items.  

See also 
Navigation menu on page 551 

Navigation menu contents on page 553 

Specify a Home screen on page 553 

Move an item in the Project Explorer on page 556 

Create a folder on page 558 

How do I open the Navigation menu? 

On the HMI device, tap Navigation  in the System Banner at the top 
of the screen, press Alt/n on an external keyboard, or press the physical 
Navigation button on the HMI device.   

Use the Navigation menu to navigate to and open shortcuts to screens 
created in Studio 5000 View Designer. The Navigation menu on the HMI 
device displays the contents of the Navigation Menu folder in the 
Project Explorer of Studio 5000 View Designer. The Navigation menu 
appears at the bottom or left side of the HMI device screen.  

The menu items displayed in the Navigation menu depend on the 
security access granted to the security role assigned to the logged on 
user. Security is set in Studio 5000 View Designer. If assigned the 
Operator role, the Navigation menu displays only the items to which the 
Operator has access.  

See also 
Navigation menu contents on page 553 

Specify a Home screen on page 553 

Select an icon for a shortcut in the Navigation menu on page 554 

Omit an item from the Navigation menu on page 555 

Project navigation 

Navigation menu 
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Restrict access to an item on the HMI device on page 354 

In station projects, you have an option to choose between a bottom or 
side menu. By default, the projects are uploaded with the side menu. 

To set the side navigation menu: 
1. In the Project Explorer, select Navigation Menu. 
2. In the Properties section, select the Navigation Menu section. 
3. From the Menu Location drop-down menu, select SideMenu or 

BottomMenu. 
4. (optional for the side menu) In the Width section, set the width of 

the menu. 

 
Tip: You can select the values between 150 and 500 to set the width of the side menu. 

 

Folders and shortcuts in the Navigation Menu folder of the Project 
Explorer to which you are granted security access appear in the 
Navigation Menu on the HMI device. 

 

The side navigation menu shows up to four levels of nesting. 

 
 

Item  Description 

 
Finds the strings in the whole Navigation menu, regardless of the level of nesting and highlights it yellow. 

 
The navigation menu contains the Home screen for the project and folders and shortcuts placed at the root level of the 
Navigation Menu folder in the Project Explorer. By default, the main menu includes Alarm Summary, Alarm Manager, Alarm 
History, Automatic Diagnostics, Auto Dial History, and Settings items. These items appear in the Predefined Screens folder 
of the Project Explorer. These items open tables to view and manage alarms, and a screen to configure settings for the 
HMI device. 

 

Change the position of the 
navigation menu 

Side navigation menu 
contents 
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Tip: You can use your keyboard to navigate through the menu: 
• Tab - activates the menu keyboard navigation. 
• Arrows - enable moving up and down through the menu. 
• Enter - opens the screen, selected from the menu. 
After opening a selected screen, the navigation menu item is marked blue. 

 

Folders and shortcuts in the Navigation Menu folder of the Project 
Explorer to which you are granted security access appear in the 
Navigation menu on the HMI device.      

 
 

Item Description 

 
The main row of the Navigation menu contains the Home screen for the project and any folders and shortcuts placed at the 
root level of the Navigation Menu folder in the Project Explorer. Tapping the Home item opens the initial screen on the HMI 
device when the HMI device restarts. By default, this main row also includes AlarmSummary, AlarmManager, Alarm History and 
Settings items. These items appear in the Predefined Screens folder of the Project Explorer. These items open tables to view 
and manage alarms, and a screen to configure settings for the HMI device.  

 
Tapping a folder shows the contents of the folder in an upper row of the Navigation menu. The upper row appears blank for 
empty folders. The open item is highlighted. To open an item, tap it, or on an external keyboard, tab to the item  and press 
Enter. Carets appear around an item to which you tab. An upper row does not appear when a folder in the bottom row of the 
Navigation menu is not selected.        

 
The back arrow in an upper row of the Navigation menu navigates back one folder at a time.  

 
The current folder path, in the form of breadcrumbs, appears in an upper row of the Navigation menu.  

 
The number of items in the Navigation menu depends on the width of the HMI device. When there are more items than can 
appear in the Navigation menu, arrows appear at either end of the Navigation menu. The Next arrow pointing right appears 
after the number of menu items surpasses the width of the Navigation menu. The Previous arrow pointing left appears when 
the first page of items is no longer in view. Use the arrows to scroll to additional pages of menu items.  

 
Dots indicate which page of the Navigation menu items is open. The dot for the open page is highlighted.   

See also 
Navigation menu on page 732 

Specify a Home screen on page 553 

Select an icon for a shortcut in the Navigation menu on page 554 

Omit an item from the Navigation menu on page 555 

Restrict access to an item on the HMI device on page 354 

The Home screen is the initial screen that opens when the HMI device 
starts. For a new project, the default Home screen is Screen_001. The 
Home icon  in the Navigation Menu folder of the Project Explorer 

Bottom navigation menu 
contents 

Specify a Home screen 
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indicates that Screen_001 is the Home screen. Screen_001 in the 
Navigation Menu folder of the Project Explorer is a shortcut based on 
Screen_001 in the User-Defined Screens folder. Designate any 
shortcut in the Navigation Menu folder as the Home screen of the 
project.  

To specify a Home screen 
1. In the Project Explorer, expand the Navigation Menu folder. 
2. Right-click the shortcut and select Set as Home. The Home icon 

 appears next to the shortcut. This is the Home screen that 
opens automatically when the HMI device restarts.  

See also 
Select an icon for a shortcut in the Navigation menu on page 554 

Omit an item from the Navigation menu 

Move an item in the Project Explorer on page 556 

Rename a screen on page 351 

Project Explorer on page 95 

An icon represents each screen in the Navigation menu on the HMI 
device. The default icon is the standard Screen icon supplied by Studio 
5000 View Designer. Change the icon to a snapshot of the screen or use 
another graphic as the icon. 

To select an icon for a shortcut in the Navigation menu 
1. In the Project Explorer, expand the Navigation Menu folder and 

select the shortcut.   
The properties for the shortcut appear on the Properties tab. 
Opening the shortcut also displays the properties of the shortcut. 
For example, open a screen and click a blank portion of the 
screen. The properties of the open screen appear on the 
Properties tab.  

2. In the Properties window, expand the Navigation Menu 
category.  

3. In the Icon list, select an option: 
• Screen Snapshot. Displays a snapshot of the shortcut's 

defining screen in the Navigation menu. In the Screen 
Snapshot box, select the graphic of the snapshot. Select the 
snapshot only if you have the screen open in View Designer. If 
the screen is not open, "Screen is not loaded" appears. To 
update the picture in the Navigation menu after changing the 
appearance of the screen, select the snapshot graphic again.   

• Predefined icon. Displays an icon for the screen in the 
Navigation menu. In the Predefined Icons box, select the 
desired icon. 

Select an icon for a 
shortcut in the Navigation 
menu 
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• Folder. Displays an image from the hard drive for the screen in 
the Navigation menu. In the Folder box, select the desired 
image. To select an image in a location other than the default 
Pictures folder, browse to select the desired image. Select any 
.BMP, .JPG, .GIF, .PNG, or .TIF image from the hard drive for 
an item in the Navigation menu. An .SVG image is not a valid 
format for the icon of a shortcut. 
The selected image appears in the Icon box. 

 
Tips:  
• All items in the Navigation menu on the HMI device appear white when unselected and blue when 

selected. To view both the selected and unselected versions of the icon to appear in the Navigation 
menu, in the Properties window, mouse over the selection in the Icon box. 

• The icon assigned to an item from the Properties tab appears in the Navigation menu on the HMI 
device.  

• The icon that appears next to the item in the Project Explorer indicates the type of item -- screen, 
shortcut, folder, or the Home screen. 

See also 
Omit an item from the Navigation menu on page 555 

Restrict access to an item on the HMI device on page 354 

Specify a Home screen on page 553 

Move a graphic element on page 142 

Create a folder on page 558 

By default, all shortcuts and folders in the Navigation Menu folder of the 
Project Explorer are represented as items in the Navigation menu on 
the HMI device. Omit any item from the Navigation menu on the HMI 
device by deleting it from the Navigation Menu folder. Do this if a screen 
in a project depicts a line in your system that is no longer in production. 
Deleting the shortcut designated as the Home screen for a project is not 
allowed. You cannot delete the shortcut with the Home icon from the 
Navigation Menu folder.  

Prerequisites 
• To delete a shortcut designated as the Home screen of the 

project, designate a new shortcut as the Home screen.  

To omit an item from the Navigation menu 
1. In the Project Explorer, expand the Navigation Menu folder. 
2. Right-click the shortcut and select Delete. The shortcut no longer 

appears in the Navigation Menu folder or the Navigation menu 
on the HMI device. 

 
Tip: Have an item not appear in the Navigation menu by restricting access to the item. Only 
items to which the assigned user role has access appear in the Navigation menu on the HMI 
device.  

Omit an item from the 
Navigation menu 
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See also 
Specify a Home screen on page 553 

Project Explorer on page 95 

Restrict access to an item on the HMI device on page 354 

Move a graphic element on page 142 

Delete a folder on page 560 

Arrange the contents in the Project Explorer to depict your system. The 
order of items, including any subfolders, in the Navigation Menu folder 
is depicted in the Navigation menu on the HMI device. Arrange the 
items in the Navigation Menu folder of the Project Explorer in the 
hierarchy to show in the Navigation menu on the HMI device. 

To move an item in the Project Explorer 
1. Select  or  before the folder to expand or collapse its

contents.
2. Drag and drop the item to the desired location. The name of the

item being moved and a description of its new location appears as
you drag. Dragging an item above or below another item displays
a line that indicates the new location. Releasing the mouse button
moves the item to its new location.

Dragging an item to a location where it cannot exist displays a
sign. Releasing the mouse button leaves the item in its original
location.

Tips: 
• Drag a screen, but not a popup, from the Predefined Screens folder to the Navigation Menu folder. 
• Move a screen or popup between subfolders within the User-Defined Screens folder. 
• Drag a screen from the User-Defined Screens folder to the Navigation Menu folder to create a 

shortcut. 
• Moving an item out of the Navigation Menu folder is not allowed. Move an item to another folder in 

the Navigation Menu folder. 
• Right-click an item to cut, copy, or paste the item. Pasting a screen in the Navigation Menu folder 

to create a shortcut is not allowed. If pasting a cut item in the new location is not allowed, paste 
the item in its original location to not remove the item from the project. 

See also 
Project Explorer on page 95 

Select an icon for a shortcut in the Navigation menu on page 554 

Specify a Home screen on page 553 

Omit an item from the Navigation menu on page 555 

By default, all users on HMI devices have access to these items in the 
Project Explorer:  

• Shortcuts in the Navigation Menu folder.
• Screens and popups in the User-Defined Screens and

Predefined Screens folders. Navigate to these items on the HMI

Move an item in the Project 
Explorer 

Restrict access to an item 
on the HMI device 
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device by triggering an event with a navigation command. Users 
who do not have the Administrator role have read-only access to 
the Settings screen and related popups in the Predefined 
Screens folder.  

Change the access level for any item in the Project Explorer. Restrict 
access to an item for any role except the Administrator role. The 
Administrator role always has Inherit access, and the role inherits Full 
Access from the root folder. 

To restrict access to an item on the HMI device 
1. In the Project Explorer, expand the folder that contains the item 

to restrict access:   
• To select a screen or popup, expand the User-Defined 

Screens folder or the Predefined Screens folder.  
• To select a shortcut, expand the Navigation Menu folder.   

2. Select or double-click the item. The Properties window for the 
item opens. 

3. In the Properties window for the selected item, expand the 
Security category. 

4. After each role (Engineer, Maintenance, Operator, Restricted, and 
Supervisor), select the access option for each role. 
• Inherit. Grants the same access assigned to the parent folder. 
• Full Access. Grants access to open and interacts with the item, 

and shows the item in the Navigation menu on the HMI device. 
• Read Only. Grants access to open the item, but denies 

interaction with it. The item appears in the Navigation menu on 
the HMI device. Users assigned to a role with read-only access 
can still interact with the Navigation menu and alarm tables. 
For example, a user with read-only access to an alarm table can 
still perform read operations, such as viewing alarms and 
details, selecting alarms and conditions, filtering alarms, and 
pausing alarms. The user cannot perform write commands that 
change the state of an alarm.   

• No Access. Denies access to open or interact with the item. 
The item does not appear in the Navigation menu on the HMI 
device. 

5. To set individual role access to a shortcut, independent of the 
access to the screen on which the shortcut is based: 

a. Select the shortcut.  

b. In the Properties window of the selected shortcut, clear the 
UseScreenSecurity check box. 

c. Select the access level for each role.  

Do not base the security for a shortcut on its defining screen if 
the user has access to some shortcuts of a screen but should 
not have access to a particular shortcut.    
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See also 
Restrict access to the HMI device on page 695 

Restrict access to a graphic element on page 695 

Project Explorer on page 95 

Properties tab on page 494 

Security overview on page 698 

A folder in the Project Explorer organizes the contents of a project. 
Folders and subfolders and their contents in the Navigation Menu folder 
appear in the Navigation menu on the HMI device. 

Create, copy, delete, and rename folders to organize contents in the 
Project Explorer.   

See also 
Create a folder on page 558 

Copy a folder on page 428 

Delete a folder on page 560 

Rename a folder on page 561 

Organize the contents of a project by creating folders in the Project 
Explorer. For example, create a folder in the User-Defined Screens 
folder to contain screens, popups, and other folders. Create a folder in 
the Navigation Menu folder to contain shortcuts and other folders. 
Create up to three levels of folders, including two levels of subfolders. 
The structure in the Navigation Menu folder of the Project Explorer is 
depicted in the Navigation menu on the HMI device. 

To create a folder 
1. In the Project Explorer, right-click the Navigation Menu folder. 

You can create a folder in the User-Defined Screens folder or a 
subfolder of the folder.   

2. Click New Folder. A new folder appears at the bottom of the folder 
with the default name Folder_001 or increment number. Folders at 
the same level must have unique names.   

See also 
Rename a folder on page 561 

Delete a folder on page 560 

Restrict access to an item on the HMI device on page 354 

Omit an item from the Navigation menu 

Project Explorer on page 95 

Create a folder for Project 
Explorer contents 

Create a folder 
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Copy a folder in the Project Explorer to reuse it within or across View 
Designer projects. Copying a folder also copies all of its subfolders. 

IMPORTANT Copying a folder to a different project does not copy screens or popups that contain 
user-defined properties. 

Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy a folder  
1. In the source project, in the Project Explorer, right-click the folder  

to copy and select Copy. 
2. In the target folder, right-click the location to paste the folder and 

select Paste. 

 
Tips:  
• Copying a root-level folder (for example, Navigation Menu, User-Defined Screens, and Predefined 

Screens) is not allowed. 
• Copying a folder in the Navigation menu between projects is not allowed. 
• Copying and pasting subfolders between root-level folders.   
• Paste folders three levels deep. The new folder appears at the same level as the item on which the 

folder is pasted. Folders at the same level must have unique names. Pasting a folder with the same 
name as an existing folder appends a number to the name of the pasted folder. For example, 
FolderName_002. 

• Only content from the Predefined Screens folder can be copied into a Predefined Screens folder. 
Copying the System Banner is not allowed. 

• Cut a folder by selecting Cut instead of Copy. 
• Copying a folder copies any children of the folder as well as any localized data associated with the 

folder.  

See also 
Create a folder on page 558 

Delete a folder on page 560 

Rename a folder on page 561 

Reuse content on page 359 

Creating a shortcut or folder assigns a unique name, such as 
Shortcut_001 or Folder_001, to the item. Use a caption instead of a 
system-defined name to accommodate more text, line breaks, spaces, 
and non-ASCII characters. Create a caption to display a more 
meaningful description for a screen or a folder on the HMI device. 

Copy a folder 

Create a caption for a 
shortcut or folder in the 
Navigation menu 
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To create a caption for a shortcut or folder in the Navigation menu 
1. In the Project Explorer, expand the Navigation Menu folder. 
2. Select the shortcut or folder. The properties of the shortcut or 

folder appear on the Properties tab. 
3. In the Properties tab, expand the Navigation Menu category.  
4. In the Caption box, type the caption text. The entire caption 

appears on the title bar of the Navigation menu upon selecting 
the folder. Only the first two lines appear in the Navigation menu 
below the icon. 

IMPORTANT Keep the following in mind when creating a caption: 
• By default, changing the name of the shortcut or folder, either by using the 

Rename command or by typing a new name into Name box on the Properties 
window, changes the name in the Caption box.  

• View Designer shows the text in the Caption box on the HMI device. Changing 
the name of the shortcut or folder in the Navigation Menu folder or in the 
Name box on the Properties window does not change the name on the HMI 
device.  

• The caption is not reflected in the Navigation Menu folder or the Name box on 
the Properties window. 

See also 
Navigation menu on page 551 

Delete a folder to remove it from the Project Explorer. When you delete 
a folder from the Navigation Menu folder or User-Defined Screens 
folder, the content of the folder is removed. Deleting the root level project 
is not allowed. Deleting certain folders is also not allowed:  

• Folder that contains the Home screen 
• Folder that contains screens with existing shortcuts 
• Default folder -- Navigation Menu, User-Defined Screens, or 

Predefined Screens. 

To delete a folder 
1. In the Project Explorer, expand the Navigation Menu folder or 

the User-Defined Screens folder. 
2. Right-click the folder and select Delete. The folder no longer 

appears in the Project Explorer. If you delete the folder from the 
Navigation Menu folder, the folder no longer appears on the 
Navigation menu on the HMI device. 

See also 
Create a project on page 53 

Create a folder on page 558 

Rename a folder on page 561 

Move an item in the Project Explorer 

Project Explorer on page 95 

Delete a folder 
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Creating a folder gives the folder unique name such as Folder_001 or 
Folder_002. Change the name of the folder to reflect the purpose or 
contents of the folder. A folder in the Navigation Menu folder of the 
Project Explorer appears as a folder item in the Navigation menu on 
the HMI device.  

To rename a folder 
1. In the Project Explorer, expand the Navigation Menu folder or 

the User-Defined Screens folder. 
2. Right-click the folder and click Rename. 
3. Type a new name for the folder and press Enter. 

 
Tips:  
• Folder names at the same level must have unique names. 
• Renaming the Navigation Menu, User-Defined Screens, or Predefined Screens root level folders is 

not allowed. 
• Create a caption for the folder to display more than eight characters and spaces. 

See also 
Create a caption for a shortcut or folder in the Navigation menu on 
page 559 

Create a folder on page 558 

Delete a folder on page 560 

Move an item in the Project Explorer 

Project Explorer on page 95 

 

Rename a folder 
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Chapter 19 

Display alarms 

Display alarms to monitor and manage control system alarms. View 
Designer provides a default Alarm Summary screen, Alarm Manager 
screen, and Alarm History screen. Change an alarm screen or add an 
alarm table graphic element to a new screen to create your own alarm 
screen.  

View Designer requires no configuration or tag binding to display alarms 
on the HMI device. Use Logix Designer to program alarm detection 
instructions and create tag-based alarms in a Logix 5000 controller.   

Each controller in a View Designer project displays a combination of up to 
4,000 tag-based or 1000 instruction-based alarms. The 5380, 5480 and 
5580 Logix families of controllers support tag-based alarms. A View 
Designer project with four controllers displays a maximum of 16,000 
tag-based alarms.  

See also 
Alarms overview on page 563 

Create an alarm screen on page 565 

What is the Alarm Summary? on page 99 

What is the Alarm Manager? on page 99 

Alarm table filters on page 612 

By default, new projects contain an AlarmSummary screen with an 
Alarm Summary table, an AlarmManager screen with an Alarm 
Manager table, and an AlarmHistory screen with an Alarm History 
Viewer table. These screens exist in the Predefined Screens folder of 
the Project Explorer. New projects have shortcuts to the predefined 
AlarmSummary, AlarmManager, and AlarmHistory screens. 

You can also create your own alarm screens by using Alarm Summary, 
Alarm Manager, and Alarm History Viewer graphic elements from the 
Toolbox. Rockwell Automation recommends having no more than 4000 
tag-based alarms, or 1000 instruction-based alarms in a Logix controller. 
The 5380, 5480 and 5580 Logix families of controllers support tag-based 
alarms.  

Alarms defined in your Logix controllers automatically appear on the 
Alarm Summary, Alarm Manager, and Alarm History. No additional 
configuration in View Designer is needed. 

Rockwell Automation recommends that an alarm table be the only 
graphic element on a screen.  

Available operations depend on the alarm screen:  

Alarms overview 
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Operation  Alarm 
Summary  

Alarm 
Manager  

Alarm 
History 

Acknowledge alarms    

Disable alarms    
Enable alarms    
Filter alarms by Event Time    
Pause the display of incoming alarms    
Reset a digital alarm    

Reset alarm counts    
Select alarms    
Shelve individual alarm conditions    
Shelve entire alarm (all conditions)    
Sort and filter alarms    
View alarms    
View alarm condition details    
View alarm quality    
Unshelve alarm conditions    
Unshelve alarms    

In View Designer, alarm tables contain sample data representative of the 
data an alarm table may display. The sample data inserts data of average 
length into the default columns in the alarm table. Sample data appears 
for the purposes of configuring the alarm table. Use sample data to 
determine and change column width, font, font size, and padding around 
content. Changes to font and padding properties do not appear in the 
Details pane of an alarm table.  

Alarm tables scale to the size of the target HMI device. When 
downloading a project to a different size HMI device, default alarm tables 
may not provide the best results on the new HMI device screen.  

Large alarm tables are for HMI device screens ten-inch or larger, while 
medium alarm tables are for six-inch to nine-inch HMI device screens. 
The size of an alarm table does not affect the number of alarms the table 
displays. When downloading a project to an HMI of a different size, 
Rockwell Automation recommends replacing the alarm tables in the 
project. Open the existing alarm screens, delete the existing alarm tables 
from the screens, and add the appropriate sized alarm tables for the new 
HMI device. 

 
Tip: You can use Logix extended tag properties in alarm messages. If you include an extended 
property that is not defined in Studio 5000 Logix Designeras a part of alarm message, non-existing 
extended property content will be replaced by three asterisks (***). 

 

See also 
Alarm Summary on page 571 

Alarm Manager on page 586 

Create an alarm screen on page 565 
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Alarms have good or bad quality. Good quality indicates the alarm is 
functioning correctly. Bad quality indicates that there is a problem with 
the alarm.  

The current state may not be detected or accurate. Bad quality occurs 
from abnormal scenarios, such as a disconnect in the network, or a 
controller in Program mode, or by configuration issues. If the alarm has 
bad quality due to an abnormal scenario, all conditions of the alarm fault 
because evaluating or detecting the alarm is not possible. If the alarm 
has a configuration error, such as invalid limit, only the affected 
conditions have bad quality. The unaffected conditions have good quality 
and continue to function. View alarms with bad quality in an Alarm 
Manager only. Quality details appear in the Details pane of the Alarm 
Manager table.  

For configuration-related faults, level conditions (HIHI, HI, LO, and 
LOLO) and ROC conditions (ROC Positive and ROC Negative) are 
evaluated independently. With the exception of severity, only affected 
conditions are faulted. If the ROC Positive limit is invalid, only the ROC 
Positive condition faults. The ROC Negative condition and all level 
conditions maintain good quality. If the ROC_Period is invalid, both the 
ROC Positive and ROC Negative conditions fault, but all level conditions 
maintain good quality. Level condition limits have dependent 
relationships. The HIHI limit must be greater than HI, HI must be greater 
than LO, and LO must be greater than LOLO. If any level limit is out of 
range, all levels fault. 

In an Alarm Manager, inhibit states from all alarm conditions roll up for a 
single alarm. If the level or ROC conditions fault for an alarm, the alarm is 
of bad quality. The conditions that are of good quality continue to function 
normally and appear in an Alarm Summary when they are in the 
interesting state. When the alarm is of bad quality due to an abnormal 
scenario, all conditions for the alarm are of bad quality. 

See also 
Resolve alarm faults on page 567 

Details pane for an Alarm Summary on page 580 

Details pane for an Alarm Manager on page 592 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

Create an alarm screen to view alarms configured in Logix Designer on 
the HMI device. Alarm screens receive alarm data automatically. There 
is no configuration or tag binding required in View Designer. 

By default, an AlarmSummary screen and an AlarmManager screen 
exist in the Predefined Screens folder of each Project Explorer for 
each project. When creating a custom alarm screen, for best results, 
make the alarm table the only graphic element on the screen. Do not add 
an alarm table to a popup or the System Banner. Add an alarm table to a 
screen only.   

Alarm faults and alarm 
quality 

Create an alarm screen 
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Prerequisites 
• Configure ALMA and ALMD alarm instructions in Logix Designer 

or add tag-based alarms in a Logix Designer. The 5380, 5480 and 
5580 Logix families of controllers support tag-based alarms.  

To create an alarm screen 
• In the Alarms category of the Toolbox, drag and drop the 

appropriately sized alarm table graphic element onto the screen.  

 
Tips:  
• Change the appearance of an alarm table through the Properties pane.  
• To ensure an alarm table contains readable content and has a row height tall enough to tap on the 

HMI device, change the font size and padding of the table cells. For an Alarm Summary, change the 
number and content of columns. Create filters to return alarms meeting filter criteria on the 
AlarmSummary and AlarmManager screens on the HMI device. 

• Open a specific screen on the HMI device for the alarm selected on the Alarm Summary or Alarm 
Manager by either adding an event that writes the value of the SelectedAlarmName property to the 
tag in a controller and then use the value when creating a project event, or create a Navigation 
event that uses a state table. 

See also 
Disable touch and key input for an alarm table on page 566 

Change the opacity of an alarm table on page 569 

Specify the default sort order of alarm table contents on page 570 

Configure alarm table rows for readability and touch on page 568 

Resize a graphic element on page 144 

Disable touch and key input for an alarm table to prevent interaction with 
the table on the HMI device. For example, disable touch and key input for 
an alarm table to prevent selecting alarms on the HMI device.    

To disable touch and key input for an alarm table 
1. On the screen, select the alarm table. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance node.  
4. Clear Enabled.  

See also 
Specify the visibility of an alarm table on page 570 

Disable a button on an Alarm Summary table on page 573 

Disable a button on an Alarm Manager table on page 586 

Configure alarm table rows for readability and touch on page 568 

Specify the visibility of an alarm table on page 570 

Disable touch and key input 
for an alarm table 
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Alarm faults and their qualities appear in the Quality Details row in the 
Details pane of an alarm table. An alarm indicates good quality if all 
alarm conditions (High High, High, Low, Low Low, ROC Positive, ROC 
Negative, Deviation High, Deviation Low, TRIP, and TRIP_L) are in good 
quality.  

Fault Cause of Fault Quality 
Indicator 

Affected 
alarm 
conditions  

No fault N/A Good All 

Status from controller not 
read yet 

Abnormal Conditions Bad All 

Instruct fault only (specific 
fault not set) 

Configuration  Bad All 

In faulted Configuration  Bad All 
Severity invalid Configuration Bad All 

Alarm limits invalid Configuration Bad High High, High, 
Low, Low Low 

Deadband invalid Configuration Bad High High, High, 
Low, Low Low 

ROC Positive limit invalid Configuration Bad ROC Positive 

ROC Negative limit invalid Configuration Bad ROC Negative 
ROC period invalid Configuration Bad ROC Positive, 

ROC Negative 
Old Logix firmware Abnormal Conditions Bad All 
Controller in Program mode Abnormal Conditions Bad All 
Major controller program 
fault (recoverable) 

Abnormal Conditions Bad All 

Communication failure (last 
value known) 

Abnormal Conditions Bad All 

Communication failure (no 
last value known) 

Abnormal Conditions Bad All 

Connection with controller 
lost 

Abnormal Conditions Bad All 

Major controller program 
fault (unrecoverable) 

Abnormal Conditions Bad All 

Failed to subscribe to 
controller 

Abnormal Conditions Bad All 

Detected hazard of 
overwriting old notifications 
in Alarm Log 

Abnormal Conditions Bad All 

Arithmetic overflow Abnormal Conditions Bad All 

See also 
Resolve alarm faults on page 567 

Details pane for an Alarm Summary on page 580 

Details pane for an Alarm Manager on page 592 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

Alarm faults occur for two reasons: 

• Condition related issues. Abnormal conditions are events that 

Alarm faults and quality 
indicators 

Resolve alarm faults 



Chapter 19  Display alarms 
 

568 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

occur outside normal operations. A disconnected network, power 
cycles to a controller or HMI device, project downloads to the 
controller, major faults on a controller, or a controller in Program 
mode can all cause alarm faults.   

• Configuration related issues. Alarms exist in Logix Designer 
with enforced valid configuration values. Configuration errors 
generally occur when alarm parameters change by writing to a 
member of the alarm. An alarm with a member named 
AlarmName.Severity  indicates the severity of its associated 
alarm condition. Changing the severity tag member to an invalid 
value shows the alarm as bad quality until the severity changes to 
a valid value. 

To resolve alarm faults 
1. Open the Alarm Manager screen.  
2. In the Inhibit State column, select an alarm row that has a Bad 

Quality icon . 
3. To view the details of the alarm, select Details . A Details 

pane with additional information for the last selected alarm 
appears.  

 
Tip: The Details pane opens at the bottom of an alarm table for ten-inch or larger HMI devices 
and replaces the alarm table on six-inch to nine-inch HMI devices. 

4. In the Details pane review the reasons for a faulted alarm or 
condition in the last row -- Quality Details. 

5. Resolve the alarm fault.  
• Correct the condition causing the alarm fault.   
• Correct the configuration causing the alarm fault.   

See also 
Open an alarm screen on page 800 

Alarm faults and alarm quality on page 565 

Details pane for an Alarm Summary on page 580 

Details pane for an Alarm Manager on page 592 

Configure properties to affect the displayed font, font size, and row 
padding (the distance between cell contents and cell borders) in a table. 
Font size affects row height. Padding is required to make tapping rows 
feasible on an HMI device. Using a small font size and no padding makes 
it difficult to tap a single row in an alarm table on the HMI device. Row 
height is determined by the FontSize property value and twice the value 
of the RowPadding property. The default combined FontSize (nine 
points) and RowPadding (14 pixels) property values result in an 
approximate row height of one-third inch. There is no minimum or 
maximum font size or row padding. To be able to tap single alarm rows 
on the HMI device, specify reasonable font sizes and row padding for a 
table. 

Configure alarm table rows 
for readability and touch 
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To configure alarm table rows for readability and touch 
1. On the screen, select the alarm table. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance node.  
4. To make sure the alarm table is readable and allows enough room 

within rows for touch, configure the properties: 
• FontName. Select a font.  
• FontSize. Enter a font size readable for users on the HMI 

device.  
• RowPadding. Enter the distance, in pixels, between cell 

content and the cell border.  
The selected FontName, FontSize, and RowPadding property 
values are reflected in the sample data of the alarm table. The 
changes are also reflected in the alarm table on the HMI device. 
Changes to these properties are not reflected in the Details 
pane of an alarm table. 

See also 
Specify the visibility of an alarm table on page 570 

Disable a button on an Alarm Summary table on page 573 

Disable a button on an Alarm Manager table on page 586 

Specify the default sort order of alarm table contents on page 570 

Specify the visibility of an alarm table on page 570 

Change the opacity level of an alarm table to make it more or less 
transparent. 

To change the opacity of an alarm table 
1. On the screen, select the alarm table. 
2. In the Properties window, click the Properties tab. 
3. Expand the Appearance category. 
4. In the Opacity box, enter a percentage. 0 is fully transparent and 

100 is fully opaque.  

See also  
Specify the visibility of an alarm table on page 570 

Move a graphic element on page 142 

Specify the default sort order of alarm table contents on page 570 

Disable touch and key input for an alarm table on page 566 

Resize a graphic element on page 144 

Change the opacity of an 
alarm table 
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Specify if an alarm table is always visible on the HMI device screen. Bind 
the visibility of an alarm table to a tag value to display the alarm table only 
when the specified tag value is true. For example, bind visibility to a tag 
to indicate there is a problem in the system. If binding the alarm table to a 
tag value, the table appears on the HMI device screen only when the tag 
is true.  

To specify the visibility of an alarm table 
1. On the screen, select the alarm table. 
2. In the Properties window, click the Properties tab. 
3. Expand the Appearance category. 
4. In the Visible box, select an option: 

• Visible (selected) 
• Not visible (cleared)  

See also 
Disable touch and key input for an alarm table on page 566 

Change the opacity of an alarm table on page 569 

Specify the default sort order of alarm table contents on page 570 

Move a graphic element on page 142 

Configure alarm table rows for readability and touch on page 568 

Determine how alarm table content is initially sorted on the HMI device 
screen. Specify which columns to sort and in which order, and whether to 
sort the contents of a column in ascending or descending order.      

To specify the default sort order of alarm table contents 
1. On the screen, select the alarm table. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category. In the SortOrder box, enter 

columns and their order: 
• A valid column number, colon, and a D for descending or A for 

ascending. For example, 1:D,2:D provides a primary sort of 
Column 1 in descending order, and a secondary sort of Column 
2 in descending order. You can enter a value for each column in 
the table. 

See also 
Disable touch and key input for an alarm table on page 566 

Change the opacity of an alarm table on page 569 

Specify the visibility of an alarm table on page 570 

Move a graphic element on page 142 

Specify the visibility of an 
alarm table 

Specify the default sort 
order of alarm table 
contents 
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Resize a graphic element on page 144 

The Alarm Summary lists the alarms in a project or configured HMI 
device. Each project contains an AlarmSummary screen by default. 
Create an additional screen with an Alarm Summary graphic element to 
create a custom Alarm Summary screen.  

The Alarm Summary lists alarms in the project that have the status of 
either In Alarm or Unacknowledged. View the Details pane of the 
Alarm Summary screen to see data such as Current Value, In Alarm 
Time, Out of Alarm Time, and tag values for the last selected alarm. 

 
Tip: For tag-based alarms, the Alarm Summary only displays alarms with Use and evaluate alarm 
selected in Logix Designer. 

Use the Alarm Summary on an HMI device to:  

• Acknowledge alarms. 
• Disable alarms. 
• Shelve alarms. 
• Sort alarms. 
• Filter alarms. 
• Pause alarms. 
• Reset latched alarms. 
• View alarm details. 

See also 
Alarm Summary contents for a large HMI device screen on page 
577 

Alarm Summary contents for a medium HMI device screen on 
page 575 

Alarm Summary table columns on page 579 

Details pane for an Alarm Summary on page 580 

What is the Alarm Summary? on page 99 

New columns in an Alarm Summary table appear at the right side of the 
table with sample data inserted into each column. Sample data is 
representative of the length of data anticipated for a column. Use sample 
data to determine the column width to use for a column. 

To add a column to an Alarm Summary table 
1. On the screen, select the Alarm Summary table. 
2. In the Properties window, select the Columns tab.  
3. Select Add Column.  
4. Select the data to display in the column. The selected column 

appears in the new card heading. Change the width of a column to 
display the data.     

Alarm Summary 

Add a column to an Alarm 
Summary table 
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See also 
Change the width of a column in an Alarm Summary table on page 
572 

Change the order of columns in an Alarm Summary table on page 
572 

Alarm Summary table columns on page 579 

Columns tab on page 580 

Change the width of a column in an Alarm Summary table if the data in 
the column is wider than the current width of the column. Use the sample 
data inserted in a column to determine the column width. The sample 
data is representative of the length of data anticipated for a column.   

To change the width of a column in an Alarm Summary table 
1. On the screen, select the Alarm Summary table. 
2. In the Properties window, select the Columns tab.  
3. In the column card, click Show/Hide  to expand the column 

card. The selected column card is outlined in blue.  
4. In the Width field at the bottom of the column card, enter the 

value:  
• A positive number, representing the width of the column, in 

pixels 
Changes to column width are saved automatically. The last 
column added fills the remaining space in the row. If the total width 
of all columns exceeds the width of the table, a horizontal scroll 
bar appears at the bottom of the table.  

 
Tip: When resizing a column in an Alarm Summary table, leave some space between the text 
of the column heading and the border of the column. If the text of a column heading appears 
at the column border, the text of the column heading may appear clipped in the Alarm 
Summary table on the HMI device 

See also 
Change the order of columns in an Alarm Summary table on page 
572 

Delete a column from an Alarm Summary table on page 573 

Alarm Summary table columns on page 579 

Columns tab on page 580 

Resize a graphic element on page 144 

The columns of the alarm table on the predefined AlarmSummary 
screen appear in a default order. This screen is located in the 
Predefined Screens folder of the Project Explorer.  

Change the width of a 
column in an Alarm 
Summary table 

Change the order of 
columns in an Alarm 
Summary table 
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To change the order of columns in an Alarm Summary table 
1. On the screen, select the Alarm Summary table. 
2. In the Properties window, select the Columns tab.  
3. Point to the column card heading and select Move column up  

or Move column down  to move the column higher (to the left) 
or lower (to the right) in the table. Changes made to the order of 
columns are depicted in the Alarm Summary table on the screen. 

See also 
Add a column to an Alarm Summary table on page 571 

Change the width of a column in an Alarm Summary table on page 
572 

Alarm Summary table columns on page 579 

Columns tab on page 580 

Delete a column to remove it from the Alarm Summary table. This 
removes unwanted data from the table and provides room for other data 
that may be more pertinent. You cannot change the data a column 
shows. By default, Column 2 in predefined Alarm Summary table of a 
project shows the alarm state. You cannot change column data from 
Alarm State to Comments or any other data.  

To delete a column from an Alarm Summary table 
1. On the screen, select the Alarm Summary table. 
2. In the Properties window, select the Columns tab.  
3. In the heading of the column card, select Delete .  Deleted 

columns are removed from the Alarm Summary table on the 
screen. 

See also 
Add a column to an Alarm Summary table on page 571 

Change the order of columns in an Alarm Summary table on page 
572 

Alarm Summary table columns on page 579 

Columns tab on page 580 

Prevent users from performing certain operations on an Alarm Summary 
table on the HMI device. To do this, disable the appropriate button on the 
alarm table. For example, to prevent disabling alarms, disable Disable 

 for the Alarm Summary table.  

On the HMI device, a disabled button has diagonal hash marks across it. 

Tapping the button displays an Error icon  . Tap the Error icon to 
open an Error list that describes the button as disabled.  

Delete a column from an 
Alarm Summary table 

Disable a button on an 
Alarm Summary table 
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To disable a button on an Alarm Summary table 
1. On the screen, select the Alarm Summary table. 
2. In the Properties window, select the Properties tab. 
3. Expand the General node. 
4. Clear the check box to disable the button and the associated 

operation on the HMI device:  
• AcknowledgeEnabled. Clear this check box to disable 

Acknowledge  on the selected alarm table. This prevents 
indicating awareness of the alarm and changing the alarm state 
from unacknowledged to acknowledged. 

• DisableEnabled. Clear this check box to disable Disable  
on the selected alarm table. This prevents stopping an alarm 
condition from being evaluated, effectively turning off the alarm. 

• ResetLatchedEnabled. Clear this check box to disable Reset 
Latched Selected  on the selected alarm table. This 
prevents resetting a latched alarm that is latched in the In Alarm 
state.  

• ShelveEnabled. Clear this check box to disable Shelve  on 
the selected alarm table. This prevents stopping the notification 
of new state changes for an alarm or alarm condition.  

See also 
Specify the visibility of an alarm table on page 570 

Disable touch and key input for an alarm table on page 566 

Change the width of a column in an Alarm Summary table on page 
572 

Specify which users have access to perform certain operations on an 
Alarm Summary table. To enable all users to perform an operation, set 
security access to Full Access. For example, determine that all users 
have access to acknowledge an alarm. In this case, set the access for 
Acknowledge  to Full Access. Alternatively, determine that security 
access for acknowledging an alarm depends on the role of user. In this 
case, set the Access properties to Inherit. Inherited access levels include 
Full Access, Read-Only access, or No Access.  

To specify access to operations performed on an Alarm Summary 
table  

1. On the screen, select the Alarm Summary table. 
2. In the Properties window, select the Properties tab. 
3. Expand the Security node. 
4. Locate the property for the button to set access:     

• AcknowledgeAccess. Set access for Acknowledge  on 
the selected Alarm Summary table. This button changes the 
alarm state from unacknowledged to acknowledged. 

Specify access to 
operations performed on an 
Alarm Summary table 
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• DisableAccess. Set access to Disable  on the selected 
Alarm Summary table. This button stops an alarm condition 
from being evaluated, effectively turning off the alarm. 

• ResetLatchedAccess. Set access to Reset Latched  on 
the selected Alarm Summary table. This button resets a latched 
alarm in the In Alarm state.  

• ShelveAccess. Set access to Shelve  on the selected 
Alarm Summary table. This button prevents the notification of 
new state changes for an alarm or alarm condition.  

5. In the field, select an option:  
• Full Access. Specify that all users have access to the button.  
• Inherit. Specify that the button inherits access from the screen.       

Inherited access for a user role can be Full Access, Read-Only 
access, or No Access. If a button inherits Read-Only access, 
hash marks appear across the button on the HMI device. An 
error appears if the user presses the button. If a button inherits 
No Access from the screen, the user does not have access to 
the screen containing the alarm table. In this case, the screen 
does not appear in the Navigation menu. 

See also 
Specify the visibility of an alarm table on page 570 

Disable touch and key input for an alarm table on page 566 

Change the width of a column in an Alarm Summary table on page 
572 

Change the order of columns in an Alarm Summary table on page 
572 

Alarm Summary contents 
for a medium HMI device 
screen 
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This screen depicts the default appearance and content of the Alarm 
Summary Medium alarm table on the predefined AlarmSummary 
screen for a six-inch to nine-inch HMI device. This screen is in the 
Predefined Screens folder of the Project Explorer. The table exists for 
medium, six-inch to nine-inch HMI device screens. Create an Alarm 
Summary Medium table with customized appearance and content, or 
change the Alarm Summary Medium table on the predefined 
AlarmSummary screen. 

 
Item Description 

 
The list of In Alarm and/or Unacknowledged alarms in the project. Each row contains a single alarm condition. 
Depending on configuration, the Alarm Name can appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.TagName. For tag-based alarms, the Alarm Name appears as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag is not located inside a program, this part is 
omitted and the Alarm Name appears as ::ControllerName.TagName.@Alarms.AlarmName. 

 
 

Buttons to perform operations on alarms in the Alarm Summary table: 

 
Alarm Manager opens the Alarm Manager screen. The Alarm Manager lists all alarms configured in the system 
and their current states. Therefore, the Alarm Manager shows alarms not shown in the Alarm Summary, and 
provides additional tasks for alarms.  

 
Details hides or shows the Details pane, which contains the details of the last selected alarm. The Details pane 
appears on the bottom half of large alarm tables and replaces the list of alarms in medium alarm tables. If no 
alarm is selected, the Details pane is empty.   

 
Select All selects all of the alarms in the alarm table, including those not displayed on the current page of 
alarms. 

 
Deselect All deselects all alarms in the alarm table, including those not displayed on the current page of 
alarms. 

 
Select Page selects all of the alarms displayed on the current page of alarms. 

 
Reset Latched Alarms sets the selected latched state of the alarm to Normal if the input of the alarm has 
returned to normal. Resetting a latched alarm acknowledges the alarm, if it is not acknowledged.   

 
Pause stops updates to the Alarm Summary table for 10 seconds or until performing another operation on the 
table. While updates to the Alarm Summary table are paused, alarms in the controllers are still evaluated. 
When the table is no longer paused, any changes to alarm states are reflected in the table and updates 
resume.     

 
Disable stops the alarm condition from being evaluated. In effect, this turns off the selected alarm. This 
button disables the entire alarm. It is not possible to disable an individual alarm condition.   
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Shelve prevents the notification of new state changes to the selected alarm if the alarm is acknowledged. 
Updates to the alarm do not appear. The alarm remains shelved until the shelve duration from the controller 
expires automatically or until manually unshelving the alarm. Updates to the alarm then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected alarm conditions. Shelving an alarm in 
the Alarm Manager table shelves all of the conditions of the alarm. From the condition list in the Details pane 
of the Alarm Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. Change the Shelve Duration and 
Max Shelve Duration values using Logix Designer in order to propagate updated values to the Alarm Summary 
and Alarm Manager clients. Use the previous Shelve Duration and Max Shelve Duration values when shelving 
alarms in Studio 5000 alarm tables. 

 
Acknowledge indicates that you are aware of the alarm. This button changes the state of the alarm from 
unacknowledged to acknowledged. 

 
Help opens the Help popup. This popup displays a legend of icons for In Alarm/Unacknowledged, 
Normal/Unacknowledged, In Alarm/Acknowledged, and Faulted alarms, and the task each button on an alarm 
table performs.  

 
Filter list. Select a filter on the HMI device to list only the alarms containing the filter value for the indicated column. For 
example, if the filter exists, select the filter Priority:High to show only those alarms with a high priority. Filters are 
configured in View Designer.  

 
The number of Normal/Unacknowledged, In Alarm/Unacknowledged, In Alarm/Acknowledged, and Faulted alarms in the 
alarm table. 

See also 
Alarm Summary table columns on page 579 

Add a column to an Alarm Summary table on page 571 

Delete a column from an Alarm Summary table on page 573 

Disable a button on an Alarm Summary table on page 573 

The Alarm Summary Large alarm table appears on the predefined 
AlarmSummary screen for a ten-inch or larger HMI device. This screen 
is in the Predefined Screens folder of the Project Explorer. The table 
exists for large, ten-inch or larger HMI device screens. Create an Alarm 
Summary Large table with customized appearance and content, or 
change the Alarm Summary Large table on the predefined 
AlarmSummary screen.  

 
Item Description 

Alarm Summary contents 
for a large HMI device 
screen 
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The number of In Alarm/Unacknowledged, In Alarm/Acknowledged, Normal/Unacknowledged, and Faulted alarms.   

 
The list of In Alarm and/or Unacknowledged alarms in the project. Each row contains a single alarm condition. 
Depending on configuration, the Alarm Name can appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.TagName. For tag-based alarms, the Alarm Name appears as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag is not located inside a program, this part is 
omitted and the Alarm Name appears as ::ControllerName.TagName.@Alarms.AlarmName. 

 
The Details pane with additional details for the selected alarm. This pane displays data, such as Current Value, In 
Alarm Time, Out of Alarm Time, and tag values. When selecting multiple alarms, details shown are for the last selected 
alarm. On medium HMI devices, this Details pane replaces the Alarm Summary table. 

 
Filter list. Select a filter on the HMI device to list only the alarms containing the filter value for the indicated column. 
For example, if the filter exists, select the filter Priority:High to show only those alarms with a high priority. Filters are 
configured in View Designer.  

 
Buttons to perform operations on alarms in the Alarm Summary table: 

 
  

Back opens the previously displayed screen. When opening the Alarm Manager screen from the Alarm 
Summary screen, this button reopens the Alarm Summary screen. 

 
Alarm Manager opens the Alarm Manager screen. The Alarm Manager lists all alarms configured in the 
system and their current states. Therefore, the Alarm Manager shows alarms not shown in the Alarm 
Summary, and provides additional tasks for alarms.  

 
Details hides or shows the Details pane, which contains the details of the last selected alarm. The 
Details pane appears on the bottom half of large alarm tables and replaces the list of alarms in 
medium alarm tables. If no alarm is selected, the Details pane is empty.   

 
Select All selects all of the alarms in the alarm table, including those not displayed on the current page 
of alarms. 

 
Deselect All deselects all alarms in the alarm table, including those not displayed on the current page 
of alarms. 

 
Select Page selects all of the alarms displayed on the current page of alarms. 

 
Reset Latched Alarms sets the selected latched state of the alarm to Normal if the input of the alarm 
has returned to normal. Resetting a latched alarm acknowledges the alarm, if it is not acknowledged.   

 
Pause stops updates to the Alarm Summary table for 10 seconds or until performing another operation 
on the table. While updates to the Alarm Summary table are paused, alarms in the controllers are still 
evaluated. When the table is no longer paused, any changes to alarm states are reflected in the table 
and updates resume.     

 
Disable stops the alarm condition from being evaluated. In effect, this turns off the selected alarm. 
This button disables the entire alarm. It is not possible to disable an individual alarm condition.   

 
Shelve prevents the notification of new state changes to the selected alarm if the alarm is 
acknowledged. Updates to the alarm do not appear. The alarm remains shelved until the shelve 
duration from the controller expires automatically or until manually unshelving the alarm. Updates to 
the alarm then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected alarm conditions. Shelving an 
alarm in the Alarm Manager table shelves all of the conditions of the alarm. From the condition list in 
the Details pane of the Alarm Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. Change the Shelve Duration 
and Max Shelve Duration values using Logix Designer in order to propagate updated values to the Alarm 
Summary and Alarm Manager clients. Use the previous Shelve Duration and Max Shelve Duration values 
when shelving alarms in Studio 5000 alarm tables. 

 
Acknowledge indicates that you are aware of the alarm. This button changes the state of the alarm 
from unacknowledged to acknowledged. 

 
Help opens the Help popup. This popup displays a legend of icons for In Alarm/Unacknowledged, 
Normal/Unacknowledged, In Alarm/Acknowledged, and Faulted alarms, and the task each button on an 
alarm table performs.   
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See also 
Alarm Summary table columns on page 579 

Delete a column from an Alarm Summary table on page 573 

Disable a button on an Alarm Summary table on page 573 

On the Alarm Summary Large and Alarm Summary Medium tables, 
alarm data appears in columns. To change an Alarm Summary table or 
when creating an Alarm Summary table, add columns (for example, add 
Severity or a row shown in the Details pane of the alarm table as a 
column in an Alarm Summary table), remove columns, or rearrange 
columns. This table shows the default columns used in the Alarm 
Summary table on the predefined AlarmSummary screen.  

Column   Description Medium Alarm 
Summary 

Large Alarm 
Summary 

! (Priority) The urgency of the event: 

• Low  

• Medium  

• High  

• Urgent  

  

Alarm State The state of the alarm condition:  

• Normal, Unacknowledged  and Urgent  

• In Alarm, Acknowledged  and Urgent   

• In Alarm, Unacknowledged  and Urgent   

  

Inhibit State The value applied to an alarm that inhibits the alarm at some level. 
These states include:  

• Disabled  

• Suppressed  

• Shelved   
If no icon appears for Inhibit State, the alarm is of good quality 
and is not disabled, suppressed, or shelved. 

  

Event Time The time the alarm condition or sub-condition changed to the 
currently displayed state.  

  

Condition Name A name that describes the alarm condition. Condition names vary 
by event category. For example: 
• Analog conditions include DEV_HI, DEV_LO, HIHI, HI, LO, LOLO, 

ROC_POS, and ROC_NEG 
• Level: LO, LOLO, HI, HIHI, ROC_POS, and ROC_NEG 
• Discrete: TRIP, TRIP_L (Latched) 

  

Alarm Name The list of alarms, in all states, for the controllers referenced in the 
View Designer project. Each row contains an alarm and the 
conditions. Depending on configuration, the Alarm Name can 
appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.TagName. For tag-based alarms, 
the Alarm Name appears as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If 
the tag is not located inside a program, this part is omitted and 
the Alarm Name appears as 
::ControllerName.TagName.@Alarms.AlarmName. 

  

Message The message assigned to the alarm in the alarm instruction.   

Alarm Summary table 
columns 
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See also 
Add a column to an Alarm Summary table on page 571 

Change the width of a column in an Alarm Summary table on page 
572 

Change the order of columns in an Alarm Summary table on page 
572 

Delete a column from an Alarm Summary table on page 573 

How do I open the Columns tab? 

Select the table on the screen and in the Properties pane, click the 
Columns tab. 

A table graphic element displays columns of data.  

Use the Columns tab to: 

• Add or delete columns. 
• Change the order of columns. 
• Change the width of columns. 

See also 
Add a column to an Alarm Summary table on page 571 

Change the width of a column in an Alarm Summary table on page 
572 

Change the order of columns in an Alarm Summary table on page 
572 

Delete a column from an Alarm Summary table on page 573 

In a medium Alarm Summary table intended for HMI devices with 
seven-inch to nine-inch screens, the Details pane replaces the list of 
alarms in the table. In a large Alarm Summary table exists for HMI 
devices with ten-inch or larger screens, the Details pane opens at 
bottom of the table. 

Columns tab 

Details pane for an Alarm 
Summary 
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Item Description 

 
The Details pane with additional details for the selected alarm. This pane displays data, 
such as Current Value, In Alarm Time, Out of Alarm Time, and tag values. When multiple 
alarms are selected, details display for the last selected alarm.  

See also 
Details pane rows on page 581 

Alarm Summary for a large HMI device on page 779 

Alarm Summary for a medium HMI device on page 777 

Alarm faults and alarm quality on page 565 

Selecting Details  on an alarm table opens the Details pane in the 
lower half of: 

• Large Alarm Summary table 
• Large Alarm Manager table 
• Large Alarm History table 

Details pane rows 
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The Details pane replaces the list of alarms in medium alarm tables. The 
Details pane shows details for the selected alarm condition of a selected 
alarm. Condition details display the selected alarm condition in the Alarm 
Manager table. The contents of the Details pane appears in rows. 

Row Description 

Priority The urgency of the alarm condition: 

• Low  

• Medium  

• High  

• Urgent  
Severity The numeric value mapped to the assigned priority of the alarm condition: 

• 1-250 (Low) 
• 251-500 (Medium) 
• 501-750 (High) 
• 751-1000 (Urgent) 

Alarm State The state of the alarm condition: 
• Normal Unacknowledged 
• In Alarm Acknowledged 
• In Alarm Unacknowledged 
• Normal Acknowledged 

Inhibit State The value applied to the alarm condition that inhibits the alarm at some 
level. These states, indicated by an icon in the alarm table, include:  

• Bad Quality  

• Disabled  

• Suppressed  

• Shelved  
• Faulted 
These states can be combined. When an alarm has more than one inhibit 
state applied, the icon of the highest inhibit state shown above appears in 
the table. 

Event Time The date and time the alarm event occurred.  
Condition • Analog conditions include: DEV_HI, DEV_LO, HIHI, HI, LO, LOLO, ROC_POS, 

and ROC_NEG 
• Discrete conditions include: TRIP and TRIP_L 

Expression The expression configured in Logix Designer for the selected condition. 
The expression appears only for tag-based alarms. 

Alarm Name The name of the alarm. This name includes the controller name of the 
alarm and the tag name. It can also include the name of the program if 
the tag is defined at the program level. Depending on how it was 
configured, the Alarm Name can appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.  
For tag-based alarms, the alarm name can appear as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag 
is not located inside a program, this part is omitted and the Alarm Name 
appears as ::ControllerName.TagName.@Alarms.AlarmName. 

Message The message assigned to the alarm in the Logix Designer project. 
In Alarm Time The time the selected alarm entered the In Alarm state. 
Acknowledge Time The time the selected alarm was acknowledged. 
Out of Alarm Time The time the selected alarm entered the Normal or Out of Alarm state. 
Enabled Time The time the selected alarm was enabled. 
Disable Time The time the selected alarm was disabled. 



Chapter 19  Display alarms 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 583 
 

Suppress Time The time the selected alarm was suppressed. 
Unsuppress Time The time the selected alarm was unsuppressed. 

Shelve Time The time the selected alarm was shelved. 

Unshelve Time The time the selected alarm was unshelved. If the alarm is currently 
shelved, this is the time the alarm is unshelved automatically when the 
shelve duration expires.  

Alarm Class The user-defined class assigned to the alarm in the Logix Designer 
project. 

Alarm Group Displays the alarm group from Logix Designer to help classify and sort 
alarms. Displayed only for tag-based alarms. 

Limit Value Exceeded The condition limit assigned to the alarm in the Logix Designer project.  
Tag 1 Value The value of the associated tag parameter 1. 
Tag 2 Value The value of the associated tag parameter 2. 

Tag 3 Value The value of the associated tag parameter 3. 
Tag 4 Value The value of the associated tag parameter 4. 
Alarm Count The number of times the alarm condition has entered the In Alarm state. 
Current Value The current tag input value resulting in the alarm state.  
Event Category Digital events are categorized as Discrete. Analog events are categorized 

as Level.  
Shelve duration The default time for which the selected alarm condition is shelved to 

prevent the notification of new state changes. Shelve duration is assigned 
to the alarm in the Logix Designer project. 

Max Shelve Duration The maximum time the alarm can be shelved.   
Quality Details Displays information of a fault in case of faulted alarms. 

State Change Type This row applies to Alarm History only and displays the type of alarm state 
change for the currently selected alarm record: 
• In Alarm 
• Return to Normal 
• Acknowledged 
• Disabled 
• Enabled 
• Suppressed 
• Unsuppressed 
• Shelved 
• Unshelved 
• Configuration Changed 
• Fault 
• Alarm Counter Reset 

 

 
Tip: The Alarm History table does not contain the following details pane rows: 
• In Alarm Time 
• Acknowledge Time 
• Out of Alarm Time 
• Enabled Time 
• Disables Time 
• Suppress Time 
• Unsuppress Time 
• Shelve Time 
• Unshelve Time 
• Shelve Duration 
Max Shelve Duration 
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See also 
Details pane for an Alarm Summary on page 580 

Alarm faults and alarm quality on page 565 

Alarm Summary contents for a large HMI device screen on page 
577 

Alarm Manager contents for a large HMI device screen on page 
589 

How do I open the Help popup? 

1. Open an alarm table:  
• In the System Banner at the top of the screen, tap Alarm 

Status Indicator  to open the Alarm Summary.  
• At the top of the Alarm Summary table, tap Alarm Manager  

to open the Alarm Manager.  
2. From either the Alarm Summary or the Alarm Manager, tap Help 

. 

The Help popup opens when pressing Help  on an HMI device. This 
popup  shows a legend of icons that appear on the alarm screens and 
the task each button on an alarm table performs. The functions vary 
depending on the selected alarm table. 

Help popup for Alarm Summary and Alarm Manager tables: 

 
Help popup for Alarm History table: 

 
 

Item Description 

 
A legend for icons in the alarm table.  

Help popup for alarm tables 
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A legend for alarm functions you can perform on the alarm table. The alarm functions represent buttons on the alarm 
table. The functions you can perform vary depending on the selected alarm table: 

  
Back opens the previously displayed screen. When opening the Alarm Manager screen from the Alarm 
Summary screen, this button reopens the Alarm Summary screen. 

 
Alarm Manager opens the Alarm Manager screen. The Alarm Manager lists all alarms configured in the system 
and their current states. Therefore, the Alarm Manager shows alarms not shown in the Alarm Summary, and 
provides additional tasks for alarms.  

 
Details hides or shows the Details pane, which contains the details of the last selected alarm. The Details pane 
appears on the bottom half of large alarm tables and replaces the list of alarms in medium alarm tables. If no 
alarm is selected, the Details pane is empty.   

 
Select All selects all of the alarms in the alarm table, including those not displayed on the current page of 
alarms. 

 
Deselect All deselects all alarms in the alarm table, including those not displayed on the current page of 
alarms. 

 
Select Page selects all of the alarms displayed on the current page of alarms. 

 
Reset Latched Alarms sets the selected latched state of the alarm to Normal if the input of the alarm has 
returned to normal. Resetting a latched alarm acknowledges the alarm, if it is not acknowledged.   

 
Reset Alarm Counts resets the alarm count in the controllers and the Alarm Count value in the Details pane of 
the Alarm Manager table to zero. The reset is performed for all conditions of the currently selected alarm.  

 
Pause stops updates to the Alarm Summary table for 10 seconds or until performing another operation on the 
table. While updates to the Alarm Summary table are paused, alarms in the controllers are still evaluated. 
When the table is no longer paused, any changes to alarm states are reflected in the table and updates 
resume.     

 
Disable stops the alarm condition from being evaluated. In effect, this turns off the selected alarm. This 
button disables the entire alarm. It is not possible to disable an individual alarm condition.   

 
Enable enables the selected alarms in the Alarm Manager table. Enabling an alarm allows the alarm condition 
to be evaluated, in effect turning on the alarm. Enabling an alarm enables all of the conditions for that alarm. 
Enabling an individual alarm condition is not allowed.  

 
Shelve prevents the notification of new state changes to the selected alarm if the alarm is acknowledged. 
Updates to the alarm do not appear. The alarm remains shelved until the shelve duration from the controller 
expires automatically or until manually unshelving the alarm. Updates to the alarm then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected alarm conditions. Shelving an alarm in 
the Alarm Manager table shelves all of the conditions of the alarm. From the condition list in the Details pane 
of the Alarm Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. Change the Shelve Duration and 
Max Shelve Duration values using Logix Designer in order to propagate updated values to the Alarm Summary 
and Alarm Manager clients. Use the previous Shelve Duration and Max Shelve Duration values when shelving 
alarms in Studio 5000 alarm tables. 

 
Unshelve unshelves the selected alarm in the Alarm Manager table. Unshelving allows notification of new state 
changes to alarms. From the condition list in the Details pane of the Alarm Manager table, unshelve individual 
alarm conditions.  

 
Acknowledge indicates that you are aware of the alarm. This button changes the state of the alarm from 
unacknowledged to acknowledged. 

 Date filter. Select the box and enter a date and time to list only the alarm state change records that occurred 
between the chosen date and time and the present. Select the checkbox on the right side to activate the filter. 

 Refresh loads the latest alarm state changes from the alarm history. You can also exit and enter the screen 
with the Alarm History again to refresh with the latest changes. 

 
Help opens this Help popup.  

See also 
Alarm Summary contents for a medium HMI device screen on 
page 575 

Alarm Manager contents for a medium HMI device screen on page 
588 
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Create an alarm screen on page 565 

Resize a graphic element on page 144 

Alarms overview on page 563 

The Alarm Manager lists all alarms configured in a system and their 
current states. By default, each project includes an AlarmManager 
screen. Create an additional screen with a graphic element to create a 
custom Alarm Manager table. 

 
Tip: For tag-based alarms, Alarm Manager displays alarms marked as active and ready for evaluation. 

Use the Alarm Manager to monitor and interact with the alarms on the 
HMI device. View the Details pane of the Alarm Manager screen to 
show all of the details of the selected condition. 

 
Tip: Refer to Logix Designer Help for the information about tag-based alarms. 

See also 
Alarms overview on page 563 

Create an alarm screen on page 565 

Alarm Manager contents for a large HMI device screen on page 
589 

Alarm Manager contents for a medium HMI device screen on page 
588 

What is the Alarm Manager? on page 99 

Prevent users from performing certain operations on an Alarm Manager 
table on the HMI device. For example, to prevent disabling alarms, 
disable the appropriate button on the alarm table.  

On the HMI device, a disabled button has diagonal hash marks across it. 

If the button is tapped, an Error icon  appears. Tap the Error icon 

 to open an Error list that describes the button that is disabled.   

To disable a button on an Alarm Manager table 
1. On the screen, select the Alarm Manager table. 
2. In the Properties window, select the Properties tab. 
3. Expand the General node. 
4. Select the check box to disable the desired button and associated 

operation on the HMI device:  

• DisableEnabled. Clear this check box to disable Disable  
on the selected alarm table. This prevents stopping an alarm 
condition from being evaluated, effectively turning off the alarm. 

• EnableEnabled. Clear this check box to disable Enable  on 
the selected alarm table. This prevents allowing an alarm 

Alarm Manager 

Disable a button on an 
Alarm Manager table 
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condition from being evaluated again, effectively turning on the 
alarm. 

• ResetCountsEnabled. Clear this check box to disable Reset 
Alarm Counts   on the selected alarm table. This prevents 
resetting the Alarm Count value of the alarm table to zero. The 
alarm count indicates the number of times an alarm has gone 
into the In Alarm State. 

• ShelveEnabled. Clear this check box to disable Shelve  on 
the selected alarm table. This stops any instance of preventing 
the notification of new state changes for an alarm or alarm 
condition.  

• UnshelveEnabled. Clear this check box to disable Unshelve 
 on the selected alarm table. This prevents resuming the 

notification of the new state changes of an alarm. 

See also 
Specify the visibility of an alarm table on page 570 

Disable touch and key input for an alarm table on page 566 

Alarm Summary on page 571 

Alarm Manager on page 586 

Specify which users have access to perform certain operations on an 
Alarm Manager table. For example, determine that all users, regardless 
of their assigned security role, have access to enable an alarm. To do 
this, set the EnableAccess property to Full Access. Alternatively, 
determine that security access to enabling alarms depends on the role 
assigned to the logged in user. In this case, set the EnableAccess 
property to Inherit. 

To specify access to operations performed on an Alarm Manager 
table  

1. On the screen, select the Alarm Manager table. 
2. In the Properties window, select the Properties tab. 
3. Expand the Security node. 
4. Locate the property for the button to set access:   

• DisableAccess. Set access to Disable  on the selected 
Alarm Manager table. This button stops an alarm condition from 
being evaluated, effectively turning off the alarm. 

• EnableAccess. Set access to Enable  on the selected 
Alarm Manager table. This button allows an alarm condition to 
be evaluated, effectively turning on the alarm. 

• ResetCountAccess. Set access to Reset Alarm Counts  
on the selected Alarm Manager table. This button resets the 
Alarm Count value to zero on the alarm table. The alarm count 
indicates the number of times an alarm has gone into the In 
Alarm State. 

Specify access to 
operations performed on an 
Alarm Manager table 
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• ShelveAccess. Set access to Shelve  on the selected 
Alarm Manager table. This button prevents the notification of 
new state changes for an alarm or alarm condition.  

• UnshelveAccess. Set access to Unshelve  on the 
selected Alarm Manager table. This button resumes the 
notification of new state changes for an alarm. 

5. In the box, select an option:  
• Inherit. Specify that access to the button is inherited from the 

screen.      
• Full Access. Specify that all users have access to the button.   

Inherited access for a user role can be Full Access, Read-Only 
access, or No Access. If a button inherits Read-Only access, 
hash marks appear across the button on the HMI device. 
Pressing the button displays an error. If a button inherits No 
Access from the screen, there is no access to the screen 
containing the alarm table. In this case, the screen does not 
appear in the Navigation menu on the HMI device. 

See also 
Specify the visibility of an alarm table on page 570 

Disable touch and key input for an alarm table on page 566 

Disable a button on an Alarm Manager table on page 586 

The Alarm Manager Medium alarm table appears on the predefined 
AlarmManager screen. This screen is in the Predefined Screens folder 
of the Project Explorer. The table exists for medium, six-inch to 
nine-inch HMI device screens. Create an Alarm Manager Medium table 
with customized appearance and content.  

 
Item Description 

 
The list of alarms, in all states, for the controllers referenced in the View Designer project. The Alarm Manager displays 
tag-based alarms marked for use and evaluation. Each row contains an alarm and the conditions. Depending on 
configuration, the Alarm Name can appear as ::ControllerName.TagName or ::ControllerName\ProgramName.TagName. 
For tag-based alarms, the Alarm Name appears as ::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If 
the tag is not located inside a program, this part is omitted and the Alarm Name appears as 
::ControllerName.TagName.@Alarms.AlarmName.  

Alarm Manager contents for 
a medium HMI device 
screen 
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Buttons to perform operations on alarms in the Alarm Manager table: 

 
Back opens the previously displayed screen. When opening the Alarm Manager screen from the Alarm Summary 
screen, this button reopens the Alarm Summary screen. 

 
Details hides or shows the Details pane, which contains the details of the last selected alarm. The Details pane 
appears on the bottom half of large alarm tables and replaces the list of alarms in medium alarm tables. If no 
alarm is selected, the Details pane is empty.   
The Details pane on an Alarm Manager table shows a list of conditions. Buttons to shelve and unshelve 
individual alarm conditions appear above the list of conditions. 

 
Select All selects all of the alarms in the alarm table, including those not displayed on the current page of 
alarms. 

 
Deselect All deselects all alarms in the alarm table, including those not displayed on the current page of alarms. 

 
Select Page selects all of the alarms displayed on the current page of alarms. 

 
Reset Alarm Counts resets the alarm count in the controllers and the Alarm Count value in the Details pane of 
the Alarm Manager table to zero. The reset is performed for all conditions of the currently selected alarm.  

 
Enable enables the selected alarms in the Alarm Manager table. Enabling an alarm allows the alarm condition to 
be evaluated, in effect turning on the alarm. Enabling an alarm enables all of the conditions for that alarm. 
Enabling an individual alarm condition is not allowed.  

 
Disable stops the alarm condition from being evaluated. In effect, this turns off the selected alarm. This button 
disables the entire alarm. It is not possible to disable an individual alarm condition.   

 
Unshelve unshelves the selected alarm in the Alarm Manager table. Unshelving allows notification of new state 
changes to alarms. From the condition list in the Details pane of the Alarm Manager table, unshelve individual 
alarm conditions.  

 
Shelve prevents the notification of new state changes to the selected alarm if the alarm is acknowledged. 
Updates to the alarm do not appear. The alarm remains shelved until the shelve duration from the controller 
expires automatically or until manually unshelving the alarm. Updates to the alarm then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected alarm conditions. Shelving an alarm in 
the Alarm Manager table shelves all of the conditions of the alarm. From the condition list in the Details pane of 
the Alarm Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. Change the Shelve Duration and Max 
Shelve Duration values using Logix Designer in order to propagate updated values to the Alarm Summary and 
Alarm Manager clients. Use the previous Shelve Duration and Max Shelve Duration values when shelving alarms 
in Studio 5000 alarm tables. 

 
Help opens the Help popup. This popup displays a legend of icons for In Alarm/Unacknowledged, 
Normal/Unacknowledged, In Alarm/Acknowledged, and Faulted alarms, and the task each button on an alarm 
table performs.  

 
Filter list. Select a filter on the HMI device to list only the alarms containing the filter value for the indicated column. For 
example, if the filter exists, select the filter Priority:High to show only those alarms with a high priority. Filters are 
configured in View Designer.  

See also 
Alarm Manager on page 586 

Alarm Manager contents for a large HMI device screen on page 
589 

Create an alarm screen on page 565 

Alarm Manager table columns on page 591 

Disable a button on an Alarm Manager table on page 586 

Alarm Manager contents for 
a large HMI device screen 
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The Alarm Manager Large alarm table appears on the predefined 
Alarm Manager screen. This screen is in the Predefined Screens folder 
in the Project Explorer. The table exists for large, ten-inch or larger HMI 
device screens. Create an Alarm Manager Large table with customized 
appearance and content instead of using the predefined Alarm Manager 
screen. 

 
Item Description 

 
The list of alarms, in all states, for the controllers referenced in the View Designer project. The 
Alarm Manager displays tag-based alarms marked for use and evaluation. Each row contains an 
alarm and the conditions. Depending on configuration, the Alarm Name can appear as 
::ControllerName.TagName or ::ControllerName\ProgramName.TagName. For tag-based alarms, 
the Alarm Name appears as ::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If 
the tag is not located inside a program, this part is omitted and the Alarm Name appears as 
::ControllerName.TagName.@Alarms.AlarmName.  

 
Buttons to shelve and unshelve the alarm condition selected in the Details pane. The Details 
pane appears at the bottom of the Alarm Manager table.  

 
 

Shelve shelves the alarm condition selected in the Details pane. Shelving a condition 
prevents notification of new state changes to the alarm. 

 
Unshelve unshelves the alarm condition selected in the Details pane. Unshelving a 
condition allows notification of new state changes to the alarm. 

 
In the list of conditions, select a condition to show all of the details for that conditionin the 
Details pane. For example, to show details for the TRIP condition for the selected alarm, scroll to 
and tap TRIP.  

 
Filter list. Select a filter on the HMI device to list only the alarms containing the filter value for the 
indicated column. For example, if the filter exists, select the filter Priority:High to show only 
those alarms with a high priority. Filters are configured in View Designer.  

 
Buttons to perform operations on alarms in the Alarm Manager table: 

 
 

Back opens the previously displayed screen. When opening the Alarm Manager screen 
from the Alarm Summary screen, this button reopens the Alarm Summary screen. 

 
Details hides or shows the Details pane, which contains the details of the last selected 
alarm. The Details pane appears on the bottom half of large alarm tables and replaces 
the list of alarms in medium alarm tables. If no alarm is selected, the Details pane is 
empty.   

 
Select All selects all of the alarms in the alarm table, including those not displayed on the 
current page of alarms. 
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Deselect All deselects all alarms in the alarm table, including those not displayed on the 
current page of alarms. 

 
Select Page selects all of the alarms displayed on the current page of alarms. 

 
Reset Alarm Counts resets the alarm count in the controllers and the Alarm Count value in 
the Details pane of the Alarm Manager table to zero. The reset is performed for all 
conditions of the currently selected alarm.  

 
Enable enables the selected alarms in the Alarm Manager table. Enabling an alarm allows 
the alarm condition to be evaluated, in effect turning on the alarm. Enabling an alarm 
enables all of the conditions for that alarm. Enabling an individual alarm condition is not 
allowed.  

 
Disable stops the alarm condition from being evaluated. In effect, this turns off the 
selected alarm. This button disables the entire alarm. It is not possible to disable an 
individual alarm condition.   

 
Unshelve unshelves the selected alarm in the Alarm Manager table. Unshelving allows 
notification of new state changes to alarms. From the condition list in the Details pane of 
the Alarm Manager table, unshelve individual alarm conditions.  

 
Shelve prevents the notification of new state changes to the selected alarm if the alarm 
is acknowledged. Updates to the alarm do not appear. The alarm remains shelved until 
the shelve duration from the controller expires automatically or until manually unshelving 
the alarm. Updates to the alarm then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected alarm conditions. 
Shelving an alarm in the Alarm Manager table shelves all of the conditions of the alarm. 
From the condition list in the Details pane of the Alarm Manager table, shelve individual 
alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. Change the 
Shelve Duration and Max Shelve Duration values using Logix Designer in order to 
propagate updated values to the Alarm Summary and Alarm Manager clients. Use the 
previous Shelve Duration and Max Shelve Duration values when shelving alarms in Studio 
5000 alarm tables. 

 
Help opens the Help popup. This popup displays a legend of icons for In 
Alarm/Unacknowledged, Normal/Unacknowledged, In Alarm/Acknowledged, and Faulted 
alarms, and the task each button on an alarm table performs.  

 
The Details pane lists condition details for the selected alarm. Each row lists details for one 
alarm condition. The details include when the alarm condition was enabled or disabled, 
suppressed or unsuppressed, or shelved. Selecting multiple alarms in the Alarm Manager table 
shows condition details for the last alarm selected. 

See also 
Alarm Manager on page 586 

Alarm Manager contents for a medium HMI device screen on page 
588  

Create an alarm screen on page 565 

Alarm Manager table columns on page 591 

Disable a button on an Alarm Manager table on page 586 

The Alarm Manger table provides alarm information in columns:     

Column Description 
Alarm Manager table 
columns 
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Alarm State The conditions of the alarm: 

• Normal, Unacknowledged  and Urgent  

• In Alarm, Acknowledged  and Urgent  

• In Alarm, Unacknowledged  and Urgent  
• Normal, Acknowledged 
The Alarm Manager table displays a combination of all the conditions of an alarm. If any 
condition in the alarm is In Alarm or Unacknowledged, the alarm appears as In Alarm or 
Unacknowledged in the Alarm Manager. 

Inhibit State The value applied to an alarm that inhibits the alarm. These states include:  

• Bad Quality  

• Disabled  

• Suppressed  

• Shelved   
When an alarm has more than one inhibit state, the icon of the highest inhibit state appears in 
the table. If no icon appears, the alarm has good quality, and is not disabled, suppressed, or 
shelved. 

Alarm Name The name of the alarm created in Logix Designer. For instruction-based alarms, it includes the 
alarm controller and tag. It can also include the name of the program if the tag is going to be 
defined at the program level. The Alarm Name can be configured as ::ControllerName.TagName 
or ::ControllerName\ProgramName.TagName. For tag-based alarms, the Alarm Name appears as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag is not located inside a 
program, this part is omitted and the Alarm Name appears as 
::ControllerName.TagName.AlarmName. 

See also 
Alarm Manager on page 586 

Details pane rows on page 581 

Alarm Manager contents for a large HMI device screen on page 
589 

Details pane for an Alarm Summary on page 580 

Details pane for an Alarm 
Manager 
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In a medium Alarm Manager table intended for HMI devices with six-inch 
to nine-inch screens, the Details pane replaces the list of alarms in the 
table. In a large Alarm Manager table intended for HMI devices with 
ten-inch or larger screens, the Details pane opens at bottom of the table.     

 
Item Description 

 
Buttons to shelve and unshelve the selected alarm condition in the Details pane 
when it is displayed at the bottom of the Alarm Manager table.  

 
 

Shelve shelves the selected alarm condition in the Details pane. Shelving a 
condition prevents notification of new state changes to the alarm. 
Change the Shelve Duration and Max Shelve Duration through Logix Designer. 
If changes to the Shelve Duration and Max Shelve Duration values are not 
made through Logix Designer, the updated values are not propagated to the 
Alarm Summary and Alarm Manager clients. In this case, the previous Shelve 
Duration and Max Shelve Duration values are used when shelving alarms in 
Studio 5000 alarm tables. 

 
Unshelve unshelves the selected alarm condition in the Details pane. 
Unshelving a condition allows notification of new state changes to the alarm. 

 
Select a condition to show all of the details of the condition in the Details pane. For 
example, to show details for the TRIP condition for the selected alarm, scroll to and 
select TRIP. 

 
The condition details for the selected alarm. The details include when the alarm 
condition was enabled or disabled, suppressed or unsuppressed, or shelved. When 
multiple alarms are selected in the Alarm Manager table, condition details are 
displayed for the last alarm selected. 

See also 
Details pane rows on page 581 

Alarm Manager for a medium HMI device on page 783 

Alarm Manager for a large HMI device on page 784 

Alarm faults and alarm quality on page 565 

Selecting Details  on an alarm table opens the Details pane in the 
lower half of: 

• Large Alarm Summary table 

Details pane rows 
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• Large Alarm Manager table 
• Large Alarm History table 

The Details pane replaces the list of alarms in medium alarm tables. The 
Details pane shows details for the selected alarm condition of a selected 
alarm. Condition details display the selected alarm condition in the Alarm 
Manager table. The contents of the Details pane appears in rows. 

Row Description 

Priority The urgency of the alarm condition: 

• Low  

• Medium  

• High  

• Urgent  
Severity The numeric value mapped to the assigned priority of the alarm condition: 

• 1-250 (Low) 
• 251-500 (Medium) 
• 501-750 (High) 
• 751-1000 (Urgent) 

Alarm State The state of the alarm condition: 
• Normal Unacknowledged 
• In Alarm Acknowledged 
• In Alarm Unacknowledged 
• Normal Acknowledged 

Inhibit State The value applied to the alarm condition that inhibits the alarm at some 
level. These states, indicated by an icon in the alarm table, include:  

• Bad Quality  

• Disabled  

• Suppressed  

• Shelved  
• Faulted 
These states can be combined. When an alarm has more than one inhibit 
state applied, the icon of the highest inhibit state shown above appears in 
the table. 

Event Time The date and time the alarm event occurred.  
Condition • Analog conditions include: DEV_HI, DEV_LO, HIHI, HI, LO, LOLO, ROC_POS, 

and ROC_NEG 
• Discrete conditions include: TRIP and TRIP_L 

Expression The expression configured in Logix Designer for the selected condition. 
The expression appears only for tag-based alarms. 

Alarm Name The name of the alarm. This name includes the controller name of the 
alarm and the tag name. It can also include the name of the program if 
the tag is defined at the program level. Depending on how it was 
configured, the Alarm Name can appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.  
For tag-based alarms, the alarm name can appear as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag 
is not located inside a program, this part is omitted and the Alarm Name 
appears as ::ControllerName.TagName.@Alarms.AlarmName. 

Message The message assigned to the alarm in the Logix Designer project. 
In Alarm Time The time the selected alarm entered the In Alarm state. 
Acknowledge Time The time the selected alarm was acknowledged. 
Out of Alarm Time The time the selected alarm entered the Normal or Out of Alarm state. 
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Enabled Time The time the selected alarm was enabled. 
Disable Time The time the selected alarm was disabled. 
Suppress Time The time the selected alarm was suppressed. 
Unsuppress Time The time the selected alarm was unsuppressed. 

Shelve Time The time the selected alarm was shelved. 

Unshelve Time The time the selected alarm was unshelved. If the alarm is currently 
shelved, this is the time the alarm is unshelved automatically when the 
shelve duration expires.  

Alarm Class The user-defined class assigned to the alarm in the Logix Designer 
project. 

Alarm Group Displays the alarm group from Logix Designer to help classify and sort 
alarms. Displayed only for tag-based alarms. 

Limit Value Exceeded The condition limit assigned to the alarm in the Logix Designer project.  
Tag 1 Value The value of the associated tag parameter 1. 
Tag 2 Value The value of the associated tag parameter 2. 

Tag 3 Value The value of the associated tag parameter 3. 
Tag 4 Value The value of the associated tag parameter 4. 
Alarm Count The number of times the alarm condition has entered the In Alarm state. 
Current Value The current tag input value resulting in the alarm state.  
Event Category Digital events are categorized as Discrete. Analog events are categorized 

as Level.  
Shelve duration The default time for which the selected alarm condition is shelved to 

prevent the notification of new state changes. Shelve duration is assigned 
to the alarm in the Logix Designer project. 

Max Shelve Duration The maximum time the alarm can be shelved.   
Quality Details Displays information of a fault in case of faulted alarms. 

State Change Type This row applies to Alarm History only and displays the type of alarm state 
change for the currently selected alarm record: 
• In Alarm 
• Return to Normal 
• Acknowledged 
• Disabled 
• Enabled 
• Suppressed 
• Unsuppressed 
• Shelved 
• Unshelved 
• Configuration Changed 
• Fault 
• Alarm Counter Reset 

 

 
Tip: The Alarm History table does not contain the following details pane rows: 
• In Alarm Time 
• Acknowledge Time 
• Out of Alarm Time 
• Enabled Time 
• Disables Time 
• Suppress Time 
• Unsuppress Time 
• Shelve Time 
• Unshelve Time 
• Shelve Duration 
Max Shelve Duration 



Chapter 19  Display alarms 
 

596 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

See also 
Details pane for an Alarm Summary on page 580 

Alarm faults and alarm quality on page 565 

Alarm Summary contents for a large HMI device screen on page 
577 

Alarm Manager contents for a large HMI device screen on page 
589 

How do I open the Help popup? 

1. Open an alarm table:  
• In the System Banner at the top of the screen, tap Alarm 

Status Indicator  to open the Alarm Summary.  
• At the top of the Alarm Summary table, tap Alarm Manager  

to open the Alarm Manager.  
2. From either the Alarm Summary or the Alarm Manager, tap Help 

. 

The Help popup opens when pressing Help  on an HMI device. This 
popup  shows a legend of icons that appear on the alarm screens and 
the task each button on an alarm table performs. The functions vary 
depending on the selected alarm table. 

Help popup for Alarm Summary and Alarm Manager tables: 

 
Help popup for Alarm History table: 

 
 

Item Description 

 
A legend for icons in the alarm table.  

Help popup for alarm tables 
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A legend for alarm functions you can perform on the alarm table. The alarm functions represent buttons on the alarm 
table. The functions you can perform vary depending on the selected alarm table: 

  
Back opens the previously displayed screen. When opening the Alarm Manager screen from the Alarm 
Summary screen, this button reopens the Alarm Summary screen. 

 
Alarm Manager opens the Alarm Manager screen. The Alarm Manager lists all alarms configured in the system 
and their current states. Therefore, the Alarm Manager shows alarms not shown in the Alarm Summary, and 
provides additional tasks for alarms.  

 
Details hides or shows the Details pane, which contains the details of the last selected alarm. The Details pane 
appears on the bottom half of large alarm tables and replaces the list of alarms in medium alarm tables. If no 
alarm is selected, the Details pane is empty.   

 
Select All selects all of the alarms in the alarm table, including those not displayed on the current page of 
alarms. 

 
Deselect All deselects all alarms in the alarm table, including those not displayed on the current page of 
alarms. 

 
Select Page selects all of the alarms displayed on the current page of alarms. 

 
Reset Latched Alarms sets the selected latched state of the alarm to Normal if the input of the alarm has 
returned to normal. Resetting a latched alarm acknowledges the alarm, if it is not acknowledged.   

 
Reset Alarm Counts resets the alarm count in the controllers and the Alarm Count value in the Details pane of 
the Alarm Manager table to zero. The reset is performed for all conditions of the currently selected alarm.  

 
Pause stops updates to the Alarm Summary table for 10 seconds or until performing another operation on the 
table. While updates to the Alarm Summary table are paused, alarms in the controllers are still evaluated. 
When the table is no longer paused, any changes to alarm states are reflected in the table and updates 
resume.     

 
Disable stops the alarm condition from being evaluated. In effect, this turns off the selected alarm. This 
button disables the entire alarm. It is not possible to disable an individual alarm condition.   

 
Enable enables the selected alarms in the Alarm Manager table. Enabling an alarm allows the alarm condition 
to be evaluated, in effect turning on the alarm. Enabling an alarm enables all of the conditions for that alarm. 
Enabling an individual alarm condition is not allowed.  

 
Shelve prevents the notification of new state changes to the selected alarm if the alarm is acknowledged. 
Updates to the alarm do not appear. The alarm remains shelved until the shelve duration from the controller 
expires automatically or until manually unshelving the alarm. Updates to the alarm then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected alarm conditions. Shelving an alarm in 
the Alarm Manager table shelves all of the conditions of the alarm. From the condition list in the Details pane 
of the Alarm Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. Change the Shelve Duration and 
Max Shelve Duration values using Logix Designer in order to propagate updated values to the Alarm Summary 
and Alarm Manager clients. Use the previous Shelve Duration and Max Shelve Duration values when shelving 
alarms in Studio 5000 alarm tables. 

 
Unshelve unshelves the selected alarm in the Alarm Manager table. Unshelving allows notification of new state 
changes to alarms. From the condition list in the Details pane of the Alarm Manager table, unshelve individual 
alarm conditions.  

 
Acknowledge indicates that you are aware of the alarm. This button changes the state of the alarm from 
unacknowledged to acknowledged. 

 Date filter. Select the box and enter a date and time to list only the alarm state change records that occurred 
between the chosen date and time and the present. Select the checkbox on the right side to activate the filter. 

 Refresh loads the latest alarm state changes from the alarm history. You can also exit and enter the screen 
with the Alarm History again to refresh with the latest changes. 

 
Help opens this Help popup.  

See also 
Alarm Summary contents for a medium HMI device screen on 
page 575 

Alarm Manager contents for a medium HMI device screen on page 
588 
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Create an alarm screen on page 565 

Resize a graphic element on page 144 

Alarms overview on page 563 

How do I open the Alarm History table? 

In the System Banner at the top of the screen, open the Navigation 
menu by tapping Navigation . Select the Alarm History item in the 
Navigation menu that appears at the bottom of the screen. 

The Alarm History lists alarm state change records from the alarm log. 
One alarm log record appears in a row. 

Use the Alarm History on an HMI device to: 

• Review the historical alarm records showing alarm state changes. 
• Filter alarm state changes. 

The Alarm History displays the history of alarm state changes available at 
the moment you open the screen. Close and reopen the screen or select 
Refresh  to load the latest alarm state changes.  

View Designer retains alarm state history after: 

• Rebooting or powering off the HMI device. 
• Loading a new project. 
• Disconnecting a controller from the HMI device. 
• Replacing a controller.  
• Having a controller recover from a fault. 
• Downloading a new program from a controller connected to the 

HMI device. 
• Clearing the alarm log on a controller connected to the HMI 

device.  

 
Tip:  
In the rare case the alarm history database is corrupted, the operator does not see any 
records in the Alarm History Viewer, although the alarm state changes are still happening. In 
such case, reboot the HMI device. 

PanelView terminals display up to 40,000 historical alarm state changes. 
This limit does not change with the number of controllers connected to 
the PanelView terminal. After exceeding the limit, new records replace 
the oldest alarm records. 

See also 
Alarm History Viewer contents for a large HMI device screen on 
page 601 

Alarm History Viewer contents for a medium HMI device screen on 
page 602 

Alarm History Viewer table columns on page 603 

New columns in an Alarm History appear on the right side of the table 
with sample data in each column. Use the sample data to determine the 
column width of a column. 

Alarm History 

Add a column to Alarm 
History Viewer 
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To add a column to an Alarm History table 
1. On the screen, select the Alarm History. 
2. In the Properties window, select the Columns tab.  
3. Select Add Column.  
4. Select the data to display in the column. The selected column 

appears in the heading of the new card.  
5. Change the width of a column to display the data.     

See also 
Delete a column from an Alarm History Viewer table on page 600 

Change the order of columns in an Alarm History Viewer table on 
page 600 

Change the width of a column in an Alarm History table if the data in the 
column is wider than the current width of the column. Use the sample 
data in a column to determine the required column width. The sample 
data represents the length of data anticipated for a column.   

To change the width of a column in an Alarm History table 
1. On the screen, select Alarm History. 
2. In the Properties window, select the Columns tab.  
3. In the column card, click Show/Hide  to expand the column 

card. The selected column card is outlined in blue.  
• In the Width field at the bottom of the column card, enter a 

positive number for the column width, in pixels. 
Changes to column width are saved automatically. The last 
column added fills the remaining space in the row. If the total width 
of all columns exceeds the width of the table, a horizontal scroll 
bar appears at the bottom of the table.  

 
Tip: When resizing a column in an Alarm History table, leave some space between the text of 
the column heading and the border of the column. If the text of a column heading appears at 
the column border, the text of the column heading may appear clipped in the Alarm History 
on the HMI device 

See also 
Change the order of columns in an Alarm History table on page 
600 

Delete a column from an Alarm History table on page 600 

Alarm History table columns on page 603 

Columns tab on page 580 

Resize a graphic element on page 144 

Change the width of a 
column in an Alarm History 
table 
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The columns in the table on the predefined Alarm History screen 
appear in a default order. This screen is in the Predefined Screens 
folder of the Project Explorer.  

To change the order of columns in an Alarm History table 
1. On the screen, select Alarm History. 
2. In the Properties window, select the Columns tab.  
3. Point to the column card heading and click Move column up  

move the column to the left or Move column down  to move 
the column to the right. Reordered columns appear in the Alarm 
History table on the screen. 

See also 
Add a column to an Alarm History table on page 598 

Delete a column from an Alarm History table on page 600 

Delete a column to remove it from the Alarm History table. This removes 
unwanted data from the table and provides room for more pertinent data. 
Once you make a data assignment to a column, it is not possible to 
change it. By default, Column 2 in the predefined Alarm History shows 
the alarm state.   

To delete a column from an Alarm History table 
1. On the screen, select the Alarm History. 
2. In the Properties window, select the Columns tab.  
3. On the column card, select Delete .  Deleted columns no 

longer appear in the Alarm History table. 

See also 
Add a column to an Alarm History table on page 598 

Change the order of columns in an Alarm History table on page 
600 

Add an Alarm History graphic element to a screen to create a screen on 
the HMI device to view the history of alarm state changes. 

Prerequisites 
• Configure ALMA and ALMD alarm instructions in Logix Designer 

or add tag-based alarms in a Logix Designer. The 5380, 5480 and 
5580 Logix families of controllers support tag-based alarms.  

Change the order of 
columns in Alarm History 
table 

Delete a column from Alarm 
History Viewer 

Create an Alarm History 
table 
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To create an Alarm History screen 
• In the Alarms category of the Toolbox, double-click or drag and 

drop the Alarm History Large or the Alarm History Medium 
graphic element onto the screen.  

See also 
Resize a graphic element on page 144 

The Alarm History Large alarm table appears on the predefined Alarm 
History screen. This screen is in the Predefined Screens folder of the 
Project Explorer. The table is recommended for large, ten-inch or larger 
HMI device screens. 

 

 
Item Description 

 
The list of alarm state changes records from the alarm log. 

 
 

Buttons to perform operations on alarms in the Alarm History table: 

 
Details hides or shows the Details pane, which contains the details of the last selected alarm. The Details pane 
appears on the bottom half of large alarm tables and replaces the list of alarms in medium alarm tables. If no 
alarm is selected, the Details pane is empty.   

 Refresh loads the latest alarm state changes from the alarm history. You can also exit and enter the screen with 
the Alarm History again to refresh with the latest changes. 

 
Help opens the Help popup. This popup displays a legend of icons for In Alarm/Unacknowledged, 
Normal/Unacknowledged, In Alarm/Acknowledged, and Faulted alarms, and the task each button on an alarm 
table performs. 

 
Filter list. Select a filter in the HMI device to list only the alarm state change records containing the filter value for the 
indicated column. For example, if the filter exists, select the filter Priority:High to show only those alarm state changes 
with a high priority. Configure filters in View Designer. 

Alarm History contents for 
a large HMI device screen 
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See also 
Alarm History on page 598 

Alarm History table columns on page 603 

Alarm History for a large HMI device screen on page 789 

The Alarm History Viewer Medium alarm table appears on the 
predefined Alarm History screen. This screen is in the Predefined 
Screens folder of the Project Explorer. The table is recommended for 
six-inch to nine-inch HMI device screens.   

 
Item Description 

 
The list of alarm state changes records from the terminal. 

 
Filter list. Select a filter in the HMI device to list only the alarm state change records containing the filter value for the 
indicated column. For example, if the filter exists, select the filter Priority:High to show only those alarm state changes 
with a high priority. Configure filters in View Designer. 

 
Date filter. Select the box and enter a date and time to list only the alarm state change records that occurred between 
the chosen date and time and the present. Select the checkbox on the right side to activate the filter. 

 
Number of filtered records and total number of records. 

 
Buttons to perform actions available for the Alarm History Viewer: 

 
Details hides or shows the Details pane, which contains the details of the last selected alarm state change 
record. The Details pane appears on the bottom half of large alarm tables and replaces the list of alarms in 
medium alarm tables. If no record is selected, the Details pane is empty. 

 Refresh loads the latest alarm state changes from the alarm history. The operator has to refresh the table to 
see the latest changes. The operator can also exit and enter the screen with the Alarm History again to 
refresh. 

 
Help opens the Help popup. This popup displays a legend of icons and the task each button on an alarm table 
performs. 

See also 
Alarm History on page 598 

Alarm History table columns on page 603 

Alarm History Viewer 
Medium 
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Alarm History for a medium HMI device screen on page 788 

Data fields in the Alarm History table appear in columns with 
descriptions of alarm information. The configuration in View Designer 
determines the columns and the order of the columns. View Designer 
enables adding, removing or rearranging the columns. 

Column Description 

! (Priority) The urgency of the event: 
• Low   
• Medium   
• High   
• Urgent  

Alarm The state of the alarm condition: 

• Normal, Acknowledged  
• Normal, Unacknowledged  and Urgent  
• In Alarm, Acknowledged  and Urgent  
• In Alarm, Unacknowledged  and Urgent  

Inhibit The value applied to an alarm that inhibits the alarm at some level. These 
states include:  
• Disabled  
• Enabled  
• Suppressed  
• Unsuppressed 
• Shelved   
• Unshelved 

• Faulted  
• Alarm Count Reset 
If no icon appears for Inhibit State, the alarm is of good quality and is not 
disabled, suppressed, or shelved. 

Event Time The time the alarm condition or sub-condition changed to the currently 
displayed state.  
The alarm state changes are sorted by default using this column, from the 
newest, to the oldest. 

Condition Name A name that describes the alarm condition. Condition names vary by event 
category. For example: 
• Level: LO, LOLO, HI, HIHI, ROC_POS, ROC_NEG 
• Discrete: TRIP, TRIP_L (Latched) 

Alarm Name The name of the alarm. This name includes the controller name of the alarm 
and the tag name. It can also include the name of the program if the tag is 
defined at the program level. Depending on how it was configured, the Alarm 
Name can appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.  
For tag-based alarms, the alarm name can appear as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag is 
not located inside a program, this part is omitted and the Alarm Name 
appears as ::ControllerName.TagName.@Alarms.AlarmName. 

Message The message assigned to the alarm in the alarm instruction or tag-based 
alarm configuration. 

Alarm History table 
columns 
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Column Description 

State Change The types of state changes for an alarm include: 
• Triggered 
• Untriggered 
• Acknowledged 
• Disabled 
• Enabled 
• Suppressed 
• Unsuppressed 
• Shelved 
• Unshelved 
• Configuration Changed 
• Fault 
• Alarm Counter Reset 

Tag 1 Value The value of tag 1. 

Tag 2 Value The value of tag 2. 
Tag 3 Value The value of tag 3.  
Tag 4 Value The value of tag 4. 

See also 
Alarm History on page 598 

Alarm History contents for a large HMI device screen on page 601 

Alarm History contents for a medium HMI device screen on page 
602 

Selecting Details  on an alarm table opens the Details pane in the 
lower half of: 

• Large Alarm Summary table 
• Large Alarm Manager table 
• Large Alarm History table 

The Details pane replaces the list of alarms in medium alarm tables. The 
Details pane shows details for the selected alarm condition of a selected 
alarm. Condition details display the selected alarm condition in the Alarm 
Manager table. The contents of the Details pane appears in rows. 

Row Description 

Priority The urgency of the alarm condition: 

• Low  

• Medium  

• High  

• Urgent  

Details pane rows 
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Severity The numeric value mapped to the assigned priority of the alarm condition: 
• 1-250 (Low) 
• 251-500 (Medium) 
• 501-750 (High) 
• 751-1000 (Urgent) 

Alarm State The state of the alarm condition: 
• Normal Unacknowledged 
• In Alarm Acknowledged 
• In Alarm Unacknowledged 
• Normal Acknowledged 

Inhibit State The value applied to the alarm condition that inhibits the alarm at some 
level. These states, indicated by an icon in the alarm table, include:  

• Bad Quality  

• Disabled  

• Suppressed  

• Shelved  
• Faulted 
These states can be combined. When an alarm has more than one inhibit 
state applied, the icon of the highest inhibit state shown above appears in 
the table. 

Event Time The date and time the alarm event occurred.  
Condition • Analog conditions include: DEV_HI, DEV_LO, HIHI, HI, LO, LOLO, ROC_POS, 

and ROC_NEG 
• Discrete conditions include: TRIP and TRIP_L 

Expression The expression configured in Logix Designer for the selected condition. 
The expression appears only for tag-based alarms. 

Alarm Name The name of the alarm. This name includes the controller name of the 
alarm and the tag name. It can also include the name of the program if 
the tag is defined at the program level. Depending on how it was 
configured, the Alarm Name can appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.  
For tag-based alarms, the alarm name can appear as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag 
is not located inside a program, this part is omitted and the Alarm Name 
appears as ::ControllerName.TagName.@Alarms.AlarmName. 

Message The message assigned to the alarm in the Logix Designer project. 
In Alarm Time The time the selected alarm entered the In Alarm state. 
Acknowledge Time The time the selected alarm was acknowledged. 
Out of Alarm Time The time the selected alarm entered the Normal or Out of Alarm state. 
Enabled Time The time the selected alarm was enabled. 
Disable Time The time the selected alarm was disabled. 
Suppress Time The time the selected alarm was suppressed. 
Unsuppress Time The time the selected alarm was unsuppressed. 

Shelve Time The time the selected alarm was shelved. 

Unshelve Time The time the selected alarm was unshelved. If the alarm is currently 
shelved, this is the time the alarm is unshelved automatically when the 
shelve duration expires.  

Alarm Class The user-defined class assigned to the alarm in the Logix Designer 
project. 

Alarm Group Displays the alarm group from Logix Designer to help classify and sort 
alarms. Displayed only for tag-based alarms. 

Limit Value Exceeded The condition limit assigned to the alarm in the Logix Designer project.  
Tag 1 Value The value of the associated tag parameter 1. 
Tag 2 Value The value of the associated tag parameter 2. 
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Tag 3 Value The value of the associated tag parameter 3. 
Tag 4 Value The value of the associated tag parameter 4. 
Alarm Count The number of times the alarm condition has entered the In Alarm state. 
Current Value The current tag input value resulting in the alarm state.  
Event Category Digital events are categorized as Discrete. Analog events are categorized 

as Level.  
Shelve duration The default time for which the selected alarm condition is shelved to 

prevent the notification of new state changes. Shelve duration is assigned 
to the alarm in the Logix Designer project. 

Max Shelve Duration The maximum time the alarm can be shelved.   
Quality Details Displays information of a fault in case of faulted alarms. 

State Change Type This row applies to Alarm History only and displays the type of alarm state 
change for the currently selected alarm record: 
• In Alarm 
• Return to Normal 
• Acknowledged 
• Disabled 
• Enabled 
• Suppressed 
• Unsuppressed 
• Shelved 
• Unshelved 
• Configuration Changed 
• Fault 
• Alarm Counter Reset 

 

 
Tip: The Alarm History table does not contain the following details pane rows: 
• In Alarm Time 
• Acknowledge Time 
• Out of Alarm Time 
• Enabled Time 
• Disables Time 
• Suppress Time 
• Unsuppress Time 
• Shelve Time 
• Unshelve Time 
• Shelve Duration 
Max Shelve Duration 

See also 
Details pane for an Alarm Summary on page 580 

Alarm faults and alarm quality on page 565 

Alarm Summary contents for a large HMI device screen on page 
577 

Alarm Manager contents for a large HMI device screen on page 
589 

How do I open the Help popup? 

1. Open an alarm table:  
Help popup for alarm tables 
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• In the System Banner at the top of the screen, tap Alarm 
Status Indicator  to open the Alarm Summary.  

• At the top of the Alarm Summary table, tap Alarm Manager  
to open the Alarm Manager.  

2. From either the Alarm Summary or the Alarm Manager, tap Help 
. 

The Help popup opens when pressing Help  on an HMI device. This 
popup  shows a legend of icons that appear on the alarm screens and 
the task each button on an alarm table performs. The functions vary 
depending on the selected alarm table. 

Help popup for Alarm Summary and Alarm Manager tables: 

 
Help popup for Alarm History table: 

 
 

Item Description 

 
A legend for icons in the alarm table.  

 
A legend for alarm functions you can perform on the alarm table. The alarm functions represent buttons on the alarm 
table. The functions you can perform vary depending on the selected alarm table: 

  
Back opens the previously displayed screen. When opening the Alarm Manager screen from the Alarm 
Summary screen, this button reopens the Alarm Summary screen. 

 
Alarm Manager opens the Alarm Manager screen. The Alarm Manager lists all alarms configured in the system 
and their current states. Therefore, the Alarm Manager shows alarms not shown in the Alarm Summary, and 
provides additional tasks for alarms.  

 
Details hides or shows the Details pane, which contains the details of the last selected alarm. The Details pane 
appears on the bottom half of large alarm tables and replaces the list of alarms in medium alarm tables. If no 
alarm is selected, the Details pane is empty.   

 
Select All selects all of the alarms in the alarm table, including those not displayed on the current page of 
alarms. 

 
Deselect All deselects all alarms in the alarm table, including those not displayed on the current page of 
alarms. 
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Select Page selects all of the alarms displayed on the current page of alarms. 

 
Reset Latched Alarms sets the selected latched state of the alarm to Normal if the input of the alarm has 
returned to normal. Resetting a latched alarm acknowledges the alarm, if it is not acknowledged.   

 
Reset Alarm Counts resets the alarm count in the controllers and the Alarm Count value in the Details pane of 
the Alarm Manager table to zero. The reset is performed for all conditions of the currently selected alarm.  

 
Pause stops updates to the Alarm Summary table for 10 seconds or until performing another operation on the 
table. While updates to the Alarm Summary table are paused, alarms in the controllers are still evaluated. 
When the table is no longer paused, any changes to alarm states are reflected in the table and updates 
resume.     

 
Disable stops the alarm condition from being evaluated. In effect, this turns off the selected alarm. This 
button disables the entire alarm. It is not possible to disable an individual alarm condition.   

 
Enable enables the selected alarms in the Alarm Manager table. Enabling an alarm allows the alarm condition 
to be evaluated, in effect turning on the alarm. Enabling an alarm enables all of the conditions for that alarm. 
Enabling an individual alarm condition is not allowed.  

 
Shelve prevents the notification of new state changes to the selected alarm if the alarm is acknowledged. 
Updates to the alarm do not appear. The alarm remains shelved until the shelve duration from the controller 
expires automatically or until manually unshelving the alarm. Updates to the alarm then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected alarm conditions. Shelving an alarm in 
the Alarm Manager table shelves all of the conditions of the alarm. From the condition list in the Details pane 
of the Alarm Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. Change the Shelve Duration and 
Max Shelve Duration values using Logix Designer in order to propagate updated values to the Alarm Summary 
and Alarm Manager clients. Use the previous Shelve Duration and Max Shelve Duration values when shelving 
alarms in Studio 5000 alarm tables. 

 
Unshelve unshelves the selected alarm in the Alarm Manager table. Unshelving allows notification of new state 
changes to alarms. From the condition list in the Details pane of the Alarm Manager table, unshelve individual 
alarm conditions.  

 
Acknowledge indicates that you are aware of the alarm. This button changes the state of the alarm from 
unacknowledged to acknowledged. 

 Date filter. Select the box and enter a date and time to list only the alarm state change records that occurred 
between the chosen date and time and the present. Select the checkbox on the right side to activate the filter. 

 Refresh loads the latest alarm state changes from the alarm history. You can also exit and enter the screen 
with the Alarm History again to refresh with the latest changes. 

 
Help opens this Help popup.  

See also 
Alarm Summary contents for a medium HMI device screen on 
page 575 

Alarm Manager contents for a medium HMI device screen on page 
588 

Create an alarm screen on page 565 

Resize a graphic element on page 144 

Alarms overview on page 563 

A filter is applied to a table to show only the data values for records that 
match specified criteria.  

Apply one filter at a time to a table to show the data you want to see in the 
table. In alarm tables, view data values not included in the table from the 
Details pane of the table.  

Filter the contents of an 
alarm table 
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See also 
Create a filter for a table on page 609 

Change the value of a filter on page 611 

Delete a filter from a table on page 612 

Filters tab on page 609 

Alarm table filters on page 612 

How do I open the Filters tab? 

Select the table on the screen and in the Properties window, click the 
Filters tab. 

Apply filters one at a time to a table. Filters show only the items in a table 
that match the specified criteria. For example, for a large alarm table 
graphic element, create an Alarm State filter with the value Urgent. 
When a table filter is applied on the HMI device, only those alarms in an 
urgent state appear in the table.  

Create a filter for data values even if the data is not configured to appear 
as a column in the table. For alarm tables, look in the Details pane to see 
the data values available for the selected alarm. 

Use the Filters tab to: 

• Create a filter 
• Change the value of a filter 
• Delete a filter 

See also 
Create a filter for a table on page 609 

Change the value of a filter on page 611 

Delete a filter from a table on page 612 

Alarm Manager on page 586 

Alarm Summary on page 571 

Create filters to display only those records or rows in a table that match 
specified criteria. For example, create an Alarm State filter and specify 
Unacknowledged as the value for the filter. On the HMI device, when 
the user applies the Alarm State: Unacknowledged filter, the table 
returns only unacknowledged alarms. If a filter is created without a value, 
the filtered table returns only those records that have no value for the 
filter data. For example, in an Alarm Summary table, create a Message 
filter without specifying a value. The filter returns only the alarms where 
the message is blank. If no alarm in the table has a blank message, the 
filter returns no alarms.  

Filters are available in the Filter list of the table on the HMI device. There 
is no limit to the number of filters for a table. Apply only one filter at a time.  

Filters tab 

Create a filter for a table 
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To create a table filter 
1. On the screen, select the table. 
2. In the Properties window, select the Filters tab.  
3. Select Add Filter.  
4. Scroll to select the data item to filter the table. A filter card 

appears. The selected filter card is outlined in blue.     
5. Select or enter the value of the filter.   

• Select a value. For filters requiring a selected value, a Select 
filter value list appears below the filter. Select the value. For 
example, to display only alarms in the In Alarm state, for an 
Alarm State filter, select In Alarm. The filter returns any record 
with an In Alarm state (including In Alarm, Acknowledged and In 
Alarm, Unacknowledged alarms).  

• Enter a value. For filters requiring a manually entered value, an 
empty box appears below the selected filter. Type the value. For 
example, for an Alarm Name filter, type the value 
"Bottling_Line_A." This filter returns any alarm named 
Bottling_Line_A. Typing only a portion of the value, such as 
"Bottling," returns rows containing "Bottling_Line_A." Spaces 
are considered characters. Consider this when creating a filter 
for a field such as Message, which supports spaces. 

 
Tips:  
• Filters for a table are saved automatically.  
• The value field is in error when the filter does not have a valid value. Close and reopen the Filters 

tab to see the value field outlined in red.   
• If the value of the filter is too long to display in the card heading, ellipses (...) appear at the end of 

the filter name.   
• Set the default filter for an alarm table by entering the number of the filter in the FilterIndex 

property for the alarm table. The number of a filter is the order the filter appears on the Filters tab. 
The third filter is filter 3. Entering 3 in the FilterIndex property initially filters the alarm table by 
that filter on the HMI device.  

See also 
Change the value of a filter on page 611 

Delete a filter from a table on page 612 

Filters tab on page 609 

Alarm Manager on page 586 

Alarm Summary on page 571 

Set the default filter for an alarm table to initially display certain alarms on 
the HMI device. When the alarm table opens on the HMI device, only 
those records or rows that match the criteria of the filter appear in the 
table. Select another filter on the HMI device to filter other alarms or 
display all alarms. 

Prerequisite  
• Create a filter for the table. 

Specify the default filter for 
a table 
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To specify the default filter for a table 
1. On the screen, select the table. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category. 
4. In the FilterIndex property, enter the numeric value of the filter. 

 
Tip: The number of a filter is the order the filter appears on the Filters tab. The third filter is 
filter 3. Entering 3 in the FilterIndex property initially filters the alarm table by that filter on 
the HMI device.  

See also 
Create a filter for a table on page 609 

Create an alarm screen on page 565 

Display alarms on page 563 

Alarm table filters on page 612 

Change a filter value to change the displayed alarm rows. The table 
returns rows when selecting a filter on the HMI device, such as a Priority 
filter that returns urgent alarms in an alarm table. For example, change 
value of that filter to return high priority alarms instead. Deleting or 
selecting no value for a filter filters the table to return only those records 
that have no value for the filter data. For example, in an Alarm Summary 
table, change a Message filter to have no value. The filter returns only 
the alarms with message data that is blank. If no alarm in the table has a 
blank message, the filter returns no alarms.  

Changing the data on which a filter is based is not supported. For 
example, a Priority filter is unable to change to a Message filter. Only 
change the value used to return table rows when the filter is applied. To 
change data for a filter, delete the filter and create a new one.   

To change the value of a filter  
1. On the screen, select the alarm table.  
2. In the Properties window, select the Filters tab. Collapsed filter 

cards show both the filter and the value in the card heading. 
3. To expand the filter card, select Show/Hide  next to the filter 

card. The selected filter card is outlined in blue and contains only 
the filter in the card heading.     

4. To change the value of a filter, select or enter a new value for the 
filter: 
• Select a value. For filters requiring a selected a value, a list 

appears after the current value of the filter. Select a different 
value for the filter.   

• Enter a value. For filters requiring a manually entered value, in 
the list, select the current value and type a new value. 

Change the value of a filter 
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Tips:  
• Changes made to filters are applied to the table automatically. 
• If there is not a valid value entered for the filter, the value field is in error. Close and reopen the 

Filters tab to observe the value field outlined in red. 
• If the value of the filter is too long to display in the card heading, ellipses (...) appear at the end of 

the filter name. 

See also 
Create a filter for a table on page 609 

Delete a filter from a table on page 612 

Filters tab on page 609 

Alarm Manager on page 586 

Alarm Summary on page 571 

On an HMI device, filters are displayed in a Filter list in a table. Delete 
filters that no longer apply to a table.  For example, delete a Priority filter 
that allows users to sort an alarm table based on alarm priority.     

To delete a filter from a table 
1. On the screen, select the table.  
2. In the Properties window, select the Filters tab. Collapsed filter 

cards display the filter and its value in the card heading. This 
eliminates the need to expand the card to verify the value of the 
filter before deleting the filter.   

3. In the heading of the filter card to delete, select Delete . 

 
Tip: Changes to filters are applied to the table automatically. 

See also 
Create a filter for a table on page 609 

Change the value of a filter on page 611 

Filters tab on page 609 

Alarm Manager on page 586 

Alarm Summary on page 571 

Create filters for an alarm table added to the screen from the Toolbox. 
Add and delete filters from both user-created and predefined alarm 
tables. These are the filters for the Alarm Summary, Alarm Manager 
and Alarm History tables to add to the screen. The records returned 
depend on the criteria selected when creating the filter. For example, 
creating a Priority filter with the value Urgent returns rows with urgent 
priority alarms. Filter alarms using these fields: 

• Alarm Class 
• Alarm Name 
• Alarm Group 

Delete a filter from a table 

Alarm table filters 
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• Alarm State 
• Condition Name 
• Event Category 
• Inhibit State 
• Limit Value Exceeded 
• Message 
• Priority 
• Quality 
• Severity 
• State Change Type (Alarm History Viewer only) 
• Tag 1 Value 
• Tag 2 Value 
• Tag 3 Value 
• Tag 4 Value 

Alarm tables in the predefined AlarmSummary, AlarmManager and the 
Alarm History screens contain default filters with predefined criteria to 
return alarm rows on the HMI device.  

The filters and their criteria (filter: criteria) for alarm tables on the 
predefined Alarm Summary and Alarm Manager tables are:  

• Alarm State: In Alarm 
• Alarm State: In Alarm, Acknowledged 
• Alarm State: In Alarm, Unacknowledged 
• Alarm State: Normal, Unacknowledged 
• Alarm State: Unacknowledged 
• Inhibit State: Bad Quality (Alarm Manager only) 
• Inhibit State: Disabled 
• Inhibit State: Shelved 
• Inhibit State: Suppressed 
• Priority: High 
• Priority: Low 
• Priority: Medium 
• Priority: Urgent 

The filters and their criteria (filter: criteria) for the predefined Alarm 
History table are: 

• Alarm State - In Alarm 
• Inhibit State - Bad Quality 
• Inhibit State - Disabled 
• Inhibit State - Shelved 
• Inhibit State - Suppressed 
• Priority - High 
• Priority - Urgent 
• State Change Type - Acknowledged 
• State Change Type - Alarm Counter Reset 
• State Change Type - Configuration Changed 
• State Change Type - Disabled 
• State Change Type - Enabled 
• State Change Type - Fault 
• State Change Type - In Alarm 
• State Change Type - Return to Normal 
• State Change Type - Shelved 
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• State Change Type - Unshelved 
• State Change Type - Unsuppressed 

See also 
Create a filter for a table on page 609 

Change the value of a filter on page 611 

Delete a filter from a table on page 612 

Filters tab on page 609 
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Chapter 20 

Display Automatic Diagnostics 

Display automatic diagnostics to monitor and manage Rockwell 
Automation hardware diagnostics. View Designer provides a default 
Automatic Diagnostics screen, and an Automatic Diagnostics 
History screen. Change Automatic Diagnostics screen or add 
automatic diagnostics table graphic element to a new screen to create 
your own automatic diagnostics screen.  

View Designer requires no configuration to display automatic diagnostics 
on the HMI device. The HMI device automatically collects diagnostic 
events from Logix 5000 controllers. Use Logix 5000 controller and Studio 
5000 Logix Designer to configure hardware or to turn off Automatic 
Diagnostics. 

See also 
Automatic Diagnostics overview on page 615 

Properties for Automatic Diagnostics and Automatic Diagnostics 
History tables on page 617 

Automatic Diagnostics on page 621 

Automatic Diagnostics History on page 625 

 

By default, new projects contain an Automatic Diagnostics screen with 
an Automatic Diagnostics table, and an Automatic Diagnostics History 
screen with an Automatic Diagnostics History table. These screens exist 
in the Predefined Screens folder of the Project Explorer. New projects 
have shortcuts to the predefined Automatic Diagnostics and 
Automatic Diagnostics History screens. 

You can create your own diagnostics screens by using Automatic 
Diagnostics and Automatic Diagnostics History graphic elements 
from the Toolbox. 

Automatic Diagnostics of hardware configured in your Logix controllers 
automatically appear on the Automatic Diagnostics and Automatic 
Diagnostics History. No additional configuration in View Designer is 
needed. 

Rockwell Automation recommends that an automatic diagnostics table 
be the only graphic element on a screen.  

Available operations depend on the Automatic Diagnostics screen: 

Operation Automatic Diagnostics 

Suppress  

Display Automatic 
Diagnostics 

Automatic Diagnostics 
overview 
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Operation Automatic Diagnostics 

Unsuppress  

In View Designer, automatic diagnostics tables contain sample data 
representative of the data an automatic diagnostics table may display. 
The sample data inserts data of average length into the default columns 
in the automatic diagnostics table. Sample data appears in order to 
configure the automatic diagnostics table. Use sample data to determine 
and change column width, font, font size, and padding around content. 
Changes to font and padding properties do not appear in the Details 
pane of an automatic diagnostics table.  

Automatic Diagnostics tables scale to the size of the target HMI device. 
When you download a project to a different size HMI device, default 
automatic diagnostics tables may not provide the best results on the new 
HMI device screen.  

Large automatic diagnostics tables are designed for ten-inch or larger 
HMI device screens, while medium automatic diagnostics tables are 
designed for six- to nine-inch HMI device screens. The size of an 
automatic diagnostics table does not affect the number of automatic 
diagnostics the table displays. When you download a project to an HMI of 
a different size, Rockwell Automation recommends replacing the 
automatic diagnostics tables in the project. Open the existing automatic 
diagnostics screens, delete the existing automatic diagnostics tables 
from the screens, and add the correct size automatic diagnostics tables 
for the new HMI device. 

See also 
Display Automatic Diagnostics on page 615 

Create an Automatic Diagnostics screen on page 616 

Automatic Diagnostics statuses on page 621 

Create an Automatic Diagnostics screen to view Rockwell Automation 
hardware diagnostics on the HMI device. Automatic Diagnostics 
screens receive diagnostics data automatically. There is no configuration 
required in View Designer. 

By default, an Automatic Diagnostics screen and an Automatic 
Diagnostics History screen are included in the Predefined Screens 
folder of each Project Explorer for each project. When creating a 
custom automatic diagnostics screen, make the automatic diagnostics 
table the only graphic element on the screen. Do not add an automatic 
diagnostics table to a popup or the System Banner. Add an automatic 
diagnostics table to a screen only.   

To create an Automatic Diagnostics screen 
• In the Automatic Diagnostics category of the Toolbox, drag and 

drop the automatic diagnostics table graphic element onto the 
screen. 

Create an Automatic 
Diagnostics screen 
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Tips:  
• Change the appearance of an automatic diagnostics table in the Properties pane. For example, to 

ensure an automatic diagnostics table contains readable content and has a row height that you 
can tap on the HMI device, change the font size and padding of the table cells. For an Automatic 
Diagnostics, change the number and content of columns. 

• Select filters to return automatic diagnostics meeting filter criteria on Automatic Diagnostics 
screen on the HMI device. 

 

See also 
Properties for Automatic Diagnostics and Automatic Diagnostics 
History tables on page 617 

How do I open Properties tab 

On the Properties window, click the Properties tab. 

 

Use these properties to customize the Automatic Diagnostics or 
Automatic Diagnostics History table. These properties are categorized by 
Type, General, Security, Appearance, and Position and Size. 

Configure properties to change the displayed font, font size, and row 
padding (the distance between cell content and cell borders) in a table. 
Font size affects row height. Padding makes tapping rows feasible on an 
HMI device. Using a small font size and no padding makes it difficult to 
tap a single row in an alarm table on the HMI device. Row height is 
determined by the FontSize property value and twice the value of the 
RowPadding property. The default FontSize (nine points) and 
RowPadding (14 pixels) property values result in an approximate row 
height of one-third inch. There is no minimum or maximum font size or 
row padding. To be able to tap single alarm rows on the HMI device, 
specify optimal font sizes and row padding for a table. 

To configure Automatic Diagnostics table rows for readability and 
touch 

1. On the screen, select the Automatic Diagnostics or Automatic 
Diagnostics History table. 

2. In the Properties window, click the Properties tab. 
3. Expand the Appearance node.  
4. Ensure that the automatic diagnostics table is readable and allows 

enough room within rows for touch. 
5. Configure the properties: 

• Font Name. Select a font.  
• Font Size. Enter a font size readable for users on the HMI 

device.  
• Row Padding. In pixels, enter the distance between the cell 

content and the cell border.  
The sample data of the automatic diagnostics table reflects the selected 
FontName, FontSize, and RowPadding property values. The changes 
also appear in the automatic diagnostics table on the HMI device. The 

Properties for Automatic 
Diagnostics and Automatic 
Diagnostics History tables 

Configure automatic 
diagnostics table rows for 
readability and touch 
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Details pane of an automatic diagnostics table does not reflect changes 
to these properties. 

See also 
Properties for Automatic Diagnostics and Automatic Diagnostics 
History tables on page 617 

Change the opacity level of a table to adjust the transparency. 

To change the opacity of a table 
1. On the screen, select the Automatic Diagnostics or Automatic 

Diagnostics History table. 
2. In the Properties window, click the Properties tab. 
3. Expand the Appearance category. 
4. In the Opacity box, enter a percentage, where 0 is fully 

transparent and 100 is fully opaque. 

See also 
Properties for Automatic Diagnostics and Automatic Diagnostics 
History tables on page 617 

Specify if an automatic diagnostics table is always visible on the HMI 
device screen.  

To specify the visibility of a table 
1. On the screen, select the Automatic Diagnostics or Automatic 

Diagnostics History table. 
2. In the Properties window, click the Properties tab. 
3. Expand the Appearance category. 
4. In the Visible box, select an option: 

• Visible (selected) 
• Not visible (cleared)  

See also 
Properties for Automatic Diagnostics and Automatic Diagnostics 
History tables on page 617 

Determine how table content is initially sorted on the HMI device screen. 
Specify which columns to sort and in which order, and whether to sort the 
contents of a column in ascending or descending order.      

To specify the default sort order of table contents 
1. On the screen, select the Automatic Diagnostics or Automatic 

Change the opacity of 
Automatic Diagnostics or 
Automatic Diagnostics 
History table 

Specify the visibility of 
Automatic Diagnostics or 
Automatic Diagnostics 
History table 

Specify the default sort 
order of Automatic 
Diagnostics or Automatic 
Diagnostics History table 
contents 
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Diagnostics History table. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category.  
4. Enter columns and their order, in the SortOrder box 

• A valid column number, colon, and a D for descending or A for 
ascending. For example, 1:D,2:D provides a primary sort of 
Column 1 in descending order, and a secondary sort of Column 
2 in descending order. You can enter a value for each column in 
the table. 

See also 
Properties for Automatic Diagnostics and Automatic Diagnostics 
History tables on page 617 

How do I open the Columns tab? 

Select the table on the screen and in the Properties pane, click the 
Columns tab. 

A table graphic element displays columns of data.  

Use the Columns tab to: 

• Add or delete columns. 
• Change the order of columns. 
• Change the width of columns. 

See also 
Properties for Automatic Diagnostics and Automatic Diagnostics 
History tables on page 617 

Add a column to the Automatic Diagnostics or Automatic 
Diagnostics History tables on page 619 

Change the width of a column in Automatic Diagnostics or 
Automatic Diagnostics History table on page 620 

Change the order of columns in Automatic Diagnostics or 
Automatic Diagnostics History table on page 620 

Delete a column from a table on page 620 

New columns in tables appear on the right side of the table with sample 
data inserted into each column. Sample data is a representative of the 
length of data in a column. Use sample data to determine the column 
width. 

To add a column to the Automatic Diagnostics or Automatic 
Diagnostics History tables 

1. On the screen, select the Automatic Diagnostics or Automatic 
Diagnostics History table. 

2. In the Properties window, select the Columns tab.  

Columns tab 

Add a column to the 
Automatic Diagnostics or 
Automatic Diagnostics 
History tables 
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3. Select Add Column.  
4. Select the data to display in the column. The selected column 

appears in the new card heading. Change the width of a column to 
display the data.     

Change the width of a column in either Automatic Diagnostics or 
Automatic Diagnostics History table if the data in the column is wider 
than the width of the column. Use the sample data inserted in a column to 
determine the column width. The sample data is representative of the 
length of data anticipated for a column.   

To change the width of a column in a table 
1. On the screen, select the Automatic Diagnostics or Automatic 

Diagnostics History table. 
2. In the Properties window, select the Columns tab.  
3. In the column card, click Show/Hide  to expand the column 

card. The selected column card is outlined in blue.  
4. In the Width field at the bottom of the column card, enter a positive 

number, representing the width of the column, in pixels. 
Changes to column width are saved automatically. The last 
column added fills the remaining space in the row. If the total width 
of all columns exceeds the width of the table, a horizontal scroll 
bar appears at the bottom of the table.  

 
Tip: When resizing a column in a table, leave some space between the text of the column 
heading and the border of the column. If the text of a column heading appears at the column 
border, the text of the column heading may appear clipped in the Automatic Diagnostics or 
Automatic Diagnostics History table on the HMI device. 

 

The columns of the automatic diagnostics tables on the predefined 
Automatic Diagnostics and Automatic Diagnostics History screens 
appear in a default order. The screen is located in the Predefined 
Screens folder of the Project Explorer.  

To change the order of columns in a table 
1. On the screen, select the Automatic Diagnostics or Automatic 

Diagnostics History table. 
2. In the Properties window, select the Columns tab. 
3. Point to the column card heading and select Move column up  

or Move column down  to move the column higher (to the left) 
or lower (to the right) in the table. Changes made to the order of 
columns are depicted in the table on the screen. 

Delete a column to remove it from the Automatic Diagnostics or 
Automatic Diagnostics History table. This removes unwanted data from 
the table and provides room for other data that may be more pertinent. 
You cannot change the data a column shows. By default, Column 1 in 
the predefined Automatic Diagnostics or Automatic Diagnostics History 
table of a project shows the automatic diagnostics state. You cannot 
change column data from Automatic Diagnostics State to Comments or 
any other data.  

Change the width of a 
column in Automatic 
Diagnostics or Automatic 
Diagnostics History table 

Change the order of 
columns in Automatic 
Diagnostics or Automatic 
Diagnostics History table 

Delete a column from a 
table 
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To delete a column from a table 
1. On the screen, select the Automatic Diagnostics or Automatic 

Diagnostics History table. 
2. In the Properties window, select the Columns tab.  
3. In the heading of the column card, select Delete . 

Automatic Diagnostics tables display 4 diagnostics statuses: 

• Active, Unsuppressed that shows the default state where the 
message appears for the first time. This state informs that a fault is 
present and requires immediate action. 

• Active, Suppressed shows the state where the fault still exists, 
but it has already been noticed and suppressed by using the 
Suppress command, so it may not require immediate 
intervention. This is useful for control system equipment which is 
under maintenance to temporarily ignore the faults from that 
equipment. 

• Inactive, Suppressed shows that the fault no longer exists, but 
the diagnostics remains in the list until an Unsuppress operation 
is performed, usually without maintenance intervention. 

• Inactive, Unsuppressed shows that the fault does not occur and 
the diagnostics is not in suppressed state. It appears only in the 
historical diagnostic data for information about fault resolution 
time. 

View Designer has an Automatic Diagnostics lists that displays the 
diagnostics in a project or configured HMI device. Each project contains 
an Automatic Diagnostics screen by default. Create an additional 
screen with an Automatic Diagnostics graphic element to create a 
custom Automatic Diagnostics screen.  

Diagnostics in the project have the status of either Active or Inactive, 
Suppressed. View the Details pane of the Automatic Diagnostics 
screen to see data such as Message, Event Time, Diagnostic Code. 

Use automatic diagnostics on an HMI device to:  

• Suppress a diagnostic. 
• Unsuppress a diagnostic. 

See also 
Display Automatic Diagnostics on page 615 

Automatic Diagnostics overview on page 615 

Automatic Diagnostics statuses on page 621 

Automatic Diagnostics 
statuses 

Automatic Diagnostics 

Automatic Diagnostics 
contents for a medium HMI 
device screen 
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The Automatic Diagnostics Viewer Medium table appears on the 
predefined Automatic Diagnostics screen. This screen is in the 
Predefined Screens folder of the Project Explorer. The table is 
recommended for six- to nine-inch HMI device screens. Create an 
Automatic Diagnostics Medium table with customized appearance and 
content, or change the Automatic Diagnostics Medium table on the 
predefined Automatic Diagnostics screen. 

 
 

Item Description 

 
The list of automatic diagnostics state change records from the HMI device. 

 
Filter list. Select a filter on the HMI device to switch between the list of diagnostics in the respective state. For example, select 
Suppressed to show only those diagnostics that are in the suppressed state.  

 
Buttons to perform actions available for the Automatic Diagnostics Viewer: 

 
Details hides or shows the Details pane, which contains the details of the last selected automatic diagnostics. The 
Details pane replaces the list of diagnostics in medium automatic diagnostics tables. If no record is selected, the 
Details pane is empty. 

 
Select All selects all of the diagnostics in the Automatic Diagnostics table, including those not displayed on the current 
page of diagnostics. 

 
Deselect All deselects all diagnostics in the Automatic Diagnostics table, including those not displayed on the current 
page of diagnostics. 

 
Select Page selects all of the diagnostics displayed on the current page of diagnostics. 

 Suppress places the selected diagnostics event in the suppressed state. 

 Unsuppress places the selected diagnostics event in the unsuppressed state. 

 
Help opens the Help popup. This popup displays a legend of icons and the task each button on a diagnostics table 
performs. 

 
The number of Active, Unsuppressed; Active, Suppressed and Inactive, Suppressed diagnostics in the Automatic Diagnostics 
table. 

 

The Automatic Diagnostics Viewer Large table appears on the 
predefined Automatic Diagnostics screen. This screen is in the 
Predefined Screens folder of the Project Explorer. The table exists for 
ten-inch or larger HMI device screens. Create an Automatic 
Diagnostics Large table with customized appearance and content, or 

Automatic Diagnostics 
contents for a large HMI 
device screen 
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change the Automatic Diagnostics Large table on the predefined 
Automatic Diagnostics screen.  

 
 

Item Description 

 
The list of automatic diagnostics state changes records from the terminal. 

 
Filter list. Select a filter on the HMI device to switch between the list of diagnostics in the respective state. For example, 
select Suppressed to show only diagnostics in the suppressed state.  

 
Buttons to perform actions available for the Automatic Diagnostics Viewer: 

 
Details hides or shows the Details pane, which contains the details of the last selected automatic diagnostics. 
The Details pane appears on the bottom half of large diagnostics tables. If no record is selected, the Details 
pane is empty. 

 
Select All selects all of the diagnostics in the diagnostics table, including those not displayed on the current 
page of diagnostics. 

 
Deselect All deselects all diagnostics in the diagnostics table, including those not displayed on the current 
page of diagnostics. 

 
Select Page selects all of the diagnostics displayed on the current page of diagnostics. 

 Suppress places the selected diagnostics event in the suppressed state 

 Unsuppress places the selected diagnostics event in the unsuppressed state 

 
Help opens the Help popup. This popup displays a legend of icons and the task each button on an diagnostics 
table performs. 

 

Select Details  on an automatic diagnostics table to open the 
Details pane. 

In a medium Automatic Diagnostics table intended for HMI devices with 
seven- to nine-inch screens, the Details pane replaces the list of 
automatic diagnostics in the table. In a large Automatic Diagnostics table 
intended for HMI devices with ten-inch or larger screens, the Details 
pane opens at bottom of the automatic diagnostics table. 

Details pane for Automatic 
Diagnostics 
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Item Description 

 
The Details pane with additional details for the selected 
automatic diagnostics. This pane displays data, such as 
Message, Event Time, Diagnostic Code. When multiple 
diagnostics are selected, details display for the last 
selected automatic diagnostics.  

The contents of the Details pane appears in rows. 

Row Description 

Message The message with a fault description.  
Device Name The name of the controller for which automatic diagnostics 

occurred. 
Product Name The name of the Rockwell Automation application for which 

automatic diagnostics occurred.   
Event Time The date and time the automatic diagnostics event 

occurred.  
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Row Description 

State The state of an automatic diagnostic. 
Diagnostics Code The message defining what type of diagnostics occurred. 
Resource The resource that reports a fault. 
Catalog The device catalog number.  
Product Type The type of a product that provides detailed information 

about the device that reports a fault. 
Vendor The vendor of a device that reports a fault. 
Version The firmware version of a device for which automatic 

diagnostics are reported. 

 

Specify which users have access to perform certain operations in an 
Automatic Diagnostics table. To enable all users to perform an operation, 
set security access to Full Access. For example, determine that all 
users have access to suppress an automatic diagnostic. In this case, set 
the access for SuppressAccess to Full Access. Alternatively, 
determine that security access for suppressing an automatic diagnostic 
depends on the user role. In this case, set the Access properties to 
Inherit. Inherited access levels include Full Access, Read-Only, or No 
Access.  

To specify access to operations performed on an Automatic 
Diagnostics table  

1. On the screen, select the Automatic Diagnostics table. 
2. In the Properties window, select the Properties tab. 
3. Expand the Security node. 
4. Locate the property for the button to set access:     

• SuppressAccess. Sets access for Suppress on the selected 
Automatic Diagnostics table. This button changes the automatic 
diagnostics state to suppressed. 

• UnsuppressAccess. Sets access to Unsuppress on the 
selected Automatic Diagnostics table. This button changes the 
automatic diagnostics state to unsuppressed. 

5. For both properties, select an option:  
• Full Access. Grants all users access to the button.  
• Inherit. Specifies that the button inherits access from the 

screen.       
Inherited access for a user role can be Full Access, Read-Only, 
or No Access. If a button inherits Read-Only access, hash 
marks appear across the button on the HMI device. An error 
appears if the user selects the button. If a button inherits No 
Access from the screen, the user does not have access to the 
screen containing the Automatic Diagnostics table. In this case, 
the screen does not appear in the Navigation menu. 

 

Use the Automatic Diagnostics History on an HMI device to review the 
historical diagnostics records showing diagnostics state changes. 
Automatic Diagnostics History lists diagnostics state change records 

Specify access to 
operations performed on 
Automatic Diagnostics table  

Automatic Diagnostics 
History 
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from the diagnostics log. A diagnostic log record appears in a row. 

The Automatic Diagnostics History displays the history of diagnostics 
state changes available when you open the Automatic Diagnostics 
History screen. Close and reopen the screen or select Refresh  to 
load the latest diagnostics state changes.  

View Designer retains diagnostics state history after: 

• Rebooting or powering off the HMI device. 
• Loading a new project. 
• Disconnecting a controller from the HMI device. 
• Replacing a controller.  
• Having a controller recover from a fault. 
• Downloading a new program from a controller connected to the 

HMI device. 
• Clearing the diagnostics log on a controller connected to the HMI 

device.  

 
Tip: In the rare case of the diagnostics history database being corrupted, the operator does 
not see any records in the Automatic Diagnostics History viewer. Diagnostic state changes 
still occur. If you do not see any records, remote the HMI device. 

 

PanelView terminals display up to 1,000 historical diagnostics state 
changes. This limit does not change with the number of controllers 
connected to the PanelView terminal. After exceeding the limit, new 
records replace the oldest diagnostics records. 

See also 
Display Automatic Diagnostics on page 615 

Automatic Diagnostics overview on page 615 

Automatic Diagnostics statuses on page 621 

 

Automatic Diagnostics 
History contents for a 
medium HMI device screen 
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The Automatic Diagnostics History Viewer Medium table appears on 
the predefined Automatic Diagnostics History screen. This screen is in 
the Predefined Screens folder of the Project Explorer. The table is 
recommended for six- to nine-inch HMI device screens. Create an 
Automatic Diagnostics History Medium table with customized 
appearance and content or change the Automatic Diagnostics History 
Medium table on the predefined Automatic Diagnostics History 
screen.  

 
 

Item Description 

 
The list of automatic diagnostics state changes records from the terminal. 

 
 

Buttons to perform actions available for the Automatic Diagnostics History Viewer: 

 
Details hides or shows the Details pane, which contains the details of the last selected automatic 
diagnostics state change record. The Details pane replaces the list of diagnostics in medium 
automatic diagnostics tables. If no record is selected, the Details pane is empty. 

 Refresh loads the latest diagnostics state changes from the automatic diagnostics history. The 
operator has to refresh the table to see the latest changes. To display the latest state changes, close 
and reopen the Automatic Diagnostics History viewer. 

 
Help opens the Help popup. This popup displays a legend of icons and the task each button on an 
automatic diagnostics history table performs. 

 

 

Automatic Diagnostics 
History contents for a large 
HMI device screen 
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The Automatic Diagnostics History Viewer Large table appears on 
the predefined Automatic Diagnostics History screen. This screen is in 
the Predefined Screens folder of the Project Explorer. The table exists 
for ten-inch or larger HMI device screens. Create an Automatic 
Diagnostics History Large table with customized appearance and 
content or change the Automatic Diagnostics History Large table on 
the predefined Automatic Diagnostics History screen.  

 
 

Item Description 

 
The list of automatic diagnostics state changes records from the terminal. 

 
 

Buttons to perform actions available on the Automatic Diagnostics History table: 

 
Details hides or shows the Details pane, which contains the details of the last selected automatic 
diagnostics state change record. The Details pane appears on the bottom half of large automatic 
diagnostics history tables. If no record is selected, the Details pane is empty. 

 Refresh loads the latest diagnostics state changes from the automatic diagnostics history. The 
operator has to refresh the table to see the latest changes. To display the latest state changes, close 
and reopen the Automatic Diagnostics History viewer. 

 
Help opens the Help popup. This popup displays a legend of icons and the task each button on an 
automatic diagnostics table performs. 

 

 

 

Select Details  on an automatic diagnostics history table to open the 
Details pane. 

Details pane for Automatic 
Diagnostics History 
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In a medium Automatic Diagnostics History table intended for HMI 
devices with seven-inch to nine-inch screens, the Details pane replaces 
the list of automatic diagnostics in the table. In a large Automatic 
Diagnostics History table intended for HMI devices with ten-inch or larger 
screens, the Details pane opens at bottom of the automatic diagnostics 
table. 

 
 

Item Description 

 
The Details pane with additional details for the selected 
automatic diagnostics history. This pane displays data, 
such as Message, Event Time, Diagnostic Code and State 
Change. When multiple diagnostics are selected, details 
display for the last selected automatic diagnostics.  

 
Buttons to perform operations on diagnostics in the 
Automatic Diagnostics History table. 

The contents of the Details pane appears in rows. 

Row Description 

Message The message with a fault description.  
Device Name The name of a controller for which the automatic 

diagnostics occurred for.  
Product Name The Rockwell Automation product for which the diagnostics 

occurred for.  
Event Time The date and time the automatic diagnostics event 

occurred.  
State The state of an automatic diagnostic. 
State Change The last state change performed on the diagnostics. 
Diagnostics Code The type of diagnostics that occurred. 
Resource The resource that reports a fault. 
Catalog The device catalog number.  
Product Type The detailed information about the device that reports the 

fault. 
Vendor The vendor of the reporting device. 
Version The firmware version of the reporting device.  
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Help popup 
The Help popup opens when pressing Help  on an HMI device. This 
popup shows a legend of icons that appear on the automatic diagnostics 
screens and the task each button on an automatic diagnostics table 
performs. The functions vary depending on the selected diagnostics 
table. 

Help popup for Automatic Diagnostics table: 

 
Help popup for Automatic Diagnostics History table: 

 
 

Item Description 
 

 
Help popup. 
 

 
 

A legend for automatic diagnostics functions you can perform on the automatic diagnostics table.The functions you can 
perform vary depending on the selected automatic diagnostics table: 
 

 Active, Unsuppressed displays the default state in which the message appears for the first time. 
This state informs that a fault occurs and requires immediate action. 

 Active, Suppressed displays the state in which the fault still exists. This state has already been 
viewed and suppressed by the user, so it may not require immediate attention, 

 Inactive, Unsuppressed indicates that the fault does not occur and that diagnostics are not in 
the suppressed state. The fault appears only in the historical diagnostic data regarding fault 
resolution time. 

 Inactive, Suppressed displays that the fault no longer exists, but the diagnostics remains in the 
list until an Unsuppress operation is performed, usually without maintenance intervention. 

 
Details hides or displays the Details pane, which contains the details of the last selected 
automatic diagnostics state change record. The Details pane replaces the list of diagnostics in 
medium automatic diagnostics tables. If no record is selected, the Details pane is empty. 

 
Select All selects all of the diagnostics in the automatic diagnostics table, including those 
diagnostics displayed on the current page of diagnostics. 

 
Deselect All deselects all diagnostics in the automatic diagnostics table, including those 
diagnostics displayed on the current page of diagnostics. 

 
Select Page selects all of the diagnostics on the current page of diagnostics. 
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Item Description 
 

 Suppress places the diagnostics event in the suppressed state.  

 Unsuppress places the diagnostics event in the unsuppressed state. 

 Refresh loads the latest automatic diagnostics state changes from the automatic diagnostics 
history. To display the latest state changes, close and reopen the Automatic Diagnostics History 
viewer. 

 
Help opens the Help popup. This popup displays a legend of icons and the task each button on a 
diagnostics table performs. 

 

See also 
Display Automatic Diagnostics on page 615 

Automatic Diagnostics overview on page 615 

Filter the contents of Automatic Diagnostics 
A filter is applied to a table to show only the automatic diagnostics 
records that match specified statuses.  

Apply one filter at a time to a table to show the data that you want to see 
in the table. In automatic diagnostics tables, view data values not 
included in the table from the Details pane of the table.  

See also 
Specify the default filter for an automatic diagnostics table on page 
631 

Filter Automatic Diagnostics on page 632 

Automatic Diagnostics on page 621 

Automatic Diagnostics History on page 625 

Set the default filter for an automatic diagnostics table to initially display 
certain diagnostics on the HMI device. When the automatic diagnostics 
table opens on the HMI device, only those records or rows that match the 
status appear in the table. Select another filter on the HMI device to list 
other automatic diagnostics.  

To specify the default filter for a table 
1. On the screen, select the table. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category. 
4. In the FilterIndex property, enter the numeric value of the filter. 

 
Tip: The number of a filter is the order that the filter appears on the Filters tab. The third 
filter is filter 3. Entering 3 in the FilterIndex property initially filters the automatic diagnostics 
table by that filter on the HMI device. Rockwell Automation recommends using the first filter 
in the status Active, Unsuppressed as a default filter. 

Specify the default filter for 
an automatic diagnostics 
table 
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Select filters to display only those records or rows in a table that match 
specified criteria.  

Select (No Filter) to show all messages regardless of their status.  

Select an Active, Unsuppressed automatic diagnostics status to display 
only diagnostics that are active, and informs about a fault that occurs and 
requires immediate action. 

Select Suppressed automatic diagnostics status to display all 
diagnostics that has already been noticed and suppressed by using the 
Suppress command. The diagnostics on this list may or may not require 
immediate intervention. 

 

 

Filter Automatic 
Diagnostics 
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Chapter 21 

Display data on a trend chart 

A trend chart displays data over time in a graphical format. Trend charts 
can display values from tags in a controller, user-defined properties, or 
properties of a graphic element.  For example, a trend chart can monitor 
tank pressure and tank temperature over the course of an hour.  

Use a trend chart to display data on a trace. Specify how data is 
displayed by setting the range of the data and how often the trend chart 
requests data.  

View tag values from a data log on a trend chart by creating traces for the 
tags. Trend charts automatically display data from a data log for the 
specified tag. View the historical data on the HMI device by interacting 
with the trend chart.    

Use a trend chart to: 

• Monitor processes in a manufacturing system  
• Display data from a tag, user-defined property, or the property of a 

graphic element 
• Display up to eight traces that plot data over time to graphically 

present data   
• View, pan, and pause data on the HMI device 

See also 
View trend charts on page 819 

Traces tab on page 633 

Create a basic trend chart on page 634 

Trend chart contents on page 641 

Specify the visibility of a trend chart on page 639 

How do I open the Traces tab? 

Click the trend chart on the screen, and in the Properties pane, click the 
Traces tab.  

Use traces to visually display values on a trend chart. Each trace 
represents a set of data points collected over time.  

Use the Traces tab to:  

• Add or delete traces on a trend chart. 
• Bind to a tag, user-defined property, or property of a graphic 

element containing the data to depict on the trace.  
• Change the appearance of a trace. 
• Label a trace for diagnostic purposes. 

Traces tab 
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For example, using the Traces tab, add a blue trace to monitor the 
pressure of water filling a tank and a red trace to monitor the temperature 
of the water. The resulting trend chart shows, in real-time, the current 
water pressure and water temperature for the tank.  

See also 
Create a basic trend chart on page 634 

Add traces to a trend chart on page 636 

Change the appearance of a trace on page 646 

Delete a trace from a trend chart on page 640 

The trend chart updates every second. Updates occur even if there is no 
sample data to display for the current time span. The time span is the 
length of time shown on the trend chart.  

Each trend chart can display data for up to eight traces. Samples, or data 
values at specific points in time captured at the specified rate, are plotted 
on the trend chart in the specified time span. Traces automatically display 
data from a data log for the specified tag. Samples connect to create a 
linear trace. If there are multiple traces and one or more traces are in 
error, the traces that are in error are not plotted on the trend chart. Traces 
that are not in error plot data on the trend chart. 

For each trace on a trend chart, samples are plotted using a horizontal 
axis representing time and a vertical axis representing the value. By 
default, labels appear on each axis. The time axis shows placeholder 
labels for time and the y-axis shows labels based on the minimum value 
and maximum value of the trend chart. View Designer does not support 
configuring these labels. 

 
Tips:  
• If data is not available for a specific time period, the trend chart displays a gap in the trace. For 

example, the HMI device may temporarily lose connection with a controller.  
• For applications already downloaded to the HMI device, it may take up to the length of the sample 

rate before data shows on the trend chart. For example, if the trend chart has a sample rate of 
30000 milliseconds or 30 seconds, it may take up to 30 seconds before any data shows on the 
trend chart. In some cases, it can take twice the sample rate before data shows on the trend chart. 
For example, if the sample rate is one minute and the application is just being downloaded to the 
HMI device and communication to a controller is being established, it may take an additional 
minute to plot data. No trace appears until there are two data points to plot.  

See also 
Trend chart contents on page 641 

Create a basic trend chart on page 634 

Add traces to a trend chart on page 636 

Change the background color of a trend chart on page 643 

Create a trend chart to display data over time in graphical format. Display 
data on a trend chart by: 

• Setting the minimum and maximum values 

Traces 

Create a basic trend chart 
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• Adding traces 
• Specifying the tag containing the data to depict 
• Changing the appearance of a trend chart 

IMPORTANT A trend chart clears all traces and resumes when the MaxValue, MinValue, or 
Visible property of a trend chart changes on the HMI device. For example, 
changing the MaxValue, MinValue, or Visible property value of a trend chart 
through a Text Input graphic element causes the trend chart, even while 
paused, to resume at the current time. Historical data, if available in a data log, 
appears for data before the current time. The trend chart discards all other 
data and plots new data.  

To create a basic trend chart 
1. In the Trend Charts category of the Toolbox, double-click or drag 

and drop the Trend Chart graphic element onto the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the General category. 
4. In the MaxValue box, type any numeric value greater than the 

MinValue property value.  
5. In the MinValue box, type any numeric value less than the 

MaxValue property value. 
6. Select the Traces tab. 
7. Select Add Trace. 
8. In the Value box, select Browse  and navigate to the tag 

containing the data to depict on the trace, or enter the tag 
manually using the exact tag name and format. 

9. To add additional traces, below the last Trace card, select Add 
Trace, and in the Tag box select the tag for the trace. 

 
Tips:  
• The Value box does not have an initial value. Bind the Value box to a tag in a controller, a 

user-defined property, or a property of a graphic element. Unbinding this property is not 
supported.    

• To customize the appearance of a trend chart, change the properties in the Appearance category 
on the Properties tab in the Properties window.  

• To customize the appearance of a trace on a trend chart, change the properties in Appearance 
category on the Traces tab in the Properties window.  

• Trend charts automatically display data from a data log for the specified tag. Tags may exist in 
more than one data log. The trend chart uses the data log that contains a matching sample rate. If 
there is more than one data log with a matching sample rate or there is no data log with a 
matching sample rate, the trend chart uses the first data log.  

• The range of signed integers that is represented without losing precision is –(2^53)..(2^53). All 
integer values outside this range are rounded to 15 significant digits. For example, 
8765432109876543210 is rounded to 8765432109876540000, losing the precision for the last four 
least significant digits. 

See also  
What is a trend chart? on page 642 

Change the range of data displayed on a trend chart on page 636 

Change the appearance of a trace on page 646 

Change the background color of a trend chart on page 643 

Change how often a trend chart requests data from controllers on 
page 640 
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To display data in a trend chart, add up to eight traces to the trend chart 
in View Designer. Associate each trace with a tag, user-defined property, 
or a property of a graphic element. The trace displays the values of the 
tag on the trend chart on the HMI device. Traces automatically display 
data from a data log for the specified tag.  

To add traces to a trend chart 
1. Select the trend chart on the screen.  
2. In the Properties window, select the Traces tab.   
3. Select Add Trace. A Trace card appears.  
4. In the Value box, select Browse  to navigate to and select the 

tag, or enter the exact tag name and format.  

 
Tip: Do not select a STRING or LINT data type. Trend charts do not support these data types. 
Traces with a STRING or LINT data type display an error.  

See also 
Change the range of data displayed on a trend chart on page 636 

Change the appearance of a trace on page 646 

Delete a trace from a trend chart on page 640 

Trend chart contents on page 641 

Delete a trace from a trend chart on page 640 

Label a trace to identify that trace in error messages. When a trace is in 
error, the error message in the Error list displays the trace label and the 
name of the property placing the trace in error.   

To label a trace for diagnostic purposes  
1. Select the trend chart on the screen.  
2. In the Properties window, select the Traces tab.   
3. Expand the Trace card of the trace.  
4. In the Label box, type a name for the trace.  

See also 
Create a basic trend chart on page 634 

Add traces to a trend chart on page 636 

Delete a trace from a trend chart on page 640 

Change the range of data displayed on a trend chart on page 636 

Hide the axes on a trend chart on page 645 

Change the minimum data value, maximum data value, and time span of 
a trend chart to change the range of data displayed. By default, trend 
charts show data with values between 0 and 100. The default span of 

Add traces to a trend chart 

Label a trace for diagnostic 
purposes 

Change the range of data 
displayed on a trend chart 
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time of a trend chart is one second or 1000 milliseconds. 

IMPORTANT A trend chart clears all traces and resumes when the MaxValue or MinValue property of 
a trend chart changes on the HMI device. For example, changing the MaxValue or 
MinValue property value of a trend chart through a Text Input graphic element causes 
the trend chart, even while paused, to resume at the current time. Historical data, if 
available in a data log, appears for data before the current time. The trend chart 
discards all other data and plots new data. 

To change the range of data displayed on a trend chart  
1. Select the trend chart on the screen.  
2. In the Properties window, select the Properties tab. 
3. Expand the General category.  
4. In the MaxValue box, type any numeric value greater than the 

MinValue property value. 
5. In the MinValue box, type any numeric value less than the 

MaxValue property value. 

 
Tip: The value in the MinValue box must be less than the value in the MaxValue box.  

6. In the TimeSpan box, type the span in seconds. A valid time span 
is between 1 and 3600 seconds. 3600 seconds equals one hour.  

7. In the SampleRate box, type the rate, in milliseconds, at which the 
trend chart requests data from the controller. Valid sample rates 
are between 500 and 60000 milliseconds which equal one-half 
second and 60 seconds.  

 
Tips:  
• If the trend chart requests data more frequently than data updates in the controller, the data 

plotted may not appear in a linear fashion on the trend chart. 
• To avoid slow panning on a trend chart that has a time span over 30 minutes, enter a minimum of 

1000 milliseconds, or 1 second, in the SampleRate box.  
• Trend charts automatically display data from a data log for the specified tag. Tags may exist in 

more than one data log. The trend chart uses the data log that contains a matching sample rate. If 
there is more than one data log with a matching sample rate or there is no data log with a 
matching sample rate, the trend chart uses the first data log. 

• Data displaying in real time on the HMI device uses the sample rate of the trend chart.  
• Data displaying historical values on the HMI device uses the sample rate of the data log for the 

project. 
• The range of signed integers that is represented without losing precision is –(2^53)..(2^53). All 

integer values outside this range are rounded to 15 significant digits. For example, 
8765432109876543210 is rounded to 8765432109876540000, losing the precision for the last four 
least significant digits. 

See also 
Configure property binding to pan to the start time of a trend chart 
on page 638 

Add an event to pan to the start time of a trend chart on page 638 

Add traces to a trend chart on page 636 

What is an event? on page 476 
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Bind the property of a graphic element to the time span of the trend chart. 
The graphic element and trend chart must exist on the same screen. 
Tapping the graphic element on the HMI device pans to the start time of 
the trend chart.  

Configure property binding to pan to the start time of a trend chart 
1. Select the trend chart on the screen.  
2. In the Properties window, select the Properties tab.   
3. Expand the General category.  
4. In the TimeSpanStart box, select the date and time format. 
5. On the same screen as the trend chart, bind the property of a 

graphic element that can write values to the TimeSpanStart 
property of the trend chart. Bind using the format 
Element.Property.  
For example, bind the Text property of a Text Input graphic 
element on the screen to the TimeSpanStart property of the trend 
chart. Use the format TrendChartName.TimeSpanStart. On the 
HMI device, the Text Input displays the time and date of the trend 
chart. Clicking the Text Input graphic element on the HMI device 
opens the virtual keypad and displays the trend chart date and 
time. The format of the date and time depend on the format 
specified in the TimeSpanStart box: 
TimeSpanStart  Date format Time format 

M/dd/yyyy h:mm:ss AP M/dd/yyyy h:mm:ss ap 
dd/M/yyyy hh:mm:ss dd/M/yyyy hh:mm:ss 
yyyy-MM-dd hh:mm:ss yyyy-MM-dd hh:mm:ss 
d MMM yyyy hh:mm:ss d MMM yyyy hh:mm:ss 
M/d/yyyy M/dd/yyyy h:mm:ss ap 
d/M/yyyy dd/M/yyyy hh:mm:ss 
yyyy-MM-dd yyyy-MM-dd hh:mm:ss 
d MMM yyyy d MMM yyyy hh:mm:ss 

 

 
Tips:  
• Data displaying in real time on the HMI device uses the sample rate of the trend chart.  
• Data displaying historical values on the HMI device uses the sample rate of the data log for the 

project.  

See also 
Add an event to pan to the start time of a trend chart on page 638 

Add traces to a trend chart on page 636 

Property-to-property binding on page 510 

Add an event to pan to the start time of the trend chart. Create the event 
for a graphic element that is on the same screen as the trend chart. 
Performing the event on the HMI device pans to the start time of the trend 
chart.  

Configure property binding 
to pan to the start time of a 
trend chart 

Add an event to pan to the 
start time of a trend chart 
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To add an event to pan to the start time of a trend charts 
1. Select the trend chart on the screen.  
2. In the Properties window, select the Properties tab.   
3. Expand the General category.  
4. In the TimeSpanStart box, select the date and time format. 
5. Create an event for a graphic element on the screen. 
6. Add a Value Write command to the event.  
7. In the Write To box of the command, enter the binding using the 

format TrendChartName.TimeSpanStart. 
8. In the Expression box, type the start time using the same format 

specified in the TimeSpanStart box, or bind to a tag with that 
same date and time format. 

 
Tips:  
• Data displaying in real time on the HMI device uses the sample rate of the trend chart.  
• Data displaying historical values on the HMI device uses the sample rate of the data log for the 

project.  

See also 
Change the range of data displayed on a trend chart on page 636 

Add traces to a trend chart on page 636 

Configure property binding to pan to the start time of a trend chart 
on page 638 

What is an event? on page 476  

Specify if a trend chart is always visible on the HMI device screen. To 
display the trend chart only when the specified tag value is true, bind the 
visibility of the trend chart. For example, bind the Visible box to a tag to 
indicate a problem in the manufacturing system. Binding the Visible box 
of a trend chart to a tag value displays the trend chart on the HMI device 
when the tag is true. 

IMPORTANT A trend chart clears all traces and resumes when the MaxValue or MinValue property of 
a trend chart changes on the HMI device. For example, changing the MaxValue or 
MinValue property value of a trend chart through a Text Input graphic element causes 
the trend chart, even while paused, to resume at the current time. Historical data, if 
available in a data log, appears for data before the current time. The trend chart 
discards all other data and plots new data. 

To specify the visibility of a trend chart 
1. On the screen, select the trend chart. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category. 
4. Specify the visibility: 

• Select the Visible box to make the trend chart visible on the 
HMI device.  

• Clear the Visible box to make the trend chart not visible on the 
HMI device.  

Specify the visibility of a 
trend chart 
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See also 
Change the appearance of a trace on page 646 

Change the background color of a trend chart on page 643 

Delete a trace from a trend chart on page 640 

Delete a trace from a trend chart on page 640 

Change how often a Trend chart graphic element requests data from a 
controllers by changing its sample rate. The default sample rate is every 
1000 milliseconds or every second. Change the sample rate to match the 
interval to sample data for the trend chart. For example, change the 
sample rate to match the rate at which data updates in the controllers.    

To change how often a trend chart requests data from controllers 
1. Select the trend chart on the screen.  
2. In the Properties window, select the Properties tab.   
3. Expand the General category.  
4. In the SampleRate box, enter the rate, in milliseconds, at which 

the trend chart requests data from the controllers. Enter positive 
numbers between 500 and 60000 to represent one-half second to 
60 seconds. 

 
Tips:  
• If the trend chart requests data more frequently than data updates in the controllers, the data 

plotted may not appear in a linear fashion on the trend chart. 
• To avoid slow panning on a trend chart that has a time span over 30 minutes, enter a minimum of 

1000 milliseconds, or one second.  
• Trend charts automatically display data from a data log for the specified tag. Tags may exist in 

more than one data log. The trend chart uses the data log that contains a matching sample rate. If 
there is more than one data log with a matching sample rate or there is no data log with a 
matching sample rate, the trend chart uses the first data log. 

See also 
Change the range of data displayed on a trend chart on page 636 

Add traces to a trend chart on page 636 

Delete a trace from a trend chart to no longer display the values 
associated with the trace on the trend chart. For example, delete a trace 
if its data depicts a bottling line being discontinued from the 
manufacturing system.   

To delete a trace from a trend chart 
1. Select the trend chart on the screen. 
2. In the Properties window, select the Traces tab. 
3. In the upper right corner of the Trace card of the trace to delete, 

select Delete Trace . The trace no long appears on the trend 
chart. 

 
Tip: Deleting a trace does not delete the tag from a data log. 

Change how often a trend 
chart requests data from 
controllers 

Delete a trace from a trend 
chart 
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See also 
Add traces to a trend chart on page 636 

Change the appearance of a trace on page 646 

Change the range of data displayed on a trend chart on page 636 

Trend chart contents on page 641 

View trend charts on page 819 

A trend chart depicts data from up to eight traces and plots those values 
across the chart:   

 
Item Description 

 
Traces on the trend chart consist of lines and markers. Each trace plots data over the 
specified time span. Add up to eight traces to a trend chart. Customize the appearance of a 
trace. The trend chart updates every second to display the most recent values, even if there 
are no values plotted during that time span. 

 
The y-axis that represents data. This axis displays the values of the MinValue and MaxValue 
properties of the trend chart. 

 
The axis that represents time. The value on the right side of this axis represents the current 
time. The time is not synchronized with the HMI device and may be a few seconds ahead or 
behind. The value on the left side of this axis represents the current time minus the time 
span. This axis displays the date by default. The date is the left-most point of the axis. The 
date changes once the left-most point of the axis displays data for the next day.    

 Pan Backward  displays previous data one-half time span at a time. This button appears 
only when there is data collected prior to the data displayed in the current time span.  

 Pan Forward  displays more recent data one-half time span at a time. This button 
appears only when there is data collected after the data displayed in the current time span.  

 Resume  updates data after the trend chart is paused. Pause  replaces Resume 

 when the trend chart is scrolling. When a trend chart is paused, the trend chart is static 
at the time the trend chart was paused and data is not updated. Data is collected in the 
background.    

See also 
View trend charts on page 819 

Create a basic trend chart on page 634 

Add traces to a trend chart on page 636 

Trend chart contents 
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Traces tab on page 633 

A trend chart is a graph of data from the system. For example, a trend 
chart can monitor tank pressure and tank temperature over the course of 
an hour. 

Use a trend chart to: 

• Monitor processes in a manufacturing system  
• Display data from a tag, user-defined property, or the property of a 

graphic element 
• Display up to eight traces that plot data over time to graphically 

present data   
• View, pan, and pause data on the HMI device 

See also 
Create a basic trend chart on page 634 

Traces tab on page 633 

Trend chart contents on page 641 

The data on a trend chart represents the data in the system. The 
appearance of a trend chart and its data may also represent the system. 
For example, if a bottling line is blue, the data for that line may be 
configured to appear blue in the trend chart.  

Change the appearance of a trend chart to customize the trend chart.    

See also 
Change the background color of a trend chart on page 643 

Specify the grid lines on a trend chart on page 644 

Change the color of text on a trend chart on page 644 

Change the appearance of a trace on page 646 

Hide the axes on a trend chart on page 645 

Change the border of a trend chart to customize the trend chart to appear 
on the HMI device. Specify the color, style, and width of the border.  

To change the appearance of a trend chart border  
1. Select the trend chart on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance and Border categories. 
4. In the Color box, select any color using the Color Picker or enter 

a Hex color value manually.  

 
Tip: Hex values must be in #RRGGBB format. R, G, and B are Hex digits from 0 through F and 
represent the color channel values for red, green, and blue. For example, #ffff00 produces 
yellow. 

5. In the Style box, select a style for the border:  

What is a trend chart? 

Change the appearance of a 
trend chart 

Change the appearance of a 
trend chart border 
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• Line. None, Solid, Dash, Dot, Dash Dot, or Dash Dot Dot 
• Cap. Flat, Round, or Square 
• Join. Miter, Bevel, or Round 

6. In the Width box, select the width of the border or select None. 

See also 
Change the background color of a trend chart on page 643 

Change the appearance of a trace on page 646 

Change the color of the axes on a trend chart on page 645 

Change the color of the grid on a trend chart on page 643 

Change the background color of a trend chart to change the fill color 
behind the traces. The default background color for the Trend Chart 
graphic element is white.  

To change the background color of a trend chart  
1. Select the trend chart on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category.  
4. In the FillColor box, select any color. Select any color in the Color 

Picker or a Hex color value entered manually. The Hex value must 
be in the format #RRGGBB. R, G, and B are Hex digits from 0 
through F and represent the color channel values for red, green, 
and blue. For example, #ffff00 produces yellow. 

See also 
Add traces to a trend chart on page 636 

Change the color of the grid on a trend chart on page 643 

Change the appearance of a trace on page 646 

Delete a trace from a trend chart on page 640 

Change the color of the grid to customize the appearance of a trend 
chart.   

To change the color of the grid on a trend chart 
1. Select the trend chart on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category.  
4. In the GridColor box, In the Color box, select any color using the 

Color Picker or enter a Hex color value manually. The Hex value 
must be in the format #RRGGBB. R, G, and B are Hex digits from 
0 through F and represent the color channel values for red, green, 
and blue. For example, #ffff00 produces yellow.  

Change the background 
color of a trend chart 

Change the color of the grid 
on a trend chart 
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See also 
Change the appearance of a trace on page 646 

Change the background color of a trend chart on page 643 

Hide the axes on a trend chart on page 645 

Prevent interaction with a trend chart on page 647 

Hide or show grid lines to customize the appearance of a trend chart. By 
default, horizontal grid lines appear on a trend chart while vertical grid 
lines do not. Hiding the grid lines shows only the background color of the 
trend chart behind the traces.  

To specify the grid lines on a trend chart 
1. Select the trend chart on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category.  
4. Select the ShowGridVertical box to show the vertical lines on the 

grid of the trend chart. Clear this box to hide the vertical lines. 
5. Clear the ShowGridHorizontal box to hide the horizontal lines on 

the grid of the trend chart. Select this box to show the horizontal 
lines. 

See also 
Change the background color of a trend chart on page 643 

Change the color of the grid on a trend chart on page 643 

Change the color of the axes on a trend chart on page 645 

Hide the axes on a trend chart on page 645 

Prevent interaction with a trend chart on page 647 

Change the color of text on a trend chart to change the color of the labels 
on both axes. Do this to customize the appearance of the trend chart to 
make the data and time labels easier to read. 

To change the color of text on a trend chart 
1. Select the trend chart on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category.  
4. In the FontColor box, select a color. Select any color in the Color 

Picker or a Hex color value entered manually. The Hex value must 
be in the format #RRGGBB. R, G, and B are Hex digits from 0 
through F and represent the color channel values for red, green, 
and blue. For example, #ffff00 produces yellow. 

Specify the grid lines on a 
trend chart 

Change the color of text on 
a trend chart 
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See also 
Change the background color of a trend chart on page 643  

Change the color of the grid on a trend chart on page 643  

Change the color of the axes on a trend chart on page 645  

Change the appearance of a trend chart border on page 642  

Hide the axes on a trend chart on page 645 

Change the color of the axes to customize the appearance of a trend 
chart. Changing the color of the axes changes the color of the markers 
and labels on both the y-axis and the time axis.  

To change the color of the axes on a trend chart   
1. Select the trend chart on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category.  
4. In the AxesColor box, select any color using the Color Picker or 

enter a Hex color value manually. The Hex value must be in the 
format #RRGGBB. R, G, and B are Hex digits from 0 through F 
and represent the color channel values for red, green, and blue. 
For example, #ffff00 produces yellow.  

See also 
Hide the axes on a trend chart on page 645 

Change the color of the grid on a trend chart on page 643 

Specify the grid lines on a trend chart on page 644 

Change the background color of a trend chart on page 643 

Prevent interaction with a trend chart on page 647 

Hide the axes to customize the appearance of a trend chart. Hiding the 
axes hides both the y-axis and the time axis, including all labels and tick 
marks.   

To hide the axes on a trend chart 
1. Select the trend chart on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category.  
4. Clear the ShowAxes box to hide the axes, tick marks, and labels. 

Select the box to show these items on the trend chart.   

See also 
Change the color of the axes on a trend chart on page 645 

Change the color of the 
axes on a trend chart 

Hide the axes on a trend 
chart 
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Specify the grid lines on a trend chart on page 644 

Change the appearance of a trace on page 646 

Label a trace for diagnostic purposes on page 636 

Change the line color and line width of a trace. Each trace has a solid line 
by default that is one point wide and has a unique color. 

To change the appearance of a trace 
1. Select the trend chart on the screen. 
2. In the Properties window, select the Traces tab. 
3. Expand the Trace card and the Appearance category.  
4. In the Color box, select any color using the Color Picker or enter 

a Hex color value manually. The Hex value must be in the format 
#RRGGBB. R, G, and B are Hex digits from 0 through F and 
represent the color channel values for red, green, and blue. For 
example, #ffff00 produces yellow.  

5. In the Width box, select the width for the trace:  
• 1/2 
• 1 
• 2 
• 3 

See also 
Add traces to a trend chart on page 636 

Change the range of data displayed on a trend chart on page 636 

Change the marker of a trace on page 646 

Delete a trace from a trend chart on page 640 

Change the marker that depicts data samples on a trace. Markers have 
different shapes. Each trace can use a different marker to depict data 
samples. A trace does not have to have a marker.  

To change the marker of data on trace  
1. Select the trend chart on the screen.  
2. In the Properties window, select the Traces tab.   
3. Expand the Trace card and the Appearance category. 
4. After the Marker box, select the arrow to select a marker:  

• None 
•  Star  
•  Cross 
•  Circle 
•  Square 
•  Triangle 
•  Filled Circle 
•  Filled Square 

Change the appearance of a 
trace 

Change the marker of a 
trace 
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•  Filled Triangle 
The selected marker appears on the trace in the trend chart on the 
HMI device.  

See also 
Change the appearance of a trace on page 646 

Specify the visibility of a trend chart on page 639 

Change the color of the grid on a trend chart on page 643 

A trend chart displays the date by default. The format of the date on a 
trend chart depends on the format specified for the time span start of the 
trend chart:   

TimeSpanStart  Date format 

M/dd/yyyy h:mm:ss AP M/dd/yyyy 
dd/M/yyyy hh:mm:ss dd/M/yyyy 
yyyy-MM-dd hh:mm:ss yyyy-MM-dd 
d MMM yyyy hh:mm:ss d MMM yyyy 
M/d/yyyy M/dd/yyyy 
d/M/yyyy dd/M/yyyy 
yyyy-MM-dd yyyy-MM-dd 
d MMM yyyy d MMM yyyy 

To show the date on a trend chart 
1. Select the trend chart on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category.  
4. Select the ShowDate box.  

 
Tip: To not show the date on a trend chart, clear the ShowDate box. 

See also 
Create a basic trend chart on page 634 

Specify the visibility of a trend chart on page 639 

Trend chart contents on page 641 

Configure property binding to pan to the start time of a trend chart 
on page 638 

Pause  or Resume , Pan Forward , and Pan Back  
buttons appear on a trend chart by default. To interact with a trend chart 
on the HMI device, press the buttons or tab to them and press Enter on 
an external keyboard. Hide the buttons to prevent interaction with the 
trend chart on the HMI device.  

Show the date on a trend 
chart 

Prevent interaction with a 
trend chart 
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To prevent interaction with a trend chart  
1. Select the trend chart on the screen. 
2. In the Properties window, select the Properties tab. 
3. Expand the Appearance category.  
4. Clear the ShowButtons box to hide the buttons on the trend chart 

on the HMI device. Select the box to show the buttons. 

 
Tips:  
• Clearing the ShowButtons box does not depict any changes in View Designer. The buttons do not 

show on the HMI device.  
• To have the trend chart not accept touch or key input even when buttons show on the trend chart, 

clear the Enable box.  

See also 
Change the color of the grid on a trend chart on page 643 

Specify the grid lines on a trend chart on page 644 

Hide the axes on a trend chart on page 645 

Change the background color of a trend chart on page 643 
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Chapter 22 

Log data 

Log data to review the tag values of a process in a system. A data log is a 
collection of data values from specified tags. Data logs are exported from 
the HMI device to an external device such as an SD card or a USB 
storage device. Exported data logs are contained in a .zip file. The .zip 
file contains a .csv file for each data log. Data logs are exported through 
an event that triggers an action that then exports the data log for viewing 
on a computer. 

 
Tip: Data logs contain tag values from all controllers in a project. 

Use a data log to: 

• View historical data for a specific duration. 
• Collect tag values at a specified sample rate. 
• Identify data patterns in a system. 
• Troubleshoot a system. 
• Provide data for audits. 

A data log automatically records data values in the background on an 
HMI device when a View Designer project with a configured data log is 
running. Record the values of up to 250 tags in a data log. Each project 
can contain up to three data logs, however the total number of tags per 
project is still 250 across the three data logs. Log data at a specific 
sample rate for a specified duration.  

To view the tag values collected by the data log, export the data log to a 
.zip file on a USB storage device or SD card and then view the data log 
on a computer. To view the values of tags being logged on the HMI 
device, add the tags to a trend chart.  

See also 
Add a data log to a project on page 649 

Add an event command to export a data log on page 469 

Data log contents on page 665 

What is an event? on page 476 

Add a data log to a project to create a log of specified tag values. Data 
logs collect data at a specific sample rate and for a specified duration. 
The data log collects data in the background when a project with a 
configured data log is running on the HMI device. Add up to three data 
logs to a project.  

Add a data log to a project 
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To add a data log to a project 
1. In the Project Explorer, navigate to the Data Logs folder. 
2. Right-click the Data Logs folder and select New Data Log. The 

initial data log added to a project has the default name 
DataLog_001. 

 
Tips:  
• Rename the data log through the Properties window.  
• Double-click the data log to open the data log. From an open data log change the sample rate, 

change the log duration, and add tags.   

See also 
Open a data log on page 650 

Change the log duration on page 651 

Add event commands to export a data log on page 469 

Data log contents on page 665 

Open a data log to add tags to the data log in order to specify the sample 
rate and log duration of the data log.  

To open a data log 
1. In the Project Explorer, expand the Data Logs folder. 
2. Double-click the data log. The tab with the name of the data log 

opens and lists any tags already added to the data log. 

See also 
Add a data log to a project on page 649 

Change the sample rate of a data log on page 650 

Change the log duration on page 651 

Add a tag to a data log on page 652 

Data log tab on page 665 

Change the sample rate of a data log to change how often the data log 
collects tag values, in milliseconds, on the HMI device. For example, to 
collect data every 30 seconds, specify 30,000 milliseconds as the 
sample rate. The default sample rate is 1000 milliseconds or every 
second. Valid sample rates range from 500 milliseconds to 60,000 
milliseconds.  

To change the sample rate of a data log 
1. In the Project Explorer, expand the Data Logs folder and 

double-click the data log. The data log opens in the Data Log tab. 

 
Tip: Right-clicking the data log in the Data Logs folder and clicking Open opens the data log.  

Open a data log 

Change the sample rate of a 
data log 
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2. In the box after Sample Rate at the top of the data log, select how 
often the data log collects data. For example, select 500 ms to 
have the data log collect data every half second.  

 
Tips:  
• Changing the sample rate causes previously collected data to no longer appear in the data log 

when the project downloads again.  
• If there is no change to the sample rate, log duration, or number of tags in the data log, previously 

collected data in the data log remains unchanged when redownloading the project to the HMI 
device.  

• The Sample Rate box has a red outline if it does not contain a valid entry.   
• The data log contains tag values with the specified sample rate from all controllers. 

See also 
Data log contents on page 665 

Change the log duration on page 651 

Rename a data log on page 663 

Add a data log to a project on page 649 

Change the log duration of a data log to change how long the data log 
collects the specified tag values on an HMI device. Specify the log 
duration in minutes, hours, or days. For example, to collect data for a day, 
specify one day as the log duration. The default log duration is seven 
days. The maximum log duration is 365 days.  

To change the log duration 
1. In the Project Explorer, expand the Data Logs folder and 

double-click the data log. The data log opens in the Data Log tab. 

 
Tip: Right-clicking the data log in the Data Logs folder and selecting Open opens the data log. 

2. In the second box after Log Duration at the top of the data log, 
select the duration and unit of measure for the duration. For 
example, type 14 and select days to have the data log start 
collecting data for two weeks once the project downloads to the 
HMI device. 

 
Tips:  
• Changing the log duration causes previously collected data to no longer appear in the data log 

when the project downloads again.  
• If there is no change to the sample rate, log duration, or number of tags in the data log, previously 

collected data in the data log remains unchanged when redownloading the project to the HMI 
device.   

• The Log Duration box has a red outline if it does not contain a valid entry. Enter a valid log duration 
between 1 of any of the selected units and 365 days. 8760 hours and 525,600 minutes are both 
equivalents of 365 days.  

See also 
Data log contents on page 665 

Change the sample rate of a data log on page 650 

Rename a data log on page 663 

Change the log duration 
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Add a data log to a project on page 649 

Add a tag to a data log to have the value of that tag logged. Data logs for 
the specified sample rate and duration. Adding a tag discards previously 
collected data in the data log. 

IMPORTANT Data logs do not support ::Local:HMIDevice. When in a data log, certain tags appear as 
undefined in View Designer and have Bad Quality in an exported data log: 
• AutoLogoff.Delay 
• AutoLogoff.Enable 
• AutoLogoff.RemainingTime 
• Device.ActiveLanguage 
• Display.CurrentScreenName 
• Security.CurrentUserName 
• Security.CurrentUserRole  

Prerequisites 
• Export the data log on the HMI device to retain any collected data.   
• On the Project Properties dialog box, verify that the View 

Designer project references the Logix Designer project file (.acd) 
that contains the tags to use.  

To add a tag to a data log 
1. In the Project Explorer, expand the Data Logs folder and 

double-click the data log to open it. 
2. Select the blank row at the bottom of the data log and type the path 

of the tag or browse for the tag:  

a. At the end of the row, select Select tag . The Tag Browser 
displays the result of the last browsing session. 

b. Select the drill-in arrow  next to the category: 

• Controllers. Navigate to the desired controller tag and level 
to browse to the tag. 

• HMI Device. Navigate to the desired user-defined data type 
property and tag. 

c. Double-click the tag and close the Tag Browser. The tag and 
its path appear in the data log. 

 
Tips:  
• Data logs do not support spaces in tag paths. View Designer shows a red outline when manually 

typing spaces or copying and pasting spaces when editing a tag path. Content from the clipboard 
that contains spaces does not paste as a row in a data log.    

• In the exported data log file, one column of data values exists for each added tag. Adding a tag 
twice does not create an additional column for the tag. View Designer ignores duplicate tags.    

• Tag entries in the data log appear with Bad Quality when the controller is not synchronized with the 
HMI device. 

• Browse and add tags to a data log from all controller references. 

See also 
Log data on page 649 

Add a tag to a data log 
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Delete a tag from a data log on page 654 

Add a data log to a project on page 649 

Search for and select a tag  

Add event commands to export a data log on page 469 

Add a Status tag to a data log to display the status code of the data log. 
Numeric values for the Status tag include: 

• RUNNING: 10 
• STOPPED: 20 
• SAFELY_STOPPED: 30 

When at least one data log is in the RUNNING status, the general status 
of data logs is also RUNNING. 

IMPORTANT Data logs do not support ::Local:HMIDevice. When in a data log, certain tags appear as 
undefined in View Designer and have Bad Quality in an exported data log: 
• AutoLogoff.Delay 
• AutoLogoff.Enable 
• AutoLogoff.RemainingTime 
• Device.ActiveLanguage 
• Display.CurrentScreenName 
• Security.CurrentUserName 
• Security.CurrentUserRole  

Prerequisites 
• Export the data log on the HMI device to retain any collected data. 
• On the Project Properties dialog box, verify that the View 

Designer project references the Logix Designer project file (.acd) 
that contains the tags to use.  

To add a tag to a data log 
1. In the Project Explorer, expand the Data Logs folder and 

double-click the data log to open it. 
2. After the Status tag field, select Select tag . The Tag 

Browser displays the result of the last browsing session. 
3. Select  next to the category: 

• Controllers. Navigate to and expand the desired controller 
tag to browse to and select the desired tag. 

• HMI Device. Navigate to the desired user-defined data type 
property and tag to select the tag. 

4. Double-click the tag and close the Tag Browser. The tag and its 
path appear in the Status tag field. 

 
Tips:  
• Data logs do not support spaces in tag paths. View Designer shows a red outline when manually 

typing spaces or copying and pasting spaces when editing a tag path. Content from the clipboard 
that contains spaces does not paste as a row in a data log. 

• Browse and add tags to a data log from all controller references. 

Add a Status tag to a data 
log 
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See also 
Log data on page 649 

Add a data log to a project on page 649 

Search for and select a tag  

Add event commands to export a data log on page 469 

Delete a tag from a data log to no longer have the values of that tag 
logged on the HMI device. Do this to no longer view the historical values 
of the tag in the data log. Removing a tag discards previously collected 
data in the data log. 

Prerequisites 
• Export the data log on the HMI device to retain any collected data.   
• In the Project Explorer, expand the Data Logs folder and 

double-click the data log to open it.  

To delete a tag from a data log 
1. In the open data log, scroll to navigate to the tag rows.  
2. Select the tag rows to remove from the data log: 

• Individual. Select the empty row header at the beginning of the 
row. 

• Consecutive. Select the empty row header at the beginning of 
the first row to delete, hold down Shift, and select the empty 
row header at the beginning of the last row to delete.  

• Nonconsecutive. Select the empty row header at the 
beginning of a row, hold down Ctrl, and select the empty row 
header at the beginning of additional rows. 

3. Press Delete. The tag no longer appears in the data log. 

 
Tips:  
• Right-clicking the selection and selecting Delete Selected Row(s) removes the tags from the data 

log.  
• Selecting and deleting all of the text in the cell creates an empty row. Add a new tag to the row or 

delete the row. View Designer outlines the empty row in red. Closing a data log that has an empty 
row displays the last valid tag for that row when reopening the data log. 

See also 
Add a data log to a project on page 649 

Add a tag to a data log on page 652 

Add event commands to export a data log on page 469 

Delete a data log from a project on page 664 

Data log contents on page 665 

Delete a tag from a data log 
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Create an event command to export a data log to view the tag values 
collected on the HMI device. When triggered on the HMI device, the 
event exports all of the data logs in the View Designer project. Data logs 
export to a USB storage device or SD card for a PanelView project as a 
.zip file. The .zip file contains a .csv file for each data log.  

For a PanelView project, create an additional event to allow the safe 
removal of the removable media from the HMI device so that files on the 
media do not become corrupt. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add event commands to export a data log 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Data Log category and configure the command: 

• Export Data Log. Creates and exports each data log in .csv 
format to a .zip file:  
• In the Destination box of the command card, select USB or 

SD Card for a PanelView project. 
• In the FileName box, type the name of the export .zip file for 

the data log.  
• Cancel Data Log Export. Cancels the export of the data log to 

the HMI device. Partial data logs do not export. No .zip file 
appears in the destination. 

 
Tips:  
• Bind the FileName box of the Export Data Log event command to a graphic element property or a 

tag in a controller. Binding the file name specifies the data log to export on the HMI device. For 
example, bind the FileName box of the Export Data Log event command to the text property of Text 
Input graphic element. This displays the name of the data log on the Text Input graphic element 
that exports the data log from the HMI device. 

• Exporting the same data log file to the same removable media creates a new export file each time. 
The file name increments by one. This may cause the USB storage device, SD card, or destination 
to reach capacity. For example, DataLog_002 indicates a second instance of an exported data log 
named DataLog. 

• When the data log is exporting, the Data Export icon  appears in the System Banner. If there 

is an error exporting a data log, the Data Export Error icon  appears in the System Banner. 
• Data log exports do not complete or create a .zip file on removable media if a ControlFLASH, 

reboot, or power cycle to the HMI device occurs during the export. 
• The data log file contains tag values from all controllers. 

Add an event command to 
export a data log 
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See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Configure an action to occur when touching or releasing a key on the 
HMI device. For example, create a Key Press event so that pressing L1 
on the HMI device opens a specific screen. 

You can use an external keyboard with the HMI device. The L1 through 
L10 keys listed when creating Key Press and Key Release events 
correspond with pressing Shift+F1 through Shift+F10 keys on an 
external keyboard. The R1 through R10 keys listed when creating Key 
Press and Key Release events correspond with pressing Ctrl+F1 
through Ctrl+F10 on an external keyboard.  

To trigger an action on a Key Press or a Key Release event 
1. Select the item to have the event. The item can be a graphic 

element, a graphic element in the definition of an Add-On 
Graphic, an Add-On Graphic instance, a group of elements, a 
screen, a popup, or the System Banner. 

 
Tip: Select items on either the Screen area, Project Explorer, or Graphic Explorer. 

2. In the Properties pane, click the Events tab. 
3. Select Add Event and select an event from the list. 

• Key Press. Occurs when pressing a designated key on the HMI 
device or on an external keyboard. 

• Key Release. Occurs when releasing a designated key on the 
HMI device or an external keyboard.  

4. In the Key box, select the key to use for the event. 
5. To have the event occur even if the graphic element does not have 

focus when the event triggers, clear the Requires Focus 
checkbox. By default, this check box is not selected. Therefore, 
the event still triggers even when the graphic element does not 
have focus. This may occur when pressing Tab to highlight 
another graphic element on the screen. Placing focus on a graphic 
element requires pressing Tab to highlight the graphic element. 

6. If a Release event requires that the event of the graphic element 
triggers not only when releasing the element or key, but even if 
another screen opens, select the Always Trigger Release Event 
checkbox. This setting is useful for having the element act like a 
momentary push button where a Press event sets a tag to 1 to 
start a conveyor belt, and a Release event sets the same tag to 0 
to stop the conveyor belt. 

7. Select Add Command. 

Trigger an action on a Key 
Press or a Key Release 
event 
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8. Expand a command category to list the commands in that 
category:  
• Alarm History. Cancel export of the alarm history, clear alarm 

history, or export alarm history. 
• Data Log. Cancel export of data log, clear data log, or export 

data log to a USB or SD card.  
• HMI Device Configuration. Configure screen calibration, load 

a runtime application from removable media to the HMI device, 
reboot the HMI device, and safely remove media. 

• Language. Change the language that displays on the HMI 
device. 

 
Tips:  
• Import the desired languages before changing the language that displays on the HMI device. 
• If a translatable string is left blank, View Designer defaults to the download language for runtime 

applications downloaded to the HMI device. If the string that is translated for the download 
language is also blank, View Designer defaults to the language used for designing the project. 

• Navigation. Navigate to screens on the HMI device. 

 
Tip: Multiple screen navigation commands can exist for an event. All other types of 
commands for the event are executed before the navigation command. Only one 
navigation command is executed for an event. This is generally the first navigation 
command. The remaining navigation commands are ignored on the HMI device. To ensure 
the navigation command is the navigation command executed, Rockwell Automation 
recommends adding only one navigation command to an event.  

• Notification. Send an email notification. 
• PDF. Commands that zoom or navigate pages in a PDF file. 
• Security. Log on or log off the HMI device. 

9. Value. Commands that increment, toggle, or write a value to the 
selected tag.Select and configure the command the event is to 
perform.  

 
Tips:  
• Create multiple commands for each event. The order of execution may not correspond with the 

order of commands listed on the Event card. 
• Creating many tag write commands for an event may pause screen updates while the writes occur. 
• When an event performs multiple commands that write to multiple tags, all of the write commands 

occur sequentially. Therefore, you may not see all of the tag values in the Logix controllers at the 
same time. 

See also 
Event commands on page 456 

Events tab on page 447 

Trigger an action on a Button Behavior event on page 444 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a State Enter or State Exit event on page 454 

Configure an action to occur when pressing or releasing a graphic 
element or the screen on the HMI device. For example, create a Touch 
Press event so that a specific screen opens when touching a graphic 
element.   

Trigger an action on a 
Touch Press or a Touch 
Release event 
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To trigger an action on a Touch Press or a Touch Release event 
1. Select the item to have the event. The item can be a graphic 

element, a graphic element in the definition of an Add-On 
Graphic, an Add-On Graphic instance, a group of elements, a 
screen, a popup, or the System Banner. 

 
Tip: Select items on either the Screen area, Project Explorer, or Graphic Explorer. 

2. In the Properties pane, click the Events tab. 
3. Select Add Event and select an event from the list. 

• Touch Press. Occurs when pressing a screen or element on 
the HMI device.  

• Touch Release. Occurs when releasing a screen or graphic 
element on the HMI device.   

4. If a Touch Release event requires that the event of the element 
trigger even if a finger slides off the element before releasing the 
element, the graphic element becomes disabled or invisible, or a 
screen navigation opens a different screen, select the Always 
Trigger Release Event checkbox. This setting is useful for having 
the element act like a momentary push button. For example, a 
Touch Press sets a tag to 1 to start a conveyor belt, and a Touch 
Release event sets the same tag to 0 to stop the conveyor belt. 

5. Select Add Command. 
6. Expand a command category to list the commands in that 

category:  
• Alarm History. Cancel export of the alarm history, clear alarm 

history, or export alarm history. 
• Data Log. Cancel export of data log, clear data log, or export 

data log to a USB or SD card.  
• HMI Device Configuration. Configure screen calibration, load 

a runtime application from removable media to the HMI device, 
reboot the HMI device, and safely remove media. 

• Language. Change the language that displays on the HMI 
device. 

 
Tips:  
• Import the desired languages before changing the language that displays on the HMI device. 
• If a translatable string is left blank, View Designer defaults to the download language for runtime 

applications downloaded to the HMI device. If the string that is translated for the download 
language is also blank, View Designer defaults to the language used for designing the project. 

• Navigation. Navigate to screens on the HMI device. 

 
Tip: Multiple screen navigation commands can exist for an event. All other types of 
commands for the event are executed before the navigation command. Only one 
navigation command is executed for an event. This is generally the first navigation 
command. The remaining navigation commands are ignored on the HMI device. To ensure 
the navigation command is the navigation command executed, Rockwell Automation 
recommends adding only one navigation command to an event.  

• Notification. Send an email notification. 
• PDF. Commands that zoom or navigate pages in a PDF file. 
• Security. Log on or log off the HMI device. 

7. Value. Commands that increment, toggle, or write a value to the 
selected tag.Select the command the event is to perform.  
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Tips:  
• Create multiple commands for each event. The order of execution may not correspond with the 

order of commands listed on the Event card. 
• Creating many tag write commands for an event may pause screen updates while the writes occur. 
• When an event performs multiple commands that write to multiple tags, all of the write commands 

occur sequentially. Therefore, you may not see all of the tag values in the Logix controllers at the 
same time. 

See also 
Event commands on page 456 

Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a Button Behavior event on page 444 

Trigger an action on a State Enter or State Exit event on page 454 

In what order are touch events triggered? on page 478 

Select a command under a category to perform when an event triggers: 

Category Command Description 

Alarm History Cancel Alarm History Export Cancels the export of the alarm history. 
Clear Alarm History Removes all alarm events stored on the HMI device. 
Export Alarm History Exports a .csv file for the alarm history in the project to a .zip file and places the .zip 

file on a USB drive or SD card to review the alarm history on a computer. 
Certificates Delete Certificate Deletes a digital certificate stored on the HMI device. This command requires 

entering the fingerprint of a specific certificate. 

Import Certificate Imports a digital certificate with a specified file name. 
Data Log Cancel Data Log Export Cancels the export of the data log. 

Clear Data Log Clears the contents of all data logs or selected data logs. 

Export Data Log Exports a .csv file for each data log in the project to a .zip file and places the .zip file 
on a USB drive or SD card to review the data log on a computer. 

HMI Device 
Configuration 

Calibrate Touch Screen Calibrates the HMI device screen for touch. This command displays a red target on 
the screen. Press and hold the center of the target until the target turns white and 
another red target appears. Continue pressing and holding the centers of all 
remaining targets as they appear. All processed targets are replaced with white 
targets. A green circle with a check indicates successful calibration. A red circle with 
an X indicates a failed calibration. 
If a red circle with an X appears, perform the event again to calibrate the screen. 

Load Application Loads the specified runtime application file to the HMI device from either a USB 
storage or an SD card. 

Reboot Terminal Reboots the HMI device immediately. 
Safely Remove Media Prepares the SD card for safe removal from the HMI device so the files do not 

become corrupt or read-only. 
Language Switch Language Changes the language that displays on the HMI device. 

Tip: Import the desired languages before changing the language that displays on the 
HMI device. 

Navigation Navigate Backward Navigates back in history to the screen opened using the Navigation menu or a 
Screen Navigate command.  
Logging off the HMI device erases the navigation history.  

Navigate Forward Navigates forward in history to the screen opened using the Navigation menu or a 
Screen Navigate command.  
Logging off the HMI device erases the navigation history. 

Open web browser Opens the web browser in a new window. 
Close web browser Closes the web browser. 

Event commands 
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Category Command Description 

Popup Close Closes the popup on the HMI device when the event occurs. Only one popup can be 
open on the HMI device at a time. 

Popup Open Opens a specific popup when the event occurs. Only one popup can be open on the 
HMI device at a time. 
In the Open Popup box, navigate to and select the popup the event is to open. If the 
selected popup has a user-defined data type property, bind the value in the Property 
Configuration box to the user-defined data type property of the popup. This passes 
the value to the popup when it opens on the HMI device.  
If a graphic element on the popup to open has an aliased property with a value, the 
Popup Open command can read the value from a referenced graphic element and 
apply it to the alias. In the Property Configuration box at the bottom of the 
command, enter the name of the graphic element and the property that has the 
value to apply to the aliased property. Use the format ElementName.PropertyName. 
When the event triggers, the graphic element on the popup with the aliased property 
shows the property value of the graphic element that is referenced in the Property 
Configuration box. The Property Configuration box appears for the command only if 
there is an aliased property or user-defined property on the target popup.   

Screen Navigate Opens the specified shortcut or screen when the event occurs.  
In the Navigate To box, select the screen or shortcut that the event is to open. If the 
selected screen or shortcut has a user-defined data type property, bind the value in 
the Property Configuration box to the user-defined data type property of the screen 
or shortcut. This passes the value to the screen when it opens on the HMI device.   
If a graphic element on the screen to open has an aliased property with a value, the 
Screen Navigate command can read the value from a referenced graphic element 
and apply it to the alias. In the Property Configuration box at the bottom of the 
command, enter the name of the graphic element and the property that has the 
value to apply to the aliased property. Use the format ElementName.PropertyName. 
When the event triggers, the graphic element on the screen with the aliased property 
shows the property value of the graphic element that is referenced in the Property 
Configuration box. The Property Configuration box appears for the command only if 
there is an aliased property or user-defined property on the target screen. 

Show Navigation Menu Opens the Navigation menu on the HMI device screen when the event occurs. 
Notification Send Email Sends an email with a configurable subject and message to one or more recipients. 

First configure the email server connection from the Settings screen on the HMI 
device.  

PDF Previous Page Navigates to the previous page in a PDF document. 

Next Page Navigates to the next page in a PDF document. 
Go To Page Navigates to a specified page in a PDF document. 
Zoom in Increases the document magnification by a percentage of the preset level in a PDF 

document. 
Zoom out Decreases the document magnification by a percentage of the preset level in a PDF 

document. 
Zoom to Adjusts the magnification to fit the page, fit the width of the page, or display the 

page at 100% magnification. 
Security Logon Opens the Log On dialog box when the event occurs. When the Log On dialog box 

opens, any open popup closes. 
Logoff Logs you off the project. If the Guest user role has security access to the current 

screen, the screen remains open. If the Guest user role does not have security 
access to the current screen, the Home screen opens.   

State State Previous Applies the previous state in the selected State Table to the graphic element when 
the event occurs. To configure this command, in the box in the command card, 
select the name of the desired State Table. Select Wrap Around to continue to apply 
states when the event occurs, even if the beginning or end of the State Table is 
reached.  
If you create a State event with a State Previous command with Wrap Around 
selected, the graphic element loops through states in the State Table as the event 
occurs. 
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Category Command Description 

State Next Applies the next state in the selected State Table to the graphic element when the 
event occurs. To configure this command, in the box in the command card, select 
the name of the desired State Table. Select Wrap Around to continue to apply states 
when the event occurs, even if the beginning or end of the State Table is reached.  
If you create a State event with a State Next command with Wrap Around selected, 
the graphic element loops through states in the State Table as the event occurs. 

Value Increment Increments the value of the selected tag when the event occurs. Specify the value 
with a number, a tag, an expression, an element property, or the property of a screen 
or Add-On Graphic.  
In the Increment box, enter or browse to select the tag or property of a screen or 
Add-On Graphic. In the By box, create the expression value by which to increment the 
tag when the event occurs. The increment can be either negative or positive.  

Toggle Toggles the value of the selected tag from 0 to 1, or from 1 to 0, when the event 
occurs.  
In the Tag box, enter or browse to select the tag or property of a screen or Add-On 
Graphic.  

Write  Writes a value to the selected tag when the event occurs. Specify the value with a 
number, a tag, an expression, an element property, or the property of a screen or 
Add-On Graphic.  
In the Write To box, enter or browse to select the tag or property of a screen or 
Add-On Graphic. In the Expression box, create the expression value to write to the 
tag when the event occurs. 

 

 
Tips:  
• For best performance, create commands that evaluate no more than 20 tags. 

For example, it is best for a Write command to have an expression containing no more than 20 
tags or a Send Email command to embed no more than 20 tags in the message. 

• For commands with expressions using many tags in a reference, have 10 or fewer such commands 
in an event for best performance.  

• Using larger numbers of tag references in many commands may cause slow screen performance 
while those commands evaluate. 

• Reference 1000 or fewer tags across all the project events. Using a larger number of tag 
references may cause delays in PanelView 5000 recovery from controller disconnects. 

• If the HMI device processes a large number of background tasks, like multiple triggered alarms, 
you may need to repeat a button press to execute the button commands. 

See also 
Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a State Enter or State Exit event on page 454 

Import a language file on page 671 

Export text strings for language translation on page 670 

An event is something that occurs to trigger an action. Events initiate on 
the HMI device. An example of an event is touching a graphic element or 
key. The system can also initiate events. An example event is a tag 
changing values in a controller.  

What is an event? 
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Create events for a graphic element, an instance of an Add-On Graphic, 
a graphic element within the definition of an Add-On Graphic, or a screen. 
There are four types of events:   

• Button Behavior. Touch or release a button or key on the HMI 
device, or configure a graphic element or Add-On Graphic with 
typical button behaviors. 

• Touch Press and Touch Release. Touch or release a graphic 
element, Add-On Graphic, screen, popup, or System Banner on 
the HMI device. 

• Key Press and Key Release. Touch or release a key on the HMI 
device keypad or an external keyboard.  

• State Enter and State Exit. Perform an event when a graphic 
element or Add-On Graphic transitions into or out of a selected 
state. For example, perform the event when the value of a tag in a 
controller changes from 50 to 100. 

Access Project Explorer > Project Events to create events for a 
project. Project events execute commands after evaluating an 
expression from false to true, or pressing a key. A project event triggers 
regardless of the screen or popup on the HMI device. 

Each event requires configuring one or more actions or commands that 
the event triggers. When the event occurs, the event performs the 
configured command. Depending on the type of event, commands from 
different categories can perform tasks. These categories and their 
commands are: 

• Alarm History. Remove all alarm events stored on the HMI 
device. Export alarm history to a .csv file on a USB device or an 
SD card in order to view the information on a computer, or cancel 
the export. 

• Certificates. Import a digital certificate from removable media, or 
delete a certificate from the HMI device. A digital certificate allows 
the HMI device to access locations on the Internet using the 
secured HTTPS and WSS protocols. 

• Data Logs. Clear one or more data logs. Export a data log to a 
.csv file on a USB device or an SD card in order to view the 
information on a computer, or cancel the export. 

• HMI Device Configuration. Calibrate touch for the HMI device 
screen, load a runtime application from the HMI device, reboot the 
HMI device, or safely remove media when the event occurs. 

• Language. Change the language that displays on the HMI device. 
• Navigation. Open the next or previous screen in your navigation 

history, a popup on the screen, a specific screen on the HMI 
device, or the Navigation menu on the HMI device when the 
event occurs. Open or close the web browser. 

• Notification. Send an email with a configurable subject and 
message to one or more recipients. 

• PDF. Navigate through the pages of PDF documents. 
• Security. Open the Logon dialog box or log off when the event 

occurs. 
• State. Apply the previous or next state in the selected State Table 

to the graphic element or Add-On Graphic when the event occurs.  
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• Value. Increment a tag value by a configured value or expression, 
toggle a tag value between True and False, or change a tag value 
by a configured value or expression when the event occurs. 

 
Tips:  
• Import the desired languages before changing the language that displays on the HMI device.  
• If a translatable string is left blank, View Designer defaults to the download language for runtime 

applications downloaded to the HMI device. If the translated string for the download language is 
also blank, View Designer defaults to the language used for designing the project. 

See also 
Trigger an action on a Button Behavior event on page 444 

Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a State Enter or State Exit event on page 454 

Import a language file on page 671 

Export text strings for language translation on page 670 

By default, the initial data log added to a View Designer project is named 
DataLog_001. This number is incremented when creating a new data log 
with the same name. A project can contain up to three data logs. 

Rename a data log to make the name that reflects its purpose, content, or 
targeted use. Names within a folder must be unique and are not 
case-sensitive. For example, Monthly_DataLog and monthly_datalog are 
considered identical names.  

To rename a data log 
1. In the Project Explorer, expand the Data Logs folder. 
2. Select the data log once to select the item. 
3. Select the data log again and type the new name.  

 
Tips:  
• Right-clicking a data log, selecting Rename, and entering a new name also renames the data log.  
• Change the name of the data log through the Name box in the Properties window of the data log.  
• Changing the name of the data log causes previously collected data to no longer appear in the data 

log when the project downloads again.  

See also 
Add a data log to a project on page 649 

Change the log duration on page 651 

Change the sample rate of a data log on page 650 

Delete a data log from a project on page 664 

Add event commands to export a data log on page 469 

To reuse a tag from one data log in another data log, cut or copy the tag 
and paste it in another data log. Reuse tags to place configured tags in a 
data log.  

Rename a data log 

Reuse a tag between data 
logs 
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Prerequisites  
• In the Project Explorer, expand the Data Logs folder and 

double-click the source data log to open it.  

To reuse a tag between data logs 
1. Scroll to select the tag rows to cut or copy: 

• Individual. Select the empty row header at the beginning of the 
row.  

• Consecutive. Select the empty row header at the beginning of 
the first row to delete, hold down Shift, and select the empty 
row header at the beginning of the last row to delete.  

• Nonconsecutive. Select the empty row header at the 
beginning of a row, hold down Ctrl, and select the empty row 
header at the beginning of additional rows. 

2. Right-click the selected tags and select an option: 
• Cut. Remove the tags from the source data log and copy them 

to the clipboard. 
• Copy. Leave the tags in the source data log and copy them to 

the clipboard.  
3. Open the target data log. 
4. Paste the tags in the data log: 

• Without replacing existing tags. Right-click the empty row 
header at the beginning of the last row in the data log and select 
Paste. The tags appear at the end of the data log.  

• Replace existing tags. Select the same number of tags rows to 
be replaced in the data log as are pasted to the clipboard, 
right-click the selected tags, and then select Paste. The tags 
replace the selected tags. 

See also 
Add a data log to a project on page 649 

Add a tag to a data log on page 652 

Add event commands to export a data log on page 469 

Delete a data log from a project on page 664 

Data log contents on page 665 

Delete a data log from a View Designer project to stop the data log from 
collecting data on the HMI device. After deleting a data log, download the 
project to the HMI device. Deleted data logs cannot be undeleted. A View 
Designer project can contain up to three data logs. 

To delete a data log from a project  
1. In the Project Explorer, expand the Data Logs folder.  

Delete a data log from a 
project 
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2. Right-click the data log and select Delete. The Project Explorer 
no longer contains the data log. 

See also 
Log data on page 649 

Add a data log to a project on page 649 

Add event commands to export a data log on page 469 

Delete a tag from a data log on page 654 

Rename a data log on page 663 

How do I open the Data Log tab? 

In the Project Explorer, expand the Data Logs folder and double-click a 
data log.  

The Data Log tab contains the open data log for the View Designer 
project. The data log displays the tags added to the data log. Add a total 
of 250 tags for all data logs in a project.  

Use the Data Log tab to: 

• Change the interval at which the data log collects tag values. 
• Change how long the data log collects tag values.  
• Add tags to the data log using the Tag Browser. 
• Add a Status tag to the data log using the Tag Browser. 

For example, add a data log to a project that records tag values for thirty 
seconds for a bottling line View Designer project over the course of a 
week. Add a data log to the project, add the tags associated with the 
bottling line to the data log, set the sample rate to 30,000 milliseconds, 
and set the log duration to seven days. 

See also 
Add a data log to a project on page 649 

Change the log duration on page 651 

Change the sample rate of a data log on page 650 

Data log contents on page 665 

Log data on page 649 

Data log tab 

Data log contents 
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A data log collects tag values in the background when a project with a 
configured data log is running on the HMI device.  

 
Item Description 

 
The Sample Rate of the data log in milliseconds. Specify how often the data log collects tags 
values once the View Designer project downloads to the HMI device. 

 
The Log Duration of the data log. Specify how long the data log collects tag values when a 
project with a configured data log is running on the HMI device. Specify the log duration in 
hours, days, or minutes. Enter a valid log duration between 1 of any of the selected units and 
365 days. 8760 hours and 525,600 minutes are both equivalents of 365 days. 

 
The Status tag of the data log. Bind this property to a controller tag to display the status code 
of the data log in numeric format (DINT). 

 
The tag with values to be logged. Each data log can collect values from up to 250 tags. All of 
the data logs in a project can have a combined maximum of 250 tags.  

 
The name of the open data log and the tag count of the data log. This is the number of tags in 
the open data log. A data log can contain up to 250 tags. The combined data logs in a project 
can contain up to 250 tags.  

 
The total number of tags. This number represents all of the data logs in the project. The 
combined data logs in a project can contain up to 250 tags.  

 
The percentage of data log capacity used. This is the total size of all data logs in a project, 
compared to the maximum size supported. Data logs in a project can have a combined 
maximum of 250 tags. Each data log can have up to a 500 millisecond sample rate and a 365 
day duration.  

See also 
Log data on page 649 

Add a data log to a project on page 649 

Add event commands to export a data log on page 469 

Change the log duration on page 651 

Change the sample rate of a data log on page 650 
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Data cannot log if the resulting data log configuration exceeds the 
maximum size. Sample rate, number of tags, and log duration determine 
the size of a data log.  

Each project contains up to three data logs. View Designer calculates the 
total size of all data logs in a project and compares the size against the 
maximum supported. The data logs in a project can have a combined 
maximum of 250 tags. Each data log can have up to a 500 millisecond 
sample rate and a 365-day duration.  

If the data log fails project verification, reduce the size of one or more of 
the data logs by:  

• Reducing the log duration 
• Increasing the sample rate 
• Reducing the number of tags  

The data log capacity used appears as a percentage in the bottom-right 
corner of the data log .csv file.  

See also 
Delete a tag from a data log on page 654 

Change the log duration on page 651 

Change the sample rate of a data log on page 650 

Delete a data log from a project on page 664 

Retaining or replacing data logs on an HMI device occurs during a:  

• Download. Adding a new data log or deleting a data log and then 
redownloading a project to the HMI device retains the values of 
previously configured data logs. Redownloading a project that has 
a data log with a configuration change such as name, size, and 
tags, retains only the values of previously unchanged configured 
data logs. Downloading a project to an HMI device that has an SD 
card with data logs from a different project replaces the data logs. 

• Firmware change. Data logs remain unchanged when firmware 
on the HMI device is updated with a ControlFLASH. Data logging 
does not occur during a ControlFLASH. Downloading the same 
project to the HMI device after updating the firmware leaves the 
data log on the HMI device unchanged. When the project runs, 
data logging starts again. 

• HMI reboot. Data logging stops when rebooting the HMI device. 
The data log remains unchanged. Data logging starts after the 
reboot completes.    

• HMI recovery. If a project has a data log and the HMI device runs 
out of memory or has a fatal error, there are two options: 
• Restore Defaults. The HMI device opens the default project. 

Data logging stops when the HMI device is in error or when the 
default project is running. The data log on the SD card from the 
previous project on the HMI device remains unchanged. Data 
logging starts when downloading a project that contains a data 
log to the HMI device.  

How is the maximum size of 
a data log configuration 
calculated? 

Data log retention 
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• Continue. The HMI device recovers and the previous project 
opens. Data logging starts.  

• SD card change. Data logging stops when removing the SD card 
from the HMI device. Data logging starts when inserting any SD 
card. The SD card can be from the same project, a different 
project, the same HMI device, or a different HMI device. The SD 
card may contain the same or different data logs. The result of 
inserting an SD card in the HMI device depends on the data log on 
that SD card:  
• Same data log. When inserting an SD card that contains a data 

log from the current project on the HMI device, data logging 
starts. New data appends to the existing data log.   

• Different data log. Inserting an SD card that contains a 
different data log replaces the data log on the SD card with the 
data log in the project currently running on the HMI device.   

• No data log. Inserting an SD card that has no data log into an 
HMI device that has a project with a data log creates a data log 
on the SD card. 

 
Tips:  
• If no SD card exists on the HMI device, rebooting the HMI device or downloading a project stops 

data logging. Data logging starts when inserting an SD card. 
• Any time it is necessary to remove the SD card, ensure that the files do not become corrupt. On the 

Settings screen on the HMI device, open the Data Log popup and select  Safely Remove SD 
Card.  

See also 
View tag values in a data log on page 825 

Data log on page 823 

Data log file on page 826 
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Chapter 23 

Switch languages 

Switch the language that appears on the HMI device by using View 
Designer to import and export the desired languages. In View Designer, 
select the language or languages from a predefined list.  

View Designer creates a Microsoft Excel language file when exporting 
the selected languages. This spreadsheet contains a KEY column that 
contains all of the user-editable text strings in the project. The selected 
languages appear as headings for the other columns in the spreadsheet. 
Enter the translation for each item in the spreadsheet.  

Import the language file to add the languages to the View Designer 
project. When downloading the project to the HMI device, select the 
project language using the Download Runtime Application wizard.  

 
Tip: Only localized and unlinked properties can import or export.  

Items that display in the selected language include:  

• Controller extended tag properties. 
• Controller alarm strings. 
• User-editable text strings. 

 
Tips:  
• Alarm history is always logged in the language chosen as the default language in Project Properties 

> Language. 
• The alarm history viewer element shows the content of the alarm history log. It does not switch the 

language of the alarm messages because the messages are only logged in one language. 
• If an alarm message configuration changes in the controller, the alarm history viewer element 

displays the old alarm message for alarm transitions prior to the change and the new alarm 
message for alarm transitions after the change. 

• Items that do not display in the selected language include: 
• Error messages. 
• Non-user-editable text strings, such as the column headings in the Alarm Summary or text that 

is built into a graphic element. 
• If there is a duplicate language column in the language file, such as two en-US columns, View 

Designer imports the data in the right-most column. 

See also 
Export Languages dialog box on page 669 

Export text strings for language translation on page 670 

Import a language file on page 671 

Add a language to a View Designer project on page 672 

How do I open the Export Languages dialog box? 

On the Menu bar, click Tools > Export Languages. 

Switch languages on the 
HMI device 

Export Languages dialog 
box 
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Use the Export Languages dialog box to export user-editable text 
strings in a project so that the strings can be translated. View Designer 
creates a language file that contains all of the strings used in the project 
along with their location within the project.  

Use the Export Languages dialog box to: 

• Specify the default language of the project. 
• Select the languages for translation. 
• Select the location to save the exported language file. 

See also 
Export text strings for language translation on page 670 

Import a language file on page 671 

Add a language to a View Designer project on page 672 

About changing the project language on page 675 

Export user-editable text strings in a project to a language file to translate 
the text strings. 

To export text strings for language translation 
1. Select Tools > Export Languages. 
2. In the Select current language list, select the language in which 

the project was created.  
3. In the Selected language for localization box, select one or 

more languages for translating the strings.  

 
Tips:  
• View Designer does not support the Spanish (Spain, Traditional Sort) language that is supported in 

Studio 5000 Logix Designer®.  
• When opening the exported language file in Microsoft Excel, the selected languages appear as 

column headers. Languages currently in the project are always included in the export operation, 
and are not available for selection. 

4. In the Export language file to box, select Browse to select the 
location to save the language file, and select Save.  

 
Tips:  
• The default path and file name is C:\Users\username\Documents\Studio 5000\Projects\Project 

name_Language.xlsx.  
• View Designer supports .xlsx and .txt file formats only.  
• If a file name does not have a file extension, or has an file extension that is not supported, View 

Designer appends the file to the default .xlsx format. 
• View Designer only exports localizable and unlinked properties. 

5. Select Export.  
6. Open the exported file using Excel.  

 
Tip: Excel does not size cells automatically to display data in its entirety. To ensure that all of 
the data displays, auto-size the height and width before editing the spreadsheet. 

7. To add a language that is not in the spreadsheet, in the column 
next to the last language column, enter the language code for the 
desired language, such as en-US. 

 
Tip: Reference the Internet Engineering Task Force (IETF®) RFC 5646 for guidelines on 
formatting language codes. 

Export text strings for 
language translation 
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8. (optional) Insert a space after the language code and add the 
applicable contextual information. Content is not case sensitive.  

See also 
Export Languages dialog box on page 669 

Import a language file on page 671 

About changing the project language on page 675 

Add an event command to change the language on the HMI 
device on page 460 

How do I open the Import languages dialog box? 

On the Menu bar, click Tools > Import Languages. 

Use the Import Languages dialog box to add the languages to a View 
Designer project. Add up to 20 different languages in one application. 

View Designer creates and exports a language file that contains the 
user-editable text strings in a project. After the strings are translated, 
import the language file to add the languages to the project. 

Use the Import Languages dialog box to: 

• Select the translated language file. 
• View the language changes made to the View Designer project.  

See also 
Import a language file on page 671 

Export text strings for language translation on page 670 

About changing the project language on page 675 

Add an event command to change the language on the HMI 
device on page 460 

View Designer creates and exports a language file that contains the 
user-editable text strings in a project. After the strings are translated, 
import the language file to add the languages to the project. 

To import a language file 
1. Select Tools > Import Languages. 
2. On the Import Languages dialog box, next to the Language file 

box select Browse and select the translated language file.  
The Import language changes box lists the language changes 
that will be made to the project: 
• Languages Added 
• Languages Updated 
• Languages Removed 
• Invalid Languages  

Import Languages dialog 
box 

Import a language file 
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Tips: 
•  View Designer supports .xlsx and .txt file formats only. 
• If importing a file with a name that does not have a file extension, or has an file extension that is 

not supported, View Designer appends the file to the default .xlsx format. 
• Invalid language data imports but does not download to the HMI device. 
• When exporting the language file, all language data in the project exports, including any previously 

imported language data that is invalid. 
View Designer only imports localizable and unlinked properties. 

3. Select Import. 
4. Save the project. 

See also 
Import Languages dialog box on page 671 

Export text strings for language translation on page 670 

About changing the project language on page 675 

Add an event command to change the language on the HMI 
device on page 460 

Add a language file to a View Designer project to display user-editable 
text strings in a specific language on the HMI device. Select the 
language to display during the download process. 

To add a language file to a View Designer project 
1. Select Tools > Export Languages. 
2. In the Select current language list, select the language in which 

the project was created.  
3. In the Selected language for localization box, select one or 

more languages for translating the strings. 

 
Tips:  
• View Designer does not support the Spanish (Spain, Traditional Sort) language that is supported in 

Studio 5000 Logix Designer®.  
• When opening the exported language file in Microsoft Excel, the selected languages appear as 

column headers. Languages currently in the project are always included in the export operation, 
and are not available for selection. 

4. In the Export language file to box, select Browse to browse to 
and select the location to which to save the language file. 

 
Tips:  
• The default path and file name is C:\Users\username\Documents\Studio 5000\Projects\Project 

name_Language.xlsx.  
• View Designer supports .xlsx and .txt file formats only.  
• If a file name does not have a file extension, or has an file extension that is not supported, View 

Designer appends the file to the default .xlsx format. 
• View Designer only exports localizable and unlinked properties. 

5. Open the exported file using Excel.  

 
Tip: Excel does not size cells automatically to display data in its entirety. To ensure that all of 
the data displays, auto-size the height and width before editing the spreadsheet. 

6. Select Tools > Import Languages. 
7. On the Import Languages dialog box, next to the Language file 

box select Browse and select the translated language file. 

Add a language to a View 
Designer project 



Chapter 23  Switch languages 
 

 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023 673 
 

The Import language changes box lists the language changes 
that will be made to the project: 
• Languages Added 
• Languages Updated 
• Languages Removed 
• Invalid Languages  

 
Tips:  
• Invalid language data imports but does not download to the HMI device. 
• When exporting the language file, all language data in the project exports, including any previously 

imported language data that is invalid. 
• Only localizable and unlinked properties are imported. 

8. Select Import. 
9. Save the project. 

See also 
Download a runtime application to an HMI device on page 710 

About changing the project language on page 675 

Add an event command to change the language on the HMI 
device on page 460 

Create an event command to change that language that displays the 
runtime application on the HMI device. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to change the language on the HMI device 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the Language category and select Switch Language. 
4. In the Switch Language To list, select a language.  

See also 
Add a language to a View Designer project on page 672 

Import a language file on page 671 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Add an event command to 
change the language on the 
HMI device 
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Trigger an action on a Key Press or a Key Release event on page 
451 

About changing the project language on page 675 

Remove a language from a View Designer project when the language is 
no longer needed. 

To remove a language from a View Designer project 
1. Select Tools > Export languages. 
2. In n the Select current language list, select the language in 

which the project was created.  
3. In the Selected language for localization box, select one or 

more languages for translating the strings. 

 
Tips: 
• View Designer does not support the Spanish (Spain, Traditional Sort) language that is supported in 

Studio 5000 Logix Designer®.  
• When opening the exported language file in Microsoft Excel, the selected languages appear as 

column headers. Languages currently in the project are always included in the export operation, 
and are not available for selection. 

4. In the Export language file to box, select Browse to browse to 
and select the location to which to save the language file.  

 
Tips: 
• The default path and file name is C:\Users\username\Documents\Studio 5000\Projects\Project 

name_Language.xlsx.  
• View Designer supports .xlsx and .txt file formats only.  
• If a file name does not have a file extension, or has an file extension that is not supported, View 

Designer appends the file to the default .xlsx format. 
• View Designer only exports localizable and unlinked properties. 

5. Open the exported file using Excel. 
6. Locate and delete the column for the language to remove from the 

project, and save the file. 
7. Select Tools > Import Languages. 
8. On the Import Languages dialog box, next to the Language file 

box select Browse and select the translated language file.  
The Import language changes box lists the language changes 
that will be made to the project: 
• Languages Added 
• Languages Updated 
• Languages Removed 
• Invalid Languages  

 
Tips: 
• Invalid language data imports but does not download to the HMI device. 
• When exporting the language file, all language data in the project exports, including any previously 

imported language data that is invalid. 
• Only localizable and unlinked properties are imported. 

9. Select Import. 
10. Save the project. 

See also 
Add a language to a View Designer project on page 672 

Remove a language from a 
View Designer project 
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About changing the project language on page 675 

Download a runtime application to an HMI device on page 710 

Studio 5000 HMI devices support Logix tag extended property strings, 
such as tag descriptions. If no languages are set up in the Logix project, 
the HMI device displays the default extended property strings defined in 
the Logix project. If languages are set up in the Logix project, the HMI 
device displays only the extended property strings created for the 
English-United States language.  

Graphic elements that reference unconfigured Logix tag extended 

properties show an Error icon . These graphic elements handle Logix 
tag extended properties in specific ways:  

• Numeric Display. Dashes appear if .@Min or .@Max are not 
configured for the tags in the Logix Designer project file (.acd). 

• Text Display. The Error icon  appears if .@EngUnit, .@State0, 
.@State1, or .@Description is not configured for the tag in the 
Logix project. If .@EngUnit, .@State0, .@State1, or 
.@Description is configured for the tag in the Logix project but left 
blank, the graphic element appears blank.   

Studio 5000 HMI devices support the Logix STRING data type. Standard 
ASCII characters are encoded with values 0 through 127 with each 
standard ASCII character encoded in a single byte of the STRING data 
type. The HMI device can read and write standard ASCII characters 
using this standard encoding.  

The HMI device uses UTF-8 encoding to read and write string tags 
containing multi-byte characters to a controller using the STRING data 
type. UTF-8 encodes multi-byte character sets by breaking down 
complex characters, such as Unicode characters, into multi-byte 
representations. The Logix 5000 controller can then store complex 
characters in the STRING byte array. 

 
Tips:  
• The maximum length of a text display reading from a String data type in a controller is 476 

characters. 
• If the String is encoded using UTF-8, the text display may not show 476 characters because each 

character may take multiple bytes of data. 

See also 
Use the runtime application on page 728 

Alarm screens on page 774 

Troubleshoot on page 829 

 

Use View Designer to select a language to display on the HMI device. 
This feature enables you to display the runtime application in a language 
the operator understands.  

In View Designer, select the language or languages from a predefined 
list. View Designer creates a language file when you export the selected 
languages. Open the file using Microsoft Excel. The language file 

Language handling and 
STRING data type support in 
View Designer 

About changing the project 
language 
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contains a KEY column that contains all of the user-editable text strings in 
the project.  

The selected languages are used as the headings for the other columns 
in the spreadsheet. Enter the translation for each item in the spreadsheet 
in the appropriate column.  

Import the language file to add the languages to the View Designer 
project. When you download the project to the HMI device, select the 
project language using the Download Runtime Application wizard. 

 
Tip: Only content that can be localized and unlinked properties can be imported or exported.  

These items display in the selected language: 

• Controller extended tag properties. 
• Controller alarm strings. 
• User-editable text strings. 

 
Tips:  
• Alarm history is always logged in the language chosen as the default language in Project Properties 

> Language. 
• The alarm history viewer element shows the content of the alarm history log. It does not switch the 

language of the alarm messages because the messages are only logged in one language. 
• If an alarm message configuration changes in the controller, the alarm history viewer element 

displays the old alarm message for alarm transitions prior to the change and the new alarm 
message for alarm transitions after the change. 

• Items that do not display in the selected language include: 
• Error messages. 
• Non-user-editable text strings, such as the column headings in the Alarm Summary or text that 

is built into a graphic element. 
• If there is a duplicate language column in the language file, such as two en-US columns, View 

Designer imports the data in the right-most column. 

 

See also 
Export Languages dialog box on page 669 

Import Languages dialog box on page 671 

Add a language to a View Designer project on page 672 

Download a runtime application to an HMI device on page 709 

Add an event command to change the language on the HMI 
device on page 460 
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Chapter 24 

Emulate a project 

Emulate a project to depict the project as it is to appear on the HMI 
device. The project screens and the HMI device that displays the 
downloaded project appear in the View 5000 Emulator window.  

Use the Emulator to: 

• Verify project content, behavior, and navigation as it is to appear 
on the physical HMI device. 

• Verify a project when there is no physical HMI device.  
• Test a project before impacting the physical system. 

Only one instance of the Emulator can be running on a computer at a 
time.  

Emulate the project after setting the Emulator to Controller path for 
each referenced controller in the project properties.   

Setting the Emulator to Controller path to the same path for multiple 
controller references displays duplicate alarms in the Alarm Summary 
and the Alarm Manager. Each alarm in the controller displays for each 
controller reference that has the same Emulator to Controller path. 

The Emulator depicts PanelView 5000 HMI devices. Changes made to 
the project after starting the Emulator do not emulate. The Emulator runs 
for two hours before closing automatically. Manually close the Emulator 
at any time.  

See also 
Start the Emulator on page 678 

Close the Emulator on page 679 

Emulator scaling for an HMI device on page 680  

View 5000 Emulator contents on page 681 

Tags not supported by the Emulator on page 680 

How do I open the Emulator? 

Click  Emulate Project or on the Menu bar, click PROJECT > 
Emulate Project. 
Use the View 5000 Emulator window to see the behavior of the View 
Designer project before downloading it to the physical system. Interact 
with the project screen and depicted HMI device to verify that:  

• Screen content displays correctly 
• Screen navigation works correctly 
• Key and touch actions work correctly 

Emulate a project 

View 5000 Emulator window 
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The View 5000 Emulator windows displays the project being emulated 
and the target PanelView 5000 HMI device of the project.   

See also 
Emulate a project on page 677 

Start the Emulator on page 678 

Close the Emulator on page 679 

Emulator scaling for an HMI device on page 680 

View 5000 Emulator contents on page 681 

Start the Emulator to view and test the behavior of the open project. This 
verifies the project before downloading it to the Emulator. Emulate a 
project for each open instance of View Designer. 

Prerequisites 
• Add controller references to the project and set the Emulator to 

Controller path in the References tab for each referenced 
controller in the project properties. This path allows the Emulator 
to emulate the data from the Logix Designer project file (.acd) in 
the View Designer project file (.vpd). 

 
Tip: Setting the Emulator to Controller path to the same path for multiple controller 
references displays duplicate alarms in the Alarm Summary and the Alarm Manager. Each 
alarm in the controller displays for each controller reference that has the same Emulator to 
Controller path. 

• To emulate a different project, close the View 5000 Emulator 
window. Only one instance of the Emulator can run on a computer 
at one time.  

To start the Emulator 

1. In the open project, select  Emulate Project. The Emulate 
Project dialog opens and shows progress as View Designer 
verifies and then starts the runtime application. The Emulate 
Project dialog box closes automatically when the Emulator starts. 

 
Tips:  
• The verification process when downloading a project to the Emulator is the same verification 

process that occurs when downloading a project to the HMI device. The process verifies the syntax 
of all expressions, the elements and properties referenced in expressions, and the existence of all 
project tags in the referenced controller projects.   

• If View Designer encounters a problem, the Emulate Project window indicates that there is an 
error. Any errors to correct appear in the Errors window below the View Designer screen. Select 
Close to close the Emulate Project window, use the Errors window to navigate to the source of the 
error. Resolve all errors before restarting the Emulator. 

2. The View 5000 Emulator window opens and shows the initial 
screen of the project and the specified PanelView 5000 HMI 
device.  

3. Interact with the project in the View 5000 Emulator window:  

Start the Emulator 
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• Interact with screens in the project as if the screen appears on 
the target PanelView 5000 HMI device. For example, select 
items.  

• Interact with the HMI device by selecting buttons on the 
depicted PanelView 5000 HMI device. 

• Interact with the HMI device through an external keyboard: 
• L1 through L10 on an HMI device keypad correspond with 

Shift+F1 through Shift+F10 on an external keyboard. 
• R1 through R10 on an HMI device keypad correspond with 

Ctrl+F1 through Ctrl+F10 on an external keyboard.  

 
Tips:  
• Selecting PROJECT > Emulate Project starts the Emulator. 
• View Designer does not emulate changes made to the project after the starting the Emulator. Close 

and restart the Emulator to continue emulating the project.  
• The Emulator does not support: 
• HMIBC buttons.  
• Certain settings and interactions with the HMI device: 
• Rebooting the HMI device.  
• Calibrating the touch screen of an HMI device. 
• Changing the brightness of the HMI device. 
• Changing the IP address of the HMI device. 
• Viewing diagnostic information for the HMI device. 
• Configuring the date and time of the HMI device. 
• Setting the time zone of the HMI device. 
• Configuring the screen saver of the HMI device.  
• Importing a troubleshooting profile. 
• Exporting a troubleshooting log. 

See also 
Emulate a project on page 677 

View 5000 Emulator window on page 677 

Tags not supported by the Emulator on page 680 

Add a controller reference on page 85 

View 5000 Emulator contents on page 681 

Close the View 5000 Emulator window to stop emulating the open 
project.  

To close the Emulator 
• Perform one of the following to close the Emulator: 

• Select  in the View 5000 Emulator window.   
• Close the open View Designer project. 
• Close View Designer. 

 
Tips:  
• Running the emulator for two hours automatically closes the Emulator. 
• Before the Emulator closes automatically after two hours, a banner below the title bar of the View 

5000 Emulator window indicates that the Emulator closes in five minutes. 

Close the Emulator 
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See also 
Emulate a project on page 677 

View 5000 Emulator window on page 677 

Start the Emulator on page 678 

Emulator scaling for an HMI device on page 680 

View 5000 Emulator contents on page 681 

The View 5000 Emulator window scales to fit the depicted HMI device. If 
the HMI device does not fit in the View 5000 Emulator window, the size 
of the HMI device scales to fit the View 5000 Emulator window. View 
Designer scales the window to show the full depiction of the HMI device 
without having to scroll. 

See also 
Emulate a project on page 677 

View 5000 Emulator window on page 677 

Start the Emulator on page 678 

Close the Emulator on page 679 

View 5000 Emulator contents on page 681 

Some tags associated with configuring settings on the HMI device at 
runtime are not supported in the Emulator. For example, changing the 
time zone when emulating a project is not supported. Tags not supported 
when emulating a project include:  

HMI Device Setting Tag 

Date/Time ::Local:HMIDevice.DateTime.DateConfig 
::Local:HMIDevice.DateTime.TimeConfig 
::Local:HMIDevice.DateTime.TimeZoneConfig 

Device ::Local:HMIDevice.Device.AmbientTemp 
::Local:HMIDevice.Device.CPUFrequency 
::Local:HMIDevice.Device.CPUTemperature 
::Local:HMIDevice.Device.CPUUtilization 
::Local:HMIDevice.Device.DLRTopology 
::Local:HMIDevice.Device.DownloadsEnabled 
::Local:HMIDevice.Device.EnetNetworkCount 
::Local:HMIDevice.Device.FirmwareMajorRev 
::Local:HMIDevice.Device.FirmwareMinorRev 
::Local:HMIDevice.Device.HardwareMajorRev 
::Local:HMIDevice.Device.HardwareMinorRev 
::Local:HMIDevice.Device.HardwareProductCode 
::Local:HMIDevice.Device.HardwareProductType 
::Local:HMIDevice.Device.HostNameConfig 
::Local:HMIDevice.Device.LastBootupTime 
::Local:HMIDevice.Device.MemoryFree 
::Local:HMIDevice.Device.MemoryTotal 

::Local:HMIDevice.Device.MemoryUsed 
::Local:HMIDevice.Device.ProductName 

Emulator scaling for an HMI 
device 

Tags not supported by the 
Emulator 
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HMI Device Setting Tag 

::Local:HMIDevice.Device.StorageFree 
::Local:HMIDevice.Device.StorageTotal 

::Local:HMIDevice.Device.StorageUsed 
::Local:HMIDevice.Device.TotalOnTime 

Display ::Local:HMIDevice.Display.BacklightIntensity 
::Local:HMIDevice.Display.ResolutionHorizontal 
::Local:HMIDevice.Display.ResolutionVertical 
::Local:HMIDevice.Display.ScreenSaverEnabled 
::Local:HMIDevice.Display.ScreenSaverImagePath 
::Local:HMIDevice.Display.ScreenSaverIntensity 
::Local:HMIDevice.Display.ScreenSaverTime 

Ethernet ::Local:HMIDevice.Enet[n].DHCPConfig 
::Local:HMIDevice.Enet[n].Domain 
::Local:HMIDevice.Enet[n].Gateway 
::Local:HMIDevice.Enet[n].GatewayConfig 
::Local:HMIDevice.Enet[n].IPAddressConfig 
::Local:HMIDevice.Enet[n].MACAddress 
::Local:HMIDevice.Enet[n].PrimaryDNS 
::Local:HMIDevice.Enet[n].PrimaryDNSConfig 
::Local:HMIDevice.Enet[n].SecondaryDNS 
::Local:HMIDevice.Enet[n].SecondaryDNSConfig 
::Local:HMIDevice.Enet[n].SubnetMask 
::Local:HMIDevice.Enet[n].SubnetMaskConfig 
::Local:HMIDevice.Enet[n].TertiaryDNS 
::Local:HMIDevice.Enet[n].TertiaryDNSConfig 
::Local:HMIDevice.EnetLink1.FullDuplex 
::Local:HMIDevice.EnetLink1.FullDuplexConfig 
::Local:HMIDevice.EnetLink1.LinkSpeed 
::Local:HMIDevice.EnetLink1.LinkSpeedConfig 

See also 
View 5000 Emulator contents on page 681 

Start the Emulator on page 678 

Emulate a project on page 677 

View 5000 Emulator window on page 677 

An example project and the target HMI device in the View 5000 
Emulator window includes: View 5000 Emulator 

contents 
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Item Description 

 
The View 5000 Emulator window title bar with the name of the target PanelView 5000 HMI device 
and the View Designer emulated project.  

 
The screen of the View Designer project as it is to appear on the physical HMI device. Select items 
to interact with the screen as if using touch or key actions on the physical HMI device.  

 
The target emulated PanelView 5000 HMI device. Interact with the HMI device as if it is the 
physical HMI device. For example, select a button on the HMI device in the View 5000 Emulate 
window.  

See also 
Emulate a project on page 677 

View 5000 Emulator window on page 677 

Start the Emulator on page 678 

Tags not supported by the Emulator on page 680 

Emulator scaling for an HMI device on page 680 

How do I open Emulate Project dialog box?  

Click  Emulate Project.  
The Emulate Project dialog box indicates that View Designer: 

• Downloads the project to the Emulator 
• Builds the runtime application 
• Starts the runtime application 

The Emulate Project dialog box closes automatically when the 
application starts and the View 5000 Emulator window opens to 
depict the project.  

Emulate Project dialog box 
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Tips:  
• The verification process when downloading a project to the Emulator is the same verification 

process that occurs when downloading a project to the HMI device. The process verifies the syntax 
of all expressions, the elements and properties referenced in expressions, and the existence of all 
project tags in the referenced controller projects.   

• If View Designer encounters a problem, the Emulate Project window indicates that there is an 
error. Any errors to correct appear in the Errors window below the View Designer screen. Select 
Close to close the Emulate Project window, use the Errors window to navigate to the source of the 
error. Resolve all errors before restarting the Emulator. 

See also 
Emulate a project on page 677 

Start the Emulator on page 678 

View 5000 Emulator contents on page 681 

Tags not supported by the Emulator on page 680 
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Chapter 25 

Set security 

View Designer security provides the ability to control access to the 
runtime application by controlling access to:  

• The HMI device  
• Individual screens, shortcuts, and popups  
• Graphic elements 
• Downloads to the HMI device 

Security is project-specific, not application-wide, and applies only to user 
(role) runtime access. 

Use the Security Administration dialog box to set up access rights for 
anyone interacting with the HMI device. 

See also 
Security overview on page 698 

Add a Security Administration user account on page 688 

Restrict access to an item on the HMI device on page 354 

Enable VNC access rights to an HMI device on page 700 

Security roles on page 690 

How do I open the Security Administration dialog box? 

On the Menu bar, click TOOLS > Security Administration. 

Use the Security Administration dialog box to: 

• Add and remove users 
• Assign roles and passwords to users 
• Determine the role of the Guest user 
• Configure password policies 
• Configure access rights for users remotely connecting an HMI 

device 

See also 
Add a Security Administration user account on page 688 

Restrict access to the HMI device on page 695 

Configure password security policies on page 687 

Enable VNC access rights to an HMI device on page 700 

Security overview on page 698 

Set security 

Security Administration 
dialog box 
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How do I open the HMI Device tab? 

On the Menu bar, click PROJECT > Project Properties and click the 
HMI Device tab. 

Use the Log On Method tab on the Project Properties dialog box to 
specify how users log on to the HMI device. You can require users to log 
on with a user name and password, or with a PIN. 

Use the Security Administration dialog box to specify the password 
and/or PIN for each user.  

See also 
Project Properties dialog box on page 68 

Security Administration dialog box on page 685 

Restrict access to the HMI device on page 695 

Security overview on page 698 

How do I open the Policies tab? 

On the Menu bar, click TOOLS > Security Administration, and on the 
Security Administration dialog box, click the Policies tab. 

Use the Policies tab on the Security Administration dialog box to 
configure the password policies to be used by the target HMI device. The 
policies specify the requirements the password must meet. 

See also 
Security Administration dialog box on page 685 

Configure password security policies on page 687 

Security overview on page 698 

How do I open the Users tab? 

On the Menu bar, click TOOLS > Security Administration, and from 
the Security Administration dialog box, click the Users tab. 

Use the Users tab on the Security Administration dialog box to: 

• Create, delete, or sort user accounts for each person who 
interacts with the HMI device.  

• Assign the password and/or PIN for users to log on to the HMI 
device. 

• Assign a role to each user. 
• Change the default role of the Guest user. None grants the Guest 

user access to the Home screen only. Any non-Administrator role, 
including None,  prevents any non-Administrator user from 
changing settings on the HMI device.  

Log On Method tab 

Policies tab 

Users tab 
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See also 
Security Administration dialog box on page 685 

Add a Security Administration user account on page 688 

Delete a Security Administration user account on page 691 

Security roles on page 690 

Security overview on page 698 

 Use the Policies tab on the Security Administration dialog box to 
create security policies, such as password complexity and length, for 
user authentication. Assign the password on the card for each user on 
the Users tab. 

Prerequisites 
• On the Project > Project Properties > Log On Method tab, 

verify that Use user name/password for logging on is selected. 

To configure password security policies 
1. Select Tools > Security Administration. 
2. Select the Policies tab. 
3. Change the password settings as needed:  

• Log off the user after a period of inactivity. Set in minutes 
how long the user has to remain inactive to be automatically 
logged out. 

• Minimum password length. Specify the minimum amount of 
characters required. The maximum number allowed is 14. 

• Password history. Type the number of previous passwords to 
remember. This enforces a password history and sets how 
frequently you can reuse old passwords. The maximum number 
allowed is 24.  

• To disable this feature, set the Number of Passwords to 
Remember to zero. 

• Passwords must meet complexity requirements. Select this 
option to enforce complexity requirements when you create or 
change passwords. 

 
Tip: Passwords that meet complexity requirements must: 
• Not contain the User Name. 
• Not contain any portion of the Full Name. 
• Contain characters from three of four categories: 
• Uppercase characters of European languages (A through Z, with diacritic marks, 

Greek and Cyrillic characters) 
• Lowercase characters of European languages (a through z, sharp-s, with diacritic 

marks, Greek and Cyrillic characters) 
• Numbers 0 through 9 

Non-alphanumeric characters ~!@#$%^&*_-+=`|\(){}[]:;"'<>,.?/ 

4. Select OK to save the changes and close the Security 
Administration dialog box. 

Configure password 
security policies 
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See also 
Security Administration dialog box on page 685 

Policies tab on page 686 

Users tab on page 686 

Restrict access to the HMI device on page 695 

Secure an application on the HMI device by logging off users 
automatically after a certain period of inactivity on the HMI device. 
Manually logging off is still supported when Auto-Logoff is enabled. When 
the auto-logoff occurs, the Guest user role is active. Configure 
Auto-Logoff through either the security policies for the application or by 
using AutoLogoff system tags. 

To configure Auto-Logoff 
1. Select Tools > Security Administration. 
2. Select the Policies tab. 
3. Under Auto-Logoff Policies, select Log off the user after a 

period of inactivity. 
4. In the minutes box, type the number of minutes up to 1440. Select 

the arrows to increase or decrease the number of minutes of 
inactivity before auto-logoff occurs. 

5. Select OK to save changes and close the Security 
Administration dialog box, or select Apply to save changes and 
keep the Security Administration dialog box open. 

 
Tips:  
• Playing videos and accessing IP cameras through the web browser does not prevent the 

auto-logoff. 
• To configure Auto-Logoff through tag binding, bind to the AutoLogoffEnable and AutoLogoffDelay 

system tags on the local HMI device. 
• The AutoLogoffRemainingTime system tag displays the time remaining, in seconds, before 

auto-logoff occurs. 

See also 
Security Administration dialog box on page 685 

Policies tab on page 686 

Users tab on page 686 

Restrict access to the HMI device on page 695 

System tags: Device on page 539 

To control user access to the runtime application at different levels, 
create a user account for every person that will interact with the HMI 
Device. Assign a security role and password and/or PIN to each user. It 
is recommended to define no more than 500 users.  

Configure Auto-Logoff 

Add a Security 
Administration user 
account 
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To add a Security Administration user account 
1. Select Tools > Security Administration and select the Users 

tab.  
2. Select Add user  or start typing in the last user card to create a 

new user card. 

 
Tip: Typing in the User Name box opens a card for data entry.  

3. In the User Name box, type the name that the user will use to log 
on to the HMI device. This name displays in the banner on the HMI 
device. 

 
Tips:  
• The name can contain up to 40 characters of numbers, letters, and underscores.  
• The name must not begin with a number, contain spaces, have more than one underscore in a row, 

or end with an underscore. 
• The User Name box cannot contain Unicode characters.   

4. (optional) In the Full Name box, type the first and last name, up to 
100 characters, of the user.  

5. (optional) In the Description box, type a description, up to 100 
characters, of the user. 

6. In the Role box, select the security role to assign to the user.  
7. Enter and confirm the password and/or PIN the user will use to log 

on to the HMI device.  
• Passwords must adhere to the policies you configured on the 

Policies tab on the Security Administration dialog box.  
• PINs must have a minimum of four numbers and a maximum of 

eight numbers.  
• If Password Must Meet Security Requirements is selected 

on Policies tab, passwords must meet complexity 
requirements. 

• Passwords can contain Unicode characters.  

 
Tip: To meet complexity requirements, passwords must: 
• Not contain the User Name. 
• Not contain any portion of the Full Name. 
• Contain characters from three of the following four categories: 
• Uppercase characters of European languages (A through Z, with diacritic marks, 

Greek and Cyrillic characters) 
• Lowercase characters of European languages (a through z, sharp-s, with diacritic 

marks, Greek and Cyrillic characters) 
• Numbers 0 through 9 

Non-alphanumeric characters ~!@#$%^&*_-+=`|\(){}[]:;"'<>,.?/ 

8. Select OK to save the changes and close the Security 
Administration dialog box, or select Add User  to continue 
adding users. 

 
Tips:  
• Copy and paste Security Administration user accounts from other View Designer projects to save 

time. 
• To reset the password for a user, select Reset on the account card for that user. 

See also 
Security Administration dialog box on page 685 

Restrict access to the HMI device on page 695 
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Configure password security policies on page 687 

Copy a Security Administration user account on page 432 

Security roles on page 690 

In View Designer security, a user is comparable to a Windows user 
account, and a role is comparable to a Windows user group. No specific 
behavior is assigned to each role.  

Assign a role to each user on the Security Administration > Users tab. 
The assigned role determines which screens the users in the role can 
access according to the security settings for the screens. All users have 
the Operator role by default.  

The View Designer roles to assign to users include:    

Role Responsibility 
Administrator Administering the system, such as adding users and 

assigning passwords. This security role is assigned to 
Guest users by default.  

Engineer Automating the machine and creating or setting the 
direction of the HMI. 

Maintenance Keeping the system running at maximum efficiency, and 
using the HMI screens to troubleshoot, diagnose, and 
maintain equipment. 

Operator Running the machine or process, and using the HMI 
project to view and interact with the process. This 
security role is assigned to new users by default. 

Restricted Activities requiring less access than an Operator. 
Determine screen access based on business needs. This 
role prevents any non-Administrator user from changing 
settings on the HMI device.  

Supervisor Overall production of the machine or plant and uses the 
HMI screens for critical information, such as the product 
production, production rate, downtime, and product 
quality. 

None Indicates that no role is associated with the Guest user. 
This option is available for the Guest user account only. 
Assigning this role grants the Guest user access to only 
the Home screen.  

See also 
Security Administration dialog box on page 685 

Add a Security Administration user account on page 688 

What is the Guest user? on page 696 

Assign a role to the Guest user on page 693 

Security overview on page 698 

Copy a Security Administration user account to reuse the information 
within and across View Designer projects. Copy individual items from the 
user account or copy an entire user account card including the password 
and PIN. 

Security roles 

Copy a Security 
Administration user 
account 
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Prerequisites 
• Open the source View Designer project containing the content to 

copy. 
• If the content is to be pasted into another project, for each project, 

start an instance of View Designer and open the target project. It is 
recommended to open no more than three instances of View 
Designer at one time. 

To copy a Security Administration user account 
1. In the source project, select Tools > Security Administration. 
2. Select the Users tab to display the User Accounts box.  
3. In the User Accounts box, select a user account card, and then 

right-click and select Copy. 
• To copy a single item, highlight the item, and then right-click and 

select Copy. 
4. In each target project in the User Accounts box, select a card 

(outside of the User Name box), right-click and select Paste. The 
card pastes below the currently selected card. 
• If a new user card is selected, the card pastes above it. 
• To paste a single item, right-click the appropriate box on the 

user account card and select Paste. 
5. Select OK to apply the changes and close the dialog box. 

 
Tips:  
• Copy only one user card at a time. 
• A red outline around a box on a user account card indicates an error condition, such as a duplicate 

name or PIN. You must correct all errors before you can save the changes. 
• Cut a Security Administration user account by selecting Cut instead of Copy. 

See also 
Security Administration dialog box on page 685 

Users tab on page 686 

Add a Security Administration user account on page 688 

Security overview on page 698 

Delete a Security Administrator user account if, for example, a user no 
longer requires access to the HMI device. 

To delete a Security Administration user account 
• Select Tools > Security Administration, and select the Users 

tab. 
• On the card for the user, select Remove . 

Delete a Security 
Administration user 
account 
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See also 
Security Administration dialog box on page 685 

Users tab on page 686 

Restrict access to the HMI device on page 695 

Configure password security policies on page 687 

Security overview on page 698 

Change user account information for Security Administration, for 
example, to change the password. 

To change Security Administration user account information 
1. Select Tools > Security Administration and select the Users 

tab. 
2. Select the user card. 
3. Change any or all of the information. 

See also 
Security Administration dialog box on page 685 

Users tab on page 686 

Restrict access to the HMI device on page 695 

Configure password security policies on page 687 

Security overview on page 698 

Sort Security Administration user accounts by Full Name, Role, or User 
Name. 

To sort Security Administration user accounts 
1. Select Tools > Security Administration and select the Users 

tab. 
2. In the Sort by box, select an option from the list.  

See also 
Security Administration dialog box on page 685 

Users tab on page 686 

Restrict access to the HMI device on page 695 

Configure password security policies on page 687 

Security overview on page 698 

Change a Security 
Administration user 
account 

Sort Security 
Administration user 
accounts 
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A Guest user interacts with an HMI device without logging on to the 
device. Assign any of the predefined roles to the Guest user, or select 
None to limit the Guest user to only viewing the Home screen. 

To assign a role to the Guest user 
1. Select Tools > Security Administration and select the Users 

tab. 
2. In the Guest User section, in the Role box, select a role from the 

list.  

See also 
Security roles on page 690 

Security Administration dialog box on page 685 

Users tab on page 686 

Restrict access to the HMI device on page 695 

Configure password security policies on page 687 

By default, any user not logged into the project on the HMI device has 
Administrator access to the Settings screens. These screens in the 
Predefined Screens folder of the Project Explorer configure the HMI 
device at runtime. Limit the access guest users have to the Settings 
screens by assigning any role but the Administrator role. Users who are 
not assigned the Administrator have Read Only access to the Settings 
screens. This prevents non-Administrator users from disrupting the 
system. For example, a Guest user cannot reboot the HMI device. The 
user can still navigate to and open all of the Settings screens on the HMI 
device to review the HMI device settings and configuration.   

To restrict access settings on the HMI device 
1. Select Tools > Security Administration. The Security 

Administration dialog box opens.  
2. In the Guest User box after Role, select any role, including None, 

that is not the Administrator role. All options on the Settings 
screens on the HMI device are Read Only for any user except an 
administrator.  

See also 
Security Administration dialog box on page 685 

Set security on page 685 

Assign a role to the Guest user on page 693 

What is the Guest user? on page 696 

Security overview on page 698 

Assign a role to the Guest 
user 

Restrict access to settings 
on the HMI device 
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By default, all users on HMI devices have access to these items in the 
Project Explorer:  

• Shortcuts in the Navigation Menu folder. 
• Screens and popups in the User-Defined Screens and 

Predefined Screens folders. Navigate to these items on the HMI 
device by triggering an event with a navigation command. Users 
who do not have the Administrator role have read-only access to 
the Settings screen and related popups in the Predefined 
Screens folder.  

Change the access level for any item in the Project Explorer. Restrict 
access to an item for any role except the Administrator role. The 
Administrator role always has Inherit access, and the role inherits Full 
Access from the root folder. 

To restrict access to an item on the HMI device 
1. In the Project Explorer, expand the folder that contains the item 

to restrict access:   
• To select a screen or popup, expand the User-Defined 

Screens folder or the Predefined Screens folder.  
• To select a shortcut, expand the Navigation Menu folder.   

2. Select or double-click the item. The Properties window for the 
item opens. 

3. In the Properties window for the selected item, expand the 
Security category. 

4. After each role (Engineer, Maintenance, Operator, Restricted, and 
Supervisor), select the access option for each role. 
• Inherit. Grants the same access assigned to the parent folder. 
• Full Access. Grants access to open and interacts with the item, 

and shows the item in the Navigation menu on the HMI device. 
• Read Only. Grants access to open the item, but denies 

interaction with it. The item appears in the Navigation menu on 
the HMI device. Users assigned to a role with read-only access 
can still interact with the Navigation menu and alarm tables. 
For example, a user with read-only access to an alarm table can 
still perform read operations, such as viewing alarms and 
details, selecting alarms and conditions, filtering alarms, and 
pausing alarms. The user cannot perform write commands that 
change the state of an alarm.   

• No Access. Denies access to open or interact with the item. 
The item does not appear in the Navigation menu on the HMI 
device. 

5. To set individual role access to a shortcut, independent of the 
access to the screen on which the shortcut is based: 

a. Select the shortcut.  

b. In the Properties window of the selected shortcut, clear the 
UseScreenSecurity check box. 

c. Select the access level for each role.  

Restrict access to an item 
on the HMI device 
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Do not base the security for a shortcut on its defining screen if 
the user has access to some shortcuts of a screen but should 
not have access to a particular shortcut.    

See also 
Restrict access to the HMI device on page 695 

Restrict access to a graphic element on page 695 

Project Explorer on page 95 

Properties tab on page 494 

Security overview on page 698 

Restrict access to a graphic element to allow or disallow touch events. 
For example, prevent users from navigating to a screen in the project.  

To restrict access to a graphic element 
1. Select the graphic element on the screen. 
2. In the Properties window, expand the Security category. 
3. In the Access property box, select a security level from the list: 

• Inherit (default). The security level of the screen determines if 
the graphic element is enabled or disabled. Graphic elements 
that support cross-hatching when they are disabled display with 
cross-hatching. 

• Full Access. The security level of the screen is ignored and the 
state of the Enabled property for the graphic element is used to 
determine if the graphic element is enabled or disabled, and 
displays with cross-hatching. 

 
Tip: If the Enabled property check box for the graphic element is cleared, the graphic 
element is disabled and shows cross-hatching regardless of the Security Access property 
setting. 

See also 
Security Administration dialog box on page 685 

Restrict access to the HMI device on page 695 

Restrict access to an item on the HMI device on page 354 

Properties window on page 493 

Security overview on page 698 

Restrict access to the HMI device by selecting a method for users to log 
on to the HMI device:  

To restrict access to the HMI device  
1. On the Project > Project Properties > Log On Method tab, 

select a Security option: 

Restrict access to a graphic 
element 

Restrict access to the HMI 
device 
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• Use user name/password for logging on 
• Use PIN for logging on 

2. On the Tools > Security Administration > Users tab, enter a 
password or PIN for each user. 

3. (optional) On the Security Administration > Policies tab, adjust 
the complexity requirements for passwords  by specifying 
Password Policy Settings:  
• Log off the user after a period of inactivity. Set in minutes 

how long the user has to remain inactive to be automatically 
logged out. 

• Minimum password length. Specify the minimum amount of 
characters required. The maximum number allowed is 14. 

• Password history. Type the number of previous passwords to 
remember. This enforces a password history and sets how 
frequently you can reuse old passwords. The maximum number 
allowed is 24.  

• To disable this feature, set the Number of Passwords to 
Remember to zero. 

• Passwords must meet complexity requirements. Select this 
option to enforce complexity requirements when you create or 
change passwords. 

 
Tip: Passwords that meet complexity requirements must: 
• Not contain the User Name. 
• Not contain any portion of the Full Name. 
• Contain characters from three of four categories: 
• Uppercase characters of European languages (A through Z, with diacritic marks, 

Greek and Cyrillic characters) 
• Lowercase characters of European languages (a through z, sharp-s, with diacritic 

marks, Greek and Cyrillic characters) 
• Numbers 0 through 9 

Non-alphanumeric characters ~!@#$%^&*_-+=`|\(){}[]:;"'<>,.?/ 

See also 
Security Administration dialog box on page 685 

Add a Security Administration user account on page 688 

Configure password security policies on page 687 

Security overview on page 698 

The Guest user is logged on automatically upon starting up the system 
and logging off. Anyone who is not logged on or has no assigned security 
role has Guest user access to the HMI screens. Guest users can access 
only the screens that have the same level of security that is given to the 
Guest user account. By default, the role of the Guest user is 
Administrator so the Guest user can view all screens.  

The Guest user account saves time because it does not require users to 
log on to see HMI screens with a specific level of security. For example, 
to not require a user to log on before navigating screens with an 
Operator level of security, assign the Guest user the Operator security 
role.  

What is the Guest user? 
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To make the system more secure, assign the None security role to the 
Guest user. Users who are not logged on can then only view the Home 
screen regardless of the security assigned to any HMI screen.  

To ensure that only Administrator users can change the settings on the 
HMI device to, for example, reboot the HMI device, assign any role but 
Administrator to the Guest user. For example, assign the None role. 

See also 
Security Administration dialog box on page 685 

Add a Security Administration user account on page 688 

Assign a role to the Guest user on page 693 

Security roles on page 690 

Security overview on page 698 

Access to the HMI device is either through user name and password or 
PIN.  

Set up user accounts to access the HMI device on the Security 
Administration dialog box. Assign each user a password and/or PIN. 
Use the Policies tab on the Security Administration dialog box to 
create security policies such as password complexity and length and to 
enforce password strength. 

Use the Guest user account to restrict users that do not log in. Have the 
Guest user view only the Home screen or certain screens. 

The HMI Device screen in the Predefined Screens folder provides a 
way to prevent overwriting the runtime application in the HMI device. 
Clear Allow Downloads and Firmware Updates to prevent 
downloading a project or updating firmware on the HMI device. 

See also 
Security for screens, shortcuts, and popups on page 698 

Security for graphic elements on page 697 

There are two ways to secure graphic elements on a screen: 

• Disable a property in the Appearance category. Clearing the 
Enabled property for a graphic element prevents touch and key 
events for the graphic element. The graphic element appears 
cross-hatched regardless of the access assigned to the screen. 
Use this method if, for example, to disable a graphic element 
during a particular machine state. It is typical to set this security 
through binding for use at runtime.   

• Access property in the Security category. The Access 
property in the Security category works with the Enabled 
property and the cross-hatch functionality of graphic elements. 
When Access is set to Inherit, the graphic element uses the 
security of the current screen to either show the graphic element 
as enabled or disabled and cross-hatched. For example, if the 

Security for HMI devices 

Security for graphic 
elements 
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screen is Read Only, Access is set to Inherit, and Enabled is 
selected, the graphic element appears cross-hatched. If the 
current screen security changes to Full Access, this enables the 
graphic element.  
When Access is set to Full Access, the graphic element uses the 
state of the Enabled box to determine if the graphic element it is 
enabled or disabled and displays cross- hatched regardless of the 
security of the current screen. Use Full Access to enable a button 
with a screen navigation command even if the screen is ready 
only. The user on the HMI device can then navigate the project in 
Read Only mode. This enables all commands for the button, not 
just the screen navigation.  

See also 
Security for screens, shortcuts, and popups on page 698 

Security for HMI devices on page 697 

Access to HMI screens is based on role and not a specific user. A role is 
comparable to a Windows user group. Each user has a user account and 
an assigned role.   

By default, all users on HMI devices have access to items in the Project 
Explorer that include:  

• Shortcuts in the Navigation Menu folder 
• Screens and popups in the User-Defined Screens or Predefined 

Screens folders. Navigate to these items on the HMI device by 
triggering an event that has a navigation command.  

The root-level folder of a project is assigned Full Access, which gives 
users access to all items regardless of the assigned role of the user. The 
Navigation Menu, User-Defined Screens, and Predefined Screens 
folders inherit security access from the root folder.  

Each folder and screen has a Security category that specifies that the 
level of access for each role to individual screens or the contents of a 
folder. 

See also 
Security for HMI devices on page 697 

Security for graphic elements on page 697 

View Designer security provides the ability to control access to the 
runtime application by controlling access to:  

• The HMI device  
• Individual screens, shortcuts, and popups  
• Graphic elements 
• Downloads to the HMI device 

Security is project-specific, not application-wide, and applies only to user 
(role) runtime access. 

Security for screens, 
shortcuts, and popups 

Security overview 
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Security for the HMI device 
Access to the HMI device can be a user name and password or PIN. 

Set up user accounts on the Security Administration dialog box for 
everyone who interacts with the HMI device, and assign each user a 
password and/or PIN. Use the Policies tab on the Security 
Administration dialog box to create security policies, such as password 
complexity and length, to enforce password strength. 

Use the Guest user account to restrict users who are not logged in to be 
able to view only certain screens, or limit their access to viewing only the 
Home screen. Assign the Guest User any role except the Administrator 
role to prevent any non-Administrator user, including Guest users, from 
changing settings on the HMI device. This prevents any 
non-Administrator user from performing tasks such as rebooting the HMI 
device.  

Security for individual screens, shortcuts, and popups 
Access to HMI screens is based on user roles, and not specific users. A 
role is comparable to a Windows user group. When creating a user 
account for each user, assign the user a role.  

By default, all users on HMI devices have access to these items in the 
Project Explorer:  

• Shortcuts in the Navigation Menu folder. 
• Screens and popups in the User-Defined Screens and 

Predefined Screens folders. Navigate to these items on the HMI 
device by triggering an event with a navigation command. Users 
who do not have the Administrator role have read-only access to 
the Settings screen and related popups in the Predefined 
Screens folder.  

The root-level folder of a project is assigned Full Access, which gives 
users access to all items regardless of role. The Navigation Menu, 
User-Defined Screens, and Predefined Screens folders inherit security 
access from the root folder. The Settings screen and its related popups in 
the Predefined Screens folder have Ready Only access for any user 
who does not have the Administrator role. 

Each folder and screen has a Security category, which provides a way to 
select the level of access for each role for individual screens or the 
contents of a folder.  

Security for graphic elements 
There are two ways to secure graphic elements on a screen: 

• Enabled property in the Appearance category. When you clear 
the Enabled property check box for the graphic element, it 
disallows touch and key events for that graphic element and 
shows as cross-hatched regardless of the Security > Access 
property setting for the screen. For example, use this method if, 
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during a particular machine state, the HMI designer wants the 
graphic element disabled. This is generally used with binding and 
controlled at runtime.  

• Access property in the Security category. The Security > 
Access property works with the Enabled property and the 
cross-hatch functionality of graphic elements. When Access is set 
to Inherit, the graphic element uses the current screen Security 
setting to determine if it should be enabled or disabled and 
cross-hatched. For example, if the screen is Read Only, Access 
is set to Inherit, and the Enabled property is selected, the graphic 
element is disabled and displays cross-hatched. If the current 
screen security changes to Full Access, the graphic element is 
enabled and the cross-hatch does not show.  
When Access is set to Full Access, the graphic element uses the 
state of the Enabled property to determine if it is enabled or 
disabled and displays cross- hatched regardless of the current 
screen Security setting. For example, use this if the HMI designer 
wants a button with a screen navigation command to be enabled 
and active even if the screen Security level is Read Only so that 
the operator can navigate the project in Read Only mode. Use this 
capability with caution because all commands, not just screen 
navigation, for the button are enabled in this mode.  

Security for downloads to the HMI device 
The HMI Device screen in the Predefined Screens folder provides a 
way to prevent overwriting the runtime application in the HMI device. 
Clear the Allow Downloads and Firmware Updates check box on the 
HMI Device screen to prevent the download of a project or an update of 
the firmware on the HMI device. 

See also 
Security Administration dialog box on page 685 

Add a Security Administration user account on page 688 

Restrict access to the HMI device on page 695 

Restrict access to a graphic element on page 695 

What is the Guest user? on page 696 

Specify access rights by entering a password for view-only or full control 
access. Users gain access rights when remotely connecting to an HMI 
device. 

To configure VNC access rights to an HMI device: 
1. Select Tools > Security Administration. 
2. Select the VNC tab. 
3. In the desired access area, enter and confirm a password to 

remotely connect to the HMI device. If assigning different access 

Enable VNC access rights to 
an HMI device 
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rights for users, enter separate passwords in each area. Each user 
enters the password that grants the specified remote access. 
• VNC View-Only Access. Grants read-only access to an HMI 

device. 
• VNC Full-Control Access. Grants full interaction with an HMI 

device. 

 
Tips: 
•  Passwords must be between 6 and 8 characters in length. 
• The runtime application ignores any password characters beyond 8 characters entered. 
• A blank password disables access. For example, to enable Full-Control Access, leave the VNC 

View-Only Access password blank to disable, and then enter a password for Full-Control Access. 
• If passwords in the Password and Confirm boxes do not match, a red outline appears around the 

Confirm box and around the VNC tab. 
• Do not use the same password for View-Only and Full-Control access. If the same password is set 

for View-Only and Full-Control, View-Only access is assigned to all users remotely connecting to an 
HMI device.  

4. Select OK. 

 
Tip: To reset a password for an access type, select the Reset button next to the access type. 

 

 
Note: After rebooting the PanelView 5000 HMI device, the VNC server configuration automatically 
resets to the Disabled state. 

 

See also 
VNC tab on page 701 

Security Administration dialog box on page 685 

How do I open the VNC tab? 

On the Menu bar, click Tools > Security Administration, and on the 
Security Administration dialog box, click the VNC tab. 

VNC is a protocol used for remotely connecting to an HMI device. Use 
the VNC tab on the Security Administration dialog box to configure or 
change access rights for users remotely connecting to an HMI device. 
The available access rights are View-Only and Full-Control.  

See also 
Security Administration dialog box on page 685 

Enable VNC access rights to an HMI device on page 700 

Add URLs to the allowed locations list to grant users access to external 
resources through the Web Browser. The locations can be network 
locations, or files and folders on the removable media inserted in the HMI 
device. If the HMI device has multiple USB drives inserted, the drive 

VNC tab 

Add locations to the 
allowed locations list 
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inserted last is accessible. Add a maximum of 1000 locations. By default, 
the web browser blocks access to all locations not included on the 
allowed locations list. Add access to all servers used by the webpages 
that you add to the allowed locations list. Set access for different security 
roles. 

To add locations to the allowed locations list 
1. Select Tools > Security Administration and select the Web 

Content tab. 
2. Select Add URL . Focus sets on the new table row. 
3. Enter an URL using one of these schemes: 

• http:// 
• https:// 
• ws:// 
• wss:// 
• sd:/ 
• usb:/ 
• (optional) use a scheme with an IP address or a ranges of IP 

addresses 

 
Tips: 
• Use the asterisk * to substitute a character or a string of characters. 
• Enter a single asterisk in the row to allow the security role to access all possible URLs. 
• Enter *:// and an IP address to access a location that may use HTTP or HTTPS protocol. 
• Enter the schema without the rest of the URL to grant roles access to all locations using this 

schema. 
• When entering a range of IP addresses, place the range in parentheses, for example: 

http://1.1.1.(5-158) or use asterisk to represent all values in a decimal (0-255): https://1.1.1.*. 

4. Select the security roles to access to the URL. By default, all roles 
are selected. 

5. Select OK to save the changes and close the Security 
Administration window, or select Add URL  to add additional 
locations. 

See also 
Web browser on page 758 

Delete locations from the allowed locations list on page 702 

 

Delete locations that you no longer want users to access. Remove 
locations from the allowed location list. 

To delete locations from the allowed locations list 
1. Select Tools > Security Administration and select the Web 

Content tab. 
2. Select a row in the in the table. To select multiple rows, hold Ctrl 

when selecting. 
3. Press Delete. 

Remove locations from the 
allowed locations list 
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4. Select OK to save the changes and close the Security 
Administration window. 

 

Add ports to the list of open ports to allow the HMI device to 
communicate with devices and web services that use specific ports. Add 
a maximum of 1000 ports. 

To add ports to the list of open ports 
1. Select Tools > Security Administration and select the Ports 

tab.  
2. Select  Add ports to open. The focus automatically moves to 

the new list row. 
3. Enter a port number (1-65535) in the Port list. 
4. Select OK to save the changes and close the Security 

Administration window, or select  Add ports to open to 
continue adding ports. 

See also 
Delete ports from the list of open ports on page 703 

Remove ports from the list of open ports to no longer have the port open 
on the HMI device. 

To delete ports from the list of open ports 
1. Select Tools > Security Administration and select the Ports 

tab. 
2. Select a row in the in the table. To select multiple rows, hold Ctrl 

when selecting. 
3. Press Delete. 
4. Select OK to save the changes and close the Security 

Administration window. 

See also 
Add ports to the list of open ports on page 703 

Network-based security enables managing user accounts and user 
groups centrally. It allows network users to log on to an HMI device, 
authenticate with the Active Directory, and be granted authorization 
rights based on their role. 

When network-based logon is used for a project, local users still may be 
configured and used on the terminal (for example for back-up). You can 
switch to local users on the logon pop-up in runtime. 

 
Tip: Leaving the Connection fields blank will have the panel use local users at runtime. 

Add ports to open ports list 

Delete ports from the list of 
open ports 

Configure network-based 
security logon using Active 
Directory 
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Active Directory properties may vary depending on your company and 
the complexity of system architecture. If you find any problems during 
configuration, contact your Active Directory administrator. 

Prerequisites: 
Ensure that the logon method is set to use the user name and password: 

1. From the main menu, select Project > Project Properties. 
2. In the Project Properties window, select the Log On Method tab. 
3. Select the Use user name/password for logging on radio 

button. 
 

To configure network-based security logon: 
1. From the main menu, select Tools -> Security Administration. 
2. In the Security Administration window, select the Connection and 

Groups tab. 
3. In the Connection section, fill in the required fields. 
a. In the Domain Name field, enter your corporate domain. 

IMPORTANT During the Active Directory logon process, user name and configured Domain 
name are combined to define the User Principal Name, in the format 
<username>@<domain>.com. It is sent with a password to the domain 
controller for authentication. 
 
The username used for the User Principal Name must be used during Active 
Directory logon. 

EXAMPLE Correct format: jamessmith@domain.com,  
Incorrect format: domain.com\jsmith 
 

b. In the Domain Controller field, enter the full address of the 
Active Directory server. 

c. In the Port field, enter the number of the port. 

 
Tip: Typical default ports are: no encryption – 389, StartTLS – 389, LDAPS – 636. 

d. In the Domain Distinguished Name field, enter your domain 
distinguished name. 

EXAMPLE DC=domain,DC=com 

e. If the connection requires encryption, select the encryption 
method. 

IMPORTANT Not using encryption for network-based authentication results in sending 
username and password as plaintext over the network. This creates a 
security risk. 
 
To use StartTLS or LDAPS encryption for logon, you are required to import the 
proper security certificate to the terminal by using the Certificates setting 
screen. 
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4. In the Groups and Roles section, click  next to Add new User 
Group. 

 
Tip: You can add and define multiple groups. 

5. In the new section that appears, enter the following information: 
a. In the User Group Distinguished Name field, enter a 

distinguished name of a group. 

EXAMPLE CN=Operators,OU=Groups,DC=domain,DC=com 

b. In the dropdown menu next to the User Group Distinguished 
Name field, select the role you want to assign to the group. 

 
Tip: You can remove a group by clicking . 

At runtime, when someone logs in, the Active Directory returns the 
group membership of that user. Now this group is mapped to a 
role, so the user gets the security role mapped to the Active 
Directory group they belong to. If a user belongs to multiple groups 
with different roles, they will get the first role configured in this list. 
If a user does not belong to any group mappings, the user will 
receive an error message on the PanelView 5000 when they log 
on. 

6. Click OK. 

 
Tip: Active Directory properties may vary, depending on your company and the complexity 
of the system architecture. If You encounter any problems during configuration, contact 
your Active Directory administrator to obtain guidance or this configuration. 

See also 
Security roles on page 690 

To log on using network-based security: 
1. To log on to the application using your network-based security 

configuration, on the top of the screen, select the log on button 

. 
IMPORTANT The user name used for the User Principal Name must be used 

during Active Directory logon. 

2. Ensure that you are logging on as a domain user, enter your Active 
Directory user name and password, and Select Log on. 

Log on using 
network-based security 
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IMPORTANT When StartTLS or LDAPS encryption method is configured, you are 

required to import the proper security certificate to the terminal 
by using the Certificates setting screen. 
 
A caching mechanism is used for users who successfully logged on 
with Active Directory authentication. If the PanelView 5000 loses 
connection to the Active Directory, the user can still log on with 
cached domain credentials for 24 hours. After this period, logon is 
no longer possible without an Active Directory connection. The 
Cache is only cleared on project download, and not on reboot or 
restart. 

 
Tip: You can switch between a local user and a domain user by 
selecting the link at the bottom of the Logon screen. 
 
If the Connection information is left blank in View Designer, only 
local user logon will be used by the logon dialog at runtime. 

See also 
Import a digital certificate from removable media on page 772 

 

Caching of credentials occurs when the user was successfully logged on 
to a terminal via Active Directory service but the terminal lost the 
connection to service or service became unavailable. 

The cached credentials enable the user to logon with the domain logon 
and credentials used when the connection between the terminal and 
Active Directory worked. The cached credentials work for 24 hours after 
the last successful logon with AD. After 24 hours the cached credentials 
are deleted and the domain logon is not longer possible. 

 

Caching user credentials 
when using network-based 
security 
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Note:  
• The terminal restart or power down will not clear cache. When the terminal is running again, you 

can logon using cached credentials. 
• When a project is downloaded, the credentials cache is cleared and logon ached credentials is not 

possible. To logon, you need to connect the terminal the Active Directory or use a local user. 
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Chapter 26 

Download and upload a project 

Use the Download Runtime Application wizard to transfer a runtime 
application to an HMI device.  

View Designer verifies a project automatically when you download a 
project to the HMI device. Invalid tags or expressions are listed in the 
Errors window. 

See also 
Download Runtime Application wizard on page 709 

Download a runtime application to an HMI device on page 710 

Errors window on page 522 

Upload Runtime Application wizard on page 721 

How do I open the Download Runtime Application wizard? 

On the Menu bar, click Communications > Download. 

Use the Download Runtime Application wizard to build the runtime 
application from a project and transfer it to the HMI device.    

The wizard contains three pages: 

• HMI Device Location. Use this page to:  
• Specify the communication path from the computer running 

View Designer to the HMI device to which the runtime 
application is to download.  

• Specify the language to display if the project contains multiple 
languages. 

• Controller References. Shows the controller references for the 
project entered in the Controller References dialog box (Project 
> Project Properties > References). Use this page to verify the 
correct controller reference and project file are selected. 

• Download. This page shows the progress of the download 
process as View Designer saves and verifies the project, builds 
the runtime application, connects to the HMI device, and transfers 
the runtime application to the HMI device. 

If View Designer encounters a problem, an error message appears and 
the process stops. When View Designer finds invalid tags or expressions 
during project verification, the Errors window opens to list the warnings 
or errors associated with the tags or expressions. Resolve all errors 
before downloading the runtime application to the HMI device again.  

 

Download a runtime 
application to an HMI device 

Download Runtime 
Application wizard 
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IMPORTANT • When downloading the runtime application to an HMI device that has a different screen size or aspect 
ratio than the configured device, specify how screens are scaled on the Project Properties > Application 
tab before proceeding.  

When downloading a project or flashing an HMI device that has the screen saver running, the progress may 
not be visible. Stop the screen saver on the HMI device before beginning the download or flash process. 

See also 
Change the target HMI device for a project and select a Screen 
Scaling option on page 70 

Add a controller reference on page 85 

Errors window on page 522 

Verify a project on page 718 

About changing the project language on page 675 

Use the Download Runtime Application wizard to transfer a runtime 
application to an HMI device. 

IMPORTANT When downloading a project or flashing an HMI device that has the screen saver 
running, the progress may not be visible. Stop the screen saver on the HMI device 
before beginning the download or flash process. 

Prerequisites 
• Open the project to download to the HMI device.  

To download a project to the HMI device 
1. Select Communications > Download to open the Download 

Runtime Application wizard. 
2. Next to the Location box on the HMI Device Location page, 

select Browse  and select the IP address of the HMI device to 
download the runtime application. Select the IP address in the 
Location box. The Location box lists up to five previously used 
download locations. 

3. (optional) If the project contains multiple languages, in the 
Language box, select the language to display in the project.  

 
Tip: If the translated string for the download language is also blank, View Designer defaults to 
the language used for designing the project.  

4. Select Next. 
5. On the Controller References page: 

• Verify the information is correct. If changes are required, exit the 
wizard. Make the necessary changes on the References tab 
(Project > Project Properties > References).  

6. Verify the controllers are synchronized. The controller icon on the 
References tab of the Project Properties dialog box indicates 

the synchronization state of the controller. The  icon indicates 
that the controller is synchronizing.  

Download a runtime 
application to an HMI device 
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Tip: When starting the download process while the Logix Designer project is synchronizing 
with the View Designer project, the download process remains in the Building the runtime 
application process until synchronization is complete. This can take several minutes for a 
large controller application.  

7. Select Download to start the download process. The Download 
page shows the progress of the download process as View 
Designer saves and verifies the project, builds the runtime 
application, connects to the HMI device, and transfers the runtime 
application to the HMI device. 

If View Designer encounters a problem, an error message appears and 
the process stops. When View Designer finds invalid tags or expressions 
during project verification, the Errors window opens to list the warnings 
or errors associated with the tags or expressions. Resolve all errors 
before downloading the runtime application to the HMI device again.  

 
Tip: If a project contains a data log, and there is no change to the configuration of the data log, 
previously collected data remains in the data log when the project downloads again.  

See also 
Download Runtime Application wizard on page 709 

• Errors window on page 522 
• About changing the project language on page 675 

The screens in a project represent the physical size of the HMI device 
selected for the project.  

How and if the screens are scaled to fit the new HMI device is based on 
the scaling mode you select in the following procedure. 

To download a runtime application to a different HMI device 
1. Open the project. 
2. On the Menu bar, select Project > Project Properties. 
3. On the Project Properties dialog box, click the Application tab.  
4. In the Screen Scaling section, select a scaling option: 

• Scale with fixed aspect ratio. (Default) When you resize the 
screen, content is resized to fill the screen as much as possible 
while maintaining the same aspect ratio. If the aspect ratio of 
the screens changes from regular (4:3) to wide, or vice versa, 
squares and circles do not elongate into rectangles and 
ellipses.  
 

• Stretch to fit. Resizes the screen content to fill the screen. As 
you resize the screen from wider or narrower and vice versa, 
squares and circles are elongated into rectangles and ellipses.   
 

• Do not scale. Keeps the screen content the same size and 
position on the new HMI device as the original screens.  This 
assumes that Windows is calibrated to the DPI of the monitor on 
which View Designer is running.  If the screen on the new HMI 

Download a runtime 
application to a different 
HMI device 
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device is smaller than the original screen, the selected scale 
mode is overridden to Stretch to fit to ensure that no screen 
content is clipped off.  

5. Click OK to save changes and close the Project Properties 
dialog box. 

6. From the Menu bar, click COMMUNICATIONS > Download. 
7. In the Location box, click Browse  and select the IP address of 

the HMI device to which the runtime application is to download. 
8. Click Next to proceed to the Controller References page. 

IMPORTANT • Projects are optimized for screen performance and text accuracy for the HMI 
device for which they are configured. Although projects can be downloaded 
to and displayed on any HMI device, there may be a speed and text size 
difference between HMI devices. 

• When downloading a project or flashing an HMI device that has the screen 
saver running, the progress may not be visible. Stop the screen saver on the 
HMI device before beginning the download or flash process. 

See also 
Scaling examples on page 72 

Runtime application scaling on different HMI devices on page 77 

Add a controller reference on page 85 

Project Properties dialog box on page 68 

Screen scaling overview on page 72 

Save a View Designer runtime application as a .vpdr file. Files that are a 
.vpdr file download to the HMI device without using View Designer. Save 
the .vpdr file to removable media. After inserting the removable media in 
the HMI device, download the runtime application to the HMI device. 

Prerequisites 
• To save the runtime application to removable media, insert a USB 

storage device or SD card into the HMI device.  

To save a project to removable media 
1. Select File > Save Project As. Windows Explorer opens. 
2. Navigate to the location to save the runtime application. 

 
Tip: Save the runtime application directly to a USB drive or SD card, or save the runtime 
application to another location and then copy the runtime application to the USB drive or SD 
card. 

3. In the File name box, type a unique name for the runtime 
application. 

 
Tips:  
• Do not insert the characters ( ) or commas in runtime application file names. When selecting a 

.vpdr file to upload from removable media on the HMI device, any .vpdr file name that contains a 
comma or ( ) characters does not appear in the list selector. The list selector cannot show file 
names that contain a comma or ( ). 

• If typing the .vpdr extension as part of the file name, type the extension in lowercase letters.  

Save a runtime application 
to removable media 
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4. In the Save as type box, select View Designer Runtime 
Application (.vpdr) and select Save. The Save Runtime 
Application wizard opens the Save Runtime Application page. 
The Location box on the Save Runtime Application page 
contains the specified location and file name. 

 
Tip: Downloading a .vpd project file to the HMI device from removable media is not supported.  

5. In the Default language used at startup of HMI device and for 
undefined translations box, select the language in which to 
display the runtime application on the HMI device. 

6. Select Save. The wizard builds and saves the runtime application 
on the removable device. 

 
Tips:  
• While saving, the project is verified. Any warnings and errors that occur appear. Select Close and 

correct any warnings or errors and then save the project again.  
• Select Cancel to not save the project. 

7. When the save is complete, select Close. 

 
Tip: When the runtime application exists in a location other than removable media, copy the 
.vpdr from the location to the USB drive or SD card. 

See also 
Create a project on page 53 

Save a project on page 62 

Create an event that prepares the SD card that is in the HMI device for 
safe removal. When triggered, the event prevents the files on the SD 
card from becoming corrupt or read-only. 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to safely remove media 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the HMI Device Configuration command category and 

select Safely Remove Media. 

 
Tip: To create an indication of when the SD card is safe to remove, use the status from the 
DataLogStatus system tag. 

Add an event command to 
safely remove media 
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See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

When downloading a project to a different HMI device, screens 
automatically scale on the HMI device to fit based on the scaling option 
for the project. This does not affect the project contents in View Designer. 
The scaling option is appears on the Application tab of the Project 
Properties dialog box.  

Downloading a project to an HMI device with a different DPI setting 
affects the display of screens:  

• Content placement 
Screens appear in the center of the new HMI device. Any extra 
space required for Scale with fixed aspect ratio or Do not scale 
options appears equally on either side or above and below the 
screen. If the new HMI screen is smaller than the original screen, 
the Do not scale option is overridden to Scale with fixed aspect 
ratio to ensure screen content is not clipped. 

• Text 
Text appears at the point size for the targeted HMI device. If the 
actual HMI device differs, the text stretches to fit the new area 
based on the scale mode selected. If the actual HMI device has a 
different aspect ratio and the scale mode selected is Stretch to fit, 
the aspect ratio of the text stretches or compresses to fill the new 
area. 

• System Banner 
The System Banner is always as wide as the screen. The height 
of the System Banner depends on the selected scaling option.  

• Popups 
Popups and their contents remain the same physical size as on 
the original screen unless they do not fit the screens on the new 
HMI device. In this case, the popups and their contents reduce to 
fit the new screen area while maintaining a fixed aspect ratio. This 
is regardless of the Screen Scaling option selected. After the 
screens convert, the relative space that the popups cover on the 
new screens is different from the original screens.  

• Bindings to size and position properties 
Downloading a project to a different HMI device does not affect 
bindings to size and position properties of graphic elements. 
Update animation values in the controllers as necessary to match 
the new size and position values. 

• Raster images 

Runtime application scaling 
on different HMI devices 
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Bitmap or raster images store as a series of tiny dots called pixels. 
When adding a raster image to a View Designer screen, the image 
Height and Width property values in the Properties tab match the 
pixel size of the image. Raster images may appear unclear 
because View Designer scales the bitmap image to match the 
physical size of the image as it appears on the HMI device screen. 
Images appear sharp on the HMI device screen. 
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Loading a raster image on an HMI device that is different from the 
HMI device for the project results in the image appearing unclear 
compared to the original. Add ore remove pixels to match the new 
image size. The image size varies from with HMI device screen 
size. 
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See also 
Project Properties dialog box on page 68 

Screen scaling overview on page 72 

Download a runtime application to a different HMI device on page 
711 

How do I open the Errors window? 

The Errors window opens automatically to display the invalid tags or 
expressions detected during project verification. 

To open the Errors window manually, on the Menu bar, click VIEW > 
Errors. 

The Errors window displays the results of project verification. It opens 
when View Designer detects invalid tags or expressions. Downloading a 
project automatically verifies that project. Verify a project at any time 
during project development. For example, verify a project if a controller is 
defined for the project.  

Project verification verifies: 

• The syntax of all expressions contained in the View Designer 
project 

• The validity of parameters passed from one item to another and 
required error messages 

• The existence of elements and properties referenced in an 
expression 

• The existence of tags in the View Designer project in the 
referenced controller projects 

• That Add-On Graphics do not contain direct bindings to controller 
tags or system tags 

• That property bindings in the definition of an Add-On Graphic are 
formatted as ElementName.PropertyName 

• That aliased properties of graphic elements in the definition of an 
Add-On Graphic are not bound  

• That all tags in the data logs are valid.  
Use the Errors window to: 

• View the errors and warnings detected during project verification. 
• Navigate to the source of the error or warning so that you can 

resolve the problem. 
• Sort the results to group them by severity level, description, or 

location in the project. 

See also 
Verify a project on page 718 

Verify Project dialog box on page 544 

Sort the contents of the Errors window on page 718 

Download a runtime application to an HMI device on page 710 

Errors window 



Chapter 26  Download and upload a project 
 

718 Rockwell Automation Publication 9324-UM001G-EN-D - June 2023  
 

Sort the contents of the Errors window by type, description, or location in 
the project. 

To sort the contents of the Errors window 
• Click a column header to sort on that column. For example, to sort 

the results by location in the project, click the Location column 
header. 

 
Tip: Sort multiple criteria. For example, click the column header for the initial sort, and then 
hold the Shift key and click a second column header for the secondary sort. 

See also 
Errors window on page 522 

Verify a project on page 718 

View Designer verifies a project automatically when downloading that 
project to the HMI device. Verify a project any time during project 
development. For example, verify a project if a controller is defined for 
that project. Invalid tags or expressions appear in the Errors window. 

View Designer identifies invalid expression syntax as an error. The 
expression does not work for the project when downloaded to the HMI 
device. Resolve errors before downloading a project to the HMI device.  

An invalid tag reference shows as a warning. The project may work when 
downloading the project to an HMI device after fixing the tags in the 
controllers using Logix Designer. Resolving warnings is not required to 
download a project.  

To verify a project 
1. On the Menu bar, click Project > Verify Project. The Verify 

Project dialog box opens and verification begins.  
2. If there are errors or warnings listed in the Errors window, 

double-click an entry to navigate to its source in the project, and 
make the necessary changes to resolve it.   

3. Repeat the verification process until there are no errors or 
warnings listed in the Errors window. The list updates each time 
the verification process runs for the project. 

 
Tips:  
• View Designer verifies definitions of Add-On Graphics even if no instances of the Add-On Graphics 

exist in the project.  
• View Designer verifies tags in a data log even if no instances of the tag exist in the project. 
• Alternate methods of navigating to the source of an error or warning in the Errors window: 
• Click the hyperlink in the Location box. 
• Select an entry in the list and press Enter. 

• Alternate methods of starting the verification process: 
• In the Project Explorer, right-click the project name and click Verify Project. 
• On the Standard toolbar, click Verify Project . 

Sort the contents of the 
Errors window 

Verify a project 
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See also 
Verify Project dialog box on page 544 

Errors window on page 522 

Sort the contents of the Errors window on page 718 

Download a runtime application to an HMI device on page 710 

How do I open the Verify Project dialog box? 

On the Menu bar, click PROJECT > Verify Project. 
 

The Verify Project dialog box displays the progress of the project 
verification process.  

Project verification verifies: 

• The syntax of all expressions contained in the View Designer 
project 

• The validity of parameters passed from one item to another and 
required error messages 

• The existence of elements and properties referenced in an 
expression 

• The existence of tags in the View Designer project in the 
referenced controller projects 

• That Add-On Graphics do not contain direct bindings to controller 
tags or system tags 

• That property bindings in the definition of an Add-On Graphic are 
formatted as ElementName.PropertyName 

• That aliased properties of graphic elements in the definition of an 
Add-On Graphic are not bound  

• That all tags in the data logs are valid.  
The Errors window displays the invalid tags and expressions detected 
by the project verification process.   

See also 
Verify controller tags on page 543 

Errors window on page 522 

How do I open the Save Runtime Application wizard?  

1. Click File > Save Project As and navigate to an SD card or a 
USB drive on which to store the runtime application. 

2. In the File name box, type a unique name for the runtime 
application.  

3. In the Save as type box, select View Designer Runtime 
Application (.vpdr) and click Save.  

Use the Save Runtime Application wizard to: 

• Save a runtime application .vpdr file to removable media. 
• Select the default language of the .vpdr file.  
• Download a project to an HMI device without using View Designer. 

Verify Project dialog box 

Save Runtime Application 
wizard 
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After saving the runtime application to removable media, download the 
application by inserting the removable media in the HMI device and 
performing the download from the Settings screen. 

 
Tips:  
• When saving the runtime application, the syntax of all expressions, the elements and properties 

referenced in expressions, and the existence of all project tags in the referenced controller 
projects are verified.   

• If View Designer encounters a problem, the Save Runtime Application wizard indicates that there is 
an error. Errors appear in the Errors window below the View Designer screen. Select Close to close 
the Save Runtime Application wizard and use the Errors window to navigate to the source of the 
error. Resolve all errors before saving the runtime application to removable media. 

See also 
Create a project on page 53 

Save a project on page 62 

Save a runtime application to removable media on page 63 

Use the Upload Runtime Application wizard to transfer a runtime 
application from an HMI device to a computer.  

In the wizard, specify the communication path between the HMI device 
and the computer to which it will be uploaded and then specify where you 
want to save the uploaded runtime application file. 

See also 
Upload Runtime Application wizard on page 721 

Upload and save a runtime application on page 720 

Download Runtime Application wizard on page 709 

Load an application from removable media on page 755 

Use the Upload Runtime Application wizard to transfer a runtime 
application from an HMI device to a computer. Perform the transfer if the 
.VPD project file no longer exists on the computer that is running View 
Designer. This allows making further changes to the project and 
downloading the project to the HMI device again. 

IMPORTANT Runtime applications contain a .vpd extension. Downloading a file without a .vpd 
extension to an HMI device is not supported. 

To upload and save a runtime application: 
1. On the Menu bar, click Communications > Upload to start the 

Upload Runtime Application wizard. 
2. In the HMI Device Path box on the HMI Device Location page, 

select the IP address of the HMI device containing the runtime 
application: 
• Click the arrow to select a previously used path. 
• Click Browse  and select the HMI device. 

Upload a runtime 
application from an HMI 
device 

Upload and save a runtime 
application 
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3. Click Upload. The HMI Device Location page displays the 
progress of the upload process.  
• If a problem exists, an error message displays at the point it 

occurred and the process stops. Resolve all of the errors before 
uploading the runtime application. 

4. When the upload is complete, click Save. 
5. In the Project File box on the Save page, select the location to 

save the file: 
• Click Browse  to navigate to the location. 
• Type the path in the Project File box.  

6. Click Save. 
7. When Finished is selected to indicate the process is complete, 

click Close. 

 
Tip: The first time using the Upload Runtime Application wizard, the HMI Device Path box is 
blank. On subsequent use of the wizard, the HMI Device Path defaults to the most recent IP 
address that was used successfully. 

See also 
• Upload Runtime Application wizard on page 721 

How do I open the Upload Runtime Application wizard? 

On the Menu bar, click COMMUNICATIONS > Upload. This option is 
also available on the Studio 5000 Launcher. 

Use the Upload Runtime Application wizard to transfer a runtime 
application from an HMI device to a computer.  

The wizard contains two pages: 

• HMI Device Location. Use this page to specify the 
communication path from the HMI device containing the runtime 
application to the computer to which it will be uploaded. 
This page displays the progress of the upload process. If View 
Designer encounters a problem, an error message displays at the 
point it occurred, and the process stops.  

• Save. Use this page to specify where you want to save the 
uploaded runtime application file. This page is available only when 
the runtime application file has been successfully uploaded from 
the HMI device.    

See also 
Upload and save a runtime application on page 720 

Create an event to load a runtime application from a USB storage device 
or SD card. Add a Load Application command to a touch or key event to 
load the application. When triggered on the HMI device, the event with 
the command loads the .vpdr file from the specified removable media. If 
required, the Load Application command updates the firmware version 
on the PanelView 5000 HMI device before loading the runtime 
application file. To enable updating firmware, copy the correct version of 

Upload Runtime Application 
wizard 

Add an event command to 
load a runtime application 
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the .dmk firmware file to the removable media along with the .vpdr 
application file.  

 
Tip: Firmware update using the Load Application command only works in two cases: 
1. When the firmware on the HMI device is already V6 or later, and the firmware you want to load is V6 

or later. 
2. When the HMI device is running out-of-the-box manufacturing firmware, was manufactured after 

the V6 release date, and the firmware you want to load is V6 or later. 

 

Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to load a runtime application 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the HMI Device Configuration command category and 

select Load Application. 
4. Under Load Application from on the command card, in the 

Source box, select USB or SD Card.  
5. In the FileName box, type the name of the runtime application to 

load. 

 
Tip: Bind the FileName box of the Load Application event command to a graphic element 
property or a tag in the controller. Binding the file name specifies the file name to load on the 
HMI device. For example, bind the FileName box of the Load Application event command to 
the text property of Text Input graphic element. Use the Text Input graphic element to then 
enter the name of the .vpdr file to load from the removable media to the HMI device.  

6. In the HMItoControllerPath box, specify the controller path to use 
by selecting either: 
• Keep paths on HMI device. Use the HMI to controller path 

currently in use on the HMI device. 
• Load path in VPDR file. Use the HMI to controller path in the 

runtime application file that is loading. 
7. In each box, select Select tag  to open the Tag Browser and 

browse to select the tag or manually enter a graphic element 
property to receive the value to display on the HMI device when 
the event command triggers: 
• FirmwareUpdateRequired. Whether or not a firmware update 

is required on the HMI device to load the runtime application file 
from the removable media.  

• VPDRMajorVersion. The major version of the runtime 
application file on the removable media. 
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• FirmwareVersionToInstall. The version of the firmware that 
the Load Application command installs on the HMI device 
from the removable media.  

 
Tip: Rockwell Automation recommends binding to tags of graphic element properties in 
the FirmwareUpdateRequired, VPDRMajorVersion, and FirmwareVersonToInstall boxes to 
display updated firmware version information on the HMI device when loading the 
runtime application file.  

See also 
Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Event commands on page 456 

What is an event? on page 476 

Save a runtime application to removable media on page 63 

Select a command under a category to perform when an event triggers: 

Category Command Description 

Alarm History Cancel Alarm History Export Cancels the export of the alarm history. 
Clear Alarm History Removes all alarm events stored on the HMI device. 
Export Alarm History Exports a .csv file for the alarm history in the project to a .zip file and places the .zip 

file on a USB drive or SD card to review the alarm history on a computer. 
Certificates Delete Certificate Deletes a digital certificate stored on the HMI device. This command requires 

entering the fingerprint of a specific certificate. 

Import Certificate Imports a digital certificate with a specified file name. 
Data Log Cancel Data Log Export Cancels the export of the data log. 

Clear Data Log Clears the contents of all data logs or selected data logs. 

Export Data Log Exports a .csv file for each data log in the project to a .zip file and places the .zip file 
on a USB drive or SD card to review the data log on a computer. 

HMI Device 
Configuration 

Calibrate Touch Screen Calibrates the HMI device screen for touch. This command displays a red target on 
the screen. Press and hold the center of the target until the target turns white and 
another red target appears. Continue pressing and holding the centers of all 
remaining targets as they appear. All processed targets are replaced with white 
targets. A green circle with a check indicates successful calibration. A red circle with 
an X indicates a failed calibration. 
If a red circle with an X appears, perform the event again to calibrate the screen. 

Load Application Loads the specified runtime application file to the HMI device from either a USB 
storage or an SD card. 

Reboot Terminal Reboots the HMI device immediately. 
Safely Remove Media Prepares the SD card for safe removal from the HMI device so the files do not 

become corrupt or read-only. 
Language Switch Language Changes the language that displays on the HMI device. 

Tip: Import the desired languages before changing the language that displays on the 
HMI device. 

Navigation Navigate Backward Navigates back in history to the screen opened using the Navigation menu or a 
Screen Navigate command.  
Logging off the HMI device erases the navigation history.  

Navigate Forward Navigates forward in history to the screen opened using the Navigation menu or a 
Screen Navigate command.  
Logging off the HMI device erases the navigation history. 

Open web browser Opens the web browser in a new window. 

Event commands 
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Category Command Description 

Close web browser Closes the web browser. 

Popup Close Closes the popup on the HMI device when the event occurs. Only one popup can be 
open on the HMI device at a time. 

Popup Open Opens a specific popup when the event occurs. Only one popup can be open on the 
HMI device at a time. 
In the Open Popup box, navigate to and select the popup the event is to open. If the 
selected popup has a user-defined data type property, bind the value in the Property 
Configuration box to the user-defined data type property of the popup. This passes 
the value to the popup when it opens on the HMI device.  
If a graphic element on the popup to open has an aliased property with a value, the 
Popup Open command can read the value from a referenced graphic element and 
apply it to the alias. In the Property Configuration box at the bottom of the 
command, enter the name of the graphic element and the property that has the 
value to apply to the aliased property. Use the format ElementName.PropertyName. 
When the event triggers, the graphic element on the popup with the aliased property 
shows the property value of the graphic element that is referenced in the Property 
Configuration box. The Property Configuration box appears for the command only if 
there is an aliased property or user-defined property on the target popup.   

Screen Navigate Opens the specified shortcut or screen when the event occurs.  
In the Navigate To box, select the screen or shortcut that the event is to open. If the 
selected screen or shortcut has a user-defined data type property, bind the value in 
the Property Configuration box to the user-defined data type property of the screen 
or shortcut. This passes the value to the screen when it opens on the HMI device.   
If a graphic element on the screen to open has an aliased property with a value, the 
Screen Navigate command can read the value from a referenced graphic element 
and apply it to the alias. In the Property Configuration box at the bottom of the 
command, enter the name of the graphic element and the property that has the 
value to apply to the aliased property. Use the format ElementName.PropertyName. 
When the event triggers, the graphic element on the screen with the aliased property 
shows the property value of the graphic element that is referenced in the Property 
Configuration box. The Property Configuration box appears for the command only if 
there is an aliased property or user-defined property on the target screen. 

Show Navigation Menu Opens the Navigation menu on the HMI device screen when the event occurs. 
Notification Send Email Sends an email with a configurable subject and message to one or more recipients. 

First configure the email server connection from the Settings screen on the HMI 
device.  

PDF Previous Page Navigates to the previous page in a PDF document. 

Next Page Navigates to the next page in a PDF document. 
Go To Page Navigates to a specified page in a PDF document. 
Zoom in Increases the document magnification by a percentage of the preset level in a PDF 

document. 
Zoom out Decreases the document magnification by a percentage of the preset level in a PDF 

document. 
Zoom to Adjusts the magnification to fit the page, fit the width of the page, or display the 

page at 100% magnification. 
Security Logon Opens the Log On dialog box when the event occurs. When the Log On dialog box 

opens, any open popup closes. 
Logoff Logs you off the project. If the Guest user role has security access to the current 

screen, the screen remains open. If the Guest user role does not have security 
access to the current screen, the Home screen opens.   

State State Previous Applies the previous state in the selected State Table to the graphic element when 
the event occurs. To configure this command, in the box in the command card, 
select the name of the desired State Table. Select Wrap Around to continue to apply 
states when the event occurs, even if the beginning or end of the State Table is 
reached.  
If you create a State event with a State Previous command with Wrap Around 
selected, the graphic element loops through states in the State Table as the event 
occurs. 
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Category Command Description 

State Next Applies the next state in the selected State Table to the graphic element when the 
event occurs. To configure this command, in the box in the command card, select 
the name of the desired State Table. Select Wrap Around to continue to apply states 
when the event occurs, even if the beginning or end of the State Table is reached.  
If you create a State event with a State Next command with Wrap Around selected, 
the graphic element loops through states in the State Table as the event occurs. 

Value Increment Increments the value of the selected tag when the event occurs. Specify the value 
with a number, a tag, an expression, an element property, or the property of a screen 
or Add-On Graphic.  
In the Increment box, enter or browse to select the tag or property of a screen or 
Add-On Graphic. In the By box, create the expression value by which to increment the 
tag when the event occurs. The increment can be either negative or positive.  

Toggle Toggles the value of the selected tag from 0 to 1, or from 1 to 0, when the event 
occurs.  
In the Tag box, enter or browse to select the tag or property of a screen or Add-On 
Graphic.  

Write  Writes a value to the selected tag when the event occurs. Specify the value with a 
number, a tag, an expression, an element property, or the property of a screen or 
Add-On Graphic.  
In the Write To box, enter or browse to select the tag or property of a screen or 
Add-On Graphic. In the Expression box, create the expression value to write to the 
tag when the event occurs. 

 

 
Tips:  
• For best performance, create commands that evaluate no more than 20 tags. 

For example, it is best for a Write command to have an expression containing no more than 20 
tags or a Send Email command to embed no more than 20 tags in the message. 

• For commands with expressions using many tags in a reference, have 10 or fewer such commands 
in an event for best performance.  

• Using larger numbers of tag references in many commands may cause slow screen performance 
while those commands evaluate. 

• Reference 1000 or fewer tags across all the project events. Using a larger number of tag 
references may cause delays in PanelView 5000 recovery from controller disconnects. 

• If the HMI device processes a large number of background tasks, like multiple triggered alarms, 
you may need to repeat a button press to execute the button commands. 

See also 
Trigger an action on a Key Press or a Key Release event on page 
451 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a State Enter or State Exit event on page 454 

Import a language file on page 671 

Export text strings for language translation on page 670 

Create an event that prepares the SD card that is in the HMI device for 
safe removal. When triggered, the event prevents the files on the SD 
card from becoming corrupt or read-only. 

Add an event command to 
safely remove media 
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Prerequisites 
• Create an event to trigger the command: 

• Touch press. Occurs when touching the item on the screen 
that is configured with the event. 

• Touch release. Occurs when releasing the item on the screen 
that is configured with the event. 

• Key press. Occurs when pressing the specified key. 
• Key release. Occurs when releasing the specified key. 

To add an event command to safely remove media 
1. Select the graphic element configured with the touch or key event.  
2. In the Properties pane on the Events tab, select Add Command.  
3. Expand the HMI Device Configuration command category and 

select Safely Remove Media. 

 
Tip: To create an indication of when the SD card is safe to remove, use the status from the 
DataLogStatus system tag. 

See also 
Event commands on page 456 

Change a command that an event performs on page 474 

Delete a command from an event on page 475 

Trigger an action on a Touch Press or a Touch Release event on 
page 453 

Trigger an action on a Key Press or a Key Release event on page 
451 

Exit View Designer to close the software product. Save or discard any 
changes before exiting. 

To exit View Designer:  
1. Select File > Exit. 
2. If prompted, save or discard any unsaved changes to the project. 

See also 
Close a project on page 64 

Save a project on page 62 

 

Exit View Designer 
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Chapter 27 

Import and export 

Use the import and export features in Studio 5000 View Designer® to 
export View Designer content formatted as text. You can then import the 
text as content into other View Designer projects. It is also possible to 
automate project creation or editing (for example with a scripted 
programming language). A View Designer project exports content in the 
following formats:  

• Screens. Export as .hmi files in a folder that has the same 
structure as in Project Explorer. 

• Popups. Export as .hmi files in a folder that has the same structure 
as Project Properties. 

• Add-On Graphics. Export as .hmi files. These files appear in the 
Assets\Add-On Graphics folder. 

• Documents. Export as .pdf files. These files appear in the Assets 
> Documents folder.   

• Images. Export as .jpg, .png, .bmp, or .svg. These files appear in 
the Assets > Images folder.   

• Data Logs. Export as .hmi file. These files appear in the DataLogs 
folder. 

For more information on import and export, refer to the Studio 5000™ 
View Designer Import/Export Reference Manual, publication 
9324-RM001A-EN-P. 

 

   

 

Import project content, such as screen, popup, or graphic into another 
View Designer project. You can import previously exported project 
content, or other content created in the supported formats. The imported 
elements overwrite the existing elements in the target project, if they 
have the same name. If you need to recover any content overwritten by 
the import, the original target project is saved as a backup file stored in 
you project directory.  

 
Tip: It is recommended to import a project on the same panel type it was created for. Import for 
different panel type changes the size, position and shapes of graphic elements. 

1. Open the target View Designer project you want to import content 
to.  

2. In the menu bar, select File >Import.  
3. Navigate to the folder that contains the View Designer text file. 
4. Select the ViewApplication.hmi file and then select Open. 

Import project displays a progress bar.  
Before the import is complete, you can cancel it by clicking 
Cancel Import. 

Import content into a View 
Designer project 
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When the import is complete, the content appears in the target 
View Designer project.  

 

Export the contents of a View Designer project to a text .hmi file. You can 
import the exported project to  another View Designer project, and you 
can use any text editor that supports the .hmi file format to modify the 
project. Netwotk paths and Sharepoint is not supported, but you can use 
drive mapping. For more information, see Best practices and limitations. 

1. With the project open in Studio 5000 View Designer, from the 
menu bar, select File > Export. 

2. In Export project, enter or browse to the location where you want 
the exported content to exist.   

 
Tip: Name contains the name of the project as it appears in View Designer. 

3. Select Export. "Export successful" appears. 
4. To open the location of the exported content, click the link to the 

file path. The path contains a folder with file that has the same 
name as your View Designer project. 

5. Use a text editor to open any exported file and view or make 
changes to the content.  
 

 

Use the runtime application 
The runtime application is downloaded to an HMI device for interaction at 
runtime. Each runtime application has its own look and feel based on its 
configuration in Studio 5000 View Designer. Using the data configuration 
and application created in Studio 5000 View Designer, the HMI device 
screen animates the contents of the project by responding to data values 
from the controller. If configured, the screen responds to touch and keys.    

Use the runtime application to interact with screens and data and to 
perform system operations.  

 

Export a View Designer 
project 
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Chapter 28 

Use the runtime application 

The runtime application is downloaded to an HMI device for interaction at 
runtime. Each runtime application has its own look and feel based on its 
configuration in Studio 5000 View Designer. Using the data configuration 
and application created in Studio 5000 View Designer, the HMI device 
screen animates the contents of the project by responding to data values 
from the controller. If configured, the screen responds to touch and keys.    

Use the runtime application to interact with screens and data and to 
perform system operations.  

Screens appear on the HMI device for the downloaded application. An 
example screen contains:    

 
Item Name Description 

 
Content The screen displays the content of the example project created in 

Studio 5000 View Designer. Project content may include data, graphic 
elements, and popups with additional information.   

 
System Banner By default, the System Banner at the top of each screen in the project 

contains buttons to: 
• Open the Alarm Summary screen. 
• Open the Automatic Diagnostics screen. 
• Open the last and next screens in the navigation history.  
• Log on to the project.  
• Open the Navigation menu at the bottom of the screen.  
• Open the Data Log popup for details about the status of a data log 

if one is configured for the project.  
• View network and controller status.  
• Open the Controllers General popup to display information if there 

is an issue with a controller. 

Use the runtime application 

Runtime application 
components 
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Navigation menu The Navigation menu displays items for the assigned security role of 

the logged in user. To display the menu: 

• Select Navigation  in the System Banner.  
• Push the button on the HMI device. 
• Press Alt+N on an external keyboard.  

From the Navigation menu, select an item to open the screen, or 
select a folder to open its contents in a second row on the Navigation 
menu. Using an HMI device keypad or external keyboard, arrow key to 
highlight the item and press Enter. 

See also 
Open a screen on page 757 

System Banner contents on page 731 

Navigation menu contents on page 732 

The System Banner appears at the top of each screen in a project by 
default. It contains default navigation items: 

• A button to open the AlarmSummary screen 
• The current number of unacknowledged alarms 
• Previous and Next button 
• The username of the logged on user. 
• Diagnostic icons indicating the status of data logging and project 

events. 
• Network and controller status 
• The current date and time for the HMI device 
• Controller information for controller issues 

The HMI designer may change the System Banner to:  

• Add graphic elements, such as buttons, text displays, or 
configured elements such as a gauge to display a data value. 

• Omit default items. 
• Change the appearance of the System Banner, such as 

background color or height.  
Graphic elements with invalid tag values are outlined in red on the HMI 

device. An Error icon  pointing down appears in the System 
Banner for graphic elements with invalid tag values that exist outside of 
the System Banner. 

See also 
System Banner contents on page 731 

Navigation menu on page 732 

Navigation menu contents on page 732 

Virtual Numeric Keypad on page 736 

Virtual Standard Keyboard on page 737 

System Banner 
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By default, a System Banner with default content appears at the top of 
each screen. The HMI designer may configure the System Banner to 
add or remove items from the System Banner.  

 
Item Description 

 
 

Alarm Status Indicator opens the Alarm Summary screen on the HMI device. 

•  The button shows that there are no alarms. 

•  The button on the screen turns red and flashes when there are active alarms that are unacknowledged. 

•  The button returns to a gray icon with a numbered notification showing the number of unacknowledged 
alarms when all alarms return to normal but some alarms are still unacknowledged.    

•  The button turns to red when there are active alarms and all of them are acknowledged.  

  
Automatic Diagnostics Indicator opens Automatic Diagnostics screen on the HMI device. The button shows a 
notification with the number of active diagnostics. The button returns to an outlined icon when no diagnostics are 
active. 

  Previous displays the previous screen in the navigation history on the HMI device. 

  Next displays the next screen in the navigation history on the HMI device. To navigate with Next requires displaying a 
previous screen first. 

  Navigation displays the Navigation menu at the bottom of the screen on the HMI device. Use the Navigation menu to 
display shortcuts and folder contents. 

  
Log On logs on or off the project. The name of the logged on user appears in the System Banner. The logged on user 
sees only the screens for which the assigned user role has access. 

 
General Diagnostics Status for the data log status and project event errors. These icons appear depending on the status of data 
export and project events. 
•  Data export ongoing. The data log is exporting.  

•  Data export error. The data log is in error while collecting data or exporting. 

•  Data export remove. The media containing the data log is ready to remove without corrupting files or making files 
read-only on the USB storage device or SD card. 

•  Data export warning. Tags in the data log are in error. Select the icon to view the error details.  
A data log status icon only appears when a project contains a data log and there are no project event errors. 

•  Error. Project events and data logs are in error. Select this icon to open the predefined popup for data log and project 
event status details.  

•  Project Event. Project events are in error. Select the icon to view the error details. The Project Event Error icon only 
appears when a project event is in error. 

 

 
A Network Status icon appears only if there is an issue with network communication. Select the icon to open the HMI Device 
Configuration Network popup for details about the issue. 

•   Network caution. The network is functioning but has an issue that requires attention. For example, the Device Level 
Ring may have a break.  

•   Network error. The network is not functioning. An Ethernet link is disconnected, or there is a duplicate IP address. 

 
A Controller Status icon appears only if there is an issue with any controller in the project. Select the icon to open the Controllers 
General popup for details about the issue. 

•  Controller error. Any controller in the project is disconnected, powered down, or not configured. 

•  Controller caution. Any controller in the project is not in Run mode or the tag data of a controller is not synchronized 
with the HMI device. 

•  Controller unknown. No controller in the project is visible and it is unclear if a controller should be visible to the HMI 
device. This may occur when a controller is on a disconnected side of the network.  

System Banner contents 
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The current time and date of the HMI device.  

See also 
System Banner on page 730 

Navigation menu on page 732 

Navigation menu contents on page 732 

Virtual Numeric Keypad on page 736 

Virtual Standard Keyboard on page 737 

Use the Navigation menu to browse the contents of the application and 
open screens. The Navigation menu on the HMI device displays the 
contents of the project in Studio 5000 View Designer. The Navigation 
menu appears at the bottom or left side of the HMI device screen. To 
access the Navigation menu: 

• Select Navigation  in the System Banner.  
• Push the button on the HMI device. 
• Press Alt+N on an external keyboard.  

The menu items in the Navigation menu depend on the security access 
granted to the security role assigned to the logged on user. Security is set 
in Studio 5000 View Designer. For the Operator role, the Navigation 
menu displays only the items to which the Operator has access. Guest is 
the default user. When not logged in, only the items to which the Guest 
role has access appear in the Navigation menu.  

 

See also  
Navigation menu contents on page 732 

Open a screen on page 757 

Log on on page 752 

Log off on page 773 

Folders and screens for which security access is granted appear in the 
Navigation menu. By default, the Navigation menu contains items for 
the Alarm Summary, Alarm Manager, and Settings screens.     

 

Navigation menu 

Bottom navigation menu 
contents 
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Item Description 

 
The main row of the Navigation menu. This row contains the Home screen for the 
project and any folders and screens created at the root level of the project. The 
default content for the main row of the Navigation menu includes the Alarm 
Summary, Alarm Manager, and Settings items. These items open the default screen 
of the application, screens to view alarm tables and manage alarms, and a screen 
to configure settings for the HMI device.  

 
Selecting a folder shows the contents of the folder in an upper row of the 
Navigation menu. The upper row is blank when selecting an empty folder. The open 
item is highlighted. Carets appear around the selected item. Not selecting a folder 
in the bottom row of the Navigation menu shows no upper row.  

 
The back arrow in an upper row of the Navigation menu navigates back one folder 
at a time.  

 
The current folder path, in the form of breadcrumbs, shows in an upper row of the 
Navigation menu.  

 
When there are more items than can appear in the Navigation menu, arrows 
appear at either end of the Navigation menu. The Next arrow that points right 
appears after the number of menu items surpasses the width of the Navigation 
menu. The Previous arrow that points left appears when no longer showing the first 
page of items. Use the arrows to scroll to additional pages of menu items.  

 
Dots indicate which page of the Navigation menu contents is open. The dot for the 
open page is highlighted.   

See also 
Navigation menu 

Open a screen on page 757 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

Settings screen on page 740 

A popup is a small window that appears superimposed on the screen. It 
opens in response to a triggered action. An event configured with a 
Popup Open command opens a popup. If the event is a touch press 
event on a button, selecting the button opens the popup. A state change 
to a graphic element, such as the graphic element changing colors, can 
open a popup automatically. To verify which action opens a popup, 
contact the HMI designer. 

Only one popup can open at a time. If the contents of the popup is larger 
than the popup, the contents appear clipped at the edges of the popup. It 
is not possible to view clipped content.  

Touching elsewhere on the screen or selecting Close  on the caption 
of the popup closes the popup. The initial touch outside of the popup 
does not perform an action on the graphic element or screen.  

See also 
Popup contents on page 119 

Interact with a popup on page 759 

Popup 
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Trigger action to interact with a screen on page 760 

Navigation menu on page 732 

Open a screen on page 757 

A popup is a small window superimposed on a screen. A popup has 
basic components:  

 
Item Description 

 
An optional caption describing the contents and data the popup contains. On the 
HMI device, move a popup by dragging the caption. If a popup does not have a 
caption, the popup cannot move on the HMI device. 

 
An optional Close button. Select Close to close the popup on the HMI device. 
Other methods of closing popups include selecting elsewhere on the screen, 
opening the Navigation menu, opening another screen or popup, or creating an 
event with a Popup Close command. 

 
The contents of the popup.  

See also  
Popup on page 733 

Popup contents 

Error list contents 
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An Error list appears for any graphic element or group of graphic 

elements in error. An Error icon  appears on the graphic element or 
group. This icon opens the Error list. The item in error can be a graphic 
element, popup, or an Alarm Summary or Alarm Manager.   

 
 

Item Description 

 
The number of graphic elements in error. An individual graphic element in error shows no 

number on the Error icon . If the Error icon  displays a number, there are multiple 
graphic elements in error that are located close to each other. The Error list contains a page 
of diagnostic messages for each graphic element in the group. 

 
The name of the graphic element affected by the current page of errors. Scroll horizontally to 
view long names.   

 
The diagnostic messages for the item in error.  
• Graphic element. If a graphic element is in error, the Error list displays the tag associated 

with the error, the property not applied to the graphic element due to the error, and a 
description of what caused the error.   

• Alarms. If an Alarm Summary or Alarm Manager is in error, the Error list displays the 
affected alarm property, and a description of the alarm error.   

 
When selected, the graphic element in error appears filled with a color that contrasts the 
background color of the screen. 

 
When there are multiple graphic elements in error, numbers indicate the graphic element. If 
there are three graphic elements in error while viewing diagnostic messages for the first 
graphic element, the Error list displays 1/3. The Next and Previous buttons show the 
diagnostic messages for the next and previous graphic elements.  
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See also 
Error list on page 736 

View error messages for a graphic element on page 769 

How do I open the Error list? 

On the graphic element or group of graphic elements outlined in red, tap 

the Error icon  or tab to the icon and press Enter.  

An Error list contains a snapshot of the diagnostic messages associated 
with a graphic element or group of graphic elements in error. The Error 
list is static. Closing and reopening the Error list for a graphic element 
crosses out resolved errors. When a graphic element or group of graphic 
elements has errors, the graphic element or group appears outlined in 

red and has an Error icon .  

Errors occur for reasons including, but not limited to: 

• A tag is missing.  
• A tag is unavailable due to public/private Logix protection. 
• A data type is incompatible with the type of graphic element. 
• There is a faulted or missing controller. 
• There is a disconnected controller. PanelView 5000 detects a 

disconnect in communication within five seconds. Before five 
seconds expire, static data values may appear on a screen and 
repeating values may appear in a data log when the sample rate is 
less than five seconds. After five seconds, the data appears as 
bad quality. Updated data appears when reconnecting the 
controller. 

• There is a broken cable or other network issue. 
• Services that impact data delivery are hung or stopped. 
• A state change event caused the error. 
• An operation performed on an alarm failed. Refreshing errors for 

an alarm table is not supported. Perform the operation on the 
alarm table again. If the error occurs again, reopen the Error list. 
Resolving errors that appear on a disabled alarm table button is 
not supported. Disabled buttons appear with diagonal hash marks 
across them. The HMI Designer can enable the button in Studio 
5000 View Designer. 

• An event displays a diagnostic error. Manually removing errors 
when an error occurs due to a state change is not supported. 
Another state change event must remove the error. 

See also 
Error list contents on page 734 

View error messages for a graphic element on page 769 

Error list 

Virtual Numeric Keypad 
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Selecting a graphic element requiring numeric input opens the Virtual 
Numeric Keypad: 

 
 

Item Description 

 
In the Input box, type the numeric value for the selected screen or graphic element. 
The number displayed and initially highlighted in the Input box is the value of the tag 
bound to the element. Entering an incorrect value shows a red outline around the 
Input box. The minimum or maximum value exceeded appears in red below the Input 
box. The OK key is disabled until the error is corrected.  

 Clear  removes the value from the Input box.  

 
The displayed minimum and maximum values to enter for the selected element. 
Entering a value that exceeds the minimum or maximum value shows a red outline 
around the Input box.   

 
Backspace  deletes one number to the left at a time.  

 Positive-Negative Value  toggles the value in the Input box between 
negative and positive numbers.  

See also 
Virtual Standard Keyboard on page 737 

Enter data using the Virtual Standard Keyboard on page 753 

Trigger action to interact with a screen on page 760 

Virtual Standard Keyboard 
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The Virtual Standard Keyboard opens when interacting with a graphic 
element that requires text input.    

 
 

Item Description 

 
Type characters in the Input box. Any entry for the graphic element appears highlighted 
automatically when the Virtual Standard Keyboard opens. There is no limit to the number of 
characters in the Input box. The characters at either end of the Input box appear with a 
gradient when not all of the typed characters are visible. Scroll horizontally to see the 
remaining characters.    

 Clear  removes all characters from the Input box. This key appears only when there are 
characters in the Input box.  

 
Backspace  deletes one character to the left at a time.  

 Language Selector  displays an alpha European character on each key. Display 
characters in upper or lowercase.  

  Symbols  displays a symbol on each key. To redisplay the standard alpha characters, 

tap ABC, which replaces Symbols . 

 Shift  toggles the keyboard between uppercase and lowercase letters for one keystroke.   

 
Caps Lock toggles the between uppercase and lowercase letters. The Virtual Standard 
Keyboard remains in the selected state until you tap Caps Lock again. 

See also 
Virtual Numeric Keypad on page 736 

Enter data using the Virtual Standard Keyboard on page 753 

Trigger action to interact with a screen on page 760 

Some PanelView 5000 family of HMI devices have a physical keypad 
next to the screen. To use a physical keypad instead of the Virtual 
Standard Keypad, use the physical keypad to enter numbers in an input 
element or dialog box. Use the physical keypad to interact with graphic 
elements. For example, use the physical keypad to select an item in a 

HMI device keypad 
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List Box Selector, select an alarm in an alarm table, open items in the 
Navigation menu, and scroll messages in an Error list.  

 
 

Item Name Description 

 
Function keys Perform specific commands if events are configured for a 

screen or any of its graphic elements. For example, L1 could be 
configured in View Designer to navigate to another screen. 

 
Backspace  Press  to delete the character to the left of the cursor. 

 
Enter  Press  to enter the currently highlighted key in the 

Input field at the top of the virtual keyboard or keypad. For 
example, if the cursor is in the Input field, pressing this button 
creates a blank line. Pressing this button while 1 is highlighted, 
enters 1 in the Input field.  

 
Tab 
 Press  to place focus on the next input element or control 

on a screen that allows user interaction. Press this key to move 
from the Input field on the virtual numeric keypad to the 
individual keys on the virtual numeric keypad.  

 Back Tab  Press  to place focus on the previous input element or 
control that allows for interaction on the screen. On the 
Navigation menu, press this key to move to an upper row in the 
Navigation menu. 

 
Navigation   Press  to open the Navigation menu. 

 
Home  
 Press  to move the cursor to the beginning of the Input 

field, select the first item in a List Box Selector, or select the first 
alarm in an Alarm Summary or Alarm Manager table. 

 End 
 Press  to move the cursor to the end of the Input field, 

select the last item in a List Box Selector, or select the last alarm 
in an Alarm Summary or Alarm Manager table. 

 
Arrow keys Press an arrow key to highlight the key directly above, below, or 

to the left or right of the currently highlighted key on the virtual 
standard keyboard. Press these keys to move one character at a 
time in the Input field of the virtual standard keyboard.  

 
 

Page Up  Press  to display the previous pages of a list box.  
Page Down 
 Press  to display to the next pages of a list box.  

 
Esc Press Esc to close a popup. 
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See also 
Enter data using the Virtual Numeric Keypad on page 754 

Virtual Numeric Keypad 

Enter data using the Virtual Standard Keyboard on page 753 

Virtual Standard Keyboard on page 737 

The Settings screen contains options to set up the HMI device, network, 
display, and controllers.  

Use the Settings screen to configure the HMI device and view network 
diagnostics. If the HMI device is in error, collect additional 
troubleshooting data. For more information about configuring the HMI 
device, refer to the PanelView 5310 Terminals User Manual 
2713-UM001 and the PanelView 5510 Terminals User Manual 
2715-UM001. 

See also 
Settings screen on page 740 

Assign an IP and DNS address on page 741 

Configure Ethernet ports on page 742 

Calibrate the touch screen on page 745 

Reboot the HMI device on page 748 

How do I open the Settings screen? 

On the physical HMI device or in the System Banner at the top of the 
screen, press Navigation  and then tap Settings. 

Use the Settings screen to view and change HMI device and 
system-wide settings. On the Settings screen, select an option to 
perform its related tasks: 

Option: Popup: Tasks: 

Network 
 

NetworkIPSettings tab • Specify Internet protocol settings 
• Specify IP addresses 
• Specify DNS addresses 

NetworkLinkSettings tab • Enable Ethernet links 
• Set link speed 
• Specify link duplex 

NetworkDiagnostic tab View network diagnostics 

Display Display • Adjust the HMI device screen 
brightness 

• Turn on the screen saver 
• Set the brightness and delay for the 

screen saver 
• Calibrate the screen to respond 

accurately to touch  

Configure the HMI device 

Settings screen 
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HMI Device 
 

HMIDevice • Specify if project downloads and 
firmware updates are allowed 

• Change the name of the HMI device 
• View catalog and firmware numbers 
• View diagnostic information 

HMIDevice_RebootConfirm Reboot the HMI device 

Data Export Data Export • Export the alarm history or a data log 
to removable media 

• Cancel the export 
• Safely remove the SD card from the 

HMI device without causing the files 
to become corrupt or read-only 

Troubleshooting Troubleshooting • Import a troubleshooting profile 
• Export a troubleshooting log 
• Turn off troubleshooting and reboot 

the HMI device 
Date and Time DateAndTime • Set the date and time for the HMI 

device 
• Set the time zone for the HMI device 

Controllers ControllersGeneral tab View controller reference and status 
information 

ControllersDiagnostic tab View controller diagnostics 

Load from Media Load Application Load a .vpdr file from a USB storage 
device or an SD Card inserted into the 
HMI device.   

VNC VNC Enable View-Only or Full-Control access 
rights or disable remote VNC 
connection. 

Email Email Configure the connection to an email 
server enable sending emails when a 
Send Email command executes on the 
HMI device. 

Certificate Certificate Import digital certificates from 
removable media to gain secured 
access to resources on the Internet or 
delete digital certificates you no longer 
need from the HMI device. 

See also 
Assign an IP and DNS address on page 741 

Load an application from removable media on page 755 

Reboot the HMI device on page 748 

Activate the VNC server at runtime on page 751 

The project on the HMI device initially downloads from Studio 5000 View 
Designer to the HMI device using a network IP address. The network 
assigns Ethernet device addresses automatically using DHCP. When 
assigning an IP and DNS address to an HMI device, use the default to 
obtain the addresses automatically, or manually enter a static IP and 
DNS address.  

Assign an IP and DNS 
address 
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DNS translates Internet domain and host names to IP addresses. DNS 
automatically converts the names typed in a Web browser address bar to 
the IP addresses of Web servers hosting the sites.  

To assign an IP and DNS address 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
2. Select Network. The Network popup opens.  
3. Select the Network tab . 
4. Select an option for obtaining IP settings:  

• Obtain IP address automatically using DHCP. This is the 
default. Select this option to automatically assign IP, Subnet 
mask, Gateway, and DNS addresses.  

• Manually configure IP settings. Select this option to manually 
assign the IP, Subnet mark, Gateway, and DNS addresses 
using the virtual numeric keypad: 
• IP address. If not setting all fields to 100, the range of values 

for the first set of numbers is 1-255. The range of values for 
the last three sets of numbers is 0-255. 

• Subnet mask. The address must be identical to the server 
subnet mask. 

• Gateway address. This address is optional. 
• Primary DNS. The primary IP-formatted address. 
• Secondary DNS. An alternate IP-formatted address. 
• Tertiary DNS. An additional alternate IP-formatted address. 

5. Select Close .  

See also 
Configure Ethernet ports on page 742 

View network diagnostics on page 743 

Settings screen on page 740 

Configure the link speed and duplex mode for the available Ethernet 
links of an HMI device:  

To configure Ethernet ports 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings. . 
2. Select Network. The Network popup opens.  
3. Select the Configure Ethernet Port tab . 
4. To  to switch on/off LLDP Protocol support for 5510 HMI device, 

select LLDP Protocol. 

 
Tip: PanelView 5310 HMI devices do not support LLDP Protocol.  

Configure Ethernet ports 
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5. To use two ports in the Ethernet configuration, select Enable 
Ethernet Link 1 and Enable Ethernet Link 2.  

 
Tip: Two Ethernet ports are available on the PanelView 5510 HMI devices only. PanelView 5310 
HMI devices only interact with Ethernet Link 1, and do not support DLR topology.  

6. Specify the network connection speed and how a port sends and 
receives data: 
• Automatically. To automatically sense the link option and 

speed based on the network connection, select Auto 
negotiate. 

• Manually. To set the desired network connection speed for the 
ports, under the Ethernet link for one or both ports, select a Link 
speed option and a Link duplex option.  

7. Select Close . 

 
Tips:  
• 10 Mbps sets the network speed to 10 megabits per second.  
• 100 Mbps sets the network speed to 100 megabits per second.  
• Half. Sends data or receives data, but not at the same time.  
• Full. Sends and receives data at the same time.  

See also 
Assign an IP and DNS address on page 741 

View network diagnostics on page 743 

Settings screen on page 740 

View network diagnostics to determine: 

• If Ethernet links 1 and 2 are enabled and disconnected. 
• The speed and duplex option (Full or Half) for each Ethernet link.  
• If a duplicate IP address is detected. 
• If DLR topology is detected or broken. Device Level Ring topology 

provides fault-tolerant network design.  
• The MAC address. The Media Access Control address is the 

unique identifier assigned to the network for communication on the 
network. 

• The IP settings for the network, including IP address, Subnet 
mask, and default gateway, and primary, secondary, and tertiary 
DNS. 

 
Tip: Two Ethernet ports are available on PanelView 5510 HMI devices only. PanelView 5310 HMI 
devices only interact with Ethernet Link 1, and do not support DLR topology.  

To view network diagnostics 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
2. Select Network. The Network popup opens.  
3. Select the Network Diagnostics tab  to view the diagnostic 

information. 
4. Select Close .  

View network diagnostics 
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See also 
Assign an IP and DNS address on page 741 

Configure Ethernet ports on page 742 

Settings screen on page 740 

Adjust the brightness of the HMI device screen by changing the backlight 
level.  

To adjust screen brightness 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
2. Select Display. The Display popup opens. 
3. In the Brightness box at the top of the screen, adjust the backlight 

level. Enter values between 1 and 100. 

 
Tip: At 1%, the display is minimally visible. The default 100% makes the screen fully bright. 

4. Select Close .  

See also 
Configure the screen saver on page 744 

Calibrate the touch screen on page 745 

Settings screen on page 740 

The screen saver extends the life of the HMI device screen by dimming 
the brightness level when activity is not sensed for a specified amount of 
time. When the screen saver activates, the HMI device screen displays a 
moving image at a reduced brightness level. When activity is sensed, the 
screen saver deactivates and the screen brightness returns to the normal 
level. 

To configure the screen saver 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
2. Select Display. The Display popup opens. 
3. To enable the screen saver, select Turn on Screen Saver.  
4. To configure the screen saver, change the following settings: 

• Wait. To change the delay before the screen saver appears, 
select Wait and enter the number of minutes. The default is 10 
minutes.  

• Brightness. To set the brightness of the screen saver, in the 
bottom Brightness box enter the number using the virtual 
numeric keypad or an external keyboard. The default is 10. 100 
is the brightest.  

5. Select Close .  

Adjust screen brightness 

Configure the screen saver 
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See also 
Adjust screen brightness on page 744 

Calibrate the touch screen on page 745 

Settings screen on page 740 

Calibrate touch screens for proper use. When touching an input element 
and no action or an unexpected action occurs, the touch screen does not 
calibrate properly. Calibrating the touch screen may take several tries 
before it is successful. Calibration is retained after a reboot or a power 
cycle. To prevent damage to the touch screen, use a finger or plastic 
stylus device with a minimum tip radius of 1.3 millimeters or 0.051 inches. 

 
Tip: Do not perform touch screen calibration from a screen that has a trend chart or an event 
triggered by a state change. While the touch screen calibrates, traces on a trend chart do not update 
with new data values and events do not write to tag values. 

To calibrate the touch screen 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
2. Select Display. The Display popup opens. 
3. Select Calibrate Touch. A red target appears on the screen: 

 
4. Press and hold the center of the target until the target turns white 

and another red target appears: 

 
5. Continue pressing and holding the centers of all remaining targets 

as they appear. All processed targets turn white. After the target in 
the center of the screen turns white, a green check mark indicates 
a successful calibration. Successful calibration is saved 
automatically. 

 
Tip: If a calibration fails, a red circle with an X appears and the calibration process begins 
again, with the first target in the upper left corner of the screen. If calibration does not 
complete, the Display popup opens.   

6. Select Close . 

See also 
Adjust screen brightness on page 744 

Configure the screen saver on page 744 

Calibrate the touch screen 
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Settings screen on page 740 

Each HMI device has a default name that identifies it to other devices on 
the network. Change this name using 15 characters including letters, 
numbers, and hyphens. The first character of an HMI device name must 
be an uppercase or lowercase letter. 

Change the name of the HMI device 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
2. Select HMI Device. The HMI Device popup opens.  
3. In the HMI device name box, enter the new name by selecting the 

keys on the virtual standard keyboard or using an external 
keyboard.  

4. Select Close .  

See also 
Disable downloads to the HMI device on page 746 

Reboot the HMI device on page 748 

Settings screen on page 740 

Downloads to the HMI device are enabled by default. Disable downloads 
to the HMI device as a security measure. This prevents replacing the 
current application when downloading an application from View 
Designer. The Allow downloads and Firmware Updates option 
applies to downloads, ControlFLASH™, and Reset Service requests.   

To disable downloads 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
2. Select HMI Device. The HMI Device popup opens. 
3. Clear Allow downloads and Firmware Updates. Project 

downloads to the HMI device are now denied. 

 
Tip: Select Allow downloads and Firmware Updates to download another project. 

4. Select Close .  

See also 
Change the name of the HMI device on page 746 

Reboot the HMI device on page 748 

Settings screen on page 740 

Change the name of the HMI 
device 

Disable downloads to the 
HMI device 
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Prepare the SD card for safe removal from the HMI device so that the 
files on the SD card do not become corrupt.    

To remove the SD card from the HMI device 
• Perform the event configured with a Safely Remove Media 

command. To identify events to perform, contact the HMI 
Designer.  

See also 
Load an application from removable media on page 755 

Configure the SMTP client through the Settings screen on the HMI 
device. The HMI device sends an email to the configured email server 
when a configured event triggers the Send Email command. 

Prerequisites 
The SMTP client only supports simple password authentication. 
Configure the email service for less secure access to allow the SMTP 
client to sign in. 

For example, either log in to: 

• Google® GmailTM  and select Less secure app access. 
• Yahoo Mail and select Allow apps that use less secure sign-in. 

To configure the SMTP client to send email 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
2. Select Email. The Email popup opens. 
3. Configure the SMTP client: 

• Server Name. Enter the name of the third-party email server. 
For example: smtp.gmail.com or smtp.mail.yahoo.com   

• Authentication. Select Password to require a password to 
connect to the email server. Selecting None requires no 
authentication to connect to the email server. 

• User Name. Enter the email address of user sending the email.  
• Password. Enter the password to connect to the email server. 
• Sender. Enter the name of the sender to appear in the emails. 
• Use SSL. Select to use secure communication to the email 

server. 
• Server Port. Enter the port number of the email server. Enter a 

port 1 – 65535. Ports 22, 53, 80, 2222, 27053, and 44818 are 
reserved for other services on the HMI device. For Gmail or 
Yahoo Mail, enter 465.  

Remove media from the HMI 
device 

Configure the SMTP client to 
send email 
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Tips:  
• If not using Use SSL, the email notification service supports STARTTLS only. 
• Entering a Server Port that is out of range or reserved displays an error. 
• An email server configuration completed on the HMI device persists after rebooting the HMI device, 

cycling power to the HMI device, and downloading a runtime application file to the HMI device.  
• To create a secure connection with a server (TLS/STARTTLS), either: 
• Select SSL and set a port with an available SSL connection. For Gmail and Yahoo Mail, in Server 

Port, enter 465. 
• Clear SSL and set a port with the server that has a TLS/STARTTLS option. For Gmail and Yahoo 

Mail, In Server Port, enter 587 or 25. If TLS/STARTTLS is not available, the connection is not 
secure. 

• The HMI device connects to the email server and sends email notifications even when the SMTP 
client is configured for password authentication and the email server does not require password 
authentication. 

4. Select Close .  

See also 
Settings screen on page 740 

Add an event command to send an email on page 465 

Event commands on page 456 

Reboot the HMI device to run the current project again. Data logs in the 
project remain unchanged when rebooting the HMI device. The data log 
starts collecting data again after the reboot completes. 

To reboot the HMI device 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.   
2. Select HMI Device. The HMI Device popup opens.  
3. Select Reboot. A prompt appears to confirm rebooting the HMI 

device.  
4. Select Yes to reboot the HMI device. Select No to not reboot the 

HMI device. Rebooting the HMI device opens the currently 
downloaded project. 

See also 
Change the name of the HMI device on page 746 

Disable downloads to the HMI device on page 746 

Settings screen on page 740 

The HMI device has a default date, time, and time zone. Change the 
values using the Date and Time popup.    

Reboot the HMI device 

Set the date and time on the 
HMI device 
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To set the date and time on the HMI device 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
2. Select Date and Time. The Date and Time popup opens. 
3. In the Date box, enter the month, day, and year in MM/DD/YYYY 

format and select OK. 
4. In the Time box, enter the hours, minutes, and seconds in 

HH:MM:SS format and select OK.  
5. In the Time Zone box, scroll to and select the time zone.   
6. Select Close . 

 
Tip: PanelView 5000 HMI devices contain a built-in database of all daylight savings time rules. 
PanelView 5000 switches to daylight savings time automatically according to the selected 
time zone. 

See also 
Change the name of the HMI device on page 746 

Disable downloads to the HMI device on page 746 

Reboot the HMI device on page 748 

View general information for controllers configured to operate with the 
HMI device. Use this information to diagnose issues with the controllers 
and collect information for Rockwell Automation Technical Support.  

To view information for configured controllers 
1. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
2. Select Controllers. The Controllers popup opens.  
3. Select the tab of the controller. 

 
Tip: If the project has multiple controller references, any unused controller reference has a 
Not configured tab.  

4. View this information to diagnose common issues with the 
controller:  
• Reference Name. The name of the controller reference 

configured in View Designer. The name does not appear if the 
project does not have a configured controller.   

• Controller Name. The name of the controller configured in 
Logix Designer. The name does not appear if the project does 
not have a configured controller.  

• Path. The communication path for the controller. The path does 
not appear if the project does not have a configured controller.  

• Catalog. The family of controllers to which the controller 
belongs.   

• Firmware. The revision of the controller firmware.   
• Tag information. The synchronization state for processing 

changes from the controller. For example, the state may be 
Synchronized, Updating, or Detecting changes. Some tag 
information may not appear if the controller tag information is 
not synchronized.   

View information for 
configured controllers 
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• Mode. The operating mode of the controller. For example, the 
mode may be Run, Program, or Fault. The mode does not 
appear if the controller is disconnected from the network. 

5. Send the diagnostic and connection information to Rockwell 
Automation Technical Support to diagnose more technical issues 
with the controller:  
• Active data items. The number of data items on scan for the 

controller.  
• Failed data items. The number of data items that did not scan 

for the controller. 
• Number optimized blocks. The numeric of optimized data 

blocks on scan for the controller.  
• Controller Responses. A count that increments each time the 

controller sends a communications packet. 
• HMIBC (I/O). The number of Class 1 CIP connections to the 

controller. 
• Alarm. The number of alarm CIP connections to the controller. 
• Data. The number of Class 3 CIP connections to the controller. 

6. Select Close .  

 See also 
Assign an IP and DNS address on page 741 

Configure Ethernet ports on page 742 

View network diagnostics on page 743 

By default, the troubleshooting data is turned on and automatically 
collects default data for an HMI device. If more information is required to 
diagnose the problem with the HMI device, Rockwell Automation emails 
a profile with a .RSTracingConfiguration extension. Use this file to collect 
additional data for Rockwell Automation Technical Support to diagnose 
the HMI device.  

When the troubleshooting profile is running, export a troubleshooting log 
to an external device and email the log to Rockwell Automation Technical 
Support for diagnosis. After the log is exported, restore default 
troubleshooting on the HMI device.  

To collect and export troubleshooting data 
1. Download the .RSTracingConfiguration file from Rockwell 

Automation to a USB drive or SD card.  
2. Insert the device into the HMI device. 
3. On the HMI device or in the System Banner, select Navigation 

 and then select Settings.  
4. Select Troubleshooting. The Troubleshooting popup opens.  
5. Select Import Profile. Messages indicating that the 

troubleshooting profile is being imported and that the 
troubleshooting profile is running appear. The profile collects the 
additional data. Do not select Restore Default Profile yet. This 

Collect and export 
troubleshooting data 
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reboots the HMI device, clearing any non-default troubleshooting 
data. 

 
Tip: If an error occurs while importing the troubleshooting profile, a message indicates that 
there is a problem with the external device or the file on the external device. The device may 
be damaged, read-only, or may not contain a valid troubleshooting profile. Place the 
necessary profile on another external device, insert that device into the HMI device, and 
select Import Profile again.  

6. If instructed in the email from Rockwell Automation that 
accompanied the profile, repeat the actions that caused the 
problem.  

7. Select Export. The troubleshooting log exports to the media. A 
message indicates when the log is successfully exported to the 
external device. The date and time stamp of the export appears. 

 
Tips:  
• If an error occurs while importing the troubleshooting profile, a message indicates that there is a 

problem with the external device or the file on the external device. The device may be damaged, 
read-only, or may not contain a valid troubleshooting profile. Place the necessary profile on 
another external device, insert the device into the HMI device, and select Import Profile again. 

• When exporting troubleshooting data to an SD card or USB storage device, make sure the SD card 
or USB storage device: 
• Has sufficient space 
• Is inserted into the HMI device 
• Has write permissions 
• Is a supported SD card type 
• Has a supported format of FAT32 

8. Place the troubleshooting log on the computer and email the file to 
Rockwell Automation Technical Support.  

9. Select Restore Default Profile. When prompted to reboot the 
HMI device, select Yes. This restores any non-default 
troubleshooting data from the HMI device.  

See also 
Change the name of the HMI device on page 746 

Disable downloads to the HMI device on page 746 

Reboot the HMI device on page 748 

Use the VNC screen to activate or de-activate the VNC server.  

To Activate the VNC server 
• Select an access command: 

• VNC View-Only Access - View content on the HMI device only. 
• VNC Full-Control Access - View content and interact with the 

HMI device. 
• Disable VNC Server - Disables the VNC server. 

 
Tip: Use View Designer to configure access rights for users remotely connecting to an 
HMI device. 

Activate the VNC server at 
runtime 
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Note: After rebooting the PanelView 5000 HMI device, the VNC server configuration automatically 
resets to the Disabled state. 

 

See also 
Settings screen on page 740 

Use the Remote Connectivity screen to activate or de-activate the VNC 
server.  

To Activate the VNC server 
• Select an access command: 

• VNC View-Only Access - View content on the HMI device only. 
• VNC Full-Control Access - View content and interact with the 

HMI device. 
• Disable VNC Server- Disables the VNC server 

Tip: Use View Designer to configure access rights for users remotely connecting 
to an HMI device. 

See also 
Settings screen on page 740 

Basic functions for the application on the HMI device include logging on 
and off, entering data, opening a screen, interacting with a popup, 
selecting a graphic element, triggering an action, and viewing diagnostic 
messages. The configuration of the application determines the 
interactions to perform on the HMI device.  

Perform basic functions on the HMI device to interact with the contents of 
the application.  

See also 
Log on on page 752 

Open a screen on page 757 

Trigger action to interact with a screen on page 760 

View error messages for a graphic element on page 769 

Log off on page 773 

Logging on to an application displays all screens for the assigned 
security role. Log on to the application using the configured password or 

Activate the server at 
runtime 

Perform basic functions 

Log on 
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PIN. Passwords and PINs appear as asterisks (*). All available screens 
appear in the Navigation menu.  

To log on 

1. In the System Banner at the top of the screen, select  Log on. 
The Logon dialog box opens. 

 
Tip: If configured, an event can open the Logon dialog box. Contact the HMI Designer to 
identify events configured for the application. 

2. Log on using the configured method:   
• User name and password (local). In the User Name box, use 

the Virtual Standard Keyboard that opens to select the keys 
and enter the user name. Do not use spaces. In the Password 
box, and select the keys to enter the case-sensitive password.  

• PIN. In the PIN box, use the Virtual Numeric Keypad that 
opens to select the keys to enter the personal identification 
number.   

• User name and password (domain). See Log on using 
network-based security on page 705. 

3. Select Log on. The Logon dialog box closes. The name of the 
logged on user appears in the System Banner.  

 
Tips:  
• To log on as a different user, open the Logon dialog box, enter a different user name and password 

or PIN, and then select Log on.   
• If the log on fails, the Logon dialog displays the message Log on unsuccessful for (name). The Logon 

dialog box remains open and the current user remains logged on.  

See also 
System Banner contents on page 731 

Log off on page 773 

Enter data using the Virtual Standard Keyboard on page 753 

Trigger action to interact with a screen on page 760 

• Navigation menu on page 732 
Select a screen or graphic element requiring input to open the Virtual 
Standard Keyboard and then select keys to enter text and numbers.  

To enter data using the Virtual Standard Keyboard 
1. Touch the screen or graphic element requiring text input. The 

Virtual Standard Keyboard opens. Any content already entered 
for the element is highlighted in the Input box at the top of the 
keyboard.  

2. If desired, select in the Input box or select the arrow keys to 
position the cursor in the Input box. If there is no current entry, the 
cursor appears in the Input box automatically. 

3. Enter or change the entry:  
To enter: Do this: 

Enter data using the Virtual 
Standard Keyboard 
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To enter: Do this: 

Characters • Select the appropriate keys. 
• To delete characters, with the cursor in the Input box, select Backspace 

 to delete one character to the left at a time.  

• To remove all the characters in the Input box, select Clear .  
Capital letters • Select Shift  and select the letter.  

• Select Caps Lock to change the keyboard to all capital letters. The keys 
display capital letters until selecting Caps Lock again. 

Symbols • Select Symbols . A symbol appears on each key.  
• Select the ABC key to show alpha numeric keys.  

European characters 
Select Language . A character appears on each key. This is a toggle key 
that returns to default characters. Characters can show in upper or lowercase.  

4. Select OK to insert the entry or select Cancel or elsewhere on the 
screen to close the Virtual Standard Keyboard. 

 
Tips:  
• A red outline appears around the Input box for an incorrect entry.  
• When using an external keyboard or the keypad on the HMI device, tab to highlight the first key on 

the Virtual Standard Keyboard, select the arrow keys to highlight a key, and then press Enter.  

See also 
Virtual Standard Keyboard on page 737 

Virtual Numeric Keypad on page 736 

Enter data using the Virtual Numeric Keypad on page 754 

Select a graphic element on page 759 

Use the Virtual Numeric Keypad to enter data. Touching the screen or 
graphic element requiring numeric input opens the Virtual Numeric 
Keypad. The minimum and maximum values to enter for the selected 
element appear below the Input box on the Virtual Numeric Keypad.  

To enter data using the Virtual Numeric Keypad 
1. Touch the screen or graphic element requiring numeric input. The 

Virtual Numeric Keypad opens. Any value for the element 
appears highlighted in the Input box at the top of the keypad.  

2. Enter or change the data:   
• Select the keys to enter the numeric value.  

• Select Positive-Negative Value  to toggle the number 
in the Input box between a positive and negative number.   

• Select Backspace  to delete one number to the left at a 
time.  

• To remove all of the numbers in the Input box, select Clear .     
3. To enter the value, select OK. To close the Virtual Numeric 

Keypad and not enter the value, select Cancel or elsewhere on 
the screen. 

Enter data using the Virtual 
Numeric Keypad 
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Tips:  
• A red outline appears around the Input box for an incorrect entry.  
• To enter a value using an external keyboard, tab to highlight the first key on the Virtual Numeric 

Keypad, select the arrow keys to highlight a key, and then press Enter. 

See also 
Enter data using the Virtual Standard Keyboard on page 753 

Virtual Numeric Keypad 

Virtual Standard Keyboard on page 737 

Select a graphic element on page 759 

Load a runtime application from removable media to the HMI device 
using the Settings screen or by using the Load Application event 
command. Using View Designer to download a project is not required 
when the application is on a USB storage device or SD card.  

To load an application from removable media 
1. Insert the USB storage device or SD Card containing the runtime 

application into the HMI device. 

 
Tips:  
• Verify that there is only one inserted USB storage device in the HMI device. View Designer does not 

support loading an application from removable media when there are two inserted USB storage 
devices. 

• If the major revision of the application on removable media does not match the major revision of 
firmware running on the HMI device, the removable media should also have the .dmk file for the 
required firmware revision. 

2. On the HMI device or in the System Banner, select Navigation 
 and then select Settings. 

3. Select Load from Media. The Load Application popup opens. 
4. Under Source, select SD Card or USB Device. 
5. Under Runtime application files, select the runtime application 

to load. The application appears in the box at the bottom of the 
popup. 

6. Select Next. 
7. Under HMI to controller path, specify the path for the HMI to use 

after the project is loaded, by selecting either: 
• Keep path currently in use on HMI device. Use the controller 

path currently used on the HMI device. Selecting this option 
displays the current HMI to controller paths. 

• Load path defined in the runtime application file. Use the 
controller path configured in the runtime application that is 
loading. 

Load an application from 
removable media 
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Tips:  
• If loading the runtime application requires a firmware update to the HMI device, a message 

appears with the current and required firmware versions. Select Load to proceed with the 
firmware update and then load the project. 

• If the removable media does not contain the required firmware version, a prompt appears. Select 
Back and then copy the required firmware version to the removable media before loading the 
runtime application file.  

• If the HMI device has a firmware version that does not support loading a runtime application file 
from removable media, a prompt appears. Select Back and then use ControlFLASH to update the 
firmware on the HMI device before loading the runtime application file. 

• Loading firmware that has a major version earlier than version 6 not supported when loading an 
application from removable media. 

• Loading firmware from media on an HMI device currently running firmware earlier than version 6 is 
not supported. 

• Firmware can be loaded from media on an HMI device running out-of-the-box manufacturing 
firmware if the HMI device was manufactured after the version 6 release. 

8. Select Load. The HMI device performs the firmware update (if 
necessary) and loads the project. Afterwards, the Home screen 
opens on the device. 

IMPORTANT If you use a custom command to load new firmware from removable media, and 
the screen containing the command is already opened before you insert the 
media, reload the screen, or navigate out of the screen and return, before using 
this command. 

See also 
Configure the HMI device on page 740 

Settings screen on page 740 

Disable downloads to the HMI device on page 746 

Perform basic functions on page 752 

Loading a runtime application file on a PanelView 5000 HMI device 
requires that the HMI device has the required version of firmware. Copy a 
runtime application .vpdr file and the required version of the firmware 
.dmk file to the removable media to load the runtime application file and 
the required version of firmware to the HMI device. 

IMPORTANT Firmware updates from removable media for a PanelView 5000 HMI device that has 
firmware prior to version 6 is not supported. Use ControlFLASH to update the firmware 
on a PanelView 5000 HMI device that is running firmware prior to version 6. 

Prerequisites 
• In View Designer, save the runtime application file as a .vpdr file 

on removable media.   

To load firmware from removable media 
1. Copy the revision of firmware that matches the runtime application 

.vpdr file on the removable media to the root directory of the 
removable media. For example, when using View Designer 
version 6 to create the .vpdr file, copy the version 6 PanelView 
5000 firmware .dmk file to the removable media. 

Load firmware from 
removable media 
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Tips:  
• The installation of Studio 5000 installs firmware .dmk files at 

C:\Users\Public\Documents\Rockwell Automation\Firmware Kits. Downloading .dmk files is also 
available from the Rockwell Automation support site. 

• The .dmk filename for a PanelView 5310 is 2713P-PanelView_m.n.dmk. The .dmk filename for a 
PanelView 5510 is 2715P-PanelView_m.n.dmk. The m.n in the filenames represent the major and 
minor revision numbers of the firmware. 

• Placing multiple .vpdr and .dmk files on the same removable media is supported. The system 
automatically loads the required .dmk file for the .vpdr file loaded from removable media.  

• Updating either the major or minor version of firmware is supported. To update only the minor 
revision of the firmware on the HMI device, copy the .dmk file with the required minor version. 

• Loading from media on an HMI device running out-of-the-box manufacturing firmware if the HMI 
device was manufactured after the version 6 release date is supported.  

2. Insert the removable media containing the .vpdr and .dmk files into 
the HMI device.  

3. From the Settings screen, select Load from Media to open the 
Load from Media popup and load the runtime application .vpdr 
file from the removable media. 

 
Tip: If the .vpdr file on the removable media requires a different version of firmware than is 
installed on the HMI device, the firmware .dmk file on the removable media automatically 
installs before the runtime application file opens on the HMI device. 

See also 
Save a runtime application to removable media on page 63 

Load an application from removable media on page 755 

Open any screen that is accessible with the assigned security rights. 
When opening a screen, an overlay dims the current screen to show that 
interaction with the screen is not available. When the new screen opens, 
interaction with the screen is available immediately. Interact with the new 
screen when the overlay from the previous screen still appears or when 
the new screen is loading content. By default, the Home screen of the 
project opens on the HMI device.  

To open a screen 
1. On the HMI device or in the System Banner at the top of the 

screen, select Navigation . The Navigation menu opens. 
2. Select to open a: 

• Screen. Select the item in the Navigation menu.  
• Home screen. Select Home  in the Navigation menu. 
• Next screen. Select Next  in the System Banner to open 

the next screen in navigation history. 
• Previous screen. Select Previous  in the System Banner 

to open the previous screen in navigation history.  
• Folder. Select a folder in the Navigation menu to display 

screens within the folder. The contents of the folder appears in 
an upper row. Folders may contain subfolders. Breadcrumbs 
shows the current folder path in the upper row.   

• Previous folder. Select Back  to the left of the 
breadcrumbs to navigate back a folder.  

Open a screen 
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Tips:  
• Using an external keyboard, tab to the item and press Enter.  
• When using an external keyboard, use the following keys to navigate the Navigation menu: 
• Next item. Press the right arrow and Enter. 
• Previous item. Press the left arrow and Enter. 
• First item. Press Home and Enter.  
• Last item. Press End and press Enter.  
• Next page of menu items. Press Page Down.  
• Previous page of menu items. Press Page Up.  

See also 
Log on on page 752 

Navigation menu on page 732 

Popup on page 733 

Select a graphic element on page 759 

Interact with a popup on page 759 

Use the web browser to access content on the intranet, the Internet, 
remote file servers, devices with built-in webpages, removable SD or 
USB drives, or IP cameras. 

You can only access the web browser through a command defined in the 
HMI application. Your level of access depends on the security 
configuration and your account privileges. 

You can run only one instance of a web browser at a time. To run a 
different instance of the web browser, first close the running instance. 
The web browser supports only one window or tab at a time. Links that 
open a page in a new tab or new window may not function. Bookmarks, 
file downloads and uploads are disabled. The HMI device does not retain 
browsing history, login data, or cookies. 

While using the web browser, pressing the Navigation button, navigating 
to a different screen, or opening a popup closes the browser window. You 
can also close the web browser using a Close Web Browser command. 
The Close Web Browser command discards any data not committed to 
the webpage, such as data entered into forms, or text boxes. 

IMPORTANT An open web browser captures all key presses. Project events relying on key presses do 
not trigger when the browser is open. 

On high RAM memory use, the web browser closes the open webpage 
and displays an error dialog so that you can reload the webpage or close 
the browser. 

If the HMI application has Auto-Logoff enabled, the browser closes. 
Playing videos and accessing IP cameras does not prevent auto-logoff 
unless the user performs other activities. 

See also 
Event commands on page 456 

Web browser 
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Add an event command to open the web browser on page 471 

Add an event command to import a certificate on page 473 

Add locations to the allowed locations list on page 701 

Configure Auto-Logoff on page 688 

Touch a graphic element to select it or use the HMI device keypad or an 
external keyboard. Placing focus on a graphic element using the HMI 
device keypad or an external keyboard places a highlighted rectangle 
around the graphic element.     

Touching a graphic element or selecting a graphic element with an 
external keyboard and pressing Enter may trigger an event. To learn 
configured events, contact the HMI Designer.   

To select a graphic element 
• Select the desired graphic element on a screen, popup, or System 

Banner. Any configured event for the graphic element triggers. 

 
Tips:  
• If a graphic element in error appears off or near an edge of the screen, an arrow with an Error icon 

 points in the direction of the graphic element. Select the arrow to open the Error list for the 
graphic element.  

• To select a graphic element using the HMI keypad or an external keyboard, select or press Tab or 
Back Tab and then select or press Enter. 

• Using an external keyboard, press Shift+Tab to back tab. 
• If selecting Tab or Back Tab does not select a graphic element, it highlights the first or last item on 

the screen that accepts focus. 
• If an item in the System Banner is highlighted, selecting Tab or Back Tab highlights the next or 

previous selectable item in the System Banner.  
• Tabbing and back tabbing highlights graphic elements on the screen and the System Banner.  
• Tabbing and back tabbing within a popup highlights graphic elements within the popup only. 

See also 
Trigger action to interact with a screen on page 760 

Interact with a popup on page 759 

HMI device keypad on page 738 

System Banner contents on page 731 

Popup on page 733 

Interact with a popup by opening, moving, or closing the popup. To 
identify the event that opens a popup, contact the HMI Designer. 

To interact with a popup 
1. Perform the event to open the popup. For example, select a button 

configured with a press event configured in Studio 5000 View 
Designer. 

Select a graphic element 

Interact with a popup 
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2. Perform any action required by the popup. If the Virtual Standard 
Keyboard or Virtual Numeric Keypad opens, enter the required 
data. Popup contents may include events and animations. 
Interacting with a popup may perform an event or animation 
depending on the configuration of the popup. Selecting a button on 
the popup may change the appearance of the button. 

3. To close a popup, select Close  on the popup or select 
elsewhere on the screen. 

 
Tips:  
• To move a popup, select and drag the caption at the top of the popup.  
• Move a portion of a popup off the edge of the HMI device screen to provide more room on the 

screen.  
• Only popups with captions can move.  
• Opening another popup or the Navigation menu closes the open popup.  
• Performing an event may close a popup. To identify events configured for the application, contact 

the HMI Designer.  

See also 
Popup on page 733 

Popup contents on page 119 

Trigger action to interact with a screen on page 760 

Enter data using the Virtual Standard Keyboard on page 753 

Enter data using the Virtual Numeric Keypad on page 754 

Trigger actions manually when pressing or releasing a configured HMI 
device screen, popup, graphic element, button, or a key on the HMI 
device keypad or an external keyboard. A graphic element transitioning 
into or out of a state may trigger an event automatically. Items can only 
trigger actions when configured to do so in Studio 5000 View Designer. 
To identify configured events, contact the HMI Designer. 

To trigger action to interact with a screen 
• Press or release a configured screen, popup, graphic element, or 

button on the screen. If keys are configured to trigger an action, 
press or release a configured key or key combination on an 
external keyboard.  
Depending on the configuration of an event in Studio 5000 View 
Designer, focus may not be required for the event to trigger. For 
example, an event may occur even if the graphic element does not 
have focus when the event triggers. A Key Press or Key Release 
event that does not require focus triggers when pressing or 
releasing the key, regardless of where focus is on the screen. If 
the graphic element requires focus to perform a configured event, 
press Tab to highlight the graphic element. The graphic element 
appears highlighted in blue.  

Trigger action to interact 
with a screen 
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Tips:  
• The configuration of a Touch Release event may always perform a command. The event occurs 

even when sliding a finger off the graphic element before releasing the graphic element, when the 
graphic element becomes disabled or invisible, or when screen navigation opens a different 
screen. A Touch Release event for a graphic element that is a momentary push button may always 
release to start a conveyor belt when pressed, and stop a conveyor belt when released.   

• For graphic elements configured to behave as a button, the button behavior may trigger when 
pressing a key. Touching graphic elements configured to behave as a button still triggers the 
action. If a graphic element has only a Key Press event, no event triggers when touching the 
graphic element.  

• L1 through L10 on an HMI device keypad correspond with Shift+F1 through Shift+F10 on an external 
keyboard. 

• R1 through R10 on an HMI device keypad correspond with Ctrl+F1 through Ctrl+F10 on an external 
keyboard. 

See also 
What is an event? on page 766 

In what order are events triggered? on page 761  

Popup on page 733 

Popup contents on page 119 

Select a graphic element on page 759 

The order in which touch events trigger depends on the events 
configured for a screen and its graphic elements. When configuring 
multiple graphic elements with touch events, the events trigger as 
follows: 

Screen events trigger before graphic element events 
A screen can have an event and also contain a graphic element with its 
own event. Touching the screen triggers the event. Touching the graphic 
element triggers the event of the screen and the event of the graphic 
element. In this example, there is an event associated with the screen, 
and an event associated with the button.  

 
Press Event Triggered action 

 
Press here to trigger the event associated with the screen.   

 
Press here to trigger the event associated with the screen and then trigger the 
event associated with the button.  

In what order are events 
triggered? 
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An event of a graphic element triggers even when the graphic 
element overlaps another 
A graphic element may lie partially over another graphic element on the 
screen. Each graphic element can have its own event. Trigger the event 
of the graphic element by touching the graphic element. This is true even 
when touching the portion of a graphic element that is on top of the other. 
In this example, there is a unique event associated with each button. Part 
of Button B lies on top of Button A. 

 
Press Event Triggered action 

 
Press here to trigger the event associated with Button A.  

 
Press here to trigger the event associated with Button B. 

 
Press here to trigger the event associated with Button B. 

Graphic elements with events are not affected by an overlay element 
that does not have an event 
A graphic element with a touch event may lie underneath an overlay 
element. If the overlay element does not have an event, the event of the 
graphic element triggers even when pressing the portion of the element 
under the overlay. In this example, there is an event associated with 
Button A. However, there is no event associated for the rectangle overlay 
lying on top of a portion of Button A.  

 
Press Event Triggered action 

 
Press here to trigger the event associated with Button A.  

 
Press here to trigger the event associated with Button A. 

 
Press here to trigger no event.  

An event of a group and the events of the graphic elements in the 
group are not affected by an overlay element that does not have an 
event 
When a group with a touch event contains graphic elements with touch 
events, touching the group triggers the event of the group. Pressing a 
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graphic element in the group triggers the event of the group, and the 
event of the graphic element. An overlay element that does not have an 
event does not affect triggered events. In this example, there is an event 
associated with the group consisting of Button A and Button B, an event 
associated with Button A, and an event associated with Button B 
(positioned partially over Button A). There is no event associated with the 
rectangle overlay. 

 
Press Event Triggered action 

 
Press here to trigger the event associated with the group and then trigger 
the event associated with Button A.   

 
Press here to trigger the event associated with the group and then trigger 
the event associated with Button B.  

 
Press here to trigger the event associated with the group and then trigger 
the event associated with Button B.  

 
Press here to trigger the event associated with the group.  

An event of a group of line art is triggered regardless where the 
group is pressed 
If a group of line art contains a touch event, it triggers the event of the 
group regardless of where the group is pressed. In this example, there is 
an event associated with the group that contains the line art.  

 
Press Event Triggered action 

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group.  
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When a group of line art with an event contains a numeric or text 
input graphic element, the event of the group triggers before the 
virtual numeric keypad or virtual standard keyboard opens 
If a group contains line art and an input graphic element, the event of the 
group triggers regardless of where the group is touched. If pressing the 
input graphic element, it triggers the event of the group and opens the 
virtual numeric keypad or virtual standard keyboard. If a group contains 
line art and an input graphic element,  the event of the group triggers 
regardless of where the group is touched. Pressing the input graphic 
element triggers the event of the group and opens the virtual numeric 
keypad or virtual standard keyboard. In this example, there is an event 
associated with the group. The group contains line art and a text input 
graphic element.  

 
Press Event Triggered action 

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group. 

 
Press here to trigger the event associated with the group and then open the 
virtual numeric keypad or virtual standard keyboard to enable input. 

When a group of line art with an event is placed on top of a numeric 
or text input graphic element that is not part of the group, the event 
of the group is triggered, but the virtual numeric keypad or keyboard 
does not open 
If a group lies on top of an input graphic element, touching the group 
triggers the event of the group. Pressing the input graphic element does 
not open a virtual numeric keypad or virtual standard keyboard.  

In this example, a group that has an event associated lies on top of an 
input graphic element that is not part of the group. 
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Press Event Triggered action 

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group. The virtual 
numeric keypad or the virtual standard keyboard does not open.   

An event of a group and the events of the graphic elements in the 
group are not triggered if the event of an overlay graphic element is 
triggered 
For example, a group with a touch event contains two graphic elements 
with their own touch events. A graphic element with its own touch event 
lies on top of the group. Touching a graphic element not under the 
overlay element triggers the event of the group and the event of the 
graphic element. Pressing a graphic element under the overlay element 
triggers only the event of the overlay element. In this example, there is an 
event associated with the group. The two buttons in the group each have 
a unique event associated with them. There is also an event associated 
with an overlay element.  

 
Press Event Triggered action 

 
Press here to trigger the event associated with the group.  

 
Press here to trigger the event associated with the group and then trigger 
the event associated with Button A.  

 
Press here to trigger the event associated with the rectangle overlay.  

When a group has a release event and the graphic elements in the 
group have press and release events, the event of the press event is 
triggered before the release events of the group and its graphic 
elements 
For example, a group with a Touch Release event contains a button with 
its own both press and release events. The events of the button change 
the state of the button upon press and release. Pressing the button 
triggers the press event of the button. The button shows the press state. 
Releasing the button triggers the Touch Release event of the group, and 
the Touch Release event of the button showing the release state. In this 
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example, a group contains only a button. There is a Touch Release event 
associated with the group. A Touch Press event and a Touch Release 
event are associated with the button.  

  
Press Event Triggered action 

 
Press the button to trigger the touch press event associated with the button. 
Release the button to trigger the Touch Release event associated with the 
group, and then trigger the touch release event associated with the button.    

See also 
Trigger action to interact with a screen on page 760 

Open a screen on page 757 

Interact with a popup on page 759 

Popup contents on page 119 

An event is something that occurs to trigger an action. Events trigger 
either manually or automatically by the system. Events trigger by:   

• Button Behavior. Touch or release a button or key on the HMI 
device, or configure a graphic element or Add-On Graphic with 
typical button behaviors. 

• Touch Press and Touch Release. Touch or release a graphic 
element, Add-On Graphic, screen, popup, or System Banner on 
the HMI device. 

• Key Press and Key Release. Touch or release a key on the HMI 
device keypad or an external keyboard.  

• State Enter and State Exit. Perform an event when a graphic 
element or Add-On Graphic transitions into or out of a selected 
state. For example, perform the event when the value of a tag in 
the controller changes from 50 to 100.   

When an event triggers, it performs an event to:   

• Change the state of a graphic element. An event can apply the 
next or previous state in an indicated state table configured in 
Studio 5000 View Designer. An event can change the appearance 
of a button to a previous red state or to the next green state.  

• Log on or off the project. 
• Open a specific screen or navigate to a previous or next screen in 

the navigation history. 
• Open or close a popup. 
• Open the Navigation menu. 
• Increment the data value of a tag with a value or expression 

configured in Studio 5000 View Designer. 

What is an event? 
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• Toggle a selected tag value between True and False. 
• Change the selected tag value by a value or expression specified 

in Studio 5000 View Designer.  
• Change the language displayed on the HMI device.  
• Export a data log. 

To identify the events configured for the application, contact the HMI 
designer. 

See also 
Select a graphic element on page 759 

Trigger action to interact with a screen on page 760 

Interact with a popup on page 759 

Navigate a PDF document on the HMI device. The buttons and 
functionality available on the HMI device depend on the configuration of 
the PDF graphic element or the PDF Viewer Add-On Graphic.  

 
Tip: The PanelView 5310 HMI device does not support the PDF Viewer graphic element or the PDF 
Viewer Add-On Graphic.  

To navigate or zoom a PDF document 
• Select a button to navigate the PDF document:  

• Bookmarks  displays the bookmarks. 
• Previous  opens the previous page. 
• Next  opens the next page. 
• Page Number opens the page of the PDF document entered in 

the Page Number box.    
• Fit Width  expands the width of the PDF document. 
• Fit Window  expands the entire page of the PDF document 

to fit the PDF graphic element. 
• Zoom In  increases the PDF document magnification by the 

percentage specified in the ByPercent property of the Zoom In 
event command. 

• Zoom Out  decreases the PDF document magnification by 
the percentage specified in the ByPercent property of the Zoom 
In event command. 

 
Tips:  
• PDF files that contain complex drawings take longer to render. For example, if a PDF contains an 

image that is actually a drawing of individual shapes such as lines, circles, and rectangles, that 
image takes longer to render than a drawing that is a single image.  

• On a keypad terminal, press a key to navigate the pages of a PDF document: 
• Home: Navigate to the first page. 
• End: Navigate to the last page 
• Page Up: Navigate to the previous page. 
• Page Down: Navigate to the previous page. 
• Up, Down, Right, and Left arrows: Navigate the content of the displayed page. 

Navigate and zoom a PDF 
document 
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See also 
Perform basic functions on page 752 

On the HMI device, an example PDF_Viewer_Landscape includes:  

 
Item Description 

 
Bookmarks for the PDF document in the PDF_Viewer_Landscape.  

  Bookmarks displays the bookmarks of the PDF document. To display bookmarks, 
configure bookmarks for the PDF before adding the PDF to the View Designer project. 

  Previous opens the previous page in the PDF document. If there is no previous page to 
open, the button appears unavailable.  

  Next opens the next page in the PDF document. When on the last page, the button 
appears unavailable. 

 
The open page in the PDF document. Specify a different page number to open a different page in 
the PDF document.  

 
The name of the PDF document in the PDF Viewer. 

  Fit Width expands the width of the PDF document to the width of the PDF Viewer.  

  Fit Window expands the size of the PDF document to the size of the PDF Viewer. 

  Zoom In increases the PDF document magnification by the percentage specified in the 
event command. 

  Zoom Out decreases the PDF document magnification by the percentage specified in the 
event command. 

 
The PDF document specified for the PDF Viewer. In View Designer, the PDF document must exist 
in the Documents folder of the Project Explorer. 

See also 
Select a graphic element on page 759 

Trigger action to interact with a screen on page 760 

PDF Viewer 
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A graphic element or group of graphic elements in error is outlined in red 

and has an  Error icon . An Error icon  appears for 10 seconds 
for any graphic element that has an event with a command that is in 
error. Select this icon to open an Error list with the diagnostic messages 
associated with a graphic element in error.  

If an error occurs for any property of a graphic element, the properties 
that set position, size, and angle freeze. When the properties of the 
graphic element are no longer in error, the last written values for the 
position, size, and angle properties apply to the graphic element.  

To view diagnostic messages for a graphic element in error 

1. Select the Error icon  on the graphic element or tab to 
highlight the icon and press Enter. The Error list opens.  

2. View the errors and diagnostic messages for the graphic element: 
Graphic element Action 

Current graphic element • Swipe vertically or select the Down Arrow and Up Arrow at the bottom and 
top of the Error list to scroll the error messages. 

• Using an external keyboard, press the Down Arrow and Up Arrow keys to 
scroll to the next and previous line of error messages.  

• Using the physical keypad, press Page Down  and Page Up  to 
scroll to the next page of error messages. 

• Press Home  and End  to go to first or last line of the error 
messages.  

Next graphic element in a group 
of graphic elements in error 

• Swipe horizontally from right to left, or select the Right Arrow in the lower 
right corner of the Error list. The diagnostic messages for the next 
graphic element in error appear in the Error list. 

• Using the physical keypad on the HMI device or an external keyboard, 

press Tab  to highlight the button and press Enter.  
• Using the physical keypad on the HMI device or an external keyboard, 

press the Right Arrow key. 
Previous graphic element in a 
group of graphic elements in 
error 

• Swipe horizontally from left to right, or select the Left Arrow in the lower 
right corner of the Error list. The diagnostic messages for the previous 
graphic element in error appear in the Error list. 

• Using the physical keypad on the HMI device or an external keyboard, 

press Tab  to highlight the button and press Enter.  
• Using the physical keypad on the HMI device or an external keyboard, 

press the Left Arrow key.  

3. To close the Error list, select Close . Using the physical 
keypad on the HMI device or an external keyboard, press Esc. 

 Tip: Closing the Error list makes the Error icon  disappear. 

See also 
Error list on page 736 

Error list contents on page 734 

How do I open the Error list? 

On the graphic element or group of graphic elements outlined in red, tap 

View error messages for a 
graphic element 

Error list 
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the Error icon  or tab to the icon and press Enter.  

An Error list contains a snapshot of the diagnostic messages associated 
with a graphic element or group of graphic elements in error. The Error 
list is static. Closing and reopening the Error list for a graphic element 
crosses out resolved errors. When a graphic element or group of graphic 
elements has errors, the graphic element or group appears outlined in 

red and has an Error icon .  

Errors occur for reasons including, but not limited to: 

• A tag is missing.  
• A tag is unavailable due to public/private Logix protection. 
• A data type is incompatible with the type of graphic element. 
• There is a faulted or missing controller. 
• There is a disconnected controller. PanelView 5000 detects a 

disconnect in communication within five seconds. Before five 
seconds expire, static data values may appear on a screen and 
repeating values may appear in a data log when the sample rate is 
less than five seconds. After five seconds, the data appears as 
bad quality. Updated data appears when reconnecting the 
controller. 

• There is a broken cable or other network issue. 
• Services that impact data delivery are hung or stopped. 
• A state change event caused the error. 
• An operation performed on an alarm failed. Refreshing errors for 

an alarm table is not supported. Perform the operation on the 
alarm table again. If the error occurs again, reopen the Error list. 
Resolving errors that appear on a disabled alarm table button is 
not supported. Disabled buttons appear with diagonal hash marks 
across them. The HMI Designer can enable the button in Studio 
5000 View Designer. 

• An event displays a diagnostic error. Manually removing errors 
when an error occurs due to a state change is not supported. 
Another state change event must remove the error. 

See also 
Error list contents on page 734 

View error messages for a graphic element on page 769 

Error list contents 
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An Error list appears for any graphic element or group of graphic 

elements in error. An Error icon  appears on the graphic element or 
group. This icon opens the Error list. The item in error can be a graphic 
element, popup, or an Alarm Summary or Alarm Manager.   

 
 

Item Description 

 
The number of graphic elements in error. An individual graphic element in error shows no 

number on the Error icon . If the Error icon  displays a number, there are multiple 
graphic elements in error that are located close to each other. The Error list contains a page 
of diagnostic messages for each graphic element in the group. 

 
The name of the graphic element affected by the current page of errors. Scroll horizontally to 
view long names.   

 
The diagnostic messages for the item in error.  
• Graphic element. If a graphic element is in error, the Error list displays the tag associated 

with the error, the property not applied to the graphic element due to the error, and a 
description of what caused the error.   

• Alarms. If an Alarm Summary or Alarm Manager is in error, the Error list displays the 
affected alarm property, and a description of the alarm error.   

 
When selected, the graphic element in error appears filled with a color that contrasts the 
background color of the screen. 

 
When there are multiple graphic elements in error, numbers indicate the graphic element. If 
there are three graphic elements in error while viewing diagnostic messages for the first 
graphic element, the Error list displays 1/3. The Next and Previous buttons show the 
diagnostic messages for the next and previous graphic elements.  
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See also 
Error list on page 736 

View error messages for a graphic element on page 769 

Prepare the SD card for safe removal from the HMI device so that the 
files on the SD card do not become corrupt.    

To remove the SD card from the HMI device 
• Perform the event configured with a Safely Remove Media 

command. To identify events to perform, contact the HMI 
Designer.  

See also 
Load an application from removable media on page 755 

Load a digital certificate from removable media to the HMI device. A 
digital certificate allows you to access locations on the Internet that use 
HTTPS or WSS secured protocols. 

 
Tips:  
• When creating a self-signed certificate, make sure the Subject Alternative Name property of the 

certificate contains the IP address of the device or server you are connecting to. 
• To import a certificate with .der extension, change the extension to .cer manually, or use a custom 

command that is setup with the certificate's exact filename. 

Prerequisites 
• Verify that the certificate files are in the root directory of the SD 

card or the USB drive. 
• The certificates must have .cer, .crt, or .pem extension. 

To import a certificate from removable media 
1. Insert the USB storage device or SD Card containing the runtime 

application into the HMI device. 
2. On the HMI device or in the System Banner, select Navigation 

 and then select Settings. 
3. Select Certificates. The Certificates popup opens. 
4. Select Import. 
5. Under Source, select SD Card or USB Device. 
6. From the Certificate files list, select a certificate file to import. You 

can only import one certificate file at a time. 
7. Select Import. The HMI device imports the digital certificate.  

See also 
Delete a digital certificate from the HMI device 

Remove media from the HMI 
device 

Import a digital certificate 
from removable media 
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Logging off from the application automatically logs on the Guest user. 
The current screen remains open if the Guest user role has security 
access to the screen. If Guest does not have access to the current 
screen, the Home screen for the project opens. Only items to which the 
Guest user account has access appear in the Navigation menu. 

To log off 

1. In the System Banner at the top of the screen, select  Log 
on. The Logon dialog box opens. 

2. Select Log off. The Logon dialog box closes. Log on appears in 
the System Banner. 

 
Tips:  
• Using an external keyboard, tab to highlight a button and press Enter. 
• Logging off the HMI device erases the navigation history.  
• Log off occurs automatically if the HMI Designer configures the project to log off after a specified 

period of inactivity. To identify any specified time limit set for automatic log off, contact the HMI 
Designer.   

See also 
Log on on page 752 

System Banner on page 730 

System Banner contents on page 731 

Navigation menu on page 732 

Navigation menu contents on page 732 

Alarms appear on predefined alarm screens included in every project. 
Each project contains a default Alarm Summary screen with an Alarm 
Summary table, and an Alarm Manager screen with an Alarm Manager 
table.  

Use alarm screens to monitor and manage control system alarms. No 
configuration or tag binding is required in Studio 5000 View Designer to 
display alarms. Use Logix Designer to program alarm detection 
instructions and add tag-based alarms in a Logix 5000 controller. The 
5380, 5480 and 5580 Logix families of controllers support tag-based 
alarms. Use alarm table graphic elements to create additional alarm 
screens. 

See also 
Alarm screens on page 774 

Differences between an Alarm Summary and an Alarm Manager 
on page 774 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

Perform basic alarm functions on page 799 

Log off 

Interact with alarms 
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View Designer provides two default alarm screens. It also provides two 
alarm table graphic elements to create alarm screens for different size 
HMI devices:   

• Alarm Summary. The Alarm Summary is a list of alarms that are 
in interesting states or require attention, such as alarms that are In 
Alarm and Unacknowledged.   

• Alarm Manager. The Alarm Manager is a list of all alarms 
regardless of their state. Alarms listed in the Alarm Manager 
include all conditions for an alarm.  

Alarms from controllers are continuously evaluated to determine whether 
they are: 

• In Alarm. Present conditions have caused the alarm to become 
active.  

• Normal. Present conditions have not caused the alarm to become 
active, so the alarm is inactive.   

 

 
Tips:  
• Operations on alarms may be limited. Alarm operation buttons may be disabled in View Designer. 

Disabled buttons have diagonal hash marks across them. When selecting a disabled button, an 

Error icon  appears on the button for 10 seconds. Selecting this icon opens an Error list with 
the message that the button is disabled. Disabled buttons do not perform the associated task.  

• If no language is defined in the controller, alarm tables show messages defined in the controller. If 
messages are not defined in the controller, the Message column in an alarm table appears blank 
without error.  

• If languages are defined in the controller and English-US is one of the defined languages, the 
message in the English-US language appears in the Message column of the alarm table. If no 
English-US string exists or if the English-US language is not one of the defined languages in the 
controller, the Message column appears blank without error. 

• For tag-based alarms, Alarm Manager and Alarm Summary display alarms marked as active and 
ready for evaluation. The 5380, 5480 and 5580 Logix families of controllers support tag-based 
alarms.  

See also 
Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

The Alarm Summary screen lists alarms in interesting states that 
require attention. For example, the Alarm Summary table lists alarms 
that are In Alarm and Unacknowledged. The Alarm Summary table 
displays one alarm condition per row. View details of each alarm 
condition in the Details pane of the Alarm Summary table. This pane 
displays data, such as Current Value, In Alarm Time, Out of Alarm Time, 
and tag values.   

The Alarm Manager screen lists all alarms, regardless of their states. 
The Alarm Manager table displays one alarm per row. All of the 
conditions are rolled up into one row for each alarm. To see the 
conditions of an alarm in the Alarm Manager table, display the Details 
pane for the alarm. Details include when the alarm condition is enabled or 
disabled, suppressed or unsuppressed, or shelved.  

Alarm screens 

Differences between an 
Alarm Summary and an 
Alarm Manager 
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When selecting multiple alarms, the display details appear for the last 
selected alarm condition in an Alarm Summary table or the condition 
details of the selected alarm in an Alarm Manager table. 

Available operations depend on the alarm screen:  

Operation  Alarm 
Summary  

Alarm 
Manager  

Alarm 
History 

Acknowledge alarms    

Disable alarms    
Enable alarms    
Filter alarms by Event Time    
Pause the display of incoming alarms    
Reset a digital alarm    

Reset alarm counts    
Select alarms    
Shelve individual alarm conditions    
Shelve entire alarm (all conditions)    
Sort and filter alarms    
View alarms    
View alarm condition details    
View alarm quality    
Unshelve alarm conditions    
Unshelve alarms    

See also 
Alarm screens on page 774 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

Details pane for an Alarm Summary on page 580 

Details pane for an Alarm Manager on page 592 

The Alarm Summary screen and Alarm Manager screen each contain 
several components.  

• Details pane. Displays additional information for the selected 
alarm condition in an Alarm Summary or the selected alarm in the 
Alarm Manager. 

• Columns. Displays data fields that contain descriptions of the 
alarm information. 

• Help popup. Displays a legend of operations to perform on the 
open alarm screen.  

See also 
Details pane on page 791 

Help popup on page 796 

Alarm Summary screen on page 776 

Alarm table interface 
components 
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Alarm Manager screen on page 781 

Alarms have good or bad quality. Good quality indicates the alarm is 
functioning correctly. Bad quality indicates that there is a problem with 
the alarm.  

The current state may not be detected or accurate. Bad quality occurs 
from abnormal scenarios, such as a disconnect in the network, or a 
controller in Program mode, or by configuration issues. If the alarm has 
bad quality due to an abnormal scenario, all conditions of the alarm fault 
because evaluating or detecting the alarm is not possible. If the alarm 
has a configuration error, such as invalid limit, only the affected 
conditions have bad quality. The unaffected conditions have good quality 
and continue to function. View alarms with bad quality in an Alarm 
Manager only. Quality details appear in the Details pane of the Alarm 
Manager table.  

For configuration-related faults, level conditions (HIHI, HI, LO, and 
LOLO) and ROC conditions (ROC Positive and ROC Negative) are 
evaluated independently. With the exception of severity, only affected 
conditions are faulted. If the ROC Positive limit is invalid, only the ROC 
Positive condition faults. The ROC Negative condition and all level 
conditions maintain good quality. If the ROC_Period is invalid, both the 
ROC Positive and ROC Negative conditions fault, but all level conditions 
maintain good quality. Level condition limits have dependent 
relationships. The HIHI limit must be greater than HI, HI must be greater 
than LO, and LO must be greater than LOLO. If any level limit is out of 
range, all levels fault. 

In an Alarm Manager, inhibit states from all alarm conditions roll up for a 
single alarm. If the level or ROC conditions fault for an alarm, the alarm is 
of bad quality. The conditions that are of good quality continue to function 
normally and appear in an Alarm Summary when they are in the 
interesting state. When the alarm is of bad quality due to an abnormal 
scenario, all conditions for the alarm are of bad quality. 

See also 
Resolve alarm faults on page 567 

Details pane for an Alarm Summary on page 580 

Details pane for an Alarm Manager on page 592 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

How do I open the Alarm Summary screen? 

In the System Banner at the top of the screen, tap Alarm Summary 
. The Alarm Summary screen opens. You can open the Alarm 
Summary screen from the Navigation menu by tapping Navigation  
in the System Banner at the top of the screen and tapping the Alarm 
Summary item in the Navigation menu at the bottom of the screen. 

 

Alarm faults and alarm 
quality 

Alarm Summary screen 
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The Alarm Summary screen contains the Alarm Summary table. This 
table lists all alarms in a project or configured HMI device that are in 
interesting states or require attention. The Alarm Summary table lists all 
the alarms in the In Alarm and Unacknowledged state. It displays one 
alarm condition per row.  

Use the Alarm Summary screen to: 

• Acknowledge alarms 
• Disable alarms 
• Shelve alarms 
• Sort alarms 
• Filter alarms 
• Pause alarms 
• Reset digital alarms 
• View alarm details 

See also 
Alarm Summary for a large HMI device on page 779 

Alarm Summary for a medium HMI device on page 777 

Alarm Summary table columns on page 780 

Details pane for an Alarm Summary on page 580 

Help popup on page 796 

The medium Alarm Summary is intended for HMI devices with six-inch 
to nine-inch screens.  

 
Item Description 

 
The list of In Alarm and/or Unacknowledged alarms in the project. Each row contains a 
single alarm condition. Depending on configuration, the Alarm Name can appear as 
::ControllerName.TagName or ::ControllerName\ProgramName.TagName. For tag-based 
alarms, the Alarm Name appears as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag is not located 
inside a program, this part is omitted and the Alarm Name appears as 
::ControllerName.TagName.@Alarms.AlarmName. 

 
Buttons to perform operations on alarms in the Alarm Summary: 

Alarm Summary for a 
medium HMI device 
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Alarm Manager opens the Alarm Manager screen. The Alarm Manager lists all 
alarms configured in the system and their current states. Therefore, the Alarm 
Manager shows alarms not shown in the Alarm Summary, and provides 
additional tasks for alarms.  

 
Details hides or shows the Details pane, which contains the details of the last 
selected alarm. The Details pane appears on the bottom half of large alarm 
tables and replaces the list of alarms in medium alarm tables. If no alarm is 
selected, the Details pane is empty.       

 
Select All selects all of the alarms in the alarm table, including those not 
displayed on the current page of alarms.  

 
Deselect All deselects all alarms in the alarm table, including those not displayed 
on the current page of alarms. 

 
Select Page selects all of the alarms displayed on the current page of alarms. 

 
Reset Latched Alarms sets the selected latched state of the alarm to Normal if 
the input of the alarm has returned to normal. Resetting a latched alarm 
acknowledges the alarm, if it is not acknowledged.   

 
Pause stops updates to the Alarm Summary table for 10 seconds or until 
performing another operation on the table. While updates to the Alarm Summary 
table are paused, alarms in the controllers are still evaluated. When the table is 
no longer paused, any changes to alarm states are reflected in the table and 
updates resume.     

 
Disable stops the alarm condition from being evaluated. In effect, this turns off 
the selected alarm. This button disables the entire alarm. It is not possible to 
disable an individual alarm condition.   

 
Shelve prevents the notification of new state changes to the selected alarm if 
the alarm is acknowledged. Updates to the alarm do not appear. The alarm 
remains shelved until the shelve duration from the controller expires 
automatically or until manually unshelving the alarm. Updates to the alarm then 
resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected alarm 
conditions. Shelving an alarm in the Alarm Manager table shelves all of the 
conditions of the alarm. From the condition list in the Details pane of the Alarm 
Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. 
Change the Shelve Duration and Max Shelve Duration values using Logix 
Designer in order to propagate updated values to the Alarm Summary and Alarm 
Manager clients. Use the previous Shelve Duration and Max Shelve Duration 
values when shelving alarms in Studio 5000 alarm tables. 

 
Acknowledge indicates that you are aware of the alarm. This button changes the 
state of the alarm from unacknowledged to acknowledged. 

 
Help opens the Help popup. This popup displays a legend of icons for In 
Alarm/Unacknowledged, Normal/Unacknowledged, In Alarm/Acknowledged, and 
Faulted alarms, and the task each button on an alarm table performs. 

 
Filter list. Select a filter on the HMI device to list only the alarms containing the filter 
value for the indicated column. For example, if the filter exists, select the filter 
Priority:High to show only those alarms with a high priority. Filters are configured in View 
Designer.  

 
The number of In Alarm/Unacknowledged, In Alarm/Acknowledged, 
Normal/Unacknowledged, and Faulted alarms.  

See also 
Alarm Summary for a large HMI device on page 779 

Alarm Summary table columns on page 780 

Details pane for an Alarm Summary on page 580 

Help popup on page 796 
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Help popup contents on page 797 

The large Alarm Summary is intended for HMI devices with ten-inch or 
larger screens.  

 
Item Description 

 
The number of In Alarm/Unacknowledged, In Alarm/Acknowledged, 
Normal/Unacknowledged, and Faulted alarms. 

 
The list of In Alarm and/or Unacknowledged alarms in the project. Each row contains 
a single alarm condition. Depending on configuration, the Alarm Name can appear as 
::ControllerName.TagName or ::ControllerName\ProgramName.TagName. For 
tag-based alarms, the Alarm Name appears as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag is not 
located inside a program, this part is omitted and the Alarm Name appears as 
::ControllerName.TagName.@Alarms.AlarmName.    

 
The Details pane with additional details for the selected alarm. This pane displays 
data, such as Current Value, In Alarm Time, Out of Alarm Time, and tag values. 
Selecting multiple alarms  displays details for the last selected alarm. On medium 
HMI devices, this Details pane replaces the Alarm Summary table. 

 
Filter list. Select a filter on the HMI device to list only the alarms containing the filter 
value for the indicated column. For example, if the filter exists, select the filter 
Priority:High to show only those alarms with a high priority. Filters are configured in 
View Designer.  

 
Buttons to perform operations on the Alarm Summary: 

 
  

Back opens the previously displayed screen. When opening the Alarm 
Manager screen from the Alarm Summary screen, this button reopens the 
Alarm Summary screen. 

 
Alarm Manager opens the Alarm Manager screen. The Alarm Manager lists all 
alarms configured in the system and their current states. Therefore, the 
Alarm Manager shows alarms not shown in the Alarm Summary, and 
provides additional tasks for alarms.  

 
Details hides or shows the Details pane, which contains the details of the 
last selected alarm. The Details pane appears on the bottom half of large 
alarm tables and replaces the list of alarms in medium alarm tables. If no 
alarm is selected, the Details pane is empty.   

 
Select All selects all of the alarms in the alarm table, including those not 
displayed on the current page of alarms. 

 
Deselect All deselects all alarms in the alarm table, including those not 
displayed on the current page of alarms. 

 
Select Page selects all of the alarms displayed on the current page of 
alarms. 

Alarm Summary for a large 
HMI device 
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Reset Latched Alarms sets the selected latched state of the alarm to 
Normal if the input of the alarm has returned to normal. Resetting a latched 
alarm acknowledges the alarm, if it is not acknowledged.   

 
Pause stops updates to the Alarm Summary table for 10 seconds or until 
performing another operation on the table. While updates to the Alarm 
Summary table are paused, alarms in the controllers are still evaluated. 
When the table is no longer paused, any changes to alarm states are 
reflected in the table and updates resume.     

 
Disable stops the alarm condition from being evaluated. In effect, this turns 
off the selected alarm. This button disables the entire alarm. It is not 
possible to disable an individual alarm condition.   

 
Shelve prevents the notification of new state changes to the selected alarm 
if the alarm is acknowledged. Updates to the alarm do not appear. The 
alarm remains shelved until the shelve duration from the controller expires 
automatically or until manually unshelving the alarm. Updates to the alarm 
then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected 
alarm conditions. Shelving an alarm in the Alarm Manager table shelves all 
of the conditions of the alarm. From the condition list in the Details pane of 
the Alarm Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. 
Change the Shelve Duration and Max Shelve Duration values using Logix 
Designer in order to propagate updated values to the Alarm Summary and 
Alarm Manager clients. Use the previous Shelve Duration and Max Shelve 
Duration values when shelving alarms in Studio 5000 alarm tables. 

 
Acknowledge indicates that you are aware of the alarm. This button 
changes the state of the alarm from unacknowledged to acknowledged. 

 
Help opens the Help popup. This popup displays a legend of icons for In 
Alarm/Unacknowledged, Normal/Unacknowledged, In Alarm/Acknowledged, 
and Faulted alarms, and the task each button on an alarm table performs.  

See also 
Details pane for an Alarm Summary on page 580 

Alarm Summary for a medium HMI device on page 777 

Alarm Summary screen on page 776 

Open an alarm screen on page 800 

Alarm screens on page 774 

Data fields in the Alarm Summary table appear in columns with 
descriptions of alarm information. The large Alarm Summary table 
contains all columns by default. Medium Alarm Summary tables contain 
a subset of the columns.  

The columns and their order depend on the configuration performed in 
View Designer. Data shown in the Details pane may be added as a 
column in the Alarm Summary table. 

Column   Description Medium Alarm 
Summary 

Large Alarm 
Summary 

Alarm Summary table 
columns 
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! (Priority) The urgency of the event: 

• Low  

• Medium  

• High  

• Urgent  

  

Alarm State The state of the alarm condition:  

• Normal, Unacknowledged  and Urgent  

• In Alarm, Acknowledged  and Urgent   

• In Alarm, Unacknowledged  and Urgent   

  

Inhibit State The value applied to an alarm that inhibits the alarm at some level. 
These states include:  

• Disabled  

• Suppressed  

• Shelved   
If no icon appears for Inhibit State, the alarm is of good quality 
and is not disabled, suppressed, or shelved. 

  

Event Time The time the alarm condition or sub-condition changed to the 
currently displayed state.  

  

Condition Name A name that describes the alarm condition. Condition names vary 
by event category. For example: 
• Analog conditions include DEV_HI, DEV_LO, HIHI, HI, LO, LOLO, 

ROC_POS, and ROC_NEG 
• Level: LO, LOLO, HI, HIHI, ROC_POS, and ROC_NEG 
• Discrete: TRIP, TRIP_L (Latched) 

  

Alarm Name The list of alarms, in all states, for the controllers referenced in the 
View Designer project. Each row contains an alarm and the 
conditions. Depending on configuration, the Alarm Name can 
appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.TagName. For tag-based alarms, 
the Alarm Name appears as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If 
the tag is not located inside a program, this part is omitted and 
the Alarm Name appears as 
::ControllerName.TagName.@Alarms.AlarmName. 

  

Message The message assigned to the alarm in the alarm instruction.   

See also 
Alarm Summary screen on page 776 

Details pane for an Alarm Summary on page 580 

Details pane rows on page 581 

Alarm screens on page 774 

How do I open the Alarm Manager table? 

In the System Banner at the top of the screen, tap Alarm Status 
Indicator . The Alarm Summary screen opens. At the bottom of the 
Alarm Summary table, tap Alarm Manager . The Alarm Manager 
screen opens. You can open the Alarm Manager screen from the 

Alarm Manager screen 
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Navigation menu by tapping Navigation  in the System Banner at 
the top of the screen and tapping the Alarm Manager item in the 
Navigation menu at the bottom of the screen. 

The Alarm Manager screen lists all alarms configured in the system and 
their current states. The Alarm Manager subscribes to alarms in the 
controller and is used to monitor and interact with those alarms from the 
HMI device screen. Every alarm from every controller is listed unless an 
alarm is removed from the controller. 

Use the Alarm Manager to: 

• Enable or disable alarms to take them out of service 
• Shelve and unshelve alarms 
• Reset counts for alarms   
• View details for a selected alarm or alarm condition 
• Sort alarms 
• Filter alarms 

See also 
Alarm Manager for a large HMI device on page 784 

• Alarm Manager for a medium HMI device on page 783 
• Help popup on page 796 
• Help popup contents on page 797 

The data fields in the Alarm Manager table are organized in columns and 
describe the alarm information.   

Column Description 
Alarm State The condition of the alarm: 

• Normal, Unacknowledged  and Urgent  

• In Alarm, Acknowledged  and Urgent  

• In Alarm, Unacknowledged  and Urgent  
• Normal, Acknowledged 
The Alarm Manager table displays a combination of all the conditions of an 
alarm. Therefore, if any condition in the alarm is In Alarm or 
Unacknowledged, the alarm appears as In Alarm or Unacknowledged in 
the Alarm Manager. 

Inhibit State The value applied to an alarm that inhibits the alarm. These states 
include:  

• Bad Quality  

• Disabled  

• Suppressed  

• Shelved   
When an alarm has more than one inhibit state, the icon of the highest 
inhibit state appears in the table. If no icon appears for Inhibit State, the 
alarm is of good quality and is not disabled, suppressed, or shelved. 

Alarm Manager table 
columns 
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Alarm Name The name of the alarm created in Logix Designer. For instruction-based 
alarms, it includes the alarm controller and tag. It can also include the 
name of the program if the tag is going to be defined at the program level. 
The Alarm Name can be configured as ::ControllerName.TagName or 
::ControllerName\ProgramName.TagName. For tag-based alarms, the 
Alarm Name appears as 
::ControllerName\ProgramName.TagName.AlarmName. If the tag is not 
located inside a program, this part is omitted and the Alarm Name 
appears as ::ControllerName.TagName.AlarmName. 

See also 
Alarm Manager for a large HMI device on page 784 

Help popup on page 796 

Alarm Summary screen on page 776   

The medium Alarm Manager is intended for HMI devices with six-inch to 
nine-inch screens.  

  
Item Description 

 
The list of alarms, in all states, for the controllers referenced in the View Designer 
project. The Alarm Manager displays tag-based alarms marked for use and evaluation. 
Each row contains an alarm and the conditions. Depending on configuration, the 
Alarm Name can appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.TagName. For tag-based alarms, the Alarm Name 
appears as ::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag 
is not located inside a program, this part is omitted and the Alarm Name appears as 
::ControllerName.TagName.@Alarms.AlarmName.  

 
Buttons to perform operations on alarms in the Alarm Manager: 

 
Back opens the previously displayed screen. When opening the Alarm Manager 
screen from the Alarm Summary screen, this button reopens the Alarm 
Summary screen. 

 
Details hides or shows the Details pane, which contains the details of the last 
selected alarm. The Details pane appears on the bottom half of large alarm 
tables and replaces the list of alarms in medium alarm tables. If no alarm is 
selected, the Details pane is empty.   
The Details pane on an Alarm Manager table shows a list of conditions. Buttons 
to shelve and unshelve individual alarm conditions appear above the list of 
conditions.   

 
Select All selects all of the alarms in the alarm table, including those not 
displayed on the current page of alarms. 

Alarm Manager for a 
medium HMI device 
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Deselect All deselects all alarms in the alarm table, including those not 
displayed on the current page of alarms. 

 
Select Page selects all of the alarms displayed on the current page of alarms. 

 
Reset Alarm Counts resets the alarm count in the controllers and the Alarm 
Count value in the Details pane of the Alarm Manager table to zero. The reset is 
performed for all conditions of the currently selected alarm.  

 
Enable enables the selected alarms in the Alarm Manager table. Enabling an 
alarm allows the alarm condition to be evaluated, in effect turning on the 
alarm. Enabling an alarm enables all of the conditions for that alarm. Enabling 
an individual alarm condition is not allowed.   

 
Disable stops the alarm condition from being evaluated. In effect, this turns 
off the selected alarm. This button disables the entire alarm. It is not possible 
to disable an individual alarm condition.   

 
Unshelve unshelves the selected alarm in the Alarm Manager table. Unshelving 
allows notification of new state changes to alarms. From the condition list in 
the Details pane of the Alarm Manager table, unshelve individual alarm 
conditions.    

 
Shelve prevents the notification of new state changes to the selected alarm if 
the alarm is acknowledged. Updates to the alarm do not appear. The alarm 
remains shelved until the shelve duration from the controller expires 
automatically or until manually unshelving the alarm. Updates to the alarm 
then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected alarm 
conditions. Shelving an alarm in the Alarm Manager table shelves all of the 
conditions of the alarm. From the condition list in the Details pane of the Alarm 
Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. 
Change the Shelve Duration and Max Shelve Duration values using Logix 
Designer in order to propagate updated values to the Alarm Summary and 
Alarm Manager clients. Use the previous Shelve Duration and Max Shelve 
Duration values when shelving alarms in Studio 5000 alarm tables. 

 
Help opens the Help popup. This popup displays a legend of icons for In 
Alarm/Unacknowledged, Normal/Unacknowledged, In Alarm/Acknowledged, 
and Faulted alarms, and the task each button on an alarm table performs. 

 
Filter list. Select a filter on the HMI device to list only the alarms containing the filter 
value for the indicated column. For example, if the filter exists, select the filter 
Priority:High to show only those alarms with a high priority. Filters are configured in 
View Designer.  

See also 
Alarm Manager for a large HMI device on page 784 

Help popup on page 796 

Help popup contents on page 797 

Details pane rows on page 581 

Details pane for an Alarm Manager on page 592 

The large Alarm Manager is intended for HMI devices with ten-inch or 
larger screens.  Alarm Manager for a large 

HMI device 
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Item Description 

 
The list of alarms, in all states, for the controllers referenced in the View Designer 
project. The Alarm Manager displays tag-based alarms marked for use and 
evaluation. Each row contains an alarm and the conditions. Depending on 
configuration, the Alarm Name can appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.TagName. For tag-based alarms, the Alarm Name 
appears as ::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the 
tag is not located inside a program, this part is omitted and the Alarm Name 
appears as ::ControllerName.TagName.@Alarms.AlarmName.  

 
Buttons to shelve and unshelve the alarm condition selected in the Details pane. 
The Details pane appears at the bottom of the Alarm Manager table.  

 
 

Shelve shelves the alarm condition selected in the Details pane. 
Shelving a condition prevents notification of new state changes to the 
alarm. 

 
Unshelve unshelves the alarm condition selected in the Details pane. 
Unshelving a condition allows notification of new state changes to the 
alarm. 

 
In the list of conditions, select a condition to show all of the details for that 
conditionin the Details pane. For example, to show details for the HI condition for 
the selected alarm, scroll to and select HI.  

 
Filter list. Select a filter on the HMI device to list only the alarms containing the 
filter value for the indicated column. For example, if the filter exists, select the 
filter Priority:High to show only those alarms with a high priority. Filters are 
configured in View Designer.  

 
Buttons to perform operations on alarms in the Alarm Manager table: 

 
 

Back opens the previously displayed screen. When opening the Alarm 
Manager screen from the Alarm Summary screen, this button reopens 
the Alarm Summary screen. 

 
Details hides or shows the Details pane, which contains the details of 
the last selected alarm. The Details pane appears on the bottom half of 
large alarm tables and replaces the list of alarms in medium alarm 
tables. If no alarm is selected, the Details pane is empty.   

 
Select All selects all of the alarms in the alarm table, including those 
not displayed on the current page of alarms. 

 
Deselect All deselects all alarms in the alarm table, including those not 
displayed on the current page of alarms. 

 
Select Page selects all of the alarms displayed on the current page of 
alarms. 
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Reset Alarm Counts resets the alarm count in the controllers and the 
Alarm Count value in the Details pane of the Alarm Manager table to 
zero. The reset is performed for all conditions of the currently selected 
alarm.  

 
Enable enables the selected alarms in the Alarm Manager table. 
Enabling an alarm allows the alarm condition to be evaluated, in effect 
turning on the alarm. Enabling an alarm enables all of the conditions 
for that alarm. Enabling an individual alarm condition is not allowed.  

 
Disable stops the alarm condition from being evaluated. In effect, this 
turns off the selected alarm. This button disables the entire alarm. It is 
not possible to disable an individual alarm condition.     

 
Unshelve unshelves the selected alarm in the Alarm Manager table. 
Unshelving allows notification of new state changes to alarms. From 
the condition list in the Details pane of the Alarm Manager table, 
unshelve individual alarm conditions.  

 
Shelve prevents the notification of new state changes to the selected 
alarm if the alarm is acknowledged. Updates to the alarm do not 
appear. The alarm remains shelved until the shelve duration from the 
controller expires automatically or until manually unshelving the alarm. 
Updates to the alarm then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected 
alarm conditions. Shelving an alarm in the Alarm Manager table shelves 
all of the conditions of the alarm. From the condition list in the Details 
pane of the Alarm Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix 
Designer. Change the Shelve Duration and Max Shelve Duration values 
using Logix Designer in order to propagate updated values to the Alarm 
Summary and Alarm Manager clients. Use the previous Shelve Duration 
and Max Shelve Duration values when shelving alarms in Studio 5000 
alarm tables. 

 
Help opens the Help popup. This popup displays a legend of icons for In 
Alarm/Unacknowledged, Normal/Unacknowledged, In 
Alarm/Acknowledged, and Faulted alarms, and the task each button on 
an alarm table performs. 

 
The Details pane lists condition details for the selected alarm. Each row lists details 
for one alarm condition. The details include when the alarm condition was enabled 
or disabled, suppressed or unsuppressed, or shelved. Selecting multiple alarms in 
the Alarm Manager table, condition details shows for the last selected alarm. 

See also 
Alarm Manager for a medium HMI device on page 783 

Help popup on page 796 

Help popup contents on page 797 

Details pane rows on page 581 

Details pane for an Alarm Manager on page 592 

How do I open the Alarm History table? 

In the System Banner at the top of the screen, open the Navigation 
menu by tapping Navigation . Select the Alarm History item in the 
Navigation menu that appears at the bottom of the screen. 

The Alarm History lists alarm state change records from the alarm log. 
One alarm log record appears in a row. 

Use the Alarm History on an HMI device to: 

Alarm History screen 
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• Review the historical alarm records showing alarm state changes. 
• Filter alarm state changes. 

The Alarm History displays the history of alarm state changes available at 
the moment you open the screen. Close and reopen the screen or select 
Refresh  to load the latest alarm state changes.  
Tip: In the rare case the alarm history database is corrupted, the operator does not 

see any records in the Alarm History Viewer, although the alarm state changes are 
still happening. In such case, reboot the HMI device. 

See also 
Alarm History for a large HMI device screen on page 789 

Alarm History for a medium HMI device screen on page 788 

Help popup on page 796 

Help popup contents on page 797 

Data fields in the Alarm History table appear in columns with 
descriptions of alarm information. The configuration in View Designer 
determines the columns and the order of the columns. View Designer 
enables adding, removing or rearranging the columns. 

Column Description 

! (Priority) The urgency of the event: 
• Low   
• Medium   
• High   
• Urgent  

Alarm The state of the alarm condition: 

• Normal, Acknowledged  
• Normal, Unacknowledged  and 

Urgent  
• In Alarm, Acknowledged  and 

Urgent  
• In Alarm, Unacknowledged  and 

Urgent  
Inhibit The value applied to an alarm that 

inhibits the alarm at some level. These 
states include:  
• Disabled  
• Enabled 
• Suppressed  
• Unsupressed 
• Shelved   
• Unshelved  

• Faulted  
• Alarm Count Reset 
If no icon appears for Inhibit State, the 
alarm is of good quality and is not 
disabled, suppressed, or shelved. 

Event Time The time the alarm condition or 
sub-condition changed to the currently 
displayed state.  

Alarm History table 
columns 
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Column Description 

Condition Name A name that describes the alarm 
condition. Condition names vary by 
event category. For example: 
• Level: LO, LOLO, HI, HIHI, ROC_POS, 

ROC_NEG 
• Discrete: TRIP, TRIP_L (Latched) 

Alarm Name The name of the alarm. This name 
includes the controller name of the 
alarm and the tag name. It can also 
include the name of the program if the 
tag is defined at the program level. 
Depending on how it was configured, 
the Alarm Name can appear as 
::ControllerName.TagName or 
::ControllerName\ProgramName.  
For tag-based alarms, the alarm name 
can appear as 
::ControllerName\ProgramName.TagNa
me.@Alarms.AlarmName. If the tag is 
not located inside a program, this part 
is omitted and the Alarm Name appears 
as 
::ControllerName.TagName.@Alarms.Ala
rmName. 

Message The message assigned to the alarm in 
the alarm instruction or tag-based 
alarm configuration. 

State Change The types of changes in the state of the 
alarm: 
• Triggered 
• Untriggered 
• Acknowledged 
• Disabled 
• Enabled 
• Suppressed 
• Unsuppressed 
• Shelved 
• Unshelved 
• Configuration Changed 
• Fault 
• Alarm Counter Reset 

Tag 1 Value The value of tag 1.  
Tag 2 Value The value of tag 2.  
Tag 3 Value The value of tag 3.  
Tag 4 Value The value of tag 4.  

See also 
Alarm History for a large HMI device screen on page 789 

Alarm History for a medium HMI device screen on page 788 

The Alarm History Medium alarm table is recommended for six-inch to 
nine-inch HMI device screens. Alarm History for a medium 

HMI device screen 
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Item Description 

 
The list of alarm state changes records from the terminal. 

 
Filter list. Select a filter in the HMI device to list only the alarm state change records containing the filter value for the 
indicated column. For example, if the filter exists, select the filter Priority:High to show only those alarm state changes 
with a high priority. Configure filters in View Designer. 

 
Date filter. Select the box and enter a date and time to list only the alarm state change records that occurred between 
the chosen date and time and the present. Select the checkbox on the right side to activate the filter. 

 
Number of filtered records and total number of records. 

 
Buttons to perform actions available for the Alarm History Viewer: 

 
Details hides or shows the Details pane, which contains the details of the last selected alarm state change 
record. The Details pane appears on the bottom half of large alarm tables and replaces the list of alarms in 
medium alarm tables. If no record is selected, the Details pane is empty. 

 Refresh loads the latest alarm state changes from the alarm history. The operator has to refresh the table to 
see the latest changes. The operator can also exit and enter the screen with the Alarm History again to 
refresh. 

 
Help opens the Help popup. This popup displays a legend of icons and the task each button on an alarm table 
performs. 

See also 
Alarm History on page 598 

Alarm History table columns on page 603 

Alarm History for a medium HMI device screen on page 788 

The Alarm History Large alarm table is recommended for large, 
ten-inch or larger HMI device screens. Alarm History for a large 

HMI device screen 
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Item Description 

 
The list of alarm state changes records from the terminal. 

 
Filter list. Select a filter in the HMI device to list only the alarm state change records containing the filter value for the 
indicated column. For example, if the filter exists, select the filter Priority:High to show only those alarm state changes 
with a high priority. Configure filters in View Designer. 

 
Date filter. Select the box and enter a date and time to list only the alarm state change records that occurred between 
the chosen date and time and the present. Select the checkbox on the right side to activate the filter. 

 
Number of filtered records and total number of records. 

 
Buttons to perform actions available for the Alarm History Viewer: 

 
Details hides or shows the Details pane, which contains the details of the last selected alarm state change 
record. The Details pane appears on the bottom half of large alarm tables and replaces the list of alarms in 
medium alarm tables. If no record is selected, the Details pane is empty. 

 Refresh loads the latest alarm state changes from the alarm history. The operator has to refresh the table to 
see the latest changes. The operator can also exit and enter the screen with the Alarm History again to 
refresh. 

 
Help opens the Help popup. This popup displays a legend of icons and the task each button on an alarm table 
performs. 

See also 
Alarm History on page 598 

Alarm History table columns on page 603 

Alarm History for a large HMI device screen on page 789 

View Designer retains alarm state history after: 

• Rebooting or powering off the HMI device. 
• Loading a new project. 
• Disconnecting a controller from the HMI device. 
• Replacing a controller.  
• Having a controller recover from a fault. 
• Downloading a new program from a controller connected to the 

HMI device. 

Alarm history retention 
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• Clearing the alarm log on a controller connected to the HMI 
device.  

See also 
Alarm History for a large HMI device screen on page 789 

Alarm History for a large HMI device screen on page 789 

Use the Details pane to display: 

• Tag values. 
• Alarm condition limits defined in the ladder logic. 
• Condition details.  
• Additional state and configuration information for alarms. 

In the Details pane for the Alarm Manager table, shelve and unshelve 
alarm conditions.  

Changes made to font, font size, and row padding are not reflected in the 
Details pane.   

See also 
Details pane for an Alarm Summary on page 580 

Details pane for an Alarm Manager on page 592 

Details pane rows on page 581 

In a medium Alarm Summary table intended for HMI devices with 
seven-inch to nine-inch screens, the Details pane replaces the list of 
alarms in the table. In a large Alarm Summary table exists for HMI 
devices with ten-inch or larger screens, the Details pane opens at 
bottom of the table. 

Details pane 

Details pane for an Alarm 
Summary 
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Item Description 

 
The Details pane with additional details for the selected alarm. This pane displays data, 
such as Current Value, In Alarm Time, Out of Alarm Time, and tag values. When multiple 
alarms are selected, details display for the last selected alarm.  

See also 
Details pane rows on page 581 

Alarm Summary for a large HMI device on page 779 

Alarm Summary for a medium HMI device on page 777 

Alarm faults and alarm quality on page 565 

Details pane for an Alarm 
Manager 
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In a medium Alarm Manager table intended for HMI devices with six-inch 
to nine-inch screens, the Details pane replaces the list of alarms in the 
table. In a large Alarm Manager table intended for HMI devices with 
ten-inch or larger screens, the Details pane opens at bottom of the table.     

 
Item Description 

 
Buttons to shelve and unshelve the selected alarm condition in the Details pane 
when it is displayed at the bottom of the Alarm Manager table.  

 
 

Shelve shelves the selected alarm condition in the Details pane. Shelving a 
condition prevents notification of new state changes to the alarm. 
Change the Shelve Duration and Max Shelve Duration through Logix Designer. 
If changes to the Shelve Duration and Max Shelve Duration values are not 
made through Logix Designer, the updated values are not propagated to the 
Alarm Summary and Alarm Manager clients. In this case, the previous Shelve 
Duration and Max Shelve Duration values are used when shelving alarms in 
Studio 5000 alarm tables. 

 
Unshelve unshelves the selected alarm condition in the Details pane. 
Unshelving a condition allows notification of new state changes to the alarm. 

 
Select a condition to show all of the details of the condition in the Details pane. For 
example, to show details for the TRIP condition for the selected alarm, scroll to and 
select TRIP. 

 
The condition details for the selected alarm. The details include when the alarm 
condition was enabled or disabled, suppressed or unsuppressed, or shelved. When 
multiple alarms are selected in the Alarm Manager table, condition details are 
displayed for the last alarm selected. 

See also 
Details pane rows on page 581 

Alarm Manager for a medium HMI device on page 783 

Alarm Manager for a large HMI device on page 784 

Alarm faults and alarm quality on page 565 

In a medium Alarm History table recommended for HMI devices with 
seven-inch to nine-inch screens, the Details pane replaces the list of 
alarms in the table. In a large Alarm History table recommended for HMI 
devices with ten-inch or larger screens, the Details pane opens at 

Details pane for Alarm 
History 
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bottom of the table. 

 
Item Description 

 
The Details pane with additional details for the selected alarm. This pane displays data, 
such as Current Value, In Alarm Time, Out of Alarm Time, and tag values. When multiple 
alarms are selected, details display for the last selected alarm.  

See also 
Details pane rows on page 581 

Alarm History contents for a medium HMI device screen on page 
602 

Alarm History contents for a large HMI device screen on page 601 

Selecting Details  on an alarm table opens the Details pane in the 
lower half of: 

• Large Alarm Summary table 
• Large Alarm Manager table 
• Large Alarm History table 

The Details pane replaces the list of alarms in medium alarm tables. The 
Details pane shows details for the selected alarm condition of a selected 
alarm. Condition details display the selected alarm condition in the Alarm 
Manager table. The contents of the Details pane appears in rows. 

Row Description 

Priority The urgency of the alarm condition: 

• Low  

• Medium  

• High  

• Urgent  

Details pane rows 
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Severity The numeric value mapped to the assigned priority of the alarm condition: 
• 1-250 (Low) 
• 251-500 (Medium) 
• 501-750 (High) 
• 751-1000 (Urgent) 

Alarm State The state of the alarm condition: 
• Normal Unacknowledged 
• In Alarm Acknowledged 
• In Alarm Unacknowledged 
• Normal Acknowledged 

Inhibit State The value applied to the alarm condition that inhibits the alarm at some 
level. These states, indicated by an icon in the alarm table, include:  

• Bad Quality  

• Disabled  

• Suppressed  

• Shelved  
• Faulted 
These states can be combined. When an alarm has more than one inhibit 
state applied, the icon of the highest inhibit state shown above appears in 
the table. 

Event Time The date and time the alarm event occurred.  
Condition • Analog conditions include: DEV_HI, DEV_LO, HIHI, HI, LO, LOLO, ROC_POS, 

and ROC_NEG 
• Discrete conditions include: TRIP and TRIP_L 

Expression The expression configured in Logix Designer for the selected condition. 
The expression appears only for tag-based alarms. 

Alarm Name The name of the alarm. This name includes the controller name of the 
alarm and the tag name. It can also include the name of the program if 
the tag is defined at the program level. Depending on how it was 
configured, the Alarm Name can appear as ::ControllerName.TagName or 
::ControllerName\ProgramName.  
For tag-based alarms, the alarm name can appear as 
::ControllerName\ProgramName.TagName.@Alarms.AlarmName. If the tag 
is not located inside a program, this part is omitted and the Alarm Name 
appears as ::ControllerName.TagName.@Alarms.AlarmName. 

Message The message assigned to the alarm in the Logix Designer project. 
In Alarm Time The time the selected alarm entered the In Alarm state. 
Acknowledge Time The time the selected alarm was acknowledged. 
Out of Alarm Time The time the selected alarm entered the Normal or Out of Alarm state. 
Enabled Time The time the selected alarm was enabled. 
Disable Time The time the selected alarm was disabled. 
Suppress Time The time the selected alarm was suppressed. 
Unsuppress Time The time the selected alarm was unsuppressed. 

Shelve Time The time the selected alarm was shelved. 

Unshelve Time The time the selected alarm was unshelved. If the alarm is currently 
shelved, this is the time the alarm is unshelved automatically when the 
shelve duration expires.  

Alarm Class The user-defined class assigned to the alarm in the Logix Designer 
project. 

Alarm Group Displays the alarm group from Logix Designer to help classify and sort 
alarms. Displayed only for tag-based alarms. 

Limit Value Exceeded The condition limit assigned to the alarm in the Logix Designer project.  
Tag 1 Value The value of the associated tag parameter 1. 
Tag 2 Value The value of the associated tag parameter 2. 
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Tag 3 Value The value of the associated tag parameter 3. 
Tag 4 Value The value of the associated tag parameter 4. 
Alarm Count The number of times the alarm condition has entered the In Alarm state. 
Current Value The current tag input value resulting in the alarm state.  
Event Category Digital events are categorized as Discrete. Analog events are categorized 

as Level.  
Shelve duration The default time for which the selected alarm condition is shelved to 

prevent the notification of new state changes. Shelve duration is assigned 
to the alarm in the Logix Designer project. 

Max Shelve Duration The maximum time the alarm can be shelved.   
Quality Details Displays information of a fault in case of faulted alarms. 

State Change Type This row applies to Alarm History only and displays the type of alarm state 
change for the currently selected alarm record: 
• In Alarm 
• Return to Normal 
• Acknowledged 
• Disabled 
• Enabled 
• Suppressed 
• Unsuppressed 
• Shelved 
• Unshelved 
• Configuration Changed 
• Fault 
• Alarm Counter Reset 

 

 
Tip: The Alarm History table does not contain the following details pane rows: 
• In Alarm Time 
• Acknowledge Time 
• Out of Alarm Time 
• Enabled Time 
• Disables Time 
• Suppress Time 
• Unsuppress Time 
• Shelve Time 
• Unshelve Time 
• Shelve Duration 
Max Shelve Duration 

See also 
Details pane for an Alarm Summary on page 580 

Alarm faults and alarm quality on page 565 

Alarm Summary contents for a large HMI device screen on page 
577 

Alarm Manager contents for a large HMI device screen on page 
589 

How do I open the Help popup? 

1. Open an alarm table:  
Help popup 
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• In the System Banner at the top of the screen, tap Alarm 
Status Indicator  to open the Alarm Summary.  

• At the top of the Alarm Summary table, tap Alarm Manager  
to open the Alarm Manager.  

2. From either the Alarm Summary or the Alarm Manager, tap Help 
. 

The Help popup shows all of the operations to perform on an alarm table. 
The buttons depicted in the popup include operations for the Alarm 
Summary, Alarm Manager, and Alarm History. The Help popup also 
displays a legend of icons for In Alarm/Unacknowledged, In 
Alarm/Acknowledged, Normal/Unacknowledged, and Faulted alarms. 

Available operations depend on the alarm screen:  

Operation  Alarm 
Summary  

Alarm 
Manager  

Alarm 
History 

Acknowledge alarms    

Disable alarms    
Enable alarms    
Filter alarms by Event Time    
Pause the display of incoming alarms    
Reset a digital alarm    

Reset alarm counts    
Select alarms    
Shelve individual alarm conditions    
Shelve entire alarm (all conditions)    
Sort and filter alarms    
View alarms    
View alarm condition details    
View alarm quality    
Unshelve alarm conditions    
Unshelve alarms    

See also 
Help popup contents on page 797 

Alarm Summary for a medium HMI device on page 777 

Alarm Manager for a medium HMI device on page 783 

Details pane rows on page 581 

The Help popup opens when pressing Help  on an HMI device. This 
popup shows a legend of icons that appear on the alarm screens and the 
task each button on an alarm table performs. The functions vary 
depending on the selected alarm table. 

Help Popup Contents 
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Help popup for Alarm Summary and Alarm Manager tables: 

 
Help popup for Alarm History table: 

 
 

Item Description 

 
A legend for icons in the alarm table.  

 
A legend for alarm functions you can perform on the alarm table. The alarm functions represent buttons on the alarm 
table. The functions you can perform vary depending on the selected alarm table: 

  
Back opens the previously displayed screen. When opening the Alarm Manager screen from the Alarm 
Summary screen, this button reopens the Alarm Summary screen. 

 
Alarm Manager opens the Alarm Manager screen. The Alarm Manager lists all alarms configured in the system 
and their current states. Therefore, the Alarm Manager shows alarms not shown in the Alarm Summary, and 
provides additional tasks for alarms.  

 
Details hides or shows the Details pane, which contains the details of the last selected alarm. The Details pane 
appears on the bottom half of large alarm tables and replaces the list of alarms in medium alarm tables. If no 
alarm is selected, the Details pane is empty.   

 
Select All selects all of the alarms in the alarm table, including those not displayed on the current page of 
alarms. 

 
Deselect All deselects all alarms in the alarm table, including those not displayed on the current page of 
alarms. 

 
Select Page selects all of the alarms displayed on the current page of alarms. 

 
Reset Latched Alarms sets the selected latched state of the alarm to Normal if the input of the alarm has 
returned to normal. Resetting a latched alarm acknowledges the alarm, if it is not acknowledged.   

 
Reset Alarm Counts resets the alarm count in the controllers and the Alarm Count value in the Details pane of 
the Alarm Manager table to zero. The reset is performed for all conditions of the currently selected alarm.  

 
Pause stops updates to the Alarm Summary table for 10 seconds or until performing another operation on the 
table. While updates to the Alarm Summary table are paused, alarms in the controllers are still evaluated. 
When the table is no longer paused, any changes to alarm states are reflected in the table and updates 
resume.     

 
Disable stops the alarm condition from being evaluated. In effect, this turns off the selected alarm. This 
button disables the entire alarm. It is not possible to disable an individual alarm condition.   
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Enable enables the selected alarms in the Alarm Manager table. Enabling an alarm allows the alarm condition 
to be evaluated, in effect turning on the alarm. Enabling an alarm enables all of the conditions for that alarm. 
Enabling an individual alarm condition is not allowed.  

 
Shelve prevents the notification of new state changes to the selected alarm if the alarm is acknowledged. 
Updates to the alarm do not appear. The alarm remains shelved until the shelve duration from the controller 
expires automatically or until manually unshelving the alarm. Updates to the alarm then resume.  
Shelving an alarm in the Alarm Summary table shelves only the selected alarm conditions. Shelving an alarm in 
the Alarm Manager table shelves all of the conditions of the alarm. From the condition list in the Details pane 
of the Alarm Manager table, shelve individual alarm conditions.  
Change the Shelve Duration and Max Shelve Duration using Logix Designer. Change the Shelve Duration and 
Max Shelve Duration values using Logix Designer in order to propagate updated values to the Alarm Summary 
and Alarm Manager clients. Use the previous Shelve Duration and Max Shelve Duration values when shelving 
alarms in Studio 5000 alarm tables. 

 
Unshelve unshelves the selected alarm in the Alarm Manager table. Unshelving allows notification of new state 
changes to alarms. From the condition list in the Details pane of the Alarm Manager table, unshelve individual 
alarm conditions.  

 
Acknowledge indicates that you are aware of the alarm. This button changes the state of the alarm from 
unacknowledged to acknowledged. 

 Date filter. Select the box and enter a date and time to list only the alarm state change records that occurred 
between the chosen date and time and the present. Select the checkbox on the right side to activate the filter. 

 Refresh loads the latest alarm state changes from the alarm history. You can also exit and enter the screen 
with the Alarm History again to refresh with the latest changes. 

 
Help opens this Help popup.  

See also 
Help popup on page 796 

Alarm Summary for a medium HMI device on page 777 

Alarm Manager for a medium HMI device on page 783 

Perform operations on the Alarm Summary screen and Alarm 
Manager screen to view and manage alarms.   

Some operations can only be performed on a specific alarm screen. Use 
the following chart to identify the operations to perform on an alarm table.  

Operation  Alarm 
Summary  

Alarm 
Manager  

Acknowledge alarms   

Disable alarms   
Enable alarms   
Filter alarms   
Pause the display of incoming alarms   
Reset a digital alarm   
Reset alarm counts   
Select alarms   
Shelve individual alarm conditions   
Shelve entire alarm (all conditions)   
Sort and filter alarms   
View alarms   
View alarm condition details   
View alarm quality   
Unshelve alarm conditions   
Unshelve alarms   

Perform basic alarm 
functions 
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See also 
Disable an alarm on page 804 

Pause an alarm on page 805 

Shelve an alarm on page 808 

Reset a latched alarm on page 809 

Reset alarm counts on page 813 

Open an alarm screen to view alarms and perform operations, such as 
acknowledging or shelving an alarm. Open the predefined Alarm 
Summary screen to view the Alarm Summary table. Open the predefined 
Alarm Manager screen to view the Alarm Manager table. Depending on 
the configuration of the HMI device application, alarm tables may exist on 
screens other than predefined screens.  

To open an alarm screen 
• Alarm Summary. In the System Banner at the top of the screen, 

select Alarm Status Indicator . The Alarm Summary screen 
opens. The Alarm Status Indicator button turns red and flashes if 
there are unacknowledged alarms. The button stops flashing 
when there are no unacknowledged alarms.  

• Alarm Manager. In the System Banner at the top of the screen, 
select Navigation  and in the Navigation menu at the bottom 
of the screen, select the Alarm Manager item. The Alarm 
Manager screen opens. 

 
Tips: 

• To open the Alarm Manager screen from the Alarm Summary, select Alarm Manager  at the 
bottom of the Alarm Summary table.  

• Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 

See also 
Open a screen on page 757 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

Sort alarms on page 802 

Select an alarm on page 800 

Select alarms to perform an operation on one or more alarms. Select 
alarms to acknowledge, shelve, unshelve, disable, enable, or reset a 
latched alarm. Deselect alarms to not perform an operation on those 
alarms.   

To select an alarm 
1. Open the Alarm Summary screen or the Alarm Manager screen. 

Open an alarm screen 

Select an alarm 
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2. In the alarm table, select the up and down arrows in the scroll bar, 
or drag the thumb between the scroll arrows to view the next or 
previous alarm.  

3. Select alarms to highlight rows: 

 
Tips:  

• To deselect all alarms, select Deselect All .  
• Select only one alarm at a time. Selecting multiple alarms or dragging to select multiple alarms is 

not allowed. Selecting an alarm and selecting another alarm selects only the last selected alarm. 
Selecting all alarms or a page of alarms deselects the previous selection and applies the new 
selection to the table. 

• If not all expected alarms show in an alarm table, in the Filter box at the bottom of the alarm table, 
select No Filter. 

• To select an alarm using an external keyboard, tab to highlight a button on an alarm table and 
press Enter. 

See also 
Open an alarm screen on page 800 

Sort alarms on page 802 

View alarm details on page 801 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

View alarm details to display more information about an alarm. Additional 
details appear for alarms in the Alarm Summary and Alarm Manager. 
Details include:  

• Alarm severity 
• Associated tag values 
• Alarm message 
• The time an alarm entered a specific state 
• Individual conditions for the alarm (Alarm Manager only) 

To view alarm details 
1. Open the Alarm Summary screen or the Alarm Manager screen. 
2. In the alarm table, select an alarm.  
3. Select Details . A Details pane with additional information for 

the last selected alarm opens at the bottom of the alarm table. The 
Details pane replaces medium alarm tables configured for 
six-inch to nine-inch HMI devices. Details show for an individual 
alarm condition in an Alarm Summary.  

4. Select Details  to hide the details for the selected alarm. 

 
Tips: 
• To show details for an alarm condition in an Alarm Manager, select the condition in the Details 

pane of the Alarm Manager table.   
• Using an external keyboard, tab to highlight a button on an alarm table and press Enter.  

View alarm details 
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See also 
Open an alarm screen on page 800 

Details pane for an Alarm Summary on page 580 

Details pane for an Alarm Manager on page 592 

Details pane rows on page 581 

View alarm condition details on page 810 

Sort and filter an alarm table to view the alarms in the desired order. 

The default sorting orders for the alarm tables are: 

• Alarm Summary by Alarm State, Priority, and Event time 
• Alarm Manager by Active State, Inhibit State and Alarm Name 
• Alarm History by Event Time in descending order 

Sorting alarms arranges the alarms in alphabetical order or by rank, 
depending on the data configuration of the column. Columns containing 
icons are sorted based on their defined ranking. Urgent alarms appear 
above High alarms. Alarm tables update dynamically as new alarms 
appear and alarm states change. In the Alarm Summary table, the latest 
In Alarm/Unacknowledged alarms appear at the top, so the order of 
sorted alarms changes continuously.  

To sort alarms 
1. Open an alarm screen:  

• Alarm Summary  
• Alarm Manager  
• Alarm History 

2. In the alarm table, select the column heading that contains the 
data to sort. The column is sorted in ascending order by default. A 
white arrow in the column heading indicates the sorted column is 
the primary sort column.  

3. (optional) To reverse the sort order, select the column heading 
again. The direction of the arrow in the column heading indicates 
the sort direction. An up arrow indicates ascending order and a 
down arrow indicates descending order. 

4. Select additional column headings to further sort the alarms. 
When sorting a second column, the first column sorted becomes 
the secondary sort column. A gray arrow indicates a secondary 
sorting column. 

See also 
Open an alarm screen on page 800 

Select an alarm on page 800 

View alarm details on page 801 

Alarm Summary screen on page 776 

Sort alarms 
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Alarm Manager screen on page 781 

Filter rows in a table to show only the specified rows. When applying 
multiple filters to a table, only the last filter applies to the contents of the 
table. The filter applies to rows removed from view by previous filters.   

An Alarm State: In Alarm filter returns all alarms with an In Alarm state, 
including In Alarm, Acknowledged, and In Alarm, Unacknowledged 
alarms. An Alarm Name: Mix filter returns all alarms with Mix as any part 
of the name including Mixer, Mixer101, or ThirdMixer.  

To filter alarms 
1. Open an alarm screen:  

• Alarm Summary  
• Alarm Manager  
• Alarm History 

2. On the alarm table, select the Filter arrow in the lower left corner 
and select a filter in the list. The selected filter appears highlighted 
and the table returns only those alarms with data matching the 
filter. 

 
Tips:  
• Configure alarm tables with a filter value in the FilterIndex property to only display alarms that 

match the criteria of the filter on the HMI device. 
• To display all alarms in a filtered table, select the Filter arrow and select No Filter. 
• Filtering an alarm table deselects all previously selected alarms. 
• Filtered results for a data that is not visible in a column, such as Severity, appears in the Details 

pane for the selected alarm. 
• When filtering an Alarm Manager, an analog alarm returns even if only one of the conditions of the 

alarm contains the data of the filter. For an Alarm State filter with an In Alarm value, an analog 
alarm returns even if only one of its conditions is In Alarm. View alarm conditions in the Details 
pane of the Alarm Manager table.  

• If a filter has no value, the filter name in the Filter box does not have a filter value after it. For 
example, when filtering on Message, no filter appears after Message: but if the Message filter has a 
value, Message: Excessive volume may appear.  

• A filter with no value returns only those alarms with no entry for the filter data.  

See also 
Open an alarm screen on page 800 

Sort alarms on page 802 

Select an alarm on page 800 

View alarm details on page 801 

Alarm faults and alarm quality on page 565 

Filter rows in the Alarm History table to show only the alarm rows from a 
selected date and time to the present.  

To filter alarms by timespan 
1. Open the Alarm History screen. 

Filter alarms 

Filter Alarm History by 
Event Time 
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2. On the alarm table,select the box containing date and time on the 
center-bottom of the screen. 

3. In the popup window, enter the date and time according to the 
format provided in the window and confirm. 
This date indicates the oldest row displayed in the view. 

4. Select the checkbox on the right side of the date. 
A highlight and a check mark  indicates that the filter is active. 

 
Tips:  
• The default value of the date and time is 8 hours before the time of entering Alarm History or the 

time of the last refresh. This allows a fast lookup of alarms that occurred during the previous shift. 
If you enter an invalid value in the popup window, for example "20" for the month number, you will 
receive an error message after selecting OK. 

• The date and time format for the Event Time filter is the same for the entire Alarm History Viewer 
element. The DateTimeFormat property determines the date and time format. 

See also 
Open an alarm screen on page 800 

Sort alarms on page 802 

Select an alarm on page 800 

View alarm details on page 801 

Alarm faults and alarm quality on page 565 

Disable an alarm to not evaluate the alarm condition. This turns off the 
alarm. Disabling an unacknowledged alarm does not acknowledge the 
alarm. Disabling individual alarm conditions in the Details pane of an 
alarm table is not supported. The Alarm Manager shows disabled 
alarms. The Alarm Summary shows disabled alarms that are 
unacknowledged.  

To disable an alarm 
1. Open the Alarm Summary screen or the Alarm Manager screen. 
2. On the alarm table, select the alarm to disable:  

• Individual alarm. Tap to select the alarm. Using an external 
keyboard, Tab to highlight the alarm list. Select the Up Arrow 
and Down Arrow to select alarms in the list.   

• Page of alarms. To select all alarms visible on the current page 
of alarms, select Select Page .  

• All alarms. To select all alarms, including those not visible on 
the current page of alarms, select Select All .   

3. At the bottom of the alarm table, select Disable . The Disable 
icon appears in the Inhibit State column for the alarm. 

 
Tips:  
• Using an external keyboard, tab to highlight a button on an alarm table and press Enter.  
• To prevent alarm notifications while continuing to log state changes, the HMI Designer may 

configure an alarm suppress in the Logix Designer project in the controller. 

Disable an alarm 
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See also 
Open an alarm screen on page 800 

Sort alarms on page 802 

Select an alarm on page 800 

Resolve alarm faults on page 567 

View alarm errors on page 805 

Pausing an alarm delays updates to the alarm status for 10 seconds. 
After 10 seconds, the notification resumes and updates to the alarm 
appear in the alarm table. When pausing an alarm, controllers continue to 
detect alarm conditions, but updates do not display in the alarm table.  

The Alarm Summary reorders alarms as new alarms enter the In Alarm 
state. Pause alarms before acknowledging an alarm. Performing any 
operation on an alarm resumes updates to the paused table.  

To pause an alarm 
1. Open the Alarm Summary screen. 
2. At the bottom of the alarm table, select Pause . The alarm 

table stops updating alarms for 10 seconds. After 10 seconds, 
Pause  is no longer highlighted and the table resumes 
updating alarms. 

 
Tips:  

• Select Pause  before the 10 seconds lapses to begin a second 10-second delay. 
• Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 

See also 
Open an alarm screen on page 800 

Sort alarms on page 802 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

Details pane for an Alarm Summary on page 580 

Performing an operation that fails for an alarm, such as disabling an 

already disabled alarm, shows an Error icon  on the alarm table. 
Alarm operation errors are write errors. The Error icon disappears after 
10 seconds. Unlike read errors, the error does not keep displaying the 
Error icon. An Error icon opens an Error list that contains: 

• The affected alarm table -- Alarm Summary or Alarm Manager 
• The alarm 
• The condition triggering the alarm 
• A description of the error 

Pause an alarm 

View alarm errors 
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To view alarm errors 
1. Open the Alarm Summary screen or the Alarm Manager screen. 
2. In the alarm table, select alarms: 

• Individual alarm. Tap to select the alarm. Using an external 
keyboard, Tab to highlight the alarm list. Select the Up Arrow 
and Down Arrow to select alarms in the list.   

• Page of alarms. To select all alarms visible on the current page 
of alarms, select Select Page .  

• All alarms. To select all alarms, including those not visible on 
the current page of alarms, select Select All .   

3. Perform the operation. If an error occurs for the operation, an 

Error icon  appears in the upper left corner of the alarm table.  

4. Select the Error icon . The list of alarms in the alarm table 
turns red and an Error list appears. When multiple alarms or 
conditions are in error, multiple error messages in the Error list. 

 
Tip: Disabled buttons have diagonal hash marks. Selecting a disabled button shows an Error 

icon  on the button for 10 seconds. Selecting the Error icon  displays an Error list 
with the message that the button is disabled. 

See also 
Open an alarm screen on page 800 

View alarm details on page 801 

Disable an alarm on page 804 

Alarm faults and alarm quality on page 565 

Resolve alarm faults on page 567 

Alarm faults occur for two reasons: 

• Condition related issues. Abnormal conditions are events that 
occur outside normal operations. A disconnected network, power 
cycles to a controller or HMI device, project downloads to the 
controller, major faults on a controller, or a controller in Program 
mode can all cause alarm faults.   

• Configuration related issues. Alarms exist in Logix Designer 
with enforced valid configuration values. Configuration errors 
generally occur when alarm parameters change by writing to a 
member of the alarm. An alarm with a member named 
AlarmName.Severity  indicates the severity of its associated 
alarm condition. Changing the severity tag member to an invalid 
value shows the alarm as bad quality until the severity changes to 
a valid value. 

To resolve alarm faults 
1. Open the Alarm Manager screen.  

Resolve alarm faults 
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2. In the Inhibit State column, select an alarm row that has a Bad 
Quality icon . 

3. To view the details of the alarm, select Details . A Details 
pane with additional information for the last selected alarm 
appears.  

 
Tip: The Details pane opens at the bottom of an alarm table for ten-inch or larger HMI devices 
and replaces the alarm table on six-inch to nine-inch HMI devices. 

4. In the Details pane review the reasons for a faulted alarm or 
condition in the last row -- Quality Details. 

5. Resolve the alarm fault.  
• Correct the condition causing the alarm fault.   
• Correct the configuration causing the alarm fault.   

See also 
Open an alarm screen on page 800 

Alarm faults and alarm quality on page 565 

Details pane for an Alarm Summary on page 580 

Details pane for an Alarm Manager on page 592 

Acknowledge an alarm to indicate that you are aware of the alarm. 
Acknowledging an alarm changes the state of the alarm from 
unacknowledged to acknowledged. The number of unacknowledged 
alarms appears in the System Banner at the top of the screen. Alarms 
with a Bad Quality inhibit state such as those with an invalid severity, are 
not included in the number of unacknowledged alarms. The Alarm 
Status Indicator  in the System Banner appears red and flashes 
when there are active alarms that are unacknowledged. The button 
remains red as long as there are active acknowledged or 
unacknowledged alarms.   

When you acknowledge an alarm, the Alarm State icon in the alarm 
table changes to represent the state of the acknowledged alarm:  

• In Alarm, Acknowledged  

• In Alarm, Acknowledged, and Urgent  
Active acknowledged alarms are listed on the Alarm Summary screen. 
Alarms with an inhibit state of disabled, suppressed, or shelved and 
unacknowledged are listed in the Alarm Summary table until they are 
acknowledged. Acknowledging a normal alarm removes it from the Alarm 
Summary table because the alarm is no longer interesting. Normal, 
Acknowledged alarms appear on the Alarm Manager screen, but no 
icon appears for Normal, Acknowledged alarms in the Alarm Manager 
table. 

To acknowledge alarms in an Alarm Summary 
1. Open the Alarm Summary screen. 
2. Select the alarms: 

Acknowledge alarms in an 
Alarm Summary 
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• Individual alarm. Tap to select the alarm. Using an external 
keyboard, Tab to highlight the alarm list. Select the Up Arrow 
and Down Arrow to select alarms in the list.   

• Page of alarms. To select all alarms visible on the current page 
of alarms, select Select Page .  

• All alarms. To select all alarms, including those not visible on 
the current page of alarms, select Select All .   

3. At the bottom of the Alarm Summary table, select Acknowledge 
. The selected alarms are acknowledged. Alarm Status 

Indicator  returns to its default state when all alarms, including 
the unacknowledged alarms, are normal.  

4. Correct the event that is causing the alarm error. For example, for 
an analog alarm, the HI level may become active if the water level 
in a tank rises beyond a specified value. To correct the issue, 
reduce the water level to below the high threshold. The alarm 
returns to its normal state. 

 
Tip: Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 

See also 
Open an alarm screen on page 800 

Select an alarm on page 800 

Pause an alarm on page 805 

Alarm Summary screen on page 776 

Alarm Summary table columns on page 780 

Shelve an alarm to prevent state changes to the alarm. Do this when a 
piece of equipment is under maintenance. Shelve an alarm from the 
Alarm Summary screen. Shelving an alarm in the Alarm Summary 
shelves only the individual alarm condition in the selected row. The alarm 
remains shelved until the shelve duration from the controller expires 
automatically or until manually unshelving the alarm. The HMI designer 
may change the Shelve Duration and Max Shelve Duration values using 
Logix Designer. 

To shelve an alarm 
1. Open the Alarm Summary screen or the Alarm Manager screen.  
2. Select the alarm: 

• Individual alarm. Tap to select the alarm. Using an external 
keyboard, Tab to highlight the alarm list. Select the Up Arrow 
and Down Arrow to select alarms in the list.   

• Page of alarms. To select all alarms visible on the current page 
of alarms, select Select Page .  

• All alarms. To select all alarms, including those not visible on 
the current page of alarms, select Select All .   

Shelve an alarm 
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3. At the bottom of the alarm table, select Shelve . A Shelved 
icon appears in the Inhibit State column of the alarm table for the 
shelved alarm. Notification of new state changes to the alarm 
cannot occur. 

 
Tips:  
• Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 
• A shelved alarm: 
• Can enter the In Alarm state. The event that changes the state of the alarm to In Alarm does not 

appear in the Alarm Summary table. 
• Remains unacknowledged until acknowledged. If a shelved alarm requiring acknowledgment 

becomes active, it does not transition to the unacknowledged state. The alarm remains 
acknowledged until unshelving the alarm. If the alarm is active when unshelving, the alarm is 
unacknowledged.    

• Appears in an Alarm Summary only if the shelved alarm is unacknowledged. 
• Appears in an Alarm Manager with the current state of the shelved alarm. 

See also 
Open an alarm screen on page 800 

Unshelve an alarm on page 812 

Pause an alarm on page 805 

Shelve an alarm condition on page 810 

When an alarm configured to latch enters the In Alarm state, the alarm 
remains In Alarm. This is true even when the input for the alarm changes. 
An alarm configured to latch when input is high remains In Alarm, even if 
the input turns low, because the alarm is latched. The alarm can only 
enter the Normal or Inactive state when resetting the alarm.  

To reset a latched alarm 
1. Open the Alarm Summary screen. 
2. Select either the instruction-based or tag-based alarm. 

 
Tip: Using an external keyboard, tab to highlight the alarm list and press the Up Arrow or 
Down Arrow to select the alarm. 

3. At the bottom of the Alarm Summary table, select Reset Latched 
Alarms . The alarm state returns to Normal. 

 
Tips:  
• Resetting a latched alarm acknowledges the alarm.  
• Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 

See also 
Open an alarm screen on page 800 

Select an alarm on page 800 

Details pane for an Alarm Summary on page 580 

Alarm Summary screen on page 776 

Help popup on page 796 

Reset a latched alarm 
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Display alarm condition details to view more information about an alarm 
condition. Additional details for an alarm condition appear in the Details 
pane of the Alarm Manager table.  

To view alarm condition details 
1. Open the Alarm Manager screen. 
2. Select the alarm.  

 
Tip: Using an external keyboard, press Tab to highlight the alarm and press Enter to select 
the alarm. 

3. Select Details . The Details pane with additional information 
for the selected alarm appears at the bottom of the alarm table. 
The Details pane replaces the alarm table on medium HMI 
devices.  

4. In the pane of individual alarm conditions to the left of the Details 
pane of the Alarm Manager table, select the condition. The details 
of the alarm condition appear.  

5. Select Details  to hide the details for the selected alarm. 

 
Tip: Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 

See also 
Open an alarm screen on page 800 

Details pane for an Alarm Summary on page 580 

Shelve an alarm condition on page 810 

Unshelve an alarm condition on page 811 

Alarm Manager screen on page 781 

Shelving an alarm condition prevents the notification of new state 
changes to the condition. Shelve an alarm condition from the Alarm 
Manager table. Shelving an alarm condition shelves only that condition. 
The alarm condition remains shelved until the shelve duration from the 
controller expires automatically or when unshelving the alarm condition 
manually. 

To shelve an alarm condition 
1. Open the Alarm Manager screen. 
2. Select the alarm. Using an external keyboard, press Tab to 

highlight the alarm list. Press the Up Arrow and Down Arrow to 
select the alarm in the list. 

3. At the bottom of the Alarm Manager table, select Details . The 
Details pane appears at the bottom of the Alarm Manager table, or 
replaces the alarm table on medium HMI devices. Details appear 
for the last selected alarm. 

4. To the left of the Details pane, select the condition to shelve. For 
example, select HIHI.  

View alarm condition 
details 

Shelve an alarm condition 
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5. Above the condition list on the left side of the Details pane, select 
Shelve  to shelve the selected alarm condition. 

 
Tips:  
• The state of the condition is indicated in the Inhibit State row of the Details pane. A Shelved icon 

appears in the Inhibit State column for the alarm in the Alarm Manager table. 
• Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 
• The HMI designer may use Logix Designer to change the Shelve Duration and Max Shelve Duration. 

If the HMI designer does not change the Shelve Duration and Max Shelve Duration values using 
Logix Designer, the updated values do not propagate to the Alarm Summary and Alarm Manager 
clients. The table uses the previous Shelve Duration and Max Shelve Duration values when shelving 
alarms. 

See also 
Open an alarm screen on page 800 

View alarm condition details on page 810 

Unshelve an alarm condition on page 811 

Details pane for an Alarm Manager on page 592 

Alarm Manager screen on page 781 

Unshelving an alarm condition allows notification of new state changes 
to the condition. Unshelve individual alarm conditions from an Alarm 
Manager table. Alarm conditions are unshelved automatically when the 
default shelving duration configured for the controller expires.  

To unshelve an alarm condition 
1. Open the Alarm Manager screen.  
2. Select the alarm. 

 
Tip: Using an external keyboard, press Tab to highlight the alarm list. Press the Up Arrow and 
Down Arrow to select the alarm in the list. 

3. At the bottom of the Alarm Manager table, select Details . The 
Details pane appears at the bottom of a large Alarm Manager 
table or replaces a medium Alarm Manager table. Details appear 
for the last selected alarm. 

4. To the left of the Details pane, select the condition to unshelve, 
such as HIHI.  

5. On a large Alarm Manager table, select Unshelve  above the 
condition list on the left side of the Details pane. On a medium 
Alarm Manager table, select Unshelve  below the Details 
pane. Only the selected alarm condition is unshelved.  
The state of the condition is indicated in the Inhibit State row of 
the Details pane. It is also indicated in the Inhibit State column 
for the alarm in the Alarm Manager table.  

 
Tip: Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 

Unshelve an alarm 
condition 
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See also 
Open an alarm screen on page 800 

Shelve an alarm condition on page 810 

Shelve an alarm on page 808 

Unshelve an alarm on page 812 

Details pane for an Alarm Manager on page 592 

Unshelving an alarm allows notification of new state changes to the 
alarm. Unshelve an alarm from the Alarm Manager. Unshelve an alarm 
for a piece of equipment in a system that is no longer under maintenance. 
Unshelving an alarm unshelves all conditions for the alarm. Alarms 
unshelve automatically when the default shelving duration from the 
controller expires.  

To unshelve an alarm 
1. Open the Alarm Manager screen. 
2. Select the alarms: 

• Individual alarm. Tap to select the alarm. Using an external 
keyboard, Tab to highlight the alarm list. Select the Up Arrow 
and Down Arrow to select alarms in the list.   

• Page of alarms. To select all alarms visible on the current page 
of alarms, select Select Page .  

• All alarms. To select all alarms, including those not visible on 
the current page of alarms, select Select All .   

3. At the bottom of the Alarm Manager table, select Unshelve . 
Notification of new state changes to the alarm occur.  

 
Tip: Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 

See also 
Open an alarm screen on page 800 

Shelve an alarm on page 808 

Shelve an alarm condition on page 810 

Unshelve an alarm condition on page 811 

Details pane for an Alarm Manager on page 592 

Enabling an alarm effectively turns on the alarm. Enable any number of 
alarms selected in an Alarm Manager table. Enabling individual alarm 
conditions in the Details pane of the Alarm Manager table is not 
supported.  

Unshelve an alarm 

Enable an alarm 
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To enable an alarm 
1. Open the Alarm Manager screen.   
2. Select the alarms: 

• Individual alarm. Tap to select the alarm. Using an external 
keyboard, Tab to highlight the alarm list. Select the Up Arrow 
and Down Arrow to select alarms in the list.   

• Page of alarms. To select all alarms visible on the current page 
of alarms, select Select Page .  

• All alarms. To select all alarms, including those not visible on 
the current page of alarms, select Select All .   

3. At the bottom of the Alarm Manager table, select Enable . The 
selected alarms are enabled. 

 
Tip: Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 

See also 
Open an alarm screen on page 800 

Disable an alarm on page 804 

Sort alarms on page 802 

Select an alarm on page 800 

Alarm Manager screen on page 781 

Alarm counts indicate the number of times an alarm enters the In Alarm 
State. Resetting alarm counts resets the alarm count in the controller to 
zero. It also resets the Count value in the Details pane of the alarm table 
to zero. Reset alarm counts to gauge how many additional times or how 
fast an alarm enters the In Alarm State. Resetting counts for an individual 
alarm condition in the Details pane of the Alarm Manager table is not 
supported. Counts for all conditions for the selected alarm are reset. 

To reset alarm counts 
1. Open the Alarm Manager screen.   
2. Select the alarm.  

 
Tip: Using an external keyboard, press Tab to highlight the alarm and press Enter to select 
the alarm. 

3. At the bottom of the table, select Reset Alarm Counts . The 
alarm count in the controller, and the Alarm Count value in the 
Details pane of the Alarm Manager table are reset to zero. 

 
Tip: Using an external keyboard, tab to highlight a button on an alarm table and press Enter. 

See also 
Open an alarm screen on page 800 

Reset alarm counts 
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Shelve an alarm on page 808 

Unshelve an alarm on page 812 

Sort alarms on page 802 

Alarm Manager screen on page 781 

View the quality of alarms that is detected through controller faults. While 
there can be several faults or reasons that determine the quality of an 
alarm, each alarm is assigned only one quality -- good, bad, or uncertain. 
If there is no fault, the quality of the alarm quality is good. If the status of a 
controller status is not read yet, the quality of the alarm is uncertain.  

To view alarm quality 
1. Open the Alarm Manager screen.   
2. Select to select the alarm. Using an external keyboard, tab to 

highlight the alarm list and press the Up Arrow or Down Arrow to 
select the alarm.   

3. In the Details pane at the bottom of the Alarm Manager table, 
select the horizontal scroll arrows to scroll to the Quality Detail 
row. This row lists the quality of the alarm. The quality of the alarm 
is bad if the alarm has one of these faults: 
• Instruct fault only (specific fault not set) 
• Instruction faulted 
• Severity invalid 
• Alarm limits invalid 
• Deadband invalid 
• ROC positive limit invalid 
• ROC negative limit invalid 
• ROC period invalid 
• Old Logix firmware 

 Tip: If an alarm has a fault, a Bad Quality  icon appears in the Inhibit State column 
of the Alarm Manager table. 

See also 
Alarm faults and quality indicators on page 567 

Open an alarm screen on page 800 

View alarm details on page 801 

View alarm condition details on page 810 

Alarm Manager screen on page 781 

Alarm faults and their qualities appear in the Quality Details row in the 
Details pane of an alarm table. An alarm indicates good quality if all 
alarm conditions (High High, High, Low, Low Low, ROC Positive, ROC 
Negative, Deviation High, Deviation Low, TRIP, and TRIP_L) are in good 
quality.  

View alarm quality 

Alarm faults and quality 
indicators 
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Fault Cause of Fault Quality 
Indicator 

Affected 
alarm 
conditions  

No fault N/A Good All 

Status from controller not 
read yet 

Abnormal Conditions Bad All 

Instruct fault only (specific 
fault not set) 

Configuration  Bad All 

In faulted Configuration  Bad All 
Severity invalid Configuration Bad All 

Alarm limits invalid Configuration Bad High High, High, 
Low, Low Low 

Deadband invalid Configuration Bad High High, High, 
Low, Low Low 

ROC Positive limit invalid Configuration Bad ROC Positive 

ROC Negative limit invalid Configuration Bad ROC Negative 
ROC period invalid Configuration Bad ROC Positive, 

ROC Negative 
Old Logix firmware Abnormal Conditions Bad All 
Controller in Program mode Abnormal Conditions Bad All 
Major controller program 
fault (recoverable) 

Abnormal Conditions Bad All 

Communication failure (last 
value known) 

Abnormal Conditions Bad All 

Communication failure (no 
last value known) 

Abnormal Conditions Bad All 

Connection with controller 
lost 

Abnormal Conditions Bad All 

Major controller program 
fault (unrecoverable) 

Abnormal Conditions Bad All 

Failed to subscribe to 
controller 

Abnormal Conditions Bad All 

Detected hazard of 
overwriting old notifications 
in Alarm Log 

Abnormal Conditions Bad All 

Arithmetic overflow Abnormal Conditions Bad All 

See also 
Resolve alarm faults on page 567 

Details pane for an Alarm Summary on page 580 

Details pane for an Alarm Manager on page 592 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

Alarms have good or bad quality. Good quality indicates the alarm is 
functioning correctly. Bad quality indicates that there is a problem with 
the alarm.  

The current state may not be detected or accurate. Bad quality occurs 
from abnormal scenarios, such as a disconnect in the network, or a 
controller in Program mode, or by configuration issues. If the alarm has 
bad quality due to an abnormal scenario, all conditions of the alarm fault 
because evaluating or detecting the alarm is not possible. If the alarm 

Alarm faults and alarm 
quality 
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has a configuration error, such as invalid limit, only the affected 
conditions have bad quality. The unaffected conditions have good quality 
and continue to function. View alarms with bad quality in an Alarm 
Manager only. Quality details appear in the Details pane of the Alarm 
Manager table.  

For configuration-related faults, level conditions (HIHI, HI, LO, and 
LOLO) and ROC conditions (ROC Positive and ROC Negative) are 
evaluated independently. With the exception of severity, only affected 
conditions are faulted. If the ROC Positive limit is invalid, only the ROC 
Positive condition faults. The ROC Negative condition and all level 
conditions maintain good quality. If the ROC_Period is invalid, both the 
ROC Positive and ROC Negative conditions fault, but all level conditions 
maintain good quality. Level condition limits have dependent 
relationships. The HIHI limit must be greater than HI, HI must be greater 
than LO, and LO must be greater than LOLO. If any level limit is out of 
range, all levels fault. 

In an Alarm Manager, inhibit states from all alarm conditions roll up for a 
single alarm. If the level or ROC conditions fault for an alarm, the alarm is 
of bad quality. The conditions that are of good quality continue to function 
normally and appear in an Alarm Summary when they are in the 
interesting state. When the alarm is of bad quality due to an abnormal 
scenario, all conditions for the alarm are of bad quality. 

See also 
Resolve alarm faults on page 567 

Details pane for an Alarm Summary on page 580 

Details pane for an Alarm Manager on page 592 

Alarm Summary screen on page 776 

Alarm Manager screen on page 781 

Export the alarm history from the HMI device to removable media to view 
the alarm state changes collected on the HMI device. Open the exported 
alarm history file on a computer. 

Prerequisites 
• Insert an SD Card or a USB drive into the HMI device so the Alarm 

Log service can export.   

To export the alarm history 
1. Open the Settings screen.  
2. Select Data Export. The Data Export popup opens.  
3. In What to export, select Alarm history. 
4. In the Filename box, enter a name for the export file. 

"archive_alarms" is the default name of the export file.  
5. In Destination, select SD Card or USB Device.  

Export Alarm history 
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6. Select Export. Export progress shows a progress bar. The Data 
Export popup displays the last date and time a data log or alarm 
history exported at the top of the window.  

 
Tips:  

• When the alarm history is exporting,  Data Export appears in the System Banner.  

• If there is an error in logging data or exporting,  Data Export Error appears in the System 
Banner. 

• Data exports do not complete or create a .zip file on removable media if a ControlFLASH, reboot, or 
power cycle to the HMI device occurs during the export or when removing media before the export 
is complete.  

• There is no potential damage to files when removing a USB storage device when exporting data 
completes. 

 
IMPORTANT Do not remove an SD card before preparing the media for safe removal. This 

may corrupt files on the removable device if the HMI device has data logging 
configured. 

7. If an SD card contains the exported alarm history file, next to SD 
Card, select  Safely Remove SD Card. The Data Logger 
status at the top of the Data Export popup changes to Stopped 
and Remove SD card; reinsert to resume logging data appears.  

Data Export Remove appears in the System Banner. It is safe 
to remove the SD card. 

 
Tips:  
• When exporting the alarm history to an SD card or USB storage device, avoid error messages by 

ensuring that the SD card or USB storage device: 
• has sufficient space  
• is inserted into the HMI device 
• has write permissions  
• is a supported SD card type 
• has a supported format of either FAT32 or EXT3  
• is not corrupted and does not contain corrupted files 

• If data does not export to a supported SD card that meets requirements, reboot the HMI device. If 
rebooting fails, insert the SD card into a computer and verify that the SD meets requirements. 
Follow any prompt to scan and repair the file system index on the SD card. 

See also 
Cancel the export of alarm history on page 817 

Remove media from the HMI device on page 747 

Cancel the export of the alarm history to stop creating the export file for 
the alarm history and not save it to removable media. Cancel the export 
when the alarm history for the current project is exporting to the USB 
storage device or SD card in the HMI device.  

To cancel the export of alarm history 
1. Open the Settings screen.  
2. Select Data Export. The Data Export popup opens, showing the 

progress of the export. 
3. Select Cancel. The progress indicator stops to indicate the export 

is canceled. 

Cancel the export of alarm 
history 
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See also 
Export alarm history on page 816 

View Designer retains alarm state history after: 

• Rebooting or powering off the HMI device. 
• Loading a new project. 
• Disconnecting a controller from the HMI device. 
• Replacing a controller.  
• Having a controller recover from a fault. 
• Downloading a new program from a controller connected to the 

HMI device. 
• Clearing the alarm log on a controller connected to the HMI 

device.  

See also 
Alarm History for a large HMI device screen on page 789 

Alarm History for a large HMI device screen on page 789 

The exported alarm history contains information about the alarm state 
changes, and lists the recorded values for each column in the alarm 
history. 

 
 

Item Description 

 
The headings of the alarm history file indicate the: 
• Contents of the file is the exported alarm history. 
• HMI device that exported the alarm history.  
• IP address of the HMI device. 
• Name of View Designer project runtime application containing the data log configuration. 
• Name of the data collection. 
• Date and time the alarm history was exported. 

Alarm history retention 

Alarm history file 
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Item Description 

 
The date and time each alarm state change was recorded. 

 
Columns reflecting the columns in the AlarmHistory table. 

See also 
Export alarm history on page 816 

Cancel the export of alarm history on page 817 

Alarm history retention on page 790 

Alarm History screen on page 786 

A trend chart displays data over time in a graphical format. Trend charts 
display values from tags in a controller, user-defined properties, or 
properties of a graphic element. If a tag exists in a configured data log, 
the trend chart also displays historical data. A trend chart can monitor 
tank pressure and tank temperature over the course of an hour.  

View Designer supports up to four trends per screen. Trend charts start 
updating when a screen containing the trend chart opens. The trend chart 
plots any available historical data. By default, trend charts collect and 
show data on traces every second. Updates occur even if there is no 
sample data to display for the current time span. Traces appear on a 
trend chart when there are two available data points.  

Trend charts are interactive. Pause trend chart data for closer inspection. 
Resume to continue updates to a trend chart. To view previous or more 
recent data, pan trend charts backward or forward.  

Use a trend chart to: 

• Monitor processes in a manufacturing system.  
• Display data from a tag, user-defined property, or property of a 

graphic element. Tags may include historical data. 
• Display up to eight traces that plot data over time to graphically 

present data.  
• View, pan, and pause data on the HMI device.  

 
Tips:  
• For applications already on the HMI device, it may take up to the length of the sample rate before 

data shows on the trend chart. If the trend chart has a sample rate of 30000 milliseconds or 30 
seconds, it may take up to 30 seconds before any data shows on the trend chart. For applications 
downloading to the HMI device, it can take twice the sample rate to show data while establishing 
communication with the controllers.   

• If there are multiple sets of data for the same time period in the data log, the trend chart plots only 
the most recent data for the time period. This occurs even if a previous set of data for the time 
period has more data than the most recent set of data.  

• When both historical and real-time data is available, the trend chart shows real-time data at the 
sample rate of the trend chart. Historical data displays at the sample rate of the data log. 

See also 
Pause a trend chart 

Resume updates to a trend chart on page 820 

View trend charts 
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Pan trend chart data on page 821 

Trend chart contents on page 821 

Pause a trend chart to stop it from scrolling and review the current data. 
When a trend chart pauses, the trend chart stops scrolling and traces no 
longer update. There is no time limit for pausing a trend chart. The time 
range and data is static on a paused trend chart. The trend chart shows 
only the data at the time the trend chart pauses. Data collection continues 
in the background.  

To pause a trend chart 
1. At the bottom of the trend chart, select Pause . The trend chart 

stops scrolling. 
2. To resume updates to the trend chart, select Resume  . The 

trend chart begins scrolling again time. The trend chart starts 
scrolling once the current time span fills with data. 

 
Tips:  
• To use the HMI device keypad or an external keyboard to press a button on the trend chart, tab to 

the button and press Enter. 
• Navigation to a different screen automatically resumes updates to the trend chart. If navigation 

opens a different screen and then returns to the screen containing a paused trend chart, the trend 
chart resumes updates.  

• The HMI Designer determines if a button appears to interact with the trend chart on the HMI 
device. 

See also 
View trend charts on page 819 

Resume updates to a trend chart on page 820 

Pan trend chart data on page 821 

Trend chart contents on page 821 

A paused trend chart does not update traces. No data plots for the time 
span when the trend chart pauses. Resume updates to a trend chart to 
plot data and update traces. When updates resume, the trend chart plots 
data collected during the pause.      

To resume updates to a trend chart 

• At the bottom of the trend chart, select Resume  . Updates to 
the trend chart resume and data updates are plotted on the traces.  

 
Tips:  
• The HMI Designer determines if a button appears to interact with the trend chart on the HMI 

device. 
• To use the HMI device keypad or an external keyboard to press a button on the trend chart, tab to 

the button and press Enter. 

Pause a trend chart 

Resume updates to a trend 
chart 
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See also 
View trend charts on page 819 

Pan trend chart data on page 821 

Pause a trend chart 

Trend chart contents on page 821 

Pan trend chart data to move backward and forward through the plotted 
data. Pan data backward to see past data, and pan data forward to return 
to more recent data in the trend chart. When data pans, the trend chart 
pauses. The most recent value in the panned data appears on the right 
side of the trend chart.  

To pan trend chart data 
1. Select the pan direction: 

• Previous data. Select Pan Backward  at the bottom of the 
trend chart. Previous data appears one half time span at a time.  

• More recent data. Select Pan Forward   at the bottom of 
the trend chart. More recent data appears one time span at a 
time until the current data appears.  

2. To resume scrolling, select Resume . 

 
Tips:  
• The HMI Designer determines if a button appears to interact with the trend chart on the HMI 

device. 
• To navigate to a specified time to pan the trend chart, select the item on the screen configured 

with the event. To identify the event, contact the HMI Designer.  
• Panning to current data uses the sample rate of the trend chart. Panning to historical data uses 

the sample rate of the data log for the project.  
• If there are multiple sets of data for the same time period in the data log, the trend chart plots only 

the most recent data for the time period. This occurs even if a previous set of data for the time 
period has more data than the most recent set of data.     

• If a graphic element has configured binding to pan to the start of the trend chart, select the 
graphic element. To identify the graphic element, contact the HMI Designer. 

• To use the HMI device keypad or an external keyboard to select a button on the trend chart, tab to 
the button and press Enter. 

See also 
Pause a trend chart 

Resume updates to a trend chart on page 820 

Trend chart contents on page 821 

View trend charts on page 819 

Pan trend chart data 

Trend chart contents 
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A trend chart depicts data on up to eight traces and plots those values 
across the chart:   

 
Item Description 

 
Traces on the trend chart consist of lines and markers. Each trace plots the values of the tag 
in the controller over the specified time span. Trend charts can display up to eight traces. The 
trend chart updates every second to display the most recent values, even if there are no 
values plotted during that time span. 

 
The y-axis that represents data. This axis displays the values of the MinValue and MaxValue 
properties of the trend chart. 

 
The axis that represents time. The value on the right side of this axis represents the current 
time. The value on the left side of this axis represents the current time minus the time span. 
The date corresponds to the left most data point. 

 Pan Backward  displays previous data one half time span at a time. This button appears 
only when there is data collected prior to the data displayed on the trend chart.  

 Pan Forward  displays more recent data one half time span at a time. This button 
appears only when there is data collected after the data displayed on the trend chart.  

 Resume  updates data after the trend chart is paused. Pause   replaces Resume 

 when the trend chart is scrolling. When a trend chart pauses, data does not update and 
the trend chart is static.  

See also 
View trend charts on page 819 

Pause a trend chart 

Resume updates to a trend chart on page 820 

Pan trend chart data on page 821 

If the View Designer project on the HMI device contains data logs, the 
HMI device logs the values of the tags in the data log automatically. The 
HMI device must have an SD card in order to log data. The SD Card 
allows the Data Log service to run and export.  

To log data 
• Insert an SD Card into the HMI device. 

Log data 
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Tips:  
• If a referenced tag does not exist in the controller or there is a communication issue with the 

controller, Tags are in error appears at the top of the Data Export popup of the Settings screen. 
• Ejecting and immediately reinserting the SD card into the HMI device may not restart data logging. 

Data logging does not recognize that the SD card is present. Eject the SD card, wait several 
seconds, and reinsert the SD card to restart data logging.  

See also 
Export a data log on page 823 

Cancel the export of a data log on page 825 

Data log file on page 826 

Data log retention on page 667 

A data log is a collection of data values from specified tags. Data logs 
export from the HMI device to an external device such as an SD card or a 
USB storage device. Exported data logs are .zip files that contain a .csv 
file for each data log in the project. Export a data log to view the data 
values on a computer. 

Use a data log to: 

• View historical data for a specific duration. 
• Collect tag values at a specified sample rate. 
• Identify data patterns in a system. 
• Troubleshoot a system. 
• Provide data for audits. 

See also 
Data log file on page 826 

Export a data log on page 823 

Data log retention on page 667 

Export a configured data log from the HMI device to removable media to 
view tag values collected on the HMI device. The exported .zip file 
contains individual .csv files for each data log in the project. Open the 
exported data log file on a computer to view the values in the data log. 

Prerequisites 
• Insert an SD Card into the HMI device so the Data Log service can 

run and export. 

 
Tip: If a referenced tag does not exist in a controller or there is a communication issue with a 
controller, Tags are in error appears at the bottom of the Data Export popup that opens from 
the Settings screen.  

To export a data log 
1. Open the Settings screen.  

Data log 

Export a data log 
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2. Select Data Export. The Data Export popup opens and indicates 
that the Data Log service is running.  

3. Under What to export, select Data logs. 
4. In the Filename box, enter a name for the export file. 

"archive_datalog" is the default name of the export file.  
5. Under Destination, select SD Card or USB Device.  
6. Select Export. Export progress shows a progress bar. The Data 

Export popup displays the last date and time a data log exported 
at the top of the window. 

 
Tips:  

• When the data log is exporting,  Data Export appears in the System Banner.  

• If there is an error in logging data or exporting a data log,  Data Export Error appears in the 
System Banner. 

• Data log exports do not complete or create a .zip file on removable media if a ControlFLASH, 
reboot, or power cycle to the HMI device occurs during the export or when removing media before 
the export is complete.  

• There is no potential damage to files when removing a USB storage device when exporting the data 
log file completes. 

 
IMPORTANT Do not remove an SD card before preparing the media for safe removal. This 

may corrupt files on the removable device. 

7. If an SD card contains the exported data log file, next to SD Card, 
select  Safely Remove SD Card. The Data Logger status at 
the top of the Data Log popup changes to Stopped and Remove 
SD card; reinsert to resume logging data appears.  Data Log 
Remove appears in the System Banner. It is safe to remove the 
SD card. 

 
Tips:  
• Data logging resumes when an SD card is inserted into the HMI device. 
• Bad Quality tag values occur in the data log when: 
• The HMI device is disconnected from a controller. 
• A controller is not synchronized. 
• An invalid tag is not defined in a controller or has an invalid address logged in the data log. 
• When downloading a project to or restarting the HMI device, data may appear as Bad Quality until 

the Data Log service starts collecting data from a controller.  
• When exporting a data log to an SD card or USB storage device, avoid an error message by 

ensuring that the SD card or USB storage device: 
• Has sufficient space  
• Is inserted into the HMI device 
• Has write permissions  
• Is a supported SD card type 
• Has a supported format of either FAT32 or EXT3  
• Is not corrupted and does not contain corrupted files 

• If a data log does not export to a supported SD card that meets requirements, reboot the HMI 
device. If rebooting fails, insert the SD card into a computer and verify that the SD meets 
requirements. Follow any prompt to scan and repair the file system index on the SD card. 

See also 
Cancel the export of a data log on page 825 

Data log on page 823 

Data log file on page 826 
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Data log retention on page 667 

View a data log on a computer after exporting the data log from the HMI 
device. Data log files export in .zip format to a removable USB storage 
device or SD card.  

Prerequisites 
• Export the data log.  

To view tag values in a data log 
1. Insert the removable media containing the exported data log .zip 

file into a computer and extract the file. 
2. Open the contents exported data log file using a program that 

opens .csv files. The exported data log file contains a .csv for each 
data log in the project.  

See also 
Data log file on page 826 

Data log retention on page 667 

Cancel the export of a data log to stop creating the export file for the data 
log and not save it to removable media. Cancel the export when the data 
log for the current project is exporting to the USB storage device or SD 
card in the HMI device.  

To cancel the export of a data log 
1. Open the Settings screen.  
2. Select Data Export. The Data Export popup opens, showing the 

progress of the export. 
3. Select Cancel. The progress indicator stops to indicate that the 

export is canceled. 

See also 
Export a data log on page 823 

Data log on page 823 

Retaining or replacing data logs on an HMI device occurs during a:  

• Download. Adding a new data log or deleting a data log and then 
redownloading a project to the HMI device retains the values of 
previously configured data logs. Redownloading a project that has 
a data log with a configuration change such as name, size, and 
tags, retains only the values of previously unchanged configured 
data logs. Downloading a project to an HMI device that has an SD 
card with data logs from a different project replaces the data logs. 

View tag values in a data 
log 

Cancel the export of a data 
log 

Data log retention 
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• Firmware change. Data logs remain unchanged when firmware 
on the HMI device is updated with a ControlFLASH. Data logging 
does not occur during a ControlFLASH. Downloading the same 
project to the HMI device after updating the firmware leaves the 
data log on the HMI device unchanged. When the project runs, 
data logging starts again. 

• HMI reboot. Data logging stops when rebooting the HMI device. 
The data log remains unchanged. Data logging starts after the 
reboot completes.    

• HMI recovery. If a project has a data log and the HMI device runs 
out of memory or has a fatal error, there are two options: 
• Restore Defaults. The HMI device opens the default project. 

Data logging stops when the HMI device is in error or when the 
default project is running. The data log on the SD card from the 
previous project on the HMI device remains unchanged. Data 
logging starts when downloading a project that contains a data 
log to the HMI device.  

• Continue. The HMI device recovers and the previous project 
opens. Data logging starts.  

• SD card change. Data logging stops when removing the SD card 
from the HMI device. Data logging starts when inserting any SD 
card. The SD card can be from the same project, a different 
project, the same HMI device, or a different HMI device. The SD 
card may contain the same or different data logs. The result of 
inserting an SD card in the HMI device depends on the data log on 
that SD card:  
• Same data log. When inserting an SD card that contains a data 

log from the current project on the HMI device, data logging 
starts. New data appends to the existing data log.   

• Different data log. Inserting an SD card that contains a 
different data log replaces the data log on the SD card with the 
data log in the project currently running on the HMI device.   

• No data log. Inserting an SD card that has no data log into an 
HMI device that has a project with a data log creates a data log 
on the SD card. 

 
Tips:  
• If no SD card exists on the HMI device, rebooting the HMI device or downloading a project stops 

data logging. Data logging starts when inserting an SD card. 
• Any time it is necessary to remove the SD card, ensure that the files do not become corrupt. On the 

Settings screen on the HMI device, open the Data Log popup and select  Safely Remove SD 
Card.  

See also 
View tag values in a data log on page 825 

Data log on page 823 

Data log file on page 826 

Data log file 
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The exported data log file displays information about the HMI device and 
the data log, and lists the recorded data values for each tag in the data 
log. 

 
 

Item Description 

 
The headings of the data log file indicate the: 
• Format of the file is an exported data log. 
• HMI device that exported the data log.  
• IP address of the HMI device. 
• Name of View Designer project runtime application containing the data log configuration. 
• Name of the data log in the runtime application. 
• Date and time the data log was exported.  

 
A column for each tag in the data log. Each column heading includes the controller path, the 
graphic element, and the property configured with the tag.  

 
The data values logged for each tag.  

 
The date and time each data value was logged.  

See also 
Export a data log on page 823 

Cancel the export of a data log on page 825 

Data log retention on page 667 

Data log on page 823 
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Chapter 29 

Troubleshoot 

At release time, this application presents certain circumstances and 
errors that require troubleshooting. This section supplies categories of 
Troubleshooting topics that indicate possible causes and solutions.  

In this section: 

Cannot paste content on page 829 

Cannot paste instance of Add-On Graphic on page 829 

Invalid configuration on page 829 

Unable to paste element type on page 830 

Unable to perform state change on page 830 

Possible cause and solution: 

• Add-On Graphics cannot contain other Add-On Graphics.  
Add a graphic element to the definition of the Add-On Graphic 
instead. 

• The definition of the Add-On Graphic is deleted.  
Pasting an instance of an Add-On Graphic is allowed only if the 
definition for the Add-On Graphic exists. Paste an instance of an 
Add-On Graphic for which a definition exists. 

See also 
Create an Add-On Graphic on page 375 

Possible cause and solution: 

• The content is not compatible with the installed version of Studio 
5000 View Designer. 
Use the current version of Studio 5000 View Designer to open and 
convert the project and then paste the content.  

See also 
Convert a project on page 58 

Possible cause and solution: 

• Binding directly to a controller tag from within the definition of an 
Add-On Graphic is not allowed.  
Create user-defined data type property to bind the Add-On 
Graphic to a controller tag.  

Troubleshoot 

Add-On Graphics 

Cannot paste content 

Cannot paste instance of 
Add-On Graphic 

Invalid configuration 
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• Cannot bind to an alias property from within the definition of an 
Add-On Graphic.  
Alias a property in the definition of an Add-On Graphic.  

See also 
Create a user-defined data type property for an Add-On Graphic 
on page 378 

Alias a property in an Add-On Graphic on page 412 

Possible cause and solution: 

• Instances of the Add-On Graphic exist in the project.  
Remove all instances of the Add-On Graphic from the project and 
then remove the definition of the Add-On Graphic. 

See also 
Delete an Add-On Graphic from a project on page 379 

Possible cause and solution: 

• Copying an instance of an Add-On Graphic into the definition of an 
Add-On Graphic is not allowed.   
Paste a graphic element instead.  

• Copying content from a predefined system management screen 
into the definition of an Add-On Graphic is not allowed.  
Paste system management screen content only in its original 
location to recover default project screens. Paste a different  
graphic element into the definition of the Add-On Graphic. 

See also 
What is the Settings screen? on page 97 

Possible cause and solution: 

• An infinite state table loop occurred.  
Change the expression in the state table to prevent an infinite 
state table loop. 

See also 
Change an expression on page 521 

 

In this section: 

Active alarm missing from alarm table on page 831 

Alarm data is not visible on page 831 

Unable to delete Add-On 
Graphic 

Unable to paste element 
type 

Unable to perform state 
change 

Alarms 
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Alarms missing from Alarm Manager on page 831 

Bad quality alarms appear in Alarm Summary on page 832 

Cannot perform operation on alarm table on page 832 

Details for selected alarm do not appear on page 832 

Failed to reset latched (TRIP_L) alarm on page 832 

No alarms appear in Alarm Manager on page 832 

No alarms appear in Alarm Summary on page 833 

Possible cause and solution: 

• The project may be configured incorrectly. For example, if an 
incorrect controller path is entered, no alarms appear on the 
Alarm Summary screen or the Alarm Manager screen.  
Check the project configuration in View Designer to make sure 
that the correct controller path exists.  

• Bad quality alarms do not appear on the Alarm Summary screen.  
If alarms are missing from the Alarm Summary screen only, 
check and resolve alarm fault status on the Alarm Manager 
screen.  

See also 
Project Properties dialog box on page 68 

Resolve alarm faults on page 567 

Possible cause and solution: 

• The Alarm, Event, or Communication service ends because the 
HMI device is out of memory. 
On the HMI device, open the Settings screen, tap HMI Device, 
and on the HMI Device popup, look at the memory use. Tap 
Reboot to manually restart the HMI device to free up memory. 

• The Alarm, Event, or Communication service ends. If the 
Communication service terminates, alarms appear with bad 
quality. There is no notification if the Alarm or Event services end. 
If any of the services ends, the HMI device restarts automatically. 

• The controller is unavailable due to an error in communication 
updates. The affected alarms appear as bad quality. 
Check the network connections. Open the Settings screen, tap 
HMI Network and on the Network popup, tap the Network 
Diagnostics tab . 

• The project configuration is too large. 
Reconfigure the project to display the recommended limit of up to 
500 alarms. 

Possible cause and solution:  

• The connection to a controller is lost or cannot be established.  
Establish a connection to the controller. 

Active alarm missing from 
alarm table 

Alarm data is not visible 

Alarms missing from Alarm 
Manager 
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• A controller flash update is in progress.  
Wait until the flash update to the controller is complete.  

• The controller firmware is invalid.  
Verify and modify the correct controller firmware if necessary.  

• There is low memory in a controller.  
Restart the controller manually to free up some memory.  

Possible cause and solution:   

• The connection to a controller is lost or cannot be established.  
Establish a connection to the controller. 

• A controller flash update is in progress.  
Wait until updates to the controller are complete. 

• There is no project in a controller after a firmware update or flash.   
Upload the project to the controller. 

• A controller is in a major fault.  
Clear the major fault and return the controller to Run mode. 

• A controller is in Program mode.  
Return the controller to Run mode. 

Possible cause and solution: 

• If the buttons on the alarm table appear available and without hash 
marks, the alarm table graphic element is read-only due to the 
assigned security role.  
Have the System Administrator grant the assigned security role 
access to the table. 

Possible cause and solution: 

• The alarm condition may not be selected in the table.  
Select the alarm in the Alarm Summary table or select the alarm 
condition in the Alarm Manager table. Details for the selected 
alarm appear in the Details pane of the selected table.   

Possible cause and solution: 

• The latched alarm may still be active.  
Remove the condition triggering the alarm and then reset the 
alarm once it is no longer active.   

Possible cause and solution: 

• The project has an incorrect configuration.  
Reconfigure the project and download it to the HMI device again.  

See also 
Add a controller reference on page 85 

Project Properties dialog box on page 68 

Bad quality alarms appear 
in Alarm Summary 

Cannot perform operation 
on alarm table 

Details for selected alarm 
do not appear 

Failed to reset latched 
(TRIP_L) alarm 

No alarms appear in Alarm 
Manager 
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Possible cause and solution:  

• The Alarm Summary table is not configured with columns. Add 
columns to the Alarm Summary table.  
Select the Alarm Summary table, in the Properties window 
select the Columns tab and select Add Column.  

• An applied filter may not list alarms in the Alarm Summary table.  
Select the Filter arrow and select No Filter. 

 

In this section: 

Cannot export data log to SD card on page 833 

Tags are in error on Data Log popup on page 834 

Possible cause and solution:  

• The SD card as insufficient space.   
Insert an SD card that has enough space to contain the exported 
data log file.   

• The SD card is not present.  
Verify that the SD card is inserted into the HMI device.  

• The SD card is read-only. 
Insert an SD card that has write permissions. 

• The SD card is not a supported type.  
Insert a supported SD card.  

• The SD card is not the supported format. 
Insert an SD card that has a supported format of either FAT32 or 
EXT3 

• The SD card is corrupted or contains corrupted files.  
Replace or repair the SD card. 

• Restarting the HMI device is required but does not solve the export 
issue.   
Insert the SD card into a computer to verify that the SD card meets 
requirements and follows any prompt to scan and repair the file 
system index on the SD card.  

Possible cause and solution: 

• The data log service is stopped.   
Verify that the HMI device contains an SD card that is not missing, 
full, or read-only and then restart the HMI device.  
 
 

 

Possible cause and solution:  

• A referenced tag does not exist in the controller.  
Check the configuration of the data log in View Designer. Export 
the data log to view tags with Bad Quality.    

No alarms appear in Alarm 
Summary 

Data logs 

Cannot export data to SD 
card 

Data Log Error icon appears 
in System Banner 

Data Log Warning icon 
appears in System Banner 
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• There is a communication issue with a controller.   
Check the controller path and the physical connection between the 
HMI device and the controller.   

Possible cause and solution:  

• A referenced tag does not exist in the controller.  
Check the configuration of the data log in View Designer. Export 
the data log to view tags with Bad Quality.    

• There is a communication issue with a controller.   
Check the controller path and the physical connection between the 
HMI device and the controller.   

In this section: 

Blue outline appears around graphic element on page 834 

Error icon appears on graphic element on page 834 

Graphic element does not change states when it reaches a certain 
value on page 834 

Item not visible on screen on page 837 

Red outline appears around graphic element on page 835 

Possible cause and solution: 

• Focus is set on an item on the HMI device. Focus is set by 
pressing Tab on the HMI device keypad or an external keyboard.  
To remove the blue outline, press Tab again on the HMI device 
keypad or an external keyboard. Focus is set on the next item. 

 

Possible cause and solution: 

• The graphic element is in error.  

Tap the Error icon  to open the Error list. Scroll down through 
the errors for the graphic element to identify issue. If there is a 
group of graphic elements in error, swipe right or left to display the 
next or previous graphic element in the group in error. After fixing 

the problem, the Error icon  disappears. 
Possible cause and solution:  

• The state table does not exist.  
Create the state table on the Animations tab of the Properties 
window for the selected graphic element.  

• The state table containing the state changes is not selected in a 
State Previous or State Next command.  
Verify that the state table is selected for the State Previous or 
State Next commands on the Events tab of the Properties 
window for the selected graphic element.  

• The state change does not exist in the state table.  
Verify the values of the properties in the state table on the 
Animations tab of the Properties window for the selected graphic 

Tags are in error on Data 
Log popup 

Graphic elements 

Blue outline appears around 
graphic element 
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element. If the property does not appear in the state table, on the 
Animations tab, edit the state table and select the property.  

See also 
Configure an animation using a State Table on page 438 

Events tab on page 447 

Animations tab on page 435 

Possible cause and solution: 

• The graphic element is in error. Errors occur if, for example, an 
invalid tag type cannot be written to a property of the graphic 
element, a tag bound to a property does not exist in the controllers 
referenced in the project, or an operation cannot be performed in a 
table.  

Tap the Error icon  on the graphic element or group to open 
the Error list. The graphic element or group fills with red and the 
error list opens. Scroll down through the errors for the graphic 
element to identify the issue. For a group of graphic elements in 
error, swipe right or left to display the errors for the next or 
previous graphic element that is in error within the group. After 

fixing the problem, the red outline and Error icon  disappear. 
In this section: 

CIP error occurred on page 835 

Failed to calibrate touch screen on page 835 

HMI device failed to restart on page 835 

HMI device is slow, hangs, or unresponsive on page 835 

Performance is poor on HMI device on page 836 

Unable to connect to HMI device on project download on page 836 

Possible cause and solution: 

• The communication settings may not be correct.  
Open the Settings screen and tap Controllers to change the 
communication settings.   

Possible cause and solution: 

• The target areas are not touched or are touched outside of the 
allotted time.  
Press and hold inside the target areas until each indicator 
completes a circle. Do this in the time indicated by the progress 
indicator. 

Possible cause and solution: 

• The HMI device cannot restart.  
Cycle power to the HMI device.  

Possible cause and solution: 

HMI device 
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• The HMI device is low on memory.  
Restart the HMI device. 

Possible cause and solution: 

• The configuration of the project deployed to the HMI device may 
be too large. 
Tune the HMI device for optimized memory and limit the data the 
project displays.  

Possible cause and solution: 

• Logix V32 software had an older version of FactoryTalk Linx 
preinstalled. 
Update FactoryTalk Linx to version 6.20 (CPR 9 SR 12.0) or later.  

In this section:  

Navigation time between screens is slow on page 836 

Screen does not appear in Navigation menu on page 836 

Possible cause and solution: 

• The HMI device may be low on memory.  
Reduce the configuration of the project deployed to the HMI 
device by limiting the data the project displays.  

Possible cause and solution:  

• The screen no longer exists in the project.  
Recreate the screen. 

• The screen exists in the project but does not have a shortcut to in 
the Navigation Menu folder of the Project Explorer in Studio 
5000 View Designer.  
Drag the screen from the User-Defined Screens folder to the 
Navigation Menu folder of the Project Explorer in Studio 5000 
View Designer. 

• Your assigned security role is not granted access to the screen.  
Have the System Administrator grant your assigned security role 
access to the screen.  

• The expected screen is a popup.  
Popups do not appear in the Navigation menu, but are opened by 
an event. Perform the necessary event to open the popup.  

In this section:  

Access to screen or popup denied on page 837 

Cannot access Logix Designer project on page 837 

Cannot change password or PIN on page 837 

Cannot log on to application on HMI device on page 837 

Logged on as Guest user on page 837 

Popup does not open on page 838 

Navigation 

Navigation time between 
screens is slow 

Screen does not appear in 
Navigation menu 

Security 
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Possible cause and solution: 

• The .acd file may be secured. View Designer cannot access the 
data from tags, and the Tag Browser cannot be used to browse 
tags, in the secured file.  
Unsecure the project file. You must have the appropriate security 
privilege in Logix Designer. In Logix Designer on the Controller 
Properties dialog box, click the Security tab and set Security 
Authority to No Protection. Alternatively, replace the secured 
project file in the controller with an unsecured version of the 
project file.  

Possible cause and solution:  

• Your assigned security role does not have access to the screen or 
popup.  
Have the System Administrator grant your assigned security role 
access to the screen or popup. 

• The graphic element is read-only.  
Have the System Administrator verify that the security access 
assigned to the graphic element is not read-only.  

Possible cause and solution: 

• Passwords and PINS cannot be changed from the HMI device.  
Contact the administrator to change the password or PIN using 
Studio 5000 View Designer.   

Possible cause and solution: 

• When a login attempt fails and the current user or Guest remains 
logged on to the application on the HMI device, it may be because 
the user security account used to log on does not exist for the 
application. The user name and password or PIN used to log on 
may also be incorrect.  
Contact the administrator for the correct user name and password 
or PIN.  

Possible cause and solution: 

• The Visible box for the graphic element may be cleared.  
Make the item visible by selecting the Visible box in the 
Properties window for the graphic element.  

• The Visible box is bound to a tag.  
Expect the graphic element to only appear when that value is 
reached. 

See also    
Change a property on page 493 

Bind a property to a data item on page 508 

Possible cause and solution: 

Cannot access Logix 
Designer project 
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• The Guest user is automatically logged on at system startup. 
When you log off the system, the Guest user account is 
automatically logged on. This is because only one user can be 
logged on at a time.  
To log on with assigned security access, log on using the correct 
user name and password or PIN. Contact the System 
Administrator for this information. 

Possible cause and solution:  

• The popup no longer exists in the project.  
Recreate the popup in Studio 5000 View Designer. 

• The popup is renamed.  
Rename the popup, or on the Events tab for the selected screen 
or graphic element, select the popup that the event is to open.  

• An event is not configured to open the popup.  
Verify on the Events tab of the selected graphic element that there 
is a Navigation event for opening the popup. 

• Security access to the popup is not granted.  
Have the System Administrator grant your assigned security role 
access to the popup. 

See also 
Events tab on page 447 

When logging on to the terminal using Active Directory fails, various error 
messages display, depending on the error. Errors may come from LDAP 
AD client or from the terminal platform. Because the terminal runtime and 
emulator use different LDAP clients, the error code may be different for 
the terminal and emulator. 

LADP errors include: 

• The message "Active Directory service cannot be reached 
(error=<code>)" appears when the Active Directory cannot be 
reached. The main reasons for this issue are incorrect Active 
Directory connection settings, HMI device being disconnected, or 
unavailable Active Directory server. It is shown for the following 
errors: 
• 91 (LDAP_CONNECT_ERROR) 
• 81 (LDAP_SERVER_DOWN) 
• -1 (LDAP_SERVER_DOWN) 
• 52 (LDAP_UNAVAILABLE) 
• 1 (LDAP_OPERATIONS_ERROR) 
• 11 (LDAP_ADMINLIMIT_EXCEEDED) 

• The message "Invalid credentials" appears when you provide 
invalid credentials on logon. It is shown for the code error 49 
(LDAP_INVALID_CREDENTIALS). 

• The message "Other network security error: (error=<code>)" 
appears for all the other LDAP errors. 

Terminal errors display the following messages: 

Network-based security 
runtime error messages 
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• The message "Username or password field cannot be empty." 
appears when you left the username or password field blank. 

• The message "User not found in directory service" appears when 
the user was not found in the Active Directory. 

• The message "Cannot read user group membership" appears 
when user has no membership group assignment on Active 
Directory side. 

• The message "User not assigned to a configured user group" 
appears when the credentials are correct but HMI device cannot 
match user to configured group. User group configuration for the 
project may be incorrect.  

For more information and detailed description of the codes, see: 

• LDAP Results Codes (emulator)  
• OpenLDAP Results Codes (terminal runtime)  
• Common Active Directory Bind Errors 

See also: 
Configure network-based security logon on page 703 

Log on using network-based security   on page 705 

 

 

In this section:  

Boolean failed to toggle on page 839 

Failed to evaluate expression on page 839 

Failed to read or write tag on page 839 

Failed to toggle value on page 840 

HMIBC tag does not exist on page 840 

String value failed to increment on page 840 

Value does not display on page 840 

Possible cause and solution: 

• The value may not be a Boolean, causing a data conversion error.  
Verify that the value type is Boolean. 

When an expression is not evaluated and the value not shown on the graphic element, this may occur for the 
following reasons:  
• The tag in the expression is not found in the controller. Bind the expression to a tag that is in the controller. 
• There is an invalid property or property value in the expression. Verify that the properties and property values in 

the expression are valid. 
• There are an invalid number of arguments in the expression. Verify that the number of arguments in the 

expression is valid. 
• The expression is invalid. Verify that the expression is valid. 

Possible cause and solution: 

• The tag may not exist.  
Verify the path of the tag in the property.  

Tag values 

https://ldapwiki.com/wiki/LDAP%20Result%20Codes
https://github.com/openldap/openldap/blob/master/include/ldap.h
https://ldapwiki.com/wiki/Common%20Active%20Directory%20Bind%20Errors
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See also 
Bind a property to a data item on page 508 

Possible cause and solution: 

• The value may not be a Boolean, causing a data conversion error 
occurred.  
Verify that the value is a Boolean. 

Possible cause and solution: 

• A command to change a tag fails if the write to controller fails.  
Make sure that the controller is connected to the HMI device.   

Possible cause and solution: 

• A data conversion error may have occurred because incrementing 
a string value is not allowed.  
Bind the property to a numeric tag.  

Possible cause and solution:   

• The tag does not exist in the controller.  
Select a tag that exists in the controller and verify that the 
controller is referenced in the properties of the project. 

• The tag value is not a number and cannot be converted to a 
number.  
Verify the value in the property, binding, or expression.  

• The value has an invalid syntax.  
Verify the syntax of the binding or expression or the value of the 
parameter in the binding or expression. 

• The expression is not evaluated because math is being attempted 
on a non-numeric value or because the property cannot be divided 
by zero.  
Verify the values for the property. 

• The tag type is mismatched and the data cannot be converted, or 
the tag is read-only.  
Verify the tag type and verify that the External Access property for 
the tag is not set to None.   

See also 
Bind a property to a data item on page 508 

Change a property on page 493 

Change an expression on page 521 

In this section: 

HMI project file cannot download on page 841 

Lost connection to HMI device on page 841 

Unable to connect to HMI device on page 841 

HMIBC tag does not exist 

Upload and Download 
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Unable to download or upload the HMI project on page 841 

Possible cause and solution:  

• File downloads are disabled on the HMI device.  
Check the Allow download and Firmware updates option on the 
HMI device configuration screen. 

• Another file download is in process.  
Wait until the first download is complete and then try again. 

See also 
Settings screen on page 740 

Possible cause and solution:  

• The HMI device lost power or is disconnected from the network.  
Verify that the HMI device is powered on and connected to the 
network.  

• The workstation is busy processing requests from other programs, 
processes, or services.  
Open Task Manager on your workstation to verify that no other 
program, process, or service is impacting the performance of the 
workstation. 

Possible cause and solution:   

• The HMI device is not powered on or connected to the network.  
Verify that the HMI device is a PanelView 5000 HMI device. 

• The HMI device at address <x> is not a PanelView 5000 HMI 
device.  
Verify that the HMI device is a PanelView 5000 HMI device.  

• The selected HMI device is from the recently accessed HMI device 
path list, but the HMI device is no longer on the network for 
download.  
From the HMI Device Configuration screen on the HMI device, 
verify that an IP address is assigned to the HMI device. 

• The selected HMI device is a previous HMI device selected from 
the location list, and the HMI device is no longer on the network for 
upload.  
Verify that the IP address entered in the HMI Device Path box on 
the Download and Upload dialog boxes is correct. Select a 
previous path in the Location box on the Application tab of the 
project properties. 

Possible cause and solution:  

• The connection between View Designer and the HMI device is lost 
during the file download.  
Verify that the HMI device is powered on and connected to the 
network. 

 

HMI project file cannot be 
downloaded 

Lost connection to HMI 
device at address <x> 

Unable to connect to HMI 
device at its IP address 
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Glossary 

absolute path 
A path that contains the root directory, all subdirectories, and file or object 
name. For example, C:\Users\Public\Pictures\Desert.jpg. 

binding 
A virtual connection of two or more components in a system.  

calibration 
The process of comparing an instrument or device with a standard to 
verify its accuracy. It also includes making adjustments to meet the 
standard, or devising a corrected scale. 

controller reference 
A connection to a Logix Designer project file (.acd) from a View Designer 
project file (.vpd) that automatically synchronizes data between a Logix 
Designer project file (.acd) and View Designer project file (.vpd). 

controller tag 
A tag at controller scope. 

DNS 
A domain name system for converting hostnames and domain names 
into IP addresses on the internet or on local networks that use the TCP/IP 
protocol. 

domain name system 
A system for converting hostnames and domain names into IP addresses 
on the internet or on local networks that use the TCP/IP protocol. 

HMI 
Human-machine interface.  

A - M 
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HMI device 
Human-machine interface device. Graphical display hardware on which 
an operator can monitor, control, and display application status 
information graphically. 

HMIBC 

Human-Machine Interface Button Control.HMI path 
The path from the computer containing the HMI project file to the HMI 
device on which the runtime application is downloaded. 

HMI project 
A .vpd file containing HMI screens, controller references, and the path of 
the HMI device to run the application.  

HMI server 
HMI servers, also called FactoryTalk View SE Servers, store and serve 
HMI projects, which contain displays, alarms, tags and other services, to 
HMI clients such as FactoryTalk View Studio and FactoryTalk View SE 
Clients. HMI clients use the FactoryTalk Directory to locate the 
computers that are hosting HMI servers. 

relative path 
A path that specifies the location of a directory relative to another 
directory.  

runtime 
The period during which the HMI project file is running on the HMI device 
from startup to shutdown. 

screen parameter 
An aliased property that is used to pass tag values to a screen at runtime. 
It is one of the many methods used to reuse content and simplify screen 
creation. 
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system tag 
A predefined tag that provides information about your system, such as 
the current logged-in user and the current time and date.  

.VPD 
The file extension for project files created using the Studio 5000 View 
Designer software.  
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Rockwell Automation support 
Use these resources to access support information. 

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification 
updates. 

rok.auto/support  

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase  
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport  

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature  
Product Compatibility and Download Center 
(PCDC) 

Get help determining how products interact, check features and capabilities, and 
find associated firmware. 

rok.auto/pcdc  

 

Documentation feedback 
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at 
rok.auto/docfeedback. 

Waste Electrical and Electronic Equipment (WEEE) 

 
At the end of life, this equipment should be collected separately from any unsorted municipal waste. 

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec. 

 

http://rok.auto/support
http://rok.auto/knowledgebase
http://rok.auto/phonesupport
http://rok.auto/literature
http://rok.auto/pcdc
http://rok.auto/docfeedback
http://rok.auto/pec
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